Blender

3D Content Creation Noob to Pro

en.wikibooks.org
On the 28th of April 2012 the contents of the English as well as German Wikibooks and Wikipedia projects were licensed under Creative Commons Attribution-ShareAlike 3.0 Unported license. A URI to this license is given in the list of figures on page 1877. If this document is a derived work from the contents of one of these projects and the content was still licensed by the project under this license at the time of derivation this document has to be licensed under the same, a similar or a compatible license, as stated in section 4b of the license. The list of contributors is included in chapter Contributors on page 1865. The licenses GPL, LGPL and GFDL are included in chapter Licenses on page 1949, since this book and/or parts of it may or may not be licensed under one or more of these licenses, and thus require inclusion of these licenses. The licenses of the figures are given in the list of figures on page 1877. This PDF was generated by the \LaTeX typesetting software. The \LaTeX source code is included as an attachment (source.7z.txt) in this PDF file. To extract the source from the PDF file, you can use the pdfdetach tool including in the poppler suite, or the http://www.pdflabs.com/tools/pdfkt-the-pdf-toolkit/ utility. Some PDF viewers may also let you save the attachment to a file. After extracting it from the PDF file you have to rename it to source.7z. To uncompress the resulting archive we recommend the use of http://www.7-zip.org/. The \LaTeX source itself was generated by a program written by Dirk Hünniger, which is freely available under an open source license from http://de.wikibooks.org/wiki/ Benutzer:Dirk_Huenniger/wb2pdf.
## Contents

1. Unit 1: Background .................................................................................................................. 3
   1. Knowing before Making ....................................................................................................... 5
      1.1. Additional Resources ................................................................................................... 7
   2. What Blender Can Do .......................................................................................................... 9
      2.1. An Example .................................................................................................................. 9
      2.2. Steps in the 3D Production Process ............................................................................ 10
      2.3. Additional Resources ................................................................................................ 12
   3. 3D Geometry ....................................................................................................................... 13
      3.1. Coordinates And Coordinate Systems ........................................................................ 13
      3.2. Axes Of Rotation ......................................................................................................... 16
      3.3. Additional Resources ................................................................................................ 19
   4. Coordinate Transformations ............................................................................................... 21
      4.1. Coordinate Transformations ....................................................................................... 21
      4.2. Linear Transformations ............................................................................................... 23
      4.3. Multiple Transformations ........................................................................................... 24
      4.4. Inverse Transformations ............................................................................................. 26
      4.5. Projections .................................................................................................................. 27
   5. Orthographic Views ............................................................................................................. 29
      5.1. Example ....................................................................................................................... 29
      5.2. Additional Resources ................................................................................................ 31
   6. Perspective Views .................................................................................................................. 33
      6.1. One-point Perspective .................................................................................................. 34
      6.2. Two-point Perspective ............................................................................................... 35
      6.3. Three-point Perspective .............................................................................................. 36
      6.4. Additional Resources ................................................................................................ 36
   7. Coordinate Spaces in Blender .............................................................................................. 37
      7.1. Global and local coordinates ....................................................................................... 37
      7.2. View coordinates .......................................................................................................... 39
      7.3. Normal coordinates ...................................................................................................... 40
      7.4. UV Coordinates .......................................................................................................... 41
   8. Overview .............................................................................................................................. 43
Contents

9. Keystroke, Button, and Menu Notation 45
   9.1. Hotkeys ............................................. 45
   9.2. Mouse Notation ..................................... 46
   9.3. Navigating Menus ................................... 47
   9.4. Additional Resources ................................. 49

10. Non-standard Input Devices .............................. 51

11. Operating System-specific Issues ...................... 55
    11.1. GNU+Linux ......................................... 55
    11.2. Mac OS X ............................................ 56
    11.3. Microsoft Windows ................................. 56

12. Blender User Interface ................................ 59
    12.1. Why Doesn’t It Follow UI Conventions For [Insert OS Of Choice Here]? 60
    12.2. Why Doesn’t It Prompt To Save Changes? .............. 61

13. Blender Windowing System ............................... 63
    13.1. An Interface Divided ................................ 63
    13.2. Window Headers ...................................... 64
    13.3. Window Types ........................................ 67
    13.4. The Active Window ................................... 72
    13.5. Resizing Windows .................................... 72
    13.6. Shelves ............................................... 73
    13.7. Too Much To Fit ..................................... 75
    13.8. Splitting And Joining Windows ....................... 76
    13.9. The Default Workspace ............................... 77
    13.10. Workspace Presets ................................ 81
    13.11. One Document At A Time ............................ 84
    13.12. Scenes .............................................. 84
    13.13. Leaving Blender ..................................... 85

14. User Preferences Windows ............................... 87
    14.1. Saving User Preferences ............................ 87
    14.2. Accessing the User Preferences .................... 87
    14.3. Configuring Your Preferences ....................... 89
    14.4. Additional Resources ............................... 92

15. Properties Window ....................................... 93

16. The Contexts ........................................... 95
    16.1. Render Context File:Blender255RenderContextButton.png ........ 95
    16.2. Render Layers Context File:Blender267RenderLayersContextButton.png 95
    16.3. Scene Context File:Blender255SceneContextButton.png ............... 95
    16.4. World Context File:Blender255WorldContextButton.png ............... 96
    16.5. Object Context File:Blender255ObjectContextButton.png .............. 96
21.5. Edge Loop Selection .................................................. 151
21.6. Loop Cuts .............................................................. 151
21.7. Edge Loop Deletion ..................................................... 151
21.8. Subdividing Parts ....................................................... 151
21.9. Subdivision Surface Modifier ........................................ 152
21.10. Sharpening the Curves ............................................... 157

22. Quickie Lighting .......................................................... 161

23. Quickie Model ............................................................. 165
  23.1. Bring up the Default Cube ......................................... 167
  23.2. Setting up the Viewport ............................................ 168
  23.3. Adjusting the Height ............................................... 170
  23.4. Extruding ............................................................. 172
  23.5. Merging ............................................................... 173
  23.6. Saving your Work .................................................... 175
  23.7. Additional Resources ............................................... 176

24. Quickie Render ........................................................... 177
  24.1. Rendering the Quickie Model ...................................... 178
  24.2. Seeing Your Render ................................................ 178
  24.3. Aiming the Camera ................................................ 178
  24.4. Lighting .............................................................. 179
  24.5. Saving the Render .................................................. 179
  24.6. Renderer Selection ................................................ 180
  24.7. Render Control ........................................................ 181
  24.8. Render Image Dimensions ......................................... 184
  24.9. Image File Formats ................................................ 186
  24.10. Additional Resources .............................................. 188

25. Enter the World ......................................................... 189

26. Understanding the Camera ............................................. 191
  26.1. Real-World Cameras ................................................ 191
  26.2. The Camera In Blender .............................................. 192
  26.3. See Also ............................................................. 198

27. Improving Your House .................................................. 199
  27.1. Adding a Ground Plane ............................................. 200
  27.2. Scaling with a Pivot ............................................... 202
  27.3. Edge Selection ..................................................... 203
  27.4. Extruding Edges .................................................... 204
  27.5. Face Selection ...................................................... 207
  27.6. Extruding Faces .................................................... 208
  27.7. Deleting Edges ..................................................... 210
  27.8. Subdividing Faces ................................................ 210
  27.9. Final Steps .......................................................... 213
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>28.</td>
<td>Extruding a Simple Person</td>
<td>215</td>
</tr>
<tr>
<td></td>
<td>28.1. Start a New Scene</td>
<td>216</td>
</tr>
<tr>
<td></td>
<td>28.2. Selection Methods</td>
<td>216</td>
</tr>
<tr>
<td></td>
<td>28.3. Extruding Limbs</td>
<td>220</td>
</tr>
<tr>
<td></td>
<td>28.4. Adding the Head</td>
<td>226</td>
</tr>
<tr>
<td></td>
<td>28.5. Save Your Work</td>
<td>228</td>
</tr>
<tr>
<td>29.</td>
<td>Smoothing Your Simple Person</td>
<td>231</td>
</tr>
<tr>
<td></td>
<td>29.1. Subsurfaces</td>
<td>232</td>
</tr>
<tr>
<td></td>
<td>29.2. Smooth Shading</td>
<td>235</td>
</tr>
<tr>
<td>30.</td>
<td>Improving Your Simple Person</td>
<td>239</td>
</tr>
<tr>
<td></td>
<td>30.1. Widening the Torso</td>
<td>239</td>
</tr>
<tr>
<td></td>
<td>30.2. Bending the Arms</td>
<td>242</td>
</tr>
<tr>
<td></td>
<td>30.3. Making Feet</td>
<td>244</td>
</tr>
<tr>
<td></td>
<td>30.4. Reshaping the Head</td>
<td>245</td>
</tr>
<tr>
<td>31.</td>
<td>Spinning a Simple Hat</td>
<td>247</td>
</tr>
<tr>
<td></td>
<td>31.1. Creating a Generatrix</td>
<td>247</td>
</tr>
<tr>
<td></td>
<td>31.2. Spinning the Hat</td>
<td>249</td>
</tr>
<tr>
<td></td>
<td>31.3. Smoothing Your Hat</td>
<td>250</td>
</tr>
<tr>
<td></td>
<td>31.4. Additional Resources</td>
<td>251</td>
</tr>
<tr>
<td>32.</td>
<td>Putting the Hat on the Person</td>
<td>253</td>
</tr>
<tr>
<td></td>
<td>32.1. Adjusting an Object’s Median Point</td>
<td>254</td>
</tr>
<tr>
<td></td>
<td>32.2. Positioning the Hat</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>32.3. Parenting the Hat to the Person</td>
<td>257</td>
</tr>
<tr>
<td></td>
<td>32.4. Renaming Objects</td>
<td>258</td>
</tr>
<tr>
<td></td>
<td>32.5. Outliner Windows</td>
<td>259</td>
</tr>
<tr>
<td></td>
<td>32.6. Good on ya’ mate!</td>
<td>260</td>
</tr>
<tr>
<td></td>
<td>32.7. Additional Resources</td>
<td>260</td>
</tr>
<tr>
<td>33.</td>
<td>Overview</td>
<td>261</td>
</tr>
<tr>
<td>34.</td>
<td>Quickie Material</td>
<td>263</td>
</tr>
<tr>
<td></td>
<td>34.1. Your First Material</td>
<td>264</td>
</tr>
<tr>
<td></td>
<td>34.2. Specifying Colors</td>
<td>268</td>
</tr>
<tr>
<td></td>
<td>34.3. Additional Resources</td>
<td>272</td>
</tr>
<tr>
<td>35.</td>
<td>Multiple Materials per Object</td>
<td>273</td>
</tr>
<tr>
<td></td>
<td>35.1. Set the Scene</td>
<td>274</td>
</tr>
<tr>
<td></td>
<td>35.2. Colorize Time</td>
<td>275</td>
</tr>
<tr>
<td>36.</td>
<td>Metal Versus Plastic</td>
<td>279</td>
</tr>
<tr>
<td></td>
<td>36.1. Making It Plastic</td>
<td>280</td>
</tr>
<tr>
<td></td>
<td>36.2. Making It Metal</td>
<td>281</td>
</tr>
<tr>
<td></td>
<td>36.3. Making It Ceramic</td>
<td>282</td>
</tr>
</tbody>
</table>
37. Texture Settings 283
   37.1. Material Textures ........................................ 289
   37.2. World Textures ........................................... 290

38. Image Textures 293
   38.1. Image Texture Settings .................................... 293
   38.2. Making Your Own Texture .................................. 304

39. Procedural Textures 309
   39.1. A Simple Wood Texture .................................... 309

40. Quickie Texture 315
   40.1. Making It Mottled .......................................... 316
   40.2. Adjusting the Influence ................................... 318
   40.3. Making It Wrinkly (Bump Map) ............................. 321

41. Halo Materials 323
   41.1. Introduction ............................................... 323
   41.2. Setting The Scene ......................................... 323
   41.3. Adding The Flare ......................................... 324
   41.4. The Final Result .......................................... 325

42. Blender Memory Management 327
   42.1. Datablocks And Users ...................................... 327

43. A Common Pitfall in Older Tutorials (Align to View Issue) 331

44. Using Bones 335

45. Mountains out of Molehills 337
   45.1. Creating a simple plane ................................. 337
   45.2. First mountain ........................................... 338
   45.3. Peaks vs. hills ........................................... 341
   45.4. Shaping the world ........................................ 343
   45.5. Smoothing things out ..................................... 345
   45.6. Naturalness ............................................... 346
   45.7. Adding your guy with the hat ............................ 347

46. Modeling a Volcano 349
   46.1. Adding a Plane ........................................... 349
   46.2. Making the Mountain ...................................... 349
   46.3. Forming the Crater ........................................ 353
   46.4. Subsurf ................................................... 355
   46.5. Adding Magma ............................................. 358
   46.6. Varying the Terrain ...................................... 358

47. Penguins from Spheres 361

48. Dicing With Depth (Dice Modeling) 363
58.7. Final touches ................................................. 449

59. Simple Vehicle: Body ............................................. 451
    59.1. Techniques ................................................. 451
    59.2. Planning ..................................................... 451
    59.3. Building the Jeep ......................................... 451
    59.4. A Touch of Detail ......................................... 472
    59.5. Subsurf ...................................................... 483
    59.6. Optional Activities ....................................... 483

60. Simple Vehicle: Some Assembly Required .................................. 485
    60.1. Techniques ................................................. 485
    60.2. Overview ................................................... 485
    60.3. Appending the File ........................................ 485
    60.4. Rinse and Repeat ......................................... 487
    60.5. Parenting ................................................... 488
    60.6. Final things ............................................... 489
    60.7. Extra ....................................................... 490
    60.8. Additional Tutorials ...................................... 493

61. Modeling a 3D Parachute in Blender .......................................... 495
    61.1. Remove the default cube ..................................... 495
    61.2. Add a cylinder ............................................... 496
    61.3. Remove the bottom row of vertices ......................... 497
    61.4. Extrude and scale to shape ................................ 498
    61.5. Make the top more rounded ................................ 500
    61.6. Extrude the parachute straps ............................. 500
    61.7. Merge it together .......................................... 501

62. Model a Low Poly Head ............................................... 503
    62.1. Overview ................................................... 503
    62.2. Add a plane .................................................. 504
    62.3. Make a pointed chin ........................................ 504
    62.4. Extrude the face ............................................ 506
    62.5. Make the facial features ................................... 508
    62.6. Smooth the mouth region ................................... 515
    62.7. Make the head ............................................... 516
    62.8. Make the back of the head ................................. 518
    62.9. Finishing it up ............................................. 522

63. Building a House .................................................. 523
    63.1. Setting the Scene ........................................... 524
    63.2. Make the Roof ............................................... 525
    63.3. Naming the Roof and House Objects ....................... 528
    63.4. Colouring the House ....................................... 530
    63.5. Make a Chimney ............................................. 536
    63.6. Adding a Window ........................................... 541
    63.7. Adding a Door ............................................... 548

X
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>63.8. Building the Fence</td>
<td>549</td>
</tr>
<tr>
<td>63.9. The Ground Plane and a Path</td>
<td>561</td>
</tr>
<tr>
<td>63.10. Improve the Lighting</td>
<td>565</td>
</tr>
<tr>
<td>63.11. Check the Camera View</td>
<td>566</td>
</tr>
<tr>
<td>63.12. Final Render</td>
<td>566</td>
</tr>
<tr>
<td>64. Pipe joints</td>
<td>569</td>
</tr>
<tr>
<td>64.1. T joint</td>
<td>569</td>
</tr>
<tr>
<td>64.2. 6 cylinder joint</td>
<td>572</td>
</tr>
<tr>
<td>64.3. 3 cylinder joint</td>
<td>574</td>
</tr>
<tr>
<td>64.4. T joint with smaller diameter</td>
<td>576</td>
</tr>
<tr>
<td>65. Lighting Suzanne: Introductory one lamp lighting</td>
<td>581</td>
</tr>
<tr>
<td>66. Lighting Suzanne: Introductory one lamp lighting</td>
<td>583</td>
</tr>
<tr>
<td>66.1. Suzanne, Our Star</td>
<td>583</td>
</tr>
<tr>
<td>66.2. The default light</td>
<td>586</td>
</tr>
<tr>
<td>66.3. Types of lamps</td>
<td>587</td>
</tr>
<tr>
<td>66.4. Light Energy</td>
<td>589</td>
</tr>
<tr>
<td>66.5. Distance and Height</td>
<td>589</td>
</tr>
<tr>
<td>66.6. Rotation</td>
<td>591</td>
</tr>
<tr>
<td>66.7. Experiment!</td>
<td>592</td>
</tr>
<tr>
<td>66.8. Note on Transparency</td>
<td>592</td>
</tr>
<tr>
<td>66.9. Note on World Lighting</td>
<td>594</td>
</tr>
<tr>
<td>67. Overview</td>
<td>595</td>
</tr>
<tr>
<td>68. Intro to Bézier Curves</td>
<td>597</td>
</tr>
<tr>
<td>69. Bevelling a Curve</td>
<td>599</td>
</tr>
<tr>
<td>70. NURBS Patches</td>
<td>601</td>
</tr>
<tr>
<td>71. Deforming Meshes using the Curve Modifier</td>
<td>603</td>
</tr>
<tr>
<td>71.1. Understanding the Curve Modifier</td>
<td>603</td>
</tr>
<tr>
<td>71.2. Another Example</td>
<td>609</td>
</tr>
<tr>
<td>72. The Empty Object</td>
<td>615</td>
</tr>
<tr>
<td>72.1. Using an Empty With the Array Modifier</td>
<td>618</td>
</tr>
<tr>
<td>73. Background Images</td>
<td>623</td>
</tr>
<tr>
<td>73.1. Other Ways To Bring In Reference Images</td>
<td>627</td>
</tr>
<tr>
<td>74. Aligning Vertices with a Guide Image</td>
<td>629</td>
</tr>
<tr>
<td>74.1. Background: orthographic projection</td>
<td>630</td>
</tr>
<tr>
<td>74.2. Making a Simple Pyramid</td>
<td>631</td>
</tr>
<tr>
<td>74.3. Using the guide images</td>
<td>632</td>
</tr>
<tr>
<td>75. Modeling a Fox from Guide Images</td>
<td>643</td>
</tr>
<tr>
<td>75.1. Method 1</td>
<td>643</td>
</tr>
<tr>
<td>Chapter</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>75.2</td>
<td>But where's the FOX?</td>
</tr>
<tr>
<td>75.3</td>
<td>Method 2 (using mirroring)</td>
</tr>
<tr>
<td>75.4</td>
<td>Using mirroring with method 1</td>
</tr>
<tr>
<td>75.5</td>
<td>Detailed steps to align images using GIMP</td>
</tr>
<tr>
<td>76</td>
<td>Using Bézier Curve to Model a 3D logo from a 2D logo</td>
</tr>
<tr>
<td>76.1</td>
<td>Overview</td>
</tr>
<tr>
<td>76.2</td>
<td>Load the background image into blender</td>
</tr>
<tr>
<td>76.3</td>
<td>Delete the cube</td>
</tr>
<tr>
<td>76.4</td>
<td>Introducing the Bezier Curve</td>
</tr>
<tr>
<td>76.5</td>
<td>Modeling the lighting bolt</td>
</tr>
<tr>
<td>76.6</td>
<td>Modeling the red circle</td>
</tr>
<tr>
<td>76.7</td>
<td>Extra Practice</td>
</tr>
<tr>
<td>77</td>
<td>Subsurface Scattering</td>
</tr>
<tr>
<td>78</td>
<td>Ray Tracing</td>
</tr>
<tr>
<td>78.1</td>
<td>Setting The Scene</td>
</tr>
<tr>
<td>78.2</td>
<td>Ray-Traced Transparency</td>
</tr>
<tr>
<td>78.3</td>
<td>The Fresnel Factor</td>
</tr>
<tr>
<td>78.4</td>
<td>Ray-Traced Mirroring</td>
</tr>
<tr>
<td>78.5</td>
<td>Why Are My Shadows Black?</td>
</tr>
<tr>
<td>79</td>
<td>Using Textures</td>
</tr>
<tr>
<td>79.1</td>
<td>Colormap</td>
</tr>
<tr>
<td>79.2</td>
<td>Diffusemap</td>
</tr>
<tr>
<td>79.3</td>
<td>Luminositymap</td>
</tr>
<tr>
<td>79.4</td>
<td>Specularitymap</td>
</tr>
<tr>
<td>79.5</td>
<td>Reflectionmap</td>
</tr>
<tr>
<td>79.6</td>
<td>Transparencymap</td>
</tr>
<tr>
<td>79.7</td>
<td>Refractionmap</td>
</tr>
<tr>
<td>79.8</td>
<td>Translucencymap</td>
</tr>
<tr>
<td>79.9</td>
<td>Bumpmap/Normalmap</td>
</tr>
<tr>
<td>79.10</td>
<td>Displacement Map</td>
</tr>
<tr>
<td>79.11</td>
<td>Dirtmap</td>
</tr>
<tr>
<td>79.12</td>
<td>Use UV Coordinates for your Maps</td>
</tr>
<tr>
<td>80</td>
<td>Using a texture to make a material partially transparent</td>
</tr>
<tr>
<td>80.1</td>
<td>Using a greyscale texture - white for opaque</td>
</tr>
<tr>
<td>80.2</td>
<td>Using a partially transparent texture to make the material transparent</td>
</tr>
<tr>
<td>81</td>
<td>Creating Basic Seawater</td>
</tr>
<tr>
<td>81.1</td>
<td>Create 3 linked planes</td>
</tr>
<tr>
<td>81.2</td>
<td>Create material</td>
</tr>
<tr>
<td>81.3</td>
<td>Create Material / Textures (Blender 2.63)</td>
</tr>
<tr>
<td>81.4</td>
<td>Extra Practice</td>
</tr>
<tr>
<td>82</td>
<td>Mountains Out Of Molehills 2</td>
</tr>
</tbody>
</table>
## 83. Basic Carpet Texture 759
- 83.1. Goal .............................................. 759
- 83.2. The Basic Material and Shader Settings .................. 760
- 83.3. Cloud Texture 1 .................................. 760
- 83.4. Cloud Texture 2 .................................. 761
- 83.5. The Final Cloud Texture ............................ 762
- 83.6. The Last Texture .................................. 763

## 84. The Rusty Ball 765
- 84.1. UPDATE ............................................. 766

## 85. Creating Pixar-looking eyes 773
- 85.1. Parts of the Eye ..................................... 774
- 85.2. Materials ........................................... 775
- 85.3. Lighting ............................................. 779
- 85.4. Changing the Eye Color .............................. 780
- 85.5. Pixar Eye Video Tutorial ............................ 784
- 85.6. Useful Links ........................................ 784

## 86. Procedural Eyeball 785
- 86.1. Creating the Mesh ................................... 786
- 86.2. Adding the Textures ................................ 787
- 86.3. Pupil Dialation ..................................... 792

## 87. Putting It All Together: A Dragon! 795

## 88. Putting it all Together: A Dragon! 797
- 88.1. Modeling from the Image ............................. 798
- 88.2. Setting the Body Materials and Textures .............. 799
- 88.3. Adding the Eyes .................................... 801
- 88.4. A Dragon Needs Teeth and Claws ..................... 801
- 88.5. Horns, a Crest, and Nostrils ......................... 803
- 88.6. Giving the Dragon Wings ............................ 805
- 88.7. FIRE! ............................................... 806
- 88.8. Ground to Stand on ................................ 808
- 88.9. Lighting ............................................ 809

## 89. THE FINAL RESULT 813

### III. Unit 3: Broadening Horizons 815

## 90. The UV/Image Editor 817

## 91. UV Map Basics 819
- 91.1. The Basics of UV Mapping .......................... 819
- 91.2. Alternative method ................................ 826
- 91.3. Learning More ..................................... 828
118. Simple Cloth Animation 955
   118.1. Making the Skirt Mesh .................................. 955
   118.2. Creating the Vertex Group ................................ 956
   118.3. Animating the Skirt ..................................... 956
   118.4. Prior to Keeping the Folds ............................... 958
   118.5. Keeping the Folds ....................................... 959
   118.6. Extra Practice ........................................... 961

119. Soft Body with Wind 963

120. Blender Game Engine Basics- Rolling Ball 965

121. Platformer: Controls and Movement 967
   121.1. Set Up ..................................................... 967
   121.2. Controls ................................................... 968

122. Maze: Force and Multiple Levels 971
   122.1. Maze Surface ............................................. 971
   122.2. Character ................................................ 974
   122.3. Motion ..................................................... 976
   122.4. Testing .................................................... 977
   122.5. Falling .................................................... 978
   122.6. Camera ..................................................... 980
   122.7. Beautification ............................................ 981
   122.8. Levels ...................................................... 984
   122.9. Dynamic obstacles ....................................... 985
   122.10. Conclusion ................................................ 987

123. Platformer: Improving the Physics 989
   123.1. Creating Your Hit Test Object ............................ 989
   123.2. Excessive Bouncing ..................................... 990
   123.3. Final Notes ............................................... 990

124. How to Make an Executable 991
   124.1. Windows .................................................... 991
   124.2. GNU/Linux or Mac OS X ................................ 993
   124.3. BlenderPlayer ............................................. 993
   124.4. Legal Issues ............................................. 993
   124.5. Proprietary Blend Files .................................. 994

125. Build a Skybox 995

126. Basic Mouse Pointer 997

127. Text in BGE 999

128. Platformer: Creating the Engine with Python 1001
   128.1. Code Sections ............................................ 1001
   128.2. Adding the Player Object ............................... 1002
### IV. Unit 4: Taking Off with Advanced Tutorials

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>129. Introduction</td>
<td>1007</td>
</tr>
<tr>
<td>129.1. First Steps In Blender Scripting</td>
<td>1007</td>
</tr>
<tr>
<td>129.2. The bpy Module</td>
<td>1010</td>
</tr>
<tr>
<td>129.3. The mathutils Module</td>
<td>1011</td>
</tr>
<tr>
<td>129.4. See Also</td>
<td>1011</td>
</tr>
<tr>
<td>130. Anatomy Of An Addon</td>
<td>1013</td>
</tr>
<tr>
<td>130.1. Text Blocks</td>
<td>1013</td>
</tr>
<tr>
<td>130.2. Your First Operator</td>
<td>1013</td>
</tr>
<tr>
<td>130.3. Invoking Your Operator</td>
<td>1017</td>
</tr>
<tr>
<td>130.4. If You Hit An Error</td>
<td>1018</td>
</tr>
<tr>
<td>131. A User Interface For Your Addon</td>
<td>1019</td>
</tr>
<tr>
<td>131.1. Your First Panel</td>
<td>1019</td>
</tr>
<tr>
<td>131.2. Adding Undo Support</td>
<td>1020</td>
</tr>
<tr>
<td>131.3. Put It All Together</td>
<td>1020</td>
</tr>
<tr>
<td>131.4. Space Types, Region Types, Contexts, Oh My!</td>
<td>1021</td>
</tr>
<tr>
<td>132. Adding A Custom Property</td>
<td>1023</td>
</tr>
<tr>
<td>132.1. Defining A Property</td>
<td>1023</td>
</tr>
<tr>
<td>132.2. Using The Property</td>
<td>1024</td>
</tr>
<tr>
<td>132.3. Put It All Together</td>
<td>1024</td>
</tr>
<tr>
<td>133. A Separately Installable Addon</td>
<td>1027</td>
</tr>
<tr>
<td>133.1. The Addon Info Dictionary</td>
<td>1027</td>
</tr>
<tr>
<td>133.2. Making The Addon Installable</td>
<td>1028</td>
</tr>
<tr>
<td>133.3. Installing The Addon</td>
<td>1028</td>
</tr>
<tr>
<td>133.4. Using The Installed Addon</td>
<td>1028</td>
</tr>
<tr>
<td>134. Object, Action, Settings</td>
<td>1031</td>
</tr>
<tr>
<td>134.1. Adding To The Add Menu</td>
<td>1031</td>
</tr>
<tr>
<td>134.2. Fixing Up The UI</td>
<td>1032</td>
</tr>
<tr>
<td>134.3. invoke Versus execute</td>
<td>1033</td>
</tr>
<tr>
<td>134.4. Put It All Together</td>
<td>1033</td>
</tr>
<tr>
<td>134.5. Undocumented Blender</td>
<td>1034</td>
</tr>
<tr>
<td>135. Overview</td>
<td>1047</td>
</tr>
<tr>
<td>136. High Dynamic Range imaging (HDRi)</td>
<td>1049</td>
</tr>
<tr>
<td>136.1. Introduction</td>
<td>1049</td>
</tr>
<tr>
<td>136.2. Definitions</td>
<td>1049</td>
</tr>
<tr>
<td>136.3. Usage</td>
<td>1050</td>
</tr>
<tr>
<td>136.4. Quick Tutorial <em>for experienced blendies</em></td>
<td>1051</td>
</tr>
<tr>
<td>136.5. Step-by-step Tutorial</td>
<td>1051</td>
</tr>
<tr>
<td>137. Creating a Light Probe</td>
<td>1055</td>
</tr>
<tr>
<td>Chapter</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>138.</td>
<td>Landscape Modeling with Heightmaps</td>
</tr>
<tr>
<td>138.1.</td>
<td>Creating the heightmap image</td>
</tr>
<tr>
<td>138.2.</td>
<td>Create grid and add the image as texture</td>
</tr>
<tr>
<td>138.3.</td>
<td>Use texture as heightmap</td>
</tr>
<tr>
<td>139.</td>
<td>How to Do Procedural Landscape Modeling</td>
</tr>
<tr>
<td>139.1.</td>
<td>Mountains</td>
</tr>
<tr>
<td>140.</td>
<td>Landscape Modeling I: Basic Terrain</td>
</tr>
<tr>
<td>140.1.</td>
<td>Creating the Canvas</td>
</tr>
<tr>
<td>140.2.</td>
<td>Molding the Mountains</td>
</tr>
<tr>
<td>140.3.</td>
<td>Texturing the Terrain</td>
</tr>
<tr>
<td>140.4.</td>
<td>Reader Contributions</td>
</tr>
<tr>
<td>140.5.</td>
<td>Reader Contributions 2</td>
</tr>
<tr>
<td>140.6.</td>
<td>Reader Contributions 3</td>
</tr>
<tr>
<td>141.</td>
<td>Landscape Modeling II: Texture Stenciling</td>
</tr>
<tr>
<td>141.1.</td>
<td>Creating the Stencil</td>
</tr>
<tr>
<td>141.2.</td>
<td>Applying the Stencil</td>
</tr>
<tr>
<td>141.3.</td>
<td>Adding Snow</td>
</tr>
<tr>
<td>141.4.</td>
<td>Multiple Stencils</td>
</tr>
<tr>
<td>142.</td>
<td>Landscape Modeling III: Exporting as a Heightmap</td>
</tr>
<tr>
<td>142.1.</td>
<td>A Word About Heightmaps</td>
</tr>
<tr>
<td>142.2.</td>
<td>Creating the Material</td>
</tr>
<tr>
<td>142.3.</td>
<td>Setting up the Camera</td>
</tr>
<tr>
<td>142.4.</td>
<td>Avoid Stair-Stepping</td>
</tr>
<tr>
<td>143.</td>
<td>Bump Mapping</td>
</tr>
<tr>
<td>143.1.</td>
<td>Creating Bump Maps</td>
</tr>
<tr>
<td>143.2.</td>
<td>Applying the animated bump map</td>
</tr>
<tr>
<td>144.</td>
<td>Normal Mapping</td>
</tr>
<tr>
<td>145.</td>
<td>Texture Normals</td>
</tr>
<tr>
<td>145.1.</td>
<td>The Texture-Normal</td>
</tr>
<tr>
<td>146.</td>
<td>Color Map Normals</td>
</tr>
<tr>
<td>146.1.</td>
<td>The Color-Map-Normal</td>
</tr>
<tr>
<td>146.2.</td>
<td>Creating a Normal Map</td>
</tr>
<tr>
<td>147.</td>
<td>Introduction</td>
</tr>
<tr>
<td>148.</td>
<td>Texture Nodes</td>
</tr>
<tr>
<td>148.1.</td>
<td>A Simple “Rainbow” Texture</td>
</tr>
<tr>
<td>148.2.</td>
<td>Scalars Versus Vectors</td>
</tr>
<tr>
<td>149.</td>
<td>Material Nodes</td>
</tr>
<tr>
<td>149.1.</td>
<td>A Simple Graduated Material</td>
</tr>
</tbody>
</table>
150. Compositing 1125
  150.1. Compositing Example ........................................ 1125
  150.2. Things to Try .................................................. 1131
  150.3. Other Tutorials ................................................ 1132

151. Further Compositing: A Portal Effect 1133
  151.1. The Outer Scene ................................................ 1134
  151.2. Animating The Camera ........................................ 1135
  151.3. The Inner Scene ............................................... 1137
  151.4. Inner Scene Animation ........................................ 1139
  151.5. Compositing It All Together ................................ 1140
  151.6. More On Lighting ............................................. 1143

152. Advanced Rendering 1145

153. Alternative Renderers 1147
  153.1. Cycles ............................................................ 1147
  153.2. Freestyle ........................................................ 1148
  153.3. External Renderers ........................................... 1148

154. Disadvantages of Other Renderers 1149
  154.1. Say Goodbye to Your Materials and Lighting .............. 1149
  154.2. High-Quality Renderers Are S-L-O-W ....................... 1149

155. Introduction to Cycles 1151
  155.1. A Simple Cycles Example ...................................... 1152
  155.2. Real-Time Rendering Previews ............................... 1165
  155.3. Nodes? What Nodes? .......................................... 1167
  155.4. See Also ....................................................... 1167

156. A Glass Material in Cycles 1169
  156.1. The Magic Sky ................................................ 1171
  156.2. Here Comes The Glass ........................................ 1180
  156.3. Adjustable Refraction ....................................... 1188
  156.4. A Reusable Custom Shader .................................. 1188

157. Dealing with Fireflies in Cycles 1195
  157.1. Making An Example .......................................... 1196
  157.2. Fixing The Problem 1: Renderer Tweaks ...................... 1202
  157.3. Fixing The Problem 2: The Despeckle Filter ............... 1204

158. Fireflies in Cycles, Continued 1211
  158.1. Finer Despeckling: Separate Lighting Passes ............. 1211
  158.2. Conclusion .................................................... 1225
  158.3. See Also ....................................................... 1225

159. Procedural Eyeball in Cycles 1227
  159.1. Creating the Mesh ........................................... 1227
  159.2. UV-Mapping the Iris ........................................ 1232
159.3. Creating the Materials ................................................. 1233
159.4. The Final Result ....................................................... 1237

160. Introduction to Freestyle ........................................... 1239
  160.1. A Simple Freestyle Example .................................... 1239
  160.2. See Also .......................................................... 1244

161. Overview ............................................................... 1245

162. Introduction ........................................................... 1247

163. Guided Tour: ............................................................. 1249

164. Armature Object ......................................................... 1251

165. Armature Object in Object Mode .................................. 1253
  165.1. The Armature Object ............................................. 1253
  165.2. The Edit Panel When in Object Mode ......................... 1255
  165.3. Extra Practice ..................................................... 1264

166. Armature Object in Edit Mode ..................................... 1265
  166.1. Now the basics about bones .................................... 1266
  166.2. The edit panel .................................................... 1267
  166.3. Naming convention ................................................ 1273
  166.4. Mirror Editing .................................................... 1274

167. Armature Object in Pose mode .................................... 1277
  167.1. So What Can You Do? ............................................. 1277

168. Mesh Object ............................................................ 1283

169. Connection between Armature and Mesh ..................... 1285
  169.1. The Armature Modifier ......................................... 1285
  169.2. The Old Way ..................................................... 1286
  169.3. Tip: Bake envelope to vertex groups ....................... 1287

170. Envelope ............................................................... 1289
  170.1. What is Envelope ................................................ 1289
  170.2. Edit Envelope .................................................... 1290
  170.3. Envelope Options ............................................... 1291

171. Vertex Groups & Weight Paint .................................. 1295
  171.1. What Are Vertex Groups? ..................................... 1295
  171.2. Weight Paint ..................................................... 1296
  171.3. Vertex Groups and Armatures ............................... 1299
  171.4. Using Weight Painting with Armatures .................... 1300

172. Shape Keys ............................................................. 1305
  172.1. Shape Key? ....................................................... 1305
  172.2. The GUI .......................................................... 1308

XX
183. Timeline Window 1355
   183.1. Timeline Window 1355

184. IPO Window 1357
   184.1. IPO Window 1357

185. Data Type 1359
   185.1. IPO Data Type 1359

186. NLA Window 1361

187. (about this placeholder) 1363

188. The NLA Window 1365
   188.1. Forum Notes 1365
   188.2. Walkthrough 1365

189. Introduction To NLA Editor 1369
   189.1. NLA (Non-Linear Animation) 1369
   189.2. Setting up the Scene 1369
   189.3. Adding Action Strips 1370
   189.4. Getting the Strips to Play 1372
   189.5. Conclusion 1374

190. The Stride feature 1375

191. Relative Vertex Keys 1377
   191.1. Introduction: 1377
   191.2. Window Layout: 1377
   191.3. Setting your Neutral Pose 1377
   191.4. Setting up your additional Pose Lines 1377
   191.5. Set your Poses 1377
   191.6. Name your Poses 1378
   191.7. Time to Animate (b) 1378
   191.8. Adjust your Slow in & Out 1378

192. Working Example: Bob 1379
   192.1. Getting Started 1379

193. Building the Rig 1381

194. Deform the Mesh 1385

195. Create a Walk Cycle 1387

196. Working example: Piston, Rod and Crank 1389
   196.1. Piston, Rod and Flywheel 1389
   196.2. Links 1397
## 197. Working example: Cutting Through Steel 1399

- 197.1. Creating the Alpha-Map .......................... 1400
- 197.2. Welding sparks .................................. 1403
- 197.3. Using the alpha map on an object ............... 1404
- 197.4. Material for the plane ........................... 1407
- 197.5. Lighting the torch ................................ 1409
- 197.6. More realistic sparks ............................. 1410
- 197.7. Smoke ............................................. 1411
- 197.8. After Glow ........................................ 1414
- 197.9. Links .............................................. 1416

## 198. Overview 1417

## 199. Advanced Game Engine Techniques (GUI) 1419

- 199.1. Making Blender Games Graphically ............... 1419

## 200. Creating Pop-Up Menus 1421

- 200.1. Making An Easy Title Menu ....................... 1421
- 200.2. Author’s Starting Menu Example .................. 1423
- 200.3. A Main Menu ..................................... 1424

## 201. Creating Dropping Menus 1429

- 201.1. Making Moving Selectors .......................... 1429
- 201.2. Make the Menu Move .............................. 1433

## 202. The ”5-Layer” Button 1435

- 202.1. Scheduled Construction .......................... 1435

## 203. Creating Object Outlines 1437

- 203.1. Scheduled Construction .......................... 1437

## 204. Advanced Game Engine Techniques (Python) 1439

- 204.1. Needs Expert ..................................... 1439
- 204.2. Additional Resources ............................. 1439
- 204.3. External Links ................................... 1439

## 205. Hacking Blender 1441

- 205.1. Getting the Blender Source Code .................. 1441
- 205.2. Layout of the Blender Source ..................... 1442
- 205.3. Blender’s “Genetic Code”: “DNA” and “RNA” .......... 1444
- 205.4. Special Globals: “G” and “U” ...................... 1444
- 205.5. Naming Conventions .............................. 1444
- 205.6. User-Interface Implementation ..................... 1445
- 205.7. See Also ........................................ 1445

## 206. Introduction to Game Engine Source 1447

V. Appendices 1449
### VI. Reference Material  

1451

#### 207. Glossary

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>207.1. A</td>
<td>1453</td>
</tr>
<tr>
<td>207.2. B</td>
<td>1453</td>
</tr>
<tr>
<td>207.3. C</td>
<td>1454</td>
</tr>
<tr>
<td>207.4. D</td>
<td>1455</td>
</tr>
<tr>
<td>207.5. E</td>
<td>1455</td>
</tr>
<tr>
<td>207.6. F</td>
<td>1455</td>
</tr>
<tr>
<td>207.7. G</td>
<td>1456</td>
</tr>
<tr>
<td>207.8. H</td>
<td>1456</td>
</tr>
<tr>
<td>207.9. I</td>
<td>1456</td>
</tr>
<tr>
<td>207.10. J</td>
<td>1457</td>
</tr>
<tr>
<td>207.11. K</td>
<td>1457</td>
</tr>
<tr>
<td>207.12. L</td>
<td>1458</td>
</tr>
<tr>
<td>207.13. M</td>
<td>1458</td>
</tr>
<tr>
<td>207.14. N</td>
<td>1458</td>
</tr>
<tr>
<td>207.15. O</td>
<td>1459</td>
</tr>
<tr>
<td>207.16. P</td>
<td>1459</td>
</tr>
<tr>
<td>207.17. Q</td>
<td>1460</td>
</tr>
<tr>
<td>207.18. R</td>
<td>1460</td>
</tr>
<tr>
<td>207.19. S</td>
<td>1461</td>
</tr>
<tr>
<td>207.20. T</td>
<td>1462</td>
</tr>
<tr>
<td>207.21. U</td>
<td>1462</td>
</tr>
<tr>
<td>207.22. V</td>
<td>1463</td>
</tr>
<tr>
<td>207.23. W</td>
<td>1463</td>
</tr>
<tr>
<td>207.24. X</td>
<td>1463</td>
</tr>
<tr>
<td>207.25. Y</td>
<td>1463</td>
</tr>
<tr>
<td>207.26. Z</td>
<td>1463</td>
</tr>
</tbody>
</table>

#### 208. Frequently Asked Questions

1465

#### 209. Tutorial Links List

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>209.1. General Blender Information</td>
<td>1467</td>
</tr>
<tr>
<td>209.2. Blender Tutorial Websites</td>
<td>1467</td>
</tr>
<tr>
<td>209.3. Blender Interface</td>
<td>1469</td>
</tr>
<tr>
<td>209.4. Modeling</td>
<td>1469</td>
</tr>
<tr>
<td>209.5. Texturing</td>
<td>1471</td>
</tr>
<tr>
<td>209.6. Lighting, Shadows and Rendering</td>
<td>1472</td>
</tr>
<tr>
<td>209.7. Compositing</td>
<td>1473</td>
</tr>
<tr>
<td>209.8. Animation</td>
<td>1473</td>
</tr>
<tr>
<td>209.9. Particles</td>
<td>1473</td>
</tr>
<tr>
<td>209.10. Fluid Simulation</td>
<td>1474</td>
</tr>
<tr>
<td>209.11. Game Engine</td>
<td>1474</td>
</tr>
<tr>
<td>209.12. Python and Plugins</td>
<td>1475</td>
</tr>
<tr>
<td>209.13. Related Programs</td>
<td>1476</td>
</tr>
<tr>
<td>209.15. FAQ</td>
<td>1477</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>209.16. Miscellaneous</td>
<td>1477</td>
</tr>
<tr>
<td>209.17. Other Lists</td>
<td>1478</td>
</tr>
<tr>
<td>209.18. About</td>
<td>1478</td>
</tr>
<tr>
<td>210. Hotkeys</td>
<td>1479</td>
</tr>
<tr>
<td>211. Output Formats</td>
<td>1481</td>
</tr>
<tr>
<td>212. Image Portfolio</td>
<td>1483</td>
</tr>
<tr>
<td>212.1. Summary</td>
<td>1483</td>
</tr>
<tr>
<td>212.2. Categories</td>
<td>1483</td>
</tr>
<tr>
<td>212.3. A sampling of images from the above categories</td>
<td>1483</td>
</tr>
<tr>
<td>213. Blender Glossary</td>
<td>1527</td>
</tr>
<tr>
<td>214. Materials Directory: Every Material Known To Man</td>
<td>1531</td>
</tr>
<tr>
<td>215. Sources of free 3D models</td>
<td>1533</td>
</tr>
<tr>
<td>215.1. Blender-Specific</td>
<td>1533</td>
</tr>
<tr>
<td>215.2. Non-Blender-Specific</td>
<td>1533</td>
</tr>
<tr>
<td>216. All Blueprints Links</td>
<td>1537</td>
</tr>
<tr>
<td>216.1. Registration Required</td>
<td>1537</td>
</tr>
<tr>
<td>216.2. Payment Required</td>
<td>1537</td>
</tr>
<tr>
<td>216.3. Shouldn’t Really Be Here?</td>
<td>1537</td>
</tr>
<tr>
<td>217. Materials, Textures, Photos</td>
<td>1539</td>
</tr>
<tr>
<td>VII. Advice</td>
<td>1541</td>
</tr>
<tr>
<td>218. Asking for Help</td>
<td>1543</td>
</tr>
<tr>
<td>219. Tips for a Successful Project</td>
<td>1545</td>
</tr>
<tr>
<td>220. Modeling Realistically</td>
<td>1547</td>
</tr>
<tr>
<td>220.1. Assemble Things, Don’t Chisel Them</td>
<td>1547</td>
</tr>
<tr>
<td>220.2. Separate Objects for each Material</td>
<td>1548</td>
</tr>
<tr>
<td>220.3. Removing the Fourth Wall</td>
<td>1549</td>
</tr>
<tr>
<td>220.4. Proportions and Measurements</td>
<td>1549</td>
</tr>
<tr>
<td>221. Modeling tips</td>
<td>1551</td>
</tr>
<tr>
<td>222. Cheat the 3D</td>
<td>1553</td>
</tr>
<tr>
<td>222.1. Ways to Improve Performance</td>
<td>1553</td>
</tr>
<tr>
<td>223. Performance vs. Quality</td>
<td>1555</td>
</tr>
</tbody>
</table>
235.3. The finishing touch ................................................. 1626
235.4. External links ....................................................... 1626

236. Modeling a picture ..................................................... 1629
   236.1. Modeling a picture ................................................ 1629
   236.2. Printing a Rendered Image ...................................... 1630

237. Modeling with the Spin Tool .......................................... 1631

238. Spin Tool Introduction ................................................. 1633
   238.1. How the Spin Tool Works ....................................... 1633
   238.2. Typical Work Flow .............................................. 1634
   238.3. Post Modeling .................................................... 1651

239. Illustrative Example: Model a Wine Glass ......................... 1653
   239.1. Model half the outline .......................................... 1653
   239.2. Spinning the outline ........................................... 1654
   239.3. Cleaning up the Mesh ........................................... 1657

240. Illustrative Example: Model a Mug .................................... 1659

241. Creating Ogg-Theora movies using Blender ....................... 1661
   241.1. Converting saved frame picture files to Ogg Theora ........... 1661
   241.2. Converting AVIs to Ogg Theora ................................ 1661

242. Creating animated GIFs using Blender and Gimp .................. 1663

243. 3D Tiling Backgrounds For The Web .................................. 1665
   243.1. Overview ....................................................... 1665
   243.2. Create The Object You Wish To Tile ......................... 1665
   243.3. Specify Your Tiling Area ...................................... 1666
   243.4. Tile Away! ...................................................... 1668
   243.5. Camera Settings ............................................... 1673
   243.6. Lighting & Materials ........................................... 1674
   243.7. Rendering ...................................................... 1674
   243.8. Shopping ....................................................... 1675

244. Cool Things That Aren't That Obvious in Blender .................. 1679
   244.1. Attribution ..................................................... 1679
   244.2. File Browser Functions ........................................ 1679
   244.3. Object/Vertex Manipulation ................................... 1680
   244.4. Working with Meshes ........................................... 1686
   244.5. Animation ...................................................... 1687
   244.6. UV Mapping, Particles and Texturing ....................... 1687
   244.7. Rendering ...................................................... 1689
   244.8. Miscellaneous .................................................. 1692
   244.9. ???. ........................................................... 1693
   244.10. Sculpt Mode Hotkeys .......................................... 1693
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>245. Troubleshooting</td>
<td>1695</td>
</tr>
<tr>
<td>246. Creating Blender Libraries</td>
<td>1697</td>
</tr>
<tr>
<td>246.1. How to Make a Library</td>
<td>1697</td>
</tr>
<tr>
<td>246.2. Library Usefulness Checklist</td>
<td>1698</td>
</tr>
<tr>
<td>246.3. Publishing Your Library</td>
<td>1699</td>
</tr>
<tr>
<td>246.4. Beyond Libraries</td>
<td>1699</td>
</tr>
<tr>
<td>246.5. Thank You</td>
<td>1699</td>
</tr>
<tr>
<td>247. Add some depth with stereo</td>
<td>1701</td>
</tr>
<tr>
<td>247.1. The stereo camera</td>
<td>1701</td>
</tr>
<tr>
<td>247.2. Stereo viewing with the rig</td>
<td>1704</td>
</tr>
<tr>
<td>247.3. Stereo rendering</td>
<td>1704</td>
</tr>
<tr>
<td>248. Ways to create a &quot;fluffy&quot; effect (materials and lights)</td>
<td>1709</td>
</tr>
<tr>
<td>248.1. Spherical Blend Texture</td>
<td>1709</td>
</tr>
<tr>
<td>248.2. Backlighting</td>
<td>1710</td>
</tr>
<tr>
<td>249. Human Body</td>
<td>1715</td>
</tr>
<tr>
<td>250. Rendering Information</td>
<td>1719</td>
</tr>
<tr>
<td>251. Using Blender Libraries</td>
<td>1721</td>
</tr>
<tr>
<td>251.1. Indirect linking</td>
<td>1721</td>
</tr>
<tr>
<td>251.2. Groups</td>
<td>1721</td>
</tr>
<tr>
<td>251.3. See also</td>
<td>1722</td>
</tr>
<tr>
<td>252. Beginning Modeling Final Project</td>
<td>1723</td>
</tr>
<tr>
<td>253. Using Inkscape to make advanced Bezier curves</td>
<td>1725</td>
</tr>
<tr>
<td>253.1. Introduction to Inkscape</td>
<td>1725</td>
</tr>
<tr>
<td>253.2. Getting Started</td>
<td>1725</td>
</tr>
<tr>
<td>254. Light Mapping</td>
<td>1733</td>
</tr>
<tr>
<td>254.1. Needs Expert</td>
<td>1733</td>
</tr>
<tr>
<td>255. Platonic Solids</td>
<td>1735</td>
</tr>
<tr>
<td>255.1. External Link</td>
<td>1736</td>
</tr>
<tr>
<td>256. Modeling techniques and Workflow</td>
<td>1737</td>
</tr>
<tr>
<td>257. Polygonal Modeling</td>
<td>1739</td>
</tr>
<tr>
<td>258. Box Modeling</td>
<td>1741</td>
</tr>
<tr>
<td>258.1. Before We Start</td>
<td>1741</td>
</tr>
<tr>
<td>258.2. The Work Flow</td>
<td>1741</td>
</tr>
<tr>
<td>259. Illustrative example: Model a Chair (Swan Chair)</td>
<td>1745</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>260. Model a Chair-Preparations</td>
<td>1747</td>
</tr>
<tr>
<td>260.1. Knowing our model</td>
<td>1747</td>
</tr>
<tr>
<td>260.2. Loop study</td>
<td>1747</td>
</tr>
<tr>
<td>261. Model a Chair-The Seat</td>
<td>1751</td>
</tr>
<tr>
<td>261.1. Start with a Primitive</td>
<td>1751</td>
</tr>
<tr>
<td>261.2. Rough it out</td>
<td>1751</td>
</tr>
<tr>
<td>261.3. Adding More Details</td>
<td>1762</td>
</tr>
<tr>
<td>262. Model a Chair-The Feet</td>
<td>1775</td>
</tr>
<tr>
<td>262.1. Starting Primitive</td>
<td>1775</td>
</tr>
<tr>
<td>262.2. The Upper Telescope</td>
<td>1776</td>
</tr>
<tr>
<td>262.3. The Lower Telescope</td>
<td>1779</td>
</tr>
<tr>
<td>262.4. The Stops</td>
<td>1790</td>
</tr>
<tr>
<td>262.5. The Whole Chair</td>
<td>1800</td>
</tr>
<tr>
<td>263. Illustrative Example: Modeling a Simple Human Character</td>
<td>1803</td>
</tr>
<tr>
<td>264. Modeling a Human Character - Preparations</td>
<td>1805</td>
</tr>
<tr>
<td>265. Modeling a Human Character - Modeling</td>
<td>1807</td>
</tr>
<tr>
<td>266. Blocking the Figure</td>
<td>1809</td>
</tr>
<tr>
<td>267. Detailing and Finishing</td>
<td>1817</td>
</tr>
<tr>
<td>268. Illustrative Example: Model a Car (Box)</td>
<td>1825</td>
</tr>
<tr>
<td>269. Illustrative Example: Model a Dragon</td>
<td>1827</td>
</tr>
<tr>
<td>270. Polygon by Polygon modeling</td>
<td>1829</td>
</tr>
<tr>
<td>270.1. Before we start</td>
<td>1829</td>
</tr>
<tr>
<td>270.2. The Workflow</td>
<td>1830</td>
</tr>
<tr>
<td>271. Illustrative Example: Model a Woman Face</td>
<td>1837</td>
</tr>
<tr>
<td>272. Illustrative Example: Model a Car (Polygon-By-Polygon)</td>
<td>1839</td>
</tr>
<tr>
<td>273. Blocking with Primitives</td>
<td>1841</td>
</tr>
<tr>
<td>274. Animation Notes and FAQ</td>
<td>1843</td>
</tr>
<tr>
<td>274.1. Blender 3D: Animation Notes and FAQ</td>
<td>1843</td>
</tr>
<tr>
<td>274.2. IMPORTANT</td>
<td>1843</td>
</tr>
<tr>
<td>274.3. Authors &amp; Contributors</td>
<td>1843</td>
</tr>
<tr>
<td>274.4. Introduction</td>
<td>1843</td>
</tr>
<tr>
<td>274.5. Todo List</td>
<td>1844</td>
</tr>
<tr>
<td>274.6. Animation FAQ</td>
<td>1844</td>
</tr>
<tr>
<td>274.7. Armatures</td>
<td>1844</td>
</tr>
<tr>
<td>274.8. Hotkeys</td>
<td>1844</td>
</tr>
<tr>
<td>274.9. Approaches, Techniques, Tips and Tricks</td>
<td>1845</td>
</tr>
</tbody>
</table>
Part I.

Unit 1: Background
1. Knowing before Making

Blender is a powerful and complex 3D modeling and rendering package. Before you can use it effectively to make things, you need to know a few things about how it works:

- the process of 3D modeling and rendering (what Blender does)
- some rudiments of 3D analytic geometry (axes and coordinates)
- orthographic and perspective views of a 3D object
- local coordinate systems and child objects
- the fundamentals of Blender’s user interface (hotkeys, windows, and menus)
- how to view a 3D scene from different vantage points (in Blender)

This unit is entirely devoted to this sort of background knowledge. You won’t create your first Blender model until the next unit.

Knowing this, you might be tempted to skip ahead. Depending on your background, this might or might not work. For instance, if you’ve used other 3D graphics packages, you might be able to skim (or skip) ahead as far as the user interface tutorial. But if there’s any doubt, please proceed through the tutorials in sequence.

Blender is not the kind of software you can launch into and grope about until you find your way. It’s not like exploring an unfamiliar city. It’s more like flying a spaceship. If you hop into the pilot’s seat without knowing the fundamentals, you’ll be lucky to ever get off the ground, and it’d take a miracle for you to reach your destination safely.

1.0.1. A Word about Jargon

Like any subject, 3D modeling has its own jargon: terminology specific to the subject and ordinary words that have special meanings in the context of computer graphics.

In this book, important new words are highlighted on first appearance and defined soon after. If you suspect you’ve missed (or forgotten) the meaning of a word, try looking it up in the Glossary.

1.0.2. Things You’ll Need

In order to work through the tutorials, you’ll need access to a computer that has Blender installed (download the latest stable release).
Depending on what is installed on your system you may also need the appropriate Python installation. Each version of Blender works only with one specific version of Python, which is generally included in the download.

<table>
<thead>
<tr>
<th>Blender version</th>
<th>Python version</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.49</td>
<td>2.6</td>
</tr>
<tr>
<td>2.5x</td>
<td>3.2</td>
</tr>
<tr>
<td>2.6</td>
<td>3.3</td>
</tr>
</tbody>
</table>

Since Blender is open-source software, you can download the source code and build it yourself, but it’s easier to download a pre-built install package. Install packages are provided for each supported operating system:

- Microsoft Windows (32-bit and 64-bit)
- Linux (32-bit and 64-bit x86)
- Apple Mac OS X (PowerPC and Intel)
- FreeBSD (32-bit and 64 bit)
- Solaris
- Irix

For example, to install Blender on a Debian-based GNU/Linux distribution (such as Ubuntu), you can enter the following command into the terminal:

```bash
sudo apt-get update && sudo apt-get upgrade && sudo apt-get install blender
```

Windows users get to choose between an executable installer ("setup wizard") and a ZIP archive.

Once that finishes, Blender should appear in the Graphics section of your desktop environment’s application menu.

You may also want to download a 2D image editor, such as GIMP (http://www.gimp.org/downloads), Paint.NET (http://www.getpaint.net/), or Photoshop. For viewing video files, you may want to install VLC (http://www.videolan.org/vlc/index.html) media player.

It’s also a good idea to have pencil and paper handy for sketching and taking notes. There’s a lot to absorb. Taking notes as you go will pay dividends later.

### 1.0.3. Where to Go for Help

In case you get stuck, you can ask for help from other Blender users\(^3\) in the appendices\(^4\).

---

\(^3\) Chapter 218 on page 1543  
\(^4\) http://en.wikibooks.org/wiki/%2F%23Appendices
1.1. Additional Resources

Many modules have a section like this at the bottom, listing websites with information on the topics covered in the module.

- Blender system requirements\(^5\)
- the *GIMP*\(^6\) wikibook
- Windows installation\(^7\)
- Linux installation\(^8\)
- OSX installation\(^9\)
- About the Python programming language\(^{10}\)

---

5  http://www.blender.org/features-gallery/requirements/
6  http://en.wikibooks.org/wiki/GIMP
10 http://www.python.org/about/
2. What Blender Can Do

In this module, you’ll learn what Blender does, both in terms of the product (images) and the process (3D modeling).

Blender is a free software\textsuperscript{1} package for authoring “three-dimensional” (3D) graphics (also known as \textit{computer graphics} or “CG”), including still images, games, and video.

While the end-product of most Blender projects is a two-dimensional (2D) raster image on a flat surface (be it a monitor, movie screen, or sheet of paper), the images are said to be "3D" because they exhibit the \textbf{illusion of depth}. In other words, someone looking at the image can easily tell which parts are meant to be closer and which are farther away.

2.1. An Example

Here’s a realistic still image that was authored with Blender.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{A_Lonely_House}
\caption{"A Lonely House", by Mayqel}
\end{figure}

\begin{footnote}
\textsuperscript{1} \url{http://en.wikipedia.org/wiki/free\%20software}
\end{footnote}
Look closely at the building.

• Because it is obscured by the building, you can tell that the tree-lined hillside is behind the building instead of vice versa.
• The way the top and bottom edges of the front wall appear to converge toward the base of the tree allow you to judge the angle between the front wall and your viewpoint.
• Your brain interprets dark portions of the wall as shadows, allowing you to estimate where the light is coming from, even though the sun is outside the frame of the image.

While an illusion of depth can be authored by hand with 2D graphics software (or a paintbrush!), Blender provides a much easier way.

It’s likely that the lonely house never existed outside of the artist’s mind. Instead of building a big set on a rural lot in Germany, waiting for the right light, and photographing it, the author built a scene in a virtual 3D world—one contained inside a computer. He or she then used Blender to render the scene (convert it into a 2D image). You can view more of what Blender can do at the Blender gallery: http://www.blender.org/features/

2.2. Steps in the 3D Production Process

To produce an image like the one above involves two major steps to start with:

• Modelling, which is the creation of your little 3D world, also known as a model or scene. This involves defining the geometry of the objects, making it look like they are made out of particular materials, setting up the lighting, and defining a camera viewpoint.
• Rendering, which is the actual generation of the image of the world from the viewpoint of the camera (taking a “photograph” of the scene, if you like), for your audience to enjoy.

3D is often used to produce not just single still images, but animations as well. This requires some additional steps:

• Rigging — setting up a rig, namely a way of deforming (changing the shape of) a character in various repeatable ways to convincingly mimic joint movements, facial expressions and other such actions of real-life people or animals.
• Posing — choreographing the positions of the objects and their parts in the 3D scene over time, using the previously-created animation rigs
• Rendering now involves creating a whole sequence of frames representing movement over time, rather than just a single still frame.

But that’s not all. There are frequently additional processes to embellish the results of the above, to make them look more realistic:

• Sculpting — a more organic form of modelling objects by shaping them as though they were made out of clay. This produces more complicated, irregular shapes which mimic real objects found in nature, as opposed to clean, simple, geometrical ones which mostly only exist in the world of mathematics.
• Texture painting — You’re probably familiar with programs that let you paint an image on a 2D digital canvas. Such programs are commonly used in 3D production, to create textures which are “wrapped” around the surfaces of 3D objects to give them a more
Steps in the 3D Production Process

interesting appearance. 3D programs also often allow direct painting on the surfaces of those objects, so the effect of the design can be observed immediately, instead of having to go through a separate paint-on-a-flat-surface-then-wrap sequence of steps.

- **Physical modelling** — simulating the behaviour of real-world objects subject to real-world forces, for example hard balls colliding, soft cloth draping itself over an obstacle under gravity, water flowing and pouring. Mathematical formulas are available for these that give results very close to real life, all you need is the computing power to calculate them.

- **Motion capture**, or *mocap*: producing convincing animations, particularly ones that look like the movements of real people (walking, running, dancing etc) can be hard. Hence the technique of capturing the motions of live actors, by filming them with special markers attached to strategic points on their bodies, and doing computer processing to track the movements of these markers and convert them to corresponding movements of an animation rig.

- **Compositing** — this is where 3D renders are merged together with real photographic/live-action footage, to make it look like a rendered model is in the middle of a real-world scene, or conversely a real live actor is in the middle of a rendered scene. If done with proper skill, in particular due care to matching the effects of lights and shadows, the viewer becomes unable to tell what is real and what is not!

And just to add another complication to the mix, there are two kinds of rendering:

- **Real-time** rendering is rendering that has to happen under tight time constraints, typically for interactive applications like video gaming. For example, most gamers nowadays consider that the screen has to be updated 60 times per second in order to render smooth motion and respond quickly enough to player actions. These time constraints impose major limitations on the kinds of rendering techniques that can be used.

- **Non-real-time** rendering is where the time constraints are not so tight, and quality is the overriding factor. For example, when producing a single still frame, it may not matter so much that it takes minutes or hours to do so, because the beauty and detail of the final image is worth it. When rendering a Hollywood-quality movie, it may still take hours per frame, but the use of a *renderfarm* of hundreds or thousands of machines, all working on different frames at the same time, allows the entire sequence to complete in just a few weeks.

**But wait, there’s more:** There are also some areas, which might be considered to be stepping outside of traditional 3D production work, where Blender provides functionality:

- **Video editing** — having rendered your animation sequences and shot your live-action footage, you will want to combine them in a properly-timed linear sequence to tell a coherent story.

- **3D printing**[^3dprinting] — Though still in its early days yet, many people are already experimenting with creating objects using 3D printers. The shape data may be obtained from real objects with 3D scanning, or it may be created from scratch using 3D modelling, or you can even combine both processes.

Blender is a capable tool for every single one of these processes. There’s quite a lot there, isn’t there? But don’t be too intimidated: this Wikibook will take things step by step, and you will be able to produce some fun stuff from early on.

2.3. Additional Resources

- w:3D rendering\(^3\)
- w:Comparison of 3D computer graphics software\(^4\)
- w:Computer-generated imagery\(^5\)
- w:Depth perception\(^6\)
- Blender Art Gallery\(^7\)
- Blender Homepage\(^8\)

---

4 [http://en.wikipedia.org/wiki/Comparison%20of%203D%20computer%20graphics%20software](http://en.wikipedia.org/wiki/Comparison%20of%203D%20computer%20graphics%20software)
8 [http://www.blender.org/](http://www.blender.org/)
3. **3D Geometry**

If you haven’t previously studied 3D graphics, technical drawing, or analytic geometry, you are about to learn a new way of visualizing the world, an ability that’s fundamental to working with Blender or any 3D modeling tool.

3D modeling is based on **geometry**, the branch of mathematics concerned with spatial relationships, specifically **analytical geometry**, which expresses these relationships in terms of algebraic formulas. You may have studied geometry in school, in which case, some of the terminology will seem familiar.

3.1. **Coordinates And Coordinate Systems**

Look around the room you’re in. The odds are it will have a cuboidal shape, with four vertical walls at right angles to each other, a flat, horizontal floor, and a flat, horizontal ceiling.

Now imagine there’s a fly buzzing around the room. (If there really is a fly buzzing around, feel free to look at it instead of imagining.) The fly is moving in three-dimensional space. In mathematical terms, what that means is that, at any moment, its position within the room can be expressed in terms of a unique combination of three numbers.

Now, there are an infinite number of ways—**coordinate systems**—in which we could come up with a convention for defining and measuring these numbers—the **coordinates**. And each convention will give different values for the numbers, even if the fly is in the same position—coordinates only make sense with reference to a specific coordinate system! To narrow down the possibilities (in a purely arbitrary fashion, of course), let us label the walls of the room with the points of the compass: in a clockwise direction, North, East, South and West. (If you know which way is really north, feel free to use that to label the walls of your room; otherwise, choose any wall you like as north.)

Consider the south-west corner of your room, the point at floor level. We will call this (arbitrary) point the **origin** of our coordinate system, and the three numbers at this point will be $(0, 0, 0)$. The first of the three numbers will be the distance (in some suitable units, let’s say metres) eastwards from the west wall, the second number will be the distance northwards from the south wall, and the third number will be the height above the floor.

Each of these directions is called an **axis** (plural: **axes**), and they are conventionally labelled X, Y and Z, in that order. With a little bit of thought, you should be able to convince yourself that every point within the space of your room corresponds to exactly one set of $(x, y, z)$ values. And conversely that every possible combination of $(x, y, z)$ values, with $0 \leq x \leq W$, $0 \leq y \leq L$ and $0 \leq z \leq H$ (where $W$ is the east-west dimension of your room, $L$
is its north-south dimension, and $H$ is the height between ceiling and floor) corresponds to a point in the room.

The following diagram illustrates how the coordinates are built up, using the same colour codes that Blender uses to label its axes: red for X, green for Y and blue for Z (an easy way to remember this if you’re familiar with RGB is the order -- Red X, Green Y, Blue Z). In the second picture, the value for $x$ defines a plane parallel to the west wall of the room; in the third picture, the value for $y$ defines a plane parallel to the south wall; and in the fourth picture, the value for $z$ defines a plane parallel to the floor. Put the planes together in the fifth picture, and they intersect at a unique point.

This style of coordinate system, with the numbers corresponding to distances along perpendicular axes, is called *Cartesian coordinates*, named after René Descartes, the 17th-century mathematician who first introduced the concept. Legend has it that he came up with the idea after watching a fly buzzing around his bedroom!

There are other ways to define coordinate systems, for example by substituting direction angles in place of one or two of the distance measurements. These can be useful in certain situations, but usually all coordinate systems in Blender are Cartesian. However, switching between these coordinate systems is simple and easy to do in Blender.

### 3.1.1. Negative Coordinates

Can coordinate values be negative? Depending on the situation, yes. Here we are only considering points within our room. But supposing, instead of placing our origin in the bottom southwest corner, we put it in the middle of the room, halfway between the floor and ceiling. (After all, it is an arbitrary point, we can place it wherever we would like to, just as long as we all agree on where it is.) Now, remember that our X-coordinate is the distance *east* from the origin; How do we express the fact that a point lies *west* of the origin? Simple: We give it a negative X-coordinate. Similarly, points north of the origin have a positive Y-coordinate, while those south of it get a negative Y-coordinate; and those points above the origin get a positive Z-coordinate, while those below it get a negative Z-coordinate.

### 3.1.2. Handedness Of Coordinate Systems

It is conventional for most Cartesian coordinate systems to be *right-handed*. To see what this means, hold the thumb, index finger and middle finger of your right hand perpendicular to each other:
Now you can orient your hand so that the thumb points along the X-axis in the positive direction (direction of increasing coordinate numbers), the index finger along the positive Y-axis, and the middle finger along the positive Z-axis. Another way of looking at it is, if you placed your eye at the origin, and you could see the three arrows pointing in the directions of positive X, positive Y and positive Z as in Figure 1, the order X, Y, Z would go clockwise.
Yet another way to understand this is to make a fist with your right hand, with the fingers bent towards you. Stick out your thumb directly to the right (X). Now aim pointer finger straight up (Y). Finally make your middle finger pointing towards yourself (Z). This is looking down from above directly on top of origin.

3.2. Axes Of Rotation

Consider a spinning ball. Every point on it is moving, except the ones right in the middle: these form a line of stillness around which the rest of the ball spins. This line is called the axis of rotation.
More precisely, the axis of rotation of a rotating object over a period of time is a point or a line connecting points that do not change position while the object rotates, drawn when the observer assumes he/she does not change position relative to that object over time.

Conventionally, the direction of the axis of rotation is such that, if you place your eye looking in that direction, the rotation appears clockwise, as illustrated below, where the yellow arrow shows the rotational movement, while the purple one shows the rotation axis:

![Figure 5](image)

To remember this convention, hold your right hand in a thumbs-up gesture:
If the rotation follows the direction of the curled-up fingers, then the direction of the axis of rotation is considered to be the same as the direction which the thumb is pointing in.

This gesture is a different form of the right-hand rule and is sometimes called *the right-hand grip rule*, *the corkscrew-rule* or *the right-hand thumb rule*. From now on in this book, it will be referred to as 'the right-hand grip rule'.

When describing the direction of a rotating object, do not say that it rotates *left-to-right/clockwise*, or *right-to-left/counterclockwise*. Each of these claims on their own are useless, because they’re relative to the observer. Instead of saying this, find the direction of the axis of rotation and draw an arrow to represent it. Then people who know the right-

---

hand grip rule will be able to figure out what the direction of rotation of the object is, by using the rule when interpreting your drawing.

3.3. Additional Resources

- the *Geometry*² wikibook
- w:Analytic geometry³
- w:Cartesian coordinate system⁴
- w:Right-hand rule⁵
- w:Rotation⁶

---

⁴ [http://en.wikipedia.org/wiki/Cartesian%20coordinate%20system](http://en.wikipedia.org/wiki/Cartesian%20coordinate%20system)
4. Coordinate Transformations

4.1. Coordinate Transformations

A transformation is any kind of operation that changes coordinate values in some way. For example, if you pick up an object and move it to a different place in the room without changing its orientation, then the coordinates of each point on the object relative to the room are adjusted by an amount that depends on the distance and direction between the old and new positions; this is called a translation transformation.

If you simply turn the object around without moving it from its original location, then that’s called a rotation.
If the object were to get bigger or smaller, then that would be called a *scaling* transformation. In the real world, only a few objects can be scaled in this way—for example, a balloon can be inflated or deflated to a larger or smaller size, but a bowling ball cannot be re-sized. Regardless of what can and can’t be re-sized in the real world, any object can be scaled (re-sized) in the world of computer graphics. Scaling may be *uniform* (applying equally in all dimensions) or *non-uniform*.
4.2. Linear Transformations

The main kinds of coordinate transformations we’re concerned with here are called *linear transformations*. Lines that were straight before the transformation remain straight after; they do not turn into curves. For example, the following diagram illustrates three linear transformations applied to the square in the center: a scaling, a shear or skew transform, and a rotation, plus one transformation that isn’t linear, because it introduces curves where there were none before.
4.3. Multiple Transformations

It is possible to *concatenate* or *compose* a series of transformations. The resulting transformation can do a whole bunch of things in one operation—translation, rotation, scaling etc. However, the order of composition of the component transformations becomes important—in general, transformations are not *commutative*. For example, compare the result of moving our model a certain distance along the Y axis followed by rotating it about the X axis (If this doesn’t make sense, consider that the axes are fixed, they aren’t moving with the object. More on that later Global and local coordinates\(^1\):}

\(^1\) Chapter 7.1 on page 37
Figure 13  Translation followed by rotation

versus the result of doing the rotation first:
In some instances, three of the forms of transformation may be applied on a single object concurrently. Such a feature exists in Blender and is normally implemented in creating animations. Therefore, you can decide to pick up the object (first transformation - translation), twist it (second transformation - rotation), and, in a 3D modeling environment, increase the size of the object (third transformation - scaling).

4.4. Inverse Transformations

There is quite commonly a need to find the inverse of a transformation—that is, the opposite transformation that undoes its effect. For example, a rotation of $+45^\circ$ about the X axis is undone by a rotation of $-45^\circ$ around the same axis.

Inverses have many uses, one of which is to simplify the construction of certain kinds of transformations.

For example, it is easy to construct a rotation transformation about the X, Y or Z-axis of the coordinate system. But what about a rotation of $\Theta^\circ$ around an arbitrary axis? This can be made out of the following parts:

- a translation that makes the rotation axis pass through the origin.
- rotations about the Y and/or Z axes, as appropriate, so the rotation axis lies along the X axis.
- a rotation of $\Theta^\circ$ about the X axis.
- the inverse of the rotations that aligned the rotation axis with the X axis.
- the inverse of the translation that made the rotation axis pass through the origin.
Most of the transformations we deal with in 3D modelling have an inverse, but not all—see the next section for some that don’t.

4.5. Projections

Most of our display and output devices are not three-dimensional. Thus, three-dimensional images need to be projected onto a two-dimensional surface (like a display screen or a printed page) before we can see them.

There are two main ways to perform such projections. One is orthographic projection, where parallel lines are drawn from all points of the three-dimensional object until they intersect a plane representing the display surface:

![Orthographic Projection](image)

**Figure 15**

More on orthographic projections²

The other way is perspective projection, where the lines drawn are not parallel, but intersect at a point representing the location of the eye of the viewer:

² Chapter 5 on page 29
Figure 16

Projections are also linear transformations. But since they take a three-dimensional space and flatten it onto a two-dimensional surface, some information is lost. Which means these are non-invertible transformations; they cannot be undone, at least in a unique way—the depth information is gone.

More on perspective projections\(^3\)

The mathematics of perspective were first worked out in the 11th century by Alhazen\(^4\), and used to great effect by the Italian Renaissance painters four hundred years later.

\(^3\) Chapter 6 on page 33

\(^4\) http://en.wikipedia.org/wiki/Alhazen
5. Orthographic Views

Blender provides two different ways of viewing 3D scenes:

- orthographic view

and

- perspective view.

In order to use these views effectively, you need to understand their properties.

An orthographic view (or projection) of a 3D scene is a 2D picture of it in which parallel lines appear parallel. An additional property of such views is that all edges perpendicular to the view direction appear in proportion, at exactly the same scale.

Usually such views are aligned with the scene’s primary axes. Edges parallel to the view axis disappear; those parallel to the other primary axes appear horizontal or vertical. The commonly-used orthographic views are the front, side, and top views, though back and bottom views are possible.

Uniform scale makes orthographic views very useful when constructing 3D objects—not only in computer graphics, but also in manufacturing and architecture.

Here’s one way to think about orthographic views:

Imagine photographing a small 3D object through a telescope from a very great distance. There would be no foreshortening. All features would be at essentially the same scale, regardless of whether they were on the near side of the object or its far side. Given two (or preferably three) such views, along different axes, you could get an accurate idea of the shape of the object—handy for "getting the feel" of objects in a virtual 3D world where you’re unable to touch or handle anything!

5.1. Example

Here is a drawing of a staircase:
Figure 17  An isometric view of a staircase

and here are three orthographic views of the same staircase, each outlined in red:
Figure 18  Figure 1: Orthographic views of a staircase

The views are from the front, top, and left. Dashed lines represent edges that, in real life, would be hidden behind something, such as the left wall of the staircase. (Think of each view as an X-ray image.)

The leading edges of the steps are visible in both the front and top views. Note that they appear parallel and of equal length in 2D, just as they are in 3D reality.

5.2. Additional Resources

• w:Orthographic projection\(^1\)

\[^1\text{http://en.wikipedia.org/wiki/Orthographic\%20projection}\]
6. Perspective Views

As you know, the main reason for modeling 3D objects in Blender is to render images that exhibit the illusion of depth.

Orthographic views are great for building a house, but seriously flawed when it comes to creating realistic images of the house for use in a sales brochure. While a builder wants blueprints that are clear and accurate, a seller wants imagery that’s aesthetically pleasing, with the illusion of depth. Blender makes it easy to use tricks like perspective, surface hiding, shading, and animation to achieve this illusion.

How does perspective work?

The essence of perspective is to represent parallel edges (in a 3D scene) by edges (in the 2D image) that are not parallel. When done correctly, this produces foreshortening (nearby objects depicted at a larger scale than faraway ones) and contributes to the illusion of depth.

Perspective is challenging to draw by hand, but Blender does it for you, provided you give it a 3D model of the scene and tell it where to view the scene from.

If you’re confident that you understand perspective, you can skip the rest of this module and proceed to the "Coordinate Spaces in Blender" module.

Note:
Blender only does 3-point perspective, not 1-point or 2-point.
6.1. One-point Perspective

![Image of a cubic lattice or framework]

Figure 19  Figure 1: 1-Point Perspective.

Drawing classes teach several different kinds of perspective drawing: one-point perspective, two-point perspective, and three-point perspective. In this context, the word "point" refers to what artists call a *vanishing point*.

One-point perspective works when you’re looking at a 3D object head-on and it’s centered in your view.

Imagine looking down a straight and level set of train tracks. The tracks will appear to converge at a point on the horizon. This is the *vanishing point*.

The image on the right is a 2D image of a cubic lattice or framework. Like any cube, it has six square faces and twelve straight edges. In the 3D world, four of the edges are parallel to our line-of-sight; they connect the four corners of the nearest square to the corresponding corners of the farthest one. Each of these edges is parallel to the other three.

In the 2D image, those same four edges appear to converge toward a vanishing point, contributing to the illusion of a depth. Since this is one-point perspective, there is a single point of convergence at the center of the image.
6.2. Two-point Perspective

![Figure 20](image)

**Figure 20  Figure 2:** 2-Point Perspective.

Now the cube is at eye level, and you’re near one of its edges. Since you’re not viewing it face-on, you can’t draw it realistically using one-point perspective. The horizontal edges on your left appear to converge at a point on the horizon to the left of the cube, while those on the right converge to the right. To illustrate the cube with a good illusion of depth, you need two vanishing points.
6.3. Three-point Perspective

Now imagine that you’re above the cube near one of its corners. To draw this, you’d need three vanishing points, one for each set of parallel edges.

From this perspective, there are no longer any edges which appear parallel. The four vertical edges, the four left-right edges, and the four in-out edges each converge toward a different vanishing point.

6.4. Additional Resources

- w:Perspective (graphical)\(^1\)

\(^1\) http://en.wikipedia.org/wiki/Perspective%20%28graphical%29
We’ll start looking at how 3D scenes are represented in Blender.

As was explained in the “3D Geometry” module, Blender represents locations in a scene by their coordinates. The coordinates of a location consist of three numbers that define its distance and direction from a fixed origin. More precisely:

- The first (or x-) coordinate of the location is defined as its distance from the YZ plane (the one containing both the Y and Z axes). Locations on the +X side of this plane are assigned positive x-coordinates, and those on the -X side are given negative ones.
- Its second (or y-) coordinate is its distance from the XZ plane, with locations on the -Y side of this plane having negative y-coordinates.
- Its third (or z-) coordinate is its distance from the XY plane, with locations on the -Z side of this plane having negative z-coordinates.

Thus the origin (which lies at the junction of all three axes and all three planes) has coordinates (0, 0, 0).

### 7.1. Global and local coordinates

Blender refers to the coordinate system described above as the **global coordinate system**, though it’s not truly global—each scene has its own global coordinate system. Each global coordinate system has a fixed origin and a fixed orientation, but we can view it from different angles by moving a virtual camera through the scene and/or rotating the camera.

Global coordinates are adequate for scenes containing a single fixed object and scenes in which each object is merely a single point in the scene. When dealing with objects that move around (or multiple objects with sizes and shapes), it’s helpful to define a **local coordinate system** for each object, a coordinate system that can move with the object and follow the object around. The origin of an object’s local coordinate system is often called the **center of the object** even though it needn’t coincide with the geometrical center of the object.

3D objects in Blender are largely described using **vertices** (points in the object, singular form: **vertex**). The global coordinates of a vertex depend on:

- the (x, y, z) coordinates of the vertex in the object’s **local** coordinate system
- the location of the object’s center
• any rotation (turning) of the local coordinate system relative to the global coordinate system, and
• any scaling (magnification or reduction) of the local coordinate system relative to the global coordinate system.

For example, the teacup in Figure 1 is described by a mesh model containing 171 vertices, each having a different set of local (x, y, z) coordinates relative to the cup’s center. If you translate the cup (move it without rotating), the only bits of the model that have to change are the global coordinates of the center; the local coordinates of all its vertices would remain the same.

7.1.1. Coordinates of child objects

Any object can act as a parent for one or more other objects in the same scene, which are then referred to as its children. (An object cannot have more than one direct parent, but parent objects may themselves be the children of other objects.)

If an object has a parent, its position, rotation, and scaling are measured in the parent’s local coordinate system, almost as if it were a vertex of the parent. That is to say, the position of the child’s center is measured from the parent’s center instead of the origin of the global coordinate system. So if you move a parent object, its children move too, even though the children’s coordinates have not changed. The orientation and scaling of a child’s
Viewcoordinates and Projection Plane

Figure 24 Figure 2: View coordinates and Projection Plane
Coordinate Spaces in Blender

Taking the viewer of the scene into consideration, there is another coordinate space: the view coordinates. In Fig. 2 the viewer is symbolized by the camera. The Z axis of the view coordinates always points directly to the viewer in orthographic projection. The X axis points to the right, the Y axis points upwards (Fig. 3).

In fact you always work in view coordinates if you don’t set it any other way.* This is particularly handy if you have aligned your view prior to modeling something, e.g. if an object has a slanted roof and you want to create a window to fit in this roof, it would be very complicated to build this window aligned to the local coordinate system of the object, but if you first align your view to the slanted roof you can easily work in this view coordinate system.

(* In the Blender 2.6 series, the default has been changed to global coordinates. View coordinates remain as an option.)

If you work in one of the three standard views (Front/Top/Side) the alignment of the view coordinates fits the global coordinates; therefore it is quite natural to model in one of the standard views and many people find this the best way to model.

7.3. Normal Coordinates

Although Blender is a 3D program, only the faces are visible. The orientation of the faces is important for many reasons. For example, in our daily lives it seems quite obvious that a book lies flat on a table. This requires the surface of the table and that of the book to be parallel to each other. If we put a book on a table in a 3D program, there is no mechanism that forces these surfaces to be parallel; we have to ensure that ourselves.

The orientation of a face can be described with the help of a so-called surface normal. It is always perpendicular to the surface. If several faces are selected, the resulting normal is

\[ \text{Figures 26 Figure 4: Normal coordinate spaces for faces. The normal is shown in blue.} \]
averaged from the normals of every single face. In Fig. 4 the normal coordinates of the visible faces are drawn.

This concept can be applied to individual points on the object, even if the points themselves have no orientation. The normal of a point is the average of normals of the adjacent faces.

The images for this tutorial were produced with Blender v2.46.

7.4. UV Coordinates

In later parts (for example, talking about textures) you will come across coordinates labelled “U” and “V”. These are simply different letters chosen to avoid confusion over “X”, “Y” and “Z”. For example, a raster image is normally laid out on a flat, two-dimensional plane. Each point on the image can be identified by X and Y coordinates. But Blender can take this image and wrap it around the surface of a 3D object as a texture. Points on/in the object have X, Y and Z coordinates. So to avoid confusion, the points on the image are identified using U and V to label their coordinates instead of X and Y. We then refer to “UV mapping” as the process of determining where each (U, V) image point ends up on the (X, Y, Z) object.
8. Overview

Blender’s user interface (the means by which you control the software) is not particularly easy to learn. However, it has improved over time and is expected to continue doing so. The current version of the Blender software is 2.74. You can download it¹ from the Blender Foundation²’s website.

The tutorials in this section will familiarize you with the basics of the user interface. By the end of this section, you should be able to:

• resize, split, and merge any Blender window;
• change the type of any Blender window;
• access user preferences;
• access panels containing buttons and other controls;
• change the viewpoint of a viewport.

For those new to Blender, this is a fundamental section of the book.

8.0.1. Advice on Customization

Blender is a complex software package with many customizable features. You can customize the user interface to assign new functions to buttons and hotkeys. In fact, you can change almost anything to suit yourself. However, this complicates the giving and following of directions. It is recommended that you adhere to the default screen arrangements of Blender in order to be able to follow well in the remaining parts of these tutorials. Blender ships along with some 4 to 5 screen-content arrangements which are suitable for almost any kind of job you’ll want to use it for - from creating motions and animations to doing games.

We recommend leaving Blender’s user interface in its “factory settings” while working through the Noob to Pro tutorials. At the very least, wait until you’ve mastered the basics before you customize the interface - and we know you definitely will when you master it!

¹ http://www.blender.org/download
² http://www.blender.org/
9. Keystroke, Button, and Menu Notation

As you read through these tutorials, you will encounter cryptic codes such as $\text{[SHIFT]} + \text{LMB}$ and $\text{Timeline} \rightarrow \text{End Frame}$. These codes describe actions you perform using the keyboard and mouse. The notation used in this book comes from the Blender community, and it is standard there. We will try to import those standards here to facilitate our studies.

If you’re reading this book online, you may wish to print this page for future reference. In addition, you can bookmark in your browser for faster reference when behind your PC.

9.1. Hotkeys

![Figure 27](image)

**Figure 27** A typical numpad

Most computer keyboards have number keys in two different places: in a row above the letters and in a numpad (numeric keypad) on the right side of the keyboard. While many applications use these two sets of keys interchangeably, Blender does not. It assigns different functions to each set. If you’re using a laptop keyboard without a separate numeric keypad, this might cause some difficulty. You’ll need to use your *function key* to do some things. It is possible to indicate to Blender the type of keyboard you are using, but we strongly recommend you use a standard external keyboard even if you’re on a laptop for these tutorials as it will make your studies and usage of Blender much more straightforward and enjoyable.
This book often assumes that your keyboard has a numpad. If yours doesn’t, consult the tutorial on Non-standard Input Devices\footnote{Chapter 10 on page 51} for alternative ways to access the numpad’s functions.

### 9.1.1. Notation

<table>
<thead>
<tr>
<th>Notation</th>
<th>Action or Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT</td>
<td>(press and hold) the Alt (Option) key</td>
</tr>
<tr>
<td>CMD</td>
<td>(press and hold) the Command or Super key (On a Windows keyboard, the key bearing the Windows logo; on a Macintosh, it bears the Apple logo.)</td>
</tr>
<tr>
<td>CTRL</td>
<td>(press and hold) the Ctrl (Control) key</td>
</tr>
<tr>
<td>FN</td>
<td>(press and hold) the Fn (Function) key (generally found only on laptops)</td>
</tr>
<tr>
<td>SHIFT</td>
<td>(press and hold) the Shift key</td>
</tr>
<tr>
<td>ENTER</td>
<td>(press) the Enter (Return) key (on the main keypad)</td>
</tr>
<tr>
<td>ESC</td>
<td>(press) the Esc (Escape) key</td>
</tr>
<tr>
<td>F1 through F12</td>
<td>function keys F1 through F12 (often in a row along the top of the keyboard)</td>
</tr>
<tr>
<td>SPACE</td>
<td>(press) the space bar (usually unmarked)</td>
</tr>
<tr>
<td>TAB</td>
<td>(press) the Tab key</td>
</tr>
<tr>
<td>A through Z</td>
<td>the letters (on the main keypad)</td>
</tr>
<tr>
<td>0 through 9</td>
<td>the numerals (above the letters) on the main keypad</td>
</tr>
<tr>
<td>NUM0 through NUM9</td>
<td>the numerals on the numpad</td>
</tr>
<tr>
<td>NUMLOCK, NUM/, NUM*, NUM-, NUM+, NUMENTER, and NUM.</td>
<td>other keys on the numpad</td>
</tr>
<tr>
<td>DELETE</td>
<td>(press) the Delete key (not NUM.!)</td>
</tr>
<tr>
<td>DOWN ARROW</td>
<td>(press) the down Arrow key (not NUM2!)</td>
</tr>
<tr>
<td>LEFT ARROW</td>
<td>(press) the left Arrow key (not NUM4!)</td>
</tr>
<tr>
<td>RIGHT ARROW</td>
<td>(press) the right Arrow key (not NUM6!)</td>
</tr>
<tr>
<td>UP ARROW</td>
<td>(press) the up Arrow key (not NUM8!)</td>
</tr>
</tbody>
</table>

Combinations that involve holding down a key while performing another action are written with a plus sign (+). Thus:

- \textbf{SHIFT} + \textbf{TAB} means to \textbf{TAB} while holding down \textbf{SHIFT} and \textbf{CTRL}.

- \textbf{SHIFT} + \textbf{CTRL} + \textbf{F9} means to \textbf{F9} while holding down both \textbf{CTRL} and \textbf{SHIFT}.

### 9.2. Mouse Notation

Blender uses three mouse buttons and the scroll wheel as well, if you have one. If your mouse only has one or two buttons, consult the tutorial on Non-standard Input Devices\footnote{Chapter 10 on page 51} for alternative ways to access the functions assigned to these buttons.
<table>
<thead>
<tr>
<th>Notation</th>
<th>Action or Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>LMB</td>
<td>click with the Left Mouse Button</td>
</tr>
<tr>
<td>RMB</td>
<td>click with the Right Mouse Button</td>
</tr>
<tr>
<td>MMB</td>
<td>press down on (don’t turn) the scroll wheel or Middle Mouse Button</td>
</tr>
<tr>
<td>SCROLL</td>
<td>turn the scroll wheel in either direction</td>
</tr>
</tbody>
</table>

Mouse and keyboard actions are often combined. \( \text{SHIFT} + \text{RMB} \) means to click \( \text{RMB} \) while holding down \( \text{SHIFT} \).

### 9.3. Navigating Menus

Blender uses both pop-up and pull-down/pull-up menus. Many menus have **sub menus** (menus that are reached by going through another menu). If a menu item displays a triangle, that means it leads to a sub menu. For instance, the pull-down menu shown below has seventeen items, four of which lead to sub menus:
You can move through items in a menu by:

- moving the mouse pointer up and down

or

- pressing `UP ARROW` and `DOWN ARROW`

You can enter a sub menu either by:

- moving the mouse pointer to the right

or
• pressing **RIGHT ARROW**
You can leave a sub menu either by:
• moving the mouse pointer to the left
or
• pressing **LEFT ARROW**
To initiate a menu action, you can either:
• click **LMB**
or
• press **ENTER**
You can escape from a menu either by:
• moving the mouse pointer away from the menu
or
• pressing **ESC**
For each menu, Blender remembers which item you chose last time and highlights it for you the next time you enter the menu.

9.3.1. Notation

Menu notation is fairly self-explanatory.

\[ \text{SHIFT} + A \rightarrow \text{Mesh} \rightarrow \text{UV Sphere} \]

Means:
1. Press Shift+A
2. In the menu that pops up, move through the items until Mesh is highlighted
3. Enter the Mesh sub menu
4. Move through the items until UV Sphere is highlighted
5. Press Enter or click the left mouse button to initiate the action

9.4. Additional Resources

10. Non-standard Input Devices

This module is applicable only to users with non-standard input devices. If you have both:

- a three-button mouse

and

- a keyboard with a numpad,

then you can skip this module.

10.0.1. Keyboards lacking a numpad

Most modern laptops have a **pseudo-numpad**, a set of keys in the main keypad which double as a numpad. The keys typically used for this purpose are:

<table>
<thead>
<tr>
<th>KEY</th>
<th>KEY</th>
<th>KEY</th>
<th>KEY</th>
</tr>
</thead>
<tbody>
<tr>
<td>U</td>
<td>I</td>
<td>O</td>
<td>P</td>
</tr>
<tr>
<td>J</td>
<td>K</td>
<td>L</td>
<td>:</td>
</tr>
<tr>
<td>M</td>
<td>KEY</td>
<td>KEY</td>
<td>SLASH</td>
</tr>
</tbody>
</table>

When used as a pseudo-numpad, these keys typically act as the following keys from a true numpad:

<table>
<thead>
<tr>
<th>NUM7</th>
<th>NUM8</th>
<th>NUM9</th>
<th>NUM0</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUM4</td>
<td>NUM5</td>
<td>NUM6</td>
<td>NUM1</td>
</tr>
<tr>
<td>NUM1</td>
<td>NUM2</td>
<td>NUM3</td>
<td>NUM+</td>
</tr>
<tr>
<td>NUM0</td>
<td>NUMENTER</td>
<td>NUM.</td>
<td>NUM-</td>
</tr>
</tbody>
</table>

The numpad functions of these keys can often be toggled with **F11** or **NUMLOCK** on PCs or with **F6** on Macs. Alternatively, you can often temporarily activate the numpad behavior by holding down **FN**.

If your keyboard has the alternate labellings but you don’t know how they work, consult your laptop’s owner manual.

As a last resort, you can use the "Emulate Numpad" feature of Blender. This will allow you to use the normal numeric keys as if they were numpad numerics. Instructions for enabling this feature may be found in the "User Preferences Windows" module.
Blender uses the numeric keypad quite a bit. If you envision using your laptop for this kind of work, it may be worth investing in a *USB Numeric Keypad*. On eBay, prices for simple external numpads start around $10 USD.

### 10.0.2. Non three-button mouse

For single-button mouse users, make sure that *View & Controls* (*Input* for Blender 2.54) (under "User Preferences" on the left-most drop-down menu) → *Emulate 3 Button Mouse* is enabled.

On many computers with two-button mice, \(\text{MMB}\) can be emulated by simultaneously clicking \(\text{LMB} \text{ and RMB}\). On Windows machines you’ll need to set this up in the mouse settings in your Control Panel. On a Mac, open the *Keyboard and Mouse* preference pane and enable *Use two fingers to scroll*. Alternatively, by selecting *Emulate 3 Button Mouse* under *User Preferences*, \(\text{MMB}\) can be emulated by simultaneously clicking \(\text{ALT}\) and \(\text{LMB}\).

Recent IBM Thinkpad laptops allow you to disable the 'UltraNav' features of the middle mouse button in order to use it as a 'normal' third button. Alternatively, some laptops allow areas (called gestures) on the movement pad to act as \(\text{MMB}\) or \(\text{RMB}\), and these can be set up in the Control Panel in the Mouse Pointer options, selecting gestures and editing features there.

### Apple single-button mouse

<table>
<thead>
<tr>
<th>Notation</th>
<th>Single-button Substitute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(\text{LMB})</td>
<td>(\text{MB})</td>
<td>the Mouse Button</td>
</tr>
<tr>
<td>(\text{RMB})</td>
<td>(\text{CMD} + \text{MB})</td>
<td>Apple key + the Mouse Button</td>
</tr>
<tr>
<td>(\text{MMB})</td>
<td>(\text{ALT} + \text{MB})</td>
<td>Option (Alt) key + the Mouse Button</td>
</tr>
</tbody>
</table>

While Mac OS X natively uses both the \(\text{CTRL} + \text{MB}\) and \(\text{CMD} + \text{MB}\) to emulate \(\text{RMB}\), recent Blender releases for Mac OS X use only \(\text{CMD} + \text{MB}\) for this purpose. This behavior is documented in the *OSX Tips* file that comes with the Mac version. You can also set in System Preferences for the mouse to sense a right-click.

Note also that in the new, "unibody" design, the mouse button is under the trackpad, and the shortcut for \(\text{MMB}\) is clicking with two fingers simultaneously, which can be enabled in the System Preferences.

### Laptops lacking a middle button but with a smart-pad

Many laptops have smart pads. Smart-pads can use gestures to give the effect of \(\text{MMB}\). The default for an Elan® Smart-Pad is two-finger tapping equivalent to clicking a \(\text{MMB}\). Dragging two fingers is the same as turning a mouse wheel.
10.0.3. Tablet PCs

To get the effect of [MMB] in a viewport, drag your pen around while holding down the [ALT] key.

10.0.4. Additional Resources

- keyboard and mouse\(^1\) — Blender Manual\(^2\)
- version 2.6: keyboard and mouse\(^3\)

---

11. Operating System-specific Issues

This tutorial covers user-interface issues that are specific to particular operating systems or window managers. Read the section that applies to your computer; you may skip the rest.

11.1. GNU+Linux

\(\text{ALT} + \text{LMB}\) is used for changing the angular view on two angular axes of the 3D View window, if \(\text{ALT} + \text{LMB}\) moves the current window, then there’s a conflict with your window manager. You can resolve the conflict or use \(\text{CTRL} + \text{ALT} + \text{LMB}\) or \(\text{MMB}\) instead. (Also, you may have activated Compiz->Rotate Cube. Default configuration for rotating the Cube is also \(\text{CTRL} + \text{ALT} + \text{LMB}\); you may have to change this binding to an alternative configuration.) If you are running KDE this can be resolved by: \(\text{RMB}\) on the title bar of the main Blender window → select Configure Window Behavior → go to Actions → Window Actions → in the Inner Window, Titlebar and Frame section → select the Modifier key to be \(\text{ALT}\) and set all the select boxes beneath it to Nothing. An alternate method within KDE might be to \(\text{RMB}\) click on the title bar of the main Blender window; then select Advanced → Special Application Settings... → Workarounds and then click Block global shortcuts with Force selected and checked.

In Gnome, Click System → Preferences → Window Preferences. Look for the last three options Control, Alt and Super. Select Super. Now you can press and hold \(\text{CMD}\) to drag windows around, and use \(\text{CTRL}\) and \(\text{ALT}\) as normal.

11.1.1. KDE

Under KDE, \(\text{CTRL} + \text{F1}\) through \(\text{CTRL} + \text{F4}\) are by default configured to switch to the corresponding one of the first four desktops, while \(\text{CTRL} + \text{F12}\) brings up Plasma settings. You can change these in System Settings.

11.1.2. Gnome

You’ll want to disable the Find Pointer functionality in Gnome, which will impair your ability to use certain functions such as Snap to grid and the lasso tool. If your mouse pointer is being highlighted when you press and release \(\text{CTRL}\), go to: Mouse in Gnome’s Desktop Settings and uncheck the box Find Pointer.
11.1.3. Ubuntu

As of Ubuntu versions prior to about 09.10 (“Karmic Koala”), there was a known incompatibility between Blender and the Compiz Fusion accelerated (OpenGL) window manager used in Ubuntu. By default, Compiz Fusion is enabled in Ubuntu, causing the problems to manifest themselves in Blender as flickering windows, completely disappearing windows, inconsistent window refreshes, and/or an inability to start Blender in windowed mode.

The fix for this is simple. Install compiz-switch (might be in universe). Go to Applications → Accessories → Compiz-Switch. This will disable compiz temporarily. Do the same to turn compiz back on when you’re done using Blender.

This is no longer needed for current releases of Ubuntu.

11.2. Mac OS X

On Macs with the new thin Apple Keyboard, you may need to press \textasciitilde{FN} in order to use the \textasciitilde{F1} through \textasciitilde{F12} keys.

To expand a section in Blender, you would usually press \textasciitilde{CTRL} + \textasciitilde{UPARROW}. On a Mac, if “Spaces” is enabled, you may have to use \textasciitilde{CTRL} + \textasciitilde{ALT} + \textasciitilde{UPARROW}.

NOTE: On Yosemite 10.10.1 with “Spaces” enabled and Blender 2.72b, \textasciitilde{CTRL} + \textasciitilde{UPARROW} doesn’t seem to work.

11.3. Microsoft Windows

11.3.1. Two Ways to Launch Blender

Blender requires a console for displaying error messages, so if you launch Blender by means of an icon, two windows will appear: the graphical user interface plus a console window. Closing either window will terminate Blender. These windows are indistinguishable in the Windows taskbar in versions of Windows before Windows 7\textsuperscript{1}, which leads to confusion. Also, launching this way does not provide any way to pass command-line arguments to Blender.

Launching Blender from a command prompt is extra work, but it overcomes these issues:

1. \texttt{Start} → \texttt{Run...}
2. enter \texttt{cmd}
3. enter \texttt{cd c:\Program Files\Blender Foundation\Blender}
4. enter \texttt{blender}

EDIT: Blender 2.6 doesn’t have this problem, and hides the console window by default. You can show it by clicking Window > Toggle system console

\textsuperscript{1} http://en.wikipedia.org/wiki/Windows%207

56
11.3.2. Sticky Keys

Pressing $\text{SHIFT}$ five times in a row may activate **StickyKeys**, an accessibility option which alters how the computer recognizes commands. If a StickyKeys dialog box appears, you should LMB the "Cancel" button.

If you don’t need the accessibility features, you can disable sticky keys:

1. Start → Control Panel 
2. double-click on Accessibility Options 
3. LMB the Keyboard tab 
4. for each of the options StickyKeys, FilterKeys, and ToggleKeys :
   a) clear the Use ... checkbox 
   b) LMB the Settings button 
   c) uncheck the Use Shortcut checkbox in the settings 
   d) LMB the OK button for the settings 
5. LMB the OK button for Accessibility Options

11.3.3. Multiple Keyboard Layouts

On systems with multiple keyboard layouts, pressing $\text{SHIFT} + \text{ALT}$ can alter the layout. (For instance, it might change from QWERTY to AZERTY or vice versa.) Because of this issue, *Noob to Pro* avoids $\text{SHIFT} + \text{ALT}$ hotkeys. 

If you find your keyboard layout altered, press $\text{SHIFT} + \text{ALT}$ again to change it back.

You can also disable the hotkey:

1. Start → Control Panel 
2. double-click on Regional and Language Options 
3. LMB the Languages tab 
4. LMB the Details button 
5. LMB the Key Settings button 
6. LMB the Change Key Sequence button 
7. uncheck the Switch Keyboard Layout checkbox 
8. LMB the OK button

11.3.4. Additional Resources

- Input method editor keyboard shortcut (CTRL+SHIFT+0) switches the input language in Vista$^2$ — Microsoft Support Knowledge-Base
- w:StickyKeys$^3$

---

2 http://support.microsoft.com/kb/967893 
12. Blender User Interface

Here’s a screenshot to give you a preview of Blender’s interface. For those familiar with older (pre-2.5x) versions of Blender, this will look very different. The redesign made it much easier to find things.

For a detailed rationale explaining the redesign, read this¹.

Figure 29

12.1. Why Doesn’t It Follow UI Conventions For [Insert OS Of Choice Here]?

Blender follows its own user-interface conventions. Instead of making use of multiple windows as defined by your particular OS/GUI, it creates its own “windows” within a single OS/GUI window, which is best sized to fill your screen. Many people accustomed to how applications normally work on their platform of choice get annoyed by Blender’s insistence on being different. But there is a good reason for this.

The essence of the Blender UI can be summed up in one word: workflow. Blender was originally created by a 3D graphics shop for their own in-house use. Being a key revenue engine for them, they designed it for maximum productivity, speed and smoothness of operation. That means avoiding “bumps” that slow down the user. For example, windows never overlap, so there’s no need to keep reordering them to see hidden stuff. You don’t have to click in a window to make it active, just move the mouse. There is a minimum of interruption from popups asking for more information before performing some action; instead, the action is immediately performed with default settings, which you can then adjust afterwards and get immediate feedback on the results.

Blender may not be “intuitive” to start learning, in that you cannot simply sit down in front of it on your own and figure out things by messing about from a position of knowing nothing at all. But once you have picked up some basic conventions, you will find it all starting to make sense and then you will be free to experiment and discover things on your own.
12.2. Why Doesn’t It Prompt To Save Changes?

Most applications on whatever platform nowadays will ask for confirmation if you try to close a document that has unsaved changes. Blender is frequently criticized for not doing so.

But think about it: what constitutes an “unsaved change”? Are switching tools or adjusting the window layout changes worth saving? In Blender’s case, the answer is “yes”, because all that is part of the document state to be restored on opening. So Blender would have to prompt for confirmation practically every time you closed a document or quit Blender.

Instead, Blender always saves changes when it closes, to a file called 'quit.blend'. The next time you use Blender, simply select File --> Recover Last Session and you can resume right where you left off.
13. Blender Windowing System

Information

Applicable Blender version: 2.69

The Blender user interface may appear daunting at first, but don’t despair. This book explores the interface one step at a time.

In this module, you’ll learn about Blender windows:

• recognizing windows and their headers,
• the different types of windows,
• how to activate and resize windows,
• how to split and join windows.

You’ll also practice launching and leaving Blender.

13.1. An Interface Divided

Blender’s user interface is divided into rectangular areas called windows (or sometimes, areas). The overall arrangement of windows is called a workspace.

If you haven’t already launched Blender, go ahead and do so. You should soon see something that resembles the following.

Blender has had some major changes to its user interface (UI) since version 2.4x. Some of these changes include moving buttons and changing the space bar hot key from the “add menu” to the “search menu” (\(\text{SHIFT} + \text{A}\) is now the “add menu” hot key). This is important to know when trying to follow tutorials.

Other changes include the addition of the tool bar and window splitting widget. The shelf widget (indicated by a plus sign) opens hidden tool shelves. The object tool shelf can be toggled on and off by pressing \(\text{T}\). The properties tool shelf can be toggled on and off by pressing the \(\text{N}\). The split window widget allows you to split and join windows. Blender 2.69 is shown below.
• You may be running a different version of Blender - maybe a higher version. The screenshot was made using the 2.69 release.

If you’re running an older version, you should probably upgrade. Download instructions are in the Introduction.

• The user-interface settings on your computer may have been changed.

Try resetting the user interface with File → Load Factory Settings.

To take a screenshot in Blender, press $\text{ALT} + F3$, and click Make Screencast. This will record what’s on your screen until you click the red Close button on the info header. The screencasts will be saved in the tmp folder-In Microsoft Windows, tmp folder is located on ‘C:|tmp’.

13.2. Window Headers

Did you find all five headers?

Every Blender window has a header. A header can appear at the top of the window, at the bottom of the window, or it can be hidden. Let’s take a closer look at the headers.
Figure 31  The header of the Info window is outlined in green. The header of the 3D View window is outlined in red. Note that it runs along the bottom of the 3D View window, not the top. The header of the Properties window is outlined in blue. The header of the Outliner window is outlined in white. The header of the Timeline window is the one on the bottom (not outlined).

If you click with RMB on the header, a menu pops up which lets you move the header (to the top if it’s at the bottom, or vice versa), or maximize the window to fill the entire workspace:
To hide the header completely, move the mouse to the edge of the header furthest from the edge of the window (i.e. the top edge of the header if it is at the bottom of the window, or vice versa); it will change into a vertical double-headed arrow. Now click with \texttt{LMB} and drag towards the window edge, and the header will disappear. In its place, you will see the following symbol appear at the corner of the window:
13.3. Window Types

Blender has many types of windows (there are 16 of them in Blender 2.69) and a Console for the Python programming language. You’ve just encountered the Info, 3D View, Properties, and Outliner windows. The rest will be introduced as needed in later modules.

Every window header in Blender has an icon at the left end to indicate the window type. For instance:
Blender Windowing System

Figure 34

= Info

Figure 35
Window Types

Figure 36

Figure 37
If you LMB on the icon, a menu will pop up. (If you don’t know what LMB means, please review the Keystrokes, Buttons, and Menus Notation module.)
By matching the icon in the header to the icons in the menu, you can tell that the window here is a 3D View window.

The menu can be used to alter a window’s type. In this screenshot, the user is about to change the window into a Properties window.

**Note:**
Any window can be changed to any type. Blender doesn’t mind if there are multiple windows of the same type.
Note:
The workspace layout is saved along with the document. Anybody subsequently opening the document will see the last-saved layout.

If you’ve changed any window’s type, please change it back (or reload the factory settings with File → Load Factory Settings) before continuing with this tutorial.

13.4. The Active Window

The active window is the one that will respond if you press a key. Exactly one Blender window is active at any given time.

The active window is usually the one containing the mouse pointer. (Blender uses a "focus follows mouse" user interface model. When a hotkey fails to work as expected, it is often because the mouse pointer has strayed into a neighboring window.) To change the active window, simply move the mouse pointer into the window you wish to activate.

Practice changing the active window by moving your mouse between the 3D View and the Timeline windows. The Timeline window is exactly below the 3D View header. At this point, it is worth mentioning that the header for the 3D View window and Timeline window is at the BOTTOM of its own window instead of the top as the name "header" implies.

Note:
When a window becomes active, its header gets brighter.

13.5. Resizing Windows

Resizing windows is easy.

13.5.1. Dragging on a Border

Figure 40 Press and hold LMB. Drag with the mouse to move the border up and down. When the border is where you want it, release LMB.
Whenever you increase the size of one window, you decrease the size of another. That’s because Blender has a **non-overlapping window interface**: unlike many other programs, it does not permit windows to overlap.

### 13.5.2. Maximizing a Window

Another way to resize a window is to maximize it. When Blender **maximizes** a window, it makes it as big as possible. The previous window configuration is saved.

- To maximize the active window, press `CTRL + UPARROW`, `CTRL + DOWNARROW` or `SHIFT + SPACE`.
- When a window is maximized, use `CTRL + UPARROW`, `CTRL + DOWNARROW` or `SHIFT + SPACE` to restore the previous (unmaximized) window configuration.

Practice maximizing and un-maximizing the 3D View and Timeline windows.

**Note:**
If you are running a version of Blender before 2.57, you cannot maximize a User Preferences window.

### 13.6. Shelves

You will notice that the 3D View
Figure 41

window (the largest window in the above screenshots) has several buttons down the left. This rectangular portion is called the Tool Shelf. This is like a window within a window, and you can drag the boundary between it and the main part of the 3D View to resize.

If you drag all the way to the window boundary, the shelf will disappear. In its place, the following symbol will appear:
. Click that to bring the shelf back.

13.7. Too Much To Fit

If a window or shelf contains too much information to fit within its display area, scrollbars will appear along the bottom or right edge. You can scroll the contents by dragging these with \( \text{LMB} \); alternatively you can drag with \( \text{MMB} \) directly within the contents.

A window header may also contain more than fits within its displayable area. There is no explicit visual clue for this (except maybe the tell-tale of widgets being cut off at the right edge), but if it happens, you can drag sideways within the header with \( \text{MMB} \) to scroll its contents.
13.8. Splitting And Joining Windows

At the top right and bottom left of every window, you will see something like this:

![Figure 43](image)

If you move the mouse over this icon, you will see the pointer turn into a cross. At this point, you can do one of the following by clicking and dragging with [LMB]:

- Split the window into two copies horizontally by dragging horizontally away from the edge.
- Split the window into two copies vertically by dragging vertically away from the edge.
- Join the window to the adjacent one horizontally (getting rid of it and taking over its space) by dragging towards it.
• Join the window to the adjacent one vertically (getting rid of it and taking over its space) by dragging towards it.

Of course, the last two are only possible if there is in fact another window in that direction. Note also that you can only join windows horizontally that are the same height, and windows vertically that are the same width.

13.9. The Default Workspace

If you look at the above screenshot of the default workspace, you will see the following window types:

• The menu bar at the top (outlined in green) is actually a window, called Info
In previous versions of Blender, you could resize this to reveal the User Preferences, but in 2.5x they have been moved to their own window type. Instead, all you can see here if you enlarge the window are some debug messages, which may be removed in a future version of Blender. As of 2.70, the debug messages are still present in this menu.

- The largest window on the screen is the 3D View

Figure 45

This is where you work on your model.

- The Properties
The Default Workspace

The default workspace window is the tall area on the right; this is where most of the functions are located for performing operations on models, materials etc. In previous versions of Blender this was called the Buttons window, and was degenerating into a disorganized grab bag of functionality that made it difficult to find things. This has been cleaned up in a major way in 2.5x. Note also that it defaults to a vertical layout, rather than the horizontal one of previous versions. The new design prefers a vertical layout, which works better on today’s widescreen monitors.

- The Outliner
Figure 47

(at the top right) gives you an overview of the objects in your document. As your models get more complex, you will start to appreciate the ability to find things quickly here.

- The Timeline
(across the bottom) becomes important when you’re doing animations.

Of course, this is just the default layout. For example, if you’re doing a static model or scene, not an animation, you can get rid of the Timeline. If you’re doing heavy script development, you’ll probably want the Console available to try things out. And so on.

13.10. Workspace Presets

Up in that Info window/titlebar, you will see a menu with an icon like this
. Clicking on it with $\text{LMB}$ will show the following menu:
Selecting from this menu lets you quickly switch between various predefined workspace layouts, tailored to various workflows. Try it and see—you can return to the default layout by selecting “Default” (but note that any changes you make to the layout are immediately associated with the name being displayed here). The menu even has a search box at the bottom: typing some text in here will restrict the menu to only showing items containing that text. Hard to believe it has much use here, but perhaps in complicated projects which need dozens of different layouts, a search function could become very useful indeed!

Note also the “+” and “X” icons to the right of the menu; clicking “+” creates a new entry which is a duplicate of the last-selected entry, while clicking “X” gets rid of the currently-
selected entry. You will see these conventions appear consistently in menus elsewhere in Blender’s new, revamped interface.

13.11. One Document At A Time

Blender can only work with one open document at a time. To save changes to the current document, select one of the Save options from the File menu (or press \texttt{CTRL} + \texttt{S} to save under the last-saved name). To open a new document (actually load a copy of your last-saved user preferences), select “New” from the File menu (or press \texttt{CTRL} + \texttt{N}), and select “Reload Start-Up File” from the little popup that appears, but be aware \textit{this will not automatically save changes to the previous document} — you should have remembered to do that first.

13.12. Scenes

A \textit{scene} is like a separate Blender document-within-a-document. Different scenes within the same document can easily share objects, materials etc, so you can define them once and make different renderings and animations from them. You create, delete and switch scenes using the scene menu in the info header. A new document starts by default with just one scene, called “Scene”.

Figure 51
13.13. Leaving Blender

To close down Blender:

1. If there’s a tool active, press [ESC] to exit the tool.
2. Press [CTRL] + [Q]. This brings up an OK? menu.
3. Confirm Quit Blender by clicking [LMB] or pressing [ENTER].

**Note:**
Blender will not prompt you to save your work. However, you can easily restart Blender and then pick up where you left off using *File → Recover Last Session*.


- YouTube video on Splitting and Joining Windows in 2.49 at [www.youtube.com/watch?v=uYb1j8X-{ulc](www.youtube.com/watch?v=uYb1j8X-{ulc)
- YouTube video on Splitting and Joining Windows in 2.59 at [www.youtube.com/watch?v=mGK1gwFhx9M](www.youtube.com/watch?v=mGK1gwFhx9M)
14. User Preferences Windows

**Information**

Applicable Blender version: 2.57

In this module, we’ll take a closer look at the User Preferences window. In the process, you’ll encounter three different user-interface controls: radio buttons, toggle buttons, and sliders.

14.1. Saving User Preferences

Most other applications have a place to keep user-configured settings (including document defaults), separate from any actual documents the user creates. Blender works in a slightly different fashion: all your user-configured settings are saved in *every* document you create. Each time you create a new Blender document, it actually just reloads your default document, which is called `.blend`. To save your current state as the default document, press `CTRL+U`. This will save *everything* you’ve done to the current in-memory document, including objects and materials created, to `.blend`.

14.2. Accessing the User Preferences

First we must open the User Preferences window. There are 3 ways to do this:

- Click `LMB File → User Preferences...`
- Change the window type of the top header to *User Preferences*
and drag the header down.

- Press \texttt{CTRL + ALT + F1}, which will open the User Preferences into a separate window which you can resize at will.

The User Preferences window should look something like the screenshot below.
14.3. Configuring Your Preferences

So as to get to modeling and rendering sooner, this tutorial will cover only a few of the many preferences which you can set.

14.3.1. Auto Save

Auto Save is a very useful feature that automatically saves the current .blend after a specified period of time. The settings are:

- **Auto Save Temporary Files**: This enables/disables the auto save feature.

- **Timer (mins) slider**: This specifies the time in minutes between each auto save.

Note:
In Blender 2.66 and later, an additional option is available: "Keep Session". This option always saves a quit.blend at Quit, and loads it on starting Blender. If you close Blender with an "empty file" session (the startup.blend), it keeps the Window header name "Blender" and treats the session as if no file was loaded. For the purposes of this tutorial, it can be left disabled.
14.3.2. Number of Undo Levels

Next we’ll look at the undo settings. By default, Blender remembers your last 32 actions and allows you to undo them one at a time by pressing $\text{CTRL} + \text{Z}$. If your computer has plenty of memory, you may wish to increase that number. If it has relatively little memory, you might consider decreasing it to 10 or 20. The Memory Limit slider specifies the amount of RAM (in megabytes) to use for storing the undo levels. Undo level '0' is unlimited.
14.3.3. Numpad Emulation

Blender uses numberpad keys (such as `NUM7`) to control the 3D View and ordinary numeral keys (such as `7KEY`) to change layers. If you are working on a laptop or if you find the numberpad inconvenient, you can select *Emulate Numpad* to reassign the 3D View controls to the ordinary numeral keys.
If you ever need to restore Blender to its factory settings, you can either delete your personal ".blend" file and then restart Blender or click \[ LMB \] File → Load Factory Settings

**Note:**
The second method only affects the current session. To make the settings persist, you would need to save them with \[ CTRL + U \] or File → Save User Settings - This menu name has been changed to Save Startup File in Blender 2.67b.

### 14.4. Additional Resources

- The tutorial on Non-standard Equipment\(^1\) describes other workarounds for numpad issues.

---

\(^1\) Chapter 10 on page 51
15. Properties Window

Information
Applicable Blender version: 2.67

The Properties

Figure 57
window is where you will find most of the functions that Blender can perform with objects and materials, animation, rendering and so on. Here is also the area where you will see the greatest changes from earlier versions of Blender (where it was called the Buttons window). Hopefully you’ll agree that the new layout makes it much easier and quicker to find things!

In the header of the Properties window, you will see a row of buttons that looks like this:

![Figure 58](#)

The actual icons will vary depending on the type of object selected in the 3D view; also in the default layout, the Properties window may be too narrow to show the entire row, in which case you can either widen the window, or click drag across the buttons with MMB to scroll the button row, or use your mouse wheel within them. Each of these buttons gives you access to a different context, or subsection of the Properties settings. Unlike older Blenders, there are no more “subcontexts” — no additional buttons will appear in the header when you click any of these.
16. The Contexts

16.1. Render Context
File:Blender255RenderContextButton.png

In here are the settings that control overall rendering of the final images: what resolution to use, output format, performance, post processing, etc.

16.2. Render Layers Context
File:Blender267RenderLayersContextButton.png

Here are additional settings that offer finer control over rendering of the final images: which scene layers to render, which separate parts (passes) of the rendering process to actually perform, and how to group them into render layers (not to be confused with the scene layers) for input into subsequent compositing.

Note:
In versions of Blender prior to 2.67, these settings were combined into the Render Context.

16.3. Scene Context
File:Blender255SceneContextButton.png

In here are settings for colour management, choosing which camera to use for rendering, and units and gravity settings for physical modeling.

You can also select another scene to be a “background” for this scene. That is, all renders of this (foreground) scene will also include the contents of the background scene, as though they had been copied into this scene. While the background appears in the 3D viewport when editing this scene, none of its contents are editable, or even selectable; that has to be done in the background scene itself.
16.4. World Context
File:Blender255WorldContextButton.png

In here are settings that govern the surroundings in which the model is rendered: background sky color, mist and star settings, environment lighting etc.

16.5. Object Context
File:Blender255ObjectContextButton.png

In here are settings that apply to all kinds of objects: overall transformations, layer assignments, grouping etc. The settings shown here (and any changes made) apply to the last object selected. This is also the case for the following object-specific contexts.

16.6. Object Constraints Context
File:Blender255ObjectConstraintsContextButton.png

In here are settings that limit the motion of the object for animation purposes. The limits can also be tied to the motion of other objects in various ways.

16.7. Object Modifiers Context
File:Blender255ObjectModifiersContextButton.png

In here are settings for applying *modifiers* to the object geometry—these make changes to the geometry that only take effect at rendering time. Note that lamps, cameras and empty objects cannot have modifiers.

16.8. Object Data Context
File:Blender267ObjectDataContextButtons.png

In here you will find settings specific to the type of object: mesh vertex groupings, text font, lamp settings, camera settings, all that kind of thing. This is reflected in the icon, which changes according to the type of object selected.

16.9. Material Context
File:Blender255MaterialContextButton.png

The material settings for an object control how it looks: its colour, whether it has a shiny or dull surface, how transparent it is, and so on.
16.10. Texture Context
File:Blender255TextureContextButton.png

The texture settings specify patterns that break up the uniform appearance of a material: these patterns can affect the colour of the material, or give it a rough surface, or modify it in other ways.

16.11. Particles Context
File:Blender255ParticlesContextButton.png

An object can be set to emit particles, like smoke, flames or sparks. The concept of “particles” (and the underlying algorithms) also includes the generation of hair or fur. Or particles can be entirely custom objects, to produce effects like blades of grass interspersed with flowers in a field, water droplets on a wet surface, or even scatterings of entire buildings to make up a large cityscape!

File:Blender255PhysicsContextButton.png

In here you will find settings that control how the object reacts to forces like objects in the real world: whether it behaves like a rigid body that keeps its shape but can be knocked around, such as cloth, something soft e.g a pillow, or a flowing liquid.

16.13. Where Did The Old Stuff Go?

... the old Logic Context has been moved into its own window type, the Logic Editor.

The old Script Context has gone: Python scripting is now much more closely integrated into the Blender UI, and old scripts will not work anyway.

The functions of the other contexts have been rearranged into the new contexts as listed above. Once you get used to the new arrangement, it should make much more sense than the old one.
17. 3D View Windows

Information
Applicable Blender version: 2.70

Figure 59
windows in Blender are used to visualize 3D scenes. You’ll do a lot of work in these windows, so you will need to learn your way around.

**Note:**
The 3D view only shows an *approximation* to the final appearance of the scene. The overall geometry should be correct, but don’t expect accurate rendition of materials, textures, lighting etc, since that can be very time-consuming, and the 3D view is designed to respond to your actions at interactive speeds. Plus there are additional view options (like wireframe, hiding etc) that make it easier to see what parts of the model you’re working on, that have no effect on the final render. Also you can change your viewpoint at any time (which will be essential while working on your model/scene), while the viewpoint of the render is controlled by the camera position.

In this module, you’ll learn:
- to recognize 10 things commonly seen in viewports
- to tell which mode Blender is in
- how to change viewport options and viewpoints
- how to position the 3D cursor

You’ll also learn the fundamentals of:
- visibility layers

### 17.1. The Viewport and its Contents

Aside from its header, the remainder of a 3D View window is its **viewport**. In Blender, you use viewports any time you need an up-to-date view of the scene you’re working on.

Viewports are busy places. Go on a scavenger hunt and see what you can find in a simple viewport.

1. Launch Blender.
2. Just so we’re all looking at the same scene, load the factory settings using *File → Load Factory Settings*.
3. Confirm the “Load Factory Settings” popup with ![LMB](image) (or ![ENTER](image)).
4. If the NumLock indicator on your keyboard is unlit, press ![NUMLOCK](image) so that numpad hotkeys will work properly.

(If you’re unsure what ![LMB](image) means, please review the Keystroke, Button, and Menu Notation module1.)

You should see something like this:

---

1 Chapter 9 on page 45
17.1.1. A Virtual Scavenger Hunt

Peer into the viewport at the default scene provided by the creators of Blender and find the following eight items:

In the Center

1. a solid gray cube with orange edges.
   - This is the default cube, your first Blender object!

2. Three big arrows, one red, one green and one blue, their tails joined to a white circle
• This is not an object (part of your model/scene), but part of Blender’s user interface for manipulating objects. It is the **manipulator**, also known as the **3D transform widget**.

• The arrows represent the directions of the $X$, $Y$ and $Z$ axes of the currently-chosen **transform orientation** coordinate system. Initially this is the **global coordinate system**.

• The circle represents the center of the selected object (namely, the cube).

• If you don’t know what a ”global coordinate system” is, please review the module on Coordinate Spaces in Blender\(^2\).

• It’s possible that a tool is active. Press **ESC** to cancel any tool action.

• Another possibility is that the manipulator has been disabled:

  • Toggle it on or off with **CTRL + SPACE**.

3.
A red-and-white striped circle with black cross-hairs

- This is not an object. It is the **3D Cursor**, which indicates where newly-created objects will appear in the scene.
- The cursor is similar to the insertion point in a text editor, which indicates where newly-typed text will appear in a document.

**In the Lower Left Corner**

4.
Figure 64

- This is not an object. It is the **mini axis**, and its orientation matches that of the global coordinate system, with the usual conventions: red for X, green for Y and blue for Z. Think of it as a little compass, reminding you which way is left/right, front/back and up/down.

5. The notation "(1) Cube"

This is not an object. It is **object info**, indicating that:

- You’re viewing the first frame of an animation.

and
The current or most recently selected object is named "Cube".

**In the Upper Left Corner**

6. The notation “User Persp”

This is not an object. This is telling you something about the view being displayed by the viewport. The first word will change if you select one of the perfect views or the camera view (see below), otherwise it just says “User”, and the second word is “Persp” or “Ortho” to indicate whether this is a perspective or orthographic view.

**To the Right of Center**

7.

Figure 65
A black round thing that resembles a sun-symbol

This represents a **lamp**, a light source for the scene. (It is an object.)

8. A pyramidal wireframe thing

This represents a **camera**, a viewpoint that can be used for rendering. (It, too, is an object.) The direction it is looking is out the base of the pyramid. The solid triangle attached to one side of the base is to remind you which way is up in the image that the camera takes.

On a small display, the camera might initially lie outside of the viewport and thus be invisible. In that case, zoom out by scrolling with \( \text{MMB} \) until it becomes visible.

**Throughout**

9. A dark gray background, divided into squares by lighter lines. This is the **grid floor**, which you can (but don’t have to) use as a ground plane for positioning your models.

Each grid square is one **blender unit** (or BU) on a side. A BU can be whatever you wish: an inch, a centimetre, a mile, or a cubit. Blender lets you decide what the scale should be for your scene in the Scene tab of the Properties Panel.

10. Three mutually-perpendicular coloured lines associated with the grid floor: the red and green ones lying horizontally in the floor and the blue one running vertically. These are the global coordinate axes for orienting your scene: as usual, red is the X-axis, green the Y-axis, and blue the Z-axis.

- In Blender 2.67a, you can’t see the blue line for Z-axis here because you can see it in Front or Side view.

### 17.2. Modes

Blender has lots of **modes**, that is, settings that affect its behavior, and this is especially true of 3D View windows.

Sometimes it’s not obvious what modes are active. This leads to **mode errors** where Blender will do something you didn’t expect because you thought it was in one mode and it was actually in another.

In Blender, the function performed by a hotkey or mouse button can depend on:

- what mode the user interface is in,
- whether the keyboard is in NumLock mode,
- which window is active,
- the mode the active window is in,
- which item or items are selected,
- whether you’ve initiated a hotkey sequence.

It helps to recognize the common modes and how to get out of them.
17.2.1. Object Mode vs. Edit Mode

The 3D View windows are normally in Object Mode. In this mode:

- The mouse pointer is a white arrow (on MacOS it is black).
- Right-click (RMB) is used to select objects in the scene.

If there are objects in the scene, you can get into five other modes:

- **EditMode**: used to edit the shapes of objects
  - The mouse pointer is a thin inverse-video cross.
  - Right-click (RMB) is used to select vertices, faces or edges of the current object.
  - Press `TAB` to enter/exit this mode.
- **Sculpt Mode**
  - The mouse pointer is now a thin, orange circle.
- **Vertex Paint**
  - The mouse pointer is the same as in sculpt mode, a thin, orange circle.
- **Texture Paint**
  - The mouse pointer is a thin white circle.
- **Weight Paint**
  - The mouse pointer is again, a thin orange circle.

These modes are also indicated by a menu in the 3D View header. You can use this menu to change modes.
These modes are a setting shared by all 3D View windows. In other words, when you change the mode in one window, any other 3D View windows change mode also.

17.3. Viewport Options

**Note:**
The options in this section only affect 3D View viewports. They do not affect renders.
17.3.1. Solid vs. Wireframe

By default, the 3D View window draws objects using the Solid drawtype, in which surfaces are opaque. To toggle between Solid and Wireframe drawtype (edges only, no faces) for a particular viewport:

1. Activate the 3D View window.
2. Press \[ Z \].

Alternatively, you can choose these and other drawtypes from the "Draw type" menu in the 3D View window header.

17.3.2. Orthographic vs. Perspective

By default, viewports draw orthographic views. To toggle a viewport between orthographic and perspective views:

1. Activate the 3D View window.
2. Press \[ NUM5 \].

(If you’re unsure what the difference is, please review the "Orthographic Views" module and the "Perspective Views" module.)

Note this perspective versus orthographic setting for the 3D viewport is completely separate from the similar setting in the camera properties; the former takes effect while you’re working on the model, the latter when you render.

So why have this separate setting for the 3D view? It’s because, regardless of what you want for the final render, certain aspects of modelling are easier in one view than another. If the final render will be using perspective, then naturally showing perspective in the 3D view gives you a better idea of how the final render will look. But perspective foreshortening can sometimes make it hard to ensure the model has the proper shape, which is why there is the option to flip to orthographic view if it helps.

... you should activate the View Name option. This is enabled by default and causes the name of the current view ("User Persp", for instance) to appear in the upper left corner of every viewport. If there is no text, then you can enable it by:

1. Accessing the User Preferences window.
2. Click on the Interface tab.
3. Enable View Name.

17.4. Changing Your Viewpoint, Part One

Each viewport has a viewpoint, which takes into account:

- the location of the viewer in the 3D scene (There doesn’t need to be an object at that location.)
- the direction the viewer is looking
- the magnification (or zoom factor) used
Changing your viewpoint allows you to navigate your way through a 3D scene.

We’ll start with three very basic techniques:

- Zooming
- Orbiting/View Rotation
- Perfect Views.

Additional techniques will be covered later in this module.

### 17.4.1. Zooming

Blender offers several ways to zoom in and out:

- Use \[ \text{SCROLL} \]
- Click and drag vertically with \[ \text{CTRL} + \text{MMB} \].
- Use \[ \text{NUM+} \] and \[ \text{NUM-} \] to zoom in and out in small increments.

Note the following limitations of Blender’s zoom feature:

- If the viewport is in orthographic mode, Blender zooms as if looking through a telescope. You can increase the magnification, but the viewpoint’s location doesn’t change. For this reason, you cannot zoom into or through objects in orthographic mode.
- If the viewport is in perspective mode, Blender zooms to a point—namely the center of the viewport. The viewpoint can pass through objects, but it can’t pass beyond this point, no matter what you do. Zooming only gets slower and slower and slower. If the center of the viewport is somewhere you don’t expect, zooming may appear to be broken.

### 17.4.2. Orbiting and View Rotation

Let’s fly around in the default cube, viewing it from different angles. In this way you’ll see that it really is a cube, centered on the origin, half above the X-Y plane and half below it.

1. Activate the 3D View window by placing the mouse pointer inside it.
2. Now you can:
   - Click and drag with \[ \text{MMB} \] to orbit freely around the center of the view.
   - Use \[ \text{SHIFT} + \text{ALT} + \text{SCROLL} \] to rotate the viewpoint vertically around the center of the view.
   - Use \[ \text{NUM2} \] and \[ \text{NUM8} \] to rotate the viewpoint vertically around the center of the view in 15-degree increments.
   - Use \[ \text{CTRL} + \text{ALT} + \text{SCROLL} \] to rotate the viewpoint around the Z axis.
   - Use \[ \text{NUM4} \] and \[ \text{NUM6} \] to rotate the viewpoint around the Z axis in 15-degree increments.

If this is all very confusing for you, don’t worry! You’ll learn as you get more experience.

When you are finished flying around the cube, you can restore the original view by reloading the factory settings with File \[ \rightarrow \] Load Factory Settings .

You may have pressed number keys above the letters instead of the ones on the numpad. If you do so, the default cube will vanish. This is because the scene consists of multiple
layers. The default cube is in layer 1, and you’ve told Blender to switch to another layer of
the number you just pressed. The selected object (the cube in this case) remains in layer
1, which isn’t shown anymore. For instance, \( \text{2KEY} \) tells Blender to switch to layer 2. To
switch to layer 1 again, press \( \text{1KEY} \). You can view the different layers by clicking on the
little squares on the layer map:

![Figure 68](image)

**Note:**
Because the center of the viewport is invisible (not marked in any way), it’s hard to tell
where it is. This sometimes results in unexpected behavior during rotation.

### 17.4.3. Perfect Views

It’s often useful to get a perfect view of a scene—in other words, to view it along one of
the main axes, with the other two main axes oriented up-down and left-right.

<table>
<thead>
<tr>
<th>Perfect View Hotkeys</th>
<th>View</th>
<th>Axis Pointing Right</th>
<th>Axis Pointing Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUM7</td>
<td>”top”</td>
<td>+X</td>
<td>-Y</td>
</tr>
<tr>
<td>CTRL + NUM7</td>
<td>”bottom”</td>
<td>+X</td>
<td>-Y</td>
</tr>
<tr>
<td>NUM1</td>
<td>”front”</td>
<td>+X</td>
<td>+Z</td>
</tr>
<tr>
<td>CTRL + NUM1</td>
<td>”rear”</td>
<td>-X</td>
<td>+Z</td>
</tr>
<tr>
<td>NUM3</td>
<td>”right side”</td>
<td>+Y</td>
<td>+Z</td>
</tr>
<tr>
<td>CTRL + NUM3</td>
<td>”left side”</td>
<td>-Y</td>
<td>+Z</td>
</tr>
</tbody>
</table>

The following screenshot shows all three perfect views plus camera perspective for the
Suzanne primitive:
In fact, this layout of four viewports showing top, front and right views plus camera view is so commonly used that it has its own menu item (from the “View” menu, select “Toggle Quad View”) and keyboard shortcut (\( \text{CTRL} + \text{ALT} + \text{Q} \)).

17.5. Positioning the 3D Cursor

Positioning the 3D cursor is a very basic operation, yet one that many beginners find challenging. It touches on an issue common to all 3D graphics software: “How do you specify points in a 3D scene when we can only see two dimensions at a time?”

17.5.1. Basic Technique

1. Go into either Object Mode or Edit Mode.
2. Move the mouse pointer to the desired position (in any viewport).
3. Click \( \text{LMB} \).
### Warning

This technique will fail if the 3D manipulation widget is enabled and your desired position is too close to it. Clicking [LMB] on or near the widget (the white circle with the colored arrows) will initiate a transform operation; the object’s outline will turn white and the mouse pointer will begin dragging the object around. If this happens, press [ESC] to cancel the transform operation.

### Warning

Clicking [LMB] in a viewport can only reposition the cursor in two out of three dimensions. (The cursor’s projected distance along the central line-of-sight remains unchanged.) For this reason, any time you reposition the cursor this way you should immediately verify its position using a different viewpoint.

### 17.5.2. Two Challenges

**Challenge #1.** Using only tools presented thus far, try positioning the 3D cursor on the virtual camera.

Try it!

When you’re done, check your work by orbiting the camera.

Perhaps you thought you were done when you clicked on the camera. But the moment you changed your viewpoint, you probably found that the 3D cursor was actually behind (or in front of) the camera.

Hints:
- Try positioning the cursor in two different perfect views.
- Use orthographic views, not perspective ones.

**Challenge #2.** Using only tools presented thus far, try repositioning the 3D cursor at the origin (that is, at the center of the cube).

As before, check your work by orbiting the cube. Don’t spend too much time on this.

"I found that I would select the cube when left clicking on it in object mode, if the "Use 3d transform manipulator" button was enabled. To toggle this off, you click on the gray pointing hand in the 3d panel header, or (Ctrl Space)."

"When you want the cursor back into the cube, just select the camera with RMB, put the cursor into the cube following the steps above, and re-select the cube with RMB."

"I’ve discovered it helps a lot if you are in Object Mode and not in Edit Mode. I wrote the following before discovering this: The problem with this exercise, for me, is that left clicking on the cube selects the cube instead of moving the 3d cursor. If I click on the cube outside"
of its central white circle I can get the cursor to move there, but only to outside of this white circle, and even then this only works sometimes.

"I failed at this until I had zoomed in close enough to the cube. When I was too far zoomed out I kept selecting the cube rather than creating an edit point."

"I had the same problem and found it was because the cube was selected. I made sure I was in object mode, right clicked on the camera to select the camera instead of the cube, and I could then position the edit point in the cube. However, doing this messed up the next part of the tutorial because you cannot switch into edit mode with the camera selected! Perhaps the suggestion of trying to put the 3D cursor in the cube should be dropped as it raises too many questions at this stage."

"You can deselect all by pressing the AKEY or the select button in the 3D View."

"Use wireframe mode works better to get the cursor in."

"To get it back in the cube: 1) Make sure you’re in object mode. 2) Select the cube. 3) Object > Snap > Cursor to selection (cursor refers to the 3D cursor here) so it puts it right in the middle of the cube."

"I think it’s an essential point to note that in order to place the cursor inside the cube, the cube must NOT be selected. AKEY was probably the best way to deselect the object."

"If I remember correctly, undo history gets cleared when you switch between object and edit mode."

"I wasted a lot of time here. Thank you to the reader who suggested (on the 3D view header) Object > Snap > Cursor to selection. It was the only thing that worked to get the cursor visible again and placed where clicked."

"I missed the point of the exercise first time around. You can’t set a 3D point on a 2D screen without technique. Orthographic views are crucial. I am just learning, but take that, at least, away from it."

"Positioning the 3D cursor in orthographic views always made it snap to the cube surface, making it impossible to center precisely. Fix this by disabling "Cursor Depth" on the "interface" tab under "User Preferences".
17.5.3. More Ways to Position the Cursor

Here’s an easy way to position the cursor at the center of an object:

1. Make sure Blender is in Object Mode, with the object selected.
2. Move the mouse pointer to any 3D View window.
3. Snap the cursor to the selected object using either:
   - \( \text{SHIFT} + \text{S} \) for Cursor to Selected
   - \( \text{Object} \rightarrow \text{Snap} \rightarrow \text{Cursor to Selected} \)

Here’s 2 easy ways to relocate the cursor to the scene’s origin (0, 0, 0):

1. Move the mouse pointer to any 3D View window.
2. Press \( \text{SHIFT} + \text{C} \) to reset the cursor to the origin.
   - Note that this also changes the view location, meaning that when you zoom in, you won’t zoom in to the scene origin.
3. A better way is to click \( \text{Object} \rightarrow \text{Snap} \rightarrow \text{Cursor to Center} \)
   - You can also do this by \( \text{SHIFT} + \text{S} \rightarrow \text{Cursor to Center} \).

17.6. Changing Your Viewpoint, Part Two

Now you’ll learn some additional techniques for obtaining the view you want:

- Panning
- Centering
- Jumping to the camera’s viewpoint
- Zooming in on a selected area
17.6.1. Panning

When you orbited the cube, the viewpoint’s position and direction both changed at the same time. You also can shift the viewpoint up-down or left-right *without* changing its direction. (This is similar to the side-scrolling effect in the classic Mario and Sonic video games.)

This is called *panning*[^3], and it’s an important skill to master. Try it now:

1. Activate a 3D View window by placing the mouse pointer inside it.
2. Now you can:
   - Use `SHIFT + SCROLL` to pan up and down.
   - Use `CTRL + NUM2` and `CTRL + NUM8` to pan up and down in small increments.
   - Use `CTRL + SCROLL` to pan left and right.
   - Use `CTRL + NUM4` and `CTRL + NUM6` to pan left and right in small increments.
   - Click and drag with `SHIFT + MMB` or `SHIFT + ALT + LMB` to pan freely in the view plane.

You will likely find this to be a distraction in some cases. To move the viewpoint position back to the center, snap the cursor to the center, then click *View → Align View → Center View to Cursor*. You could also snap the cursor to the center then press  `CTRL + NUM`.

17.6.2. Centering

When you zoom or rotate the view, you always zoom or rotate around the center of the view.

To make sure everything in your scene is visible:

1. Press `HOME`.

To center the view on an arbitrary point:

1. Move the 3D cursor to the point of interest.
2. Verify the cursor position from a second viewpoint.
3. Press `ALT + HOME` to center the view.

To center the view on an object in the scene:

1. Make sure Blender is in Object Mode.
2. Zoom out until the object is in the viewport.
3. If any objects are selected, use `A` (or *Select → Select/Deselect All*) to deselect them.
4. Select the object of interest by clicking `RMB` on it.
5. Press `NUM` to center the view.

17.6.3. Jumping to the Camera’s Viewpoint

To see the scene as the virtual camera sees it, press \[ \text{NUM0} \]. Afterwards, you can rotate, pan, and zoom normally, but the virtual camera will not follow. To go back to your previous view, press \[ \text{NUM0} \] again. (In the latest versions of Blender, the virtual camera can be made to follow all the changes made in viewpoint while in camera view by checking the option “Lock Camera to View” on the Transform panel. Hit \[ N \] on your keyboard to bring the transform panel. To disable this option you can uncheck that and get back to previous settings.)

17.6.4. Zooming into a Selected Area

Suppose you want to get an extreme closeup of a particular area. Because there’s no center mark on the viewport, you might have to pan and zoom several times to get the desired view.

The shortcut for zooming to an area is:

1. Activate a 3D view window that contains the area of interest.
2. Press \[ \text{SHIFT} + \text{B} \]. A crosshair appears in the viewport.
3. Click and drag with \[ \text{LMB} \] to draw a rectangle around the area of interest.
4. When you release \[ \text{LMB} \], the viewport will zoom in on the area you selected.

17.7. View Navigation

You can also change your viewpoint in the 3D view by “walking” or “flying” through it. To activate this, press \[ \text{SHIFT} + \text{F} \]. By default in Blender 2.70, this puts you in “walk” mode, while earlier versions only offered “fly” mode. (In Blender 2.70 and later, you can choose which one you prefer in your User Preferences, under the Input tab.)

In both modes, helpful prompts appear in the header of the 3D view window to remind you of the key functions while the mode is in effect. When you have reached the position and orientation you want, press \[ \text{LMB} \text{ or Enter or SPACE} \] to end the navigation mode and stay there, or \[ \text{RMB} \text{ or ESC} \] to abandon the navigation mode and be teleported immediately back to your original position and orientation.

17.7.1. Walk Mode

In this mode, you move the mouse to turn your view up/down/left/right, and \[ \text{W}, \text{A}, \text{S} \text{ and D} \] or the corresponding arrow keys to move forward, left, back or right, and \[ \text{L} \text{ and R} \] to move up or down respectively. Hold the movement keys down to keep moving; movement stops as soon as you release them. Pressing \[ \text{MMB} \] will “teleport” you close to whatever objects lie within the crosshairs at the centre of the view.

You can also use \[ \text{TAB} \] to turn on gravity—make sure there is a floor or other object under you to land on! With gravity on, you can no longer use the vertical-movement keys, but you can use \[ \text{V} \] to make jumps. Just \[ \text{TAB} \] again to turn gravity off.
17.7.2. Fly Mode

In this older mode, moving the mouse to change the view works the same as in Walk mode, but the above direction keys (W, A, S, D, E, Q and the arrows) apply “thrust” in the respective directions, so you keep moving after releasing the key; press the key repeatedly to increase your speed in that direction, or press the key for the opposite thrust direction to reduce your speed. Also you can scroll up the mouse wheel to apply forward thrust, or scroll it down to apply backward thrust.

Your current velocity vector automatically changes direction with you when you turn. Thus, for example, you can apply a single burst of sideways thrust while facing an object, and then, without applying any further thrust, keep turning to face the object, and you will go right around it.

17.8. Visibility Layers

Every object in the scene is assigned to one or more of 20 visibility layers.

Visibility layers have many uses:

- You can put scenery, characters, particles, and lamps in different layers, to help organize your scene.
- By changing which layers are visible, you can simplify your view of the scene and work with only one or two layers at a time.
- When rendering, only visible layers are included. You can use this to render your scene layer by layer, checking each layer separately.
- You can configure lamps to illuminate only objects in the same layer.

![Figure 71](left: Viewing layer 1 only. Right: Viewing all 20 layers.)

In Object Mode, you can tell which layers are visible by looking at the twenty small boxes located in the 3D View header between the Transform Orientation menu and the "Lock" button. The top row of boxes represents layers 1 through 10, with 1 being the leftmost and 10 being the rightmost. Similarly, the bottom row of boxes represents layers 11 through 20.

17.8.1. Hotkeys

- To view just one of layers 1..9, press 1KEY .. 9KEY.
- To view just layer 10, press 0KEY.
- To view just one of layers 11..19, press ALT + 1KEY .. ALT + 9KEY.
17.9. Count Your Polys

If you want to count the polygons in your scene, this data is available in the Info Header.
As you can see in the above image, this scene has 507 vertices and 500 faces (polygons).
18. Object Mode

18.1. Introduction

In this module, you will learn some basics about operating in Object mode. This is normally the initial mode that Blender is in when you open a new document; it is the mode where you operate on whole objects, rather than on their parts.

Many of the conventions involving selection and manipulation of objects or parts of objects apply to other modes as well, so this is a good place to start getting familiar with these conventions.
Object Mode

Figure 73
Open a new document, and confirm that you are in Object mode by checking the mode menu.

Select the default cube by clicking on it with \texttt{RMB} . You will see it framed in an orangey-yellow outline.

### 18.2. Object Origin

When you select an object, you will notice a round dot appears, normally in the middle of the object, the same orangey-yellow as the rest of the selection.

This is the object’s \textit{origin}, and it is the reference point for the object’s local coordinate system. Certain kinds of edits to the object can cause this origin to end up at a position well outside the object, in which case operations like transformations applied with reference to the origin may end up not behaving as you expect. But Blender has capabilities to deal with this, which will be explained when you need them.

### 18.3. Multiple Selections

You can select more than one object at a time. With the cube still selected, change your view until you can see both it and the default lamp; select the latter by clicking on it with \texttt{SHIFT + RMB}, so both it and the cube are selected. You will notice that the lamp takes on the orangey-yellow colour, but the cube now has a more reddish highlight.

The \textbf{active} object is the last one selected; other objects can be part of the selection, but the reddish-orange highlight indicates that they are not active. The Properties window shows properties for the active object, not for the entire selection, while operations in the 3D
view like moving and deleting objects will affect the entire selection. Some operations (like
parenting, which you will learn about later) set up a special relationship between the active
object and the rest of the selection, so for these the order of selection of objects becomes
important.

You can remove the active object from the selection with `SHIFT + RMB`; the little spot
indicating the origin of the object’s geometry stays highlighted in the yellow-orange colour,
even though the rest of the object loses the selection highlight. If you do this to an inactive
object, it will make that object active.

Pressing `CTRL + I` inverts the selection—it deselects what was previously selected, and
selects everything else instead. It does not change the active object.

18.4. Selecting Obscured Objects

If multiple objects lie under the mouse, you can choose which one to select by clicking `ALT + RMB`: this will bring up a menu listing the names of the objects, and you can choose
from this menu which one to select.

Alternatively, you can add an object to the current selection, or remove it from the current
selection, by clicking `ALT + SHIFT + RMB` and selecting it from the menu.

18.5. Selecting Everything and Nothing

Pressing `A` does one of two things: if *anything* is selected, it clears the selection (i.e.
selected objects are no longer selected). But if *nothing* is selected, then it selects *everything*.

You will often see instructions to press `A` either once or twice, to ensure that either
nothing is selected, or everything is selected.

18.6. Hiding Things

When working on a complex model or scene, things are liable to get cluttered, making it
hard to see the specific part you’re working on. It is possible to *hide* objects, so they no
longer appear in the 3D view. Just select the object(s) you want to hide, and press `H`.

This is purely a convenience for working in the 3D view; hidden objects still appear
unchanged when you do a render.

Pressing `SHIFT + H` hides everything *but* the current selection. This is a quick way
to banish all the clutter and just narrow the view down to a small number of objects of
interest.

Pressing `ALT + H` brings back all hidden objects, and sets the selection to them. If you
lose track of what is hidden and what is visible, press this to bring everything back.
18.7. Local Versus Global View

Local view is another way of selectively hiding parts of the scene: pressing \texttt{NUM/} hides everything that is not part of the selection, and automatically zooms in or out as necessary so the selected objects fill the 3D view. Pressing \texttt{NUM/} (no substitute key provided for emulated numpad) again restores things as they were before, to the normal global view.

This differs from simple hiding with \texttt{H} in that a render done in local view only shows the objects currently visible in that view. In particular, if your lights are excluded from the local view, you are liable to see black blobs in place of your objects.

**How do I tell I’m in Local View?** Look at the upper-left corner of the 3D view, at the words that describe your current view orientation and perspective settings (e.g. “User Persp”). If the word “(Local)” appears on the end, then you are in local view, otherwise you are in global view.

18.8. Border Select (Box Selection)

A quick way to select lots of objects at once is with the Border Select (box selection). Press \texttt{B} to activate this, and you will see a pair of dotted crosshairs appear centred at the current mouse position. Drag diagonally with \texttt{LMB} to mark out a selection rectangle, then let go, and everything within the rectangle will be added to the selection. Or if you didn’t mean to engage box-selection mode, then as usual pressing \texttt{ESC} will get you out of it.

Alternatively, to remove things from the current selection, after pressing \texttt{B}, drag out the selection rectangle with \texttt{MMB}, and when you let go, everything in it will be deselected.

18.9. Circle Select (Brush Selection)

Another way to select several objects at once is with the Circle Select (brush selection), engaged by pressing \texttt{C}. In this mode, clicking or dragging on objects with \texttt{LMB} adds them to the selection, while \texttt{MMB} removes them from the selection. Thus the mouse becomes a brush that you can use to “paint” objects in or out of the selection.

The circle showing the size of the brush can be adjusted with the mouse wheel. This allows you to use a broad brush for selection of lots of objects at once, or a finer one for better control.

Clicking \texttt{RMB} or pressing \texttt{ESC} terminates Circle Select mode.
18.10. The Manipulator

\textbf{Figure 75}  Manipulator transformation buttons & orientation menu
Figure 76  Manipulator—translations
Figure 77  Manipulator—rotations
The manipulator appears in the middle of the selection. There are three kinds of manipulator as seen in the illustrations. It can be used to apply translations (changes of position), rotations and scalings (changes of size) to objects, and its appearance changes according to which of these functions are enabled. You can click on the menu transformation buttons that appear when the manipulator is visible, to choose one type of transformation, or shift-click to enable more than one at the same time. You can toggle the visibility of the manipulator with \texttt{CTRL} + \texttt{SPACE}, or by clicking the menu button with the red, green and blue arrows.

**Transform orientations:** the “Orientation” menu governs how the axes of the manipulator are aligned, with the default “Global” corresponding to the global coordinate system. Other useful options are “Local”, which corresponds to the local coordinates system of each object, and “View”, which is always aligned to your view.
To demonstrate this, click with **RMB** on the camera, so it is the only object selected. Set the manipulator to do only translations (blue arrow button is selected in menu), and ensure the orientation is set to “Global”. Drag on any of the coloured arrows of the manipulator with **LMB** to move the camera in the corresponding direction.

Now switch the orientation to “Local”. You will see the manipulator arrows re-orient themselves. Note that the Z-direction (blue arrow) is now in the direction of the camera view. The local co-ordinates of the camera have the optical axis of the camera running along the Z axis. By default, that is pointing towards the cube object.

The cube, by default, has its own local Z-direction running vertically.

With the manipulator orientation still set to Local, add the cube to the selection with **SHIFT + RMB**. You will see the manipulator move so it is in the centre of the selected objects. It is now in-between the camera and the cube. Now if you drag the manipulator Z axis arrow with **LMB**, each object will move along its *own* version of that axis. The camera moves towards or away from the cube and the cube rises or falls.

Switch the orientation to “Global”, and try dragging a manipulator arrow again. This time, both objects will appear locked together and will move in the same direction, along the same (global) axis.

### 18.11. Transformation Hotkeys

The manipulator is not the only way to apply transformations to objects: this can also be done via keyboard shortcuts.

Hide the manipulator to reduce clutter. Select the cube, and only the cube, again with **RMB**. Now press **G** to **Grab** the object. The selection outline around the object turns white, as it did when you were dragging with the manipulator, except this time you haven’t pressed any mouse buttons. Now move the mouse without pressing any buttons, and you will see the object move along with it. Press **LMB** or **ENTER** to terminate the movement and leave the selected object at the new position, or **RMB** or **ESC** to cancel the operation and leave the object at its original location.

Similarly, use **R** to **Rotate** the object, and **S** to **Scale** it.

You can *constrain* the movement to particular axes by pressing the appropriate keys after the axis key. For example, press **S** to start moving the cube again, and then press **X** and you will see a bright colored line appear parallel to the global X-axis; now when you move the mouse, the cube will only move along that colored line. Similarly **Y** and **Z** constrain movement to the Y- and Z-axes respectively. The colored lines that appear are a brighter reddish, green or blue that correspond to the red, green or blue lines for the X, Y or Z axes, respectively.

**Transform orientations:** to constrain the transformation to a different set of axes, press the constraint key twice. The coordinate system used depends on the selection in the Transform Orientation menu:

- Local or Global — the transformation happens in the object’s local coordinate system.
- View — the transformation is aligned to view coordinates.
For example, with the default “Global” selection from this menu, select the camera with RMB, press G to move it, then press Z twice, and you will see the coloured line orient itself along the direction of view of the camera.

These axis constraints also work with scaling, and with rotation (which only happens around the specified axis).

You can also constrain movement and scaling to happen along two axes, but not the third one, by holding down SHIFT when typing the axis constraint. For example, G followed by [SHIFT] + Z will constrain movement to the global X-Y plane (i.e. any direction except along the Z-axis). To constrain movement to the local X-Y plane, type the constraint twice: G [SHIFT] + Z [SHIFT] + Z .

Here’s a summary of what the transformation hotkeys do, with and without constraints:

<table>
<thead>
<tr>
<th>Key</th>
<th>without constraint</th>
<th>followed by</th>
<th>followed by</th>
<th>-axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>moves in plane perpendicular to view direction</td>
<td>moves along axis</td>
<td>moves in plane perpendicular to axis</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td>rotates about view direction</td>
<td>rotates about axis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>scales uniformly along all axes</td>
<td>scales along axis</td>
<td>scales uniformly in plane perpendicular to axis</td>
<td></td>
</tr>
</tbody>
</table>

In addition, the hotkey sequence R R enables free rotate , where the object can rotate around all three axes as you move the mouse.

18.11.1. Transforming by Numbers

Sometimes you need to position things accurately, using calculated numbers, instead of estimating by eye. Blender can do that too; simply type the number after the transformation hotkeys before pressing ENTER to confirm the operation. For example, G X KEY ENTER will move the selection by 1 unit in the positive X direction, while G X KEY ENTER will move by 1 unit along negative X. Decimal points are also allowed; thus S IKEY IKEY IKEY IKEY ENTER will scale the selection by a factor of 0.5, or 50%.

Rotation works similarly, using degrees clockwise around the selected X, Y or Z axis.
18.11.2. Transformation Menu

![Transformation Menu](image)

And yet another way is shown at right, in the Transform panel that appears at the top of the Properties shelf (press ⌘N to toggle its visibility at the right side of the 3D view). Here you can see the existing transformations as numbers, and drag the sliders to change them or click and type to enter new values.
18.12. Choosing the Pivot Point

When you do a scaling or rotation operation, you can choose the pivot point, which is the central origin point that remains unaffected by the operation. By default this is the “Median Point”, or centre point of the selection, but the Pivot Point menu lets you choose some other options. For example, select both the cube and the camera, and rotate them (R). By default they will rotate around their common centre. Now go to the Pivot Point menu and choose “Individual Origins”; and rotate your two selected objects with R again, and you will see each one now rotates about its own centre, rather than the common one.

Another useful pivot option is “3D Cursor”, which means the transformation origin is now the location of the 3D cursor.
Finally, the little button with the three dots and double-headed arrow just to the right of the one that pops up the Pivot Point menu is titled “Manipulate center points”; this means the transformations do not rotate the actual objects themselves, only their positions. To see the effect of this, you need to choose a pivot point that is not the object’s origin. Now try a rotation of the object, and you will see that its centre describes an arc around the pivot point, without changing the orientation of the object. Think how the seats in a Ferris Wheel rotate around the wheel’s pivot, yet still maintain their orientation.

Similarly scaling will change the distance between the chosen pivot point and the object’s origin, but will not affect the size of the object itself. A bursting firework scales rapidly in this way.

**Why can’t I rotate or scale objects?** One pitfall you might encounter is that you select an object, try rotating with `R` or scaling with `S`, and nothing happens, though moving with `G` still works. It’s quite likely you have the “Manipulate center points” button active when you didn’t mean to. Check if it’s active, and click it to deactivate if so.

**Hotkeys** — there are keyboard shortcuts for all the above options:

<table>
<thead>
<tr>
<th>Pivot Option</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Element</td>
<td><code>ALT + .KEY</code></td>
</tr>
<tr>
<td>Median Point</td>
<td><code>CTRL + ,KEY</code></td>
</tr>
<tr>
<td>Individual Origins</td>
<td><code>CTRL + .KEY</code></td>
</tr>
<tr>
<td>3D Cursor</td>
<td><code>.,KEY</code></td>
</tr>
<tr>
<td>Bounding Box Center</td>
<td><code>KEY</code></td>
</tr>
<tr>
<td>Toggle Manipulate Center Points</td>
<td><code>ALT + ,KEY</code></td>
</tr>
</tbody>
</table>

### 18.13. Basic Camera Technique

The camera view is very useful for making adjustments to your camera while getting continuous feedback on how the render will look. This view shows a framing rectangle covering the area that will appear in the render, surrounded by a passepartout which gives a darkened view of the surrounding part of the scene. You can use the mouse wheel as usual to zoom in and out, adjusting how much of your view is the rendered area and how much is passepartout.

In this view, use `RMB` on the framing rectangle to select the camera, and it will show the usual orange-yellow highlight. The manipulator will not appear even if enabled, so you must use the transformation hotkeys to perform camera transformations.

Use `G` to move the camera around parallel to the view plane. Since the view stays locked to the camera, you will see the actual scene move *in the opposite direction* to what you might expect.

The camera’s local Z-axis lies along its direction of view. This allows useful operations like `G Z F` to move the camera in or out without affecting the direction in which it’s pointing. Also the X axis runs left to right in the camera view so rotating around X `X X` will adjust the up-and-down *pitch* angle. Rotating around the vertical Y axis `Y Y` will change the *yaw* (left-right) angle, and you can rotate around the optical axis of
the camera using $[\text{R}] [\text{Z}] [\text{Z}]$ to produce an effect of *rolling* the view around the visual axis.

Another useful technique is to position the 3D cursor at a point of interest, set the pivot point to the 3D cursor, then rotate the camera about a global axis, like the global Z-axis ($[\text{R}] [\text{Z}]$), to adjust the angle of view while keeping the same objects in view, and without altering the distance of the camera from the point of interest. In real life you’d get that effect by walking in a circle around your subject with your camera mounted on a Steadicam rig.

Scaling the camera object changes its size as shown in the 3D view, but has no effect on the actual render. Regardless of what axis constraints you try to apply, the camera object will always scale uniformly along all axes.

You can also use Fly mode $[\text{SHIFT}] + [\text{F}]$ in camera-view mode to fly around the scene, taking the camera with you.

Another choice for moving your camera in Camera View is to bring up the Properties panel ($[\text{N}]$) and, in the View section, tick the box next to Lock Camera to View. Now you will be able to use the $[\text{MMB}]$ to “move objects” just as you move things around in other views such as the 3D view. Holding down the $[\text{MMB}]$ and dragging will rotate, $[\text{SHIFT}] + [\text{MMB}]$ will allow you to “move the object” around in the view (panning), and the scroll wheel will allow you to “move the object” closer or farther from the camera. You are actually moving the camera with these manipulations and not the object(s) themselves.
Note:

**Sizing the Camera:** You can scale the camera object with $\text{S}$ as you can most other objects. However, this has **no effect** on what is seen with that camera: think of it as a cosmetic thing you can do to make the camera object easier to spot (if it’s too small relative to other objects in the scene), or scale it down to keep it more in proportion when working with smaller objects.

Another way of changing the displayed size of the camera is to look in the Camera data context in the Properties window, in the Display panel. Here there is a Size field that you can use to increase or reduce the size of the camera.

18.14. **Adding/Removing Objects, Undo/Redo, Repeat**

Select the cube with $\text{RMB}$ again. Press either $\text{X}$ or $\text{DEL}$ and, after confirming the popup, the cube disappears! It has been deleted from your scene. And unlike mere hiding, it really has disappeared. Press $\text{CTRL} + \text{Z}$ to undo your last operation, and it comes back.
Click with LMB to position the 3D cursor somewhere away from the default cube. Press $\text{SHIFT} + \text{A}$ to bring up the Add menu, go to its Mesh submenu, and add another cube to the scene. Again, undo with $\text{CTRL} + \text{Z}$, and you are back to a single cube again.

Now press $\text{CTRL} + \text{SHIFT} + \text{Z}$: this will undo the undo, and redo the last operation you undid, bringing back the second cube.

Try adding a third cube; now $\text{CTRL} + \text{Z}$ should undo that and take you back to two cubes, and pressing $\text{CTRL} + \text{Z}$ again should undo the addition of the second cube, taking you back to one. Try $\text{CTRL} + \text{SHIFT} + \text{Z}$ at this point to restore the second cube, then $\text{CTRL} + \text{SHIFT} + \text{Z}$ again to restore the third one.

Blender remembers up to the last 32 things you did (depending on the limit set in your user preferences) in its undo stack, and you can go back and forth through this with $\text{CTRL} + \text{Z}$ and $\text{CTRL} + \text{SHIFT} + \text{Z}$.

Sometimes you want to perform an action repeatedly. To repeat the last action, type $\text{SHIFT} + \text{R}$.

### 18.15. Assigning Layers

You previously learned about showing and hiding layers in the 3D view. To assign the layers for selected objects, press $\text{M}$. The same keyboard shortcuts apply here as when choosing which layers to display: $\text{KEY}$ for only the first layer, $\text{KEY}$ for only the second etc, $\text{SHIFT} + \text{KEY}$ to include/exclude the first layer and so on.

After assigning an object to a different layer, it disappears! If this happens to you, it’s because the layer(s) you assigned to the object, and the layer(s) you currently have visible in the 3D view, have nothing in common. Simply change the visible layers to include at least one of those you assigned to the object, and it will reappear. For example, if currently only layer 1 is visible, and you assign an object only to layer 2, it will disappear, but reappear when you change the visible layer to layer 2.

### 18.16. Object, Action, Settings

Bring up the Add menu again ($\text{SHIFT} + \text{A}$), and this time add a new cylinder mesh to the scene. Look to the left of the 3D view, in the Tool Shelf (toggle its visibility with $\text{T}$ if it’s not visible); at the bottom you should see a new panel has appeared, titled “Add Cylinder”. Near the top of it is the “Vertices” number, initially defaulting to 32, which gives a fairly round-looking cylinder. Reduce it to 6, and adjust the view as necessary to get a good view of your “cylinder”, and you will see it is now a hexagonal prism. Change the number of vertices to 3, and it becomes a triangular prism.

This is an example of an important user-interface convention that runs right through Blender: first you select the object you want to perform an operation on as appropriate (not applicable here because we are creating a new object), then you perform the specified action with some default settings, and finally you adjust the settings to give the exact result you want. This way, instead of getting a popup before the action is performed, into which
you have to put the right settings and hope they will give the right result, you get to inter-
actively adjust the settings and immediately see the results, without having to continually 
redo the operation and deal with popups.
Part II.

Unit 2: Basic Modeling and Shading
19. Meshes and Edit Mode
20. Normals and Shading

Information

Applicable Blender version: 2.63

Figure 82

Open a new Blender document. Get rid of the default cube, and add a “UV Sphere” mesh. In the “Add UV Sphere” panel which appears at the lower left of the Toolshelf (press T to make it visible at the left side of the 3D view if it’s not), set the Segments and Rings both to a low number like 8. The result will be very angular, as at right—not round like you would expect a sphere to be at all.

Figure 83

Press F12 to do a quick render. The 3D view will be replaced with the UV/Image Editor.
view, showing the rendered image, as at right. Press [F11] to return to the 3D view.
Figure 85

Figure 86
Select the sphere object (RMB). Now look in the Toolshelf for the shading buttons:

![Figure 87](image)

, and click on “Smooth”. Now try a new render with F12.

As you can see, the surfaces of the object look a lot smoother and curved, even though the outline or silhouette is just as angular as before.

![Figure 88](image)

Return to the 3D view with F11. Ensure the UV sphere object is selected, and you are in Edit mode. Bring up the Properties shelf at the right side of the 3D view with N if it’s not already visible. Look for the Mesh Display panel, and find the settings for Normals:

![Figure 89](image)
If you check both icon boxes, the display of the UV sphere should change to look something like at right.

Those spiky little lines are the normals; the green ones in the middle of each face are face normals, while the blue ones sticking out of each vertex are vertex normals.

In the physical theory of how light works, the normal is the perpendicular to the surface of the object that the light hits. When your eye (or the camera) C is positioned on a plane through the normal of a particular surface observing a certain surface point P illuminated by a coplanar light source L, a specific amount of light will be reflected and hence be registered by the camera depending on physical characteristics of the surface. Basically, the observed intensity of reflected light is at a maximum if the angle C-P-L is divided into two equal halves by the normal.

In the real world, a lot of surfaces are curved or otherwise not flat. But a mesh can only be made up of straight edges and flat faces. So how can it represent an object with a curved surface?

When you added the UV sphere to your scene, you had the option of specifying how many segments and rings it was made from. And the more of these there are, the closer the geometry can approximate to a curve. However, the more of these are, the longer the render will take, and the more memory the model will consume to hold information about all the extra vertices, edges and faces.

Which is where that “Smooth” shading button you clicked comes in. It applies a trick called Phong shading: instead of doing the lighting calculation based on a normal for each face as the physical theory says you should, it starts with a normal assigned to each vertex, and interpolates the normal at each point on a face from the vertex normals at its corners, based on the distance at that point to those corners. The result fools the eye into seeing curved, rounded surfaces where there aren’t actually any.

Now, this completely violates the laws of physics. To start with, how can you define a “normal” which is perpendicular to a point? But as you can see, the results look rather good, with relatively little extra computation involved—much less than actually generating all that extra geometry.

As you learn more about computer graphics, you will come across more tricks like this. Physically-accurate modelling is still very difficult to do, even with modern computers, and the results may not look all that good anyway; but by adopting a bit of lateral thinking that goes completely against how physics actually works, we can often, ironically, come up with much more realistic-looking results.

---

1 http://en.wikipedia.org/wiki/Phong%20shading
20.1. Not So Smooth?

If you have been adding lots of vertices, edges and faces to your mesh, you may end up with discontinuities in smooth shading causing unsightly blotches, as shown at right.

Assuming your mesh is constructed properly (e.g. you don’t have edges and faces crossing each other in physically-impossible ways), the most likely reason for this is that the normals in the newly-added vertices and faces are pointing the wrong way. To fix this, select the troublesome part of the mesh (or just select the whole thing) in Edit mode, and press \texttt{[CTRL]+[N]} to recalculate all the normals. Now try a fresh render, to confirm that the shading discontinuity has disappeared.

\begin{quote}
\textbf{Note:}

Note the different meaning of \texttt{[CTRL]+[N]} in Edit mode; in all other modes, it opens a new default Blender document!
\end{quote}
21. More Mesh Editing Techniques

Information
Applicable Blender version: 2.67

You previously scratched the surface\(^1\) of the tools that Blender provides for editing meshes. This page will introduce more of them.

### 21.1. Adding More Mesh Pieces

Start with a default cube again. Select it and \(\text{TAB}\) into Edit mode. Press \(\text{SHIFT} + \text{A}\) to bring up the Add menu; instead of all the submenus with all the objects you could add in Object mode, now you will see only a single menu containing only mesh objects. Select, say, another cube, and use \(\text{G}\) to move it away from the first cube.

If you \(\text{TAB}\) into Object mode, you will see that the two cubes look like separate, disconnected objects, but they are in fact one object, and cannot be selected separately in Object mode. You can \(\text{TAB}\) back into Edit mode, and make connections between the vertices of the two cubes, which you cannot do with separate objects. Therefore:

**Note:**
A single mesh object can be made of separate, disconnected pieces.

### 21.2. Linked Selections

If you have some part of a mesh selected, pressing \(\text{CTRL} + \text{L}\) will select all other parts of the mesh that are connected to the already-selected parts. In the above case of the object made up of two disconnected cubes, you can \(\text{RMB}\) on a single vertex of one cube, then use \(\text{CTRL} + \text{L}\) to select all the rest of that cube but not the other.

Another way to do linked selections is to simply move the mouse over some part of the piece you want to select, and press \(\text{F}\) to immediately select everything connected to that. Conversely, \(\text{SHIFT} + \text{L}\) will unselect everything connected to the vertex under the mouse.

\(^1\) http://en.wikibooks.org/wiki/...%2FMesh%20Edit%20Mode%2F
21.3. Separating and Joining Meshes

You can separate a part of a mesh into its own object. The part you are separating doesn’t have to be disconnected from the rest of the mesh. Simply select the part you want to separate in Edit mode, and press $P$, and in the menu that appears, choose “Selection”. You will see the selected part immediately change to a reddish-orange highlight, indicating it is part of the object selection but not the active object.

Conversely, you can join two or more mesh objects into one. Select all the desired objects in Object mode, and press $CTRL + J$, and you will see them all immediately take on the orangey-yellow highlight indicating they are all the active object. $TAB$ into Edit mode, and you can confirm that you can now edit them all as part of the same mesh object.

21.4. Proper Extrusion

You previously discovered how to add whole new sections to a mesh with $CTRL + LMB$. Blender also has a proper Extrude function, which lets you do this with a bit more control.

Start with the default cube, as usual. Go into Edit mode. Select just the top four vertices. Press $E$ to start extruding, and move the mouse roughly along the direction of the Z-axis. You will find yourself dragging out a whole new face formed from four new vertices connected to the ones you previously selected. You will notice also that the movement of the newly-added part of the mesh is automatically constrained to be parallel to the Z-axis. Press $LMB$ or $ENTER$ to finish the extrusion operation.

Deselect everything. Now try selecting another four vertices of the original cube, say making up a face pointing along the X-axis. Now if you extrude these, you will see that the extrusion is automatically constrained to move only parallel to the X-axis.

A quirk of the extrusion function is that if you press $E$ and then immediately abort with $RMB$ or $ESC$, the additional mesh piece is still created, but it is left in the same position as the original mesh. To really abort the extrusion, you have to undo it with $CTRL + Z$.

21.4.1. More Extrusion Options

$ALT + E$ brings up the Extrude menu, which gives you access to more options, depending on what you have selected:

- “Region”—extrude the entire selected area as one, exactly equivalent to $E$.
- “Individual Faces”—if you have more than one face selected, then they are extruded separately. In particular, any edge common to two selected faces will give rise to two separate extruded edges, rather than one.
- “Edges Only”—extrudes only the edges; new faces are created only connecting the new edges to the existing ones, not between the new edges.
- “Vertices Only”—extrudes only the vertices; edges are created only connecting the new vertices to the existing ones, not between the new vertices, and no new faces are created.
21.5. Edge Loop Selection

*Edge loop*²s are an important concept when constructing meshes. They are so important that Blender provides a shortcut for selecting an entire edge loop with one click: \[\text{ALT} + \text{RMB}\] on an edge or vertex that is part of the loop you want to select, and it will select the entire loop. Alternatively, \[\text{ALT} + \text{SHIFT} + \text{RMB}\] adds an edge loop to the selection; or, if the part you click on is already selected, it will *deselect* the entire loop.

For example, try experimenting with a UV sphere: every line of “latitude” and “longitude” in this mesh is an edge loop.

21.6. Loop Cuts

Sometimes you need to add more vertices to the interior part of a mesh, perhaps to flesh in some detail. The loop cut function lets you add more edge loops between existing ones.

Ensure you are in Edit mode. It doesn’t matter what parts of the mesh are currently selected. Press \[\text{CTRL} + \text{R}\] to activate the *Loop Cut* function. You will see a magenta-coloured loop wrap itself around different parts of the mesh as you move the mouse. You can press \[\text{RMB}\] or \[\text{ESC}\] to abandon the operation at this point, or once you see the loop appearing around the correct part of the mesh, you can use \[\text{LMB}\] or \[\text{ENTER}\] to proceed. Now the magenta colour changes to the usual orange-yellow selection highlight, and will now restrict itself to sliding along this section of the mesh as you move the mouse. If you press \[\text{LMB}\] or \[\text{ENTER}\] at this point, you will end up with a new loop of vertices and edges at the last-shown point, while \[\text{RMB}\] or \[\text{ESC}\] will still create the new loop, but leave it positioned at the midpoint.

When the loop is still at the magenta stage, you can use the mouse wheel to increase the number of cuts to 2 or more. You can also type a number of cuts using \[0\text{ KEY} \ldots \text{9 KEY}\].

21.7. Edge Loop Deletion

Conversely, you can get rid of edge loops as well, reducing the complexity of the surface without leaving holes in it. Select the edge loop (the quick way is \[\text{ALT} + \text{RMB}\] on a component edge or vertex as described above), then bring up the deletion menu (\[\text{DEL}\] or \[\text{X}\]) and select “Edge Loop”. The selected loop will disappear, and adjacent edges and faces will be merged.

21.8. Subdividing Parts

A loop cut always cuts a complete loop. Alternatively, you can *subdivide* just a selected part of the mesh: make your selection, then press \[\text{W}\] to bring up the Vertex Specials menu, and select the top option, “Subdivide”. This will create one cut, but a panel will

More Mesh Editing Techniques

appear at the lower left of the Toolshelf (T) to make it visible at the left of the 3D view if it’s not), where you can alter the number of cuts and other settings. This same option is also available on Edge Specials [CTRL + E].

Another option is the second one on the W menu: “Subdivide Smooth”. This one computes a Catmull-Clark\(^3\) interpolation to give more of a curve rather than a flat subdivision.

### 21.9. Subdivision Surface Modifier

A modifier causes some change to the geometry of an object just before it gets rendered. The change does not affect the object as you view and edit it in the 3D view, or as it is stored in the document (unless you apply the modifier, which makes the change permanent). This allows you to create some complicated effects at render time, while the original mesh stays simple and easy to edit. Modifiers for the active object are applied and controlled in the Modifiers

Figure 91

tab in the Properties window.
A **subdivision surface modifier** (also known as a “subsurf” modifier) applies the Catmull-Clark interpolation discussed above as a modifier. Being a modifier, it applies to the entire object, not just to selected vertices. But since the original mesh is preserved, you use it as a *control cage* to adjust the shape of the interpolated curve.
Start with the default cube selected in Object mode, as usual. Go to the Modifiers tab in Properties. When you select “Subdivision Surface” from the “Add Modifier” menu, a new panel appears as at right. Notice the two value sliders under the “Subdivisions” heading; ‘View’ controls the level of subdivision within the 3D view, while ‘Render’ applies to the actual render; the higher the number of levels, the closer to a curve the interpolated geometry becomes. Having two separate settings for working environment and render allows for faster operation in the 3D view, with the usual tradeoff of lower quality, while still allowing maximum quality for the final render.
Note:

**Keyboard shortcuts:** Because the Subdivision Surface modifier is so heavily used, there is a set of hotkeys for adding the modifier to the current object if it doesn’t already have one, and setting the number of subdivision levels in the 3D view: \textbf{CTRL} + \textbf{1 KEY} .. \textbf{CTRL} + \textbf{5 KEY} for setting the view levels to 1 .. 5 respectively.

As soon as you add the modifier, the appearance of the cube should change to look something like at right (here shown with just one level of subdivision).

The upper part of the panel (from the “Apply” and “Copy” buttons upwards) is common to all modifiers. Note the X button at the right: clicking this gets rid of the modifier. Notice also in here a group of 4 icon buttons in the middle, the leftmost two looking like a camera and an eye: the meanings of these are as follows (from left to right):

- Actually use the modifier during rendering
- Show the modifier effect in the 3D view
- Show the modifier effect in the 3D view in Edit mode (if this is unchecked while the previous one is checked, then the modifier effect disappears while in Edit mode)
- Show the mesh as though the modifier were applied to it when in Edit mode.

Unchecking the first one lets you disable the modifier without losing its settings, while the remaining three can be handy if you’re trying to disentangle the effects of different modifiers during editing.
When the third button is enabled, the mesh will look like this in Edit mode: the original mesh remains highlightable and editable, while a preview of the effect of the modifier is also visible, and responds immediately to any changes made to the original mesh. (Try moving some vertices around, and see what happens.)

The fourth button goes one step further, and pretends the modifier has already been applied, while still only allowing you to edit parts corresponding to the original mesh. (This button affects the behavior of the third button; it cannot be used independently, and may disappear if the third button is unchecked.)

21.10. Sharpening the Curves

The subdivision surface modifier offers a lot more control over the resulting shape than might be apparent from above. For example, you might not want uniform curvature everywhere, you want some parts of the shape to have sharper edges. This can be achieved in two ways:

- by applying a crease value to selected edges
- by strategic positioning of additional vertices in the control-cage mesh.
21.10.1. Applying a Crease

Select the edges where you want the curve to be sharper. Press \( \text{SHIFT} + E \); now as you move the mouse, note how the curve gets pulled more or less closely to those edges. Also, the selected edges take on a magenta colour, indicating that they have a nonzero crease value applied.

This crease value can be directly seen—and edited—in the Transform panel at the top of the Properties Shelf at the side of the 3D view (you can toggle its visibility with \( N \); this ranges from 0.0 (no crease at all, the default) to 1.0 (maximum sharpness of the edge).

21.10.2. Adding Vertices

For example, start with the subdivided cube example as above. Press \( \text{CTRL} + R \) to start a loop cut, and position the magenta outline something like this:

Figure 97

Figure 98
... and move the mouse so the newly-added loop moves closer to one side of the cube. See how the subdivided mesh develops a sharper curve on this side?

To confirm the placement of the new loop, press \[ \text{LMB} \] or \[ \text{ENTER} \] once more.

**21.10.3. Which to Use?**

The basic principle is, the closer together the vertices are, the more control you have over the curve at that point. So the question is, do you just want a sharper edge, or do you want more detail? That will govern whether you need to add vertices, or just apply a crease to the existing edges.
22. Quickie Lighting

Information
Applicable Blender version: 2.63

Figure 101

Open a new default Blender document. Without doing anything else, hit \[F12\] to render the default cube with the default settings. The result should look something like at right.

Note how, because the default light is at the upper right from the camera viewpoint, the lower left visible face of the cube is completely black.

Figure 102

Go back from the render to the 3D view (\[F11\]). Now select (with \[RMB\]) the default light, and either delete it or move it to another layer (with \[M\]). Go to your World tab
Figure 103

in the Properties
window, and look for the Environment Lighting panel

Figure 105
; check the box next to the title, and leave the “E.” (energy) value at its default 1.0. This gives us a pervasive, directionless light, illuminating all objects equally from all directions, which means there will be no shadows. Do another render, and it should now look like at right.

See how we have gone from one extreme—inky-black shadows—to the other—no shadows at all. In the real world, lighting is almost never perfectly uniform, and this variation of light and shade is important to help us distinguish details of the scene around us; without such variations, everything devolves into featureless blobs.

![Figure 106](image)

Now undo your deletion of the default lamp (or move it back to layer 1 from the layer where you hid it). Enable Environment Lighting again, but this time lower the Energy value to 0.1. Do a new render, and it should now look like at right: the shadowed face is still shadowed, but not enough to make it impossible to see any details it may have. This is usually the sort of effect you want, unless you are aiming for really dramatic contrasts.

So the lesson is:

**Note:**
A single light is rarely enough for a good-looking scene.

As you learn more, you will find that it is common to use two or three lights, or even more, to ensure proper illumination of a scene. But in the simpler tutorials, where no explicit details are given about lighting, you can probably get by with the default light, plus a little extra touch of environment lighting to soften the shadows as you added above.
23. Quickie Model

Information
Applicable Blender version: 2.57

Figure 107  Your goal.
In this module, you’ll learn how to extrude and merge vertices of a mesh and how to save a model. This module also introduces the File Browser window type.

Your first model will be a house, with four walls and a pyramidal roof. Simple! And because you’re going to use the default cube as a base, all you actually need to build is the roof!

Editing in Blender generally involves four steps:

1. Selecting an object to edit.
2. Activating Edit Mode on that object.
3. Selecting part(s) of the object to act upon.
4. Specifying the action(s) to be performed on those parts.
Bring up the Default Cube

1. Launch Blender.
2. Load the factory settings using 
   \textit{File} \to \textit{Load Factory Settings}.

This should give you a perspective view of a scene containing three objects:

- a cube,
- a light source,
- a camera.
23.2. Setting up the Viewport

It will be easier to work on the roof of your house in a perspective side view:

1. Press \[ \texttt{NUM3} \] to switch to a "perfect" right side view.

**Note:** \[ \texttt{NUM5} \] puts the viewport into perspective only if it’s not already in perspective. Otherwise, \[ \texttt{NUM5} \] switches the viewport back to orthographic view.

"Right Persp" will be shown on the top left of the 3D View. The "up" ( \( Z \) ) direction in the scene is now "up" on your monitor as well.

It will also help to zoom in a bit:

1. Make sure the 3D View window is active (which means your mouse cursor is in it).
2. \[ \texttt{SCROLL} \] or press \[ \texttt{NUM+} \] a few times until the cube is about 1/3 the height of the viewport.

Because you just loaded the factory defaults, the 3D transform manipulator will be enabled. For mesh editing, it will help to turn the manipulator off:

1. Make sure the 3D View window is active.
2. Press \[ \texttt{CTRL} + \texttt{SPACE} \] to toggle the manipulator on or off.

Press \[ \texttt{TAB} \] once. This puts you into Edit Mode on the selected object(s)—namely, the cube.

**Note:**
If the lamp and/or camera were selected instead of (or in addition to) the cube, you wouldn’t be able to enter Edit Mode. (Cameras and lamps are edited in a different fashion.)

Here’s how the cube should look at this point:
Note:
The *Occlude Background Geometry* button is only visible when Blender is in Edit Mode and the draw type is Solid, Shaded, or Textured.

The default cube is constructed as a mesh. Now that you’re in Edit Mode, you can access the individual vertices, edges, and faces that make up the mesh. The default cube consists of eight vertices, twelve edges, and six faces.
23.3. Adjusting the Height

Right now, all eight vertices are selected, so any vertex edits you make will affect them all. For instance, if you were to move a vertex, the other seven vertices would follow. In order to build a roof peak for the house, you need to alter just the four top vertices of the cube. To do that, you must change the selection so that only those vertices are selected.

1. Turn 'Occlude Background Geometry’ off, so you can see all vertices. Note, in newer versions, this button is called "Limit Selection to Visible.” It is one of the buttons to the right of transform orientation which is to the right of the mode select which should be currently set to "edit mode”.
2. Deselect the bottom four vertices, one by one, using $\text{SHIFT} + \text{RMB}$.

![Figure 110](frame)
The picture on the right shows the cube (in right perspective view and occlude background geometry "off") with the correct vertices selected.

**Note:**
Remember, if you make a mistake, you can undo your work step-by-step by pressing `CTRL + Z`.

Now you’ll adjust the height of your house’s ceiling. Activate the **grab tool**:

1. Make sure Blender is in Edit Mode, with the relevant part(s) of the object selected.
2. Make sure the 3D View window is active.

The 3D View header will be replaced by numbers: "Dx: 0.0000 Dy: 0.0000 Dz: 0.0000 (0.0000)".

You want to lower the ceiling without making the walls crooked. This is hard to do freehand, but happily the grab tool provides an option for doing just that.

With the grab tool activated:

1. Press `Z` to limit movement to the global Z-axis.

![Figure 111](image)

When your ceiling is the height you want, confirm the grab with `LMB` (or `ENTER`).
23.4. Extruding

Now you’re going to “add on” to your house by **extruding**. Extrusion begins by duplicating selected parts of an object. Then the new parts are pulled away from the old ones, with new faces and edges created as necessary.

To add an attic to your house:

1. Make sure Blender is in Edit Mode, with the top four vertices selected.
2. Make sure the 3D View window is active.
3. Press **E** to activate the **extrude tool**.
4. Restrict movement to the Z axis and move the mouse pointer upward.
5. When the attic is the height you want, confirm the extrude with **LMB** or **ENTER**.

**Note:**
At the end of this process only the four new vertices (the upper corners of the attic) will be selected. The others (including the four that were originally selected) will not be selected.

Figure 112  Step 7: the extruded attic, ready to confirm
Note:
If you cancel an extrude operation without confirming it, duplicate vertices and edges have already been created. If this isn’t what you wanted, use $\text{CTRL} + \text{Z}$ to undo the duplication.

23.5. Merging

![Image of the Specials menu]

**Figure 113** The Specials menu

You can change the roof from a flat one to a pyramidal one by merging the vertices of the roof:

1. Make sure Blender is in Edit Mode, with the four top-most vertices selected.
2. Make sure the 3D View window is active.
3. Press \[ W \] to bring up the *Specials* menu.
4. Select *Merge*. (You can also access this by pressing \[ ALT + M \].)
5. The *Merge* menu should pop up, select *At center*.

A message should appear on the Info header saying that 3 vertices have been deleted, this is because in order to merge four vertices into one, three vertices must be deleted.

*Figure 114*  Your house now has a pyramidal roof!
23.6. Saving your Work

To save the current scene in a .blend file:

1. Press F2 (or select File → Save As ). This temporarily changes the active window into a File Browser window.
2. Navigate to the directory (folder) where you want to write the file by clicking LMB on directory names in the File Browser window. (Clicking on "." will take you up one level.)
3. If you wish to name the file something other than "untitled.blend", type a filename in the text box to the left of the "Cancel" button. (The .blend suffix will be added automatically.)
4. Click LMB on the "Save File" button. As soon as the save operation is complete, the window will automatically revert back to its former type.

23.6.1. Saving Further Changes

Once you have saved your work to a file for the first time, you can save subsequent changes to the same file name by pressing CTRL+S and confirming you want to overwrite the existing file.
23.7. Additional Resources

- A Video Tutorial on Edit Mode\footnote{http://www.youtube.com/watch?v=LL-cYoTQI4Q}
24. Quickie Render

Information
Applicable Blender version: 2.63

If you haven’t completed the “Quickie Model” module, do so now. You will need the resulting model for this module.

Now that you’ve created your first model, you’ll probably want to try rendering it. Your first render, with a single light source and only nine faces, should finish quickly. However, as your 3D scenes become more complex, you’ll find that rendering can take a long time.

In this module, you’ll render your quickie model and save the result in various file formats. You’ll also learn how to aim cameras and create lamps.
24.1. Rendering the Quickie Model

1. Launch Blender and load factory settings.
2. To load the house model from the previous module:
   a) Press \(\text{F1}\) or select \textit{File} \(\rightarrow\) \textit{Open} . This temporarily changes the active window into a File Browser window.
   b) Navigate to the directory (folder) where you wrote the file, by clicking \(\text{LMB}\) on directory names in the File window. (Clicking on ".." will take you up one level.)
   c) Click \(\text{LMB}\) on the name of the file you wrote.
   d) Click \(\text{LMB}\) on the "Open File" button. As soon as the operation is complete, the window will revert back to its former type.
3. Press \(\text{F12}\) or select \textit{Render} \(\rightarrow\) \textit{Render Image} . This opens the \textit{Image Editor} so you can watch the render progress.

   • With the new Apple keyboard, use \(\text{FN} + \text{F12}\) to avoid the Mac Dashboard.
   • With Macintosh OS X 10.5, use \(\text{ALT} + \text{FN} + \text{F12}\).
   • With Gnome, use \(\text{ALT} + \text{F12}\) to avoid the Gnome Search Dialog.

\begin{tcolorbox}[colback=gray!10]
\textbf{Note:}
You can stop a render in progress by pressing \(\text{ESC}\) any time when the render window has the focus. Bear in mind that this will stop the rendering of the current frame and abandon any partial results; pressing \(\text{F12}\) will start rendering the image from the beginning again.
\end{tcolorbox}

24.2. Seeing Your Render

By default, pressing \(\text{F12}\) will switch to the UV/Image Editor window, and show you your render there. You can switch back to the 3D view with \(\text{F11}\). Pressing \(\text{F11}\) in the 3D view will switch you to the UV/Image Editor window without redoing the render—you will simply see the same image as last time.

24.3. Aiming the Camera

If you don’t get a picture of the house, or if the picture is not framed well, try moving or re-aiming the camera:

1. Press \(\text{ESC}\) to get back to Edit Mode, if needed.
2. Press \(\text{NUM0}\) to take the camera’s viewpoint.
3. Press \(\text{SHIFT} + \text{F}\) to put the 3D View window into \textit{camera fly mode}.

In camera fly mode, you can:

• \textbf{Pan} and \textbf{tilt} by moving the mouse pointer up, down, left, or right.
• Accelerate by \(\text{SCROLL}\) forwards.
• Decelerate by \(\text{SCROLL}\) backwards.
• Press any key or button to exit fly mode.
Lighting

(It works differently in version 2.70 and later, more like a FPS game with possibility to slide and so on, buttons are regular FPS controls)

When you’re done positioning the camera, try rendering again.

24.4. Lighting

If your cube is completely black, you may not have a lamp in the scene. Either the default lamp got deleted, or you’re using a version of Blender that doesn’t provide a default lamp.

To add a lamp:

1. Make sure Blender is in Object Mode.
2. Place the 3D cursor where you want the lamp to go; or add the lamp then immediately grab it, and move it somewhere else.
3. Press \[\text{SHIFT} + \text{A} \].
4. In the popup menu, select Lamp \(\to\) Point.

24.5. Saving the Render

Saving the scene (with \[F2\], for instance) does not save any renders. Saving renders is a separate step.

To save your current render:

1. Make sure you are in the Image Editor. If not press \[F12\] to render.
2. Press \[F3\]. This temporarily changes the active window into a File Browser window.
3. Navigate to the directory (folder) where you want to write the file.
4. Type a filename in the text box (to the left of the "Cancel" button).
5. To the left of the window, choose your preferred file type.
6. Click \[LMB\] on the "Save as Image" button. As soon as the save operation is complete, the window will revert back to its former type.
24.6. Renderer Selection

Blender offers a choice of different rendering engines for producing images. The menu for selecting from these appears in the Info window (the thin one that contains the menu bar at the top of the default layout). In most of these tutorials, you will leave this choice set at Blender Render. But it is worth knowing what other choices are available:

- Blender Render—the oldest renderer, commonly known as the Blender Internal renderer. Built into Blender right from its early days. Can still produce good results with the right tricks, but considered by the Blender developers to be antiquated and not worthy of continuing development.
- Blender Game—this is the renderer used by the Blender Game Engine. Designed to be fast enough for interactive use in a game, which means there are limitations in the quality of renders it produces. You also use this renderer to create rigid-body physics simulations.
- Cycles Render—for this and other choices, see Advanced Rendering⁷.

---

1 Chapter 152 on page 1145
24.7. Render Control

Figure 118

The top panel under the Render tab
in the Properties window shows 3 buttons and a menu. The first button renders a single frame, equivalent to F12. The other two buttons are more relevant to animations\(^2\). 

The “Display:” menu controls what happens when you press \[ F_{12} \]: the default “Image Editor” causes the 3D view to be switched to the UV/Image Editor showing the rendered image. “Full Screen” causes the UV/Image Editor display to take over the entire screen, while “New Window” makes it appear in a separate OS/GUI window (similar to how older versions of Blender used to work). Finally, “Keep UI” causes no changes to your window layout at all; you have to explicitly bring up the Image Editor with \[ F_{11} \] to see the rendered image.
24.8. Render Image Dimensions

![Image of Blender's Render Image Dimensions settings]

You can control the size of image that Blender creates when rendering. This is specified in the “Dimensions” panel under Render.
properties. Apart from the menu at the top, the settings in this panel are grouped into two columns:

- The column on the left controls settings for a single image.
- The column on the right specifies additional settings for rendering a whole sequence of images as part of an animation\(^3\). These settings will be discussed later\(^4\).

At the upper left, under “Resolution:”, we have the dimensions in pixels of the image (the default settings are 1920×1080 as shown in the screenshot), plus an additional scale factor slider below (showing 50% by default). With these settings, the image will actually be

\(^3\) http://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%20%2F%20Basic%20%2F%20Animation

rendered at \((1920 \times 50\%) \times (1080 \times 50\%) = 960 \times 540\). Having the scale factor is a convenience; rendering smaller, lower-quality images is faster, which speeds things up when you are initially working on your model, but of course you want full quality for the final result. Instead of mentally having to work out numbers for initial- versus final-quality renders, you can simply set the resolution to the full final quality, and use the scale factor to reduce this to, say, 50% or 25% for interim work, and then set it to 100% for the final output.

24.9. Image File Formats

You set the format and location for saving rendered images in the “Output” panel under the Render
In current versions of Blender, the default format for saving rendered images is PNG\(^5\). This is a lossless format which has the option for alpha transparency (which means the sky background is replaced by transparent pixels—enabled by clicking the “RGBA” button). This is a good format if you intend to do further work with the image (e.g. in an image editor like Gimp or Photoshop), but the files can be large.

JPEG\(^6\) is a lossy\(^7\) image format, which means it throws away information that the human eye doesn’t see. This produces much smaller files than PNG, and is adequate if you just
want to upload the render directly for use in a Web page or other such document, but is not
the best choice if you intend to do further processing of the image. It also doesn’t support
alpha transparency.

To change the render file format:

1. Switch to the Render tab in the Properties window.
2. Look for the “Output” panel.
3. Click [LMB] on the popout menu with the current file format.
4. Select your preferred format.

24.10. Additional Resources

- the ”Output Formats” module
- Tutorial on Using Multiple Cameras⁸ ← Pictures are missing from this tutorial
- Ira Krakow’s Basic Blender Camera Positioning (Rigging)⁹

⁸ http://forum.nystic.com/viewtopic.php?f=34&t=2966#
⁹ http://www.youtube.com/watch?v=NzEy2sCZcHo
25. Enter the World
26. Understanding the Camera

26.1. Real-World Cameras

Before discussing the camera in Blender, it helps to understand something about how cameras work in real life. We have become accustomed to so many of their quirks and limitations when looking at real photographs that 3D software like Blender often expends a lot of effort to mimic those quirks.

When taking a photo with a real camera, a number of important factors come into play:

- **the focus** —because of how lenses work, only objects within a certain range of distances from the camera (the depth of field) will appear sharp in the image; objects closer or further than this range will begin to appear noticeably blurred, the blur getting worse the further they are outside the focus range. The narrower that range of in-focus distances (the shallower the depth of field), the more quickly this blurring happens with distance outside it.

- **the exposure time** —how long the shutter remains open. The longer this is, the more light is captured, but also the more likely the image is to pick up motion blur from things moving.

- **the aperture** —how wide the lens opening is. This is expressed, not as an actual distance measurement, but as a fraction of the focal length of the lens (loosely, distance between the lens and the image-capturing surface when the image is properly focused), written as $f$: thus, say, $f/2.8$ (“$f$ over 2.8“, not “$f 2.8$“) is a larger number, hence representing a wider aperture, than $f/8$. A wider aperture increases the amount of light being captured without contributing to motion blur, but it does reduce the depth of field. The extreme case of a pinhole camera has a very tiny aperture with infinite depth of field (no need to focus at all), but captures very little light, so needs a very well-lit scene, a long exposure, or a very sensitive image-capturing surface.

- **the sensitivity** of the image-capturing surface to light. In the days of film cameras, we talked about film sensitivity (“fast” film being more sensitive to light than “slow” film); nowadays with digital cameras we talk about the gain of the light-amplification system. High-sensitivity film was more likely to produce a grainy image; in a somewhat similar way, high light-amplification in a digital camera is more likely to produce a noisy-looking image under low-light conditions.

- **the field of view** —how much of the scene the camera can see at once. A wide-angle lens gives a wider field of view, but you have to be closer to things to be able to see them, and there is also greater perspective distortion. At the other extreme, a telephoto lens gives a very narrow field of view, but can take pictures of things from much further away. A wide-angle lens also has a shorter focal length than a narrow-angle one (remember that aperture is expressed as a ratio of the focal length $f$), therefore the telephoto lens is going to capture less light than the wide-angle one with the same aperture width. You may
also have heard of a *zoom lens*: this is one with a variable focal length, so it can be adjusted for anything from a wide-angle mode to a telephoto mode.

As you can see, many of these different factors interact with each other: the brightness of the image can be affected by any of the exposure time, the aperture, the gain sensitivity and the focal length of the lens, while each of these also has side-effects on the image in other ways.

Blender and other computer graphics software are, in principle, free of the problems of focus, exposure time, aperture, sensitivity and focal length. Nevertheless, it is common to want to introduce deliberate motion blur into an image, to give the impression of movement. Also sometimes it is useful to introduce a deliberately shallow depth of field, blurring objects in the background in order to draw emphasis to the important part of the image that is still in focus.

Exposure (the total amount of light captured in the image) is also less of a problem in computer graphics than in real-world photography, because in computer graphics you always have total control over the amount and placement of lighting in the scene. Nevertheless, if you’re not careful, you can still produce images that are overexposed (bright parts losing detail by saturating at a solid, featureless white) or underexposed (dark parts losing detail by becoming solid black).

The field-of-view issue arises from basic principles of geometry, and Blender’s camera is just as much subject to that as real cameras.

### 26.2. The Camera In Blender

Here we are going to concentrate on the important issue of *field of view*.

You can change the field of view in two ways--move the camera closer to or further from the scene (in film/TV production parlance, this is called *dollying*), or change the angle of the lens (this is called *zooming*). You do the latter in the Object Data
tab in the Properties window (the Camera has to be selected by \texttt{RMB} in Object Mode, or the required tab will not be shown).

*Perspective*\(^1\) is the phenomenon where objects that are further away from the viewer look smaller than those close by. More than that, different parts of the *same* object may be at different distances from the eye, leading to a change in the apparent shape of the object called *perspective distortion*. The mathematical theory of perspective was worked out by Alhazen\(^2\) in the 11th century, and famously adopted by the Italian Renaissance painters four hundred years later.

Here are two renders of the same scene with two different cameras, to illustrate the difference. This one moves the camera closer but gives it a wider field of view:

\(^1\) http://en.wikipedia.org/wiki/Perspective_%28visual%29
\(^2\) http://en.wikipedia.org/wiki/Alhazen
This one moves the camera back, while narrowing its field of view, to try to give the scene the same overall size.
The latter is like using a “telephoto” lens with a real camera. Notice how the wider field of view gives you a greater perspective effect. The boxes are all cuboids, with parallel pairs of opposite faces joined by parallel edges; yet there is a noticeable angle between notionally-parallel edges in both images, which is more pronounced in the upper image. That is what perspective distortion is all about.
26.2.1. Specifying the Field of View

When you select a camera object, its settings become visible in the Camera Context.

Figure 128
Photographers are accustomed to working in terms of the focal-length of the lens: longer means narrower field of view, shorter means wider field of view. But the field of view also depends on the size of the sensor (image capture area); modern digital cameras typically have a smaller sensor size than the exposed film area in older 35mm film cameras. Thus, the focal length measurements have to be adjusted accordingly, in order to give the same field of view.

Blender allows you to work this way, by specifying the focal length in the “Lens” panel, and the sensor size in the “Camera” panel. It even offers a “Camera Presets” menu, which sets the sensor size for any of a range of well-known cameras.

Also, you might be doing compositing of your computer-generated imagery on top of an actual photograph. In which case, to make the results look realistic, you need to closely match the characteristics of the camera and lens that were used to take the photo. So if you know the lens focal length and camera sensor size, it makes sense to be able to plug those values in directly.

Figure 129
But if you’re *not* doing photo compositing, but generating completely synthetic imagery, you might consider this a somewhat round-about way of working. Why not specify the field of view directly as an angle?

Blender allows for this as well. From the popup menu in the Lens panel that says “Millimeters”, select “Field of View” instead, and the Focal Length field will turn into a Field of View field, showing the angle in degrees directly. This is *much* easier to relate to the geometry of the scene!

**Note:**
Relationship between the two: If the width of the sensor is $d$, the focal length of the lens is $f$, and the angle of view is $\theta$, then they are related by $\frac{d}{2f} = \tan \frac{\theta}{2}$.

### 26.3. See Also

- Improving Blender Renders with Photography Techniques$^3$ — another explanation covering similar ground.
- es:Entendiendo la cámara$^4$

---


$^4$ [http://es.wikibooks.org/wiki/Entendiendo%20la%20c%C3%A1mara](http://es.wikibooks.org/wiki/Entendiendo%20la%20c%C3%A1mara)
27. Improving Your House

Information

Applicable Blender version: 2.57

In this module, you’ll refine the house model you created two modules ago. In the process, you’ll learn how to access Blender’s predefined meshes and how to set a pivot point. You’ll also learn how to select, extrude, delete, and subdivide the edges and faces of a mesh model.

To begin, set up Blender as follows:

Figure 131  Your goal.
1. Launch Blender and load factory settings.
2. If you have a numpad, make sure NumLock is on.
3. Load the house model you created in the "Quickie Model" module.
4. If the 3D manipulator is active, disable it.
5. Adjust the viewpoint until you can clearly see two walls of the house and two sides of the roof.

### 27.1. Adding a Ground Plane

Your house needs some ground to rest on. You can model the ground as an object in your scene. Blender has many predefined mesh objects built in. Happily, one of these is a flat, square surface.

Recall that new objects are added at the 3D cursor. Before creating the ground, you should position the cursor at ground level:

1. Select the house by clicking $\text{RMB}$ on it.
2. Enter Edit Mode by pressing $\text{TAB}$.
3. Select one of the bottom vertices by clicking $\text{RMB}$ on it.
4. Bring up the Snap menu by pressing $\text{SHIFT} + \text{S}$.
5. Choose Cursor to Selected.
6. Leave Edit Mode by pressing $\text{TAB}$ so that your ground is created as a separate object.

**Note:**
There’s an "Aligned To View" setting in the "Editing" tab of User Preferences which is off by default in 2.5x. When this setting is on, the orientation of new objects depends on the current viewpoint. Pre-2.48a releases of Blender had "Aligned To View" on by default. If you’ve turned this setting on (or are using an old release) go to "top view" (by pressing $\text{NUM7}$) before creating the ground object.
Now create the ground object:

1. Activate a 3D View window.
2. Press $\text{SHIFT} + \text{A}$.
3. Choose $\text{Mesh} \rightarrow \text{Plane}$.

**Figure 132** The ground added.
To enlarge (or scale) the ground object, use the **scale tool**:

1. Make sure Blender is in Object Mode.
2. Select the ground by clicking [RMB] on it.
3. Activate the scale tool by pressing [S].
4. Type [7KEY] to enlarge the ground 7x.
5. Press [ENTER] or [LMB] to confirm and exit the scale tool.

### 27.2. Scaling with a Pivot

Suppose you want to shrink the house by 50%. As you can probably guess, this would be done with the scaling tool. However, if you did so right now without the right pivot point, the reduced house would no longer rest on the ground. Blender scales (and rotates) objects around a **pivot point**, which by default is located at the **median point** (geometric center) of the selected object(s).

In order to scale the house while keeping its base on the ground, you need the pivot point to be at ground level. Since the 3D cursor is at ground level, you can do this as follows:
1. Make sure Blender is in Object Mode.
2. Select the house by clicking RMB on it.
3. In a 3D View header, click LMB on menu item "Object" and put the mouse cursor over Transform and select Origin to 3D Cursor from the pop-up menu. This can also be done with Ctrl+Shift+Alt+C, select Origin to 3D Cursor from the pop-up menu.

The origin of the house is now at the center of the 3D cursor. If you scale the house, the place where the 3D cursor is located will remain fixed, and everything else will expand or contract from that point. The pivot is marked with an orange-filled circle; do not mistake it for a selected vertex.

### 27.3. Edge Selection

It is often useful to select edges instead of vertices.
1. Make sure Blender is in Object Mode.
2. Select the house by clicking RMB on it.
3. Press TAB to enter edit mode.
4. Click LMB on the Edge select mode button in the 3D View header.

In Edge select mode, edges appear as orange or white line segments when they’re selected and as black line segments when they’re not.

Just as you selected vertices in Vertex select mode, you can now select (and deselect) edges in the same way as vertices. This is also the same for Face select mode.

It may be because those edges are doubled. This can happen if you cancel an extrude operation and forget to undo the duplication. Here’s a solution:

1. Switch to Vertex select mode.
2. Activate a 3D View window.
3. Select all vertices by pressing A once or twice.
4. Press W to bring up the “Specials” menu.
5. Choose Remove Doubles.

27.4. Extruding Edges

You can extrude edges in much the same way as you extrude vertices.

Figure 136  Step 5
To add an overhang to the roof of your house, first move the pivot point to the peak of the roof:

1. Switch to Vertex select mode.
2. Select just the vertex at the peak of the roof.
3. Press $\text{SHIFT} + \text{S}$ to bring up the Snap menu.
4. In the Snap menu, choose *Cursor to Selected* to move the 3D cursor to the peak.
5. Use the ”Pivot” menu (located to the left of the 3D Manipulator button) in the 3D View header to change the pivot to ”3D Cursor”.

![Figure 137](image)

**Figure 137**  After step 2

Now extrude by scaling from that point:
1. Switch to Edge select mode.
2. Select just the four edges at the base of the roof.
3. Press $E$ to activate the extrude tool.
4. Press $S$ to extrude by scaling uniformly from the pivot point.
5. As you move the mouse pointer away from the pivot point, the roof of your house will expand.
6. When the roof is the size you want, confirm by $LMB$ (or pressing $ENTER$).
7. Press $CTRL + SPACE$ to toggle the manipulator on then make the overhangs slanted by holding $LMB$ on the blue arrow that appears in the center of the house, and dragging down.

**Figure 138** After step 7
27.5. Face Selection

It is often useful to select faces.

![Image of cube with different face selection states]

**Figure 139** The select mode buttons after step 2

1. Make sure you’re in Edit Mode on the house.
2. Click **LMB** on the Face select mode button in the 3D View header.

In Face select mode, the center of each face is marked with a small square. Faces appear as orange or stippled grey areas with orange edges when they’re selected (depending on which face is active), and as grey areas when they’re not.

Just as you selected edges in Edge select mode, you can now select (and deselect) faces:

- If any faces are selected, press **A** to deselect all faces.
- If no faces are selected, press **A** to select all faces.
- To select a single face (and deselect the rest), click **RMB** (or **CMD** + **LMB**) on the center of the face.
- To toggle the selection status of a face (without affecting the rest), click **SHIFT** + **RMB** on the center of the face.
Use these techniques to select all three faces (two roof and one wall) on the +X side of your house, as shown.

- This reader would like to remind others that the positive direction of the axis is the direction the arrows point.

### 27.6. Extruding Faces

Just as you extruded edges to grow the roof, you can extrude faces to grow the entire house.
To double the size of your house without changing the pitch of the roof:

1. With the three faces on the +X side selected, activate a 3D View window.
2. Press $E$ to activate the extrude tool.
3. Press $X$ to extrude along the X axis.
4. As you move the mouse pointer in the +X direction, the +X half of your house will expand.
5. Press $2$ to expand by exactly 2 Blender units. (If you scaled your house earlier, you must change this value accordingly, e.g. scaling by 50% means you press $1$.)
6. Confirm and exit the extrude tool by clicking $LMB$ (or pressing $ENTER$).
27.7. Deleting Edges

If you look closely at the model, you’ll notice an extra edge connecting the seams between the two halves of the roof. To delete this edge:

1. Edit the house object in Edge select mode.
2. Select just the edge you want to delete.
3. Press **X** or **DELETE**.
4. When the 'Delete' menu comes up, choose *Edges*.

**Note:**
Deleting an edge automatically deletes any face(s) that include that edge.

27.8. Subdividing Faces

In order to add openings such as doors or windows to the walls of your house, you’ll need to subdivide the wall (vertical) faces into smaller faces.
To subdivide each wall face into a 10x20 grid:

1. Make sure you are not in wire-frame mode (otherwise the occlude hidden geometry button will not appear)
2. Edit the house object in Face select mode.
3. Select all six wall faces of your house.
4. Press $W$ to bring up the *Specials* menu.
5. Choose *Subdivide*.
6. Set the number of cuts to 9 in the Operator panel (also accessible through F6).

**Note:**
In some versions of Blender other than v2.70, there may be a bug that prevents the subdivide function from operating properly.

You might be wondering why to make 9 cuts instead of 10, the reason is that in case of dividing a finite surface along one axis there will be always n-1 cuts to generate n single faces. Here the number of cuts is applied in 2 dimensions. So, if you count the number of faces on the subdivided walls, you will find a 10x20 grid. The reason why there are 20 faces instead of 10 lengthwise is because you doubled the size of the house along the X axis (lengthwise).
Now you can extrude windows and doors:

1. Edit the house object in Face select mode.
2. Turn on the "Limit selection to visible (clipped with depth buffer)” (for old Blender versions "Occlude background geometry”) option by clicking [LMB] on the toggle button in the 3D View header.
3. For each wall of the house:
   a) Go to the perfect view for that wall:
      - [NUM1] for "front"
      - [CTRL] + [NUM1] for "back"
      - [NUM3] for "right"
      - [CTRL] + [NUM3] for "left"
   b) Select faces where you want to create a window or door. An easy way to do this is by:
      i. Deselecting all faces by pressing [A] once or twice.
      ii. Pressing [B] to activate the Border Select tool.
      iii. Clicking and dragging [LMB] to delimit a rectangular area.
      iv. After you release [LMB], all faces in the rectangular area will be selected.
   c) Press [E] to activate the extrude tool.
   d) Extrude inward 1/10th of a BU by typing [-.1] and confirming it with [ENTER] or [LMB].
27.9. Final Steps

1. Adjust the position of the lamp and aim the camera until you obtain a good render.
2. Save your work!
28. Extruding a Simple Person

Information

Applicable Blender version: 2.57

Figure 147  Your simple person will look like this.
In this module, you will model a simple human figure. Along the way, you will practice using extrusion and learn additional ways to select vertices, edges, and faces.

### 28.1. Start a New Scene

1. Start with the default cube (File → Load Factory Settings) and NumLock "on".
2. Press **TAB** to edit the cube.
3. Scale the cube down 50% by pressing **S** keys **ENTER**.

### 28.2. Selection Methods

Just as you did for the house model, you will begin by selecting the top four vertices of the cube. This section presents six methods for doing so.

Ease of selection depends partly on the viewport settings and viewpoint. For greatest ease, you want a view in which the parts you are trying to select are both visible and close together.

For clarity, use a view of the cube in which all vertices are visible:

- Go to right side view with **NUM3**.
- Disable the manipulator widget with **CTRL + SPACE**.
- Make sure the Limit selection to visible option is "off".
The picture on the right shows the cube with the correct vertices selected.
To begin, make sure you start in Vertex select mode.

28.2.1. Border Select Tool

The **border select tool** selects things that lie in a rectangular region of the viewport.

1. Activate (place the mouse pointer in) a 3D View window.
2. Deselect all vertices by pressing $\text{A}$.
3. Press $\text{B}$ to activate the border select tool. Two dashed gray lines should appear, one vertical and one horizontal, forming a crosshair in the viewpoint.
4. Click and drag \[\text{[LMB]}\] diagonally across the area you want to select. The area will be outlined in dashed gray lines.
5. When you release the mouse button, the vertices inside the rectangle will be added to the selection.

Practice selecting the top four vertices this way. If you make a mistake, press \[\text{[A]}\] and try again.

### 28.2.2. Circle Select Tool

The **circle select tool** selects or deselects things that lie in a circular region of the viewport.

1. Activate a 3D View window.
2. Deselect all vertices by pressing \[\text{[A]}\].
3. Press \[\text{[E]}\] to activate the circle select tool. A dashed gray circle should appear. note: Prior to Blender 2.5 \[\text{[F]}\] \[\text{[F]}\] twice.

When this tool is active, you can do various things:

- To move the select area, simply move the mouse pointer.
- To resize the select area, use \[\text{[SCROLL]}\] or \[\text{[NUM+]}\] / \[\text{[NUM-]}\].
- To select all vertices within the circle, click \[\text{[LMB]}\].
- To deselect all vertices within the circle, click \[\text{[MMB]}\] or \[\text{[SHIFT]} + \text{[LMB]}\].
- To deactivate the tool, press \[\text{[ESC]}\] or \[\text{[RMB]}\].

Practice selecting the top four vertices this way. If you make a mistake, press \[\text{[A]}\] and try again.

### 28.2.3. Lasso Select Tool

Like many graphics programs, Blender 3D has a **lasso select tool**.

1. Activate a 3D View window.
2. Deselect all vertices by pressing \[\text{[A]}\].
3. Click and hold \[\text{CTRL} + \text{[LMB]}\].
4. Drag the mouse pointer in a loop around the vertices you want to select. As you drag, a dashed gray line will appear.
5. You can deselect with lasso by pressing \[\text{CTRL} + \text{[SHIFT]} + \text{[LMB]}\].
6. Release the \[\text{[LMB]}\] when you’re done.

### 28.2.4. Vertex by Vertex Selection

You can select (or deselect) vertices one by one, as you did in the "Quickie Model" module.

1. Click \[\text{[RMB]}\] on a vertex to make it the only selected vertex.
2. Toggle the select state of additional vertices by clicking \[\text{[SHIFT]} + \text{[RMB]}\].
28.2.5. Edge Select Mode

You can select (or deselect) edges one by one, as you did in the "Improving Your House" module.

1. Click $\text{LMB}$ on the Edge select mode button in the 3D View header.
2. Select the top left edge of the cube by clicking on it with $\text{RMB}$.
3. Toggle the select state of top right edge of the cube by clicking on it with $\text{SHIFT} + \text{RMB}$.
4. Switch back to Vertex select mode by clicking $\text{LMB}$ on the Vertex select mode button in the 3D View header.

After you switch back to Vertex select mode, all four vertices in the two selected edges are selected.

28.2.6. Face Select Mode

You can select (or deselect) faces one by one, as you did in the "Improving Your House" module.

1. Click $\text{LMB}$ on the Face select mode button in the 3D View header.
2. Select the top face of the cube by clicking on its center dot with $\text{RMB}$.
3. Switch back to Vertex select mode by clicking $\text{LMB}$ on the Vertex select mode button in the 3D View header.

After you switch back to Vertex select mode, all four vertices in selected face are selected.
28.3. Extruding Limbs

The illustrations in this section are in front orthographic view, so:

- Use `NUM4` (or `View → Orthographic`) to switch to orthographic view.
- Use `NUM1` (or `View → Front`) to switch to front view.
28.3.1. Region Extrusion

1. Make sure you’re still in Edit Mode, with the top four vertices selected. (Only two will be visible in front ortho view.)
2. Activate the extrude tool by using E (or Mesh → Extrude Region).
3. Move the mouse pointer upwards. As you do, four new vertices will appear, each connected to one of the four that were previously selected.

The new vertices and their associated edges will move with the mouse pointer. You can lock them into place with LMB or ENTER.

28.3.2. Extruding a Leg

Suppose you want to extrude a region the same size as the default cube -- in other words, one Blender unit on a side.
1. Undo your previous extrude by pressing \texttt{CTRL} + \texttt{Z}.
2. Activate the extrude tool again by using \texttt{E} (or \texttt{Mesh} \rightarrow \texttt{Extrude Region}).
3. This time, as you’re moving the extruded vertices around, hold down the \texttt{CTRL} key. You’ll see that the new vertices will only move in multiples of a Blender unit. This is called \textbf{snapping}, and it makes it easy to extrude by exactly one blender unit. The size of the snapping depends on the zoom level; if you are zoomed out a long way from the object the snapping will be done in large increments and if you are zoomed in close you can snap in finer amounts.

Continue extruding until you have five cubes of equal size stacked atop one another. This will be one leg of your figure.

\textbf{Note:}

Another way to extrude by exactly one Blender unit is to press \texttt{1KEY} while the tool is active.

If you press \texttt{2KEY} when no tool is active, Blender will switch to the second layer, and your (first-layer) object will disappear. To make it visible again, press \texttt{1KEY}.

\textbf{Note:}

If you are not using Front Ortho view, the blender unit will be much larger than the cube. Switching to that view will allow for the proper size, although you can manually enter the extrusion as 0.4 units.

\textbf{Note:}

Don’t extrude any cube more than a unit at a time. You’ll want those extra vertices, edges and faces later in this tutorial.

\textbf{Note:}

If the mesh gets too big for your view, you can zoom out using \texttt{SCROLL} or \texttt{NUM-}.
28.3.3. Extruding the Pelvis

1. Press A until all vertices are deselected.
2. Rotate the view (by dragging MMB) so you can see all four vertices on the right face of the top cube.
3. Select those four vertices.
4. Extrude twice to the right.

28.3.4. Extruding the Rest of the Body

The same trick is repeated over and over to build the rest of our simple body.

Note:
To speed things up, you may want to switch to Face select mode. In Face select mode, you can select a face with a single click.

1. Create a second leg by extruding down four times from the last cube of the pelvis.
2. Create the torso by extruding up five times from the middle cube of the pelvis.
3. Extrude to each side from the next-to-top cube of the torso to create arms. (Making sure there are five on each side. Refer to the picture on the top of the page)

Figure 152  Legs and Pelvis

Figure 153  Torso
To be safe, remove any double vertices you may have inadvertently created:

1. In Vertex select mode, press `A` until all vertices are selected.
2. With a 3D View window active, press `W` to bring up the Specials menu.
3. Choose Remove Doubles.

Now check your work:

1. Return to Object Mode by pressing `TAB`.
2. Make sure the viewport draw type is Solid. (Press `Z` if it isn’t.)
3. Rotate the viewpoint and examine the body from every side (it might be useful to return to perspective view for this).

This is easily fixed. To create a face:

1. Press `TAB` to go back into Edit Mode.
2. Select four vertices.
3. Press `L` (or choose Mesh → Faces → Make Edge/Face from the 3D View header).

- Note that you can also make edges with this tool if you select two vertices.
28.4. Adding the Head

1. Move the 3D cursor to a point above the neck by clicking with LMB.
2. Adjust the cursor position in orthographic top, front and side views (NUM7, NUM1, and NUM3 respectively) until the 3D cursor is about where the center of the head should be. It may help to use \texttt{SHIFT} + \texttt{S} \rightarrow \textit{Snap} \rightarrow \textit{Cursor to Grid}.
3. Make sure you’re in Edit Mode with a 3D View window active. (If you create the head in Object Mode, it will be a separate object from the body, and changes to the body later in this tutorial won’t affect the head.)
4. Create a sphere using $\text{SHIFT} + \text{A} \rightarrow \text{Mesh} \rightarrow \text{Icosphere}$.

5. Leave the default settings for subdivisions and size in the bottom left of the screen. (Note: Your computer may slow down if you set subdivisions above 6)

You should now have a small sphere at the top of the body. To make it more proportional to the body, resize it using the scale tool:

1. Make sure you’re still in Edit Mode, with a 3D View window active and the head selected.
2. If necessary change the pivot point to Median Point.
3. Activate the scale tool by pressing $\text{S}$ (or Mesh $\rightarrow$ Transform $\rightarrow$ Scale).
4. Move the mouse pointer until the head is the size you want.

You may also adjust its position using the grab tool:

1. Make sure you’re still in Edit Mode, with a 3D View window active and the head selected.
2. Activate the grab tool by pressing $\text{G}$ (or Mesh $\rightarrow$ Transform $\rightarrow$ Grab/Move).
3. Move the mouse pointer until the center of the head is where you want it.

**Note:**
If you deselect the head and then decide that you want to select it again:
1. Hover the mouse pointer over any vertex/edge/face.
2. Press $\text{L}$ In Edit Mode this will select all vertices that are linked to the vertex nearest the mouse pointer.

Now check your work:
1. Return to Object Mode by pressing \texttt{TAB}.
2. Make sure the viewport draw type is \texttt{Solid}. (Press \texttt{Z} if it isn’t.)
3. Rotate the viewpoint and examine the body from every side. Make sure that the head connects properly to the neck.

\textbf{28.5. Save Your Work}

You will continue working on your simple person model in the next module.
To save the scene in a .blend file:

1. Press `CTRL` + `S` (or select File → Save).
2. Navigate to the directory (folder) where you want to write the file.
3. Type a filename in the text box to the left of the "Cancel" button.
4. Click `LMB` on the "Save Blender File" button.
29. Smoothing Your Simple Person

Information
Applicable Blender version: 2.57

Figure 157  Your goal.

Few real-life objects have perfectly sharp edges. People, in particular, consist of mainly smooth surfaces. How does one model a smooth object using flat faces and sharp edges?

In this module, you’ll learn how to smooth a mesh by using subsurfaces and smooth shading.

You’ll need the simple person model from the previous module. If you haven’t done it, either go back and do it now or download the pre-made model from Yosun Chang’s website at .

If the model doesn’t look solid, your Viewport Shading setting may be set to Wireframe. To switch to Solid shading:
1. Activate the 3D View window.
2. Press $\mathbf{Z}$.

29.1. Subsurfaces

So far, all the meshes you’ve created have had sharp edges, giving them a faceted appearance like that of a cut diamond. To model a smooth object (like a human body) you might think you’d need a huge number of vertices and faces. **Subsurfaces** partly solve this problem by automatically subdividing a mesh into a finer mesh suitable for smooth rendering.

![Figure 158 The sub surface modifier.](image-url)
Subsurfaces

You subsurface in Blender by adding a **subsurf modifier** to a pre-existing mesh object. A **modifier** is simply an algorithm (automatic process) which can be added to an object. (Blender modifiers are analogous to Photoshop adjustment layers.)

To get started, make sure Blender is in Object Mode, with only the simple person object selected:

1. If Blender is in Edit Mode, press `TAB`.
2. To select the simple person, `RMB` on it.

To add a subsurf modifier to the selected object:

1. Click on the modifiers tab (wrench icon) in a Properties window.
2. **Add Modifier** → **Subdivision Surface**.

The object’s appearance should immediately become more faceted and more rounded. In addition, several subsurface controls will appear in the Modifiers tab.

**Note:**
The modifier has been added, but it hasn’t actually been "applied" yet. (Applying a Blender modifier is analogous to flattening a Photoshop adjustment layer.)

The model may include some double vertices. To get rid of these:

1. Edit the model in Vertex select mode.
2. Select all vertices.
3. **Mesh** → **Vertices** → **Remove Double**
4. Try again.

You need to look in to upgrading (or possibly even downgrading) your graphics drivers. Having the right graphics driver can avert a lot of problems.

What just happened? The default subsurf modifier (one level of Catmull-Clark) subdivided each face of the object into four smaller faces that are progressively angled. This softened the sharp edges of the original model where faces met at 90-degree angles.

### 29.1.1. Controls

For this model, one level of subsurf isn’t quite enough. To increase the number of levels to two, just increase the number in the text box directly underneath **Subdivisions**. The **View** setting controls the number of subdivision levels visible in the viewport. This can be very useful when you have a high-poly scene, just decrease the number of visible subdivisions to speed up viewport action.

You can specify additional levels of subsurfing to be used during renders. For extra smooth renders, you might want three levels of subsurfing. Set this with the **Render** control immediately below the **View** control.

The **Apply** button applies the modifier to the mesh. Do not click it yet; we’ll be playing with the model a bit longer before we want to apply the changes. While useful with some modifiers, applying a subsurf modifier produces a very complex mesh, and there’s no need to do so here.
Smoothing Your Simple Person

Remember that you can undo any accidental modifications with \texttt{CTRL + Z}.

Blender can combine a series of modifiers by \textbf{stacking} them. For this reason, the Modifier tab includes buttons for arranging and removing modifiers.

You can hide edges created by the modifier by activating the \textit{Optimal Display} toggle button. The effect of Optimal Draw is especially clear with the Wireframe draw type.

You can edit the mesh in modified form (without actually applying the modifier) by activating the \textit{Apply modifier to editing cage during Editmode} toggle button, a small button to the left of the Up/Down arrows (the arrows are for changing the position of the modifier in the stack) in the Modifier panel.

Try this out:

1. Press \texttt{TAB} to enter Edit mode.
2. Make sure Blender is in Vertex select mode.
   
   Note that the vertices no longer lie on the surface of the object.
3. Activate the \textit{Apply modifier to editing cage during Editmode} button.
   
   Now all vertices lie on the surface of the object, and you can adjust the (modified) vertices directly. However, any additional vertices created by the modifier cannot be directly edited without applying the modifier.

You will be editing the boxy version of the simple person awhile longer, so before continuing, deactivate the \textit{Apply modifier to editing cage during Editmode} button.
29.2. Smooth Shading

Subsurfaces do a good job of smoothing out corners in meshes. Even with two levels of subsurfaces, however, the simple person does not look completely smooth; when viewed close up, it has a scaly appearance. This is because each face is flat shaded—shaded to resemble a flat surface—resulting in sudden changes in brightness at most edges. For a smooth object, you want smooth shading, which smooths out the changes in brightness.

1. Go to Object Mode.
2. Set the draw type of a 3D View window to "Solid".
3. Select your subsurfed object.
4. In the Toolshelf on the left, look for a caption called Shading. Under it should be a button called Smooth.
   All the mesh edges will be smoothed out, leaving no sudden changes in brightness. The faces blend smoothly into one another, making the edges nearly invisible. If the icosphere has not smoothed properly and is dimpled, enter Edit Mode by pressing TAB, select all vertices (A) and recalculate the normal direction (CTRL+N). This is also available in the Toolshelf under Normals.
5. Click the other button under Shading in the Toolshelf, named 'Flat'.
   The edges will reappear. Now you know the difference between Flat and Smooth.
6. Since the model looks better with smooth shading, click LMB on the "Smooth" button again.
Note that if you didn’t have subsurf enabled, then the mesh wouldn’t look much different. This is because smooth shading doesn’t affect the mesh shape, it just changes how the computer draws the triangles.

Smooth shading also removes a lot of definition. A good way to get rid of this is simply to add a subsurf modifier like you just did. The modifier will not only require fewer vertices, but add definition.

Figure 161  Flat Shading

Figure 162  Smooth Shading
Smooth Shading

Save your work. You will continue refining this model in the next module.

29.2.1. Additional Resources

w:Flat shading\(^1\) w:Gouraud shading\(^2\) w:Phong shading\(^3\) w:Subdivision surface\(^4\)


---

1 http://en.wikipedia.org/wiki/Flat%20shading
2 http://en.wikipedia.org/wiki/Gouraud%20shading
3 http://en.wikipedia.org/wiki/Phong%20shading
4 http://en.wikipedia.org/wiki/Subdivision%20surface
30. Improving Your Simple Person

Information

Applicable Blender version: 2.57

In this module, you’ll edit a subsurfed mesh using the scale and grab tools, all the while improving your character.

You’ll need the simple person model from the previous module. If you haven’t done it, either go back and do it now or else download the pre-made model from Yosun Chang’s website at .

30.1. Widening the Torso

To be realistic, the simple person’s torso needs to be three times wider. In order to keep the torso symmetrical, you’ll expand it by scaling both sides from a central point.
Select the sides of the torso:

1. Enter edit mode on the simple person.
2. In the 3D View header, set Face select mode.
3. From the 3D View header, choose Pivot → Median Point.
4. In the 3D View header, make sure Proportional Edit button is off.
5. Select the two faces on both the left and right sides of the torso, between the armpits and the waist.
Note:

Figure 164  The cube icon toggles the visibility of certain components.

When editing in solid mode, the vertices, edges and faces on the back side of the model are, by default, invisible. This feature can be toggled by clicking LMB on the Limit selection to visible (called in older versions, ”Occlude Background Geometry”) button in the 3D View header. Toggle it on and off a few times and observe how the back faces appear and disappear.

We will now scale the torso with the scaling tool:

1. Activate the 3D View window and press S, X.
2. Adjust the amount of scaling. Either:
   • Move the mouse pointer until the torso is the width you want.
   or
   • Press 3
3. Confirm and exit by pressing ENTER or clicking LMB.

Note:
Scaling faces causes adjacent edges and faces to move, due to their shared vertices. You cannot separate a face or edge from its vertices.

Continue selecting different parts of the torso and scaling them to get more practice using the above scaling methods.
30.2. Bending the Arms

![Removing the forearm](image)

When you’ve got the basic shape of the torso, make the person hold up his hands. You’ll do this by deleting the forearms and then extruding upward from the elbows.

Select both forearms:

1. Enter edit mode on the simple person.
2. In the 3D View header, set Face select mode.
3. With the 3D View window active, press $\text{A}$ until all vertices are deselected.
4. Select the five faces at the end of the forearm.

Now erase them:

1. Press $\text{X}$ to open the Delete menu.
2. Choose $\text{Faces}$.

The forearm will disappear, leaving a hole. Don’t panic; we’ll fix it later. Now to make the arm point upwards:

1. Select the top face of the last remaining “arm cube”.
2. Extrude the region upward by two Blender units $\text{E}$, $\text{Z}$, $\text{2}$ and confirm with $\text{LMB}$ or $\text{ENTER}$.

(Newbie comment: on my system, using Blender 2.70a, you want E2 above, not EZ2. Z-axis constraint is on by default, so pressing Z turns it off and causes trouble.)

The hole in the elbow is caused by a missing face. To fill in the missing face:

1. Deselect all vertices.
2. Select the four vertices surrounding the missing face.
3. With the 3D View window active, create the face using either...
- Mesh → Faces → Make Edge/Face
  or
- $\text{F}$

**Note:**
If a Make Faces menu appears when you try to fill the hole, it may be that you have some doubled vertices. You can remove doubles by selecting the whole mesh in edit mode, then pressing $\text{W}$ and in the appearing menu "Remove Doubles" and try again.

The new face should be smooth. If it isn’t, make it so, using Mesh → Faces → Shade Smooth.

*Figure 166*  Repeat on the other side
Go through the same steps (erase, extrude, and fill) on the other arm. Be sure to deselect all vertices in the first arm before selecting any in the other arm. If you have difficulty making the arms symmetrical, undo your work and go through the steps simultaneously on both arms.

### 30.3. Making Feet

To make feet for your simple person, you subdivide the ends of the legs and pull the front edges forward.

1. Edit the simple person in Face select mode.
2. Select the two bottom faces of the legs (front of the feet) by clicking $\text{RMB}$ on the first and then $\text{SHIFT} + \text{RMB}$ on the other.
3. Subdivide both faces, either with:
   - $\text{W Subdivide}$
   - $\text{Mesh} \rightarrow \text{Edges} \rightarrow \text{Subdivide}$

Each face gets subdivided into four smaller faces.

Now select the front edges and pull them forward:

1. Switch to Edge select mode.
2. Press $\text{A}$ until no edges are selected.
3. Select the four bottom front edges of the soles (two for each feet) (where the toes should be).
4. Press $\text{G}$ and limit movement to the Y axis.
5. Move the mouse pointer until the feet are the length you want.
6. Confirm and exit by pressing $\text{ENTER}$ or $\text{SPACE}$ or clicking $\text{LMB}$.

![Figure 167](Image)

Congratulations! You now have feet.
30.4. Reshaping the Head

When you’re satisfied with the torso and limbs, you should do something about that head. A bit too spherical, isn’t it? You can elongate it by scaling along the Z axis.

When scaling the head, you want to make sure that it stays connected to the neck.

First, place the 3D Cursor at the base of the head, where it meets the neck. An easy way to do this is as follows:

1. Go into Vertex select mode.
2. Make sure the Limit selection to visible option is “off”.
3. Select the vertex at the base of the head using RMB.
4. Snap the cursor to this vertex using SHIFT + S Cursor to Selected

Now select the entire head:

1. Hover the mouse over a vertex/edge/face of the head
2. Press E to select all parts linked to that part.

Note:
This works even when the head and body meshes overlap, so long as they aren’t linked together anywhere.

Tell Blender that you want to pivot around the 3D Cursor by changing the pivot point to 3D Cursor on the Pivot menu (the small button located to the left of the 3D Manipulator button).

Now scale the head along the Z-axis, using the scale tool (S), scaling by 1.5 should be about right).
You’ll need this simple person later, so remember to save your work!
31. Spinning a Simple Hat

### Information

Applicable Blender version: 2.57

In this module, you’ll create a hat for your simple person. Along the way, you’ll learn how to use the Spin tool and use layers.

#### 31.1. Creating a Generatrix

For future convenience, you’ll create the hat as a new object in the scene containing the simple person. If you haven’t created the simple person, either go back and do it now or else download the pre-made model from Yosun Chang’s website at .

Start by changing layers to layer two, then add the basis for your hat:

![Figure 169](image)

1. Make sure you’re in Object Mode (so that a new object will be created).
2. Click LMB on the second little square, this will make the viewport display layer two. (The top row is for layers 1 to 10, the bottom for 11 to 20, so layer 2 is immediately to the right of layer 1; layer 6 is across the space from layer 5.)
3. Go to orthographic front view by pressing NUM .
4. Create a mesh circle at the cursor, by activating the 3D View window, pressing SHIFT + A and choosing Mesh → Circle .

**Note:**
The new circle will probably look more like a line segment than a circle. If so, it’s because you’re viewing the circle edge-on.

The new mesh object doesn’t actually have to be a circle. You could use any sort of mesh object here because you’re about to reshape it into a custom 2D mesh (called a generatrix) that describes the profile of your hat. More precisely, the generatrix describes one side of a vertical cross-section through the hat. You’ll want your generatrix to have a slope; it should be higher on one side (which will become the top of the crown) than on the other (which will become the brim).
1. The newly-created mesh should be selected. If it isn’t, select it by clicking RMB on it.
2. Press TAB to edit the mesh.
3. Activate Vertex select mode.
4. Press A until all vertices are selected.
5. Press X to erase all vertices.

**Note:**
Some users are confused as to the purpose of creating the mesh only to delete it afterwards. The point of this process is to create a new "blank" object which you can then shape into a hat.

Now draw your generatrix, starting with the brim and sloping upwards toward the top of the crown:

1. Make sure you’re still in orthographic front view.
2. Press CTRL + LMB to create the first vertex.
3. Press CTRL + LMB to one side of that vertex to extrude another vertex, connected to the first by an edge.

(If this doesn’t work, make sure you are in vertex select mode.)

Keep adding vertices until you’re satisfied with the shape of your generatrix. You can always undo using CTRL + Z or go back and adjust the positions of particular vertices using the grab tool.
The mesh is then spun around an axis perpendicular to the viewplane. You want to spin around a vertical axis, so press \texttt{NUM7} to switch to top view.

### 31.2. Spinning the Hat

![Figure 171](image)

The spun hat, drawn as wireframe in orthographic front view.

Now let’s actually spin the hat:

1. Move the 3D cursor to the vertex you want to spin around by pressing \texttt{LMB} on it. You can also use the snapping tool for positioning the cursor more precisely by pressing \texttt{SHIFT+S} after selecting that specific vertex. \textit{Cursor to selected} positions the cursor.
2. Press \texttt{A} to select all the vertices. The Spin control only spins vertices that are selected.
3. Press \texttt{ALT+R} to activate the Spin tool.
   - The Spin tool is also available in the Tool Shelf under \textit{Add}

You should now see 90° of a generatrix! To spin your hat all the way round, press \texttt{F6} or look in the Operator Panel just below the Tool Shelf. There should be an input slider named \textit{Angle}, change this value from 90 to 360. There should also be a slider called \textit{Steps}, increase the value from 9 to 15.

If your hat has a large hole in the center, you must have accidentally moved the 3D cursor away from the vertex you picked in step 1. Try again.

Remember that if you spin an object 360° there will be a double row of vertices at the row of vertices you spun. To fix this, press \texttt{A} to select all vertices, press \texttt{W} and select \textit{Remove Doubles}. Note that this will only work in vertex select mode.

You may also want to merge the vertices at the top of the hat. Do this by selecting all the vertices at the top with \texttt{C} and pressing \texttt{ALT} + \texttt{M} → \textit{At Center}. You may have to do this twice as some vertices might be beneath each other.
You have more than one 3D View window, so Blender is asking which window to perform the spin in. Click LMB on the window that is showing top view.

### 31.3. Smoothing Your Hat

You’ll probably have noticed that normal hats aren’t usually as faceted as yours! To change this, first press TAB to go back to Object mode then change the shading to Smooth (available on the Tool Shelf). If there are unexpected black marks, try recalculating the normals.

1. Switch to Edit mode and open the Mesh menu in the 3D View Header.
2. Normals → Recalculate Outside.

Next, add a Subsurf modifier to the hat and set the subdivisions to two, as you did in the "Detailing Your Simple Person 1" module.

1. Click on the modifiers tab (wrench icon) in a Properties window.
2. Add Modifier → Subdivision Surface.

Save your work. You’ll need this scene for the next module.
31.4. Additional Resources

w:Surface of revolution\footnote{http://en.wikipedia.org/wiki/Surface\%20of\%20revolution}

- http://www.youtube.com/watch?v=-mPtxa_MEPA Ira Krakow’s Hat Creation Video Tutorial, based on this page.
32. Putting the Hat on the Person

Once you’re satisfied with the shapes of individual objects, you’ll want to combine them into a coherent scene. You do this in Object Mode.

In this module, you’ll learn how to use move objects to and from layers. You’ll also learn how to rename and parent objects, and you’ll get an introduction to Outliner Windows.

You’ll need the person-and-hat scene from the previous module. If you haven’t done it, either go back and do it now or else download the pre-made model from Yosun Chang’s website at .
32.1. Adjusting an Object’s Median Point

1. Load the person-and-hat scene.
2. Make sure Blender is in Object Mode.
3. Switch to Layer 2, select the hat and press $M$. A dialog box will pop up for you to choose which layer to move it to. Either press $I$ (the number on top of the keyboard, not the numberpad) or select the first box in the popup.
4. Select the person you made earlier.

Just as you did in Edit Mode, you can specify the pivot for rotating and scaling objects in Object Mode. If you just finished the previous module, the pivot is probably set to ”3D Cursor”. If so, change it back to ”Median Point”.

Figure 173  The person that you (yeah you!) made with the origin in his geometric center.
In Edit Mode, the "Median Point" for pivoting is the geometric center of all selected vertices, edges, or faces. In Object Mode, however, it’s the origin of the selected object’s local coordinates, indicated by an orange dot. In other words, the origin might lie far from the object’s geometric center.

You can use buttons in the Tools Shelf to reunify an object’s origin with its geometric center:

1. With Blender in Object Mode, click [LMB] on *Set Origin* in the Tool Shelf (under the "Edit" sub menu of *Tools*) and select *Origin To Geometry* (Blender 2.70: "Object" -> "Transform" -> "Origin to Geometry") to move the selected object’s origin to its geometric center (without changing the object’s appearance).

**Note:**
When more than one object is selected, Blender uses the average of their median points as the median point for pivoting.

This can be useful when you want a better picture of your object. With the origin set to the person’s geometric center, you can now snap the object with [SHIFT+S] to the 3D cursor. This will let you view more of the model at one time and make for a faster editing workflow.

### 32.2. Positioning the Hat

![Figure 174 Positioning the hat](image)
Putting the Hat on the Person

Once you have the hat properly oriented, move it into position on the person’s head. The grab tool enables you to position objects in Object Mode in the same way you positioned vertices, edges, and faces in Edit Mode.

1. Make sure Blender is in Object Mode.
2. Click RMB on the hat object to select it.
3. Activate the grab tool by pressing G.

As you move the mouse pointer, the hat will move around in the viewport. By default, the movement plane is perpendicular to the view axis, so the hat will move differently depending on which viewpoint you’re working in.

Just as in the Edit Mode grab tool, you can:

- Restrict the direction of motion by pressing X, Y, or Z. Press once to move parallel to a global axis, twice to use a local axis. (Press the same key a third time to return to view-plane motion.)
- To restrict motion to the global X-Y plane, lock the global Z by pressing SHIFT + Z.
- Hold down CTRL to restrict motion to discrete steps (typically one Blender unit).
- Hold down SHIFT to get finer control over the motion.
- Click LMB or press ENTER to finalize the position and exit the tool.
- Click RMB or press ESC to return the object to its previous position and exit.

Use two different orthographic views to position the hat on the person’s head. You will probably want to scale the hat to make it fit the person’s head better. When you are doing this along the X or Y axis, make the changes symmetrical by specifying the axes you want scaling to be constrained to. This option is available in the Operator panel (just below the Tool Shelf) and also by pressing F6.
32.3. Parenting the Hat to the Person

Figure 175  The parenting menu.

Once you have the hat properly sized and positioned on the person’s head, you’ll want it to stay there. In order to maintain such a cozy relationship between two objects, you’d have to remember to select them both before rotating, moving, or scaling. A drastic solution might be to join them into a single object using $\text{CTRL} + J$.

A better compromise is to Parent the hat to the person. Parenting creates a relationship between two objects, such that certain changes to one object (called the Parent object) automatically affect the other (called the Child object). Changes to the child, however, do not affect the parent.

Note that an object can have many children, but only one parent.

Since the person is bigger than the hat, it’s logical to parent the hat to the person (meaning: parent = person, child = hat) instead of vice versa.

1. Make sure Blender is in Object Mode.
2. Click **RMB** on the hat object to select it.
3. Click **SHIFT + RMB** on the person object.
   Both the person and the hat should now be selected. The order of selection is important here.
4. Press **CTRL + P** to parent the hat to the person.
5. Select **Object**. The most recently selected object becomes the parent of all other selected objects.

**Note:**
Pressing **P** in the object mode instead of **CTRL + P** will start the Blender game engine. To stop the game engine, press **ESC**.

Now when you move the hat you will see a line from the hat to the person, indicating that the person is the hat’s parent. And if you move the person, the hat will move with it.

You may get an error saying something like *Loop to Parents*, fix this by clearing all previous parents with **ALT + P**.

### 32.4. Renaming Objects

![The renaming dialog](image)

When you have multiple objects in a scene, it helps to give each one a name.

Click on the **Objects** tab in the Properties panel (the one with a box icon).

1. Now select the hat by clicking **RMB** on it.
2. At the very top of the tab you should see a dialog box with the name of your object...
• The hat’s name might be something like "Circle" depending on which mesh primitive you first built the hat from.

3. Click [LMB] on the dialog box and type in a more descriptive name like "Hat".

You have now changed the name of the hat’s object datablock. This name change will be reflected in the Outliner, which we will look at shortly.

Now select your person by clicking [RMB] on it and repeat the process, changing the name to something like "Person".

32.5. Outliner Windows

![Outliner window](image)

**Figure 177** The Outliner window.
Once you give objects names, it helps to have a way to find objects by their name and parent. This is exactly what the Outliner is for and it comes in very handy when you are working with a large scene. The Outliner is usually just above the Properties panel, you may want to pull it down a bit to see it more clearly.

You’ll notice that all the objects in your scene (Person, camera etc) are listed and that you can select these objects by clicking $LMB$ on them. And if you click $RMB$ on an object, a menu will pop up with options like Select, Deselect, Delete etc. If you select the Person and then click the "+" sign to its left, you will see that the Hat is listed below the person. This is because Blender lists all children objects beneath their parents.

On the right of each object there are a series of icons which represent the state of the object. For example, the eye icon means that your object is visible in the 3D viewport. You can turn off its visibility by clicking $LMB$ on the eye, which will turn grey; click again on the eye to make it visible. If you hover the mouse over the icons a text box will pop up with a description of what that particular icon does.

### 32.6. Good on ya’ mate!

Congratulations!! You have now finished your simple character. Pat yourself on the back, and have a celebratory coffee! (Or pop!)

### 32.7. Additional Resources


When you get to the sites for the ‘gestures and groups/parenting’, these are for an older version of blender, just click on the drop down where it says "Blender 2.4" and choose 2.6. Im only a random user and I dont know how to edit the links on here.
33. Overview
34. Quickie Material

Information
Applicable Blender version: 2.59

In this module, you will create a new material called "Green Ooze". Along the way, you will learn how to alter the diffuse, specular, and mirror colors of a material.
34.1. Your First Material

The cube in the default scene (which you get from File → Load Factory Settings) has a simple grey color. Now click on the Materials context.
Figure 179

in the Properties
The materials context contains various menus, but for now you only need diffuse, specular and mirror. The material is named and linked in the panel above the preview window. (Linking is a feature that allows materials to be shared between multiple objects (or datablocks). Changing a material affects the appearance of everything it is linked to.)

The first row of the window above the preview window indicates that:

- there is one material assigned to this object and its name is "Material".

The second row of controls indicates that:

- The current selected material’s name is "Material".
- This material will only be saved if it’s in use.
Your First Material

- It is not a "Nodes" material.
- Instead of being linked directly to an object, the current material is linked to a datablock.

To rename the material, click \( \text{LMB} \) on the name and enter the name you want.

To unlink the material, click \( \text{LMB} \) on the \( \text{X} \) button to the right of the material name ("Material"). This deletes the link to the datablock, removing the material from the mesh. As a side-effect, most of the panels in the Material context disappear. You will see in a moment, however, that the material still exists. It hasn’t been deleted; it is simply no longer in use.

At this point, you could click \( \text{LMB} \) the "New" button to create a new material, but instead we are going to reapply the old material:

1. Click \( \text{LMB} \) on the figure to the left of the "New" button.

![Figure 181](image)

2. You’ll see a nifty drop-down list containing all materials you’ve created so far. Choose \( 0 \) Material.

Materials whose names are preceded by "0" in this list are not in use. By default, Blender doesn’t save such materials when it saves the scene. Thus, you can delete a material from the list by saving the scene and then reopening it. You can override this behavior by toggling the "F" button "on" for unused materials you want saved.
Your materials will be much easier to find and manage if you give them brief, descriptive names you can recognize at a glance. Change this one’s name to “Green Ooze”. In addition, naming of your materials and other objects in your scene is useful when such components of your scene will be appended in another scene of a different Blender file. Naming your materials and other stuff in the scene will enable you to choose the right objects and materials you need whenever you wish to append just a portion of a whole bunch of work you did. For instance, you’re working on a new Blender project, but felt the material you used in this Blender file is worth it. Instead of going through the pain of creating a new material (of course you guessed in the initial one in getting the right material appearance), you just append the material to your new work. Pretty simple! Make naming a habit, as it’s much used in a production environment.

### 34.2. Specifying Colors

Since changing the name of the material doesn’t change its properties, you still have some work to do.

Simple materials are specified by three colors: diffuse, specular and mirror. Rectangular patches (swatches) of the colour in their own panel in the Material context allow you to see and change each of these. Diffuse color is the basic underlying color of the material, rendered by the diffuse shader. Specular color is for highlights (small bright spots on a shiny surface) as rendered by the specular shader. Mirror color is for true reflections rendered using ray-tracing.

There are many ways to define colours. Blender supports three:

- **RGB**: By specifying relative amounts of red, green and blue primary colours, by giving a number from 0.0 to 1.0 for each component. For example, \((R, G, B) = (0, 0, 0)\) specifies black (no colour at all); \((0, 1, 0)\) is full green; \((1, 1, 0)\) (full red + full green) is yellow; \((0.5, 0.5, 0.5)\) is 50% grey, and \((1, 1, 1)\) is full white (maximum intensity of all components). Note that this is additive mixing of colours, which is what happens when you shine lights of different colours onto a white screen, not the subtractive mixing that takes place when you mix different-coloured paints or inks on paper or canvas.

- **HSV**: By specifying a hue (colour position on the rainbow) together with a saturation (strength of colour, from garish down to pastel, with zero giving shades of grey) and value (brightness). This is generally considered to be easier to use than RGB notation when you are trying to create new colours (as opposed to copying a colour spec from somewhere else), since it is easier to predict what the likely result will be. HSV is commonly represented on a colour wheel, where the hue is the angle around the circle, saturation the distance from the centre, and value controlled by a separate brightness slider (as shown below).

- By specifying a 6-digit hexadecimal number. This is just an alternative form of RGB notation, commonly used for colour specifications in Web pages.
If you click on any colour swatch, the colour picker will pop up, allowing you to change the values. This is the most intuitive way. The window that appears will look like this and will include the following (Figure 2):

1. A color wheel to change the color as you want. In HSV mode, H corresponds to angle around this wheel, while S corresponds to distance from the centre.
2. Three color sliders that will change if you change the color in the colorwheel. You can also change the values with the sliders.
3. A slider that controls the intensity of the color. This corresponds to the V in HSV.
4. A pipette capable of sampling colors from any Blender window or render window.

![Blender’s colour picker popup](image)
5. Buttons that can change it to "HSV" or "HEX" mode.

- Alternatively you can specify hue, saturation and value components by clicking LMB on the "HSV" button and pushing the sliders around accordingly.

- You can also press the last button and enter the hexadecimal (or HEX) code. This is simply a different representation for RGB, where the hex digits represent \texttt{rrggbb}.

HSV is probably the most easily understandable way of specifying and experimenting with colours. However, as is common with most computer systems, all colours in Blender are represented internally as RGB.

If you want to get rid of the window just click LMB anywhere else.

\textbf{Note:}

\textbf{Duplicate intensity sliders?} There are two ways to control the intensity of the colour: there is the vertical intensity slider at the right of the colour picker popup, and there are also the intensity fields at the bottom of the Diffuse and Specular panels (above), the final intensity being the combination of both values. Why two different ways? Partly this is to allow a quick way to moderate or intensify the diffuse or specular components, without having to change the actual colour specification. But more importantly, this is to ensure that \textit{intensities are never set to 100\%}. The reason is that this can cause rendering calculation problems, leading to total light intensities accumulating to infinity instead of converging to a finite value. This is probably not a big issue with the Blender Internal renderer, but can become a problem with more advanced renderers\textsuperscript{a}.

\textsuperscript{a} Chapter 152 on page 1145

The most used method of creating a color of your own is using the color wheel, but because we want to be sure you will get the exact same color as us we will use the sliders. Use the above methods to set the diffuse color to R=0.149, G=1.000, B=0.446 (or use the HEX code: \texttt{6CFFB2}). If you look in the "Preview" panel, you will see that the material is now bright green.

Most real-life materials (other than metals) don’t alter the color of specular light. For this reason, Specular and Mirror are usually left at their default values (white). For green ooze, however, you’ll disregard this rule-of-thumb:

1. Click LMB the sample rectangle below the Specular window.
2. Use the color selection dialog to adjust the specular color and watch the Preview panel to see how this color affects the sample sphere’s highlight.
3. Set the specular color to R=0.640, G=0.990, B=0.566 (or use the HEX code: \texttt{D1FEC6}).

With these values for Color and Specular, you should be able to get a good ooze later on. The Preview, Diffuse and Specular panel should now look like this:
Specifying Colors

Figure 183

![Diffuse and Specular Color Settings](image)

Figure 184

**Diffuse**
- Intensity: 0.800
- Roughness: 0.500

**Specular**
- Intensity: 0.500
- Hardness: 50
As you can see, there are many other material buttons. Many of these will be explained in later modules. Suggestions for creating specific materials may be found in the "Every Material Known to Man" module.

Save this scene before proceeding. You will need it for the "Quickie Texture" module, in which you will perfect your ooze.

**Note:**

**Copying/Pasting Colours:** Quite often, you will want to duplicate or move a colour specified in one place to another. If the two colour swatches are simultaneously visible, you can use the eyedropper button in the colour picker. But if they are not, then the easiest way is to bring up the colour picker for the colour you want to copy, switch to the hex display, select the 6 hex digits, and copy them with \[\text{CTRL} + \text{C}\]. Then go to the colour you want to make the same, bring up its picker in hex mode, select the hex digits, and replace them with what you copied using \[\text{CTRL} + \text{V}\].

### 34.3. Additional Resources

- [w:HSL and HSV](http://en.wikipedia.org/wiki/HSL%20and%20HSV)
- [w:RGB color model](http://en.wikipedia.org/wiki/RGB%20color%20model)
- How to Assign a Different Material to Each Face of a Cube at [www.youtube.com/watch?v=hCYViRJFf5w](http://www.youtube.com/watch?v=hCYViRJFf5w)
35. Multiple Materials per Object

Information
Applicable Blender version: 2.74

Figure 185  The finished render.
Multiple Materials per Object

In this module, you’ll create a beach ball with two alternating colours. Along the way, you’ll learn how to apply multiple materials to a single object.

Many real-life objects have parts which are different colours, or are even made of different materials. One way to model such objects is to make each part a separate Blender object. However, Blender also allows you to assign different materials to parts of a single object.

### 35.1. Set the Scene

Begin by opening Blender and removing the default cube. Then select the lamp and change its type from ‘Point’ to ‘Hemi’ in the Light settings in the properties window (object data button), this has the advantage of it giving more light.

![Figure 186](image) The options for changing lamp type in the properties window

Now create a mesh for the beach ball:

1. With the 3D View window active, press `SHIFT + A` and choose Add → Mesh → UV Sphere.
2. In the "Add UV Sphere" panel in the bottom of the tool shelf, specify 8 segments and 4 rings.
   The initial result will be crude, but meshes with fewer vertices are easier to edit.

Make the mesh rounder and more organic using automatic subdivision:

1. In the "Properties" editor, select the "Modifiers" context (wrench icon).
2. Select "Add Modifier" and click Generate → Subdivision Surface.
3. For the number of subdivisions, set both the ‘View’ and ‘Render’ count to 2.

Get rid of that blocky look:

1. Ensure you’re in Object Mode.
2. In the tool shelf, select the "Tools" tab.
3. In the "Edit" panel of that tab, set the shading to Smooth.

---

1 Chapter 18 on page 121

274
The ball is now round, but a bit prolate. To make it more spherical, scale it by about 1.1 along the X and Y axes. To select the X-Y plane, you select ‘not $Z$’, by using the key combination $\text{SHIFT} + [Z]$. The complete sequence is, then, $S$, $\text{SHIFT} + [Z]$, 1.1.

### 35.2. Colorize Time

Now you’re ready to begin adding colors to the object:

1. Press $\text{TAB}$ to put Blender into Edit mode.
2. In the Properties editor, select the "Material" button
3. Press "$+\text{ New}$".
   A new material appears in the material slot list, and several additional panels appear below to edit the created material.
4. In the "Diffuse" panel, click on the default white diffuse color and change it to a nice yellow.
   At this point, the entire ball is yellow.
In the "Materials" panel click the "+" button (indicated by the red box in the picture, below) next to the material slot list to create a new blank slot. The "+ New" button will reappear (indicated by the blue box, in the picture below).
Click the "+ New" button and a new material will be created and assigned the empty slot in the materials slot list. Ensure that the new material is selected, then change the diffuse color to blue. Nothing will happen to the beach ball, yet.

Now make a single blue stripe on the ball:

1. All the vertices should still be selected from before; make sure the 3D view is active, then hit [A] to deselect them.
2. Switch to front view with [NUM1], and to "Face Select" mode with [CTRL] + [TAB] then [F].
3. To avoid accidents, make sure that the "Limit selection to visible" option is enabled in the 3D View header bar.
4. Select a column of four faces that will make up one stripe of the beach ball (using [SHIFT] + [RMB] on each face):
5. In the "Material" property window, select the blue material slot in the list, then click the "Assign" button.

Rotate the view (e.g. NUM6) so you can skip past a yellow stripe adjacent to the blue stripe, and select the second column that will become a blue stripe. Work your way around the ball to do this two more times. (Remember we made the sphere with 8 segments; four of these are yellow, and four are blue).

Now you see the benefit of making a sphere with only 4 rings: more rings would have meant more faces in each stripe, and more clicking to select them.
There are different kinds of shiny materials. Consider the difference between a shiny metallic object, and one made out of a glossy nonmetallic material (like plastic or ceramic). This page will explain some simple techniques for (approximately) mimicking the appearances of these materials using shader settings in the Blender Internal renderer.

For all the following manipulations, start a new Blender document, get rid of the default cube, and replace it with a UV sphere. Set it to be smooth-shaded. Change the lamp falloff to be inverse linear, just to make the scene brighter. Assign the sphere a new default material. It is the settings of this material we will now proceed to play around with.
36.1. Making It Plastic

Figure 191

For a plastic or glossy effect, give the material a diffuse colour, but leave the specular colour at white. Increase the specular intensity to something like 0.9.

(In this and the following examples, I used a diffuse colour of \#E7398B.)
36.2. Making It Metal

Now change the specular colour to be the same as the diffuse colour. (The easy way to do this is to bring up the specular colour picker, click on its eyedropper icon, and use the eyedropper tool to click on the swatch showing the diffuse colour.) Also lower the specular hardness from its default value of 50, to something like 25 or even 12. This will spread out the specular highlight, giving the impression of a surface that is shiny, but not perfectly smooth. Also lower the diffuse intensity, to something like 0.05.

To make the metal more convincing, you may want to choose a more typical metal colour, like grey, copper or bronze.
36.3. Making It Ceramic

Let’s try for a glazed-ceramic look, or perhaps some dark, shiny stone like obsidian. Set the specular colour back to white (the easiest way to do this is to switch to HSV view in the colour picker and set the S(aturation) value to 0). Increase the hardness to something like 200 to narrow and intensify the specular highlight. Leave the specular intensity high and the diffuse intensity low.

To get an even more sharply-focused highlight, change the specular shader model from its “CookTorr” default to “WardIso”. The “Hardness” parameter gets replaced with a “Slope” instead; leave this at the default 0.1.
37. Texture Settings

Information

Applicable Blender version: 2.68

Figure 194  Material texture settings
In the Properties window, you will find the Texture Settings.
Figure 196

context, which looks like at right.
At the top you will see a row of three icons
Texture Settings

Figure 197

, which indicate texture settings to view and change:

Figure 198
World Texture — a texture to use for the sky backdrop

Material Texture — a texture associated with the currently-selected material
Brush Texture — a texture used for some other purpose.

There are two main types of textures in Blender:

- Image/Movie textures
- Procedural textures (all other types in the Type menu).

An image/movie texture allows a two-dimensional image (which might be static or moving) to be wrapped around the surface of a three-dimensional object in some way. Alternatively, a procedural texture directly maps a predefined three-dimensional mathematical function to the surface coordinates of the object.

The “Coordinates:” popup menu defines how positions on the object surface are mapped to positions within the texture coordinate space. All of these options specify automatic mapping algorithms, except one: the “UV” option. This one lets you work within the UV/Image Editor, where you *unwrap* the surface of the mesh onto a flat rectangle showing
the texture image (this really only works with Image/Movie textures), and then move sections of the mesh around to make them show corresponding parts of the texture.

The “Projection:” popup menu further controls how the two-dimensional surface of the object is mapped to a two-dimensional Image/Movie texture. It seems to have no effect for procedural textures.

The “Offset:” and “Size:” X, Y and Z values allow simple adjustments of the position and scaling of the texture. Note that the size values work the opposite way to what you might expect: larger values here make the texture smaller along the corresponding dimension.

The image at right shows the common settings panels for all material texture types. Additional panels will appear depending on the chosen texture type; the settings shown are for the “None” texture, which is the same as having no texture at all.

### 37.1. Material Textures

A material may have more than one texture associated with it. At the top of the material texture settings (see above), is a list of the texture slots associated with the material. Slots may be empty (unused), and slots containing a texture may be enabled or disabled, by checking or unchecking the box at the right of the list item. Disabling a texture slot stops it having an effect on the material, which is the same as deleting the texture from the slot altogether, except it is easier to revert. This can be useful when trying to debug the effect of a combination of textures on the material.
37.2. World Textures

You previously saw how to set up colours for the sky in the World Settings\(^1\); you can also add a sky texture as well.

World texture settings look similar to material settings: again there are a number of slots, and there are mapping and influence options. But the mapping coordinates types are different (and there is no UV option), and the influence types are more limited.

**Note:**
Note that the only Influence checkbox checked by default is “Blend”.

If you’re wondering why your texture definition here is making no difference to your sky, either make sure the “Blend” checkbox is checked in your World settings, or check the “Horizon” Influence box here if you don’t want a sky gradation.
To understand how the texture settings apply to image/movie textures, start with an example texture. A nice simple one is this checkerboard at right—don’t forget to download it in (or convert it to) PNG format, as Blender cannot use an SVG file as a texture.
Start a new Blender document. Note the default cube already has a default grey material, called “Material”, and this already has a single texture, called “Tex”, of type “None”, which means it has no effect.
Note:
Before proceeding, go to the World context and turn on Environment Lighting (you can leave its default energy at 1.0). This will ensure the cube is more evenly lit, for easier visibility of the texture effect.
context of the Properties window, with Material Texture
selected, change the texture type to “Image or Movie”. You will immediately see some new panels pop up in the texture context. Look for the Image panel, as at right. This initially contains a popup menu icon for selecting from any previously-loaded images (this will start out empty), a “New” button for using one of Blender’s predefined test textures, and an “Open” button for loading an image from a file.

Click the “Open” button, and select your previously-downloaded or converted PNG version of the example checkerboard texture.
Now a whole lot more settings will become visible. From the top, the panels are:

- **Preview** — gives you a simple display of how the texture looks.
- **Colors** — lets you make simple adjustments to the image brightness, contrast etc.
- **Image** — lets you choose from any already-loaded images, and shows you the pathname of the file the image was loaded from. Note the two arrows in a circle to the right of the pathname display: clicking this will tell Blender to reload the image from the file, which is useful if you make changes to it in an external image editor.
- **Image Sampling** — controls how the image can be interpreted in a different way from straight pixel values.
Image Texture Settings

- Image Mapping — lets you crop the input image, and apply fixed numbers of repetitions to it along each axis, even before it goes through the usual texture-tiling repetition process.
- Mapping, Influence — these are more general panels that apply to all types of textures. They will be discussed in more detail shortly.

Note:
Image packing: the icon to the left of the image pathname lets you pack a complete copy of the image into the .blend file, so it no longer keeps reading the original image file. This can be useful if you want your .blend file to be self-contained, particularly if you want to send it to others. On the other hand, if your workflow depends on coordinating with someone else doing the image editing, it may be more convenient to leave it linking to a separate image file.

Figure 210  Projection: flat; axes: X→X, Y→Y, Z→Z
If you render [F12] now, you should end up with an image like this. Notice in the Projection menu (Texture → Mapping) the initial selection is “Flat”: this means that the texture X and Y coordinates go straight to object X and Y coordinates. Thus, the texture only appears on the top (and also bottom) of the cube, not on its sides. See also the three little popup menus just below the Projection menu, each containing the items X, Y and Z. These let you rearrange the object coordinates that the texture coordinates map to. If you change the first two, you can get the texture to appear on other pairs of sides of the cube, other than the top and bottom. The third menu (corresponding to the Z axis of the texture) has no effect (yet), because a flat image texture is only two-dimensional.

![Figure 211](image.png) Texture size increased to 3.

Now try changing the three “Size” fields in the Mapping panel: give them all a value of 3. This will uniformly shrink the texture pattern to one-third of its original size. Or
alternatively, it will require three times the number of texture repetitions to span the same distance as the original.

![Texture projection set to Sphere](image)

**Figure 212** Texture projection set to Sphere

Now let’s try the other Projection types. Here’s what “Sphere” looks like. Imagine the texture pattern as a flat sheet stretched and curved around, and its edges joined to form a sphere surrounding the actual object; then the sphere is shrinkwrapped down onto the object.

Note the top and bottom edges of the sheet shrink down to single points at the north and south poles; this is why the squares of the checkerboard pattern turn into triangles next to these points.
Note:
Z-axis now works: because these projection types other than “Flat” turn the texture into a 3-dimensional object, you can now use all 3 of the axis-rearrangement menus to reorient the texture in interesting, not to say confusing, ways. What happens when you assign the same texture axis to more than one object axis?

Figure 213  Texture projection set to Tube

Here’s a Tube mapping. Here the texture pattern sheet is rolled round into a cylinder, with only one pair of edges joined together, the top and bottom left open.
And lastly, here is a Cube mapping. Here 6 copies of the texture pattern are arranged parallel to the faces of a cube, before being shrinkwrapped onto the actual object. Which in this case, happens to be a cube.

Cube mappings are very commonly used in game engines, because they are just about the simplest way to wrap a texture around an entire object.
38.2. Making Your Own Texture

Procedural texturing is very powerful; however, sometimes it is difficult or impossible to generate the desired realism with them. Image texturing is there for you when you need it. To review, the basic idea is to take an outside image and wrap it around your model. You can use any texture, or a seamless one if you want it to repeat to get a tiled effect. The following shows how you create a seamless texture, and then how to apply any texture (seamless or otherwise) to an object.
38.2.1. The difference between 'tiled' and 'seamless'

In many cases a simple material will just not cut it for an object, and you will want to apply a texture to it. However, depending on the object, you may want to apply either a seamless or tileable texture. A seamless texture is an image that will, when applied to an object, spread evenly across the surface of the object without any visible borders or 'seams' even if the object is many times larger than the resolution of the image (also called 'procedural textures' in Blender). These can be useful in many situations; such as when you want a texture for a carpet to seamlessly repeat itself without having a huge resolution.

A tileable texture on the other hand, is an image that will repeat itself across an object, but with noticeable seams. Any image can be used as a tileable texture, but often they will only be used in specific instances such as a vinyl floor with a tiled pattern on it.

See Using Textures\textsuperscript{1} for more details on applying images as textures, and using them to affect many other surface attributes such as luminosity, reflectivity, translucency, displacement etc.

38.2.2. How to make a tileable texture with the GIMP

Figure 216

\textsuperscript{1} Chapter 79 on page 731
It is easy to create a tiling texture image with the GIMP\(^2\). Start with the photo you want to use. Crop out any part you don’t want. Here’s an example random photo of some plants in my garden:

![Figure 217](image-url)

Go to Gimp’s “Filters” menu, and find the “Map” submenu. In here you will find the entry “Make Seamless”. Select it. That’s it:

\(^2\) [http://www.gimp.org](http://www.gimp.org)
Just to prove it works, here’s a (scaled-down) use of the result as a tiled fill pattern:

3.8.2.3. Other Image Texture Editors

- Wood Workshop\textsuperscript{3} A free utility (Requires Operating System: Windows 2000/XP) that generates surprisingly high quality tiling wood texture images. These textures can be exported as standard image files for use within Blender.
- MapZone\textsuperscript{4} A free utility for Windows (works perfectly in Wine\textsuperscript{5}) that generates node based procedural texture maps. Mapzone can export diffuse, normal and alpha texture maps as standard image files. It can also import SVG regions created with Blender’s UV mapping tools.

\textsuperscript{3} http://www.spiralgraphics.biz/ww_overview.htm
\textsuperscript{4} http://www.mapzoneeditor.com/
\textsuperscript{5} http://winehq.org/
39. Procedural Textures

Information
Applicable Blender version: 2.70

Procedural Textures

Texturing objects can be broken down into two categories: procedural and image texturing. Procedural texturing makes use of mathematical formulas to generate textures. This is nice because it can be used to make relatively nice looking textures without external images which are very temperamental where you put them. Procedural Textures are all stored in the .blend file. These textures are obviously generated within Blender itself. Image texturing uses images created or captured outside of Blender, either from an image manipulation program such as the Paint.NET, GIMP or Photoshop, or captured on a camera. We have already learned about image texturing, so let’s move on to procedural texturing.

Current Procedural Textures

Blender currently supports many procedural textures, including: Clouds, Marble, Stucci, Wood, Magic, Blend, Noise, Musgrave, Voronoi and DistortedNoise.

39.1. A Simple Wood Texture

Let’s define a simple wood texture:

- Start a new Blender document containing the default cube.
- Select the cube (and nothing else)
- Go to the Materials tab
in the Properties Window, and rename the default "Material" to "Wood Material". Alternatively, delete the default material using the X to the right of the name field and add a new material.

Let’s add some color and texture. You can see the results at any time by pressing F12 to re-render the scene.

Start by painting cube a base color using the Wood Material’s "diffuse" color:

- In the “Material” tab,
- Scroll down to the “Diffuse” properties panel and choose a darker brown color e.g. #A57E3F.


Next, let’s add a texture to give the material some highlights.

- Switch to the “Texture” properties tab
, and again rename the default "Tex" to "Wood Texture" or create a new texture. Notice at the very top of the "Texture" tab "Cube > Wood Material > Wood Texture"

- Change the Type of the material to “Wood” using the pop-up menu.

The texture sample will show parallel alternating black and white bars that don’t look very woody at all. Never fear! The black regions will be the material’s base “diffuse” color. The white regions are like “highlights” that will be painted over the base.

Let’s make some improvements to the texture:

- While still in the “Textures” tab,
- Scroll to the “Wood” properties panel that appears, change the waveform from “Sine” to “Saw”.
- In the next row of buttons down, change the type from the default “Bands” to “Ring Noise”.
- Increase the Noise Size to 1.0.

Now the texture sample should show something resembling wavy tree-rings. If you hit F12 to render now, you will see these rings covering your cube, except a) the colour is wrong, and b) normal wood patterns aren’t so nearly circular.
To make the pattern more elongated:

- Scroll to the “Mapping” properties panel,
- Change the Size X value to 2.0 and Y to 0.4. This squishes the pattern down along the X-axis, and stretches it out along the Y-axis, giving the elliptical tree-ring shapes you commonly see on wood planks and boards.

Hit F12 to render again, and the shape of the texture should be looking a lot more woody now.

The final step is to color the highlights in the texture:

- In the “Textures” tab,
- Scroll to the “Influence” properties panel further down,
- Click on the color swatch, and choose a nice brown colour.

For a nicer effect, I chose a very light brown e.g. #DEB887.

The result should look very woody indeed!
Figure 221

- Remember that you need to Render to see the wood grain on your object.
40. Quickie Texture

**Information**

Applicable Blender version: 2.70

Textures are laid on top of materials to give them complicated colors and other effects. An object is covered with a material, which might contain several textures: An image texture of stone, a texture to make the stone look bumpy, and a texture to make the stone deform in different ways.

A texture may be an image\(^1\) or a computed function\(^2\). What the texture does and how it is mapped onto your object is set in the material buttons. Some commonly used texture types are shown on the page Using Textures\(^3\).

This tutorial uses the file from the Quickie Material\(^4\) tutorial. If you didn’t do it before, go back and do it now.

---

1 Chapter 38 on page 293
2 Chapter 39 on page 309
3 Chapter 79 on page 731
4 Chapter 34 on page 263
40.1. Making It Mottled

The file we’re working with has no texture by default.

To **add a texture**:

- Bring up the *Texture* tab

**Figure 222  Figure 1**: A simple Clouds texture
Making It Mottled

in the Properties window.

• The top panel shows a list of texture slots for the current material. In Blender v2.70, there should already be a texture in the first slot called "Tex". If it is not present, click on the + New -button under this list. This will create a new texture, attach it to the current material in the first slot, and select it ready for adjustments to its settings.

• Select the texture type Clouds in the pop-up menu. You can also change the texture’s name, as we have done for the material.

A preview appears, as well as some parameters to experiment with. A Clouds texture provides some irregularities.

• If you check back in the Materials tab, you will see a preview of the texture applied to the material in a garish magenta colour. This is the default influence colour for a new texture; presumably it was deliberately chosen to stand out as a reminder to make you switch to settings other than the default!
40.2. Adjusting the Influence

![Figure 224](image)

Figure 224  Figure 2: Default texture mapping & influence settings

If you scroll down the Texture settings in the Properties window, you will see two further panels, titled Mapping and Influence. The Influence panel controls how the material is affected by the texture. Among the ways it can do this are:

1. RGB color (all images, Magic, every texture with a colorband)
2. Intensity, either as grey scale or/and an alpha value (most of the procedural textures, image textures with alpha, textures with a colorband)
3. Normal values (*Stucci*, normal maps), which give the material a bumpy or grainy appearance

If you want to use textures you always have to be aware of the value a texture provides and the *Influence* settings for the material.

If you look at the above default Influence settings, there is just one box checked, in a group titled “Diffuse:” (which means the texture influences parameters for the material’s diffuse shader). The labels next to the checkboxes will probably not be visible in the default window width; if you widen the window, you should see the word “Color:” appear in the value slider. Alternatively, hover the mouse over either the checkbox or the slider, and you will see tooltips that mention “diffuse color”.

A *Clouds* texture provides a monochrome intensity value, ranging from 0 (where the texture is black) to 1 (where the texture is white). If you click on the colour swatch at the bottom of the Influence panel, you can alter the colour that is applied to the texture intensity value.

- Set the influence colour to black.

Procedural textures are not shown in the 3D window (only if you would use excessive amounts of vertices), even if you use GLSL materials. This means that we have to render the image to see the texture properly.

- Render the image (F12), or use the preview to judge the result of the texture.
Next we will add a *Stucci* texture to make our clouds look bumpy.
40.3. Making It Wrinkly (Bump Map)

- In the Texture panel in the Properties window, click on the second (empty) slot in the list of textures at the top. All the settings for the texture you previously created should disappear. (But of course they haven’t really gone, as you can confirm by reselecting the texture in the first slot.)
- Add a new texture here and set the type to *Stucci*.
- In the *Influence* panel, uncheck the Diffuse Color influence and, in the group titled “Geometry”, check the first box (titled “Norm”). This means it affects the rendered normal, i.e. the angle the renderer treats the surface as - creating fake shadows on the surface.
- Play with the *Norm* slider, but leave it on about 4.
The *normal* in physics and geometry is a vector perpendicular ("normal") to a surface. It is used to calculate the effect of lighting. In computer graphics, we find we can achieve all kinds of interesting effects by having the normal point in some other direction than actually normal to the surface. As, in this example, by perturbing it from one pixel to the next according to the value of a texture function, we can give the impression of a more complex geometry than a simple smooth surface, *without actually generating such a geometry*. In other words, like many things in 3D graphics, this is a lie and a cheat, and you can tell because the outline border of the object is still smooth—the bumps only appear on the visible parts within the silhouette.

Such a use of a texture to fiddle the surface normal is called a “bump” map or “normal” map. If it were used to actually generate new geometry, then it is called a “displacement” map—of course, this becomes much more computationally expensive. Since bump mapping is fake 3D, it doesn’t necessarily look good under every circumstance, you will get a greater effect on smoothly curved surfaces with high specularity, only a little or no effect on flat surfaces with low specularity.
41. Halo Materials

Information
Applicable Blender version: 2.63

41.1. Introduction

Halos are a neat effect. Instead of giving a colour/texture to the faces of a mesh, like normal Surface materials do, the Halo material ignores the faces and renders representations of the vertices instead. This can produce all kinds of ethereal, even ghostly, fantasy effects, of objects that look like they’re made out of light rather than ordinary solid matter.

A halo material can also produce a flare effect. This is the “lens flare” that happens when a physical camera is aimed at a very bright light source; the spillage of light bouncing around inside the optics produces coloured rings and other interesting artifacts on top of the image. This has become such an accepted part of photography that computer graphics programs like Blender, which do not suffer the imperfections of physical lenses, go to a great deal of trouble to offer a realistic flare effect.

This tutorial will show you how to create an image representing a flare effect in a picture of the Sun.

41.2. Setting The Scene

Open a new default Blender document. Get rid of the default cube. Insert a new UV Sphere mesh in its place, and set the number of segments and rings to 24 each. Also set Smooth shading. This will be your Sun. Create a new material for it, set the Diffuse colour to a suitable yellow. Under the Shading panel in the material settings, look for the “Emit:” slider and give it a value of 1.0 to make it look bright. Since the Sun emits its own light, you don’t need the separate default light, so get rid of that.

Go to the World properties tab
In the “World” panel at the top, click on the colour swatch labelled “Horizon” and assign a nice deep blue colour for your sky.

If you do a render now, you should see your bright yellow orb, but without any flare effect.

41.3. Adding The Flare

Now add a new Circle mesh; the default 16 vertices should be enough. By default it lies in the X-Y plane, which again is fine. Move it along the Y-axis a little closer to the camera (negative-Y direction), until it lies outside your Sun sphere, but still close to it. Scale its size down by 0.5. (It will probably be invisible when first created, because it is initially inside your Sun sphere, but it will be initially selected, so you can immediately press $G$)
and start moving the mouse without pressing any buttons, and make it appear from inside the Sun). Create a new material for it, and set the type to Halo.

In the Halo panel in the Material settings, increase the size to 3.0—this is the size of the fuzzy image that is rendered around each vertex, and this value is sufficient for them all to run together into a continuous ring. Reduce the Alpha to 0.05 to avoid overpowering the image with the halo effect.

Go further down the halo Material settings, and find the Flare panel. Check the title box to enable this. Set the number of Subflares to, say, 8 (this controls the number of separate halo reflections that will be generated, though you probably won’t be able to distinguish that many). Set the Boost to 10 to make the subhalos brighter than the original parent halo.

The Seed value in the Flare panel controls the particular flare pattern that you see; each number produces a different effect. I chose the value 3 for this example.

Where did the circle go? Like any object with a halo material, the circle object can be quite hard to see when it’s not selected. If you lose track of it, there are a couple of ways to find it again:

- Select everything with [A]. Now you can look for the ring of dots and [RMB] on it to select it exclusively.
- Use the outliner window at the upper right. You should see it listed here under its default name of “Circle”; click with [LMB] to select it, and you should see the ring of dots appear in the 3D view.

If the circle object is still inside the Sun, then wireframe [W] or bounding-box view modes may be helpful to find it again.

41.4. The Final Result

Now hit [F12] to render, and you should see something like this (the flare effect may not appear immediately with the rest of the image, give it a few more seconds to appear):
**Exercises:** Try different positions for the circle mesh; move it near to the Sun (even partly in it), far from it, move it around to different sides. How does this affect the flare pattern? Also try changing the size of the circle mesh.
42. Blender Memory Management

**Note:**
This section may be a bit bewildering on first reading. If you don’t understand it right away, don’t worry too much; but as you work more and more with Blender, making copies of objects, or sharing settings between objects, feel free to come back and re-read this and hopefully it will make some subtleties of Blender’s behaviour clearer.

42.1. Datablocks And Users

It is helpful to understand how Blender manages memory. Just about everything in a Blender document—objects in scenes, scenes themselves, materials, textures, whatever—is stored in a *datablock*. Each datablock has a name, which must be unique among datablocks of the same type. Each datablock may be referenced from one or more places, mostly in other datablocks—in Blender parlance, it has one or more *users*. For example, several different objects might share the same material, so when you change the characteristics of the material, it automatically changes the appearance of all those objects.

If the number of users of a datablock drops to zero, it still stays around in memory, but *it will not be saved when the document is saved*. Thus, if you save and reload the document, all the datablocks with zero users will disappear. (In some cases you may need to save and reload a couple of times before all zero-user datablocks disappear.)

But up until that point, the datablock will continue to appear in the relevant popup menus, so you can reassign it to more users.

You can also assign a *fake user* to a datablock; this is what the “F” button is for in the popup menus that list datablocks of that type. This ensures that the user count never goes to zero, so the datablock always gets saved in the document even if it has no real users. This is useful for “library” documents, which can contain collections of useful materials and textures, say, that can be linked or imported into other documents, without also having to include dummy objects in the library just to ensure those materials and textures get saved.

For example, here is the widget that lets you choose the material for an object:

![Figure 229](image-url)
The main part shows the name of the current material, which is editable. The X button breaks the link to this material and decrements its number of users by one, while the F button assigns a fake user to this material. The + button lets you create a new material.

The material symbol on the left pops up a list of existing materials to choose from, plus a search box to search all existing materials:

![Material Management Interface](image)

**Figure 230**

Note the entry with the 0 symbol next to it; that currently has a user count of zero, and will disappear when the document is saved and reloaded, if it is not further used.

The widget also displays the current user count if it is greater than 1:
In this case the count was incremented because the F button was selected.

**Note:**

Clicking the number (if it’s greater than 1) makes a copy of the object, attached only to this particular user. The copy has a user count of 1, while the original has its user count decremented by 1.

This is the basis of the (slightly confusing) distinction in Blender between *object datablocks* and *object data datablocks*. Object datablocks contain the information common to all the *types* of objects in the 3D scene, regardless of whether they’re mesh objects, lamp objects, camera objects or whatever; whereas the object *data* datablocks contain the information specific to that *instance* of the type of object, e.g. the vertex, edge and face definitions for this particular mesh you might be using, or the colour and energy of a lamp you’ve set up for your project, or the field of view of a camera you have.

Which leads us to the difference between the two object duplication commands, `SHIFT` + `[D]` and `ALT` + `[D]`: the former duplicates both the object datablocks and the object *data* datablocks (though this can be controlled in your User Preferences), while the latter only duplicates the object datablock. What that means is that in the first case the two objects are truly independent, but in the second case the new object continues to share the same object *data* datablock so a change in one will result in a change in both of them. So, for instance, if you use `ALT` + `[D]` on a mesh object and edit the vertices, edges or faces on one copy, the other copy will also be affected.
43. A Common Pitfall in Older Tutorials (Align to View Issue)

After much struggling to follow many tutorials based on older versions of Blender, I have downloaded multiple versions to discover why the tutorials based on versions such as 2.43 don’t work when attempted on updated versions such as Blender 2.48a and above. Newer versions such as 2.48 have added a new option to /not/ have added objects rotated to the current viewpoint. With older versions, being in top, front or side view would cause any newly added objects to face different directions on creation.

![Image](image_url)

**Figure 232** The location of the button to make the circle show up in the correct orientation

Newer versions of Blender introduced the ability to force all objects into the same global orientation; even worse, they set it up that way **BY DEFAULT**! This means that unless the user deliberately changes the settings in the new versions, many older tutorials will act as if they are broken.
Newer versions of Blender (such as version 2.48, or 2.49b) can be set to act in the same way as the older versions, by setting the Align to view on the User Preferences menu in the right way.

Making this simple changes will "unbreak" tutorials written under Blender version 2.43, by allowing new objects to be automatically oriented to whatever viewscreen orientation is selected in the active viewscreen.

Any time object rotations, lattices or whatever else end up completely out of alignment with what older tutorials say should happen, these steps are your first best fix for almost every such situation.

In 2.58 and 2.61

The settings mentioned above are found in "File->User Preferences" (shortcut: Ctrl+Alt+U) under the "Editing" tab. There's a drop-down called "Align To" where you can set "View" or "World".

Noob Note: What actually happens by default on newer versions of Blender is that the axis of rotation is perpendicular to the screen. It means that, instead of revolving around the vertical axis, the object will revolve in the plane of the screen. Another way to deal with this is to change the view just before performing the rotation (I used NUM1 view) and come back to NUM7 once done.

Noob Note: In version, 2.63 for Linux, after changing "Align To" to "View", when adding through "Add" menu, the mesh will still be aligned to "World". To get it aligned to "View" You have to add it with SHIFT-A.
**Noob Note:** In version 2.68a (unknown for older versions) there is a option to Align newly created mesh individually. When you create a mesh, (for ex. cylinder) there is a panel beneath the toolbox panel(left side of the 3D view) that shows up: Add "Mesh Name" (ex. Cylinder). Scroll down a bit and you’ll see a check-box to enable "align to view". Checking it will align the mesh you added to the current view. Re-checking it after rotating the view around will align the mesh to new view.
44. Using Bones
45. Mountains out of Molehills

Information
Applicable Blender version: 2.49

Now that we’ve created our simple person, it’s time to give him somewhere to go. In this tutorial we’ll create a mountain range using a few simple, and handy tools.

45.1. Creating a simple plane

First we need a clean area to work with.
• Start off with a new project, using `File → New`, or hit `CTRL + N`. If you have a default cube or plane just delete them now (select them with `RMB` and press `X`).

Our first step is to create a large grid plane that we’ll use for the ground and grow our mountains out of.

• Press `NUM7` to enter top view. This way our grid plane will be lying flat when we create it.
• Press `SHIFT + C`. This sets the 3D cursor to (0,0,0) which will be the center of the grid we will add (or use `SHIFT + S → Cursor to Center`).
• Now add the grid with `SHIFT + A → Mesh → Grid`. This will be our canvas.
• Now add more vertices to the grid. In the bottom of the toolbox window, change the number of X and Y subdivisions somewhere from 15 to 20.
• Change to Edit Mode using `TAB`.
• Scale the grid plane up by about 15.

First put the mouse close to the center of the grid plane and press `S` and drag the cursor away and watch the numbers in the bottom left of the 3D View. Hold `CTRL` while dragging to increment by 0.1 for a more precise measurement. Alternatively, to enter the exact amount yourself, press `S`, then simply type `15` and hit `ENTER`.

• In the Tool Shelf at left, under `Mesh Tools` hit the `Subdivide` button 4 times. Alternatively, in the 3D View window you can press `W` to open the Special Menu and select `Subdivide`. You can also just hit `ENTER`, because `Subdivide` is the first option in the Special Menu.

**Noob Note:** Using subdivision in edit mode will actually increase (double at least each time) the number of vertices. This does does not match to the screen shots provided in here. So you may want to do this only at the end of your modelling process.

### 45.2. First mountain

Now that we have the ground, it’s time to start growing our mountains.

• Make sure you have nothing selected (`AKEY`).
• Select a random vertex with `RMB`. I usually start at the one that is 4 down from the top and 4 in from the left (the 4th vertex if you count the edges).
• Change to the side view with `NUM3`. 

• Press **O** to change to proportional edit mode or use the button which shows a grey ring on the header of the 3D View. The button will change its color to blue. You can also use **SPACE → Transform→Proportional Edit** (By default this button is located just below the 3D view).

• Once you’ve turned proportional edit mode on, another button appears to its right, the falloff button. Select Smooth Falloff here. Alternatively you can use the menu on the header of the 3D View (**Mesh → Proportional Falloff → Smooth**) or, using **SHIFT + OKEY** will cycle through all of the different falloff types while using the Proportional editing tool.

• Press **G** to grab the vertex. We should now have a circle surrounding the vertex, this is our **radius of influence**. Basically any vertices inside this circle will be affected by any changes to the vertex itself.

**Noob Note:** If you’re having trouble seeing or changing the radius of influence, try saving your scene and restarting Blender.

• Use the **Mouse Wheel** or **PAGE_UPKEY** and **PAGE_DOWNKEY** to adjust the radius of influence to include just over 2 vertices on each side of our selected vertex. (Depending on your version of Blender, you may need to use **ALT + NUM+/ PAGE_UPKEY** and **ALT + NUM-/ PAGE_DOWNKEY** and may need to hold down the **LMB** while using the **Mouse Wheel** to adjust the radius of the influence. On Mac, hold the “fnKey” down and hit “page-up” or “page-down”). In 2.41 you must ‘grab’ the vertex first - only then can you alter the sphere of influence (in my version, 2.42a, the 3D cursor had to be snapped to the selection before the wheel appeared).

**Noob Note:** To change the radius on a Macbook press “fn”+ up/down. OSX uses function + arrow keys as replacements for "home", ”end”, ”page up” and ”page down” keys.
• Move the vertex up about 8 units on the Z-Axis. Do this by dragging the cursor up a little, and press the MMB; this should restrain the movements along the Z-axis. Now use CTRL to move it precisely. Alternatively you can use ZKEY to restrain movements to the Z-Axis and type 8 and hit ENTER. In older versions of Blender you may need to hit the NKEY before typing the number 8.

Congratulations, we just created our first mountain. Now it’s time to see what other things we can accomplish with the proportional editing tool.
45.3. Peaks vs. hills

The 2.37 and onward releases offer at least 6 types and 2 modes of proportional editing. The previous release only has 2 of these types: Smooth and Sharp Falloff. We’ll take a look at the difference between these two now.

- Change to top view again with NUM7. You’ll notice that now your "mountain" looks like a few differently shaded squares in the grid; you’re looking down on shaded tiles, but in the Z axis, they’re all still perfectly aligned with the original grid.
- Select another vertex away from the first. Let’s say 4 from the bottom 4 from the right (counting the vertices on the edges).
- Change back to the side view with NUM3
- Select Sharp Falloff from the menu on the bar of the 3D View. Alternatively, using SHIFT + OKEY will switch from one to the next of the 6 proportional editing modes while using the Proportional editing tool.
- As before, move the vertex up 8 units on the Z-Axis (Note: The radius of influence will still be the same size as when we last used it).
  - GKEY
  - ZKEY
  - Type 8 and hit ENTER.
Now we can see the differences between the sharp and smooth falloff. The same number of vertices are affected in both cases; only the degree to which they are affected is different.

The different proportional editing modes can be selected from the box immediately to the left of the proportional editing type box. The mode box contains three options: Off, On, and Connected. "Off" means that proportional editing will not be used. "Connected" means that only vertices linked to the selected vertices will be affected by the radius of influence. "On" means that all vertices will be affected.
45.4. Shaping the world

Now that we’ve created a couple of Mountains, it’s time to see how we can use proportional editing to shape them.

- First make sure we’re in side view (NUM3).
- Then on the smooth falloff mountain, the first one we created, select the vertex that is immediately down and left from the topmost point.
- Press RKEY to rotate, scroll the MMB to change effective radius so it includes other points. Your screen should look like the photo to the right.

You can see the size of the proportional editing circle, and that there is only one vertex on the mountainside selected.
Mountains out of Molehills

- Next hold **CTRL** and rotate everything by -90. Alternatively, use **RKEY** , **NKEY** , and type **-90** and press **ENTER** . Your mountain should now look like this:

**Noob note:** be careful about the range of affected vertices. If the range is too small, then rotating will affect just the selected vertex. If the range is too large, it will rotate everything together. You can adjust the range by using the scroll wheel on the mouse.

![Figure 240](image)

Notice that the vertex itself did not move; since it is at the center of the circle it had no effect. The adjoining vertices within the edit circle were rotated around it in decreasing amounts the further from the center they are. Try doing it again with a larger proportional editing circle. Feel free to play around with scaling or rotating from different view points (don’t forget that you can also use **GKEY** to move vertices vertically or horizontally).

Try viewing your world from top view while rotating with a large effective radius. You will see the nearby vertices move close to the full amount while vertices further away move less.
45.5. Smoothing things out

Now that we have a couple of budding mountains, you probably think they look kind of choppy. Sure they would be good if we were making an 8-bit console game, but we’re working with 3D here, we want things to look sharper (or maybe smoother) than that. There are a couple of approaches to this. The first is to use more vertices when we create our plane. And I won’t lie, it works. But it’s also a HUGE resource hog. It would take your home computer hours of work just to keep things updated, let alone run it. So instead, we fake it. The easiest way to do this is to turn on SubSurfaces (we saw this in Detailing Your Simple Person 1.) For our purposes, let’s set the subdivision (Levels) to 2. Also, ensure our SubSurf algorithm is set to Catmull-Clark (this is the default setting).

Now, you’ll notice that with SubSurf on, we lose a lot of hard edges that we had, essentially we have no sharp corners any more. I don’t know about you, but to me that doesn’t make for a very interesting mountain range. So to restore our corners, we are going to use Weighted Creases for Subsurfs.

- First turn off proportional editing with the OKEY, and ensure we’re in side view with NUM3
  - Noob note: That means, the letter O key, not the zero key. Also, NUM3 means ”3 on the numeric keypad,” not on the top row of the keyboard.
- Next, while still in edit mode, change to Edge Select mode with CTRL+TAB and select Edges. Alternatively press Edge Select Mode button at the bottom of the object window.
- In the Tool Shelf at left, select the Options tab, then under Edge Select Mode, choose Tag Crease.
- On our Sharp Falloff mountain, the second one we did, select the two edges on the right. (see image below)

---

1 Chapter 29 on page 231
• Press **SHIFT+EKEY** or **SPACE → Edit → Edges → Crease SubSurf**, then move the mouse away from the edge until the edge *Crease* reads 1.000 in the 3D viewport header. If moving the cursor there seems to be impossible, just hit 1 and enter.

As you move the cursor away from the edge you will notice two things. The first is that the edge becomes thicker as we move from it; this is showing how much of a crease we have (with *Draw Creases* turned on). The second is that you will notice the subsurfed mesh moving closer to the edge as the sharpness increases.

### 45.6. Naturalness

Press **CTRL+TAB** and select vertices. Then go into front view **NUM1**. Select the second vertex from the top in the centre of our Sharp Falloff mountain, then go into side view **NUM3**. Push **GKEY** and drag the vertex inwards, not too far or your mountain will come out of itself on the other side. Just bring it in enough to make a small indent.

Then grab the top vertex and pull it down a small amount. You will notice that there is a small “crunch” in your mountain.

Don’t forget to select all, press **WKey** and hit the **shade smooth** button to smooth everything out.
OK, so your mountains are starting to shape up. But they still look a bit too neat. You could spend time moving each individual vertex but the chances are your model will still lack the natural feel. What we need is some chaos. Thankfully this is quite easy to accomplish. Firstly select the vertices that make up your mountains, all of them and a few around the base (box and circle select will make this easier). Select a few vertices between the mountains too. Next we use something called fractals. Fractals are chaotically (i.e. randomly) generated variables. In short you can use these variables to give your mountains a "wobbly" look.

Figure 243 Fractal option in 2.6.x

In the Tools tab of the Tool Shelf, press Subdivide (under Mesh Tools), then look at the Subdivide submenu below. The value in the Fractal box is the strength of the fractal. 1 is very low and will barely change your model. 100 is very high and will twist your models into very odd shapes indeed. Have a play with different values until you find one that you like. Around about 15-30 should do it. Hit OK and presto, your mountains have been transformed from clinical neatness, to lumpy chaos.

- If you make too many fractals, your computer will slow down. However, the more fractal you add, the more bumpy and realistic it looks!

**Noob Note:** Repeatedly using the fractal tool seems to rapidly multiply the amount of vertices on your canvas. I suggest using the tool once, and if the result isn’t satisfying, undo the result (CTRL + Z) and try it again with a different fractal strength. Even after undo, your selected vertices remain selected.

**Noob Note #2:** If you have a new enough version of Blender (2.49 and up definitely has it, not sure about lower versions), there is a setting called Random in the Proportional Editing settings. Using this with a high radius may give a desired result for you without adding more mesh.

### 45.7. Adding your guy with the hat

If you changed to a new layer-- press (SHIFT ) select the layer with your guy on it or (SHIFT + 1 ). This will display both layers. If you would like to move the landscape from the second layer to the first then with the landscape selected, press (M ), and select the layer(s) you would like it on. note- make sure you’re in object mode. If you started a new project-- To insert your guy with a hat, you can simply go to file > append or link (shift+F1).

- Then select the file from the previous tutorial.
- You will then see a list of objects you can insert or ‘append’.
- First go into the 'Object' folder. Unless you renamed him/her, your person will probably be named “cube.” Select it.
- Make sure that ’Append’ button is pressed; otherwise you will not be able to scale or translate, or edit your model at all. (The 'Link' button will link a copy of your object into the current scene, and will update any changes when you reload the file. Unfortunately, this includes location and size, so we will not use it right now.)
• Press 'Load Library' to place your guy into the mountain scene. Please note, the Load Library button is top right. Confusingly, there is some text bottom left that says Load Library as well, but isn’t clickable.

• Repeat the process to get the hat (probably named “circle”). To reset the parental relationship, see the instructions at the end of the ../Putting Hat on Person/² tutorial. To scale them to the appropriate size, go to object mode by pressing TAB (unless of course you are already there). Select the object you want to resize, then press the SKEY and use the cursor to scale as you see fit. To undo any mistakes, use CTRL+Z.

Noob Note: To import the file once you have the list select the item, i.e. cube, and in the bottom right select "Active Layer" that will append it to your current proj when you click "Load Library" your work should be visible now.

Noob Note: Multiple items may be appended simultaneously. For instance: both 'cube' and 'circle' objects can be appended at the same time by highlighting both object names within the file browser by means of a RMB Click. RMB on object again to deselect.

---

2 Chapter 32 on page 253

348
46. Modeling a Volcano

Information
Applicable Blender version: 2.49

In this module, you will create a volcano using the proportional edit fall-off tool. You should be comfortable with deleting and adding meshes.

46.1. Adding a Plane

Delete the basic cube. Add a plane, and scale it up by 10. Rotate it so you see it in top-view (make sure it’s in Orthographic view too).

Enter Edit mode and subdivide (with ) 5 or 6 times. More subdividing will give you a "smoother" volcano, but it also needs more CPU power.

"Subdivide" divides every square in the plane into four new squares. So every time you press "Subdivide" you will have four times as many squares as before. "Subdivide Multi" will make x horizontal and x vertical lines through your existing squares, so the new number of squares is: \( (\text{squares}_{\text{old}}) \times (x+1)^2 \), where x is the number you enter.

46.2. Making the Mountain

In top view, select one of the points in the middle of the plane. With this point selected change to side view. Press the , which enables the "Proportional Edit Falloff" tool in the Menu-Panel beneath the 3-D-Window. As seen in the previous tutorial Blender 3D: Noob to Pro/Mountains Out Of Molehills\(^1\) when you move a vertex while edit falloff is enabled, all vertices in a defined radius of the selected vertex will align with the selected vertex when its position is altered. How they are adjusted can be chosen in the tab on the right of the yellow dot. I propose using "smooth falloff".

---

\(^1\) Chapter 45 on page 337
Now grab the vertex with $G$. You will now see a gray circle. You can change its size with the mouse wheel. Every vertex inside this radius will be affected by the falloff. Change the size of the circle so almost the whole plane is in it.
Now move the vertex a bit upwards, as seen in the picture. Optionally you can lock the z-axis to make the volcano go straight up by pressing $\text{Z}$. 

As you can see all the other vertices will shift upward. We could keep moving this vertex at the same rate, but that would cause the plane itself to rise and bend, and that’s not very good. So press $\text{LMB}$ to apply the changes, grab the same vertex a second time and repeat the previous exercise as before, except now choose a smaller radius for the circle, about half the diameter of the plane ($\text{C} \rightarrow \text{Z} \rightarrow \text{scroll} \text{ MMB}$).
Repeat this two or three more times and you will get something like this:
46.3. Forming the Crater

Now we’re going to create the “hole” on the volcano. First change the falloff to ”root”. Grab the vertex one more time, change the size of the circle so it’s more or less as seen in the picture.

Grab this vertex down a bit, apply, grab it one more time with a smaller circle. You now should have something like this:
If yours has such a jagged border like mine, you should follow the following steps: First disable the fallout tool with [V]. Then select a vertex and grab it, then pull it up so it’s on the same height as the other. Do this for every vertex till they’re more or less the same height.

You can also select the jagged vertices and the vertices around them then press [W] → Smooth (Older versions: Space → edit → vertices → smooth) and this will get rid of some of the jagged edges. (I suggest using this method since this is only a basic volcano, and using Subsurf after this will make the jagged edges all but invisible anyway.)
46.4. Subsurf

Now \[ \text{[TAB]} \] to get into Object mode. Add a Sub-Surf Modifier to the Mesh, set at level two (‘Modifiers’ tab → Add Modifier → Subsurf → Catmull-Clark → Levels: 2; Render Levels: 2).
Do not apply these settings yet, first we’ll do a test-render. Press **F12** to enter Render, after adjusting the camera. If you like your volcano you may apply the modifier, but if you have some rather nasty edges like I do, don’t apply the modifier yet. We’ll correct this now.

First click on the marked button to disable the subsurf-modifier in Edit-mode.

Then enter Edit-mode. Then select the vertices on the top and pull one after another a little bit outwards, so they form a nice circle.

Optional Enhancement Method to form the circle:
I found this nifty method to help "guide" making this circle with the manual vertex manipulation.

1. Enter Object mode, we will be creating a new temporary object.

2. Center your cursor (either Shift+S->Cursor to center(if your original plane HAS NOT shifted from center of grid) or Shift+S->Cursor to Selected(if your original plane HAS shifted from center of grid), basically you want the cursor centered in your plane.

3. Once you have the cursor centered, hit Ctrl+NUM7, to bring up Bottom Ortho view. You should now see the volcano from the inside out and your slightly edged crater opening.

4. Hit Shift+A->Mesh->Circle. This will create a circle at the cursor which will also be completely centered on the crater. Select the circle with RMB and Scale it with S, manually increase the size until it it slightly larger than your crater opening, or however large you want the out edge to be.

5. Once your circle is the correct size, make sure you have the translate manipulator turned on, select the circle and change to Front Ortho view (NUM1). Now move the circle through and above the volcano along the Z axis (blue handle). Finally, change to Top Ortho View (NUM7).

6. While still in object mode, deselect the circle and select the plane containing your volcano. You now have a nice "guide ring" to grab your vertices to! After you have finished positioning your vertices, deselect all with an A, spin your view by holding down MMB and moving the mouse, enough to be able to pick out the circle easily without selecting the plane. Tab to object mode, select the circle again with RMB and finally delete it with X.

- Unity user GlennC

Figure 254
46.5. Adding Magma

1. Press \texttt{SHIFT} + \texttt{S} and choose \texttt{CursortoCenter}.
2. Press \texttt{SHIFT} + \texttt{A} and choose \texttt{Lamp \rightarrow Point}.
3. \textit{Olderversionsonly}: press \texttt{F5} to enter the shading menu.
4. Change the color to reddish-orange. (Red: 1, Green: 0.1, Blue: 0)
5. Set the energy to around 7.
6. Raise the light until it’s just above the bottom of the crater (\texttt{G}rab along the \texttt{Z} axis).
7. If the ground level of your plane is reflecting light from the lava lamp, this is because the bottom of your crater is above ground level of the plane you created; you’ll need to turn on raytracing. In the object data menu for the light, open the Shadow menu and click “RayShadow”.

- \textit{Alternate1: SpotLamp}
  1. Change the light’s type to \texttt{Spot}.
  2. Raise the light until it’s covering most of the crater. If the light is not pointing downwards, rotate and angle it downwards.

- \textit{Alternate2: AreaLamp}
  1. Change the light’s type to \texttt{Area}.
  2. Rotate along the \texttt{Y} axis: 180 degrees.
  3. Set the gamma to 2.
  4. Set the distance to around 5.

Experiment with the values and positioning to get something that works with your volcano. It should now look like this:

Figure 256

46.6. Varying the Terrain

Next, let’s set the volcano’s material.

1. \texttt{RMB} on the volcano plane.
2. Select the "Material" button

3. Change the color to ashen gray. (Red: .260, Green: 0.230, Blue: 0.230)

4. Select the "Texture" button and press New.

5. Change the Type to Stucci.

6. In the Influence panel, uncheck Color, and check Normal. Set the Normal slider to 0.5. This will render the texture as a bump-map.

**Older versions:**

Select the volcano and press F5. Keep Pressing F5 until the Materials Buttons (symbolized by a red ball) is highlighted. Then add a new material. You do this by clicking the Add New button in the Links and Pipeline Panel. Once you’ve done that, set the settings similar to the picture below. Now press F6, then add a new texture to the material. Choose a stucci texture, set the noise size to 0.15. Now switch back to the materials-window (F5) and click on the "map to" tab. Deselect the "col" button and select the "nor" button. This will render the texture as a bump-map on the volcano. Set the "nor slider" to 0.5, which should be the default. Switch to the "map input" tab and choose "tube".
This looks really smooth, like clay pottery. To get a more rough-looking volcano, try out these options:

- Option 1: Subdivide and increase the fractal.
- Option 2: Decrease the texture’s basis size (in the ”Stucci” panel when you select the ”Texture” button).
- Option 3: Proportional edit tool.
  2. [G]rab the center vertex, and raise it along the [Z] axis.

**Older versions:**

Go into Edit mode, select all Vertices, and use the fractal (set from 15 to 30) to really get things looking rocky and mountainous. **TAB** (Edit mode) → **F9** → **AKEY** to select all → Mesh Tools → Fractal → 15 - 30 (15-low, 30-high) → OK → **TAB** (Object mode) In Blender 2.5 you can use the random proportional edit tool: use **NUM7** to switch into top view, grab the central vertex of your volcano using a large-radius random proportional edit, and pull it slightly into Z-direction.

(A note: Seems there is no need in subsurf at all since fractal tool will dramatically increase vertex quantity.)
47. Penguins from Spheres
48. Dicing With Depth (Dice Modeling)
49. Model a Goblet

Why a goblet? After all, goblets (fancy containers for consumable liquids) are not really all that important in the real world. However, they represent a very large class of interesting objects: those that are radially symmetric. Also, they are fun to play with.

To model a goblet and actually see the result, we do the following steps:

- create the actual mesh of the object.
- apply a material to the object.
- create and light a scene to display the goblet
- render the scene.

The following tutorials demonstrate three different approaches to creating the mesh model, and then show two different materials (glass and silver) that may be applied to the goblet. Finally, we add the minimal elements to the scene to permit an "interesting" rendering.

49.1. Three ways to build the mesh

As a beginner, you may wonder why we describe three different ways to build the mesh. After all, surely the Pros know of a "best" method?! The answer is that there is not really a best method. Blender provides a sophisticated toolkit, and different blender artists will become familiar with different tools. If, after you gain experience, you become comfortable with cube extrusion, then this may become your preferred tool. If you need more than four vertices per "circle" you may find that cylinder extrusion is better for some particular object. If you are comfortable with "spinning" an object, then spinning may be right for you. All three techniques generate an object that is defined by a set of vertices on a set of circles that are "stacked" on a common axis.

After we build the mesh using one of the three methods, we can apply any number of fancy techniques for texture and rendering. We provide two simple "cookbook" approaches in this section so you can see the result, but materials are treated much more extensively in other sections of the book.

In the next three sections of the book we describe the "cube extrusion" approach, the "cylinder" approach, and the "spin" approach. Following sections describe three textures that can be applied to objects that are created with any of the approaches, and the final tutorial provides a simple way to render the result.
The “cube extrusion” approach is a basic technique that all blender artists will become familiar with, to model most types of objects. Since it is such a basic technique, it may become the most efficient way for you to create objects, and you may choose to use it wherever possible rather than switching to a less familiar technique. You can see from the tutorial that this technique is perfectly acceptable for goblets, and by extension it will work for similar objects.

You may prefer the “cylinder extrusion” technique when you need more than four vertices per circle, because cylinder extrusion is very similar to cube extrusion. Thus your proficiency with cube extrusion will directly carry over to cylinder extrusion.

“Spinning” is conceptually different, even though it creates the same mesh as cylinder extrusion. Spinning is the easiest way to create a radially symmetric model from a two-dimensional description of the cross-section of an object.

49.2. How many circles?

![Figure 260](image-url)
Each of the three methods defines a set of stacked circles, with vertices equidistant around each circle. The "cube extrusion" technique has four vertices on each circle, while the cylinder and spin techniques have a user-specified number of vertices per circle. But how did we pick the number of circles and the spacing between them?

The answer is that we know in advance that we intend to use a technique called "subsurf". Subsurf interpolates additional vertices between those we explicitly specify, and this "smooths out" the profile of our goblet.

This will cause problems where we need a fairly sharp "bend" in the profile, as between the base and the stem and between the stem and the "bulb" of the goblet. At each point in the profile that has a (fairly) sharp bend, we need for the vertical circles to be close to each other. The two images illustrate this effect. Each image shows an outline of the object, the spun object, and the result after subsurf (level 2) has been applied. The outlines and the spun images are nearly identical, but the subsurfed result is very different, because there are three extra vertices in the second outline: one just above the edge of the base, one at the top of the base, and one below the bulb: these are the three locations where we need relatively sharp changes in contour. When we spin the outline, the first outline generates seven circles and two degenerate circles, while the second outline generates ten circles and two degenerate circles. Those extra three circles make all the difference. The same phenomenon occurs with the other two modelling techniques.
50. Model a Silver Goblet

Information
Applicable Blender version: 2.49
50.1. Basic Shape

At first glance, the goblet looks like it is composed of cylinders. However, while it is possible to model the goblet with a cylinder mesh, it is easier to make a goblet by using cubes. Cubes make the goblet faster to make and it makes fewer vertices to track. Now, let's start making the basic shape of the goblet.

Start with the default cube and go to Edit Mode (TAB). Move to the side view (NUM3). Box select (B) the top edges of the cube. Extrude (E → Regions) upward about one grid square. Hold down CTRL while extruding, for incremental movement, and press
the \( \text{Z} \) to restrict movement to the Z-axis. This extrusion is called E1. Repeat 2 more times for extrusion 2 and 3 (E2 and E3).

Now Extrude a longer piece upwards, for the Goblet’s stem, of 10 grid squares (E4). Next we will define the area for the 2 top knobs and the bottom of the glass by Extruding upwards 5 more times at 1 grid square each (E5-E9). Next do another upward Extrusion of about 10 grid squares (E10). This is the actual glass itself.

### 50.1.1. Inflate the Glass

![Figure 263 Sizing the first knob](image)

Now, lets begin to inflate the glass. First, clear all selections by hitting the \( \text{A} \). Make sure you are still in the side view (\( \text{NUM3} \)). Box select (\( \text{B} \)) the bottom most cube (all 8 vertices, not just the bottom 4). Then expand it outward by scaling (\( \text{S} \)), then pressing \( \text{SHIFT} + \text{Z} \) to lock/prevent any scaling in height along the Z-axis and finally pressing \( \text{4} \) to quadruple its size. Next, deselect all vertices (\( \text{A} \)), select (\( \text{B} \)) the 4th pair of vertices (E2), scale them (\( \text{S} \)), lock scaling (\( \text{SHIFT} + \text{Z} \)) and triple the vertices in size (\( \text{S} \) and \( \text{3} \)).

Do the same for E5 and E7 (the 7th and 9th pairs of vertices, respectively). Then expand (\( \text{S} \) and \( \text{SHIFT} + \text{Z} \)) the top, Goblet rectangle (E9 and E10) to 6 times its current size (\( \text{6} \)).
50.1.2. Make the cup’s interior

Figure 264
Last is the cup’s interior. Once again, you should still be in the side view (NUM3). Box select (F) the very top most vertices of the Goblet (E10). Once selected, get a better view by changing to ‘Orbit Up’ (NUM8). With the top surface selected, initiate an Extrusion (F → Regions), followed by a termination with the ESCAPE. It will appear as if nothing has happened, but new, overlapping edges have been created and are now selected (this also creates E11). Next Scale (S) the selected vertices to 4/5ths of the original size (E). This creates the inside lip of the cup. Now, Extrude (F) the interior lip, along the Z-axis (Z) downward (F8) to create the bottom interior of the Goblet (E12). Finish off by selecting all, and then a ‘Remove Doubles’ (W → Remove Doubles), for good measure. It should look something like this.
[Noob note: For some reason, when I extruded the interior of the cup to -10, I would have a lip sticking out of the bottom of the cup when I applied the subsurf. To resolve this, I extruded to -9. I was also left with a space at the bottom of the cup (i.e. you could see all the way to the base of the goblet) so I selected the bottom most vertices, pressed F, extruded and hit ESC, merged, selected the center vertex and translated that down -1. This gave me a nice looking bottom for the cup.]

[Another Noob Note: When you create the interior of the cup with .8, be sure to hit $\text{SHIFT} + z$ to restrict it to just the X and Y axis, or when you extrude your glass downwards by 10, it will go through the bottom of the glass]

[Noob Question: Does he really mean extrude the interior lip down along the Z-axis? It would seem to me that you should grab it and drag it down (or ( $\text{G}$ then $\text{Z -10 ENTER}$ )]

[Answer: Yes. Extrude creates another set of vertices. Dragging down the existing vertices won’t give the lip and the interior the right shape. Try it both ways and see.]

[Pro Note: If you wish for a more detailed cup, extrude the bottom of the cup, then scale it by .2097. Then translate (in layman’s terms, that’s “grab”) it .7181 along the negative Z axis (or -.7181 along the Z axis). Through the use of creasing and control loop-cuts, you can get a very nice goblet.]

Note: If the thickness of the vessel sides or bottom is too thin, the Goblets interior faces may 'bleed through', affecting the exterior of the Goblet when you apply a subsurf.

You may want to try modelling the inside/bottom of the Goblet (sim. to "Die Another Way" tutorial). Turning on “Occlude Background Geometry” ($\text{Z}$) will be helpful, as it turns off the ability to see & select through the model. The button icon is that of a 'ISO Cube' located with the 3 select mode buttons (4 dots, 2 lines, & a triangle) of the 3D Toolbar, in Edit Mode.

50.2. Smoothing and Defining

Time to take the mesh and turn it into a proper goblet. Add a subsurf level 2 ($\text{CTRL} + z$) to the mesh. Change to Object Mode ($\text{TAB}$) and select the Set Smooth button under Links and Materials. The cube-looking mesh will now look like an object that was created from a cylinder. This has removed all our crisp edges, and our goblet is looking very unstable! Let’s rectify things by flattening the bottom.

Noob Note: If your goblet has a bulge in it after applying the subsurf, go to Edit mode ($\text{TAB}$), select all ($\text{A}$), press $\text{W}$, and select "Remove doubles". (If a menu for boolean operations appears when you hit the $\text{W}$, then you’re not in Edit mode; change immediately to Edit mode and try the $\text{W}$ again.)

Select the four edges that surround the small circle at the very bottom (the very lowest set of edges) and press $\text{SHIFT} + \text{E}$ to enable creasing. Now drag the mouse up and down to select the level of the crease. When you’re satisfied, hit $\text{LMB}$. Repeat the process for other edges you want to be sharp. I’ve turned on Draw Creases under Mesh Tools 1 to illustrate which edges have been creased (highlighted yellow) in this example.
Note: Due to the vagueness of this tutorial I had problems trying to follow what was wanted. I got around it by beveling the goblet (for the cup-edge/thickness), and then merging necessary vertex. Here is how it turned-out:

Goblet\(^1\) Render\(^2\)

---

**Figure 266**  Applied subsurf modifier

---

1  http://i88.photobucket.com/albums/k185/captheathmalc/gobletinblender.jpg
2  http://i88.photobucket.com/albums/k185/captheathmalc/goblet.jpg
Figure 267  Crease edges

[Noob Note: I found that if you select the bottom 4 vertices and extrude them down by 2.5 increments (Z -.5 twice) and then you select the bottom 8 vertices (the bottom .5 section) and scale by 1.5 (S 1.5) it makes for a more realistic looking goblet base.]

That concludes the creation of the goblet. Save the scene for use in the lighting tutorial.
50.2.1. Quick links for the impatient

To jump to the relevant lighting section, go to Blender 3D: Noob to Pro/Light a Silver Goblet³.

What about applying glass look already? Take a sneak peek at Blender 3D: Noob to Pro/Spin a goblet#Material⁴.


⁴ Chapter 52.2.1 on page 391
51. Model a Silver Goblet Another Way

Information
Applicable Blender version: 2.49

51.1. Preliminaries

This is a version of "Model a Silver Goblet" but starting from a cylinder rather than a cube. Start Blender or start a new scene (CTRL-XKEY) and delete the default cube (in object mode, press XKey).

Change to Top view (NUM7), make sure you’re in Object mode and add a cylinder (SPACE Add > Mesh > Cylinder): in the popup menu, change the number of vertices from 32 to 16, the Radius from 1.000 to 1.800, the Depth from 2.000 to .100 and leave "Cap Ends" as it is.

Change to Front view (NUM1).

51.2. Description of the modeling steps

The steps in this tutorial are almost all made up of "extrude" and "scale": so, to avoid repeating key sequences every time,

extrude

means

1. make sure "Limit selection to visible" is off

2. box select the top vertices of the cylinder: press BKEY, click and drag LMB to make a rectangle around the top vertices

Figure 268 Shows "Limit selection to visible" icon

379
3. press EKEY, select "Region" from the popup menu, press ZKEY and type in the amount of the extrusion and press ENTER; you can move the mouse instead but it is quicker and easier to type it in.

*Newbie question: Why select "Region" and not "Individual faces"?* If you use "Region", the common edge between two neighboring faces will remain a single edge after extrusion. If you use "Individual faces", the edge will become two edges sitting at the same location. This may create problems (black lines when rendering).

For example, the following keystroke sequence extrudes by 1.5:

BKEY, click and drag LMB to make a rectangle around the top vertices; EKEY, select "Region", ZKEY, 1KEY, .KEY, 5KEY, ENTER.

**scale**

scaling is by default restricted to the X-Y plane; although the numbers in the bottom left corner of the 3D view show Z changing, in fact only X and Y change, and by equal amounts. **Noob Note:** This does not seem to be true in later versions. In 2.67 I have to press SHIFT, ZKEY to limit scaling to X and Y directions, as in the previous tutorial.

1. press SKEY, type in the value and press ENTER — you can use the mouse instead but it is quicker and easier to type in the number.
51.3. Creating the Goblet

![Diagram of a goblet with labeled E-numbers and construction steps]

This diagram shows the connection between the E-numbers and the goblet construction.

- **E1**: Deselect all vertices (**AKEY**) and extrude by 0.2; you may need to zoom in (**SCROLL-MMB**) to do this as it’s quite thin. Scale to 0.1.
- **E2**: Extrude by 0.2, scale by 2.
- **E3**: Extrude by 0.2, scale by 0.5 to make the lower knob.
- **E4**: Extrude by 4 to make the stem.
- **E5**: Extrude by 0.2, scale by 2.
• **E6:** Extrude by 0.2, scale by 0.5 to make the upper knob.
• **E7:** Extrude by 0.2, scale by 8 to make the base of the cup.
• **E8:** Extrude by 4, if you wish to make a flared cup, you can scale by 1.5.
• **E9:** Extrude by 0.0, scale by 0.9 to make the rim of the cup. (This will create a new ring of vertices and then move them in towards the centre.)

Now go into Wireframe mode (ZKEY) so you can see inside to guide the next few steps.
• **E10:** Extrude by -3.9, that is, downwards and scale by 0.69: you can do this last scaling with the mouse, if you like, to get the edges of the inside of the cup and the outside parallel.
• **E11:** Extrude by 0.0, scale by 0.0 to make the inside of the cup.

You now have a goblet, the base of the inside of the cup is the face of the last extrusion, is circular and flat as it derives from a cylinder.

If you haven’t already saved your work-in-progress, now would be a good time.

### 51.4. Subsurfing and smoothing the goblet

The last step is to subsurf and smooth: go into Object mode (TAB) and enable Solid mode again (ZKEY).

Select the Editing panel from the Buttons window (F9) and, in the "Modifiers" panel, click on "Add Modifier", select "Subsurf" from the popup menu and, in the Subsurf display, increase "Levels" from 1 to 2.

![Image](image.png)

*Figure 270* Shows the Editing panel icon and the Modifier panel

At the bottom right of the "Links and Materials" panel, click on the "Set Smooth" button. At the bottom of the cup you will see fluting — this is an artifact caused by smoothing and subsurfing triangles on a curved surface. Here it adds to the appearance, don’t you think?

**Noob Note:** If your cup does not look smooth after using Subsurf and Set smooth like mine, you may have to delete all but two of center vertices (bottom vertex at base of cup and vertex at the bottom inside the cup - AKEY to select all vertices, WKEY and Remove Doubles).
51.5. Flattening the base of the goblet

The base of the goblet is curved due to the subsurfing, so needs to be flattened.

Go into Edit mode, deselect all (\textbf{AKEY }), box-select the lowest set of vertices (\textbf{BKEY }), then crease (remove the subsurfing) by pressing \textbf{SHIFT-EKEY} and typing ”1” followed by \textbf{ENTER}.

The final result should look something like this:

![Goblet](image)

\textbf{Figure 271}
Save the scene for use in the lighting tutorial. To jump to the relevant lighting section, go to Blender 3D: Noob to Pro/Light a Silver Goblet.


---

1 http://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FLight%20a%20Silver%20Goblet
52. Spin a goblet

The spin technique is a good choice when you want to model an object that is radially symmetric and you know what the cross section of the object looks like. This the virtual equivalent of using a lathe\(^1\) to create an object in the real world. With the spin technique, we draw an outline of one half of the outline of the object, and then spin the outline about an axis to create the object’s mesh.

\(^1\) http://en.wikipedia.org/wiki/lathe
52.1. Modeling

![Photo of a real-world goblet](image)

**Figure 273**  Photo of a real-world goblet

Here is a real-world goblet. The picture is not an orthographic image, so we cannot directly copy the outline, but it is close.
52.1.1. Setup

We now model the outline. Let’s start with the default model. We want to create an initial object consisting of a two-dimensional outline, so select the cube, go to edit mode, and delete all the vertices. This leaves us with an object that has no vertices as a nice place to start. We want the resulting goblet to sit at the origin with the Z axis as its axis of symmetry so we get a front view. Since we will be working directly with mesh vertices, the manipulator is a hindrance, so turn it off. (With the manipulator on, it is easy to accidentally move a vertex out of the editing plane, but we want a 2D cross-section.) We are now ready to create the two-dimensional outline as a chain of vertices with the first and last vertices on the axis.

52.1.2. First Vertex

Now, place the first vertex: this will be the center of the bottom of the goblet, so place it slightly above the origin on the Z axis. Why? Well, for two reasons: in the real world, the bottom of a goblet is not actually flat. Instead, the rim is lower than the center of the bottom, so the bottom is concave and the goblet sits on a flat surface without wobbling. The second reason is that we intend to use the "subsurf" technique, and this technique will make a flat surface slightly convex in our virtual world, so we will preemptively start the bottom of the base with a slightly concave surface.

52.1.3. Finish the outline

Add the second vertex, which will be on the rim of the goblet’s base: move the cursor to the X axis at about -3, and add a vertex. Add additional vertices to your outline by moving the cursor to the desired location and adding, for as many vertices as you need to accurately model the outline. Since you will be using subsurf later, make sure that you place two vertices near each other when you need a sharp curve in your outline. Otherwise, subsurf will convert your sharp curve into a wide smooth curve.

Noob Note: This is wonderful advice, but it won’t work, because Blender interprets the $\text{CTRL} + \text{LMB}$ differently when you attempt to place an extruded vertex too near the vertex from which you are extruding. One quick way around this is to create your vertices sufficiently far from each other to avoid the problem, and then come back and move them to the correct spots later.

Eventually, you will place the last vertex, which will become the point at the bottom of the inside of the goblet. This point should be on the Z axis. Your outline is done!

---

2 Default model: select file→new.
3 Front view: press NUM1.
4 Manipulator off: press $\text{CTRL} + \text{SPACE}$ to bring up the Manipulator menu, then select Enable/Disable.
5 Place a vertex: $\text{CTRL} + \text{LMB}$.
6 Add a vertex: press $\text{CTRL} + \text{LMB}$, or $\text{E} + \text{ENTER}$.
7 Add a vertex: press $\text{CTRL} + \text{LMB}$, or $\text{E} + \text{ENTER}$.
8 Move a vertex: select it with RMB, move it with the cursor, and then press $\text{LMB}$. 

---

387
52.1.4. Spin

Now, to spin it. first, make sure that you are still in edit mode, and that the last vertex is selected. Set the cursor to the selection. Now, get a top view; you are now looking at your outline from the top, and it should look like a straight line along the X axis with one end at the cursor on the Z axis. (If this is not the case, select and move points to the X axis and check your work by switching back to the front view, then come back to the top view.) Now select the whole outline and then move to the button menu to perform the spin (or use the Spin option under Mesh Tools, Add, in the Toolshelf). Set the rotation to 360 and the count to 12 (or another number of your choice) and click on "spin." An elaborate circle will appear. Go to the front view to see your un-smooth goblet.

52.1.5. Finish up

Since you are in edit mode and you have the whole mesh selected, this is a good time to remove duplicate vertices. The two vertices on the Z axis (base bottom center and bulb bottom center) were duplicated 12 times, and the entire outline was duplicated once when the circle closed at the end of the spin. Remove the duplicates. If you fail to do this, the subsurf operation will create a cusp at the two centers, and an crease at the duplicated outline.

If you placed the two Z-axis vertices by hand, they may not be exactly on the axis, and therefore may still be duplicated, leaving a tiny "hole" at the axis. Fix this by merging each of the two sets separately:

1. select the vertices to merge.
2. merge at center.

Now start to smooth by using the subsurf in the button window. First add a modifier and select subsurf. Set levels to 2 Then, use smooth in the texture window. You now have a goblet model.

---

9 Cursor to selection: (SHIFT + , then cursor→selection
10 top view: NUM7
11 Select all: A once or twice, until all are displayed in yellow
12 Front view:press NUM1
13 Remove duplicate vertices:press W and select Remove Doubles
14 Merge at center:Press W, Merge → At Center, confirm with LMB or ENTER
The image shows four objects: the two-dimensional outline, a smoothed version of the two-dimensional outline, the result of spinning the outline, and the result of subsurfing and smoothing. As you follow the procedure above, you will not actually have more than one object at a time as shown here.
52.2. Rendering

As with the other two goblets, it is difficult to fully evaluate the model unless you render it. However, a "pretty" rendering requires at least minimal materials, lighting, and scenery. This section is a cookbook approach to providing these minimal elements and is not really a useful tutorial, so we won’t explain the concepts. These topics are treated at length in later tutorials. If you wish to explore these subjects in more depth, go to the appropriate tutorials.

- The Goblet material: plain glass.
• The tablecloth: A (non-existent) table with a white tablecloth, in a featureless room painted yellow.
• The lighting: one bright lamp.

52.2.1. Material

• Go to object mode and select the goblet.
• In the Materials button window, add a material\textsuperscript{15} to the goblet, and name it "glass."
• In the Material tab, change the color in Diffuse section to black (set R, G, and B all to 0.000.) Here, "black" merely means "do not add any color." It does not mean that the goblet looks black.
• In Transparency section, pick Raytrace. Set Alpha to 0.1 (i.e., quite transparent), set IOR to 1.5, and set Depth to 6 (or higher on a very fast computer.)

52.2.2. Tablecloth and room

• In the main window, put the cursor at the origin and switch to top view. In object mode, add a plane and then scale it to quite large. This is your tablecloth
• Go to object mode and select the tablecloth.
• In the Material tab, set the color to white and ensure the Alpha is 1.000 (i.e., opaque.)
• In the Shadow section, check the Receive Transparent checkbox. (Older versions: in the Shaders tab, click on Trashado.) This allows the tablecloth to show the ray traced shadow of your goblet instead of a fake shadow.
• To paint the room, in the World tab check Blend Sky and change Zenith Color to e.g. yellow.

52.2.3. Lighting

If you started with the default camera and light the scene will be too dark and the shadow effect from the lamp will not be too pretty. To fix this:

• Move the lamp higher and farther away.
• Turn up the Energy.
• In the lamp’s Shadow section, pick Ray Shadow.

52.2.4. Camera

Now adjust the camera:

• Shift to camera view.
• Dolly and aim the camera.
• Move the camera back some.
• Render.

\textsuperscript{15} \textit{Chapter 34 on page 263}
52.3. Detailed keystrokes
53. Light a Silver Goblet (Early look at lighting)
54. Simple Vehicle

Let’s make this jeep.

The idea of this tutorial is to learn to face a complex project. A vehicle is a nice object to use to test yourself and find new problems.

First, we must understand that a project does not reproduce the real world; a project shows an idea or thought and will result in a final image or video. Whatever does not appear in the final result is unnecessary to include in the model.

What vehicle should we make? Let’s go with the classic jeep. This will allow for a lot of doodads.

Let’s decide what objects of the jeep model will need to be made - body, wheels, seats, and a rocket launcher for good measure. Objects we can ignore include the engine, which
remains hidden under the hood. There are many additional objects you can make such as a steering wheel to customize your jeep.
55. Simple Vehicle: Wheel

⚠️ Blender3d Aligned to view issue
This tutorial relies on objects being created so that they are aligned to the view that you're looking through. Versions 2.48 and above have changed the way this works. Visit Aligned (http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Aligned_to_view_issue) to view issue to understand the settings that need to be changed.

55.1. Techniques

You should already know how to:

- Make a mesh
- Navigate the viewport
- Extrusion
- Create, edit materials

This section will recap and introduce:

- Forming faces
- Subsurfing
- Merging vertices
- Object naming

For our premise, envision jeep tires. They’re not too sleek but rather rugged for all kinds of terrain. We need a tire that can handle any obstacle in its way.

55.2. Model the tire

Hit NUM1 to set front view (XZ coordinates), then delete the cube.

55.2.1. Create the outside of the tire

Add a cylinder (SPACE > Add > Mesh > Cylinder alternatively Shift-A > Add > Mesh > Cylinder for newer versions)

use 32 vertices, set the radius to 4, depth to 3, and un-click the "Cap Ends" button (For 2.6x choose Cap Fill Type: Nothing).
55.2.2. Create the inside of the tire

Change to NUM1 view and make sure you are in Edit Mode.

noob note: To get the same orientation in 2.72 I rotated the newly created vertices by 90 degree on the x-axis. Same for the hubcap vertices below.

Select all vertices, hit EKEY (for blender 2.5X and on-wards, also hit ESC then "Alt+EKEY" and choose INDIVIDUAL FACES) and extrude the individual faces into the circle by moving the mouse.

You may either type in -1.2 and hit enter, or Hold SHIFT CTRL while extruding the faces until the sides come in -1.200 units (in older versions of blender hit NKEY first).

55.2.3. Create the outside faces

Rotate around the model and you’ll notice the outside of the tire doesn’t yet exist. Let’s remedy this.

Go back to NUM1 view.

Invert selection (SPACE > Select > Inverse)

Newer versions: CTRL-I for inverse selection

Press FKEY to create the missing faces, in the menu that pops up select auto

Newer versions: no auto necessary.

Figure 277 Checking the outer mesh
Model the tire

**Figure 278** Reduce the width

**noob note**: these steps aren’t working on 2.69, filled outer faces one by one in my case. unless there’s a better way to do it.

**noob note**: You can use the F2 addon in Blender 2.69 to create faces quickly. Select an Edge and press F and it will create the face based on the direction of the mouse.

**noob note**: In 2.69, it’s better to use solidify after doing control CTRL-F than the above process. In edit mode, select all, then press CTRL-F, select solidify in the menu, and type 1.2 for thickness.

**NOOB NOTE** I had the same problem in 2.69. I simply reversed the process. I created the cylinder with a radius of 2.8, and extruded the faces POSITIVE 1.2. After subsurf, the tire look almost like the pictures, and has the added advantage of a more realistic inner edge without needing creases. There are no inner faces, but that is realistic, isn’t it?

**noob note**: If you are using Blender 2.69, you can click E -> Esc then do the above process instead of use this process, everything gonna be fine.

**noob note**: With latest Blender versions, click NUM1, then select all the vertex, click E, click ESC, then S and move the mouse till you get the internal wheel part. The move to side view (NUM3), and switch on the wireframe to see the internal vertex (which should still be selected), use again S till they are vertical-aligned with the external vertex.

### 55.2.4. Subsurf the tire

Now it’s time to make the tire look like a rugged tire.
Return to Object Mode, and apply a subsurf modifier (use the Add Modifier control (it looks like a wrench) and select Subdivision Surface - select VIEW level 1 or 2 to the mesh. The tire will now look like a bead necklace. *(If not, remove doubles by going into edit mode -> select all -> WKEY -> Remove Doubles.)*

55.2.5. Crease the edges

A little creative use of creases will restore our tire.

Check that Limit Selection to Visible is off *(now called occlude background geometry on 2.49b)*.

Enter **Edge Select** mode

Bring up the circle selection tool *(AKEY to unselect all, then CKEY)*.

Use the scroll wheel to change the circle selection size to be in the center of the tire, between the inside and outside edges. This will select all of the inside edges, as well as the triangles on the side of the tire, as in the picture below. In 2.68 or above you will have to hit ENTER to confirm the selection.

Now press **SHIFT+EKEY** to Crease these edges, you can type 1.000, and press **ENTER** , or hold **CTRL** to pull in steps till you see 1.000 in the status bar at the bottom of the view window.

Note: in 2.68 and above the outside edges of the tire don’t crease using the above method. What worked fairly well is to use CTRL-I to invert the selection, then in face mode, hit EKEY -> ESC -> Alt-E -> Individual Faces and move the mouse to create a tread pattern on the tire.

**Noob note:** DO NOT turn the 'limit-selection’ tool on for the above selection, also you MUST be in Edge Select Mode or the triangles will not get selected.

**Noob note:** Make sure that you are in orthogonal view because in perspective view you are not able to make this selection.
Figure 279  Applied subsurf
55.3. Model the hubcap

The tire is almost done. Let’s add a simple hubcap to it.

55.3.1. Create a cylinder

Be sure you’re in Edit Mode

Hit `AKEY`, once or twice till the wheel is selected

Hit `NUM1` for front view

Press `SHIFT+SKEY`, from the popup menu, cursor->selection, to put the cursor at the center point of the existing tire

Hit space-> add-> cylinder with 32 vertices, radius of 1.9, depth of .5, and make sure the ”Cap Ends” button is turned off,

noob note: To get the same orientation in 2.72 I rotated the newly created vertices by 90 degree on the x-axis.
Model the hubcap

Hit **NUM7** for top view

Hit **GKEY**, then **YKEY**, then type 2.2, and hit **ENTER**.

![Hubcap Model](image)

**Figure 281** Add another tube mesh

---

### 55.3.2. Create the outside of the cap

Hit **AKEY** once, so that nothing is selected

Hit **NUM7** for top view

Zoom in with the **MMB** till the hub cap fills the view

be sure you’re in **Vertex select** mode

[Make sure Occlude Background Geometry Mode is off]

hit **BKEY** for box select, then holding the **LMB** drag the box along the top edge of the hubcap.

Hit **EKEY** on the popup select **Only Edges**, then hit **ESC**, to create the edges we will need
Hit **SKEY**, then **SHIFT+YKEY** to only move in the XZ axis, then type in .35, and hit **ENTER**

Hit **SKEY**, then **YKEY** to only move the Y axis, then type in .35, and hit **ENTER**

![Figure 282](image)

**Figure 282**  Shorten the hubcap width

### 55.3.3. Create the Axle Cover

We’ll merge these vertices together to create a flat surface.

Hit **EKEY**, on the popup select **only edges**, then hit **ESC**, to create the edges we will need

Hit **ALT+MKEY** on the popup pick at **center**. Blender will reduce the 32 vertices to 1.

Hit **NUM3** for side view

hit **GKEY**, then **YKEY**, to only move the Y axis, then type in -0.4, and hit **ENTER**
Figure 283  Scale in the front vertices
55.3.4. Final sizing of hub cap to tire

The final mesh editing is to scale the hub cap to a size that is slightly larger than the hole of the tire.

hit NUM7 for top view

position the mouse over the hubcap, and press the LKEY to select the entire hubcap

Hit SKEY, then SHIFT+YKEY to only move the XZ axis, then type 1.48, and hit ENTER

Hit NUM3 for side view

Hit GKEY, then YKEY, to only move the Y axis, then type -1.11 (use -0.77 if you want your hubs sticking out), and hit ENTER

55.3.5. Renaming the Wheel

The last thing to do is to rename the wheel so we can find it easier later.

Enter Object mode and select the wheel only.
In the Link and Materials subwindow in Editing (F9) you’ll see the Active Object name box. It should read OB:Tube in the grey box. This name was created because we started with a tube mesh. In newer versions, it will be cylinder instead of tube.

Click on the button and rename the object to something like ‘wheel’. Save your file where you’ll find it later and continue to the next step.

**Noob note:** although not something you should normally do, if you wish to create separately named objects for the hubcap and the wheel you could initially create them both separately in object mode, or split objects in edit mode with P (seParate) or in object mode, join objects with CTRL+JKEY (can cause side effects).

55.4. Extra

![Rendered tire](image)

**Figure 285** Rendered tire

Change the materials to make it look like a tire. One object can have multiple colors/textures, as you will learn in future tutorials.

*If you’d like to race ahead, then refer to the materials\(^1\) section for an explanation on how to do that, or to the Blender manual: Multiple Materials\(^2\)*
55.4.1. Creating a more complex tire

Start by loading a basic cylinder and rotating it so it rests on its side.

Next, remove the faces from the top, and bottom of the cylinder.
Now Press the 5 key to enter orthographic view.
Then press 7 to view the front of the cylinder.
Then Select Cut loop and slide in your tools menu and make a cut .5 to each side as shown in the picture.

Next, make 2 more cuts .4 on each side, then 2 more .9 on each side as shown.
Next, press the b key to enter box select mode.
you will want to select all the middle faces.

Next, grab the X axis bar as shown, and while you’re holding it type .5
Then press the A key to select everything, then grab the red x axis bar again, and type .5
to squish the whole wheel.
then use the b key to reselect the middle faces
Now, with the Middle faces still selected rotate them so they look similar to the picture shown.

Next, select all the faces beside the middle and rotate them all in the opposite direction so it looks similar to the picture shown.
Next press the A key to unselect everything.

Then start selecting faces as shown in the picture. Continue this all the way around the wheel leaving 1 space of unselected faces in-between each row.

With the faces selected press the S key to scale them. While scaling type -.5 then press enter.

**noob note**: under Blender 2.71, I had to extrude (EKEY then ESC) before scaling.
Next, select all of the side edges as shown and Then grab the white circle as shown and type .7 then press enter.

Then grab the red bar as seen in the picture to move both sides outward slightly.
repeat the last step, but this time when you grab the red handle type 1.5 as shown in the image.

**noob note**: under Blender 2.71, here again I had to extrude (EKEY then ESC ) before scaling.

You’re done!

Feel free to add the hub cap from the previous wheel, or one of your own design.
56. Simple Vehicle: MudTires

---

I’m new to wiki books, if my formatting is incorrect please correct it. My goal is to provide an updated wheel tutorial.***

Congratulations on making it this far; you’ve proven you have what it takes to finish this book. At this point you don’t need me explaining the simple things like the differences between or how to select vertices, edges or faces. Feel free to swivel the camera this way and that. I’ll leave it to you to decide when to turn snap off or occlude background geometry on. At every step I hope you think, “Ah-ha, now it looks more like a tire!” since that’s essentially what I did. I’m writing this tutorial because I don’t want this book to become outdated. Also... I really like tires!
Simple Vehicle: MudTires

This is the real world wheel we’ll be modeling. It has three parts: 1) tire 2) rim 3) hub. We’ll create the wheel laying down starting with the tire and working our way in.

In edit mode delete the default cube and hit 7NUM to go to the top view.

Center the cursor and add cylinder with 32 vertices, radius 4, and depth 2. Set Cap Fill Type to nothing. Turn increment snap on.

Next we will make a series of cylinders which will become the tire and the rim. Extrude the cylinder inwards by pressing EKEY ESC SKEY .9 enter. Do this a total of two times. Next, extrude another cylinder inwards by pressing EKEY ESC SKEY .8 enter.

Unselect the inner cylinders circles so only the vertical edges of the innermost cylinder are selected.
Merge collapse (Alt M >> Collapse) these vertical edges to create a circle that’s vertically in the center of the other cylinders.

Figure 302  merge collapse the edges
Extrude this circle inwards with EKEY ESC SKEY .4. Move this inner circle down some with GKEY ZKEY -0.5 enter.

Hub- Extrude the inner circle up EKEY ZKEY 0.5 enter Extrude size that circle in EKEY ESC SKEY 0.25 enter Move inner circle up GKEY ZKEY 0.15 enter and lastly FKEY to Ngon fill the inner circle

Figure 303  completed simple wheel

To be safe before saving highlight all and remove doubles. We can add different types of tread to this simple tire. If you’re feeling ambitious come up with your own tread design.

Working on the vertical faces of the outermost cylinder in face select mode- Type 1) Subdivide the outer faces and z lock rotate the newly created central edge by 12.
**Figure 304** rotate the middle edge by 12

Stager select every other outer face and extrude size out 1.15. Make sure your sizing outward from the center of the wheel.
Type 2) This tread is a little trickier but the extra work is worth it. Subdivide the outer faces and change the number of cuts to 2. There are now 96 outer faces. Think of these as being on 3 levels bottom middle and top.
Select 2 of the bottom faces skip 4 faces then select 2 more go all the way around the circle. The pattern for the middle level is select 2 skip one select 2 starting at the top left vertex of the bottom level. The pattern of the top is the same as the bottom select 2 skip 4 start at the top right vertex of the middle level just not the same middle selection that the bottom is... see the picture :) 

Extrude size out 1.15 from the center of the wheel
Simple Vehicle: MudTires

**Figure 308** extrude outward to create tread

Type 3) Evenly loop-cut the faces of the outer cylinder

**Figure 309** loopcut center of wheel

CTRL-R center the mouse on the outer cylinder ENTER 0 ENTER Now subdivide the outer cylinder. There are now 3 inner edges. Z lock rotate the top inner edge by 12 and the bottom inner edge by -12.
after subdividing rotate edges

this time make a Z pattern with the faces and extrude size out by 1.15

select tread pattern and extrude outward

To get the wheel standing up lock the y axis and rotate everything 90°
The wheel object as well as the wheel mesh are both named Cylinder in the outliner lets rename both Wheel. Right click the name and select rename.

**Figure 312** rename object/mesh wheel

Lets add a sub modifier and set shading to smooth.

**Figure 313** subdivide to smooth things out

Crease the hub edges. Shift EKEY 1 enter. By the way the easiest way to remove a crease is just to add a negative crease. Shift EKEY -1.
Now for some color- By the way, think of diffuse as being the base color and specular as being the reflected color. If you're curious about words like lambert and fresnel just look them in your favorite dictionary.

In the properties menu select the materials icon.

Create three material slots by clicking the plus button that's above the minus button 3 times.

**Figure 314** crease the hub
Select each material slot and click new to add a material to it. Name the first material Rim, the second Tire and the last Hub.

We'll leave the rim default white. Select Tire and change the diffuse color to almost black RGB of 0.010 and the specular intensity to 1. This gives our tire a very shiny black look. Give the hub a dull gray look by setting the diffuse color to RGB 0.05.
The first material added becomes the default material for the entire object. So we only need to select the parts of the wheel mesh that are not rim.

Select the tire - that's the two outer cylinders - with the tire material highlighted click assign.
Figure 317 assign the tire color to the tire mesh

To make selecting the hub easier close the subsurf eye in either the properties or outliner menu. Assign the hub material to the hub mesh. I’ve left adding the red hub oil seal up to you.

Figure 318 turning subsurf off makes selecting easier
Figure 319  The final Tire rendering

Thats it! Hopefully my instructions weren’t to painful. Be sure to save and good luck!
57. Simple Vehicle: Seat

57.1. Techniques

You should already know how to:

- Make a mesh
- Navigate the viewport
- Extrusion
- Subsurf
- Crease edges

This section will recap and introduce:

- Loop subdivide
- Small, consistent vertex movement

The design will be an all-terrain bucket-type seat.

57.2. Extrude the Seat

![Figure 320](image)

**Figure 320** Basic setup of shapes.

Start in **NUM1** view of the default cube and rename it.
Extrude the cube multiple times to make your basic shape. In this example a 3x3x1 block composes the body with one cube coming out the top for the headrest, and the bottom cube’s front faces extruded out to create the seat.

**Noob Note:** best practice is use "Face" selection mode, select the face, or faces you want to extrude with the \textit{RMB}, then hit \textit{E}, select an axis to move on by pressing the \textit{X}, \textit{Y}, or \textit{Z} keys, and pull with \textit{CTRL} held down.

(If you insist on using Edge select mode, or Vertex mode, you want to only pick "Faces", from the popup menu that appears, after you hit the \textit{E} key; as this will stop the doubles, and inside faces, from appearing. If you don’t see \textit{Faces} on the popup menu then you are really extruding from doubles with reversed normals, so go and remove them (\textit{W} -> remove doubles ), and possibly recalculate the inner and outer normals, before continuing)

### 57.3. Add cushion seams

![Figure 321](image)

**Noob Note:** Before starting on this, you’ll need to make sure you don’t have any unnecessary faces inside the seat, or else you’ll get strange cushion seams.

To add a little texture to the mesh, we’ll add some cushion seams. Use Loop Subdivide (\textit{CTRL} + \textit{R} or \textit{K} -> Loop Cut) and you’ll see the pink selection loop. You can use the \textit{NUM} key to increase the number of loops made at the same time. Use mouse wheel or press \textit{NUM} 3 times to form 4 loops and \textit{LMB} the center column of blocks. You may also find it easier to add them one at a time in the correct place, than inserting them and then moving them.
(To get multiple Loops instead of pressing [NUM+], just press the number of loops you want in this case [NUM4], this is a fast easy way to achieve this.) You can use a mouse-wheel as well.

Noob note: If the loop comes up with green lines rather than purple you have gone one step too far, just press [ESC] and try again. When you see the purple lines use your [MWH] or the [NUM+] button.

57.4. Position the cushion seams

Go into ZX view ([NUM1]) and make sure the view is orthographic ([NUM5] to activate/deactivate orthographic view). Place the 3D cursor on one of the sides of the head rest ([LMB], or [SHIFT]+[S] to move cursor).
Set the pivot to 3D cursor and select the two closest loop cuts. Scale ( [S] ) it down on the X axis ( [X] ) to 0.3. The goal will be to have the loop closer to the cursor to go into the cushion to become a seam. Now, do the same thing for the other side of the head rest.

**Noob note:** The easiest way to select the two closest loop cuts is to first select ( [RMB] , [SHIFT] + [RMB] ) one edge of each loop, and then go to Select Edge Loop ( [SPACE] -> Select -> Edge Loop ). Or hold down [ALT] when selecting one of the loop’s edges. This should select the entire loop. In order to select more than one loop, hold down [SHIFT] as well.

**Noob2 note:** in Ortho view with 'Limit selection to visible' disabled, just box-selected with one drag of the mouse.

### 57.5. Add Depth to the seams
In overhead view (NUM7), select the vertices in vertical parts of the two front facing seams of the seat back, grab them (G), move only along the Y axis (Y), and type in .05.

Switch to NUM3 view and move the vertices in the horizontal parts of the same two seams, grab them and move them down by moving them -0.05 along the Z-axis.

**Noob Note**: I’ve found that an easier way to do this is selecting each loop of the seam one by one and scaling to .95 (make sure the pivot is set to "Bounding Box Center")
57.6. Subsurf the seat

Add a mesh modifier to the object. Select the edges between the back and seat and crease (`\texttt{SHIFT} + \texttt{E}`) them. Crease any edges you feel like to create your perfect jeep seat.

**Noob note:** it’s best to be in Edge select mode when creasing.

A subsurf level of 2 or 3 looks best, and don’t forget to change the render level to 3 or 4.

Select all (\texttt{A}) then either hit the “Set Smooth” button at the bottom of links and materials, or hit \texttt{W} and select “Set Smooth” for a much smoother subsurf.

**Noob note:** If your seat is noticeably misshapen after adding the subsurf modifier, you may just have to delete internal faces in your model. \texttt{TAB} into edit mode, and hit \texttt{F} to get into wireframe mode. Click the face select button and look for faces that are totally inside the model. There will probably be a couple vertical faces (in YZ-plane) under the seams in the seat. I found a few elsewhere, also. Deleting all these cleared everything up.

**Noob note 2:** Another way to remove the extra faces (which can cause the “seams” to be very deep) is to go into edit mode, select your whole seat (\texttt{A}), then hit (\texttt{W}) and select “Remove doubles” from the menu. This is much quicker than finding them individually, and should solve the problem.

**Noob note 3:** The problem may also be solved by going into edit mode, using \texttt{A} to select all, and using \texttt{SPACE} > Edit > Normals > Recalculate Outside (\texttt{CTRL} + \texttt{N}).
57.7. Resize the seat

![Figure 327](image)

Figure 327  Change the widths.

Next, resize the seat’s height and width.

**Note:** Be sure to change the rotation/scaling pivot back to center point!

To make the whole seat narrower in width, select all A twice, then hit S, followed by then type 0.8 and press ENTER.
To make the seat back a bit narrower in thickness, select around the seat back (in vertex mode) with the circle select \( C \). Once you have it completely selected on all of the sides, hit \( S \), lock axis with \( Y \), and type 0.75, and hit \( \text{ENTER} \).

### 57.8. Final touches

This final seat renders to:
57.8.1. Leathery look

To give the seams a leathery cord look, Hit $\text{A}$ twice to select all, then $\text{W}$ and choose Subdivide Fractal on the popup menu (in 2.6x select Subdivide and then press $\text{F6}$ and choose 1 for fractals); just keep the defaults and the seams will look like a bunch of vines until you render it and they look like leather seams.
57.8.2. More concave

![Figure 330](image.png)  Making it concave.

Also the seat can also be made slightly more concave to look like it would hold a person better.
58. Simple Vehicle: Rocket Launcher

⚠️ Blender3d Aligned to view issue

This tutorial relies on objects being created so that they are aligned to the view that you’re looking through. Versions 2.48 and above have changed the way this works. Visit Aligned (http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Aligned_to_view_issue) to view issue to understand the settings that need to be changed.

58.1. Techniques

You should already know how to do:

• Previous Simple Vehicle techniques

This section will recap and introduce:

• UVspheres
• Changing object’s center

58.2. Overview

Two assumptions are going to be made here. One is that the rocket will not be launched in the future (use separate objects if you want to do that). The other is this is going to be a simple, simple design.

If you want to add options to your gun (think sight, trigger), go for it!

58.3. Create the Launcher

Start a new file and delete the default cube.

58.3.1. Add a cylinder

In NUMERIC view, add a cylinder mesh with 24 vertices with End Cap button pushed in (or ⌥N). We’ll use 24 because the default 36 is overkill and will only increase rendering time. Rename and elongate the cylinder along the Y axis. This will be the length of the launcher (minus the rocket).
Noob note: if your cylinder shows up facing the wrong direction, then see the Blender_3D:_Noob_to_Pro/Aligned_to_view_issue\(^1\) page, that describes how to fix this problem with 2.48 and up.

Noob Note 2: on versions 2.6 up, the cap fill type should be set to "triangle fan."

**Figure 331** Elongated cylinder

### 58.3.2. Extrude a tube from the right end

Circle Select ( \texttt{C} ) the vertices at the right end, then extrude ( \texttt{E} ) them as region, and press \texttt{ESC} to create a copy of the vertices.

Scale ( \texttt{S} ) them by 0.7.
Invert the cylinder end to make a tube.

Extrude ( `E` ) them as region toward the left, along the Y axis ( `V` ); This will make the rocket launcher look like it’s a tube.

**Note:** For older versions, which **do not create end caps** keep the previously extruded edges still highlighted. Then extrude ( `E` ) them again, and then hit `ESC`, now merge the vertices at the center ( `ALT` + `M` ). If you did this correctly, 23 vertices should be removed, and all come together to form a group of triangles inside of the tube.

**58.3.3. Extrude a tube from the left end**

Now work on the left end, by following the same steps used for the right end.

**Noob Note:** before starting on the left end, be sure to hit `Ctrl` twice to deselect the internal face you just created on the right side, which you can’t see, unless you hit `Z` to show wireframe mode.
58.4. Create the rocket

For the purposes of this tutorial we will add the rocket on the left end of the launcher.

![Rocket Diagram]

*Figure 335* Finishing the rocket head

58.4.1. For a one piece rocket + launcher

![Rocket Construction Stages]

*Figure 336*

Select the inner ring of vertices using circle select ( □ )
Extrude \((E)\) the "edge" along the Y axis \((Y)\) twice, then scale the new edge by 0.8.
Extrude the "edge" along the Y axis, and scale the new edge by 1.5.
Extrude the "edge" along the Y axis, and scale the new edge by 0.2.

extrude the "edge", hit \(ESC\), and merge \((ALT + E)\) at the center to form the face for the nose

58.4.2. For a two piece rocket and launcher

- **Method 1**: create a cone, rotate it, then extrude and scale to get the rocket shape.
- **Method 2**: create a cylinder, scale it along the Y-axis, then extrude one side, scale to about 1.3, then extrude two more faces, scaling the first about 0.3 and merging the vertices of the second at center.
- **Method 3**: Create a UV sphere with 4 rings, and model it - much in the same way as the penguin - into a rocket.

58.5. Create the mount

Having a launcher is nice, but we’ll need to affix it to the jeep somehow. Let’s add a mount to the tube.

Make sure you’re in edit mode, not object mode!

58.5.1. Add a cylinder

![Figure 337  Mount arm](image)

Add a cylinder with 24 vertices with End Cap button pulled up (or OFF), since we won’t be seeing the ends.

Scale with the Z axis locked, to about 0.55, then move it to the bottom of the tube.
58.5.2. Add a UVsphere

![Figure 338 Place the sphere](image)

The easiest way to have a wide range of motion for the launcher is to use a ball joint. We can simulate one by just adding a UVsphere. The default 32 segments and 12 rings will be fine. This creates a smooth sphere.

You can think of the number of segments as being the wedges visible when the sphere is viewed as you added it. The number of rings then could be described as the depth of the sphere from that same view.

Resize and place the sphere at the new cylinder arm.

58.5.3. Reposition the center point

This next step will be important for continuing the tutorial. Get the 3D cursor to as close to the center of the sphere as possible. While the sphere is still selected after creation, you can press `SHIFT` + `S` and snap cursor to selection, putting it in the exact center of the UV Sphere.

Switch to Object Mode. Under either the Object menu or `SPACE` go to Transform > Center Cursor. This should move the large pink dot where the cursor is located. This will give it a new center of gravity around the ball joint, making it easy to manipulate later.

**Noob Note:** If you have already deselected the sphere, press `L` while hovering your cursor over the sphere. Make sure not to include any vertices from the attached cylinder.

**Noob Note:** In 2.69, I found this in the Tool panel, Object Tools>Origin>Origin to 3D Cursor.
58.6. Subsurf

Be in **edit** mode!

Apply subsurf, level 2

Select everything ( 
[A] twice), and hit the **set smooth** button ( at the bottom of the links and materials panel).

This makes the ends of the rocket launcher tube too rounded, as real ones are squared up.

58.6.1. Square up the tube edges on the right side

On the right side (without the rocket sticking out) be in **Face** select mode
on one of the faces in the outer ring, then circle select (Ctrl), and select all the faces at the end of the launcher tube. You can also do a face loop selection by selecting a perpendicular edge to the loop with Alt + RMB in face selection mode.

Hit the set solid button (at the bottom of the links and materials panel).

Crease the edges of the faces by hitting Shift + E and set it to 1.0.

58.6.2. Squaring up the tube edges on the left side

Figure 341

Now do the left side exactly like the right side.

Noob Note Be sure to deselect everything on the other side first (Alt twice)!!
58.6.3. Squaring up the rocket

Figure 342

RMB on one of the faces in the middle surface, then circle select (C), and select the faces all the way around.

Crease the edges of the faces by hitting [SHIFT + E] and set it to 1.0.

58.7. Final touches

Apply materials or additional items to the object and save for later use.

Do not forget to name the rocket for later use.
59. Simple Vehicle: Body

59.1. Techniques

You should already know how to:

- Make a mesh
- Navigate the viewport
- Extrusion
- Form faces
- Name objects

This section will recap and introduce:

- Deleting and creating edges
- Subdividing
- Merging vertices
- Loop subdivide
- Adding unconnected vertices in one object

59.2. Planning

The jeep is being designed to include the back, flatbed, door holes, dashboard, window, and hood. The window is extruded straight up (older jeeps’ windshields aren’t slanted), and I decided to add a lower back to later hold the bumper/lights if you wanted to add them.

59.3. Building the Jeep

59.3.1. Extrude the Chassis

Start a new file.

Change to front view (NUM1), switch to EDIT mode, and deselect all (A).
Be in **Face** select mode

Starting from the default cube (#1), box select (\E\) on the right edge to select the right face, and extrude (#2) 2 units to the right along the X axis (should default, otherwise \X\). Continue with three more extrusions to the right along the X axis of 1 unit (#3), 1 unit (#4), and 2 units (#5).

deselect all (\A\).

Now starting again from the default cube (#1), box select (\E\) on the left edge to select the left side face, and extrude 1 unit (#6) to the left in the X axis
deselect all (\A\).

box select (\E\) on the bottom edge of block #6 to select the bottom face, and extrude 1 unit (#7) down in the Z axis.
deselect all (\A\).

Finally box select (\E\) on the top edge of #4 the second block from the right to select the top face, and extrude up 2 units (#8) in the Z direction.
59.3.2. **Widen the chassis**

![Diagram](image.png)

**Figure 344**

Now to widen the jeep body.

Switch to top view (NUM7).

deselect all (A).

Reduce the width of the existing boxes (#1) to one square (#2) by box selecting (F) the top edge (since you're in face select mode it will actually select all the faces on that side), now move (C) 1 unit down in the Y axis (Y)

Hit 'W', and select "remove doubles" from the popup (2 will likely be removed)

Extrude (E) by "Region", the top side, up along the Y axis (Y); once for 4 units (#3), and then extrude again by "Region" for 1 unit (#4).

This should give you the figure that is shown to the right.

**Noob Plea:** These illustrations seem to be in reverse sequence. Can somebody fix it so 1 is at the top, then 2, then 3-->4?
Noob note: holding [CTRL] as you do the above moves and extrusions will lock it to grid steps

Noob note: You might want to save your job here and rename it before carrying on as the options below are easier if you can revisit this stage.

![Image](image.png)

**Figure 345** Widening along the Y axis

### 59.3.3. Flatbed and Doors

Our jeep design will have somewhat of a cheat - no actual door.

There are now a few different ways of doing this (thanks to reader submissions)! Try each one and study the results, as they will teach you about the issues you will encounter when you start making models of your own design;

Method 1 is the simplest of them, but teaches you the least in dealing with mesh trouble.

**Method 1**

**Make the jeep bed**
In **NUM7** view

Be in **Face select** mode

Turn **occlude background geometry** (now called **Limit selection to visible**) on. It’s the button with the spotty-box icon to the right of vertex, edge, and face select buttons.

Select (RMB, then **SHIFT + RMB**) the top faces where the flatbed and then doors should go. You should now have four faces selected, two large ones for the bed, and two small ones for the doors.

**Figure 346**

**Figure 347**

Extrude (E) the “region” -2, on the Z axis (Z).
Make the no-door holes

![Diagram](image1)

Figure 348

![Diagram](image2)

Figure 349

Now in front view (NUM1)

Be in **Edge select** mode

Select (RMB) the top edge of the door face, and delete (X) the "edge". Next, do the same to the corresponding door edge on the other side.
Be in **Face select** mode

Select the faces in the bottom of the door wells, and extrude them up 0.5 along the Z axis.

Select the bed panels, and extrude them up .1 along the Z axis ( leaving them on top of each other will cause problems with rendering engines down the road )
**Noob Note:** Be very careful as you extrude the parts up, since they are on top of each other, it’s easy to select the face on the outside, rather than the one on the inside. Once you’ve done the extrusion, check the normal lines by hitting the *draw normals* button in the mesh tools more panel (*if you can’t see it, hover and scroll with the MMB*). If you don’t get good normals, then hit undo, then reselect the faces, and try again until you get the correct face being extruded (50% chance of getting the wrong face pulled up). Or select the faces with a wrong normal and hit the *Flip Normals* button in the Mesh Tools tab.

Finally, select the whole body and remove doubles, (A) to select all then (W) to bring up the specials menu. On the special’s menu, hit "remove doubles".

Note: removing doubles every couple of steps is a good habit to get into, and will save you time down the road.

**Method 2**

**Make the jeep bed**
be in Top view (NUM7), and Face select Mode.
Select the two faces in between the bumpers and windshield (RMB, then SHIFT + RMB).
Now delete both faces (X ->”faces”).

Note: you could also be in edge select mode, and delete (xkey) the edge between the two faces, for the same end result.
You will now add outer faces around the hole we just opened in the model, by selecting two vertices at the top of the model, and two from the bottom of the model.

Be in vertex mode

Deselect all (A) twice

Starting at vertex A, circle select (C) vertex B, C, and D,

Next create a face (F); do this same procedure 5 more times at the vertex groups show in the pictures.
Issues with exposed inside faces (Normals)
Now that we have gotten the new outer faces in place we can’t see into the model any more but we still have a big problem, the floor is actually the outside face of the bottom of the model, this is not good because you should never leave exposed inside faces (the other side of outer faces) on a model.

Exposed inside faces are invisible when looking through them when you apply textures and render it, since nearly all rendering engines completely ignore inside faces (A common problem with many sketchup models, ah the irony!).

You can tell a face is an inside face, by the fact that if you turn on show normals, and show vnormals, on the mesh tools more panel, the outside faces and vertices will have blue lines shooting out of them, while inside faces will not.

Understanding this now will save you lots of wasted hours in the future trying to fix your normals.

![Figure 359](image)

Press **NKEY** and turn on the show vnormals and show normals, and look closely at the exposed interior faces in the floor of the truck bed, they don’t have blue lines poping out in the inside, only on the outsides.

Now select textured from the box where you pick wireframe, or shaded, and the exposed inside faces will become invisible when viewed from the inside, but look great when looked at from the outside.

Add the floor of the bed

Lets make a floor for the bed now.
Be in **Face select** mode

Select (RMB) both faces of the truck bed,

Extrude (E) pick "region" from the popup, and move up along the Z axis (Z), by about 0.2.

With the two faces selected, hit mesh -> normals -> flip to make their normals correct for their new position

Now rotate the model till you’re looking at it from the bottom, as you can see there is now a hole that needs some extra inside faces removed, and new faces added to compete the bottom.
Select each extra face on the sides, and delete (X) the "faces" as shown in the photos.

**Figure 362**

Change to **Vertex select** mode

Select (RMB) corners a, b, c, d, and create a face [F], then do the same for c, d, e, and f.

**Figure 363**

Recheck the normals, and make sure you only have outer faces on the outside of your model.

**Make the door holes**

Method 2.2 is easier!

**Method 2.1 Subdivision**
To cut out one door, select the four vertical edges where the door will go.

Use the subdivide command (W) to cut the edges in half. You’ll notice that the subdividing will also affect the adjoining faces.
Select the two edges at the top of the door panel and delete them, removing the top half of it.

Change to **Vertex select** mode

Now build up faces by selecting the groups of vertex’s as shown in the photo, and creating a face ( ). Do the same thing for the other side, removing/adding edges and creating new faces.
If you want to clean up the look of the sub divided faces in the model

Change to **Face select** mode, and select the faces that are going to be combined.

Press \[F\] and a little window will appear titled ‘Make Faces’. Click on ‘Make FGon’ to merge the faces. *(As you may have guessed, if an FGon face is created and you want to later undo it, select the ‘clear FGon’ option in the Make Faces window.)*

**Note:** to merge an Fgon to a flat face, select it and hit \[CTRL + J\].

**Pro Note:** You don’t even have to make an FGon. Just select the door-to-be, Tris and Quads both, and hit \[CTRL + J\].

**Noob Note:** Q. What is an FGon??

A. It is a fake polygon, a way to hide triangles and quads on flat faces.

**Method 2.2 Multicut**
Be in frontview (NUM1).
Select the top edges where you want the doors

Multicut (KKEY), enter two in the popup, draw a line along the axis of the cut, as shown in the photo, and hit [ENTER].

Then move the newly created edges down and towards the sides.

**method 2.3 (Noobie)**

Select top face of where door is going to be

- to extrude, pick "Region" from the popup menu
- to lock in Z direction
- hold CTRL to snap to whole BUs and move down one BU

Select 2 top edges that look like they have no widths

- to erase, pick "Edges" from the popup menu

Two faces will be missing. For each individual missing face, Select top and bottom edges

- to fill in the missing face.

**59.3.4. Resizing the bed and windshield**

Go ahead and resize the widths of the bed and windshield.
As a precaution, Remove doubles before starting!
To narrow the width of the window, change to **Edge mode** and select the edges shown in the picture, then move (green) along the X axis.
To narrow the width of the side, change to **Edge mode** and select the edges shown in the picture, then move (\[\text{G}\]) along the Y axis.
Always move as many vertices or edges at the same time to not only work faster but to make sure they are moved equally. The use of circle select, loop select, and `SHIFT` while moving vertices is very helpful in fine movements.

![Figure 374](image) Bringing the back to a point.

If you want an object to come to a point such as a wedge from a cube, merge vertices.

In this example, the lower back area will be modified. Select two vertices to join together and press `ALT + M`. Select the option for your merging. 'At First' or 'At Last' will probably be the option that will work here.

Play around to see what each merge option does. After the merging, Blender will tell you how many vertices were removed.

Be certain to "remove doubles" (`W`), as merging creates lots of them. (You can also find it on the menu Mesh ==> Vertices ==> Remove doubles)

![Figure 375](image) Raise the flatbed.
Extrude the bed surface upward. This is only useful in hiding the tires that we’ll add later in the tutorial. Alternatively, you could make two boxes to hide them.

59.4. A Touch of Detail

59.4.1. Adding an Engine Hood

Method 1

![Figure 376 Loop Subdivide select.](image)

Let’s add some detail to the model - how about the hood? First thing to do is add some edges to the front of the jeep. Press `CTRL + R` to enter Loop Subdivide. A pink loop will appear around the mesh. Put the cursor over the area to get the example picture to appear.
When the loop is in the right place, [LMB] click. The place to put the actual cut can now be selected. Do this twice - once for each side. Move and align the resulting edges to form an angle to the front and bring the window vertices in.

Extrude the hood surface up a small amount. We don’t want it too high, just high enough to catch the light.

Zoom in and select the top-front hood edge created from the extrusion. Drag it out along the X axis. Select the now diagonal face of the hood extrusion. Extrude from it. The result will come out of the surface at a diagonal angle. Take the resulting vertices and move them close to the front of the jeep.
Using the additional lines from the loop subdivide you can improve the shape of the window

**Method 2**

Another way to raise the Jeep hood. It doesn’t require loop cuts, so is a bit simpler.

![Hood extrusion](image)

**Figure 379** Hood extrusion.

**Step 1. Make Inner Square.**

Switch to Top-view (`NUM7`), or slightly rotated off for easier viewing. Face-select the top square of the hood.

Do `-xtrude, then hit `<esc>`. NOTE: this WILL make a new surface, hitting `ESC` doesn’t cancel the extrude, just makes its location to be exactly on the old surface.

Do `-cale and type 0.9 and hit `<return>`. Now you will see the new surface as a smaller square (or really rectangle) on top of the jeep hood square.

**Noob Note:** What I had to do is `-cale on ` and type 0.9, otherwise the New Surface For the hood would end up shooting through the Windshield.

![Bring out the top front edge](image)

**Figure 380** Bring out the top front edge.

**Step 2. Shape Hood.**
Still in Top-view NUM 7, deselect all.

Box-select the right two vertices of the new square, towards the front of the jeep.

Do $\text{SCALE}$ -cale on Y, and type 0.8 and hit $<$return$>$. Leave the two vertices still selected.

Do $\text{MOVE}$ -rab on X, and type 0.2 and hit $<$return$>$.

Face-select the resulting quadrilateral.

Switch to Side-view NUM 3.

Do $\text{EXTRUDE}$ -xtrude on Z and type 0.2 and hit $<$return$>$. I used 0.2 to exaggerate the screenshot a bit, you probably want 0.1 instead.

Now you should have a raised hood on the front of the jeep.

**method 3**

Another way to extruding the Hood of the jeep including a lip that comes over the front.

![Figure 381](image)

Step 1: In face select mode ($\text{CTRL} + \text{TAB}$ ->faces), select the top of the hood and press $\text{E}$ to extrude it. Only extrude it a small amount.
Step 2: Staying in Face select mode, here is the tricky part. Select the small face on the front of the hood you just extruded. Then, hit $E$ then $ESC$. This creates a duplicated face on top of the one you selected. Do not click or move the mouse between these two keystrokes.

Step 3: Now deselect the selected face by hitting $AKEY$. Then enter Edge select mode ($CTRL + TAB$ -> edges) and select the top edge of the face you just deselected.
Step 4: Hit **NUM1** to go to the side view. Now using the red X arrow pull the edge out a little further than you pulled up the hood itself then hit **LMB**.

Step 5: Now rotate just enough so you can see under the wedge you just made. Go back into Face select mode (**CTRL** + **TAB** ->faces) and select the face on the underside of it.
Step 6: Go back into side view with NUM1. Now hit E to extrude the face a little with the mouse. When it’s a good size hit LMB.

Step 7: Now make sure the “Select only visible” button is turned off (“Occlude background geometry” in later versions) and go into Vertex select mode (CTRL + TAB -> vertices). Play around with the vertices pulling them a little closer to the front of the jeep. It’s best to select using the box select (B) or the Lasso (CTRL + LMB).
The end result should be an extruded hood with a lip.

59.4.2. Add a Fender

In the topdown view (NUM7), add a plane. Extrude an edge twice to result in three connected planes.
Figure 390  Bend the fender.

Pull the sides down to form a trapezoid shape and reduce the width.

Figure 391  Model with fenders.

Once it is in the desired shape, select the three faces and duplicate it. Press $\text{SHIFT} + D$ and all selected vertices, edges, and/or faces will be duplicated. The copy will automatically be grabbed for moving.

Move the duplicate to the jeep body and repeat the duplication two more times for a total of four fenders.

Noob note: A good idea is to first position one fender, then copy it and restrict movement to x or y-axis. Then copy both fenders and move the two new copies along x or y-axis. Much simpler than trying to position four fenders individually.
59.4.3. Add a rocket launcher mount

![Diagram of tripod setup](image)

Figure 392 Setting up the tripod in **NUM1** view.

We’ll move on to making a tripod support for the rocket launcher.

Add a cylinder mesh with 12 vertices then scale and size it so that it looks like a tube. Once you have it to a size you like,

Duplicate it twice for a total of 3 cylinders.

Rotate two of the cylinders in the **NUM1** view by **LMB** clicking on the white circle that appears when the cylinder is selected in rotate mode.

The picture on the left is an example of the end result.
Change to overhead view (NUM7) and put together the three cylinders so the tops come close together. Now all three can be selected and moved or rotated accordingly.

Move the tripod onto the jeep flat bed. The final steps are to select your materials and rename the object (described in the wheel section). This will complete our simple jeep model.
59.5. Subsurf

Since we expect a jeep body to have squared up edges, we won’t subsurf this part of the model.

59.6. Optional Activities

Feel free to add anything you see fit such as bumpers, guard rails, doors, steering wheel, lights, etc. You can either have them on the same object or separate objects (useful if you want to move them around).
60. Simple Vehicle: Some Assembly Required

60.1. Techniques

You should know how to:

- Do everything discussed in previous tutorials

This section will recap and introduce:

- Append a file
- Duplicate an object

60.2. Overview

The objects for the simple vehicle have been made if you have followed all the previous Simple Vehicle tutorials. Putting it all together will come very easy now.

60.3. Appending the File

If you have the jeep body file open, keep it open. Otherwise, open the file for the jeep body.

In Object Mode, go up to File > Append (Append or Link in later versions), about 3/4 of the way down the menu. The Find file window will appear. Go to the location where the jeep seat was saved. When the .blend file is clicked, you’ll go into it as if it is a directory.
Here we have the categories of Camera, Lamp, Material, Mesh, Object, Scene, Text, and World. We are interested in the seat object, so click on Object. Now there are three items: Camera, Lamp, and Seat. That is, it will say Seat if you named your object Seat. This is why it is useful to rename your objects, materials, etc. If you forgot to rename the object, it will be called Cube (default for our starting mesh).

**Noob note:** You must be sure you’re appending, and not linking! If you try to duplicate it, and you get an error, then it’s probably linked, there will also be ”li” to the right of the ME: object name button. Ways to be certain you’re appending are: when selecting the file, look at the bottom for the append/link options and make sure ”Append” is selected; In the file menu, don’t choose ”Append or Link (Image Browser)”, you need to use the option above it.

![Figure 396](image1)

What should happen after selecting Seat and the button ’Load Library’ is the seat will pop into our file where the 3D cursor was.

![Figure 397](image2)
It will definitely need to be scaled, rotated, and/or moved to the right position. One way to do this is to rotate the seat about the Z axis -90 degrees by pressing \textasciitilde{R} \textasciitilde{Z} \textasciitilde{P} \textasciitilde{U} \textasciitilde{NUM}. \[ \]

After placing the seat in the jeep body, let’s make another so we have a seat for the driver and passenger. Still in Object Mode with the seat selected, duplicate it (\textasciitilde{SHIFT} + \textasciitilde{D}) and slide it over. After duplicating it, it will automatically go into grab mode. If you \textasciitilde{RMB} or \textasciitilde{ESC}, it will still be duplicated - just sitting on top of the original.

\textbf{Noob note:} Duplicate appended objects in object mode, not edit mode, as they are separate objects and do not share the same edit mode space (each appended object has its own edit world, unless you join them together)

\section*{60.4. Rinse and Repeat}

Append the file again to place the wheel object and rocket launcher in the file. Scale, rotate, move, and duplicate each object accordingly. Depending on the position of your camera, you may or may not have to make all four tires. Remember that the only important parts to draw are those that will be seen!

Set the ball over the tripod. The fun part is rotating the rocket launcher since the center of it has been moved to the ball joint.
60.5. Parenting

Be sure to parent each item to the jeep chassis, by selecting the item, let’s say the tire, then also selecting the chasis (RMB then [SHIFT] + RMB) and then [CTRL] + [P], and select “make parent” from the popup menu.
60.6. Final things

You can apply material in either object, or edit mode. As you might have noticed when you select something in object mode the entire object is selected, in edit mode on the other hand individual faces can be selected, and painted.

60.6.1. Make the windshield look like glass

You have to create a new material and assign it to the appropriate faces.

In edit mode, select the faces you want (make sure you select both sides of the windshield including: front face, back face, and top face).

On the Editing section F9, under Links and Materials, click the 'New’ button under Materials then click the 'Assign’ button. This assigns the new material to the selected faces.

You can then go into the Shading section F5 and adjust the material to be glass, by setting the alpha to .20, and hitting the ray transparency button. Three more ways of making a material that looks more like glass are shown in Material Glass\(^1\).

Make sure you are editing the correct material (if you have just the one texture on the jeep, the default name for the new material should be something like ”2 Mat 2”).

Figure 401

Other possible ideas
Figure 402

Figure 403
Simple Vehicle: Some Assembly Required

Figure 404

Figure 405  Created by following the great tutorial!
60.8. Additional Tutorials

Append and Link Video Tutorial: http://www.youtube.com/watch?v=69ZB1Dr01IY
61. Modeling a 3D Parachute in Blender

Information
Applicable Blender version: 2.67

61.1. Remove the default cube

When you first open blender you will see the default Blender user interface (UI) layout and the default cube.

Delete the cube by selecting it with \texttt{RMB} and then pressing \texttt{X}.
61.2. Add a cylinder

Switch to **Side** view (NUM3).

Add a Cylinder with \( \text{SHIFT} + \text{A} \rightarrow \text{Add} \rightarrow \text{Mesh} \rightarrow \text{Cylinder} \). At the bottom of the Tool Shelf change “Cap Fill Type” to “Triangle Fan”.

Press \( \text{TAB} \) to switch to Edit mode. The cylinder should now look like the picture at right.
61.3. Remove the bottom row of vertices

Next you will want to delete the bottom row of vertices. To accomplish this go into side view by pressing [NUM3].

Ensure that you are in **Vertex select** mode (that the leftmost of the group of 3 icons
is selected; click on it if not).

Press \[ A \] twice to deselect everything.

Press \[ B \], and box select the bottom row of vertices, and press \[ X \] to delete and then confirm.

Note: you must have limit selection to visible off, the button to the right of the group of three icons for selection. If you wish to do the selection with it ON, you will have to change your perspective so as to be able to select all lower vertices.

### 61.4. Extrude and scale to shape
Be in **Vertex-select mode** (as above).

Select all the vertices around the outside of the circle. The centre vertex must not be selected. You can do this conveniently in a number of ways; why not practise them all:

- Starting with no vertices selected, use [A] to select all vertices, then [SHIFT] + [RMB] on the centre vertex to deselect it. Or
- Starting with no vertices selected, [ALT] + [SHIFT] + [RMB] (*loop select*) on one of the outside edges or vertices to select the entire loop of them. Or
- [RMB] on the centre vertex to select only it, then use [CTRL] + [I] to invert the selection.

Now switch to edge-select mode by [CTRL] + [TAB] and selecting Edges.

---

**Figure 412**

**Figure 413**

Press [E] to extrude ("region") the selection and [Z] to constrain to the Z axis.

Drag the edges a small ways down then click [LMB] to release.

As this makes a right-angle at the sides and parachutes to don’t have straight edges, we need to scale the selection outward.

Press [S] and move the mouse away from the model, you will see that the edges get smaller and bigger.

Scale them out a small ways then left click to release. You will want to practice a little with the scale amounts till you can make a realistic parachute shape.

Continue extruding and scaling till you have a shape like the one shown on the right.

When you’re done making a nice shape, be sure to select all ([A] twice), then [W] and pick “Remove Doubles”.

499
61.5. Make the top more rounded

Be in Vertex mode.

Select the center vertex in the middle of the original top half of the cylinder, use circle select to get it, otherwise you will be RMB a number of times to find it, and move it up along the Z axis.

Select all A, and then W and Remove Doubles, in case any were created.

61.6. Extrude the parachute straps

Figure 414

Figure 415
Now go into top-view by pressing \[ \text{NUM7} \]. Here you will select 4 edges at opposite sides of each other.

![Figure 416](image)

Go back into side-view \[ \text{NUM3} \] and extrude downward by pressing \[ E \] and then \[ F \].

**61.7. Merge it together**

![Figure 417](image)
All that remains to finish your parachute is to press $\text{ALT} + M$ then choose “At Center” which will merge all selected vertices.

A alternate way to make the parachute top is to create a UV sphere, and cut it in half.
62. Model a Low Poly Head

ℹ️ Information
Applicable Blender version: 2.49

This tutorial relies on objects being created so that they are aligned to the view that you're looking through. Versions 2.48 and above have changed the way this works. Visit Aligned `https://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Aligned_to_view_issue` to view issue to understand the settings that need to be changed.

⚠️ Warning
Using triangles on a subsurfed model may result in "peaks" appearing in some areas. To reduce this problem, merge as many triangles into quads as possible.

62.1. Overview

This tutorial is designed to teach users to make a low-poly animesque head in Blender.

What you need to know:

- Basic Blender controls
62.2. Add a plane

Start with a new file, and delete (X) the default cube.
Be in Front view (NUM1)
Add a plane (SHIFT + A -> add -> mesh -> plane)

62.3. Make a pointed chin

Switch to Edit mode
Be in Vertex select mode
Select the bottom two vertices (SHIFT + RMB) and press W to bring up the vertex menu.
"Select Merge", then "At Center", or just hit ALT + M and choose "At Center".
Make a pointed chin

Figure 420  A pointed chin!

Now you have a pointed chin.

Figure 421  A pointed chin!

Select the top two vertices (use the $E$)
Select the top 2 vertices

Re-arrange them so they make more of a chin shape by pressing the $\text{G}$ to move and $\text{Z}$ to constrain the movement to the Z-Axis.

**Noob Note:** Move it down; don’t scale it out.

### 62.4. Extrude the face

Now extrude ( $\text{E}$ ) "edges only", along the Z-Axis ( $\text{Z}$ ) so that you have another area.
As a precaution, remove doubles. (WKEY)

Scale it (S) so that it’s not so cubic.

Now extrude along the Z-Axis again (E then Z) and scale (S) it down a bit.
Extrude along the Z-Axis again

One last time... (E) (Z) (S)

### 62.5. Make the facial features

Select the middle vertices \textcolor{blue}{(BKEY)} or \textcolor{red}{(RMB)} and press \textcolor{green}{(WKEY)} to bring up the specials menu. Subdivide it once.

**Noob Note**: On version 2.67. Subdividing doesn’t appear to give the desired effect. I used the Knife tool. \textcolor{purple}{(KKey)} instead.

**Noob Note**: I used version 2.68 and when I subdivided I checked the box saying “Quad/Tri Mode” in the lower left corner. In the end I got the result I needed, so I think this is the option you need to get the desired effect.
Make the facial features

Now select at first the pair of vertices above and subdivide once.

Now subdivide 3 times with the pair of vertices below the center line.
Figure 430  There!

Yours should now look like this one on the right.

62.5.1. Eyes

Figure 431  Subdivide some more

Select and subdivide here, so you can make the eyes.
Figure 432  Make some eyes

And rearrange the vertices so they make eye shapes.

62.5.2. Nose

Figure 433  Select these
Now select the middle vertex here (right mouse button).
Extrude it along the Y-Axis (EKEY) (YKEY) and move your mouse around to change how far it moves.

Figure 434  Let’s make a nose!

Select these three vertices (SHIFT+RMB) and press (F) to make a face.
Make the facial features

**Figure 435**  Do the same to the other side

Now do the same to the other side, and you will have the nose’s base.

**Figure 436**  Make a face

Select these vertices (SHIFT+RMB) and make a face (F).

Do this to the other side.
You have a nose!

Now you have a nose.

62.5.3. Remove interior nose faces

Rotate the camera (CTRL+NUM1) so you are seeing the back.

Be in Face select mode.
Figure 439  Get rid of these

Select (SHIFT+RMB ) the faces behind the nose.
Delete (XKEY ) them (on the popup pick "Faces").

62.6. Smooth the mouth region

Figure 440  Select these

Be in Vertex select mode
Select the vertex at the bottom of the chin, and the one at the bottom of the nose.
Subdivide them.
**Noob Note:** I had to select and subdivide the **edge** that runs from nose to chin.

### 62.7. Make the head

![Figure 441](image1)

*Select edges on the outside*

Be in **Edge select** mode

Select all the edges on the outside (shown with blue lines in the photo).

![Figure 442](image2)

*Give the face more smoothness*
Move \((\text{GKEY})\) the vertices back, along the Y axis \((\text{YKEY})\), a bit to give the face more smoothness.

**Figure 443** Select the vertices at the back of the head.

Be in \textit{Vertex select} mode.

Rearrange the chin, by moving \((\text{GKEY})\) the bottom vertex along the Y axis \((\text{YKEY})\) till it looks right.
62.8. Make the back of the head

Be in **Edge select** mode

Now select the edges all around the back of the head, using (BKEY).

Extrude these along the y axis (EKEY) (YKEY)

**Figure 444** Extrude along Y-Axis

**Figure 445** Ta da!
Now select a set of 4 back vertices that form sort of a rectangle and press (FKEY) to make a face.

and so on....
Model a Low Poly Head

**Figure 448** and so on...

and so on....

**Figure 449** Subdivide these

now select and subdivide these once (W)
Make the back of the head

**Figure 450**  Subdivide these as well

and these points too.

**Figure 451**  Move the middle back

Now select the middle and move it back (G) (Y).
62.9. Finishing it up

And here it is with sub-surfacing. You have finished. Hit (F12) to see the final render.
63. Building a House

In this tutorial, you will learn how to make a simple toy-like house with a fence around it. You will learn how to use *array modifiers* to replicate the palings of the fence, saving you from duplicating them one by one.


Permission was asked to use it and Ton Roosendaal said "Be assured that everything that was produced by NaN now is open and free content for everyone to reuse, including the tutorial "Building a House"."

---

**Information**

Applicable Blender version: 2.67
63.1. Setting the Scene

Start a new document (CTRL + N). Split the view into four views as at right, by pressing ALT + CTRL + Q. This gives you a standard set of views: top, front, side and camera, the first three orthographic and the last one in perspective. You can switch back to the single 3D view at any time by pressing ALT + CTRL + Q again.

Leave the default cube, it will be the walls of the house.
63.2. Make the Roof

Ensure you are in **object** mode ( **TAB** switches between object and edit mode)

Now, in the Front view window (lower left)

Press **SHIFT + D** to duplicate the cube, grab mode is automatically selected, press **Z** to restrict the move to the up-down axis and move the cube to rest on top of the original (pressing **CTRL** while moving will snap it to the grid and make it easier to position accurately.) Press **ENTER** when it is in place.

You can see how useful this four-paned window is; it shows you exactly what’s going on.

Note: It helps to simply grab one of the arrows, press **Z** and then press 2 on the key pad, this will move the block 2 units in the z direction. the standard starting cube is 2 units tall.

**Note:**
Make sure you are duplicating the cube in Object mode, not Edit mode, so the roof ends up as a separate object.
The top cube is going to become the roof and needs to be given a triangular cross-section. Select the top cube (if it is not already selected) by clicking RMB on it. Press TAB to go into Edit Mode (check the box in the middle of the 3D window header). Press A to deselect all the vertices.

In the top view, select the top four (RMB the first one and SHIFT + RMB the rest). You can check in the other views that only those four are selected.

Note: another way to do this is to have "limit selection to visible" turned off, and then press the B for, border select, and make a box around the top vertices. (it helps to view it from one of the sides, by pressing either the 1 or 3 keys)

Another Note: Or, with 'limit selection to visible” turned on, press C for circle select and turn the mouse key to make the circle large enough to enclose all four vertices before you press LMB.
63.2.1. Make the Apex of the Roof

Now press \[ S \] for scaling and \[ X \] to limit the scaling to the X-axis (left to right). You could try to move the mouse back and forth to bring the top vertices together, but you will have a hard time lining them up exactly, so it’s best to just type in \[ 0 \] (zero) followed by \[ ENTER \] to set scaling to zero.

Now it looks like there are only 2 vertices where there were 4, but in fact there are still 4, even though 2 of them are occupying exactly the same positions as the other 2. With these 4 still selected, bring up the vertex specials menu with \[ W \] and select “Remove Doubles”. You should see a message briefly flash up at the top right saying “Removed 2 vertices”. Now there really are only 2 vertices where there previously were 4.

**Note:**
“Remove Doubles” is a handy function to use after complicated mesh edits. It helps reduce complexity in your mesh structure.
63.2.2. Form the Eaves

The roof needs to project over the walls of the house to form the eaves. To do this, we will scale it, but only along the X- and Y-axes, not the Z, so it doesn’t become taller.

Select all the vertices in the roof object by pressing $\text{A}$ once or twice.

Press $\text{S}$ to scale, followed by $\text{SHIFT} + \text{Z}$ to scale uniformly along all axes except Z, and scale to about 1.1. Confirm the operation with $\text{LMB}$ or $\text{ENTER}$ in the usual way.

63.3. Naming the Roof and House Objects

In a complex project with lots of objects, it can be helpful to keep them straight by giving them names. This is less of an issue in a simple tutorial like this one, but for practice, let’s give names to your objects anyway.

Go to the Object context
in the Properties window, and at the top you should see an editable field containing the name of the currently-selected object. The walls of the house should be called “Cube”, and the roof should be called “Cube.001” (note the automatic addition of a numeric suffix to keep the names unique). Try changing these to, say, “House” and “Roof” respectively.

63.3.1. Object Name Versus Mesh Name

If you look in the Mesh Data context
, you will also see a name like “Cube” or “Cube.001”. This is a separate name for the object-type-specific data (the mesh data, in this case), quite independent of the object name. Don’t worry about this name for now; you will learn about its significance later\footnote{Chapter 42 on page 327}.

### 63.4. Colouring the House

The roof now needs to be given a different colour to the default grey. Select the Materials Context.
in the Object Properties window. In the list at the top, you should see a single entry, called “Material” (the name of the initial default material). Below that is an editable field containing the name, and immediately to its right should be a small box with the number “2” in it. This number indicates that the same material is being used in two places—in this case, we know the other place is the object representing the walls of the house. Click on this “2”, and that will force a new copy of the material to be made (leaving the house walls with the original); the number will disappear, and the material name will change to “Material.001” to be different from the original.
Change this material name to “RoofRed”, to make it clearer what it is for. Next, find the panel “Diffuse” further down, showing a swatch of the diffuse (non-reflective) colour, which is initially white. Click on this to bring up a colour picker, and choose some suitable shade of red for the roof. (Notice that when using shades of red, the white to black slider on the right actually creates shades of brown from the red.) As you do this, the 3D view should instantly update to show your new colour being applied to the roof of the house. If you want to exit the colour picker and leave the colour unchanged, press \[\text{ESC}\]; otherwise, to confirm your choice, simply move the mouse outside the picker window, and it will close, leaving your last-chosen colour in effect.
Follow a similar procedure to choose the colour for the house walls: click the “House” object with **RMB** in one of the 3D views, go to the Materials Context.
in Object Properties, change the material name from “Material” to something more appropriate (here I’m choosing “HouseSandy” because I’m going to give the house walls a sandy-yellow colour), click on the colour swatch in the “Diffuse” panel and choose a suitable colour for this material. **Noob Note:** I have found it very useful, when I re-name anything, to type my new name in ALL CAPS. This makes it easier for me to pick out what I have done.
Your house should look like this now.
63.5. Make a Chimney

Go into Object mode, if you’re not already in it. (TAB flips between object and edit mode.)

Go to the Front view (lower left window).

Click LMB to position the 3D cursor on the right-hand side of the roof, this will select the spot where the chimney will be created.

Press SHIFT + A to Add → Mesh → Cube from the popup menu — a bit large, isn’t it?

Scale it along the X and Y (S, SHIFT + S) to about 0.2.

Now grab it (G, X) and move it into position looking at the front view (lower left window). (Feel free to use the mouse wheel to zoom in the view to make things easier to see.)

When this is correct, move it into position along the Y axis (T, Y) looking at the top view (upper left window).

You can check the side view (lower right window) and the camera view (upper right window) to see that it looks OK.
63.5.1. Name and Colour the Chimney

In the Object context

Figure 466

in the Object Properties window, change the name of the chimney object to "Chimney".

Next in the Materials Context
in the Object Properties window, you will notice there are no buttons, and there is an icon
Figure 468

, and next to that a button with the word "New" in it. You can now choose to have the chimney a different colour to the roof or the house or reuse one of these colours.

If you want a new colour, the "New" button, and it will create a new material with a default name and settings. You can rename this and give it an appropriate colour.

If you want to reuse the same colour, you can click on the icon
and select from the available materials, namely "RoofRed" and "HouseSandy".
63.6. Adding a Window

63.6.1. Make the Window Frame

Be in Object mode.

Using the front and top views, click **LMB** to place the 3D cursor where you want the window to go: use the top view to place it against the front wall, and the front view to place it a little to the left and up from the centre of the wall. (Of course, it’s easy enough to reposition the window after you’ve created it, so exact initial placement is not critical.)

In the front view (lower left) add a plane: **[SHIFT] + A** Mesh → Plane). This will initially be laying flat, facing upwards instead of forwards; to fix this, just rotate it 90° about the X-axis: **R** **0** **ENTER**.

Scale **S** it down to 0.4, and press **ENTER**.

To give it a rectangular shape, scale the plane by about 0.8 along the X-axis **S** **8** **ENTER**.

Move it into position (**G**), using the top and front view, on the left hand side of the house a little higher than midway.

Be in the Side View window (lower right).
Move the plane along the Y-axis (G, Y) until it is just in front of the house. You may want to zoom in (MW) to see better.

Now, still in Side View,

Switch to Edit mode (TAB)

Extrude the plane towards the house (E, -0.07) until it is embedded in the wall.

63.6.2. Make the Window Sill

Figure 471  Box-select in progress
To make this box into a window frame will require a larger view: move the mouse into the Side View window and zoom in with the mouse wheel.

Deselect all (A) and select the outer (leftmost in the right view) vertices using box select (B).

Press E and immediately (without moving the mouse) press ESC. This will extrude, but leave the newly-created vertices on top of the previous ones.

Scale the newly created vertices by 0.9 (S DKEY TKEY DKEY ENTER).

Figure 472
Extrude again inwards to most of the depth of the box about -0.03 to -0.05 along the Y axis, depending on how you have your window into the wall (\( \mathbf{E}, \mathbf{Y}, -0.03, \text{ENTER} \)).

This screenshot shows a side view in wireframe mode (use [W] to switch wireframe mode on and off).

**Note:**
The outer panel of the window that you just made cannot be inside the wall, you will see this best on the side view. (If the outer face of the window pane is inside the wall you either won’t see any paint/texture you apply, or it will half show up.)
63.6.3. **Name and Colour the Window Frame Object**

Change the name of the window object, as you previously did for the rest of the house pieces. It will be initially called “Plane” (because that is the kind of mesh object you started with); change it to “WindowFrame”. Also give it a new material, and make it white. Change the material name to “WindowFrame”.

63.6.4. **Make the Window Glass**

The glass of the window has to have a different material from the frame. There are two ways to achieve this: make them separate objects, or make them the same object, with different materials assigned to different faces. We will do the latter.
Deselect all (A)

Be in Edit mode.

Switch into Face select mode (CTRL + TAB -> faces) select mode (you’ve been in Vertex select mode up to now)

RMB on the face in the center of the window frame, to select it.

In the Materials Context, click the "+" button next to the list of materials, and where that was previously showing just the “WindowFrame” material, you should see a new blank item appear. The rest of the window will go blank, but the “New” button will appear; click this.
to create a new material. Give it a colour reminiscent of glass; I chose to colour it light blue ("87ceeb" SkyBlue).

Now to connect the new material to just that one face, press the Assign button just under the material list.

**Note:**
The material Assign, Select and Deselect buttons only appear in Edit mode.

*Figure 475*
Note:
**Patience, Grasshopper.** A simple blue rectangle may not look very much like glass. But don’t worry: in later lessons, as your skills improve, you will learn how to make a material that looks like *real* glass.

63.7. Adding a Door

Add the door using the same method:

Be in Object mode

Deselect all,

Create a plane, rotating it to face forward as necessary (R, X, PREY, PREY, ENTER) to align it with the front wall of the house.

Scale the plane down by .7 and then again by .5 along the X axis.

Move it into position using Front view and then move it against the wall of the house in Side view.

Change the Object name to “Door”. Create a new material for it; change the material’s name to “Door” and choose an appropriate colour for it.
63.8. Building the Fence

The fence will consist of long sequences of identical palings. Creating them one by one would be a long, tedious process—which is something the computer, not a human, should do, right? In fact, even creating just one paling and making duplicate copies would be a long, tedious process. Which is where the magic of modifiers comes in.

Blender’s *array modifier* lets you make any number of copies of a single object, all neatly arranged in a row or in various other ways. Being a modifier, the copying only happens at render time, so there is still only a single object to edit while modelling: change that, and the change is automatically propagated to all the copies.

63.8.1. Make a Paling

Be in object mode, with nothing else selected.

Add a plane, orient it vertically ( 90 ENTER), scaled to 0.4 and then 0.1 along the X axis in Front view.
Switch to edit mode. Ensure you are in vertex select mode (CTRL + TAB -> "vertex"), in case you were still in face-select mode from making the window (above).

To give it some thickness, go into Side view and extrude it to 0.05.

![Figure 479](image)

The pointed top is made by going back into Front view,

Selecting the top vertices and extruding them by -0.07 (along the Z axis is selected automatically),

![Figure 480](image)

Scaling them to 0 along the X axis and then removing the doubled vertices (W, "Remove Doubles": it should say "Removed 2 vertices").

In Top view move the paling to the intersection of two grid lines at a suitable distance from the house.

In Front view again, check that the bottom of the paling is level with the bottom of the house.

Change the name of the object and the mesh to "Paling", create a new material for it called "Paling" and make the colour white.
63.8.2. Duplicate the Paling

Figure 481

Be in Front view, as the flat face of the paling is along the X axis and it is easier to create the front fence first.

Change to Object mode. Select the paling. Find the Modifiers Context
in the Object Properties window. Click the “Add Modifier” button, and in the menu that pops up, select “Array”. You should see a second copy of the paling appear next to the first.
Look at the checkboxes: “Relative Offset” should be checked, “Constant Offset” and “Object Offset” should not be checked. Under “Relative Offset”, there are values for X, Y and Z; these are the distances between copies, relative to the dimensions of the object. Change the X value to something like -2 (the negative value causes the duplicated paling to appear on the other side, away from the gap we want to leave in front of the door). Now increase the number under the popup that says “Fixed Count”, and watch the line of duplicates lengthen until it reaches the point that you want to be the corner of the fence line—a count of about 12 did it for me.
Now type `ALT + D` to make a duplicate of the row of palings, followed by `X` to constrain its movement to the X-axis (parallel to the row of palings). Move the duplicate row to the end of the existing row so it looks like a continuation of it. Now type `R Z -90 ENTER` to rotate it so it lies parallel to the side of the house. Increase the array count for this row to something like 24 so it extends all the way past the side of the house to a suitable corner point.
Again, type `ALT + D` to duplicate this second row, this time followed by `Y` to constrain its movement parallel to the side of the house. Move the duplicate so it looks like a continuation of the same row. Rotate it parallel to the back of the house by typing `R` `Z` -90 `ENTER`. Adjust its array count as necessary to get the right length.
Once more, type `ALT + D` to duplicate this third row, followed by `X` to constrain its movement parallel to the back of the house. Move the duplicate to the end of the row, and rotate it to be parallel to the side of the house with `Z -90 ENTER`. Give it the same count you did to the array on the other side, so its length will be the same.
One last time: **ALT** + **P** to duplicate, **Y** to ensure it only moves parallel to the side of the house, move to the end of the row, rotate into position with **W** **Z** -90 **ENTER**. You’ll probably find it’s so long it runs into the original row of palings you started with on the other side of the front of the house; reduce its array count to something like 8 and you should end up with a nice gap in front of the door.

**Noob Note:** I encountered a problem when rendering the fence. It became grainy, and when I say grainy, there are random clusters of black all over every rendered post. Some had few of this ‘grain’ while others were almost black. I have environment lighting at 1 and it’s still goofed up. Would this be due to hand-sizing them instead of putting in all of the above values? I was unable to upload a picture of this to the site, so I used my Dropbox to share the link, here:\[2\].

**Noob Answer:** I don’t think hand sizing would make any difference. The first thing I would do is go back into edit mode on the original paling and select all vertices. Then I would hit ‘W’ and click remove doubles. After that, recalculate the normals by holding ‘Ctrl’ and hitting ‘N’. Those operations typically fix common rendering issues for me, hopefully it will work for you too.

<table>
<thead>
<tr>
<th>Alternate Noob Solution</th>
<th>I encountered this problem and it turns out it is caused by having more than one copy of the fence in the exact same place. Try moving the affected fence</th>
</tr>
</thead>
</table>

2  [https://www.dropbox.com/s/ml2jbf6kq6q0s1/untitled.png](https://www.dropbox.com/s/ml2jbf6kq6q0s1/untitled.png)
pieces, to find the duplicate then delete it. Remove doubles did not work for my instance of the problem.

63.8.3. Make the Horizontal Bars (Left Side)

![Figure 488](image)

The fence needs horizontal bars to hold the palings in place: be in Front view LMB below the middle of the left-hand fence.

Create a plane, rotating it to the vertical as necessary (R X 90 ENTER) and scale it to the length of the fence.

Scale it again to 0.05 along the Z axis and move it into position. (if you keep CTRL pressed while you move it, it will snap to the grid.)

Go into Edit mode (TAB)

In Side view move it so it is against the back of the fence and extrude it by -0.04 along the Y axis.

Go into Object mode (TAB). Give the horizontal bar the same material you previously created for the palings.

Duplicate it (ALT + D) and move it (keeping CTRL pressed) along the Z axis (Z) to make the bottom bar.
63.8.4. Make the Horizontal Bars (Right Side)

To make the bars on the right-hand part of the fence: In Front view, select both the horizontal bars you just created: [RMB] on one, then [SHIFT + RMB] on the other (you may need to zoom in to be able to select them without accidentally including the rest of the fence). Duplicate them with [ALT + D]. Move your duplicates along the X-axis [X] until they are horizontally centred around middle of the right-hand fence; now scale them horizontally [S] [X] until they are the right size.

You could have done the bars one by one, but it’s quicker to do them both at once, don’t you think?

63.8.5. Put the Horizontal Bars Around The House

Select the two horizontal bars you created above for the front fence (make sure you don’t select anything else, like the palings). Press [ALT + D] to make a duplicate, then [R] [Z] to rotate the duplicate about the Z-axis, type 90 for the angle and press [ENTER] to confirm the rotation. In the top view, move the duplicate ([G]) you just made so it’s against the side fence. Keep scaling it along the Y-axis ([S] [Y]) and/or moving it along the Y-axis ([G] [Y]) until it’s the right length and position.

Having done the side of the house, press [ALT + D] to make another duplicate of the horizontal bars, and [R] [Z] 90 [ENTER] to rotate it into the right alignment for the back
fence. In the top view, move (G) it against the palings. Now keep scaling and moving it along the X-axis until it has the right length and position.

Having done the back of the house, do the other side: another duplicate of the bars, rotate 90° around the Z-axis, move against the palings, move and scale until they’re the proper length in the right position.

Again, another duplicate, rotate and move/scale into position against the palings on the other side of the front of the house.

Figure 490

Your house should now look like this.
63.9. The Ground Plane and a Path

![Figure 491](image)

63.9.1. Make the Ground

In Top view put the 3D cursor somewhere near the middle of the plot, (click LMB)
Create a plane
Be in camera view (bottom right-hand window)
Scale it to extend just past the boundaries of what the camera sees (10.0 seems a good number).
Go back into Object mode and change its (object, mesh) name to "Ground",
create a new material for it, rename it "Grass" and select a suitable green from the colour selector ("00cd00" green3).
Check in Front view that it is level with the bottom of the house and fence and move it (along the Z axis) if necessary.
63.9.2. Make the Path

For the path: Go into Top view, create a plane.

Scale it to fit the gap in the front fence with some space on either side and position it just outside the fence.

Check, in Front view, that it lines up with the door and is level with the bottom of the house.

Scale it along the X axis to the same width as the door.
Be in Top view, Select the two vertices closest to the fence, and extrude \[ E \] away from the house \[ Y \] to make a suitable width for the footpath outside the fence.
Of those four vertices just outside the fence, select the left two and extrude a suitable distance to the left, and then the right two and extrude a suitable distance to the right, to make the path passing the house.

63.9.3. Give the Path Some Thickness

The path is still just a flat plane. Let’s give it some thickness, so it rises slightly above the ground.

Go to Object mode. Make sure the path is still selected. Go to the Modifiers Context, click Add Modifiers, and look for Solidify. The default thickness (the top-left editable field) is 0.01; change this to -0.01 so the path protrudes above the ground rather than into it.

![Figure 495](image-url)
63.10. Improve the Lighting

If you were to try to render now, you will probably find that most of your beautiful house is lost in gloomy shadow. To fix this, let’s add a bit more light to the scene.

In the top view, find the existing default Lamp object. Duplicate it a couple of times, and position your copies around the house to give it a more even lighting.
63.11. Check the Camera View

Before doing the render, check your camera is properly positioned to capture the beauty of your work. In the camera view (top-right quadrant of the split view), you should see something like this; note the passepartout (darkened area) outside the rectangle denoting the visible area of the scene that will be rendered. If you RMB on the rectangle, you can reposition the camera from side to side or up and down with G, or do G Z Z to move it closer to or further away from the scene.

63.12. Final Render

Now hit F12, and hopefully you should see something like this!
64. Pipe joints

Information

Applicable Blender version: 2.46

How to model pipe joints.

64.1. T joint

Start in top view, and delete the cube.
Figure 499  Figure 1:  
Modeling a simple T joint.

- Add a cylinder object (*Add>* Mesh>* Cylinder*)
- 16 Vertices, No Caps, Depth 4 (For recent versions of Blender create the cylinder then press F6 to get these options)
- Switch to front view (*View>* Front or NUM1*).

The X axis now points to the right. We will work along the X axis from now on.

- Change to Edit mode (TAB).
- Create a Loop Cut in the middle of the cylinder (*Ctrl-R*).
Make sure that the 3D cursor is placed in the middle of the cylinder.

- **Switch to right view** (NUM3)
- **Box select** (BKEY) the 7 vertices at the front (Tip: tick the *Occlude background geometry* button)
- **Switch back to front view** (NUM1)
- **Pivot->3D Cursor** (.KEY)
- **Scale with the X axis** (S-X), about 1.4142 (square root of 2).

**Noob Note**: If your vertices are not symmetrical after you scale them, then you may have one of two problems. Make sure your cursor is in the middle of the cylinder (AKey to select all, ShiftS, Cursor to Selected). Also make sure that you have selected the proper 7 vertices. The center vertex should lie directly along the X axis, and there should be 3 vertices on either side of the X axis.

- **Rip the mesh with** V.
- **There will be 7 overlapping vertex pairs**: 7 vertices linked to the top half of the tube, and 7 vertices linked to the bottom half of the tube.
- **Either the upper vertices or the lower vertices should be selected**. Depending on which set of vertices is now selected you will need to rotate by -45 (upper) or +45 (lower).
- **Once you have rotated the first set**, deselect all (AKEY), then box select the other half of the opening
- **Rotate the selected vertices by +/- 45 degrees**. The pipe should now be straight again thanks to the rotations.

**Noob Note**: When you rotate the vertices, make sure that you are rotating them along the Y axis (RKey, YKey).

- **Box select the vertices of the gap and extrude ”edges” along the X axis.**

- **Pivot->Median Point** (CTRL+,KEY)
- **To flatten the front**: scale at the X axis by factor 0. (S-X, 0).

- **Use the Subsurf modifier in combination with Set Smooth, LoopCuts, and Crease** to get a nice transition.
64.2. 6 cylinder joint

Be in Object mode (have nothing else selected)
Add a cube.
Switch to Edit mode
Select all, then Subdivide the cube once (W, 1) (1).
Select the 12 vertices in the middle of the cube’s edges.
Scale by factor 1.4142 (press S key and type in the factor with the keypad) (2).
Select all vertices, and Extrude "Individual Faces" (This can be done either on the Tool Shelf under "Add" or you can type Space and search for Extrude Individual Faces and Move.) (3).
Select all vertices, and Remove Doubles.
Select the center vertex of each tube, and delete them to open the ends
Select the original vertices in the middle of the object and delete them (5).
Clean your mesh as described above.
64.3. 3 cylinder joint

This is very similar to above, only the selection for scaling is different.

- Select the middle vertices at the edges where the cylinders shall come from. Additionally select the middle vertices at the faces that shall be kept free. You have to select $12 + 3 = 15$ vertices.
- Scale your selection by 1.4142.
- Select the faces that shall be extruded.
- *Extrude-* > *Individual Faces* (5)
• Select all, then *Remove Doubles*.
• Delete the inner vertices (6, 7).
• Select 3 vertices (which were middle of faces that were kept free) and 1 corner vertex in middle of the free faces (8).
• Make sure your 3D cursor is at the origin (and that you added the cube at the origin) and switch to 3D Cursor Pivot (.KEY in v2.49b), then scale (SKEY), and type in 0.7071 (inverse of square root of 2, or Sin(45 degrees) or Cos(45 degrees)) and *ENTER* (9).
• Make sure you switch back to Median Point Pivot (SHIFT +,KEY) to straighten out pipe ends (10).

Clean your mesh as described above.

If your joint looks odd, it might be because of some edges in the mesh. Delete those by selecting it and delete (XKEY) edges (not vertices).
64.4. T joint with smaller diameter

\textbf{Figure 502  Figure 4a:} Basic structure for a T joint with a smaller diameter
We’re going to create a structure like in Fig. 4a and extrude the inner circle. To do that we place a circle with Retopo (Manual\textsuperscript{1}) on the cylinder and join both objects afterwards.

- Add -> Mesh -> Cylinder
- 8 vertices (of course you can use more vertices if you like)
- No Caps
- Depth 4

\footnotesize{http://wiki.blender.org/index.php/Doc:Manual/Modelling/Meshes/Remaking_the_Tolopogy}
Pipe joints

- **Noob note:** More vertices in your cylinder will mean more intuitive work and figuring [more loop cuts, face making, etc.] later on when retopo-ing. I suggest following the tutorial first, then try to do a more advanced model with more faces / vertices when you understand the tool. If you have trouble [as I did] getting really nice geometry, do a search for some tutorial videos\(^2\). There are many really helpful ones.

- **Add->Mesh->Circle (Noob note: To make sure you create these as separate objects, be in Object Mode (not Edit Mode).)**
  - 8 vertices
  - *No fill*
  - Rotate the circle by 90° at the Y axis (**R** -> **Y** -> **90**).
  - Move the circle in front of the cylinder (**G** -> **X** -> **2**).
  - Switch to side view (**Num-3**).
  - Scale the circle to the diameter of the smaller cylinder.

  (**Noob note:** I felt this was a little unclear. What the author means is, scale the circle down until it is the size of the diameter of the smaller cylinder you are going to create from it later by extrusion. You would be wise to scale it so it fits (straight backwards from view) inside the two closest faces of the cylinder as per **Fig. 4a** if you wish to follow the tutorial. )

- Switch to edit mode, select all vertices of the circle.

  (**Noob note:** To recap: you should be in edit mode for the circle, with the all of it selected, with the cylinder object directly behind it in from your viewpoint in orthographic mode.) Make sure that you don’t work in **Wireframe** view.

- Click on **Retopo->Retopo All** in the **Mesh** panel of the **Editing** buttons.

  (**Noob note:** What Retopo does [in this case]; is project the selected topography of an object in edit mode directly backwards from your selected viewpoint onto the topography of another [seperate] object. So you must be lined up view-wise for this to work. I’ve also found sometimes I must press the **Enter key** for the **Retopo All** to take effect even if I’ve selected it with the **LMB**.)

If the vertices of the circle are not adjacent to the cylinder but have jumped to wrong places undo the last step (**Ctrl-Z**), deselect and reselect all vertices and try again. This does help (strangely). **Retopo** works with limited accuracy, if the vertices don’t fit perfectly you have to move them by hand.

- Change to object mode, select additionally the cylinder and join both objects (**Ctrl-J**).

Now you work best in **Wireframe** view.

- Add three loop cuts (**Ctrl-R** -> **3**)
- Delete the middle vertex.
- Connect the free vertices (**F**).
- Select the circle.
- Extrude and clean up.

**Noob Note**: I couldn’t follow this last pipe tutorial with blender 2.6, so I made a video on how to do it once i worked it out. Thought i would put link to it in case anyone else needed help. (hope that’s OK )  
http://www.youtube.com/watch?v=uGm696IyLEU&feature=plcp&context=C4a1ad76VAvjVQa1PpcFOwQ4P0xHxgJbOz6UWZuC-sc9jJcxe85fo%3D
65. Lighting Suzanne: Introductory one lamp lighting
66. Lighting Suzanne: Introductory one lamp lighting

If you have followed all these tutorials you now have quite a library of images: A simple figure with a hat, a penguin, a volcano, a jeep and several goblets, not to mention dice, a head and a house! To show them off to best effect, you need to experiment with lighting.

Lighting is a complex subject, as any photographer can tell you. Blender allows many different arrangements and numbers of lamps to be used in combination to light your image. For this introductory tutorial, let us consider single lamp lighting and do some experiments to see how it works. (In later sections more complicated lighting is covered: Lighting Rigs1.)

66.1. Suzanne, Our Star

We need an object to light. Who better than Blender’s favorite resident simian, Suzanne! Open the default startup page. Delete the default cube. Be sure the 3D cursor is at the origin. Add a plane. Add>Mesh>Plane, scale it up nice and large, and in the Properties panel (which by default is the lower right panel) add a material.

---

1 Chapter 96 on page 853
color such as light blue that will render well. In that same panel be sure that under
SHADOW the Receive box is checked.

Now Add Suzanne, the famous monkey. Add>Mesh>Monkey. Move her up about 1.5
Blender units so she is above the plane but close to it. [Z] [KEY] [KEY] [KEY].
Rotate her around the Z axis so she is facing the Right View. [Z] [KEY] [KEY] [KEY]. Add
a material
color such as red (red is my favorite color).
66.2. The default light

Now let’s change to the Quad view, which you should refer to extensively throughout this tutorial. Press \(\text{CTRL} + \text{ALT} + Q\) to bring up this view. You now have the TOP, FRONT and RIGHT ORTHO views. In the top right you will see your camera view. Suzanne should be seen in 3/4 profile just above the plane. If not, rotate and scroll in or out until she is. Then I suggest you bring up the object panel \(N\), scroll down to View and put a check next to Lock Camera To View.

In the outline panel, select Lamp. You will see the default lamp position. In Ortho Quad view, we can see that the default lamp is up, in front of and slightly to the right of Suzanne as she now faces. If you don’t see it, scroll out in each view window until the lamp shows up as a point with a double dashed circle around it.
When your screen looks like the screenshot, render for the first time to get a good image of Suzanne and her shadow.

### 66.3. Types of lamps

Lamp should still be selected in the Outline panel. In the Properties panel, click the button to see the properties of the light. The default lamp is a POINT lamp with ENERGY 1.000. Let’s experiment with those settings. First, click in turn each of the different kinds of lamp, SUN, SPOT, HEMI and AREA, and render after each one. You can see that each of the light types has its own characteristics. With the light in the default position, your images should look like this:
66.3.1. Point lamp

This is the default type. The light rays are assumed to originate in a single point and spread from there. At the default value of ENERGY 1.000 is not very bright and covers a limited area. It casts a good sharp shadow. Point is the basic general purpose lighting in Blender. Advanced lighting rigs will frequently use several point lights with different settings.

66.3.2. Sun

The sun is assumed to be infinitely high in the sky so its rays are all parallel. It puts out a bright light and casts heavy shadows. It is the lighting type of choice for outdoor scenes but can also be used to good effect indoor.

66.3.3. Spot

The Spot lamp behaves very much like a theatrical spotlight (DUH). It casts a limited circle of light. Within the circle it is bright and casts a heavy shadow, but outside the circle all is dark. (Note: Under the Shadow setting, the Spot lamp is the only one that can cast a Buffer shadow. The distinction is subtle but important in some more advanced applications.)

66.3.4. Hemi

The Hemi lamp resembles lights photographers choose for indoor shots. It is the only kind of light that does not cast shadows. It gives a very bright lighting that is relatively even over the entire picture.

66.3.5. Area

This light behaves more like a flood light, as if the area is flooded with it. It is extremely bright and casts a very heavy shadow.

Figure 509  Comparison of light types.
66.4. Light Energy

Each type of light has its own brightness. This is controlled mostly by the ENERGY setting of the light. Obviously less energy reduces the amount of light, more energy increases it. Still in the Properties panel, try different settings for ENERGY and see how it affects the image.

Begin with energy increased to 2.000. Render each type of lamp. We can see that reacts differently to the energy settings. Area is almost too bright at Energy 2.000, while Point and Spot are just reaching nice bright levels. Sun is ... Sun. Remember that it is infinitely far away and its rays are parallel. Little changes with the Sun. Now reduce energy to 0.300 and render each type of lamp. Point and spot at these settings are way too dim, while Area becomes a very useable setting.

![Figure 510 Lighting varying energy settings](image)

66.5. Distance and Height

The distance of the lamp also affects brightness and its position affects several things, particularly including the shadows. In the quad view, grab the default lamp and raise it up quite high, say to Z=25. The light falls off with distance, so point becomes very dark. The spot area increases with distance so the circle in the spot example is now quite large. The Sun ... well, the sun was infinitely far away already, remember? The shadow cast by the sun does not change, and hemi still casts no shadow. But the shadow cast by the other three lights moves considerably and is now almost directly under Suzanne.

Lower the lamp to Z=3, placing it almost directly at a level with the subject. Both the distance and the angle of light change. The brightness increases, the size of the spot circle
shrinks, and now the shadow is long and far behind the subject, except, of course, for the Sun which remains infinitely far away and casts parallel rays.

Figure 511  Effects of height on lighting
66.6. Rotation

The last setting we will consider in this lesson is Rotation. The Point light cannot be rotated since it is equal in all directions. Each of the others reacts differently to being rotated.

The Sun finally shows a different effect when rotated. I am not sure how Blender interprets the difference between location and rotation for the Sun. It seems rather counter intuitive. The sun when rotated seems to me to behave as if it has been moved. But in any case you can see that the shadow and the lighting show a distinct difference.

The Spot behaves very much like a real spotlight. Its circle of light moves with the rotation and frames whatever it is pointed at.

The Hemi lamp also finally shows a bit of difference. Even pointing it entirely way from the subject still lets light leak through it and give that same shadowless flat lighting.
The Area lamp has its characteristic brightness over a large field, and then suddenly cuts off in to total blackness. The contrast is very striking.

66.7. Experiment!

You can experiment with other placements of the light, and see the effects on the illumination and the shadow. There is an almost infinite variety of ways to light a Blender image, and this is just with a single lamp. Multiple lamp setups increase the variety many fold as will be seen in the Advanced portion of this tutorial.

66.8. Note on Transparency

Figure 513  Where does that shadow come from?

Figure 514  Plane Shadows set to Receive Transparency
A special case of lighting is transparent objects. What sort of a shadow do transparent objects cast? You can try an experiment. Click on Suzanne to select her. Now in the Material panel scroll down to Transparency and put a check in the box. Just below that is the Alpha setting, which controls the amount of transparency, with 1.000 being fully opaque and 0.000 being completely transparent to the point of invisibility. Let’s try setting it to 0.200 for an almost glassy effect. Render your view, and then ask yourself, why does this glassy object still cast a thick black shadow in the render?

The answer is not in Suzanne, but in the settings for the plane which is her background. Recall that we checked Receive under shadows for that plane. But go back to the properties panel for the plane, and notice that there is another check box under Shadows that says Receive Transparent. By default, to save rendering time, Blender assumes that all objects block light equally. Only if that box is checked does it make a check for transparency in
the object casting the shadow. Now render your view and you will see that the shadow is suitably glassy.

Experiment with this one. Try different types of lamp (Area is so strong that transparent objects effectively disappear) and different values for the alpha setting. You might want to remove the color material from Suzanne and see what effect that has.

### 66.9. Note on World Lighting

It is not absolutely necessary to use any lamp source. In the World panel

![Figure 516](image)

you will find several lighting settings that simply produce light throughout the scene without any particular source. Experiment with Environment Lighting and Indirect Lighting and see the effects they produce.
67. Overview
68. Intro to Bézier Curves
69. Bevelling a Curve
70. NURBS Patches
71. Deforming Meshes using the Curve Modifier

71.1. Understanding the Curve Modifier

The curve modifier lets you use a curve shape to deform a mesh. The mesh will follow every twist and turn of the curve as far as it can bend, depending on how many vertices it has—clearly, the more vertices there are, the more faithfully it can follow the curve.

The curve modifier is also very easy to confuse yourself with if you’re not careful in how you set it up. A common situation is you try to move the deformed object in one direction, but it ends up moving in a completely different direction! This happens when you choose a deformation axis that doesn’t correspond to the predominant orientation of the points in the curve.

There are in fact some predictable rules that govern the behaviour of the curve modifier. Once you understand these rules, you shouldn’t need to keep trying different things at random to try to achieve the effect you want, you should be able to go straight for it.
71.1.1. A Simple Example

Let’s do an illustrative example to clarify things. Start a new Blender document; delete the default cube, and add a grid object instead, with the default 10×10 subdivision to give it plenty of vertices that can be deformed. Also add a path curve on top of it—this will give you a NURBS curve with 5 points, initially in a straight line. The result should look like at right.
Now right-click (RMB) on the grid, go to the Modifiers Context in the Properties window, and add a new Curve modifier. (In version 2.63, you need to select object in modifier settings, or the grid will not move, so select object as your new path that we just created.)

The grid object should immediately jump a little way in the direction of the negative X-axis. Why?

Noob note: In my version of Blender I had to select NurbsPath from the Object field to get this result.

Note:
Rule One: The offset of the first point on the curve in its local coordinate system is also used to offset the origin of the deformed shape.
Deforming Meshes using the Curve Modifier

If you select the curve and TAB into Edit mode, you should see that, while the origin of the curve’s local coordinate system (the fat orange dot) is in the middle of the curve, the first point (the one at the end of curve in the same direction that the “centipede legs” are pointing) has a negative X-coordinate. Select just that point, and from the Snap menu \( \text{SHIFT} + \text{S} \), do “Cursor to Selected”. Now TAB back into Object mode, and from Object→Transform do “Origin to 3D Cursor”. This will adjust the origin of the curve’s local coordinate system to that first point (keeping the curve itself in the same place), whereupon the grid object should jump back to its original location.

Note:
**Corollary to Rule One:** You will make things a lot simpler for yourself if you change the origin of the deforming curve to coincide with its start point.

You can of course freely move around, add and delete the other points. Just be sure to keep that first point always at the origin of the curve.
Now look at the settings for the Curve modifier. Notice those six buttons under “Deformation Axis:”? 

**Note:**

**Rule Two:** The Deformation Axis is interpreted according to the **local coordinate system of the deforming curve**.

When a path curve is created, all its points initially lie along its local X-axis. Since the default for the Deformation Axis is “X”, all works pretty much as you expect. If the two do not coincide, then weird things happen when you try moving things around.
Deforming Meshes using the Curve Modifier

If you really want to mess around, you could go into Edit mode on the curve, select all its points, rotate them to, say, orient them along the local Y-axis, then get out of Edit mode, select the deformed mesh, and change the Deformation Axis on its modifier to Y, and things should still work consistently. But why bother?

**Note:**

**Corollary to Rule Two:** For simplicity, ensure that the Deformation Axis corresponds to the primary orientation of the points of the deforming curve in its local coordinate system. Otherwise, the deformed mesh will be rotated from its undeformed orientation, and will go off at a completely different angle when you try to move it.

So long as you obey the above rules, you can move, rotate and scale the deforming curve in object mode only as much as you like, and the deformation will still behave in a reasonable fashion. Of course, you can do what you like to the deformed mesh in object or edit modes, and this will still be true.

**Note:**

**Rule Three:** The effect of the deformation corresponds to the relative positions of deforming curve and deformed mesh in world coordinates.

Select the curve, TAB into Edit mode, select the middle point, and move it a little to one side, as at right. You should see the grid mesh immediately bend in a corresponding way.

Now TAB into Object mode, select the mesh, and move G it around: notice how it tries to follow the shape of whatever part of the curve lies nearest to it. What shape does it take when you move it off an end of the curve? How about to one side?

---

*Figure 521*  Fiddling with the deforming path
Alternatively, you can similarly drag the curve instead of the mesh, and the same thing will happen: it is only their relative positions that govern the actual deformation.

Also try changing the scaling radius $\text{ALT} + S$ and tilt angle $\text{CTRL} + T$ on particular curve points: note how the former causes the deformed mesh to get wider and narrow at those points, while the latter makes it tilt from side to side.

### 71.2. Another Example

**Information**

Applicable Blender version: 2.4x

#### 71.2.1. Setting up your Mesh

While this example will be done with a cone primitive, you can use the default cube or another shape of your choosing as long as it can be loop subdivided along the axis you wish to curve. Delete the default cube if you’re not going to use it as your base mesh, and add your chosen primitive. In this example, we’ll be using a Cone.

![A basic cone in Edit Mode](image)

**Figure 522** A basic cone in Edit Mode

- Set your view to the X-Y Axis (Top View) by pressing $\text{NUM7}$, the 7 on the keypad.
- Press SPACE > Add > Mesh > Cone
- A smaller number of vertices are needed, since this cone will become just the tip of the finished shape.
- Left Click and drag to reduce the number of vertices to 12, then click the Ok button. (Note: On newer versions of Blender you will have to hit $\text{F6}$ to get to this option.)
• Press **TAB** to enter Edit Mode, or choose Edit Mode from the bottom of the 3D viewport.
• Switch views to the Z-X Axis by pressing **NUM1** (1 on the keypad). Your screen should now look something like the picture at left.

If your cone is selected (one or more faces are pink, one or more vertices are yellow) press **AKEY** (Select/Deselect All) until they are deselected.

Select the point of your Cone with the **RMB** and drag it upwards with the blue arrow. If you want to constrain the scaling to set, hold down the **CONTROL** key if you want to constrain the scaling to set.

5 squares of height were added to the cone.

---

Still in Edit Mode, press the **NUM8** repeatedly to rotate your view to the underside of your cone. Select the center vertex of the circle, and hold down **CONTROL** , then press the **+KEY** on the keypad. This will select all of the adjacent vertices of the base. (You could also select the whole cone **AKEY** and deselect the top point by holding down **SHIFT** and selecting it with the **RMB** to achieve the same effect.)

• Go to front view by pressing **NUM1**
• Extrude the base of the cone by pressing the **EKEY** and choosing Region .
• Pull the new vertices away from the cone a distance and click the **LMB** to set them in place.
• Press the **SKEY** and widen the new base of the cone a bit.
• Continue extruding the cone, widening the base after each extrusion until you have at least 5 segments. The more segments you have, the smoother your curved cone will be.
• Another way of adding segments is with the Loop Subdivide tool. **CONTROL + RKEY** to bring up the purple placement ring, then **LMB** twice to add a subdivision.
• On Blender 2.6, the best way to do it is by selecting the side edges and subdivide them by pressing **WKEY** then clicking on **Subdivide** , after that you can select the number of cuts you want.
• You may find that your cone is quite large indeed now, so switch back to Object Mode with the scale tool. While you’re in Object Mode, try stretching it a bit to make a nice long needle.

Figure 524

• In Object Mode, Z-X orientation (NUM1), make sure you have nothing selected and press **SPACE > Add > Curve > Bezier Curve**

• Rotate your curve 90° (holding down the **CONTROL** key to make it rotate in 5° intervals) Note- or just R-KEY and then type 90, so that it lines up with your cone. Move it off to one side so that its not hidden by your cone.

• Grab the center vertex of each end and adjust its rotation (**RKEY**) until you have a nice shallow dome shape.

• Scale the curve in size (**SKEY**) until it is larger than your cone.

• Look at the panel below the 3D space, you should see the Editing panel is selected
Just below the panel buttons will be a window called Link and Materials. If your curve is selected, you will see a box with OB:Curve in it. This means the name of the curve is "Curve". This is important because that exact name is needed to deform the cone.

Noob Note:

1. Information
   
   Applicable Blender version: 2.69
I could not find what this section talks about. However, the name of the curve is in at least two other places: Press **NKEY** and in the Item panel is the name of the curve. OR in the Outline panel (usually top right) you can see which item is highlighted and read the name.

**Figure 526** Modified cone

- Select the cone in Object Mode. In the Editing panel window (**F9KEY**), the rightmost panel has two tabs, Modifiers and Shapes. Choose the Modifiers tab if it is not already selected.
- Click the *Add Modifier* button and choose *Curve* from the popup list.
- In the OB: box, type the exact name of your Bézier Curve (it will be "Curve" without the quotations if you left it as the default.)
- Notice the six buttons underneath the OB: and VGroup: boxes (in the Modifier Panel). They are **X, Y, Z, -X, -Y, -Z**. They affect which plane the curve deforms. For this example, you’ll need to select the **Y** button.
- Move your Cone so that it overlays the curve in the 3D space screen, and notice how it follows the Bézier Curve.
- You can modify the Bézier Curve as well as the cone repeatedly until you are happy with the design.
- If you switch to Edit Mode, notice that the cone returns to its straight orientation.
- To apply the deformation to the mesh permanently, in the Modifiers panel, click the *Apply* button next to your Curve modifier.

**Noob Note:** In more recent versions (I am using 2.69) the Modifier panel is found in the Properties Window (usually the one on the right) with a little wrench icon in the row of icons.
Deforming Meshes using the Curve Modifier

Figure 527

Click this and choose *curve* and then enter the name of your curve in the *Object:* box. I then had to select the *X* button, not the *Y* button as it says above. I don’t know why.
72. The Empty Object

Information
Applicable Blender version: 2.68

Figure 528

Every object in a scene has common settings in the Object
Context. This includes the common transform settings shown at right: location in the scene, overall rotation and overall scaling. Most objects also have additional properties, such as the geometry of a mesh and the materials that govern how it appears in the render.

The **Empty object** has none of these additional properties. It has the overall transform settings, and not much else. And it has no appearance in the final render. So what is the point of having such a thing?

In fact, it has many uses, such as:

- In the Physics
Another Example

Figure 530

Context, it can be set as the source of a force field (e.g. wind).

- It can be used as the parent\(^1\) for multiple other objects. That way they can be moved together just by moving the Empty, rather than each child object individually.
- It can be used as a target object in an **array modifier**, where it adds its transformation to the copies of the object being modified by the array.
- It is a handy marker and place holder if you are moving things around. You can mark an object’s original position, and then put it back easily where the empty object is.

In these situations, the invisibility of the Empty in the render is an advantage, because it can be placed wherever necessary, without introducing unwanted clutter into the final image.

\(^{1}\) http://en.wikibooks.org/wiki/...%2FFParenting
72.1. Using an Empty With the Array Modifier

Open a new default Blender document, complete with default cube. Add a new Empty object to the scene. It doesn’t matter what type of Empty you choose; the options just control its appearance in the 3D view, not the actual behaviour of the Empty. Besides, you can change your mind about this later anyway.

Figure 531  The types of Empty objects
Now select the default cube, go to the Modifiers
Context and add an Array modifier. In the settings panel, there are three different ways the modifier can produce its copies of the original object: via a Constant Offset, Relative Offset, or Object Offset. The Constant and Relative offsets only allow a simple displacement for the copies, but the Object Offset looks at the full transformation of the specified object, which can include rotation and scaling.

Here I have unchecked the default Relative Offset, checked Object Offset, and from the popup menu for selecting the target object, I have selected my Empty (which by default would have been called “Empty”).

But if you look at your 3D view, nothing seems to have happened: the cube is still sitting, unmoved, in its original position. In fact, it might be hard to see the Empty, because it would have been inserted in the same position as the cube, so it ends up within it. If you switch to Wireframe view, you should be able to see the Empty sitting within the cube.
Before doing anything further, increase the Count field in the cube’s array modifier to 3. This will give you a clearer idea of the effect of subsequent manipulations. Doing so will not have any noticeable effect to start with, because all the copies will be lying right on top of each other.

Now select the Empty, and move it to one side: you will immediately see a second copy of the cube follow the empty, and the third copy move by the same amount in the same direction, so it ends up beyond that.

Return the Empty to its original location, and this time try moving the cube. As the original cube moves, you will see the second copy stay with the Empty at the centre of the scene, while the third copy moves beyond that, by the same distance and in the same direction as the second copy is removed from the original cube.

Now if you return the cube to the same location as the Empty, select both and try moving them together, you will see no additional copies of the cube appear, because they remain exactly on top of the original cube.

The rule for using an Object Offset with the Array modifier is this:

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The transformation applied to copies of the modified object is the difference between the transformations of the target object and the modified object.</td>
</tr>
</tbody>
</table>

In other words:

- the translation applied is the difference between their origins.
- the rotation applied is the difference between their object rotations.
- the scaling applied is the ratio between their object scaling factors.

Try moving the Empty to one side, as before; this time leave it there, so the three copies of the cube are nicely spread out. Now try applying a rotation to the Empty; see how this applies the corresponding rotation to the second copy (the one located where the Empty is), while the third copy gets twice that rotation.

Return the Empty to its unrotated state, and this time try rotating the cube: see how the second copy (where the Empty is) stays unmoved, while the third copy gets the opposite rotation.

Undo the rotations, and now try scaling: shrinking/enlarging the Empty correspondingly shrinks/enlarges the second copy, while the third copy gets transformed by the square of the shrink/enlarge ratio (the ratio multiplied by itself, or alternatively the ratio raised to the second power). Or shrink/enlarge the original cube, and see the second copy stay unchanged (as before), while the third copy enlarges/shrinks by the inverse ratio.

When you change the transformation of the original cube, the second copy always stays unchanged because the Object Offset transformation is the inverse of the transformation you are applying to the original; hence it always cancels out for the second copy, but you can see corresponding increasing powers of it applied to subsequent copies.
72.1.1. Editing the Modified Object

Make sure the Empty is positioned so the array instances are well separated. Select the cube, [TAB] into Edit mode, select all the vertices, and try transforming them: moving, rotating or scaling.

Note the difference in behaviour from doing this to the cube in Object mode: this time all the copies of the cube transform along in unison. This is because we are not affecting the object transformation, which is what controls the behaviour of the array modifier.

72.1.2. Arranging Object Copies in a Circle

Which brings us to a convenient trick for a common need: arranging copies of an object in a neat circle.

The easiest way to do this is start with the cube and the Empty in their original central positions. Suppose you want 8 copies of the cube in your circle; the angle between them then needs to be $360^\circ \div 8 = 45^\circ$. So rotate the Empty by $45^\circ$. Now select the cube. Set the Fixed Count field of its Array modifier to 8. [TAB] into Edit mode, and move all the vertices to one side. You should see the other 7 copies of the cube correspondingly move away from the centre in different directions, maintaining a nice neat circle arrangement. Your cube mesh is simply being rotated about its origin, which is not where the vertices are, but where the Empty is!
73. Background Images

Information

Applicable Blender version: 2.70

You will often need to use reference photos to guide your modeling. Among the many things you can do with photos and other images in Blender, it is possible to use them just as guides in the 3D view, such that they do not appear in the final render. Furthermore these images will only be visible when the view is orthographic and exactly aligned to one of the X, Y or Z axes (or the camera view). This way, they can be used as a precise reference for positioning elements of the model.

Figure 534

In the 3D view, make sure the Properties Shelf is visible. Look for the Background Images panel; it will most likely be collapsed, so expand it. Initially it will look like at right, with no background images in your view.
Check the box at the top. Click the “Add Image” button once, and this will add one entry to the list of background images, as at right. Initially there is no image opened in this entry; you will need to click the “Open” button and select an image file.
Once you have chosen an image file, the list entry expands with additional options.

Clicking on the eye icon lets you temporarily hide a reference image, without actually removing it from the document. Or you can uncheck the box at the top of the Background Images panel to temporarily hide all reference images; just check it to make them visible again. Click the X to delete an entry from the list of background images.

If you have multiple scenes in your document, the document’s background image settings apply to all of them.

Figure 536
If you don’t have an image handy to experiment with, how about downloading this simple 2D one from Wikimedia Commons. Flat images with no perspective work best for use as a precise modelling reference.

Having loaded your image, it might not immediately appear in the 3D view. For it to show, you must be in a perfect (axis-aligned) view (i.e. one of NUM1, NUM3, NUM7, CTRL + NUM1, CTRL + NUM3 or CTRL + NUM7) which is in orthographic, not perspective, mode (use NUM5 to toggle between these), or alternatively it will show in NUM0 the camera view.

You may not want the same reference image visible in all views. For example, you might have one reference image for top view, another for a side view, and so on. The Axis menu lets you choose which view this image is visible in.
73.1. Other Ways To Bring In Reference Images

Maybe you don’t want to use a reference image for precise, axis-aligned modelling, but only as a rough guide. There is a standard Blender addon called “Import Images As Planes\(^1\)”, which will create a plane object and apply an imported image to it as a texture. This can then be aligned whichever way you want in the scene.

\(^1\) [http://wiki.blender.org/index.php/Extensions:2.6/Py/Scripts/Add_Mesh/Planes_from_Images](http://wiki.blender.org/index.php/Extensions:2.6/Py/Scripts/Add_Mesh/Planes_from_Images)
74. Aligning Vertices with a Guide Image

Information
Applicable Blender version: 2.49

This tutorial is about using guide images to place vertices in their proper places in 3D space. The second tutorial is on how to take good reference pictures. This tutorial assumes that you have completed all previous tutorials.

This tutorial describes the use of the background image feature of Blender to assist in creating models of 3D objects. The background image provides a reference for the dimensions of the object, similar to the way the floor plan and elevation views of a house provide dimension information for the actual house. Guide images are not rendered, and may be removed after the model is completed, or they may be retained as part of the internal documentation of the model. Background images are not generally useful for other "image" purposes such as materials, textures, and actual background images in a scene, just as a floor plan is not actually visible after a house is constructed.
74.1. Background: orthographic projection

**Figure 539** orthographic projections in six directions

**orthographic projection** is a technique used by architects and engineers to describe a three-dimensional object by the use of several two-dimensional images, or “projections.” In architecture, the projection as seen from above is called the “plan view” or “floor plan,” the projection as seen from the front is called the “front elevation,” and the projection as seen from the right side is called the “right elevation.” Orthographic projections are intended to assist builders in creating an actual 3D object.

A Blender user also wants to create a 3D object, in this case a model. Blender provides a way to use a set of one or more orthographic projections as a guide for object creation. Because the images are conceptually “behind” the object from the appropriate point of view, Blender calls these 2D images *background images*.

Each background image is located “at infinity” in an orthographic view, and there may be one image in each direction: back, front, top, bottom, left, and right. We can use one or more background images to assist our modeling effort.

For example, to model a house, we can put the “floor plan” on the bottom, and build the house above it. We put the front elevation image on the back background, and build the house in front of it. We put the right elevation image on the left background, and build the house to the right of it. The background images can be diagrams such as floor plans, or

---

they can be photographs of an object taken from sufficiently far away to provide undistorted dimensional information.

Reasonably enough, an orthographic projection is only useful in Blender when in orthographic mode. Blender enforces this to prevent you from making mistakes: the orthographic image is only displayed in the background when you are in the orthographic view mode.

### 74.2. Making a Simple Pyramid

![Add Cone](image)

**Figure 540**

First we are going to create a pyramid the easy way. Then we are going to show how to use different viewpoints and images as a guide to place vertices correctly in 3D space.

Get rid of the default cube. Press `SPACE` and select Add→Mesh→Cone. Set the number of vertices to 4, and unselect Cap End. Click OK. There’s your pyramid.

**Note:** Do not render this looking up from the bottom, as it will appear invisible, as the interior faces of models are ignored by most rendering engines.
### Information

Applicable Blender version: 2.69

![Blender screenshot of ADD CONE function](image)

**Figure 541** Blender screenshot of ADD CONE function

In later versions (not sure when it changed) `SPACE` brings up a vastly longer menu. The way to ADD something is `SHIFT A` then choose MESH > CONE. Then press `T` to open the tool panel and in the bottom part you will find "Vertices", set to 4, and "Base Fill Type" set to NOTHING.

#### 74.2.1. Save the top vertex for later steps

Enter Edit mode (`TAB`). First, unselect all the vertices by pressing `A`. Next, select the bottom four vertices of the pyramid and delete them with `DEL` or `X`. The only vertex left will be the vertex which makes the tip of the pyramid. This will be used later.

#### 74.3. Using the guide images

Now that we have the pyramid the easy way, let’s learn how to use guide images as references to build models.
74.3.1. Window Layout

To make things easier, open a user preferences window\(^2\) from the main File menu and in the "View & Controls" sub-menu, turn on the "View Name" option. The window names will be used for reference inside the rest of this tutorial. **Noob comment** On my version (2.7.2) this all seems to have changed but the required setting is on by default anyway.

Split the Main 3D view window in to 4 windows (2 x 2).

**Reminder** : to split windows, move the mouse to the border of the view, when the cursor transforms into arrow, right-click and choose "Split Area". (Explained in the guide: Noob to Pro/Blender Windowing System\(^3\).)

Change the point of view in each window so that they end up like this:

<table>
<thead>
<tr>
<th>NUM1</th>
<th>NUM3</th>
<th>NUM7</th>
<th>NUM0</th>
</tr>
</thead>
</table>

And if you click on View, you can see that these windows are respectively:

| Front | Side (Right) | Top | Camera |

Note: You can toggle quad view automatically in versions 2.5+ when you press \text{CTRL} \text{ALT} Q , but views will be:

\(^2\) Chapter 14 on page 87
\(^3\) Chapter 13.10 on page 81
By knowing which view you are looking at you may find that you quickly get the idea of what you are doing and can proceed somewhat intuitively in this section on your own without following all of the step by step instructions.

### 74.3.2. Guide images

Now, we need some images. These come from a source outside of blender. For this tutorial, we need a floor plan of our pyramid, a front elevation view, and a side elevation view. The floor plan of our pyramid is a square, and the front elevation view is a triangle, as is the side elevation. We will cheat and use the same source image for both the front and side elevation. We can make a picture of a white square and of a white triangle in the GIMP, Paint :), or some other image editor. or we can find appropriate images somewhere.
Method 1 download and use

Figure 543  Save the triangle with a black background

Download the black and white triangle image on the right of the screen and use that. This image is, minus the checker pattern at the border, 198 x 198. (click it once to get the larger version, right click on the larger one, and save)
Method 2 roll your own

![Fig. 544](image.png)

**Figure 544** The square and triangle relationship

**Noob note** Make sure that the *drawing* of the square is *square* and not just rectangular. Make the triangle the same width and height as the square. Make sure the apex of the triangle is directly above the midpoint of its baseline.

**Specific instructions for Photoshop**

Make a square selection of "n by n" size, remember the value of "n". Fill it with white color and save. To create a triangle of needed properties make a rectangular selection of same (n by n) size, on a new layer, click RMB on your document, choose "Transform selection" option in the pop-up menu. Once you are in "Transform selection" mode, right-click the blank image again. This time the pop-up menu would be different. Choose "Perspective" from it, and with LMB drag one of the two top vertices toward the other. Once the vertices meet (in the top-center of the image), exit the transformation mode, and fill the resulting triangular selection with white.

Save the files to a place that is easy to access. Blender only supports the TGA, PNG, and JPG image formats.

**Specific instructions for Gimp**

Turn on the grid (View->Show Grid, View->Snap to Grid), use the rectangle select with a fixed aspect ratio of 1:1 (in the tool options panel) to select a square that you can flood fill. For the triangle, use the node tool to draw a triangular path, convert to selection (Select->From Path) and fill it. Or you could just use Inkscape...

Save the files to a place that is easy to access. Blender only supports the TGA, PNG, and JPG image formats.
For older versions of Blender... Load the white square (the floor plan) into the top (NUM7) window by going to the 3D view window and pressing View → Background image → (click on the icon of a file). Find your file and click "select image". Since you are placing the background while looking at the view from the top, the background is placed infinitely far away at the bottom of the model, which is where we want it.

For more recent versions... Load the images (as described in the previous module) like this: In the 3D view, make sure the Properties Shelf (N) is visible. Look for the Background Images panel; it will most likely be collapsed, so expand it. Initially it will have no background images to view. Check the box at the top. Click the “Add Image” button once, and this will add one entry to the list of background images. Then, with ‘Image’ selected, use the Open button to navigate to your image file.

Can’t see your images? Check you’re in orthographic view!

Load the white triangle (the front elevation view) into the front (NUM1) view window: this places it infinitely far "behind" the model. Similarly, load the right elevation (coincidentally, the same triangle image in this special case) from the right side view side (right or NUM3) window, to place it infinitely far to the left.

If necessary, zoom out so that you can see the whole background image in each view.

Now you have now placed your guide images for making your pyramid.

**Note:** for each view, if you can not see the picture, switch to Ortho view by hitting NUM5 You won’t see it in top view till you do this. Furthermore, the entire idea of using guide images is based on using the orthographic projection, because in the orthographic projection
projection, points on the same line normal to the viewing plane appear at the same point on the view.

74.3.4. Side One

![Image of a pyramid being aligned with a guide image](image.png)

**Figure 546**

The vertex that is left will be the topmost point of the pyramid. Use the GKEY to move the vertex around. To get it in the right spot, line it up at the top most point in the front (NUM1) and side (right or NUM3) windows. If you look in the top (NUM7) window the vertex should appear to be in the center. Make sure to keep the vertex highlighted for the next step.

**Note:** If you deleted all of your mesh objects in Object Mode (including the remaining vertex), then you'll be stuck in Object Mode. You can however, add a new mesh object as a base, or an empty mesh via a python script (*Add → Mesh → Empty Mesh*) [Blender 2.49]. Once an empty mesh object has been created, select it (right click on it or AKEY), and then change to the Edit Mode. However, this does not work with Empty elements in later versions (2.7.2) - which is likely related to ‘Empty Mesh’ no longer being an option. Use any (non-Empty) Mesh instead. Now you can begin to create individual vertices with CTRL + LMB.

**Note:** it might be helpful at some point to zoom in and use the X,Y and Z movement restriction)
Now, we are going to place more vertices in the scene. Since we want to have the new vertices connected to the first one, we will make sure the first vertex is selected and hold down **CTRL** and click **LMB** to create a new one.

In the side (right or NUM3) window, place a vertex on the lower left edge of the triangle by holding **CTRL** and clicking there. This should create a line between your 2 points. If needed, use **GKEY** to line it up in that window and also at the lower right point in the top (NUM7) window.

**Noob Note:** if you wind up in the middle of square (top view) then move your new vertex around with **GKEY** till it’s in the right place in the front, side, and top views.
Next, with only one of the vertices selected, in the front (NUM1) window place a vertex on the lower left edge of the triangle using the same method. Line it up in that window and at the lower left point in the top (NUM7) window.

Now, select your 3 vertices (use AKEY) in the front (NUM1) window and press the FKEY. You should see a triangle appear.

### 74.3.5. Side Two

Press AKEY to deselect all vertices and select the vertex at the top of the pyramid again. Repeat the process from Side One to make the next side. Place a vertex in each of the other corners of the square using CTRL and LMB. Line them up in two different views with the corners of the triangle and square. Make sure only the top vertex and the two new vertices are selected and press FKEY. This will fill in a face opposite of the first face in the pyramid.
74.3.6. Sides Three and Four

To fill in the other two sides, select the top vertex and the two corner vertices on a side where there is no face yet. Again, use FKEY to fill in a face. Repeat this for the last side to have all four sides created.
74.3.7. Bottom

![Figure 550](image)

In the top (NUM7) window, select all four corners and make a face. You should have a solid pyramid! Now, select all 4 faces, hit XKEY, and choose "faces".
75. Modeling a Fox from Guide Images

<table>
<thead>
<tr>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicable Blender version: 2.49</td>
</tr>
</tbody>
</table>

This tutorial assumes that you have completed all previous tutorials.

75.1. Method 1

75.1.1. Get the pictures of the model

**Tip**
The images here do not line up. Some need to be rotated and others do not match in size. They will be kept so that you can get the "real feel" for this project.

If you have a puppy and a digital camera, take three pictures of the cute little rascal and upload them. If you don’t have a puppy, any object or small animal will do. Ideally, the photos will be looking straight down at the top of the puppy, a side view, and a front view. It’s important that the puppy be in the same pose in all three photos! Or at least close to the same pose...we all know puppies don’t stand still very long.

You could use two mirrors. One is placed next to the puppy at 45 degrees to the camera and 45 degrees to the puppy. Another is placed above the puppy, also at 45 degrees to the camera and 45 degrees to the puppy. This produces three images, one of the puppy (front\NUM1), one of its reflection seen 90 degrees to the right (side \ right \ NUM3), and one of its reflection seen from overhead (top \ NUM7). Take the photo from a long distance away with a zoom lens to get close to an orthographic projection\.

Or how about pictures of a toy wolf taken from 6 view points?:

- Left view\2
- Right view\3
- Front view\4
- Back view\5

1 http://en.wikipedia.org/wiki/Orthographic
2 http://img51.imageshack.us/my.php?image=10011325wu.jpg
• Bottom view
• Top view

Using your favorite image editor, such as PhotoShop or the GIMP (see detailed GIMP instructions below: Detailed steps to align images using GIMP), down-scale the images need to a reasonable size (I made mine 512x384), and then match them to each other. To match them, draw construction lines (pulled from the rulers above and to the left) on the left view for example to pick out key features. I picked the tail, the front of the back foot, eye level, tip of the ear, and the front of the nose:

![Image of a fox with construction lines and rulers](http://img162.imageshack.us/my.php?image=10011363ql.jpg)

![Image of a fox with construction lines and rulers](http://img119.imageshack.us/my.php?image=10011375bc.jpg)

![Image of a fox with construction lines and rulers](http://en.wikibooks.org/wiki/GIMP)

I found when I picked out these features that this first image needed to be rotated slightly. That completed, I proceeded to scale, rotate and shift the other two views (top and front) until they matched fairly well as layers on top:

---

6 http://img162.imageshack.us/my.php?image=10011363ql.jpg
7 http://img119.imageshack.us/my.php?image=10011375bc.jpg
8 http://en.wikibooks.org/wiki/GIMP
9 Chapter 75.5 on page 662
Figure 552
Once I had the proper results I saved the resulting images, and these are the ones we will use in Blender.

The results are the files you’ll need for Step Two:
Figure 554
Figure 555
Just right-click and save them some place where you can find them to load them into Blender for Step Two. You may notice the photos aren’t perfect, but we’ll use them just to show how you should deal with your real photos. When you are creating your own pictures to import, note parallax\textsuperscript{10}. In this example, parallax is present, and we’ll attempt to compensate.

### 75.1.2. Get the Picture into Blender

Getting the image into blender is the easy part. The more difficult part will be creating the mesh, but first things first. Create a new file (File $\rightarrow$ New) to see the familiar default objects. Don’t bother deleting the cube, we’ll end up using it in the tutorial. Just as was done in the "Making A Pyramid"\textsuperscript{11} section, split the 3D Viewer into four views and assign them the following view ports. Note that the arrangement is different than that used in the previous tutorial.

\begin{tabular}{ll}
NUM7 & NUM3 \\
NUM1 & NUM0
\end{tabular}

\textsuperscript{10} http://en.wikipedia.org/wiki/Parallax
\textsuperscript{11} Chapter 74.3 on page 632

Figure 556
Each window will show you different XYZ coordinates with the NUM0 view being what your object will look like to the camera object.

<table>
<thead>
<tr>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicable Blender version: 2.69</td>
</tr>
</tbody>
</table>

Note: More recent versions do this automatically when you press `CTRL`, `ALT`, `Q`, but the default arrangement of the windows is different:

<table>
<thead>
<tr>
<th>NUM7</th>
<th>NUM0</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUM1</td>
<td>NUM3</td>
</tr>
</tbody>
</table>

Now that the screen is set up, let’s load the images. In the top left viewport (XY), click View on the viewport’s header (the menu at the bottom). From the menu provided, select Background Image ... . A small window will appear.

**Tip**
If you have a later version of Blender and the Background Image .... option is missing from the View menu, try going to View > Properties, or press `N`. A new toolbar will open to the right of the viewport and by scrolling through you should see Background Images . Use the "Add images" bar and options will open up. Then check the box to display your images. (Blender 2.58 user)

Click the Use Background Image button and several more buttons will appear. Now click on the folder icon located to the right of Image: . A new full-viewport window will appear. Explore this window a bit and end up selecting the image file of the wolf from the top view. What you should get is the picture of the toy wolf from above with the default cube on top of it. Rotate your view of the cube. The picture disappeared! But don’t worry - the picture is still there. Press NUM7 to realign the viewport and see the picture again.

**Tip**
Be sure to be in orthographic view Num 5 or else you won’t see the picture.

Now load the front view of the wolf into the NUM3 (right side) viewport (YZ) as you did the top view. Repeat the procedure and load the side view of the wolf into the NUM1 viewport (XZ). As a note, each picture is specific to the viewport it was loaded into. When you switch between axes views, the picture will not change. Try this out by changing the top left viewport to NUM3 (right side) and NUM1 . Return the viewport to NUM7 (top) before continuing.

**Noob note:** the photo from the top goes into top view, the photo from the front goes into the right view, and the photo from the right goes into front view, if you have front in front, change it now!
The pictures are now loaded into the Blender viewports. If you look at the pictures on the grid, you may notice that the front view of the wolf isn’t quite center. That is okay, Blender has a way to fix it.

Move your cursor over the **NUM1** (front) viewport and press **Shift + SpaceBar**, this expands the current viewport (NUM3/front view) to a fullscreen view, then open the Background Image window for the front view again. Notice that there are picture manipulation options available. One of these includes picture offsets. Click on right side of the 'X Offset: 0.00' to increase the offset to 0.20. The picture will be shifted over slightly so now the wolf is more centered. Press **Shift + SpaceBar** again to return to the four viewport view you created earlier.

**Noob Note:** If you made, and aligned your own photos, you will need to use a different value than '0.20' to center the head in the cube in front view.

The setup work is now done! Let’s start on actually making the wolf model.

![Figure 557](image)

### 75.1.3. Create a Rough Model

This is a brute force model creation using techniques discussed previously in this book. This section is meant to help you explore and become more comfortable with them. Do *not* try to follow the example to the tee. Your wolf and my wolf will probably not look the same since you may want to add more or have less detail.

**Noob Note:** If you are just getting started with blender, this step may likely take several hours to complete, since you must use your own creativity to position things in 3D space, using 2D views. Just like sculpting, drawing, or oil painting, it will be extremely frustrating at first, but once you get used to the way it works, “modeling” will be much easier.
The rough fit stage requires either some planning or on-the-spot decisions. Think about where the wolf will have parts of its body flex or require parts jutting out.

The first step is to create a blocky wolf. Start out with a column of blocks using the extrude face command (select face, EKEY). Don’t worry about snapping the vertices to the grid since we are working with an organic figure.

*user note: I used ZKEY (wireframe view), to see better how the rough model fits out*

**Figure 2.3.1** Body column formation

The next step is to split the ears and legs off of the body. Do this by subdividing the appropriate faces. Save often, and if you make a mistake, go ahead and use the undo option (CTRL ZKEY). Also, if you find yourself looking at redundant faces, combine them (FKEY).

**Figure 2.3.2** Appendage formation
If you are having trouble with this, try mousing over the perspective window (the one you designated with NUM0) and using the MMB to rotate the view so that you are looking at the underside of the wolf. Click on the face underneath the wolf that is alongside his front legs (use the side view to check this). We are going to subdivide this face in order to grow legs off the new faces. To subdivide, press the WKEY and choose subdivide. You will see that the face has been divided into four. Take one of these faces and extrude it as many times as is necessary to make the right leg. Then do the same again for his left leg.

**Noob Note:** To avoid making the extruded faces share common vertices (and be connected to each other), either extrude the legs separately (as stated above) or select *Individual faces* in the Extrude pop-up menu. The same works for the ears.

Doing the ears is similar, except instead of working underneath you will start with the face on top of the wolf which is directly over the ears. Select this face and subdivide it once. Deselect everything using AKEY, then select one of these four faces and extrude it upwards once to make an ear. Do the same for the face alongside it to make the other ear.

Finally, extrude the tail end of the wolf one more time, so that your wolf has as many divisions as the picture above.

### 75.1.4. Refine the rough model

Let’s start refining the model starting with the tail. Try putting your viewports in wireframe mode by pushing Z, it may make things much easier. Line up the vertices over the wolf in each viewport by lasso selecting multiple vertices (CTRL LMB, Drag). then move to the right location with grab (GKEY).
Continue onto the hind legs of the wolf. It is trickier to manipulate the legs so keep rotating a viewport to look at the model from multiple perspectives. Remember that we are working in three dimensions.
Continue working up along the wolf fitting the blocks to the pictures. If you have problems seeing the picture because the model is in the way, let’s hide the model. In Edit Mode, select the entire model by `AKEY` or by pressing `LKEY` when you have the cursor over the model. Simply pressing `HKEY` will hide the selected items. To unhide the view, use `ALT+HKEY`. By hiding and unloading the model, or parts of the model, you should be able to keep using the picture as a guide. *Note:* It is much easier to just switch layers by, let’s say, pressing `2KEY` (not the Num-Block one) to hide the entire model (thus getting a look at the picture) and `1KEY` to reveal the mesh again.

Once you have the first pass done, you’ll notice that the model just won’t fit all three pictures correctly. This is due to parallax. The most obvious example is the side view. The four feet should be level, as they are all standing on a flat surface. Since they are not, we’ll just ignore some of the aspects of each picture and continue with the model. (This is a helpful example to show what you need to consider when taking your own pictures.)

**Figure 2.3.5** Completed rough fit
75.1.5. Subsurf the model

Now that the rough fit is done, let’s smooth out the wolf. Add a Subsurf modifier and set the Levels to 2. The wolf will now be smoothed, but we want to add some of the hard lines back into the model. This may be accomplished with creased edges.

First, turn on the view creased edges by toggling the Draw Creases button in the Mesh Tools 1 window. Enter Select Edges or Select Faces mode (CTRL TAB). Highlight the edge or face you want to crease and press SHIFT + EKEY. Use the mouse and pull away from the center until the Crease value is close to what you want. A value of +1.000 will give you the sharpest look and is useful for places such as the bottoms of the paws. When an edge has been creased, the edge will be highlighted in yellow (positive crease) or black (negative crease). These highlights are shown due to the ’Draw Creases’ button being turned on.

In this example, I creased edges along the paws, tail, ears, and nose to give them some sharpness.

Figure 2.4.1 Creased edges
The last step is to refit the model to the pictures. You may have noticed that when the model was smoothed, the result didn’t quite fit to the pictures. Now is a great time to tweak the vertices to fit to the pictures or add to/modify the model.

*Noob note: if you see a weird edge on the body after smoothing, check the face normals (F9 > Mesh Tools More > Draw Normals; and then W > Flip Normals on the culprit faces).*

And here is my basic wolf based on three pictures!

**Figure 2.4.2** Final toy wolf model
75.2. But where’s the FOX?

Somehow the fox from the title of this page turned into that beautiful wolf. Now the wolf is a magnificent animal but I really like the fox. So here is a quickie rendering of a fox, using techniques of this tutorial and some of the material techniques from a previous tutorial. MercedMike\(^{12}\) (discuss\(^{13}\) • contribs\(^{14}\)) 15:00, 28 February 2014 (UTC)
75.3. Method 2 (using mirroring)

In this alternative method we will do half a wolf and then mirror it to create a complete wolf. You should start out by creating a silhouette of the wolf body in the side view, and then in front view start to shape the wolf head, tail and legs...

**Noob Note:** If you are attempting this method, it is best to avoid using triangles in rounded areas of a Mesh, because they tend to cause artifacts in your model (artifacts are protruding edges or other things that don’t look realistic). Using quads is a much better alternative. Triangles should only be used on flat areas of your mesh if they cannot be avoided.
75.4. Using mirroring with method 1

You can also use mirroring with the first method (the one with cube extrusions).
This can speed up your work as you don’t have to do the same changes on each side of the fox - just once.
To start the mirroring:

- Go to Editing (F9)
- In the Modifiers panel, add a Mirror
- Check only the Y button

When modeling:

- You may want to adjust the Merge Limit value (e.g., 0.14): this means vertices too close to each other (after the mirroring) will be merged, thus avoiding artifacts along the mirror’s axis.
- Remove the faces along the mirror’s axis, otherwise Subsurf will be confused by the faces inside the body of the mirrored fox. Keep all the faces for the legs though.
- To move the legs differently on each side: when you’re done modeling the rest of the fox, apply the Mirror modifier, and then work on each leg independently.

75.5. Detailed steps to align images using GIMP

From this point forward there are multiple ways to do exactly the same thing, however for simplicity’s sake and so that I can be more detailed I will be using one method (the one which I use) and be using GIMP.

I found it best to size all the photos to a known width, with an easy way to find center. (Mine happened to be 850x638 pixels, I don’t recommend that but you can choose any size you want really, as long as all of them are the same size). Then drag the construction lines to form a crosshair in the middle of the photo. To do this, click on the top ruler, and drag down to the middle (Exact middle) of the photo, then click on the side ruler and drag across to the middle (Again exact middle) of the photo.

If you are having trouble finding the exact middle of the photo, move the cursor to the very bottom left of your photo and the height of your photo will be listed at the bottom left of the GIMP interface. The numbers are listed in an (x,y) format so you want the first number to say 0 and the second to be the largest you can make it by dragging your cursor. The second number is the height, and half of that is the middle of your photo. You can do the same with the top ruler to find the vertical middle of your photo. Only this time the co-ordinates at the bottom left of the GIMP interface should list the second number (y) as 0, and the first number should be as large as you can make it by moving your cursor (to the upper right of the photo). Once you have your width again half of that will be the middle of your photo.

Then using construction lines put one at the top of your object, and the bottom of your object. Find the “height” of your object by the distance between them. Remove the construction lines from the top and the bottom, and place a new construction line above the horizontal center line by the half of the “height” (of your object). Now place a construction line on both sides of your object and find the “width” (distance between the new vertical lines), then remove those construction lines and place a new construction line vertically half of the “width” (of your object) to the right of the vertical center line. Now cut the object out, and drag it so that the point you used as the “top” is on the horizontal construction
line that is above the middle. Then Drag the photo left or right until the right edge of the object is on the vertical construction line you put in right of the middle construction line.

Now the center of your object is at the center of your photo. This is a very important thing because when blender loads in the picture you will need this so that all of your pictures match up with each other 3d. You should repeat these steps with all 3 photos. I also don’t recommend doing it in GIMP’s ”layered mode” as that caused more pandemonium for me. I recommend opening each photo in a new window.

Taking your pictures is the most important part, because if the pictures are not all in the same scale (object size to photo size) then your photos will not line up and you won’t be able to place a dot on the same location from front view, side view, and top view.

As a recommendation I would recommend making your first model from a Lego man. That is what I did and it is very simplistic easy practice. To take my photos I took about 10 minutes to construct a photo platform for my object. It consisted of a cardboard box with two sides cut out. I covered the inside area with computer paper. I then used a 2”x4” and a ruler to make sure that the box stayed the same distance from the camera for all shots, as well as marking where the Lego man’s feet were positioned inside the box with a pencil. This will provide good pictures, providing you keep the camera at the same distance and zoom for all three photos.
76. Using Bézier Curve to Model a 3D logo from a 2D logo

### Information

Applicable Blender version: 2.49

#### 76.1. Overview

We will be using this graphic as a template for a 3d logo, tracing it, then discarding the 2d image. *(Click thru to get the larger sized version, for you to follow along with)*

#### 76.2. Load the background image into blender

##### 76.2.1. Basics of the background image panel

If you haven’t already done so, open blender and select one of the orthogonal view angles by pressing **NUM7** (top), **NUM3** (side), or **NUM1**. (front). At the bottom of the 3D viewport on the left, there are some menus, click **View -> Background Image**
A small window will appear containing just one button marked use background image ; click this button. A few more buttons will appear. One of them says image: and has a small button with a picture of a folder on it; click this button. You are now presented with a file selection screen. Using the navigation techniques from the previous tutorials, find your 2D jpeg image on your computer, click the file in the list once then click the Select Image button at the top right of the screen.

Noob note: The image is only displayed in orthogonal view. If perspective view is enabled, toggle to orthogonal view by pressing NUM5. (The image will not be rendered as it is not part of your scene.)

Once a background is selected you’ll have a dialog like this one. (Note: This tutorial was originally generated from Blender v2.37. v2.43 has been added - older versions may differ.) The background dialog buttons are described below:

76.2.2. Details of the background image panel
is a toggle button that turns display of the image on or off. Turning the button off will not clear the settings; it just hides the image. When you turn the button on again, your previous settings are back. Try it - click the button a few times. In v2.43 the equivalent button is the

![Image](image.png)

**Figure 573**  Use Background Image Button v2.43

Image selection is controlled on the row labeled

![Image](image.png)

**Figure 574**  Blender _Image Select v2.37

There are 2 buttons, a text box, and a final button. The first button
Using Bézier Curve to Model a 3D logo from a 2D logo

**Figure 575** Browsing Image Select v2.37

is used for browsing for an image. The 2nd button
Load the background image into blender

**Figure 576**  Image Select History v2.27

is for selecting an image from a history list. (This will be empty for the first time. Selecting it now will display the image you currently have selected.) The text box

![Image Select Textbox](ages/rand_logo.jpg)

**Figure 577**  Image Select Textbox v2.37

allows typing in the file directly. The
Using Bézier Curve to Model a 3D logo from a 2D logo

Figure 578   Image Remove

button removes the current background image. Version 2.43 is the same with the addition of the
Load the background image into blender

Figure 579  Image Refresh

button that refreshes the image or movie, and the

Figure 580  Image Users Count

button which shows the number of users of the image block.
The third row is called Texture and will not be used for this tutorial.

The fourth line, labeled **blend** controls the transparency of the background image with a slider. A setting of 0 is completely solid and 1 is completely transparent. You can adjust it by clicking left or right of the knob for gradual changes, clicking and dragging on the slider for rough settings or clicking directly on the **blend** text for numeric entry.

The use of the **blend** function will become obvious once we start tracing our logo. For now, play around with it, see how it changes the image, and put it back to the 0.500 default.

The fifth line, **size**, controls the size of the image. This size setting is independent of the zoom for the 3D view window. To see how the size works move the default cube off to the side so that you can see both the cube, the background dialog and the background image. Now watch both the cube and image as you change the size. Notice how the image changes size but the cube doesn’t? Now press **NUM+** and **NUM-** to change the view’s zoom. Now both the cube and image change size.

The final row controls the X and Y offset for the image. These controls move the image up and down (Y) or left and right (X). These settings can be useful if you need to reposition the image from the default position. Like the size, these offset values are independent of the view. As you change the offset values the cube you added earlier won’t move. Now scroll the view using by clicking and dragging the **SHIFT MMB** and notice how the cube and image move together?

Once you start tracing the image you won’t be using the size or offset setting.

### 76.2.3. Details for version 2.6X

the check box left to the title indicate if you can see the image or not. the **Axis** menu indicate in what views you could see the image.

the button **Image** and **Movie Clip** indicate of course if you use a Image or a Movie.

the button to left of the text box allows to choose the image from the exist, the text box say the name of the image, the F button make the image a fake user, the folder sign allow to upload a image, and the X sign delete the link to the picture.

The **blend** slider mentioned above is now called **Opacity** . The image will be completely transparent when the opacity value is zero, and fully opaque when the value is one.

### 76.3. Delete the cube

Delete the cube (select it, press **XKEY** and select All from the **Erase** menu), and set the size so that the entire image is viewable. Then set both the X and Y offsets to 0.

Set the view to top view (**NUM7** ) for the rest of the tutorial!

Finally minimize the Background Image dialog. You’ll only need it to adjust the blend setting until you finish tracing.
76.4. Introducing the Bezier Curve

The Bézier Curve\(^1\) allows drawing graceful, complex curves and only requires a few points. Specifically, it only requires 4 points for a curve: two end points and two control points.

For the moment set the blend to 1 on the Background Image dialog. With the center of the 3D view still selected, press SPACE -> Add -> Curve -> Bézier Curve . Alternatively you can use the Add menu at the top of the screen or press SHIFT -> AKEY to jump directly to the add menu. Be sure to be in EDIT MODE not OBJECT MODE.

![Figure 581](image)

Unlikely the traditional Bézier Curve each Bézier vertex has 3 points. I’ve labeled the 3 points for the left vector: A, B and C.

Just like any other vertex you select the control points and the end points with RMB and move them with standard commands like GKEY , SKEY , EKEY or RKEY . if you wish to rotate, scale, or move the whole curve, then select all the vertices on the curve using one of the various selection methods, and then use the GKEY , SKEY , or RKEY

**Point A** is an end point. The curve will always go through this point. **Points B and C** are control points. These points influence the path of the curve as it leaves **Point A** . Because the path stops at **A**, **Point B** has no real effect on the path. Instead **B** is currently locked with **C** . (If you move either **B** or **C**, the other will move.) We will fix **Point B** to move independently a little later.

\(^1\) http://en.wikipedia.org/wiki/B%C3%A9zier%20curve
The control points have 2 effects on the path exiting the end point: direction and distance (these are termed slope and magnitude in math circles) from **Point A**. The direction will provide the direction that the path will follow when it leaves **A** and the distance will determine how long the path follows that direction before it starts making its way to the curve’s next point.

---

**Figure 582** N.B. To easily make sharp turns; take **B** point and move it really close to **A**.

**Figure 583** Take **C** point and move it in the exact direction you want to turn

**Figure 584** (with **C** selected) Press EKEY to extend the Bezier, and drag it out; you will find it goes where you pointed **C**! --Jawboot 01:30, 30 April 2006 (UTC)


-->
Introducing the Bezier Curve

The example to the right shows how the control points influence the path of the curve. In the top picture, we see three curves. The top curve is the default curve. In the next curve down, C has been moved to give a drastically different direction. Notice how the path leaving A moves away from the other end point. The third curve, the distance was changed dramatically. Watch the path move much higher than the other two curves.

In the bottom example, I’ve built a heart shape using just the points shown. Dragging the bottom end point down will make the shape closer to a leaf. You’ll be able to do the same at the end of this tutorial. Go ahead move around the points for the curve and see how they

Figure 585
all interact. Get a good feel working with the curve and when you’re ready we’ll move on to tracing.

Now that you know how to work with a bezier curve set blend back to 0.5 on the Background Image dialog so we can start tracing.

76.5. Modeling the lighting bolt

76.5.1. Rough Tracing

If you don’t already have a curve add one now. It will help to move the curve to the center of the yellow lightning bolt.

![Curve Tools for Blender 3D version 2.37](image)

**Figure 586** Curve Tools for Blender 3D version 2.37
The first step in tracing is to click the Polygon convert button on the curve tools panel. You’ll find this in button on the **Buttons Window**. You may need to select the **Edit Panel**. Press **F9** if this panel isn’t visible. In Blender 2.59, the 3D View panel’s Tool Shelf (T) houses the Curve Tools, including Set Spline Type, from which you should select Poly. You must be in Edit Mode to reach the Curve Tools.

**Noob Note:** The ‘Curve Tool’ panel will not appear if you don’t have a bezier curve already placed. I learned this the hard way.

Next, move the vertices of the curve to the points shown in the image to the left. This is called Rough Tracing because you don’t need to exactly trace the image.

You only need to approximate the image. Moving the vertices should be done using the instructions from the Creating a Simple Hat tutorial.

*Note: Selecting the best place to put a vertex is a bit of an art that you’ll acquire as you work with curves. For now follow the arrows along the cutouts and place each of the vertices as shown.*

This tracing uses all the vertices of the polygon. Other cases, you’ll need add or remove extra vertices by selecting the end point of your curve press **CTRL** and click **LMB**. At the place you clicked a new vertex will appear connected to your curve.
After moving the last vertex, we finish the rough tracing by pressing the Alt+CKEY to close the polygon. You should see an image similar to the one on the right. (If you only have an outline switch your view port shading to solid by pressing the ZKEY for now.)

**Question**: how do you close the polygon in blender 2.61? **Answer** _ ALT + CKEY pressing c key alone brings up circle select. 

*Note: In Blender 2.63 and certain prior versions, the curve needs to be changed from 3D to 2D shape in order for the polygon to show up, else you get an error. This can be changed by going into Object Data and, under the Shape heading, switching the curve from 3D to 2D.*

Notice how the polygon doesn’t cover all of the yellow of the bolt and how in some places the polygon fails to conform to the shape of the bolt. This is expected and should not be a cause for concern. We correct this in the next section.

Once you’ve finished several logos you should begin to get a feel for the required placement of vertices. Until then, here are some general guidelines to keep in mind:

- A gradual curve may only require a single vertex.
- Tight curves will likely require two closely placed vertices.
- Curves may not require a vertex at all - you can define some curves using the control points of the adjacent vertices. We did this for both of the inside curves of the bolt above.
- Corners require a single vertex placed where the curve bends. A square, for instance, requires four vertices - one at each corner - to be modeled properly.
- The end point of a curve will always be on the curve. So should all of the vertices you place.

We are now ready to move onto the next step modeling the logo.
76.5.2. Polishing the Tracing

Press ZKEY to return to wire frame mode, then Press the Bézier convert button to convert the polygon back to a curve.

This will convert your polygon back into a curve. Nothing obvious will happen. If you look close, you should notice the number of points on the curve tripled. When you converted the curve back to a Bézier curve, Blender changed all of the polygon vertices to Bézier vertices. While the polygon vertex is a single point the Bézier vertex is made of an end point and 2 control points. So the extra points are the control points of the Bézier vertices. These control points are placed along the curve to produce the same shape as the converted polygon.

![Figure 589](image)

Our job is to move the control and end points so that the curve follows the edge of the bolt. The trick is to move the 2 control points between adjacent end points to bend the curve to
Using Bézier Curve to Model a 3D logo from a 2D logo

the edge of bolt. First, move the right control point of the top-left vertex. This should pull the curve from its end point to more closely match the line of our bolt. After placing this point, we move to the next control point following a clockwise direction around the bolt. Use the RMB to select the point you want to change and move it with GKEY to place it.

**Noob Note:** if you wind up with pink lines when you select the control handles, that means you hit HKEY by accident, and have put the control point in manual. to correct this hit HKEY again to put it back into “easy” or auto mode.

As you move the second point notice how the curve exiting the first end point is drawn away from the edge of the bolt being traced. We now have to adjust the first control point again to get that line back on track. This quickly turns into a balancing act adjusting each set of control points. The trick is to make smaller movements for each iteration of adjustments. Make a game of it and move the control points all along the bolt. Always move along the clockwise direction. This practice is not just for consistency, it keeps your place and ensures that moving a control point doesn’t change a portion of the curve that you’ve already completed. In time you learn to move the first point only part of the way. Then moving the second brings the curve for the first into correct alignment.

If you have some trouble aligning the curve to the edge of the bolt, consider adding a new point. There are two (at least) ways to accomplish this:

- Select 2 points that surround the problem spot where you want a new vertex and click the Subdivide button on the Curve Tools 1 tool panel.
- If near an end point, Select it, press the CKEY to open the curve, then Control+LMB click to add a new point beyond the end of the selected final vertex. Press the CKEY to reclose the curve.

![Figure 590 Adding a new end point](image)

The new end point should be positioned and then you have to adjust the curve on both sides of the end point you move. Any time you move an end point be sure that the curve going into both adjacent (clockwise and counter-clockwise) end points still aligns with the edge of the bolt.
Figure 591  Finding trace defects

Once you’ve made the complete circuit around the bolt, you’re ready for the final polishing of the edge of the curve. Press the **TAB** to switch to the object mode. This makes the polishing easier as Blender hides the points and lines for editing the curve. Now zoom in on the bolt’s edge using the **NUM+** or **Control+LMB** drag. Use **Shift+MMB** drag the screen so that you closely observe the entire edge of the bolt while zoomed in closely. Look for places where the curve pulls away from the edge.

Also look for sharp bends at each of the end points that should be smooth. You can see several defects that I found in my project after tracing the bolt. Switch back into edit mode to fix the curve and then go back into object mode to look for more defects.
Using Bézier Curve to Model a 3D logo from a 2D logo

Figure 592  Correcting poorly shaped curve

Sharp end points are adjusted by decreasing the angle between end point and the control points. Many times that is impossible to do, without messing up what you’re trying to draw, so the other way is to add more curves by subdividing (WKEY -> subdivide) the existing curve between two end points, and playing with the control points to get a nice smooth curve,

Places where the curve pulls away from the edge can be resolved by moving the control point closer to the edge. In the above image the curve was found to have been pulled away from the edge. This was fixed by moving the control point a little to the left.
Here’s the final polished curve for my project. It is shown in both edit mode and object mode so you can clearly see both the control and end points on the left and the curve to the right.

Noob note: In blender 2.37 and later (not sure of earlier versions) pressing the HKEY toggles the control points between free and aligned (Edit Mode). Free Control Points are good for sharp angles, and aligned are good for smooth curves. This shortcut is in the Space -> Edit -> Control Points menu.

This concludes the tracing of the bolt. All that remains is making the curve 3 dimensional, applying a material and positioning the final object. Before doing that, we will trace the circle in the next part of the tutorial. Save this project if you want to take a break before continuing. You’ll need it on the next tutorial.
76.5.3. Adding a Third Dimension

First, give the object some depth. if you are in wireframe, hit ZKEY to go in to solid mode, then down on the editbuttons screen, locate the "Curve and Surface" panel, and set the following values:

- Back and front buttons are selected (depressed), otherwise it will be see through.
- Extrude: 0.2 (the height of the extrusion on either side)
- Bevel Depth: 0.02 (the radius of the round bevel applied to the extruded edge)
- BevResol: 4 (the number of subdivisions on the bevel curve)

**Noob note:** In previous versions, Extrude and Bevel Depth were Ext1 and Ext2.

**Noob note:** In versions 2.6x(possibly also 2.5x), go to Properties panel --> Object Data --> Geometry for these settings.

Now you can use your knowledge from earlier in this book to change the material and/or add texture to your logo. Feel free to rotate, add lighting, or whatever floats your boat. Don’t forget to press ZKEY to toggle wireframe mode.
You should now have something that looks like the photo on the left.

76.6. Modeling the red circle

It will be helpful to make the lightning bolt distinct from the circle part of the logo, by applying a yellow material to it before continuing.

Method one is the easiest, so try it that way first.
76.6.1. Method 1 - using bezier circle

Outer circle

![Bezier Circle](image.png)

**Figure 596** Bézier Circle

Switch to object mode by hitting **TAB** if you aren’t already there. **LMB** somewhere near the center of the background photo. Press **space -> Add -> Curve -> Bézier Circle** to add a closed bezier curve with four points forming a circle. If you are in solid draw type, switch to wireframe with **ZKEY** so you can see the underlying image better. Hit **SKEY** to scale the bezier circle to fit over the circle in the image. Again, if you are using one of the newer versions, you will have to switch the circle from **3D** to **2D** in the object panel.

**Noob note:** You should stay in object mode for now, as it’s easier to scale and move the bezier circle without having to keep track of which end points are selected.
You will probably find that the bezier circle is not dead center on the sample logo so you will need to move it with **GKEY** to center it. You may need to scale it and move it several times to get it right. You will also find that the circle in the sample image is actually a slight oval, so scale and position the bezier circle, along the X axis, and Y axis, so that it touches the circle in the image on the left and right sides.

Normally, you could then scale the circle and constrain it on the X and Y axis by using **SKEY**, but it turns out that the oval isn’t regular anyway, so just select the point on the top and hit GKEY and then **XKEY**, or **YKEY** to move it around until it touches the

---

**Figure 597**  Match up left and right sides

**Figure 598**  Move top and bottom points
top of the oval in the image. Then do the same for the bottom point and you should have a pretty good fit.

**Inner half circle 1**

![Figure 599 Circle in circle](image)

Just to understand what’s happening in the next steps, switch to solid view with **ZKEY**. As you can see, you now have a circle, but it’s filled in the middle where you want to be able to see through it. To cut a hole out of the circle, be sure that the circle is selected, then hit **Shift+S** → ”cursor to selection, to put the cursor in the middle, switch into edit mode, if you’re not already in it, and then **Space -> Add -> Bézier Circle**. A new circle will appear inside the larger circle. As you can see in solid mode, the new circle actually cuts its shape out of the larger circle surrounding it.

**Noob note:** make sure you are in Edit Mode or it will add the new Bézier circle without cutting it out of the existing one.
Switch to wireframe mode with **ZKEY** so that you can see the underlying image again. Scale up the smaller circle so that it approximately fits the inner part of the circle in the image. Don’t worry about getting it exact since you’ll be manually moving all four points anyway. Move the bottom point of the bezier circle to the top left corner of the bar that crosses the circle.
Move the right point of the circle to the other corner. When you create a Bézier Circle, Blender by default sets the alignment of all the control points to aligned. To make the diagonal bottom edge you need to break the alignment on the two lower sets of control points. Hitting the HKEY will toggle between free control points and aligned. Once you’ve selected the two lower bezier points and hit the HKEY to make them free you can move each of the inner control points to create a nice straight edge. Then move the other two points and adjust their control points until you have a pretty good approximation of the rest of the inside curve.

*In Blender 2.63 and others, pressing the H key seems to hide vertices instead. To set control points to free, select the vertice, then in the curve tools under Handles, select Free. (can also be set via the menu at Curve-control points-set handle type-Free)*
Inner half circle 2

Figure 602  Wider bevel has a nice look

Next step is to press space -> Add -> Bézier Circle again and repeat the same steps, but for the lower opening in the logo. Once you’ve completed both openings, switch back to solid view with ZKEY and examine your work. Make any adjustments you need to by switching the draw type back and forth as needed.

Make it 3d

Figure 603

The next step is to make this part three dimensional like you did with the lightning bolt. Go to object mode with TAB, then select the editing buttons.

Under curve and surface, set:
Extrude/Ext1 to 0.05,
Bevel Depth/Ext2 to 0.02
BevResol to 4.

Now that we have beveled it there will be a problem. Switch back to wireframe mode with **ZKEY** and you’ll see that the bevel has widened everything so that the circle no longer matches the original image. This can be fixed fairly easily by reducing the width parameter under curve and surface to about 0.98.

**Noob Note:** I don’t see an easy way to adjust the width parameter under curve and surface in Blender 2.70. I was, however, able to adjust using **WKEY**, Width, and then incrementing with the mouse.
For final steps, select the lightning bolt again and switch into sideview with **NUM3** and hit **GKEY** and then **ZKEY** to move both elements up or down until the bolt is inside the circle.

Apply a red material to the circle and bar portion. Finally, you can go to view, then to background image and hit the background image button to hide the image now that it is no longer needed. At this point, you can add any finishing touches for lighting and camera angles and render the logo.

After rendering you will have something like this:
76.6.2. Method 2 - using mesh circle and edges

Instead of using the Bézier Curve, you can use Circles.

There are two ways of doing this:

**Easy way**

Place two vertices (CTRL+LMB), one on the inner circle and one on the outer circle so that they form a line. This line has to be perpendicular to the circle you are tracing. Then place the cursor on the middle of the circle. Then just use the spin tool under the Mesh tools tab (360 degrees and 32 steps). This creates a circle made of 32 adjacent squares. Give it more steps to increase the quality of the circle.

**Detailed way**

Go to the top view (NUM7), and press SPACE -> Mesh -> Circle. Accept the 32 vertices, you can make it less but it won’t look as good.

Move it into the center of the circle, if you don’t then I advise you have wireframe on for the moment (press Z). Then press S, for scale, and make it the correct size for the inside of the circle. Once you have that in the correct place, like so:
You may need to stretch it sideways a little, then press 'E' to extrude (choose Only Edges), press 'S' to scale and another sized circle will appear, size this appropriately then click LMB.

Deselect the second circle, then select four vertices that are near each other and that form a square.

Now press F and a face will appear, i.e. the box will be filled (turn off Wireframe, press z). Now do this right around the circle. To do this, hold down Shift and Ctrl, then draw a circle around the two vertices you wish to deselect with the Left Mouse Button. Then draw a circle around the next two vertices while holding down Ctrl and LMB, NOT SHIFT. Shift changes the control from selecting, to deselecting.
Once you have gone all around the circle it’s time to make the line through the middle. To make the crossing line you need to move 4 of the vertices slightly; example below:

![Figure 610](image)

**Figure 610** Moving the four vertices

Once you do this, highlight the 4 you moved, then press F.

**Making the circle 3D**

Highlight the full circle by pressing A either once or twice. Go to Side View, and press E for extrude and drag it down so that it is the same thickness as the lightning bolt (you’ll see why).

Now look at what you have made... it looks nice enough but where the lightening bolt goes through the circle it looks a bit odd so we will make it look like the circle is laying on top of the bolt. Where the bolt goes through the circle, note the edges and the vertices. Move them so that the lines are just either side of where the bolt goes through. Then make new edges using CTRL+R on the outsides of these edges. Like so:
Now you have squares where the lightning bolt hits the circle. Change to Wireframe (z) if you are not already in it then highlight the 16 vertices of these boxes and raise them. Now do the same for where the center line crosses the bolt but create 4 lines instead of two. To explain why, I’ve created a diagram.

**Figure 611** Creating the overlap

Now we can make the finishing touches, add subsurf and set it to 2 or 3 and add color! Then you are done :-) I won’t go over subsurf and adding color because people have covered that better than I could in previous ‘Noob to Pro’ pages. I think that’s everything.

You should now be looking at something similar to:
76.6.3. Method 3 - using mesh circle and a cube

Tracing the **No symbol** is somewhat more complex than the lightning bolt. The reason is this symbol is hollow and requires additional planning to trace than just following an outline of an object.

I’ll be back to explain the difficulties in the near future, so stay tuned.

One way to do this is outlined below:

- The first thing to do is add a mesh circle. Hit **SPACE** and select ‘Add -> Mesh -> Circle’. (This circle is mostly for measuring purposes, and will ultimately be removed.)
- Scale (**SKEY**) and move (**GKEY**) the circle so that it’s sides are even with the sides of the logo circle, and the top and bottom are an even distance from the top and bottom of the logo circle. (The logo circle is not perfectly round.)
• Make sure you’re in object mode (TAB ), add a cube (SPACE , 'Add -> Mesh -> Cube') and place it (GKEY ) on the right edge of the circle so that it is centered on the right edge.
• Scale (SKEY ) the cube so that it is the same width as the wall of the circle and touching each side of the wall.
• Now, we want the 3Dcursor at the center of the logo circle. To do this, go back to object mode (TAB ), and select the circle that we added earlier (RMB ), then press SHIFT+SKEY and choose 'Cursor -> Selection'. (This is the main reason why we have this circle here.)
• Reselect the cube (RMB ) and TAB to edit mode.
• Choose NUM7 for the top view, and use RMB to select only the front face of the cube. (Before this you have to make sure that you are in 'Face select mode'.)
• Press **XKEY** and choose Erase Vertices. This will reduce the cube to a square.
• Press **NUM7** to go to the top view then select the Editing panel (**F9**).
• Press **AKEY** to select all, and then make sure that the rotate settings are set to degr:360, Steps:50, Turns: 1. (Actually, Steps can be whatever number suits your fancy. You may want to play with various values.) This is just like we did for creating the man’s hat.
• Click on ’Spin’ to extrude the square into a ring.

Next we will create the bar.

• Staying in Edit mode, hit **SPACE** and select ’Add -> Cube’. If you haven’t moved the cursor since the ring extrusion, it should appear in the middle of the ring.
• Expand (**SKEY**) the cube so that it just encompasses the inside circle of the ring.
• Scale (**SKEY**) the square in the Y axis (**YKEY**) so that it is approximately the thickness of the logo bar.

• Return to object mode (**TAB**), and rotate (**RKEY**) the ring together with the just designed bar so that it is parallel to the logo bar.

• In Edit Mode (**TAB**), squash the ring in the Y direction (**SKEY**, **YKEY**) so that it fits the logo ring.

![Figure 616](image)

• In edit mode, reselect just the bar. To do this, choose 'Face select mode', and do an area select of the face selectors near the center of the bar (use the **BKEY**, or **SHIFT+RMB** methods).

• Re-rotate (**RKEY**) the bar (in Edit Mode) so that it is parallel to, and in the middle of, the logo bar.
The next thing we need to do is scale the bar so that it is precisely the same width as the logo bar.

To do this, choose scale (**S**KEY ), and press **Y**KEY twice. This will go to local scale mode (local to the object). This is why we were rotating the entire ring, since the ring and bar are part of the same object.
• We no longer need the original circle now, (it should be sticking out from the top and bottom of the ring), so select it (RMB), and delete it (XKEY).

• If you hit NUM3 You’ll see that the bar and the ring are at completely different heights than the lightning bolt. Select and scale them so that they are all roughly the same height (the bar should be slightly higher than the bolt, and the bolt slightly higher than the ring so that all the proper parts are covered.).

• You can use the trick above to select (RMB) only the bar, scale it in the Z axis (SKEY, ZKEY) and then hit SPACE and choose ‘Select -> Inverse’ to select the ring (all but the bar).

• When done rescaling, press NUM7 to look at your handiwork.
There is one last bit, which is to slightly rotate the whole ring around the X axis so that it is below the top of the bolt and above the bottom.
Once that’s done, all that’s left to do, is color in the ring.

76.7. Extra Practice

An Alternate More Difficult Tutorial\(^3\)

\(^3\) http://forum.nystic.com/viewtopic.php?f=34&t=3025
77. Subsurface Scattering

Information
Applicable Blender version: 2.67

Real-life materials which may look opaque are often not perfectly opaque: light may penetrate a little way into the surface before bouncing off. This is noticeable as a subtle softening and colouring of the edges of shadows on the object. This effect is known as *subsurface scattering* (commonly abbreviated “SSS”).

1  http://en.wikipedia.org/wiki/Subsurface_scattering
Open a new default Blender document. Select the default cube. Go to the Material.
context in the Properties window. Look for the Subsurface Scattering panel. Check the box at the top to enable it for the cube’s material.
Subsurface Scattering

Figure 622  Subsurface scattering with default settings, before and after

Compare how the cube looks with and without SSS enabled: see how the edge of the shadow becomes a little bit fuzzy? This is simulating the effect when the light penetrates a little way into the material, emerging just within the edges of the shadow, making them that little bit lighter.

Note:
The edges (and general geometry) of the object themselves remain sharp. The fuzziness applies purely to the shadows.

Note the following settings in the SSS panel:

- The Scale controls how the overall size of the effect relates to the size of the object. If you size your object so that 1 BU is equivalent to 1 metre, then the default scale of 0.1 should produce a realistic effect.
- The colour swatch causes the scattered light to take on the specified colour.
- The RGB Radius values govern how far the red, green and blue components of the light penetrate into the material before being scattered. These are relative values, all subject to the overall Scale factor.
Figure 623  Higher red scattering radius

For example, this is what happens when the red radius is increased to 10, leaving the green and blue radii and the actual scattering colour unchanged: this causes the red light to travel further, tinting the interior of the shadow red and the adjacent area the opposite colour—blue-green. This is similar to what happens with human skin, as the light scatters through the blood vessels underneath.
Subsurface Scattering

Figure 624

Try the various options in the Presets menu: how convincing do they look? Of course, they may look better if you apply them to a model that is supposed to look like the actual material.
78. Ray Tracing

You previously learned\(^1\) about using diffuse and specular shaders to control the appearance of a material. These settings only affect how the material reflects *direct* light from lamps; but in the real world, objects are also illuminated by *indirect* light bouncing off other lit objects.

![Figure 625](image)

**Figure 625** A particularly outstanding ray-tracing example, from the Wikipedia article\(^a\)


In particular, there is the important case of light bouncing off mirrors and other glossy or polished surfaces before travelling to the camera, and also of light passing through transparent objects and being refracted (bent).

In the real world, such light can illuminate other objects, and it can also do so after bouncing off non-mirrorlike surfaces. The general problem of modelling such indirect lighting is called global illumination, commonly abbreviated “GI”. Unfortunately, the Blender Internal renderer, which is what we have been working with so far, cannot deal with GI in its full generality; to cope with that, we would have to use the Cycles renderer, which is introduced later\(^2\). So for now we will confine ourselves to mirrorlike reflections which do not illuminate other objects.
78.1. Setting The Scene

Let’s create a very basic model we can use to experiment with various ray-tracing effects. Open a new Blender document. Make sure the default cube is selected. Go to the Modifiers
context in the Properties window, and add an Array modifier to the cube.

The cube will immediately become two cubes, but so close together that they look like a single cuboid. This is because the default settings for the Array modifier are to use a Relative offset of \((X, Y, Z) = (1.0, 0.0, 0.0)\). Change these offsets to \((1.5, 1.5, 1.5)\), so the copies are more widely separated at a more interesting angle, and increase the repetition count to 5.
Now try rotating and repositioning the camera and the cubes to get them all in the view. If you hit $\text{F12}$ to render now, you should see something like at right. So far not very exciting. But since we are going to be dealing with reflections and refractions, it would be nice to have something in the surroundings to be reflected and refracted.
One easy thing to add is a world texture. Go to the Texture
context in the Properties window. Make sure the World texture
(the leftmost of the 3 buttons at the top of the topmost panel) is selected. Create a new texture, and change its type to “Magic”, which has a nice variety of different colours. Go to the Influence panel; by default the top-left checkbox (affect background progression) is checked; but this does nothing, because the default sky setting is not to have a progression at all. So uncheck that box, and check the second one on the left (affect horizon colour) instead.

Also under the “Size:” setting, set the X, Y and Z scaling all to 3.0; by shrinking the pattern, this will bring more detail into the view.
Now if you hit $[F12]$, you should get an image with a slightly more interesting background.
OK, we are ready to start playing with the material settings...

78.2. Ray-Traced Transparency

Figure 633  Left half of pool is filled with water material, right half is empty; floor is not broken, it just looks that way because the path of the light is bent.
In physics, *refraction* is what happens to light when it crosses the boundary from one material (e.g. air) into another (e.g. water); it slows down when it enters the denser material, and speeds back up when it leaves. The *refractive index* of a material is a measure of how much the speed changes relative to a vacuum (where light travels at full speed). As the speed changes, the light beam also changes direction, giving rise to well-known “bending” effects like you see when you put a teaspoon in a glass of water, or look down into a swimming pool (as at right).

![Figure 634](image)

Anyway, back to our tutorial model. Make sure the cubes are selected. Go to the Materials
Ray-Traced Transparency

Figure 635

context in the Properties window. Find the Transparency panel, and check the box at the top to enable transparency. In the row of buttons for selecting the type of transparency just below that checkbox, titled “Mask”, “Z Transparency” and “Raytrace”, select “Raytrace”.

In the editable fields immediately below those transparency-type buttons, the one at the top left is titled “Alpha;” you will have to reduce it below its default value of 1.0 in order to see any actual transparency effect. Try reducing it to 0.5.

Just a bit further down from the Alpha field, look for two more fields: “IOR:” (“Index Of Refraction”) and “Filter:”.

To simulate glass, set the IOR to 1.5 (other useful values are 1.33 for water, 2.4 for diamond etc\(^5\)). The Filter value controls how much of the diffuse colour of the material the light

Ray Tracing

takes on as it passes through; set it to something like 0.5, though you probably won’t notice much effect from this unless you specify a strong colour in the diffuse shader settings.

The “Depth:” setting controls how many times the light passes across material boundaries before the renderer gives up keeping track. Larger values give more realistic results, at the usual cost of increased render times. In more complex scenes where you have transparent objects in front of other transparent objects, this value will have a definite effect; here it probably doesn’t matter too much.

Now if you hit $F_{12}$, you should see something like at right. The cubes still look a bit grey; if you set the alpha to 0, they will look much more transparent.

Also try playing with the “Amount:” slider under “Gloss:”; the default value of 1.0 gives perfectly smooth refraction, while values less than 1.0 give a “frosted glass” effect, blurring the light as it passes through the material.

**78.3. The Fresnel Factor**

Real-life materials are never perfectly opaque or perfectly absorbent; even with something like a shiny metal which seems entirely opaque, light still manages to penetrate a little way into the surface, and even with the blackest of black soot, there is still some (tiny) amount of reflection going on.
The general behaviour is that a material is most transparent when its surface is viewed directly-on, and it is most reflective when it is viewed almost parallel to the surface (as usual, Wikipedia has all the gory details\textsuperscript{6} if you’re interested).

If you look back at that Transparency settings panel, you will see to the right of the Alpha field one labelled “Fresnel:”, and another one below that labelled “Blend:”, which comes to life when the Fresnel value is set to something greater than its default of 0.

The Fresnel (pronounced “fray-nel\textsuperscript{7}”) value is the power, which governs how sharply the transparency of the surface changes with viewing angle; 0 means the transparency stays unchanged at all angles, while higher values cause the transparency to fall off more rapidly towards the edges. The maximum value you can set for this field is 5.0.

78.4. Ray-Traced Mirroring

Just below the Transparency panel in the material settings, you will see the Mirror panel. Check the box at the top to enable it. Note the “Reflectivity:” editable field just below the checkbox; you will need to set this to something other than its default of 0.0 in order to actually observe any mirror effect.

\textsuperscript{6} http://en.wikipedia.org/wiki/Fresnel\%20equations
\textsuperscript{7} http://en.wikipedia.org/wiki/Augustin-Jean_Fresnel
Figure 638  Is that glass, or is that glass?

If you render now, you should see something like this.

See also the colour swatch specifying the colour of reflections: the default white means that reflections keep their colours unchanged, which is characteristic of reflections off glass, plastic or ceramics. Reflections off metal tend to take on the colour of the metal.

The Gloss setting governs how mirrorlike the reflections are: reducing this from its default of 1.0 adds blurring to the reflections, giving the effect of less-polished surfaces.

Note the Mirror panel has its own Fresnel settings. Go back to the Transparency panel, and set the Alpha to 0. That will disable the diffuse and specular shaders completely, giving us a pure ray-traced material, and also render the transparency Fresnel ineffective. Instead, we will control the Fresnel here in the Mirror panel. The behaviour for a nonzero Fresnel power is similar to before; however, instead of fading from transparent in surfaces viewed face-on to effects from the shaders when viewed edge-on, it will fade from transparent to mirrored.
Set the Fresnel value to something like 2.5. Compare the render to the previous one without Fresnel:

Finally, set the Reflectivity to 1.0, and the Fresnel to 0. Now if you render, you should get a completely opaque, mirror-reflective set of cubes.
78.5. Why Are My Shadows Black?

Consider the render at right: this is a default document with a plane added; the cube has ray-trace transparency turned on with an IOR of 1.5, Filter of 0.5, Depth of 5 and Alpha of 0, other settings left at their default. The plane has a material with all settings at their default.

Light should be able to pass through the cube and illuminate the part of the plane directly behind; so why is the shadow completely black?
The problem is, by default, the Blender Internal renderer doesn't bother to compute transparent shadows. Instead, it assumes that anything that blocks the light does so completely, presumably because it would slow things down too much to assume the opposite. To fix this, select the plane (not the cube), and in its Material...
settings, look for the Shadow panel. Note the two checkboxes at upper left: by default the “Receive” one is checked, the “Receive Transparent” one is not. Check the latter as well. Now any object surface with this material assigned will have proper non-transparent shadows computed as appropriate.
Now when you re-render, you should see a more accurate-looking transparent shadow.

Imagine if you had a scene with lots of non-transparent objects with different materials receiving shadows from lots of transparent objects: you have to check this “Receive Transparent” option on *every single one* of those materials that might be receiving transparent shadows! Yes, this can be a pain. Not to mention the issue of *caustics*\(^8\), which the BI renderer doesn’t handle at all. If you want to render realistic scenes like this, then you will need to learn about Cycles\(^9\)...
79. Using Textures


**Noob note** The link below to Leigh’s ’Texturing for Dummies’ is dead. She has a concise version of some general pointers here, something I would call How to texture, in a word\(^1\) but it’s roughly 1/15th the presumed length of the original. This passage should be updated or removed as perhaps it can only be purchased now.

There are some brilliant tutorials about texturing on the net, I personally like Texturing for Dummies\(^2\) (update: now another dead link!), by Leigh Van Der Byl. It is free (as in free beer, not as in free speech like this book), so you should download and read it now, to take the most advantage out of this tutorial.

We’re going to see how to apply the texturing concepts within the Blender texturing system. I will explain it using an image texture and procedural textures, but be aware of the fact that the texturing system is quite complex, and more advanced maps are created with the use of a few combined textures.

If you’re really into texturing you need to learn how to UV-Map\(^3\), there’s no way around it.

---

3. Chapter 91 on page 819
79.1. Colormap

This is the most basic mapping type. You can use an image or a procedural texture to change the color of a material.

Noob Note: No doubt what follows is easy when you know how, but this tutorial, and the next couple, throw noobs in deep. I can’t even find the things referred to in my version. There’s too much stress just trying to decipher old instructions to fit the new software to allow bandwidth for understanding what you’re doing. Some kind pro using the latest release could rewrite this stuff imagining he knows nothing.

Noob Note: In it’s day this page was at best only documentation. The categorical terms are the only thing still valid, and those perhaps less so. I liked this page. [http://blog.machinimatrix.org/the-basics-of-texturing-i](http://blog.machinimatrix.org/the-basics-of-texturing-i)
Using an image texture:

- Add an *Image* texture in the *Texture Buttons* and load the image (this is necessary also for UV mapped textures).
- The button *Col* in the *Map To* Panel uses the RGB information of the image to change the color of the material.
- The slide number button *Col* governs the blending amount of the texture, *Neg* inverts the colour values.
- If you use *No RGB* only the intensity information from the picture is used. The target color is then taken from the RGB sliders in the *Map To* Panel.

Using a procedural texture: The result depends on the type of value the texture provides.

- If the value is of type intensity (e.g. *Clouds*), the color is taken from the RGB sliders in the *Map To* Panel.
- If the value type is color (e.g. *Magic*), everything is handled as with image textures.
Note:

Color and intensity? What the heck?

An image texture (and other textures as well) may provide two different types of values:

1. RGB-Color information
2. Alpha information. Now we have to take a look at a few different scenarios.

- If an image has no alpha channel and you
  - don’t activate Use Alpha or Calc Alpha everything is easy - the texture provides only RGB-Color information. An intensity value is then calculated automatically if necessary.
  - activate Use Alpha the texture provides no intensity value and it is not calculated. If you now activate No RGB the intensity value is again calculated from the color information. So either you use Use Alpha and No RGB or neither of them.
  - activate Calc Alpha the texture provides automatically calculated intensity values. Now No RGB has no effect.

79.2. Diffusemap

![Figure 647 Image 2a: Diffusemap settings with a small range (0.2).](image)

A Diffusemap changes the amount of diffuse light the material reflects/absorbs. This is controlled by changing the reflectivity (Ref). A material with a rough surface may have the color white, but absorbs light to a greater amount than a material with a smooth surface. For more on diffuse reflection physics, see Diffuse reflection.\(^4\)

Noob note: Most of the settings described below will be found in the "Influence" section under the texture/material panel in blender 2.61

Let’s test:

- In the Texture buttons (F6 ), in the Map Image panel, make sure UseAlpha is unchecked.
- In the Material buttons (F5 ), in the Map To panel, uncheck Col and check Ref .

Noob note: In blender 2.6x "Ref" has been changed to "Intensity"

To understand the effect of this and all other mappings, we have to discuss the meaning of
the NumButton DVar (Destination Value).

• White in a texture (or an intensity value of 1) will be mapped to the value of the DVar
  Button. So if you set Dvar to 1, white will be mapped to 1, if you set DVar to 0, white
  will be mapped to 0. The result is multiplied with the value of the Var number button.

• Black on the other hand (or an intensity value of 0) does not change anything, so the
  settings from the material will stay unchanged. The difference between the material
  settings and the DVar button is the range for the texture.

Let’s take a look at an example.

Figure 648  Image 2b: The image used for the Colormap applied as a Diffusemap with a small range
(0.2).

If we use the default settings for the Diffusemap the range of the values is small.

• Ref is 0.8
• Dvar is 1.0

• White pixels in the texture change the Ref value to 1.0, black pixels in the texture don’t
  change the Ref value at all.

So the resulting range for Ref is 1.0 - 0.8 = 0.2.
When we change the Ref parameter in the Shaders panel to 0, we’ll get a much larger range of Ref values from 0.0 (black pixels in the texture) to 1.0 (white pixels in the texture).

There are other ways to achieve a larger range, you could also set Ref to “Inverted” (click it twice, it will be painted in yellow), DVar to 0 and Ref in the Shaders panel to 1.

**Note:**
*Why is this so complex?*
Well, with complexity comes flexibility. You can use an image (or procedural texture) for a few mappings at once, e.g. Color, Diffuse, Alpha, Spec and the like.

### 79.3. Luminositymap

Luminosity is the property of self-illumination, i.e. of objects emitting light. So we change the Emit value with this texture.

This light does not illuminate other objects - you would have to use Global Illumination (e.g. Yafaray) to use an emitting object as a true light source. Radiosity rendering does not work with Luminositymaps.

Everything that was said about the DVar value applies here exactly as for Diffusemaps.

### 79.4. Specularitymap

Specularity is the second most important material attribute. Specularity fakes the reflections of light sources. Of course you can modify the general specularity with a texture. In Blender you can change three different attributes related to specularity:
1. **Spec:** The degree of specularity. You can’t set values above 1.0 with Specularity maps, but you could invert the texture and set Spec on the Shaders panel to a higher value and **Dvar** to the lowest value of your range. So the texture actually lowers the specularity in all areas, that shall have a low specularity.

2. **Hard:** The hardness of the specular reflections. Sometimes called "Glossiness". A **DVar** of 1 is equivalent to a hardness of 130. Use the same method as described above to achieve a greater range for the hardness.

3. **Csp:** The specularity color.

You will probably use some kind of "Dirtmapping" (stenciling) to change the specularity in certain regions of an object, like an often touched object, that is shinier on the used or touched parts.

For more on specular reflection physics see Specular reflection\(^5\).

### 79.5. Reflectionmap

A Reflectionmap would be used to fake real raytracing reflections, either because you don’t want to use raytracing, or you don’t want to create a scene, or you need a special effect you don’t get with raytraced reflections. A Reflectionmap would be a Colormap, typically an Environment Map\(^6\). Since you can use prerendered Environment Maps, you can fake a surrounding for your object. Sometimes it is sufficient to use a simple Colormap that just bears the right colours, e.g. if you want to create a stormy sea it is not necessary that the clouds above are truly reflected in the water.

Environment Maps are a bit more complicated to create, see the respective section in the manual.

A very different kind of texture would be used to change the amount of raytracing reflections, the **RayMir** value. This is useful for something like a stained or dirty mirror. Simply click the **RayMir** button in the Map To panel and lower the **DVar**.

### 79.6. Transparencymap

Transparency- or Alphamaps change the (partial) visibility of an object. They don’t have to be transparent themselves (though it doesn’t hurt, see Make a material partially transparent\(^7\)). You will often use an image as Colormap and Transparencymap together. A nice example for a Transparencymap is in the paragraph Translucencymap.

There’s one catch though, you can’t change Fresnel transparency with a Transparencymap. So you have to use plain transparency, or fake the Fresnel effect with the method described in the section Map Input\(^8\).

---

7. Chapter 80 on page 745
79.7. Refractionmap

Well, there’s no such thing as a Refractionmap. You can’t change the IOR with a texture. You may try and use Environment Maps to fake refraction, but the result is often not worth the effort (for stills, in an animation it might not be that noticeable).

79.8. Translucencymap

Translucency is a material property of all semitransparent materials, like frosted glass, paper, plastic, cloth, skin, stained glass and the like. It allows objects to be lit from behind. Totally clear glass does not show where the光线s travel through it. But if the glass is dirty or uneven you will see the path of the light. In the first example (Translucency 1) the glass material has a transparency of about 0.5 and a translucency of 0.78. So the glass is brighter where the光线s hit the surface from behind. Additionally a Transparency map - which sets Alpha to 1 - lets the surface appear to be stained. If we use the same map also as a Translucency map (Translucency 2), the stain appears to be lit - which it would be of course also in reality.

![Translucency 1](image1.png)
![Translucency 2](image2.png)

**Figure 650** Translucency 1: Material with Translucency and a Transparency map, but without a Translucency map. This is an example from the release notes of Blender v2.32.

**Figure 651** Translucency 2: Material with Translucency and a Transparency map and a Translucency map.

**Figure 652** Material settings for example Translucency 2 (blue glass).

The settings for the material (Z-Transp, but raytracing shadows):
The texture itself is a *Hard Noise Clouds* texture, with modified *Brightness* and *Contrast*.

**Note:**

To get the shadow and those colors as in the example images set the light to use *Ray Shadow* and the plane to receive transparent shadows by enabling *TraShadow* in the shaders tab in the *Material* buttons.

### 79.9. Bumpmap/Normalmap

![Figure 654](image-url)  
*Figure 654*  
Settings for a Bumpmap in the *Map To* panel.
Bumpmaps\(^9\) are a technique to create the illusion of geometry. They could be used for something like a canvas or any small structures that are either difficult to model, or are too computationally expensive. As long as you don’t get too close with the camera you won’t notice the difference.

They come in several different flavors:

- A Bumpmap texture in the nearer sense is a greyscale image or procedural texture mapped to \textit{Nor}. Don’t activate the button \textit{Normal Map} in the \textit{Texture Buttons} for a Bumpmap.
- A Normalmap is an RGB image whose color information bears the information about the direction of the surface normal, also mapped to \textit{Nor}. For this you need to activate the button \textit{Normal Map} in the \textit{Texture Buttons}.

See also the manual about the differences between Bump and Normal Maps\(^{10}\).

In the example the bump map was used additionally to the colormap. The \textit{Nor} slider in the \textit{Map To} panel sets the depth of the bumping.

---

\(^9\) http://en.wikipedia.org/wiki/Bump\%20mapping


740
I will try to explain what a Dirtmap is and how you apply one. There are different things that people mean when they talk about dirtmapping.

- Sometimes a Diffusemap is meant.
- Dirtshading is often used as a term for Ambient Occlusion.

With a Dirtmap I simply mean any texture that breaks the clean, uniform, untouched look of image or procedural textures. You may do this by simply combining some partially transparent textures resp. textures that affect only parts of the picture in a semirandom way. You can also select parts of the object with a stencil\textsuperscript{12} texture. And of course you can (and will) combine both of these methods.

As long as two textures don’t affect the same property you can simply apply one after the other. To select only parts of your texture to apply another texture with the same properties use stenciling. Or use stenciling as a convenient method to separate two different sections on your texture.

\textsuperscript{12} http://www.cgcookie.com/articles/2008/12/21/blender-intro-to-stencil-maps
Using Textures

You need at least three textures for this.

1. The basic texture (e.g. color).
2. The selecting (stenciling) texture.
3. The Dirtmap affecting the same or other properties then the first texture.

The stenciling texture has to provide an intensity value, so if you want to use an image (or other RGB) texture you must activate *No RGB*.

![The stenciling texture.](image)

**Figure 659** The stenciling texture.

The image texture used as a dirtmap for our example contains some semirandom noise.
Settings for the stenciling texture.

*Nor* for the stenciling texture was not really necessary, but it adds a nice 3D effect. Since the stenciling texture is mostly white, I had to use *Neg* to use the black pixels as mask.

The third texture ("Dirt") affects *Col*, *Nor* and *Spec*.
79.12. Use UV Coordinates for your Maps

It is often necessary to create UV coordinates for more complicated textures/objects. UV coordinates only describe the geometry of the mapping, i.e. which pixels to map on what face. You can use the UV coordinates to create any mapping you want.

1. Create an UV map for your object. This is beyond the scope of this tutorial, see UV Map Basics\(^\text{13}\) and the section about UV Mapping in the manual.
2. Don’t turn TexFace in the Material Panel in the Material buttons on. Though TexFace is a very simple way to use UV textures, the normal texture mapping methods are much more flexible.
3. Load the image you used for UV-mapping (or any image with the same size) as an image texture. Change Map Input to UV.
4. Now you can use this image - or multiple different images - for your maps, including color-mapping.

The advantage of this technique is that you have much better control over your texture. Even if you just want to texture something like a cube shaped object, you’re often better off with UV mapped textures.

\(\text{13}\) Chapter 91 on page 819
80. Using a texture to make a material partially transparent

Information

Applicable Blender version: 2.49

To understand the collaboration of textures and material we will use the opacity of a material - the alpha value - as an example. We will show how to set the opacity/transparency of a material with different types of textures.

The Alpha value of the material is set with the A (lpha) slider in the Material panel. This is the basic Alpha value. If Alpha is 1, the material is fully opaque, if Alpha is 0, the material is fully transparent.

Now you change that basic Alpha value with a texture.

1. If the basic Alpha value is 1 you can only lower it with a texture, because 1 is the maximum value anyway.
2. If the basic Alpha value is 0 you can only increase it with a texture.

The target value of Alpha that can be achieved with the texture is set with the DVar button in the Map To panel. If Alpha is 0 and DVar is 0 than nothing will happen. You can set either:

1. Alpha to 1 and DVar to 0, then the texture will lower the Alpha value, or you can set
2. Alpha to 0 and DVar to 1, then the texture will increase the Alpha value.

Both methods are possible and equal in the result, but for clarity we will always use method number 1. There are more combinations possible, so it may be that you find tutorials with different settings.
80.1. Using a greyscale texture - white for opaque

In **Img. 1a** the black areas shall become transparent, the white areas shall become opaque.

- Load the image as *Image* texture, turn off *Use Alpha*.
- Set the *Alpha* value in the material buttons to 1. This is the default value anyway.
- Activate *ZTransp* (or *RayTransp* if you need refraction)
- The *Map To* panel:
  - Turn off *Col* (or else the texture would also affect the color of the material)
  - Turn on *Alpha* inverse, you have to click it twice. We need inverse here, because the texture shall affect the material from its black parts. *(Noob Note: On blender 2.63 you need to set a specific 'Alpha' value (the one located under 'influence->diffuse) to -1, as the alpha button referenced in this step no longer exists in 2.63.)*
  - Turn on *Spec* inverse (you don’t want your transparent sections to show specular highlights) *(Noob Note: As far as I could tell, the equivalent to doing this on blender 2.63 is to set a specific 'Intensity' value (located under Influence->Specular) to -1.)*
  - Set the *DVar* value to 0. The default value is 1.

**Figure 661  Image 1a:** Greyscale Image of leaf

**Figure 662  Image 1b:** Material settings for the texture

Now let’s take a look at the texture.
Using a greyscale texture - white for opaque

affect the Map To values fully
nothing.
ject the Map To values partially.

Figure 663  Image 1c: Result of applying
the Greyscale Image to a plane

The result is shown in Img. 1c, the texture applied to a plane rendered against a white
world background.

If your texture is inverted, i.e. black shall become opaque and white transparent, simply
use the normal Alpha and Spec setting in the Map To panel. (Noob Note If you don’t see
the white ‘shine’ on the maple leaf, move the default point lamp (lighting source) closer to
the plane mesh to which the texture and material are assigned. )

That’s it. It’s basically the same for all settings, the only problem that remains is sometimes
to know which value a texture will give if you use transparent textures or colored textures.
80.2. Using a partially transparent texture to make the material transparent

Often we have a partially transparent texture, and want to directly use that transparency of the texture to make the material transparent too. We have now to think a bit about the values that are generated by the texture itself: If we load the image texture with *Use Alpha*, the Alpha value of the image is used as input value for *Alpha* and *Spec* in the *Map To* panel. So a fully transparent pixel in the image has an Alpha value of 0, a fully opaque pixel has an Alpha value of 1. This is exactly the same situation as above, simply turning on *Use Alpha* and *Premul* (tiply Alpha in Advance) will give use the same result as with the greyscale image.
So:

- Turn on *Use Alpha* in the *Map Image* panel of the texture buttons.
- Turn on *Premul* in the *Image* panel. This is necessary to get real partial transparent borders.
- Turn on *Col* in the *Map To* panel additionally.

**Figure 665** Image 2b: Texture settings for a RGB/Alpha texture
The rendering result is pretty similar to **Img. 2a**, only that it is affected by lighting (and casts shadows).

Don’t forget to turn on *TraShadow* in the *Shaders* panel for the object that is receiving the shadow. (**Noob Note:** In Blender 2.6x you also need to check the "Receive Transparent" box in the shadow section of the material for the object receiving shadows or you will get a black square shadow.)

(**Noob Note:** In this case add a plane colored white just below the "leaf." This is the object the you should turn on *TraShadow* with as this is the object that will receive the shadow. This is also providing that you have a light source properly positioned.)
81. Creating Basic Seawater

Information
Applicable Blender version: 2.49

[ed. note: Need a much more basic introduction to what materials, textures, maps, and all the accompanying terms are with illustrative examples before diving into a specific sea-water example. Much more effective learning when you know what you’re changing.]
75% of the Earth’s surface is covered with water. In homage to this great fact, we will develop your materials skills first by creating basic seawater.

### 81.1. Create 3 linked planes

First we create a new file in Blender and delete the default cube by pressing XKEY and confirming the popup dialog. Now switch to top view with NUM7 and enter SPACE > Add > Mesh > Plane to create a plane. Then scale it up to 20 its original size with the SKEY the way you’ve already learned in one of the earlier tutorials. Go to the side

![Image: Blender interface settings for seawater material](image)
view with **NUM3** and duplicate this plane *two more times* using **Alt-D** (not Shift-D), moving the plane down on the Z axis by two grid spaces each duplicate. This will make the transparency of the water more realistic once we set it. Using Alt-D rather than Shift-D makes a linked duplicate, so that the changes we make to one plane effect the other two.

### 81.2. Create material

Now off to the actual texturing work. Select any one of the planes and press **F5** to bring up the Material Buttons in the Buttons Window. You will probably find two new small windows appearing here: one called Links and Pipelines and the other one Preview.

*(Noob note: A new section has been added for Blender 2.63 users after this section.)*

Click the 'Add New' button in the 'Links and Pipelines' tab to create a new material named ‘Material.001’ or so. To make life easier we’ll rename it to something meaningful like 'Seawater' by simply clicking it and typing in the letters, as shown here (SHIFT+DELETE in field to clear):

Now, on the same tab, give the seawater material a color of RGB (0.100, 0.310, 0.435). Find the tab that reads 'Mirror Transp' and click it. Click on 'Ray Mirror' and 'Ray Transp'. For the 'Ray Mirror' box, move the 'Ray Mir' slider to 0.3, the 'Fresnel' slider to 2.5 and the Depth to 5. For the 'Ray Transp' box, move the 'IOR' slider to 1.33, the 'Fresnel' slider to 2.0 and the Depth to 5. This will give the water realistic transparency and reflection. Also click the 'Shaders' tab, change 'CookTorr' to 'Blinn', move 'Spec' to 2.000, 'Hard' to 180 and 'Refr' to 10.000. This will make the water look more glossy.

Now we’ll add a procedural texture to our seawater, which will give it a “wavy” look. Click the Texture button (looks like bricks) or press **F6** to view the texture buttons subcontext. Click on the knob to the left of the texture name and select the ”Add New” button. This creates a new texture named ”Tex.001” or so. Click on the name and change it to ”Waves”.

Go to the Texture Type pull-down (**F6**) and select ‘Clouds’. On the Clouds tab change 'NoiseSize' to 0.050. Our Waves texture is ready; next, we will refine how it is applied to our Seawater material.

Noise Size increases the size of the noise, in this case, the clouds. Soft Noise blends the intensities and reduces the contrast. Makes a mellow effect, like soft waves. Hard noise creates a high contrast, and brings out individual 'shapes'.

If you want to add more detail to your water, add another texture and rename it to 'Large-Waves’. Make it a cloud texture like the previous one, but make it’s 'NoiseSize' 0.300 and use 'Hard noise'.
Left click on the Materials button (looks like a red sphere) to return to the material buttons subcontext. Look at the Texture panel, and you’ll see that the "Waves" texture has been automatically associated with the Seawater material.

Select the 'Map To' tab. Click the 'Nor' and 'Spec' buttons so they’re selected and have white text (the white text indicates a positive mapping). Click the 'Hard' button twice so it’s selected and has yellow text (the yellow text indicates a negative mapping). Click the 'Col' button so it is not selected, this button will show any color in the texture which we do not want. Find the 'Nor' Slider and move its value to about 5.00.

If you created the "LargeWaves" texture, select the "LargeWaves" texture under 'Texture and Input', go to the 'MapTo' tab, deselect 'Col', select 'Nor' and move the 'Nor' slider to 7.00. Do not select 'Hard' or 'Spec' this time.

For lighting press Space > Add > Lamp > Sun . You shouldn’t need to move the sun or change any of its settings. Finally move the camera to the edge of the plain and move it up towards the sky a bit.

Go to the Scene tab (F10 ), and look for the six buttons next to the big render button. Deselect all these, leaving only the 'Ray' button selected. This will tell Blender not to render some features in our scene that we really don’t need. Go and press F12 to render the water, it may take a while depending on your system.

Admire your water, and maybe drink a tall glass of something refreshing!
81.3. Create Material / Textures (Blender 2.63)

**Material**
- Go to the properties window (Bottom right window by default) and click on the Material tab
- Click of the + symbol to create a new material and name it Seawater
- Click on the diffuse color box and give it a seawater blue RGB (0.100, 0.310, 0.435)
- Enable the Mirror checkbox
- In the Mirror section, set Reflectivity: 0.3, Fresnel: 2.5 and Depth: 5
- Enable the Transparency checkbox
- In the Transparency section, click the Raytrace button
- Also in the Transparency section, set IOR: 1.33, Fresnel: 2 and Depth: 5
- In the Specular section, use the pull-down menu to change CookTorr to Blinn, then set Intensity: 1, Hardness: 180 and IOR: 10

**Textures**
- Still in the Properties window, click on the Textures tab
- Click on the “+ New” button to create a new texture and name it Waves
- Set the Type: Clouds using the pull-down menu
- In the Clouds section, set Size: 0.05 to create soft noise
- In the Influence section, uncheck Color under Diffuse, then under Specular, check the "Specular" box and "Hardness" box then set the value to Hardness: -1. Under Geometry, check the “Normal” box and set the value to Normal: 5
- Select the second line in the Textures list and create a second Texture using the “+ New” button. Name it LargeWaves
- Set the Type to clouds again, but this time, set Size: 0.3 in the Clouds section and click on the "Hard" button for hard noise
- Deselect “Color” and under Geometry, select the “Normal” box and set the value to Normal: 7

**Lighting**
- In object mode, select the default lamp (if present) and delete it
- Create a new lamp by pressing ALT+A and selecting Lamp --> Sun
- Place the Sun in the sky by moving it up the Z-axis. Press G, Z, 20 and hit ENTER
- Go back to the Properties window and click on the World tab
- Click on the box under Horizon Color and set the color to RGB (0.242, 0.617, 0.831) for sky blue
- Position the camera to be looking over the water with some sky visible and render your scene.
- How about using what we have learned in previous modules to add some dolphins swimming just below the surface?
81.4. Extra Practice

This tutorial might also help you make even more realistic water: Link\(^1\)

\(^1\) http://forum.nystic.com/viewtopic.php?f=34&t=1445
82. Mountains Out Of Molehills 2

This tutorial shows you how to use displacement mapping to make a simple environment.

1. Make a grid. (Add/Mesh/Grid) 32x32 will do just fine. Be sure to create a Grid instead of a Plane, or you’ll end up with just a flat plane! This is because a Plane only has four vertices to manipulate - one for each corner - while a Grid has many, many more. A 32x32 Grid, for example, would have over 1000 vertices. The more vertices there are to manipulate, the more effect displacement mapping will have on the finished product.

2. Set it smooth. (Editing/Link and Materials/Set Smooth)

3. Make a new material for it. (Shading/Material/Add New)

4. Make a new texture for the material. (Shading/Texture/Add New)

5. Go to Shading/Texture Buttons. You can see your newly created texture there now.

6. Change Texture Type to Clouds.

7. Change the name of the texture to be more descriptive. For example GroundDisp or something similar.

8. Go back to Shading/Material buttons. You can see our cloud texture applied now, but it’s not applied correctly yet. Let’s fix this next.

9. Go to Shading/Map To. This defines how the selected texture is mapped on our material. Uncheck Col, check Disp on, and set the Disp slider to a value like 0.200

10. Set camera and a few lights to the scene. (This is already done as part of the default scene in recent versions of Blender, such as 2.49)

11. Render.

Noob Note It looks like from version 2.70 there is no shading as a main tool but rather as a subtool for Material, so in version 2.70 to get the effect described in here you have to check third checkbox in Texture>Influence>Geometry and adjust the slider

Several individuals, when working through this tutorial, had trouble getting anything more than a flat plane. A few solutions were proposed (most are still visible on the Talk page), and while each worked in its own way, the vast majority of the time the problem stemmed from creating a Plane instead of a Grid. Be sure to follow each step very carefully to ensure you don’t miss anything or do a step incorrectly.
You can't weaken the environment easily by changing Nor value in the Shading/MapTo. This defines how strongly the displacement texture affects the material. You could also add subsurfing to the ground area to get smoother results. Also feel free to tweak the texture and try out different alternatives.

Once your mountain looks good, try adding some Mist.

1. Select the "Mist" button on the "Mist/Stars/Physics" tab among the World buttons.
2. Add a Cloud Texture to the World and make it blend from white to gray.

The end result is something like this:

Figure 671
The purpose of this tutorial, is to highlight the power of blenders built in shaders and procedural textures to create a carpet material to use in your scenes.

NOTE: For those of you needing help getting a similar scene to the one above, here are some axis positions, etc. to help out:

(Spot-Lamp)  
X = 1.62, Y = -0.86, Z = -6.74; rotation -X = -37.26, Y = -3.16, Z = 181.34;

(Area-Lamp-1) X = -4, Y = -3.27, Z = -4.12; rotation -X = 54.67, Y = -18.59, Z = 109.47;

(Area-Lamp-2) X = 2.07, Y = -2.08, Z = -4.85; rotation -X = -29.37, Y = -28.98, Z = 355;

(Area-Lamp-3) X = 0.31, Y = -2.89, Z = -4.29; rotation -X = -49.23, Y = -10.63, Z = 6.68;

(Monkey) X = 0.05, Y = 0, Z = 0.42; rotation -X = 58.61, Y = -16.07, Z = 23.245; 
DIM (dimensions) X = 2.734, Y = 1.969, Z = 1.703;

(Plane) X = 0, Y = 0, Z = 0; (no rotation); Dimensions: X & Y = 14.30, Z = 0.

Alternately, you could also download a pre-made file\(^1\) in case that you’re in a hurry.

**Newby Note:** With these settings, I get a big white-out.

**Noob Note:** Try adjusting each of the area lamps Dist(ance) value. This helped me.

**Noob Question:** How does the above coordinates help me at all? I haven’t found anything that tells me were in 3D space object actually is or the objects dimensions little alone control them. Nothing in the Tutorial up to now even gives a clue to this.

**Noob Answer:** Hit ’N’ to bring up the Transform Properties window and enter the values there.

\(^1\) [http://www.mediafire.com/file/wwkzd9be907681g/basic-scene.blend](http://www.mediafire.com/file/wwkzd9be907681g/basic-scene.blend)
83.3. Cloud Texture 1

Press ‘F6’ on the keyboard to bring up the texture panel. Click the bottommost of the long boxes to create a texture in the bottom channel. Create a new texture and rename it something like ‘Red Clouds 1’. From the ('Texture Type') pull down select clouds. In the 'Clouds' settings panel change ('NoiseSize') to [0.210] and ('NoiseDepth') to [4].

Now select the Colors tab which will bring up the ColorBand for the texture. Press the orange ('Add') button to add a cursor on the colourband. Next make sure the 'Cur : 0' is showing next to the add button and change the colours as follows - (R 0.770, G 0.168, 0.168). Now click on right side of the 'Cur : 0' so it shows 'Cur : 1'. Change 'Pos' to 0.6.
Set Alpha to 1 and change the colour to \((R \, 0.732 \, G \, 0.243 \, B \, 0.243)\).

![Texture 1 texture panel Screenshot](image)

**Figure 675** Texture 1 texture panel Screenshot

Now go back into the material settings and change the settings in the Map To tab as follows. Click ('Spec') twice so the text becomes yellow do the same for ('Hard'). Now select 'Subtract' for the texture blending mode. Change ('Col') to \([0.188]\).

![Texture 1 materials panel Screenshot](image)

**Figure 676** Texture 1 materials panel Screenshot

At this stage if you render you might find it hard to notice the difference, it is apparent only where there is low light levels on the plane, don’t worry about this at the moment. It means if you render with Ambiant Occlusion you get a nice carpet effect of slightly varying colour.

### 83.4. Cloud Texture 2

Go back to the texture panel and create another texture, call it 'Clouds' and put it in the channel above 'Red Clouds'. Change ('NoiseSize') to \([0.054]\) and ('NoiseDepth') to 4. Select 'Improved Perlin' from the Noise Basis pull down. Finally change ('Nabla') to
As you can see the material is starting to look a bit better, only 2 more textures to go.

### 83.5. The Final Cloud Texture

Switch to the texture panel once again and create a new Clouds texture in the next channel up. Change (‘NoiseSize’) to [0.010] and (‘NoiseDepth’) to [6]. Now click on the ‘Colors’ tab and change the colour of the left cursor (‘Cur : 0’) to (R 0.713 G 0.262 B 0.223) and Alpha to 0. Switch to Cursor 1 (‘Cur : 1’) and its colour settings (R 1.000 G 0.363 B 0.000) and
83.6. The Last Texture

Finally, go to the textures panel one last time. Create a new Stucci texture in the next channel up. Change ('NoiseSize') to [0.006] and ('Turbulence') to [10.94]. Click on the 'Colors' tab. The first cursor 'Cur : 0' should be black with alpha 0. 'Cur : 1' should be red (R 1.000 G 0.000 B 0.000) with alpha 1.

Figure 682  Render of the 3 textures so far
Now go to the material panel. Under the 'MapTo' tab, click on ('Nor'). Click on ('Spec') and ('Hard') twice. Change the Blending type to 'Subtract'. Change ('Col') to \([0.056]\) and ('Nor') to \([0.50]\). And that's it. When you render now, you should have a nice-looking carpet material. By tweaking with the colours, you can create any colour of carpet.

\[\text{Figure 685} \quad \text{Final Render of Carpet Material}\]
84. The Rusty Ball

Information

Applicable Blender version: 2.49

Making objects with image textures is not really hard for simple objects like balls, cubes, and tubes. I’ll show you how to do this:

Figure 686
• Make a new Scene in Blender and delete the default cube.

• Make an object you want to have the image on (I recommend a Mesh plane, sphere or tube).

(If you are making a Mesh Plane, change your view to above, by pressing Num7)

To make a rusty ball I suggest an icosphere with a size of 2 which will fit nicely in the camera view.

• Sequence to add the Ball is: Spacebar, Add, Mesh, Icosphere.

• Go to the materials (F5) and select "O Material" from the popupmenu by the "Add new" button. (the little arrows)

• Now go to the textures (F6) and choose "Texture Type" A drop down (or up) menu appears and you will get many options, the one we need is "Load image". Click it, then select "Load" and navigate to an image you want to use. (Note: JPGs, PNGs or TGAs are recommended for Blender. Bitmaps tend to get all screwy.)

(Noob Note: Do search for Rust Textures if you do not have one handy.)

• After this, you’ll have to specify how your image should be applied to your object. To do this, go to the materials again, where you’ll have to find the "Map input" tab (near the textures tab). If you have selected it, you’ll see four buttons: Flat, Cube, Tube and Sphere. Select the option which meets your object best. You can see a simple preview of the different options in the "Preview" window and try the different modes.

• Render your object. If you can’t see your picture well, you can try to rotate your object or select another option in the "Map input" tab.

You can also render videos onto objects using this method. Just select a movie in the "Load image" dialog and enable the option "Movie" at the textures buttons. NOTE: Blender ONLY works with Full Resolution video, not video which has been compressed using a codec. Most video software will allow you to export video as "full frames " or "no compression ". Experiment a bit!

84.1. UPDATE

<table>
<thead>
<tr>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicable Blender version: 2.69</td>
</tr>
</tbody>
</table>

Much has changed in recent versions. This is an excellent tutorial by the original author, but I will try to bring it up to date.
• Make a new scene in Blender and delete the default cube.
• Add a sphere. Apply a Subsurf modifier and Smooth as we have learned in previous tutorials.
• Find a file picture that you want to apply to your object. Check Flickr for something like “rust texture.” (If you are going to share it, be sure you check the license of the texture you download.)
• IMPORTANT: You need a seamless texture. If you are not sure, use a program such as GIMP. Use FILTERS > MAP > MAKE SEAMLESS. Usually this works well but if your texture turns into gorp, try another one.
• In the Properties Panel, which by default is the bottom right panel, select the Material icon
The Rusty Ball

Figure 688

- Select NEW or if you already have a material in use, select the + sign to add a new material. Give it a good name like rustyball.
- Click on the Texture Icon
Click NEW or if you already have a texture loaded, click on the + to add a new one. Give it a good name like RUST.

The default type is CLOUDS. Pull down the menu and change it to IMAGE OR MOVIE.

Go to the IMAGE section, choose OPEN. New options will become available.

Under Source: Click the folder icon and navigate to your image.

Scroll down. In the Image Mapping area are some options that you may need to try. If your image is small it may have to be repeated in the X or Y directions.

In the Mapping section (yes, one section is Image Mapping and the other is just Mapping) after Projection, choose the shape closest to your object. If you are using a sphere like the example, then choose ... you guessed it ... SPHERE.

The Preview often looks a bit odd and stripey, but render your project and it should look very nice.

This method works for all sorts of things. Try making a brick wall with a wooden gate using Flickr textures or go back to the Jeep tutorial and put a pattern on your jeep.
Figure 690  Textures used from Flicker under Creative Commons 2.0 license
Figure 691  Psychedelic Jeep, my own texture such as it may be
85. Creating Pixar-looking eyes

**Information**
Applicable Blender version: 2.49

Figure 692  The final result, with a blue iris.
Creating Pixar-looking eyes

Note: This tutorial uses the same modelling and texturing technique described in the well-known MAX tutorial by Adam Baroody (http://www.3dluvr.com/rogueldr/tutorials/eye/eyes.html). The sole purpose of my tutorial is to make this technique more popular among the Blender users by explaining how to achieve the same result with Blender.

The goal of this tutorial is to make a Pixar-looking eye. One of the main reasons that Pixar’s characters really convey life is in their eyes. They have depth, you can see how the eye not only shines but it "collects" light. You may think that you can’t achieve this effect without raytracing but you’re wrong. The secret of this depth is in the modelling of the eye. Let’s see how it works!

85.1. Parts of the Eye

In this picture you can see the "ingredients" of the eye model. The blue mesh at the left is the cornea. Its shape allows for a small spot of specular light to appear on it even if the light is in a far side position. The mesh next to it is the iris. Now notice how it’s a bit concave. That’s the tricky part - the shape of the iris allows for a wide soft specular light to appear at the opposite side of the lamp direction. This fakes refracted light from the cornea and makes the illusion of "collecting" light and creates depth. The next mesh is the eye pupil - a simple circle. The pupil size is the same size as the iris hole. You can position it close to the inner side of the iris. And finally - the eyeball. It’s a simple sphere with a hole in it.

I won’t go deep into modelling of each element - it uses Blender’s subdivision surfaces and it’s quite simple as you can see.

Figure 693
85.2. Materials

Now let’s look at the materials.

85.2.1. Sclera

To make the eye white, press NUM3 to go into side view and add a UVsphere with 8 segments and 8 rings. To create the hole at the front of the eyeball, delete the 8 triangular faces that make up one end of the eyeball. Ctrl+Tab+3 to go into face select mode, B for border mode and select the middle 8 triangles as shown below, press Delete or the X button and LMB on Faces.

![Image of UVsphere with selected faces](image)

Figure 694

The resulting hole will be ringed by 8 vertices (which you could subsequently extrude and use to help you model the sections below - just a suggestion for those who feel capable)
Creating Pixar-looking eyes

The eye white\(^1\) has white color and high values for Spec and Hard (depends on the lighting), as well as a moderately high Ref value (0.700 - 0.800). Optionally you can use a reflection map to make it look more wet but I usually don’t do this.

(Noob note: Using a Phong specular shader turned to work quite well.)

(User: Make sure shadow buttons are off or it will black out the iris. Spec and Hard are located in the Shaders tab.)

85.2.2. Iris

- Loop select the opening of the eye (ALT+RMB click edge of opening).
- Duplicate the loop (SHIFT+DKEY). Move the new loop away from the eye a bit perpendicular to the opening.
- With the loop still selected, extrude (EKEY). Without moving the extrusion, press ENTER.
- Resize by half (SKEY then .KEY then NUM5 then ENTER).
- Move the inner loop back toward the eye a bit to form the concave shape.
- Create a new material\(^2\) and create a new texture\(^3\) called iris. Then hit F6 or click the spotty square icon.

---

2 Chapter 34 on page 263
3 Chapter 40 on page 315
to open the texture panel, choose Image as the texture type and then press Load Image button and use the image below.

Figure 695

Figure 696 Setting the iris color.
Here is the eye texture taken from the picture above

![Eye Texture](https://vimeo.com/9295010)

**Figure 697** The iris

**Alternatively**, you can create an image like this procedurally, using the technique described here. 4

All that is required now is a bit of tweaking of the texture size using the Xsize and Ysize values in the Map Input tab, and scaling the pupil hole size in Edit mode. Also please remember to change in the map input settings from 'flat' to 'cube'. You can tweak the RGB values and brightness/contrast of the image to achieve the appearance you want. Use

4 [https://vimeo.com/9295010](https://vimeo.com/9295010)
a smaller value for Hard (about 50) otherwise you’ll have a too shiny look instead of soft specular that fakes refracted light. The Spec value depends on the energy and distance of the light that illuminates it. Generally you’ll need to take care that the refracted light on the iris should be no more than half as bright as the small specular spot on the cornea - otherwise you’ll achieve the bad effect of two specular spots. Oh, another important thing - join the four meshes before tweaking the texture coordinates. Otherwise you’ll have to do the job twice after you join them, because the texture space is changed. And activate shadeless button.

85.2.3. Pupil

The material for the pupil is a simple black color with the ”shadeless” button on.

85.2.4. Cornea

The cornea uses a transparent material (alpha = 0.1 ) with Spec = 0.6, Hard = 255 and SpecTra = 1 . ”Ztransp” should also be turned on (found under Links and Pipelines tab). The cornea is simply a piece that fits exactly in the middle of the hole in the eye white. Make sure that the 'Traceable' button, under Render Pipeline, in the Links and Pipelines tab, is switched off. Noob note: I found it helps to turn off Shadebuff since, as far as I know, you don’t generally want the cornea to cast a shadow.

Noob question: I don’t know where is the ”SpecTra” Value. I’m working on 2.46. Thanks a lot. You can find ”SpecTra” under ”Mirror Transp”

Noob Question: My cornea isn’t transparent. I don’t know where Traceable is since I’m using 2.6x

Noob answer: This applies to 2.6. Something that doesn’t seem to be mentioned in this tutorial (sorry if it is and I missed it) is the cornea’s shadow settings. If it casts a shadow, it will block out everything inside the eye. So under the the cornea’s Material->Shadow settings uncheck the cast box.

Another option is to leave the cast box in your cornea on, and change to shadow setting in your iris. Check the Receive Transparent, and that works just as well.

85.3. Lighting

The lighting is simple - move the eye to a new layer, create a new lamp and make the lamp affect only this layer. Position the lamp at a good angle so you have a small shiny spot of specular light on one side of the iris and a soft spot of ”refracted” light on the other side. You can use a backlight to prevent the eyeball from being too dark at the non-illuminated part.

To move the newly created lamp to a new layer, press SHIFT+M and select the second blue button and press OK. P

Noob Question: Why do you need to create a new layer?
Noob Answer: It’s just meant to prevent cluttering in your main workspace. It’s completely optional.

That’s it! Now you’re (almost) ready to start with character animation. You have a nice eye, now you only need a character for it!

85.4. Changing the Eye Color

You can change the color of the eye by either changing the cornea color, or by changing the iris color itself. Changing the cornea color might be like putting on colored contacts.

85.4.1. Changing the Cornea Color

To change the cornea color, do the following:

1. In the mesh which is used to create Cornea set the value of the alpha slider to 0.2 (or more if you desire)
2. Change the color of the mesh to whatever color you like
3. Turn off traceble

4. Render!

(and remember to smooth out everything by selecting the particular mesh going to edit buttons and clicking on set smooth)
Changing the Eye Color

Figure 699

Figure 700
85.4.2. Changing the Iris Color

To change the iris color you can either edit the iris image external from blender or you can modify the RGB values of the image when imported into Blender.

Figure 702  Setting the iris color.
85.5. Pixar Eye Video Tutorial

- Ira Krakow’s Blender 2.49 Pixar Eye Tutorial\(^5\)

85.6. Useful Links

For rigging an eyeball, (making it stay in one place while turning to look at something) and other eyeball stuff, you can visit this site. This tutorial assumes you already have the eyeball made above or one of your own. Click.\(^6\) 5 jun 2009, the PDF shows no rigging, only creating an eyeball. (May 10th 2011, the site no longer exists.)

\(^5\) [http://www.youtube.com/watch?v=52KEN7NjkP0](http://www.youtube.com/watch?v=52KEN7NjkP0)
\(^6\) [http://rjnlk94.googlepages.com/eyeballtutorial](http://rjnlk94.googlepages.com/eyeballtutorial)
86. Procedural Eyeball

Information
Applicable Blender version: 2.43

Level: intermediate

Building a better (procedural) eyeball!
Originally created by Jon McKay (Ammusionist) and posted on blenderartists.org/forum
http://blenderartists.org/forum/showthread.php?t=85722&highlight=eyeball
The end result of this tutorial is an eyeball that fulfills the following requirements:

1. Single mesh
   • I wanted to be able to append a single object into any project.
2. Procedural Textures
   • I didn’t want to have to rely on image maps that could get lost.
3. Versatile
   • One single model to be used for any type of character, be it human, alien or whatever.
4. Easy
   • Any effects needed to be quickly accessible. I don’t want to be wasting time faffing around with colour-band settings at the texture level
5. Impressive
   • This sucker needs to look good any way it goes.
6. One other thing I really wanted was the iris musculature to follow the pupil dilation!

[Total Noob] I found this tutorial both informative and useful. It’s best to download the PDF version with the screen shots if you want to get as much info out of it as I did, and in fact, understand all that’s going on in the Tute

New Link (08th Nov ’11): Here is the full tutorial as a pdf file. 9 pages of screenshots and extremely detailed instructions. (1.2mb)

(Noob note: In my blender 2.49, I had to unclick the ’Traceable’ setting on the cornea of my eye when following the PDF tutorial, else I ended up with a giant black ’olive’, this does not appear to affect ray mirroring, and corrects my problem.)

86.1. Creating the Mesh

[noobnote1] Maybe worth to look at this link instead... http://web.pdx.edu/~wlf/tut.html

Note: You might want to check out this video first: http://www.youtube.com/watch?v=KKmHUZroaBA

The objective here is to make a great looking eyeball. That means it may not be anatomically perfect, but there are some things we need to take into account: The eye should consist of a white (white bit with veins); an iris (coloured bit); a pupil (black but in the centre of the iris) and a cornea (clear bit surrounding the whole eye). These may not be absolutely correct, but these are how I’m referring to the pieces of the eye.

- Start with a ball: Go to a front view (Keypad-1) and create a UV sphere. 24 Rings and segments should be sufficient. It’ll give us plenty of smoothness and enough verts to work with when we create shapes.

  NOOB NOTE: If you want the eye to point toward you, you may have to rotate it 90 degrees. Go to side view [num3], click Rkey and rotate while pressing the control key. Return to front view.

  (Noob Note #2: If you, like most people, want the eyeball’s iris and pupil to point towards the front, but don’t want to change views, press the RKEY, then XKEY to restrict rotation to the X-AXIS, then, while holding CTRLKEY, rotate the sphere by 90°.)

- This sphere will become the coloured parts of the eye, but we also need a second sphere for the cornea. Use the Zkey to switch to a wireframe view (ifyou’re not already there). Hit the A key a couple of times to ensure all points are selected then Shift-D to duplicate the sphere.

  (Mast3rlinkx’s addition: I started the other tutorial, Realistic Eyes in Blender, but it’s incomplete. I thought I could use the base mesh of that tutorial here for a more realistic look, and a less confusing mesh. I used this shape for the cornea.)

- Press S-Key to scale and scale the second sphere to slightly larger than the first. (Hint: Hold shift while scaling for fine adjustment) or you could also enter a value, 1.01.

- Now that we have a nice confusing mesh, we’re going to make our life easier. We’re going to hide the outer bit for the moment. Hit the "H" key.

- Don’t panic like I did the first time I accidentally hit H, you can bring it all back with Alt-H. (Note: In blender Alt + some key often reverses the effect of pressing the key in the first place!)

- OK Now to create the basic mesh for the inner part. Basically, we need to make a concave iris/pupil section.

- Switch to a side view and use the Border Select (B-Key) to select the first four rings and the tip. Now we’re going to flatten these. Press "S" for scale "Y" for Y axis only and "number 0" for scale-to-zero. (Mast3rlinkx says: If you do this, your poor eyeball will have a pinched appearance where the pupil and iris should be. What you should do is hit S, then Z, then 0. Then drag along the Z-Axis so the flattened area is flush with the

---

curve of the sphere.) (Noob Note: The axis you need to use will change depending on
the way you aligned your eye. If you want the front to point along the Y-axis, scale Y to
0; otherwise, scale Z to 0.)

- Now grab the flattened verts with the "G" key and press Y so that it goes the right way,
and drag it a little into the eyeball. [noob note: you can also select two opposite vertices
in the fourth ring before scaling along the Z axis, and press CTRL + S to snap the 3D
cursor to the center of the fourth ring. Then set the pivot point to 3D cursor.]

- Now for the cornea. It’s not perfectly spherical; it bulges slightly at the front. We’re
going to use the Proportional Editing tool.

- First, we need to un-hide the cornea. Hit Alt-H
- Usually you would use the O-Key, but this little menu item allows you to activate pro-
portional editing for Connected vertices.

- Once activated, you can select the type of falloff from the 3D header bar. Select “Root
Falloff” (Mast3rlinkx’s Second Addition: Instead of root falloff, which looked less realistic
than it could have, I used Sphere Falloff and got a more realistic look. That’s just my
opinion, being someone who points out the anatomically incorrect portions of a cartoon
character’s appearance.)

- Press A-Key a couple of times again to make sure no points are selected, switch to a side
view (Keypad-3) and right click just to the left of the front-most point. We just want to
select that one vertex.

- Now comes some fun. We want to drag that point away from the eye in the y axis, so
press “G” for grab and “Y” for Y axis. As you move the vertex, you’ll see a circle that
defines the influence of the proportional editing. Adjust it so it is about ¼ the height of
the whole eye and drag it out until it looks right.

- To clean the model up, we’re going to apply a subsurface and apply some smoothing. Go
to the editing buttons and find the modifier panel.

- Add a subsurface modifier and set both level and render level to 2.

- Now hit Tab to switch to Object mode and hit the “Set Smooth” button in the Link and
Materials panel.

- Now would be a good time to save your work before we go on to textures.

86.2. Adding the Textures

You’re going to need multiple materials on this mesh. It’s possible to apply materials to
selected faces.

- First, switch to editing mode and change the select mode to Face select. (Oh, and switch
off proportional editing if it’s still on from the last section)

- Press A a couple of times to ensure nothing is selected.

- Press Z to switch off wireframe; this will be easier without it.

- Place the mouse pointer in the centre of one of the faces on the outside layer of the eye
and press “L” to select linked faces. If you get a message saying “Nothing Indicated” try
positioning the pointer on a different face and try again.
• Once the cornea section is selected, in the “Links and Materials” panel of the editing buttons, click “New”. The counter above it will change to “1 Mat 1” best read as material 1 of 1. Click “Assign” to assign the cornea faces to material 1.

• Hide the cornea faces (H-Key). We’ll assign the rest from the outside in. If a face is already assigned to a material and it is assigned to another, it just switches place. Therefore, it’s easiest next to assign all the visible faces.

• Press A to select all and, as above, click “New” then click “Assign”.

• Now for the iris and pupil. Hit A to deselect all.

• Switch to a front view and zoom in. Hit “B” twice to enable paint select and select the central faces plus one ring out. You can control the size of the selector by rotating your mouse wheel.

• Again, create a “New” material index and “Assign” the pupil faces to it.

• Finally, click A to deselect all and use paint select again to select the remaining faces on the iris. Assign them to a new material.

• Now we’re ready to make the materials. Switch to object mode (Tab). Change to the object editing buttons and in the Draw panel, locate the “Transp” control. Set this on. This means as we go we’ll be able to see through the cornea.

86.2.1. Cornea Material

We’ll start with the simplest texture first. The cornea is basically just colourless and transparent. Note that we’re using Z-Transparency instead of Ray Trans. This is because some lighting conditions make the eye under the cornea difficult to see. (NOTE: Until I get the images uploaded, you should refer to the pdf version for the settings. Meanwhile, here is how I see them:

Go to the shading buttons (F5)
Under the Links and Pipeline tab, ZTransp is clicked along with Radio and Tracable.
Under the Material tab, col is white and alpha is 0.1.
Under the Shaders tab, CookTor Spec is 1.674 and Hardness is 333. (Noob Note: I could be wrong, but in Blender 2.63 it appears you need to set the Shading->Emit to 1.67 and Specular->Hardness to 333.)
Under the Mirror Transp tab, Ray Mirror is clicked, RayMir is 0.4, Depth is 3 --Bonapon\(^3\) (talk\(^4\)) 14:31, 6 October 2009 (UTC)
(Noob note: In my blender 2.49, I had to unclick the ’Traceable’ setting on the cornea of my eye when following the PDF tutorial, else I ended up with a giant black ’olive’, this does not appear to affect ray mirroring, and corrects my problem.)

---


86.2.2. White Material

The white of the eye’s a little trickier. The material here includes some red veins that can be seen at the side of the eye, but not from the front. This can be done with two textures, but there’s a cheat we can use.

First, the veins:

Switch to Material Index 2 (In the Links and Materials panel, click the right arrow so it reads “4 Mat 2” or Material 2 of 4).

Click the cross or X next to the material name and add a new material.

Go to the texture buttons:

Using a marble texture, copy these settings.

(Here are the settings that I see
Under the Colors tab:
Cur: 0: Pos=0; R=1, G=0.617, B=0.629; A=1;
Cur: 1: Pos=0.340; R=1, G=1, B=1; A=0;
Under the Marble tab:
Sharper, Soft noise and Sin are clicked;
NoiseSize=0.634; NoiseDepth=5; Turbulence=26.04;
--Bonapon\(^5\) (talk\(^6\)) 15:25, 6 October 2009 (UTC))

The two colour band items are shown here separately. This makes a nice marble texture that will evenly cover the eyeball. So how to hide it from the front of the ball? Another colour band trick, but this time in the material itself.

Here they are in all their glory.

(As I see them:
Under the material tab, Col is white and alpha is 1;
Under the Ramps tab:
Cur: 0: Pos=0.690; R=1, G=1, B=1; A=0; Input is Shader; (These settings are not shown in the pdf so I have extrapolated. Please correct if wrong.)
Cur: 1: Pos=0.690; R=1, G=1, B=1; A=1; Input is Normal;
--Bonapon\(^7\) (talk\(^8\)) 15:43, 6 October 2009 (UTC))

The colour band items are both white with one alpha 0.0 and one alpha 1.0. As you can see they are very close together to give a fairly clear line that the veins will stop at. The

\(^5\) http://en.wikibooks.org/wiki/User%3ABonapon  
\(^6\) http://en.wikibooks.org/wiki/User%20talk%3ABonapon  
\(^7\) http://en.wikibooks.org/wiki/User%3ABonapon 
\(^8\) http://en.wikibooks.org/wiki/User%20talk%3ABonapon
input setting for the band is set to “Normal” this means the left hand side of the band refers to faces that are parallel to the camera view and the right is faces that are facing directly towards the camera.

I’ve also added a bit of mirroring so that we get a little scenery reflected!

There’s also some colour band fun to be had with the pupil material.

### 86.2.3. Pupil Material

I wanted a nice black texture, but I also wanted to get a red-eye effect if a light is shone directly at it from behind the camera. Why? I guess just because I can, and now so can you!

As before move to the next material index and create a new material.

There’s no textures in this one. It’s basically black and a little reflective with a nice hard specular.

(In the materials button (F5):

Under the Links and Pipeline tab, Ztransp, Radio, Tracable and Shadbuff are clicked;

Under the Material tab, Col is Black, presumably with an alpha of 1, while Spe is white with an alpha of 0.6;

Under the Shaders tab, CookTor spec is 0.594, Hard is 294;

Under the Mirror Transp tab, Ray Mirror is clicked, RayMir is 0.3;

--Bonapon⁹ (talk¹⁰) 18:14, 6 October 2009 (UTC))

Have a good look at the colour band settings though!

Position 1 is black with an alpha of 0 and positioned at 0.97. Trust me on this setting, it took a while to get it right!

(Under the Ramps tab:

Cur=0; Pos=0.970; R=0, G=0, B=0, A=0; --Bonapon¹¹ (talk¹²) 18:22, 6 October 2009 (UTC))

The second is all the way across at position 1 and is fully red (with no blue or green) and alpha 1. We want the red-eye to respond to light not angle like the white of the eye, so set the colour band input to “Shader”.

(Cur=1; Pos=1; R=1, G=0, B=0, A=1 (The alpha of the second position is not shown in the pdf) ; --Bonapon¹³ (talk¹⁴) 18:22, 6 October 2009 (UTC))

---

⁹ http://en.wikibooks.org/wiki/User%3ABonapon
¹⁰ http://en.wikibooks.org/wiki/User%20talk%3ABonapon
¹¹ http://en.wikibooks.org/wiki/User%3ABonapon
¹² http://en.wikibooks.org/wiki/User%20talk%3ABonapon
¹³ http://en.wikibooks.org/wiki/User%3ABonapon
¹⁴ http://en.wikibooks.org/wiki/User%20talk%3ABonapon
Now the bit you’ve all been waiting for – the iris!

86.2.4. Iris UV Map

Save your work and grab a cup of coffee for this part. It’s a little involved.

We need the texture to stay glued to the mesh irrespective of the shape of the mesh. This gives the effect of the muscles in the iris expanding and contracting. In a nutshell, we’re going to UV map a procedural texture to a single part of the mesh.

OK, here we go. Switch to a material editing window. You’ll need to be able to see both a 3D window and an image window. It wouldn’t hurt to see a buttons panel as well. My material screen kind of looks like this.

(Noob Note: To clarify: an "Image Editor" window option is in the Select Window Type drop down button situated at the very left of the header next to the View drop down. Select 'UV/Image Editor'. To achieve the screen the author describes, first split your view. Then select a front ortho view with NUM1 in the right window. In the left select UV/Image Editor from the Select Window Type button as described.)--WithAlligators15 (talk16) 05:59, 24 February 2010 (UTC) (Blender 2.49b)

Make sure the window is displaying a front view (Keypad-1) this will be important when we unwrap the bit we’re going to use.

Change the 3D window to mesh editing / face select and use the brush select (B-Key twice) to select the iris faces.

Now change to UV Face Select mode. The faces should remain selected. (As of Blender 2.46 the UV Face Select mode no longer exists. It’s been merged with Edit mode. All you have to do is select all the vertices/faces/edges in Edit mode and press the U-key.)

With the cursor in the 3D window, press “U-Key” for unwrap and select “Project from View”. The image window should now contain a nice even circle of dots. Put the cursor in the image window and press “A” to select all the points. Scale and move them until they fit nicely in the outer square of the image grid. Now select each ring in turn using brush select, starting from the innermost, and scale them until they cover from the centre to the outside of the image grid as shown.

Now we’ve got a map, let’s get a texture. Switch back to a modelling screen and change to object mode for the next part.

86.2.5. Iris Material

Firstly, a texture to control the colour blend across the iris. Generally it starts on the outer edge dark and gets lighter as it moves to the centre. Sounds like a job for the blend texture.

The texture itself is fairly straightforward, but again, the colour band is where the magic happens.

15 http://en.wikibooks.org/wiki/User%3AWithAlligators
I’ve pictured all three stops in the colour band. Note the alpha values. This blend texture is meant to tint the iris texture so it’s lighter in the centre and darker in the outside. (Note: I will have to create my own screen prints as I don’t know if the original author has uploaded images or if they are copyrighted. For this to happen, I will first have to complete the tutorial myself. --Bonapon\(^1\) (talk\(^2\)) 20:34, 8 October 2009 (UTC))

Now for that iris texture:

I stumbled over this texture almost by accident when I was working on a different project. Copy the settings as they appear here.

Note: the colour band points are black with alpha 0 and white with alpha 1. This allows the material colour to come through the texture, so we can set the main eye colour in the material buttons.

The main colour is blue which sets the colour of the iris. The centre colour comes from the texture settings:

The blend texture is applied to the UV map input. The green colour is used as a lighten mix to tint the iris near the centre. Using the Stencil option allows the other texture to show through.

The iris texture is applied to UV again and some normal as well as colour is applied. This makes some small shadows in the iris when the light is from the side. Add some lights and have a look at your eyeball so far.

### 86.3. Pupil Dialation

We’re going to use shape keys to create the pupil effects.

We’re going to create a normal eye and a cat’s eye. Fortunately, the fully dilated eye is the same in both cases so that’s going to be our shape key basis.

Go to the edit buttons and select the Shape Key panel.

Make sure “Relative” is selected and click “Add Shape Key” to create the base shape.

Switch to edit mode, point selection. Select just the first loop in of the iris. To select an edge loop in point mode, place the cursor on a line between two points that’s on the loop and Alt-Right Click. Shift + Alt-RClick will add the selected loop to what’s already selected.

Now scale this to just inside the width of the loop that the iris shares with the white.

Now do the same with each of the other two loops. This should produce a nice dilated pupil.

Hint: If you scale the inner loop out, but the edge of the colour doesn’t follow it exactly, drop it and hit Shift-E, then move the pointer to the right. This causes the subsurfaced mesh to closer follow the selected edge.

17 http://en.wikibooks.org/wiki/User%3ABonapon
18 http://en.wikibooks.org/wiki/User%20talk%3ABonapon

792
Now to create the normal (human) pupil shape. Switch to object mode (Tab) and add a new shape key. Name it “Normal Pupil Contract”

Now grab the edge loop between the pupil and the iris. Scale is down so it’s just a little bigger than the loop in the pupil. Select all the points in the pupil as well now and scale them all very small.

Now select the next loop out and scale it down, followed by the final edge loop. It should look like this.

Now switch back to object mode and try the shape key slider out. Pretty neat huh?

Let’s make a cat’s eye now. Switch shape keys back to “Basis” and add a new shape key called ”Cat Pupil”.

Use the same method as before to scale the edge loops. As you scale, restrict your scaling to the X axis (That is “S” then “X”). You should end up with a shape key like this:

That’s pretty much it. Try some other things like rotating iris edge loops in the shape keys for spiral eyes, or weird shapes for the contracted pupil.

Don’t forget to save – and enjoy!

(noob note: when switching between sliders, the previous one must be reset, or their effects will combine in weird and unfathomable ways)
87. Putting It All Together: A Dragon!
I downloaded Blender without knowing much about how to use it, probably like you. I hunted around for a good tutorial and found this one. It is teaching me wonderful things! I have diligently followed every lesson from the beginning, as I hope you have. Every lesson seems to contain some valuable technique. So now it is time to put it all together into a single project.

Hopefully, you now know

- How to add objects, move and rotate them, scale them in various dimensions, and change their shape.
- How to use proportional editing to change them even more.
- How to parent, join and separate objects.
- How to use materials and textures.
- How to use images in materials.
- How to use basic lights.
- How to use modifiers including subsurf and array.
- Basic use of curves
- It will help if you know how to use a photo editor such as GIMP to produce seamless textures

This project will build on all that background. Since all those things have been covered before, this will not be a key-by-key tutorial but rather a description of the general steps to take to make the finished scene.
88.1. Modeling from the Image

![Komodo Dragon](image1)

Figure 706  Komodo Dragon

![Using cubes to model the dragon](image2)

Figure 707  Using cubes to model the dragon
It happens that the Komodo Dragon is one of my favorite creatures. Let us start with that and let our imagination run wild. In the lesson on Modeling a Fox from Guide Images\textsuperscript{1} we learned how to make a beautiful 3 dimensional wolf from an image. (Yes, I know. The fox turned into a wolf. If you did that lesson you understand.) Here is a nice picture of a Komodo Dragon by wallygrom from Creative Commons\textsuperscript{2} with a proper license. We can then set that picture as a background image and apply the technique of starting with a cube and scaling it, extruding it, scaling again and so on. We only have one view, so our imagination and application of other pictures has to help with the top and end views, and we have to add a nice long tail. As you build your cubes keep in mind that you will have to create faces and extrude the legs so place a well sized face at the proper spot.

We will use the techniques we learned to split faces and add the legs. Be sure to provide a nice mouth to put teeth in later, and pay particular attention to modeling the claws. I modeled one entire foot and then duplicated it three times to have them all, and joined each one to the body at the appropriate spot.

Once you have outlined the dragon with the cubes, remember what we learned in Smoothing Your Simple Person\textsuperscript{3} and apply subsurf modifier and smooth the entire thing. You can then push and pull on vertices to help make it look as good as possible. I wanted to try to maintain the look of an ordinary creature and stay close to my Komodo Dragon, rather than a huge fierce beast to take on St. George.

### 88.2. Setting the Body Materials and Textures

Use what we learned in Image Textures\textsuperscript{4} to give the dragon his scales. The most used technique in this tutorial is:

---
\textsuperscript{1} Chapter 75 on page 643  
\textsuperscript{2} https://commons.wikimedia.org/wiki/Main_Page  
\textsuperscript{3} Chapter 29 on page 231  
\textsuperscript{4} Chapter 38 on page 293
Putting it all Together: A Dragon!

- Search Flicker Creative Commons\(^5\) for a properly licensed picture that has a good material in it. If you use Google or some other search, be sure that the picture you get is properly licensed if you plan to share the image.
- If your image is NOT a single seamless texture, use photo editing software (such as GIMP) to produce a usable seamless file.
  - Load the image into GIMP. Crop it to a reasonable size showing a relatively uniform texture.
  - Choose \textit{Filters > Map > Make Seamless}. Other photo editors will usually have a similar operation.
  - Save the image with a suitable file name.
- Add a material and a texture using the image. Adjust the settings as needed to look good.
- If you are following my steps, I have put all the textures in this article for you to copy if you wish. Click on the thumbnail image and go to the Wiki page from which you can download.

\textbf{Figure 709}  Fantasy Dragon Skin seamless texture

You can just select a rectangular swatch of skin from the picture and use GIMP to make it seamless. But Komodo Dragons are a depressing color. For a fantasy creature we need a brighter skin! So you can play with GIMP Colorizer until you have a suitably colored swatch. I used red and gold, but use your imagination! This becomes the first material and texture for the dragon’s body. It will probably be necessary to repeat the image several times in both the X and Y directions. I used X:6 and Y:2 in this particular case.

\(^5\)  http://www.flickr.com/creativecommons/by-sa-2.0/
88.3. Adding the Eyes

The dragon needs suitably scary eyes. Hopefully you have already modeled eyes for the Procedural Eyeball\textsuperscript{6} tutorial. I chose the cat’s eye. In Some Assembly Required\textsuperscript{7} we learned how to append a file. Append the Cat’s Eye, and then work on the color textures until you have a suitably scary dragon eye. Then duplicate it and put one eye on each side of the dragon’s head. I joined the eyes to the body, but you can also just parent them if you are careful. You will notice in later renderings that I kept playing with the eye color and position.

88.4. A Dragon Needs Teeth and Claws

The dragon needs suitably scary eyes. Hopefully you have already modeled eyes for the Procedural Eyeball\textsuperscript{6} tutorial. I chose the cat’s eye. In Some Assembly Required\textsuperscript{7} we learned how to append a file. Append the Cat’s Eye, and then work on the color textures until you have a suitably scary dragon eye. Then duplicate it and put one eye on each side of the dragon’s head. I joined the eyes to the body, but you can also just parent them if you are careful. You will notice in later renderings that I kept playing with the eye color and position.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{dragon.png}
\caption{The first rendering.}
\end{figure}

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{claws.png}
\caption{Assigning texture to the claws}
\end{figure}

---

\textsuperscript{6} Chapter 86 on page 785
\textsuperscript{7} Chapter 60 on page 485
Using the technique from Multiple Materials per Object, isolate the claws and give them a nice shiny black material. Too much Specularity will make the claws look like plastic, too little will make them dull and uninteresting. I added just a little bit of Mirror also. It will be something to experiment with until you get the look you like. Click on the picture to enlarge it and see the setting I settled on. Remember that you have to select the area of the mesh and ASSIGN it to the material or you will wind up with a dragon that is black all over! (That is the voice of sad experience speaking).

A dragon needs teeth. A lot of teeth! Modeling all those teeth would be a big job. Fortunately we learned how to use array modifiers in Building a House. Add a cone, scale it down very small, and extrude some more parts so you can shape it into a nice curve. When you have a beautifully sharp tooth, add the Array modifier and make it into a whole row of sharp teeth. Then duplicate the whole thing three times, rotate it around as needed, and you will have four rows of teeth, enough for both jaws. This is why we left the mouth open when we made the original model.
88.5. Horns, a Crest, and Nostrils

Figure 713  Using the Curve Modifier

Figure 714  The color settings for the horns
Figure 715  Nostrils

Let's give the beast some horns. Here we can use what we learned in Deforming Meshes using the Curve Modifier\(^\text{10}\) to make some gracefully curved horns. Just as in that lesson, add a cone and extrude segments to give a lot of vertices. Then create your Bezier Curve and set it as a modifier to the horn mesh. Properly done your horn will mold itself to the shape of the curve. Duplicate it and rotate it to fit the other side of the head and put them in place.

Animal horns are some of the most beautiful structures in nature. We should make a particularly pretty material for them. We can use the blending colorband as in the tutorial Basic Carpet Texture\(^\text{11}\), updating it a bit for 2.69, to give the horns a nice color appearance. Then add Subsurface Scattering\(^\text{12}\) as taught in that tutorial, with a lot of experimenting, until you get a really beautiful appearance. The settings I used are in the picture but it is fun to try different things.

An impressive crest should dominate the dragon’s back. I found a picture of a basilisk lizard and used it as a background model for the crest. The Crest texture was produced in GIMP exactly the same way as the dragon skin texture.

Reptile nostrils are sort of nondescript, so let's make some nice nostrils like a snorting bull might have. You can use the technique from Spin a goblet\(^\text{13}\) to model one nostril, then duplicate it, rotate the pair until they look fierce, and give them a nice color like the dark red brown I picked. Then put them in place and parent them to the body.

Now you can render your dragon and see the basic body shape, but something is missing. What is it?

\(^{10}\) Chapter 71 on page 603  
\(^{11}\) Chapter 83 on page 759  
\(^{12}\) Chapter 77 on page 705  
\(^{13}\) Chapter 52 on page 385
88.6. Giving the Dragon Wings

The wings were the hardest part, because we have not had many tutorials in this series that dealt with the problems involved. I started with a cylinder object and went from there, joining other cylinders to it, and then selecting edges and using \([\text{F}]\) to create faces. There may be other better ways to do it. I wanted the wing sail parts to be semi transparent and give an appearance of shimmering colors. Experimenting with the transparency and the materials as seen in the screenshot gave me some I liked pretty well. I am not completely satisfied with it but perhaps it is the best that can be done with the tools we have so far learned. Joining the wings to the body seemed to produce some distortions so I just parented both of them to the body object.
Now there is just one more thing that a perfect dragon needs.

88.7. FIRE!

Figure 718  Settings for flames

Figure 719  Seamless flame material
Everybody knows that dragons breathe fire. It seems that there are many different ways to do flames in Blender. However, I am attempting to use methods covered so far in this tutorial series, so I wanted to experiment and see what could be done with just what we have learned. I came up with something reasonably close to flame breath using basic techniques. I started with a series of cylinder objects, scaled at one end until they are almost cones, and then stacking them inside each other. I used the proportional editing that we learned about in Mountains Out Of Molehills\textsuperscript{14} to pull and stretch into some more or less random shapes. I found the flame picture and turned it into a seamless material swatch. Then I wrapped it around my cones and began playing with the settings for transparency, and added an Emit setting just to see how it looked. (If you want to jump ahead refer to Making Fire\textsuperscript{15} in the next section of this series.)

\textbf{Figure 720} Scaling the cylinders

\textbf{Figure 721} Distorting the cylinders

\textsuperscript{14} Chapter 45 on page 337
\textsuperscript{15} \url{http://en.wikibooks.org/wiki/Blender%3A_Noob_to_Pro%2FMaking%2FFire}
88.8. Ground to Stand on

Now it is time to complete the scene by giving him something to stand on. Since his front feet are raised, put in a sort of lava flow for him. That seems appropriate for a dragon. Try Adding a series of cubes. Stack them up and pull them out of shape with proportional editing. Add a subsurf modifier, and then the set the lava rock as an image texture. Again I made a seamless material out of a photo.

Then create a plane and again use the proportional editor to make some nice hills. A seamless green grass texture repeated multiple times completed the ground.
88.9. Lighting

So far the lighting has just been the default point light. I think it is a bit more dramatic to use the Sun style of lamp. As we learned in Light a Silver Goblet\textsuperscript{16} go to Add $>$ Lamp $>$ Sun and place a sun type lamp rather high in the sky. You will notice that now you get two overlapping shadows, one from the Sun and one from the default point lamp. You could just delete the point lamp, but, to advance beyond what has already been covered, it is useful as fill lighting. You can select the point lamp, go to the properties panel and click on the light icon.

\textsuperscript{16} http://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%2FLight%20a%20Silver%20Goblet
. Scroll down to Shadow and click No Shadow and the point light becomes a fill light. Setting the horizon color in the world panel
Figure 726

is the last step to produce this scene.
I think it nicely combines pretty much all I have learned about Blender so far in the tutorial! If you want to try your hand at a project, it is not as hard as you might think. You and I have really learned a lot by going through the first two sections of *Blender 3D: Noob to Pro*. I thank all the authors who have worked hard to bring us to this point.

I challenge you to show off what you can do with your newly acquired knowledge and put your finished work up here. It will probably be a lot better than mine.

89.0.1. Add your project below this line
Part III.

Unit 3: Broadening Horizons
90. The UV/Image Editor
91. UV Map Basics

In case you’re wondering, UV mapping stands for the technique used to "wrap" a 2D image texture onto a 3D mesh. "U" and "V" are the name of the axes of a plane, since "X", "Y" and "Z" are used for the coordinates in the 3D space. For example: increasing your "V" on a sphere might move you along a longitude line (north or south), while increasing your "U" might move you along a line of latitude (east or west).

Another explanation can be gleaned from the Blender manual. Imagine a paper 3D model of an object, e.g. a sphere, that is to be laid flat on a table. Each of the 3D coordinates of the sphere can be mapped to the 2D coordinate on the flat piece of paper. Blender provides another view of the vertices (coordinates) in the UV/Image Editor. You can select and edit these 2D vertices just like in the 3D Editor window. The purpose of this unwrapping of the coordinates is just to map these coordinates to images/pictures so that the 3D image can have a realistic looking surface with textures derived from these images.

91.1. The Basics of UV Mapping

Add a sphere

We’ll use a sphere for this demonstration. Delete the initial cube (x). Then, create a new model, a sphere (→ Add → Mesh → UV Sphere). Leave the settings at default for now.
Mark a UV seam

In edit mode, select a ring of vertices around the widest part of the sphere (the equator, if you like). This can be done easily by holding down $\text{SHIFT + ALT}$ and right-clicking on the 'equator'.

Press $\text{CTRL+E}$ and select Mark Seam, or select Mesh $\rightarrow$ Edges $\rightarrow$ Mark Seam. This tells the UV unwrapper to cut the mesh along these edges.
Unwrap the mesh

Next, create a window for the UV mapping: click and drag left the small lined area in the top right corner of the 3D window, a new window will be created. Set its window type to "UV/Image Editor" with the drop down box at the bottom left corner of the new window or with [SHIFT+F10].
In the 3D View window, select all your vertices, and press $U \to \text{Unwrap}$ . In the UV/Image editor you should see all the vertices/faces/edges of the model represented, or 'mapped', in 2D space.

You also need to select UV Editing from the Screen Layout dropdown in the UV/Image editor window otherwise Blender will unwrap the sphere but you won’t be able to see it.

Figure 730

Figure 731
Apply an image

Now we’re going to actually use this UV map. Save the following image (click to view in full high resolution (4,096 × 2,048 pixels)):

Figure 732

Load it in the UV/Image Editor window by clicking Image → Open Image or by pressing \textasciitilde{\text{ALT}+\text{O}}. Then with the grab, rotate and scale tools, adjust the UV islands (the UV groups that aren’t connected to each other) so that it fits nicely on top of the image as shown. To select a UV island, hover the mouse over the island and press \text{L}.

Note: Since the aspect ratio of the image will warp the UV’s, it may be easier to simply re-unwrap the mesh exactly the same way you did before. You can then adjust the UV’s as needed.

Figure 733
Admire your new creation

Back in the 3D View window, go into Object mode. The next drop-down menu to the right is the Draw Type menu; use it to set the Draw Type to Textured. Note that parts of the model will be shadowed and other parts illuminated based on the location of the lights in your scene. Try adding more lights and moving them around so you see the model more clearly, and try to use this lighting preview to 'previs' your render.

To make the texture visible in renderings, you also need to add the texture to the sphere as a new material. In the Properties window, switch to the Shading context by clicking the small shaded-sphere button. Create a new material by pressing the New button, leave the settings as they are for now; then switch to the Texture context. Create a new texture and select the type to be 'Image or Movie'. Select the globe texture from the dropdown menu.

Figure 734
The Basics of UV Mapping

Then go to the mapping menu and set the Coordinate to 'UV' and the 'Map' to 'UVMap', leave the projection at 'Flat'. This will make use of the UV's we unwrapped earlier.

To make the globe a bit smoother, switch to the Modifier context in the Properties window and add a subsurf modifier; set the number of subdivisions to 2. Then press \text{F12} in the 3D viewport and select 'Smooth' under the shading options. This will make the globe far smoother and more realistic.

Now, simply press \text{F12} to render your scene!

Note that in the above render I've changed the lighting and the camera position to make the image more interesting. I also added a star background, you can find the settings for this in the World context in the Properties window. Enable 'Stars', 'Paper Sky' and 'Blend Sky'. Play around with the settings for them until you reach a result you're pleased with.
Noob Note: The 'Stars' option has been removed in Blender 2.70.

91.2. Alternative method

If you looked around the textured globe we just made, you would have noticed that around the 'equator' there were lines, or 'seams', where the two UV islands met. This is a common problem with UV mapping and there are a couple of ways to avoid it. In our case, since we’re using a sphere, the best way to remove the seams is to use spherical mapping.

First download one of the textures from this link: [http://earthobservatory.nasa.gov/Features/BlueMarble/BlueMarble_2002.php](http://earthobservatory.nasa.gov/Features/BlueMarble/BlueMarble_2002.php). Then use this texture for your globe instead of the one we first downloaded.

Go into edit mode, and select all the vertices of sphere. Press $U \rightarrow$ Sphere Projection. If you’ve got the UV/Image editor open you should see a very different UV map, as shown below. Note that only the 'Unwrap' option will use the seams we just made, all of the other options completely ignore it.

Now let’s make the UVs fit more evenly over the texture. In the UV/Image editor, press $UVs \rightarrow$ Constrain to Image Bounds. This will make sure that during editing none of the UVs will go over the bounds of the texture; if they did, it would cause the texture to repeat itself in the area of the UVs outside the bounds.
Now select all the UVs with $\mathbf{A}$ and scale them up till it is stopped by the image bounds. In my case, there is one vertex in the top-right corner, and a few in the bottom-right corner that are quite distant from the rest of the UVs; to fix this, I simply selected those vertices and moved them closer to the rest of the UVs.

Now simply scale all the UVs by the X axis until the UVs stretch over all of the image. Doing this is exactly the same as scaling in the 3D viewport, press $\mathbf{S}$ and $\mathbf{X}$, then drag the mouse.

Now rerender your model, and you will see that there are no seams!
91.3. Learning More

In this tutorial we have barely scratched the surface of what is possible with UV mapping. Below are some more tutorials that will help you learn more about Blender’s UV tools:

1. Introduction to UV unwrapping in Blender: http://cgcookie.com/blender/2011/01/21/intro_uvmapping/

92. Realistic Eyes In Blender

Information
Applicable Blender version: 2.49

92.1. Warning

[While pretty excellent up until that point -- especially as a hands-on example of real-world UV-unwrapping -- this tutorial cuts off midway, possibly merely a sixth of the way through the entire process.]

92.2. Overview

This tutorial will teach you how to effectively utilize textures and materials in Blender to create realistic eyes for characters. This tutorial was inspired by a great Maya tutorial in the Gnomon Workshop series by Alex Alvarez. My goal with this tutorial is to teach you how to get those same stunning results using Blender. Please check out Alex’s tutorial as well, as it is very informative and covers more detail than I will be covering here. This tutorial assumes you know your way around the Blender interface and so I will not explain each key command as I go, but will instruct you in what steps to take and point out details such as key commands only when it seems relevant to do so. In addition, you will need some sort of image manipulation software, as this tutorial relies heavily on image-based textures, which we will be preparing outside of Blender. I will be using Photoshop, but feel free to use GIMP or whatever you’re comfortable with.

Above is an example of what can be achieved using the techniques described in this tutorial. OK, let’s dig in...

92.3. Reference Material

Let’s Take a moment to familiarize ourselves with the anatomy of the human eye. Do a Google image search and examine whichever diagram is to your liking. Now, you don’t have to pay attention to every single feature, but do take note of the cornea, the iris, the pupil, and the sclera. These are the only parts that are visible to us when we look at a person’s eyes, and therefore the only parts we will actually need to create. Many of the diagrams you find out there will be disproportionate, and so in order to know how large to make our features in relation to one another, it is best to view a large number of diagrams,
a large number of eye photos, and also photos of plastic models of the eye, as plastic models tend to be truer to scale than 2D drawings. I also found a photo of a guy popping his eyes half-way out of his head. All of these together gave me a good feel for what the appropriate proportions are for a human eyeball. To some extent though, cornea size and sclera shape will vary on a person-to-person basis, so there is no precisely correct size, per se.

92.4. Building The Eye

Creating a UV sphere. 24 segments, 24 rings, and a radius of 1 is recommended. The top of the UV sphere will become the cornea of the eye. So now let’s go into side view, in the orthographic view, and with the topmost vertex selected and proportional falloff enabled, grab and raise this vertex along the Z axis. Don’t click to finalize the edit just yet - first we will use the mouse wheel to control how much falloff is going to be applied. This process can require some finess and multiple adjustments until the bump of the cornea is anatomically correct. You will want to set the falloff shape to "sphere".
Below is a render of the curve I ended up going with. You can use it as a guide when modeling if it helps you. This is with a SubSurf of 3 applied, so keep that in mind.
Now, some people may prefer to use a NURBS sphere for the geometry of their eyeball. If you are comfortable with NURBS modeling, and texturing NURBS models, go right ahead. It will give you a smoother and more rounded eyeball. I prefer not to complicate things with NURBS when polys will do just fine, and am guessing most of you feel the same, so I’m sticking with polys. This does however bring us to the topic of the SubSurface modifier and how it will affect your eyeball. When SubSurf is applied to a UV sphere such as our own, it causes the previously spherical shape to become slightly oblong. In other words, the eye will become nearsighted. This is barely noticeable, but it does happen, as a result of the way SubSurfing affects a UV sphere. You could create a UV sphere with more rings to ease this if it bothers you. It looks fine for our purposes though, to be honest. See the comparison in the animated GIF below.
There is one last issue to address with regard to using a polygon-based eyeball. That is
the small triangles that persist on the poles of the eyeball. These stubborn tris will remain
and you will find that they result in an ugly and unnatural pinched effect when a specular
highlight appears over the center of the cornea. Adding a SubSurface modifier will not make
them go away. This didn’t become apparent until after I did some texturing work and test
renders, but I want to point it out to you now, before we get into all that. (See examples
below)
This can be remedied by adding more rings where those edges come together. Select only the edges in the very center of the cornea and **Subdivide Smooth**. Now **deselect** and again **select** the new innermost edges. **Subdivide Smooth** again. You can even do this a third time if you find it necessary. Rotate the model around in the viewport and do a couple of test renders to make sure the specular highlight doesn’t reveal any artifacts.

Now repeat this process at the opposite pole of the eye (the optic nerve area).

We are now ready to begin texturing the eyeball.
92.5. UV Mapping

In **Edit Mode**, we will define the seams for our eye. Select the edges you want to mark as seams and type **Ctrl E**, then choose **Mark Seam** from the menu.

With all of your mesh selected, type **U** to unwrap. We can now see our unwrapped UV layout in the **UV/Image Editor** window. (For older versions of Blender, you might need to select **UV Face Select** mode to unwrap, but it’s better if you download the latest.)
Those two islands we see are the cornea and optic nerve area. We can move them out of our way by selecting any vertex on them and typing L to select all linked vertices. Then G to grab as usual.

Select a column of verts on the sclera region of our UV layout. Type W to bring up the Weld/Align menu. Choose Align X. This is how we will go about straightening this contorted shape into a usable guide to map our textures.

Grab and move your straightened column of verts over to the left.

Constraining to the X axis, by typing the "X" key after you grab, is a good habit to get into while straightening these out.
Some untangling may be necessary.

And then re-straightening.

Figure 748

Straightening out all of these vertices into a usable grid shape will take you some time. It’s one of the more tedious steps of this tutorial, but it’s worth it in the end because having a rectangular grid will prove very helpful when we are texturing our eyeball. You’ll want to use Blender’s grid as a reference and just align the rows and columns to it exactly. Well, you can’t get it exactly aligned, since there is no snap-to-grid feature, but you can eyeball it and everything will work out fine. The grid lines must be perfectly straight though, so always constrain to either the X or Y axis when moving anything. You can scale the whole thing up later, once each row and column is evenly spaced. Be sure to leave some space between your UV layout and the border of the layout area - don’t "bleed" it to the edge or you will have texturing problems later.

[EDIT by nick_chang207]: You can align them perfectly; all you have to do is select all the rows and columns one by one, (you can use Alt + R) and then select the axis along which you want them to be aligned. For example, select the top column and then press 'S' to scale, then 'Y' to align it to the Y axis, and then '0' to align them. For the rows, do the same thing, only select the 'X' axis instead of the 'Y' axis this time. Its pretty easy this way.

[Edit by redset] If it’s not clear, you can actually untangle this way too - simply Alt+RMB to select a row of edges, S Y 0 and Return (or left-click) to align them all, then G Y to move them up to a grid line. Repeat this for each row of edges, then work across the columns using the X key to align your scaling and movement to the X axis instead. You’ll end up with a nice neat grid, and if you aligned them to gridlines you can just scale the entire island up to fill as much space as you need.
It’s important to pay attention to which way the UV layout is facing. Chances are the top of the sclera region is actually what you will want to be the bottom. It doesn’t technically matter which way it’s facing, but you will probably want it to look intuitive when you are painting the textures. I had to rotate that piece 180 degrees to get the cornea pole on top and the optic nerve pole on the bottom.

[Edit by redeset] Mine actually seemed to be the right way up - I found you could check by going to the 3D view (or having split windows so you can see the 3D and UV views at the same time) and making sure every vertex is selected, then holding shift and clicking to deselect a vertex on the model, close to the optic nerve or the cornea. Back in the UV view the vertex will disappear from your UV map, so you can work out how the map corresponds to the actual mesh surface. There might be an easier way to check but I’m new to this myself! (Just select all again to get the whole map back)

Once you’re done, save your .blend file and then save your UV Face Layout. This is done in the Scripts Window: Scripts > UV > Save UV Face Layout. The "UV Image Export" dialog box will appear. I recommend choosing a size of 2048 pixels.
92.6. Preparing A Template For Texturing

Now launch your image editor and open the UV face layout you just saved. (You probably saved it as a .tga file, since that is Blender’s default format for UV layouts) So we are now looking at a black and white UV grid. We want to get rid of the white regions so we can see through them to the layers below. The quickest way to do this is to set the blending mode to "multiply". If that works for you, go for it. Personally, I like my transparency to be represented by the checkered pattern, and for that we will need true alpha transparency.
In Photoshop this can be done by going to the menu and choosing Select > Color Range. Using the eyedropper, click any white part of the image, set Fuzziness to zero, and click "OK".

Figure 751

Now delete the selected white regions by choosing Edit > Clear from the menu.

nooby note: The same actions can be done in the GIMP editor by going to menu, choose Select > By Color and click any white part to select the white area. Then go to menu again and choose Colors > Color to Alpha and click "OK".

another nooby note: In PhotoShop you can also modify the layer’s blending options so that areas of white or black will become transparent: When you first open the image in photoshop it will be a single layer image, and the layer name will be ‘background’ - Double click it and give it a name like "UV-Grid". THEN select the "UV-Grid” layer , Right-Click -> ”Blending Options”, in the bottom area of the dialog set the top value for the slider on "Blend If -> This Layer " setting on grey to be a little lower (most likely 254). This means any values on "this layer" that are greater than 254 will be blended with the underlying layers. - Make sure you create your other layers BELOW this layer so the grid will always be on top.

One other element that will be useful to have in our template is a layer of markers that denote where the equator of the eye is, because what looks like the middle on the UV layout is not actually the middle. To find the middle, go back into Blender and count the rings of your eye mesh, starting at the seam of the cornea. Once you get to the equator, take note of how many rings it took to get there. Go back to your image editor and mark that area. You can mark it with a guide, or mark it with a coloring of some sort - as long as it’s clear to you that it indicates the equator of the eye mesh. It may also be useful to mark the point where the transparency of the cornea should begin.

Figure 752
92.7. First Bump Map - The Sclera

**Create a material** for your eyeball. Then within that material **create a texture**. Name this texture something like "BumpMap(Procedural)". Set the texture type to **clouds**. A noise size of **0.25** with a noise depth of **2 or 3** is fine, and you can experiment with other values if you like. The other texture settings can be left at their defaults.

Now we are going to bake this procedural texture to get an image-based UV texture that we can edit in our paint program. Why? Because there is not an even level of bumpiness around the eyeball. The sclera has bumps, while the cornea doesn’t. If your cornea was bumpy, your vision would be distorted. We want our 3D eyeball to accurately convey this subtle difference when light is reflected from the surface.

Before baking the texture, there are some parameters we must specify. In the materials panel click the **Map To** tab. The Color button is depressed by default, so you can leave it as is. Make sure this is the only depressed button. Then **change the color to black**.

Now go to the **Material** tab. Change the diffuse color to **white** and click the **Shadeless** button.

**Note**: In this particular case it doesn’t actually matter which of these colors is set to white and which is set to black. The end result is basically the same, and you can always invert the image later.
Check the Material Preview window to make sure it looks right.
Time to bake your eye. Make sure your eyeball object is selected and go into **UV Face Select Mode**. Then **split your screen** and set one viewport to the **UV/Image Editor**. From the menu at the bottom of the UV/Image Editor, choose **Image > New**. Enter a name like "ScleraBumpBake" and set both the Width and Height to **2048** (to match your UV guide). Click "OK" and a new all-black image will appear behind the UV grid.
Go to **Scene panel > Render > Bake tab** and click the **Textures** button. Then set the margin to **10** and click the **BAKE** button. You will see the black image in the **UV/Image Editor** fill in with your bump texture. From the menu choose **Image > Save As**.

Now would also be a good time to **save your .blend file**.

(Where’s the rest of this tutorial?)
93. Beginning Lighting

Lighting, you say? Pssh. Just throw up one light source and let her run, right?

Lighting is probably the most underestimated part of a scene by new 3D artists. Unlike real life, it’s actually quite easy to produce a uniformly well-lit, shadowless scene in Blender. But such scenes are usually pretty dull and boring.

Far more interesting are ones with highlights drawing attention to some areas, and shadows in other areas, leading the viewer to wonder what they might conceal. If a picture tells a story, and a picture is worth a thousand words, then lighting is like the punctuation for those words, the pauses between sentences and the sudden dramatic changes of tone.

Extremely uniform lighting can even give the picture a “photoshopped” look, as though the artist took part of one picture and stuck it on top of another. Whereas even a little bit of shadowing of one object by another can reinforce the impression that they are very much three-dimensional objects with a definite spatial relationship to each other, located in the same scene.

The following tutorials will help you gain knowledge of the technical use of lights in your scenes.
94. Understanding Real Lights

In order to learn how to light a scene properly it is helpful to first learn a few things about real lights. When you add a light to your scene you need to understand how to go about emulating the properties of the real light source that you want your Blender light to replicate.

94.1. The Properties of Real Lights

94.1.1. Color

Every light source always has a distinctive color of its own. A photograph taken at sunrise or sunset is very easy to distinguish from one that is taken at noon just by looking at the color of the light. Incandescent light bulbs emit a light of a color that is different from that of fluorescent light bulb. So a scene lit with one of the two will have a different color cast when compared to the other.

94.1.2. Angle

Light always streams in from a particular direction. The angle or direction of light has a particular influence on which planes of an object receive light and the shape and direction of the shadows that are cast by objects receiving light from that particular source.

94.1.3. Brightness and Decay

As light travels through space it decays or grows dimmer with distance. Think of a firework bursting in the night sky. When the firework first bursts the sparks are bunched close to each other. Over a short period of time they quickly spread out from each other. If you replace sparks with photons of light and the firework with your light source than you have a very rough analogy to how and why light decays. All real lights decay with distance according to the inverse-square law. At times when lighting a Blender scene it becomes necessary to cheat this law.

94.1.4. Shadows

Real lights will always cast a shadow of some sort. Real scenes also typically include multiple sources of light (even if these are only indirect lighting as a result of light bouncing off other objects). Thus, even in an area shadowed by one light source, there will typically be light coming from other directions, to soften the shadow so it is not completely inky black.
94.1.5. Size

Real light sources rarely take the form of tiny points; the light usually comes from an area of discernible size. This manifests itself in the form of a softness to the edge of the shadows, or *penumbra*\(^1\): areas behind an object where the light is partially obscured are less dark than the inner parts of the shadow where the light is completely blocked.

94.2.

These are not all the properties of real lights, but as far as CGI lighting is concerned they are the most important. As we will see later on, Blender offers enough controls for you to tweak and adjust each of these key properties of light.

95. Understanding Blender Lights

### Information

Applicable Blender version: 2.68

Blender provides several different kinds of lights:

- **Point**: Single point light source. Useful to provide very localized light. The shadows can be sharp, or you can set its size to something nonzero to make the shadows fuzzy. Can represent light sources within the scene; e.g. if there is a lightbulb or candle or something in the scene, position one of these within it to give the impression of light coming from that object.

- **Sun**: A light with parallel rays that will illuminate the scene with an even light. Because the sun is (effectively) infinitely far away, the position of this lamp does not matter, only its direction. Good to use in brightly-lit outdoor scenes (i.e. a sunny day).

- **Spot**: Spot lights produce light constrained to a cone-shaped beam, and have some special features. They are the only light source that can be made visible with the 'halo' option, to simulate light in a fog. They are also the only light source that can cast buffer shadows (see below).

- **Hemi**: 180°-wide uniform, shadowless light source. Great for use as a fill light, or as a back light, or to represent light from the sky. Similar to Sun, its position does not matter, only its direction.

- **Area**: These are similar to point lamps, except that they are rectangular. As a result they can cast accurate raytraced soft shadows, at the expense of additional render time.

There are two different kinds of shadows that lights may cast: *buffered* and *ray-traced*. The main difference is that buffered shadows are much quicker to calculate, but take more memory, and can be of lower quality without some fiddling. Also strand-rendered materials (as can be used for hair or fur) cannot cast ray shadows with the Blender Internal renderer, so you have to use buffer shadows for them so their shadows look realistic.

Only spot lamps can cast buffered shadows. Hemi lamps cannot cast shadows at all.

<table>
<thead>
<tr>
<th>Lamp Type</th>
<th>Buffer Shadow</th>
<th>Ray Shadow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Sun</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Spot</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Hemi</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Area</td>
<td>no</td>
<td>yes</td>
</tr>
</tbody>
</table>
95.1. Light Settings

Blender’s lights offer many settings you can mess with to adjust their effect, such as:

- **Energy** — the strength of the light.
- **Colour** — real lights often have a colour, rather than being pure white. It is common in photography to talk about lights adding “warm” (reddish/yellowish) or “cool” (bluish) tints to a scene.
- **Falloff** — real lights get weaker with distance according to the well-known inverse-square law\(^1\). But Blender doesn’t force you to conform to reality: point and spot lamps also allow for other options, like inverse-linear or even a custom curve.
- **Distance** — even with inverse-square falloff, the intensity of real lights never quite goes to zero at any distance, though it may become too low to measure. Blender’s distance specification allows you to limit the effect of the light to a finite maximum distance. This can be useful for having multiple lights illuminating different parts of a scene, while minimizing unwanted interactions between them—a headache that real photographers and lighting technicians cannot avoid!
- **Negative** — instead of adding light to a scene, this light source can actually darken the scene. Again, not possible with real lights, but useful for certain kinds of effects. In live action black cards are sometimes used to reduce reflection on the subject by absorbing reflected light. This light could serve to provide a similar function.
- **This Layer Only** — this light only illuminates objects on the same layer(s). Another useful way to minimize unwanted interactions between different lights.
- **Specular** — uncheck this box to prevent this light illuminating specular parts of materials.
- **Diffuse** — uncheck this box to prevent this light illuminating diffuse parts of materials.

95.1.1. Lighting Without Lamps

It is possible to light a scene without lamps, or with fewer lamps. In the World Context

of the Properties Window, there are three options, for “Environment Lighting”, “Ambient Occlusion” and “Indirect Lighting”.

Environment Lighting adds a shadowless light that seems to come from all directions and fill all parts of the scene.

Ambient Occlusion (“AO” for short) is supposed to mimic the effect of shadows darkening corners and crevices of real-world objects (in theory this should naturally fall out of accurate lighting calculations, but it is easier to compute it separately); Blender also allows you to use AO to brighten parts of the scene outside those corners and crevices.

Indirect Lighting tries to mimic light bouncing off diffuse surfaces and illuminating other diffuse surfaces. It only works when the “Gather” option (next panel down) is set to “Approximate”.

• Ambient Occlusion Video Tutorial: http://www.youtube.com/watch?v=rKUAemD7004
96. Basic Lighting Rigs

Information
Applicable Blender version: 2.68

Open a new Blender document. Delete the default cube, and insert the Monkey (Suzanne) instead. Hit [F12] to render. You should get something like this.
See how the character’s face—arguably the most important part you usually want to look at—is in shadow? That is absolutely terrible lighting.

In this section, we will look at how to improve the lighting of this scene. The object of the game is not to get rid of all shadows, because flat-lit scenes tend to look pretty boring, too. Instead, we will look at how to make imaginative use of the placement and strength of highlights and shadows, to add interest and realism to the scene.

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If you have any experience with photography</strong>, a lot of this material should be familiar to you. Lighting in 3D rendering borrows a lot from the accumulated experience that photographers have had with lighting real-world scenes. However, because computer graphics cannot be 100% faithful to the laws of physics, some limitations apply. And also some tricks become possible that are simply not achievable in the real world.</td>
</tr>
</tbody>
</table>

In photography, there are basically two kinds of lighting setups: outdoor and indoor. In the real world, outdoor lighting (at least in daylight) is dominated by the Sun. This is a single, extremely strong light source. But there is also indirect sunlight reflected off other objects, including the sky, and these tend to soften the shadows and even add some colour to them. Outdoor close-up model photo shoots also frequently make use of metal sheets, held up by support crew, to deliberately add more of this indirect reflection and make the lighting of a model more even.

Indoor (studio) lighting setups are commonly described in terms of the number of lights employed, commonly “one-point”, “two-point” or “three-point” for 1, 2 or 3 lights.

In 3D graphics, you can cheat over this outdoor/indoor distinction. After all, the Sun is just another light source you can choose to place in a scene. Instead of metal reflectors, it is usually simpler to just add more lights, even if it is meant to be an outdoor scene. In Blender, the lights themselves need not show up in the render, only their illumination of the scene.
96.1. One-Point Lighting

Continuing on from the above example, move the default lamp so it is roughly in the same location as the camera. Now your render should look something like this:

This is similar to the lighting you get when you take a picture on a point-and-shoot or cameraphone with flash enabled: because the light source is close to the lens, you don’t see many shadows (think about it: the parts the light doesn’t reach are close to the parts your vision doesn’t reach), leading to a very flat image. This is why experienced photographers often try to avoid using the flash.
96.2. Two-Point Lighting

This time I have gone back to the default light position, and added a second light ("fill light") close to the camera, reducing its strength to 0.5, while the original "key light" stays at 1.0. That way the second light fills in the shadows just enough to make things legible, without flattening out the lighting completely.

The important point is that the key (brightest) light is not at the camera position. That way, the image will contain some interesting shadows.
96.3. Three-Point Lighting

![Three-Point Lighting Figure](image)

**Figure 762** Positioning the backlight

Now we add a *third* light, called the “backlight”. This is positioned behind and a little above the model, and serves to accentuate the upper silhouette (particularly the head and shoulders), and make our model stand out from the background. I set its energy to 2.0, to increase the effect. This screenshot shows what should be a good position for this light (it is directly above the green line of the Y-axis). Put it too close to Suzanne, and her bald head will glow a little *too* brightly. :)

---

857
Figure 763  I’m ready for my close-up, Mr DeMille.

Now the render looks like this. Does the effect look familiar? You should have seen something like it in countless close-ups in film and TV, as well as portraits.

96.4. Other Lighting Setups

Of course, there are countless other ways to light a scene. The above ones are mainly intended for close-ups and portraits. But where there are multiple characters in a scene, or even no characters at all and just the scene, you may want to position multiple lights to draw attention to some parts or characters while playing down other parts.
96.5. See Also

- Portrait Lighting Setups\(^1\) — a good intro to the different lighting setups commonly used for professional portrait photography.

\(^1\) [http://www.professionalphotography101.com/portrait_lighting/lighting_names.html](http://www.professionalphotography101.com/portrait_lighting/lighting_names.html)
97. Faked Global Illumination with Blender internal
98. Practising Good Parenting
99. Overview
100. Introduction to Keyframing
101. The Ways of the Animator

You have just seen how animation can be applied to most object property values. In addition to this, Blender provides some specific features to aid in animating movements of parts of objects:

- **Meshes** can have *shape keys* defined for them. These give different positions to the vertices (though their number and *topology*—edge/face connections—cannot change). The amount of influence each shape key contributes to the shape can be continuously adjusted from nothing to 100%, and like other property values can be made to vary over time.

- **Armatures** are specialized objects, consisting of rigid *bones* that can be connected by joints, and moved and rotated relative to each other to produce different poses, very much like the skeleton of a human or animal. Armatures do not appear in the final render, but a mesh can be *deformed* (i.e. have its shape changed) by an armature to bring lifelike movement to a character.

- **Lattices** are another kind of specialized object that can also be used to deform a mesh. Like armatures, they do not appear in the final render. Unlike armatures, they lack rigid joints, and so produce more rubbery changes of shape, characteristic of creatures without bones, or perhaps for a cartoony effect.

- Curve and surface objects can also have shape keys defined for them. And of course curves can be used to deform a mesh via the curve modifier.

- You previously saw the usefulness of the Empty object\(^1\) in modifiers. But being an object with position, scale and rotation properties like any other, these properties can be animated for an Empty, too, with corresponding effects on those modifiers. Also if the Empty happens to be a parent\(^2\) of other objects, then those objects can be animated as a group, just by animating the Empty.

---

1 Chapter 72 on page 615
102. Animation Editors

Information

Applicable Blender version: 2.70

Blender offers several different kinds of editing windows specifically to do with animation.

102.1. Timeline

You have previously come across the Timeline
view as the simplest way to see the keyframes in an animation. This window also includes transport controls that you can use to start and stop the animation, jump to a particular frame with \[ LMB \], and scrub by dragging across a time range with \[ LMB \].

This window also lets you define markers which you can name to identify important points in the animation, for informational purposes. Also, using the “Bind Camera to Marker” function, you can dynamically switch the active camera at marked points in the animation, to cut between different viewpoints.
102.2. Graph Editor

You previously saw how to define keyframes for animating a property, such as an object position or material setting. But what if you get a keyframe definition slightly wrong? Perhaps the timing is slightly off, or the movement is not quite right. You could delete the keyframe and try again. But, in many cases, it would be easier if you could get into the actual definition of the keyframe and tweak it around a bit, move its time position, adjust the animated property values, that kind of thing.

This is the purpose of the Graph Editor.

Figure 765

It gives you the most detailed, low-level view possible of your animation, by drawing an *FCurve* for each animated property of the selected object, representing how the property
value varies over time. Each curve has control points located at each of its keyframes, and you can move these points around—horizontally to change the timing, or vertically to change the keyframe value—as well as add and remove points.

102.3. Dope Sheet

The Dope Sheet

![Figure 766](image.png)

Figure 766

gives a high-level view of your animation, similar to the Timeline, but slightly more detailed. Here you see the separate keyframes for each animated object, and you can do some limited editing, like moving the keyframes around, and duplicating and deleting keyframes, but you can’t seem to add entirely new ones.
Actually, this window can show any of five different editor submodes: Dope Sheet, Action Editor, Shape Key Editor, Grease Pencil or Mask. The Action Editor is useful in conjunction with the NLA Editor (below).

- See also: Dopesheet\(^1\) on the Blender Wiki.

### 102.4. NLA Editor

The NLA ("Non-Linear Animation") Editor

---

\(^1\) http://wiki.blender.org/index.php/Doc:2.6/Manual/Animation/Editors/DopeSheet
Animation Editors

represents a different way of setting up an animation: instead of thinking of it as a single linear sequence of keyframes, you break it up into actions, which are separate sequences that can be arranged in various ways. You can also duplicate an action any number of times, position the copies at different times in the overall animation, and even attach them to different objects. But they still share a single set of FCurve contents, which you can edit in the Graph Editor as you would a monolithic linear animation sequence, and your changes will take effect in all copies of the action.

To edit the contents of an action in the Graph Editor, you select the action and \( \text{[TAB]} \) into "tweak mode" (analogous to Edit mode in the 3D view). \( \text{[TAB]} \) again takes you out of Tweak mode.

**Note:**

**Actions do not appear in the Timeline or Dope Sheet.** This means that, once you start to use actions, you no longer get a correct overview of your animation in these two windows. The Timeline is still useful for its transport controls, but otherwise you should stick to the NLA Editor for your overview.

However, the Action Editor submode of the Dope Sheet now becomes useful, for creating new actions. These start out initially empty of any keyframes or FCurves, but you can add these in Tweak mode.

- **See Also:** NLA Editor\(^2\) on the Blender Wiki.

### 102.5. To Summarize...

The above description may seem rather confusing in places. Basically, there are two ways to organize your animation:

- **Linear**, as a single sequence of FCurves and keyframes
- **Non-linear**, as a sequence of actions, each consisting of a sequence of FCurves and keyframes. The nonlinear data can be further divided into multiple overlapping tracks, which combine together at any moment in time to produce the complete animation.

Objects that can have animation data attached to them can have both kinds, linear and nonlinear. You can even attach both kinds at once, though then the linear animation data takes precedence. It is easy to change your mind and switch back and forth; typically, the development of a simple animation might start out linear, then change to nonlinear as it gets more complicated.

103. Introducing the Graph Editor
104. Animation Rendering
105. Lattice Modifier

**Information**

Applicable Blender version: 2.49

105.1. What is a Lattice?

A Lattice is essentially a simple container that can be used to deform and manipulate a more complex mesh in a non-destructive manner (i.e. A lattice can be used to seriously deform a mesh then, if the lattice is later removed, the mesh can automatically return to its original shape).

105.2. How to add and use a Lattice

A Lattice is added to the scene in the same way other objects are added. Either:

**Noob Note** For Blender 2.62 or 2.63 users, I recommend referring to this Lattice Modifier video tutorial by Ed Lazor for animating the lattice, as numerous interface changes have occurred between Blender 2.4x and 2.6x.

1. Shift-A over the 3D window and choose Lattice from the pop-up menu, or
2. Press Spacebar over the 3D window and choose Lattice from the pop-up menu, or
3. LMB ADD from the 3D window menu and choose Lattice from the drop-down menu

The default Lattice looks just like a cube when first added except that it is just one Blender Unit (BU) wide whereas a mesh cube is 2 BU wide. When the Lattice is added, the window remains in Object Mode and the Lattice can be moved, resized and rotated like any other Blender Object.

On its own, a Lattice serves no purpose whatsoever since it can’t be seen in a rendered image. Its only use is to manipulate another object and so, to be useful, we need to associate another object with it. The current method for doing this is by applying a "Lattice Modifier" to a Blender object.

The basic workflow is:

- Add a mesh (cube, cylinder, cone, sphere, etc.)
- Add a Lattice
- Select the mesh

---

1. [http://www.youtube.com/watch?v=10asQDMhFQw](http://www.youtube.com/watch?v=10asQDMhFQw)
• Press F9 and go to Modifiers Panel(buttons window). In the modifiers tab Press Add Modifier > Lattice
• In the Ob: Panel, enter the name of the Lattice (The default name is Lattice, Lattice.001, Lattice.002, etc. - or you can give it a useful name that you’ll remember later)

NOTE: In older versions of Blender, a lattice was applied using a parent method - select the mesh, then select the Lattice, then press Ctrl-P and choose ”Lattice Deform”. While this method is still available, it does not offer the full functionality of the newer Lattice Modifier. If you use the parent method, you will need to press the ”Make Real” button in the modifiers palette to enable the modifier functionalities. Using the method, the Lattice becomes a parent and a modifier. As a parent, it will act on the mesh in Object Mode whereas a true modifier lattice only influences the mesh when altered in Edit Mode.

![Figure 768](image_url)

Adding a Lattice Modifier to an object

Now, we can change the Lattice in **Edit Mode** and any changes we make to it will affect the mesh.

**Note: Applying the Modifier Correctly**

When adding the modifier to your object, you must enter exactly the same name as your lattice. The default is **Lattice** with a capital ”L” but if you’ve changed it or have more than one Lattice, then you will need to enter the new name. When you enter a valid Lattice
name, the name stays visible in the Ob: box. If your entry disappears then you’ve entered
the name incorrectly.

One simple way to get the right name is to select the Lattice, go to F9, Link and Materials
panel and where it says Ob:Lattice or Ob:Lattice.001 etc., move the mouse over this field
and press Ctrl-C (don’t click on it, just hover over it). This copies the Lattice name. Then
select your object, go to the Lattice Modifier panel, hover the mouse over the Ob: field and
press Ctrl-V to paste the name in. Now it should stay there and your Lattice should work
in Edit Mode.

Noob note: I recommend the method with Ctrl-P for animation.

105.2.1. Basic Exercise:

1. Start with a new Blender scene, delete the default cube and add a UVsphere (Space-
   bar> Add> Mesh > UVsphere). Accept the default 32 Segments and Rings. You could
   use any of the mesh shapes but because the sphere is heavily subdivided (made up of
   lots of edges and faces); you will get a better idea of what the Lattice is doing.

2. Tab back into Object Mode then add a Lattice. It is generally wise to resize the Lattice
   so that it surrounds the mesh it will be deforming. So, press SKEY and enlarge the
   lattice to 2 BU wide.

3. Select (RMB) the Sphere and add a Lattice Modifier to it. Make sure that you type
   the exact Lattice name correctly into the box. Nothing appears to happen but that’s
   fine.

4. Now select your Lattice, TAB into Edit Mode, select just one control point (a control
   point looks like a vertex) on the Lattice and move it around. You will see the sphere
   mesh stretching and squashing relative to that control point. Move each Lattice
   control point one at a time and see just how far you can deform the mesh. Zoom in
   your 3D window if you need a closer look.

5. The control points of the Lattice can be moved, scaled and rotated in the usual ways.
   Try selecting a few of all the control points and scaling them (SKEY) or Rotating
   them (RKEY) and watch the mesh follow along.

6. Now, exit Edit Mode (TAB) and select the sphere in Object Mode. Go to the modifiers
   panel and press the big ”X” button to remove the modifier. Despite all that deforming,
   the sphere immediately returns to its original size and shape. Nothing was really
   changed in the sphere’s mesh data. Immediately re-apply the modifier as before and
   see the Lattice immediately apply its own deformation to the sphere again.

105.3. Getting more involved with Lattice

The default Lattice is two control points high, two wide and two deep, i.e., it is two control
points wide in each direction (these are referred to as the U, V and W directions). However,
we can change the number of control points in one, two or all directions. This is done by
selecting the Lattice, going to the Lattice Panel (F9) and changing the values in the U,
V & W buttons. If you decrease one figure to a value of 1, the Lattice will become two-
dimensional (planar). Decreasing two values to 1 will change the Lattice to a line (one
dimension). This can be useful, especially if the remaining value is increased, but is not the most common usage of Lattice.

**Figure 769**

**UVW settings for Lattice**

**NOTE:** The "Make Regular" button will set the UVW control points of an unscaled Lattice to be exactly one Blender Unit apart in each direction. The "Outside" button effectively removes all the internal control points which are added when the UVW settings are higher than 2.

In most situations you will want to increase some or all the values as this gives you more control over complex deformations, much like a subdivided mesh. How much you increase the UVW directions depends entirely on how much detailed control you need over deformations. As you’ve already seen basic squash, stretch, shear and simple deforms can easily be achieved with the default 2,2,2 Lattice but by increasing the UVW values a little, a whole new range of deform possibilities becomes available.
Three Lattices with different UVW settings

One thing to understand, however, is that a Lattice cannot bend the individual edges of a mesh (the lines connecting any two vertices) so the mesh must contain enough edges in order to apply complex lattice deformations to it. These edges must be genuine edges and not the virtual edges created by a subsurf modifier (Correction: Yes, they can be edges generated by a subsurf modifier, provided the subsurf comes above the lattice in the modifier stack for the object being deformed; use the up/down-arrow buttons next to each modifier to rearrange them as necessary). Edges can also be added to a mesh using a variety of tools including subdivide, knife and loop cuts (some info on these http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Die_Easy_2http://).

New Note: Use the K key to open a menu for the knife, loop cuts, etc. Knives are used to add a vertex to each line you left click and drag the cursor over, and loop cuts allow you to make multiple cuts into your active object.

About loop cuts: Ctrl + R also is a direct shortcut to a loop cut. Furthermore, loop cuts’ main uses are for subsurf modeling. In order to accomplish a hard edge in a subsurfed object (for example the edges and corners of a wooden table or the bumpers of a car) you must apply loop cuts to the faces surrounding the edge and place them very close to them (and parallel). Experiment with a simple subsurfed cube and you’ll see. Keep in mind this is why when modeling it is highly recommended to use quads. A loop cut will only cut a quad face, or every face connected with it in one direction, but only quads. Another main reason why it is recommended to model with quad faces is regarding animation but I suppose other tutorials will deal with that later. More information: http://wiki.blender.org/index.php/Manual/Edge_and_Face_Tools
105.3.1. Intermediate Exercise

For this exercise, start over with a new scene and repeat Steps 1 - 3 in the Basic Exercise above. Don’t go into Edit Mode yet.

Basic Exercise:

1. Start with a new Blender scene, delete the default cube and add a UVsphere (Space-bar> Add > Mesh > UVsphere). Accept the default 32 Segments and Rings. You could use any of the mesh shapes but because the sphere is heavily subdivided (made up of lots of edges and faces); you will get a better idea of what the Lattice is doing.

2. Tab back into Object Mode then add a Lattice. It is generally wise to resize the Lattice so that it surrounds the mesh it will be deforming. So, press SKEY and enlarge the lattice to 2 BU wide.

3. Select (RMB) the Sphere and add a Lattice Modifier to it. Make sure that you type the exact Lattice name correctly into the box. Nothing appears to happen but that’s fine.

• In Object Mode, select the Lattice then press F9 and go to the Lattice Panel. Increase all the UVW values to 4. You will immediately see the change displayed in the 3D window.

Figure 771

A simple subdivided cube after a complex lattice deformation
• Tab into Edit Mode and play with the control points again. The first thing you might notice is that the corner control points have less influence now than before. This is because the effect is proportional to the distance of each point from the mesh. Move some points in the middle of a side face and you’ll see the effect is significantly greater.

• Try selecting groups of control points and pulling them away from the Lattice to stretch lumps and bumps out from the mesh. If you are familiar with the proportional edit tool, try that too - it works on Lattices just like it does on meshes.

Try doing the same exercise but increasing values in only the W direction. (U divides in the X direction, V divides the Y direction and W divides the Z direction). So, set the UVW to 2,2,4 and play with the control points again in Edit Mode. Select the two rows of control points around the centre of the Lattice and scale them up (SKEY) then Scale them down along Z-axis only (Skey>ZKey). Try other transforms constrained on different axes for interesting, controlled results.

There are three different options for how the Lattice Modifier affects each UVW direction. These are Linear, Cardinal and B-Spline. All I can say is that B-Spline is the default and to find out what the difference is, press the buttons and see.

105.4. Examples

![Figure 772](image)

*Some examples of a Lattice deforming a standard UV Sphere mesh (not smoothed)*
105.5. Making it stick

To keep the mesh deformed permanently, you can select it and press the "APPLY" button in the Lattice Modifier panel. This "bakes" the mesh in the deformed position and disconnects it from the Lattice. The Lattice can then be deleted without the mesh returning to its original shape. This is useful if you are using the Lattice as a modelling tool rather than an animating tool.

Also, instead of deleting the Lattice, you can use it to immediately modify another mesh. Simply move the Lattice over the new mesh in Object Mode then apply the Lattice Modifier to the new mesh. If the Lattice is already in a deformed state, the mesh will immediately be deformed too. Press Apply again to "bake" that mesh and keep re-using the already deformed Lattice on as many other meshes as you wish for matching results.

[Noob Note: I found it interesting that you can even apply the lattice deformation to the original object again once baked, and it will deform even further.]

105.6. Animating a Lattice Modifier

Lattice animation uses a workflow almost identical to the RVK (Relative Vertex Key) workflow from Blender 2.37 and earlier. You don't need to know this but some people might find the information useful.

With your Lattice Modifer already added to your object, select the Lattice and press I-Key to tell Blender you wish to animate the Lattice. Choose "Lattice" from the pop-up list. This sets the basis key (undeformed state) for the Lattice.

Adding the basis key

In the Editing panel (F9), press the "Relative" button.

Figure 773

Set the keys to "Relative"
NOTE: The Slurph setting determines the delay, in frames, for how long it will take to morph from their former state to the one applied by the new lattice.

To set your first deform key, press **I-Key** and then "Lattice" again then enter **Edit Mode**. Deform the Lattice by scaling or moving control points then Tab back into **Object Mode**. If you open an **Action Window** now, you will see your first key, "Key 1", added to the list. If you press the small arrow at the top of the list, it will display the slider for that key.

![Figure 774]

*Lattice key sliders in the Action Window [Noob note for blender 2.48a]* In the action window, select "ShapeKey editor" in the dropdown "editing modes for this editor" (in the panel header)

To add more Lattice keys, for a variety of deform shapes, repeat the process: I-Key, Tab to Edit Mode, move control points, Tab back to Object Mode. Each time you exit edit mode, a new key will be added to the list in the Action Window.

Animating the Lattice uses the same process as animating Shape Keys for meshes.

If you want the object to begin undeformed, then set each key slider to zero on the first frame of the animation. Move through the frames, setting the sliders as you go to deform the Lattice as desired. You will often find you’ll need to set a key before and after each deform key in order to control the rate at which deformations take place in the animation.
Setting keys in an animation

Noob note: I’m doing everything as described and get no keys in action window when exiting Edit mode... Any suggestions?

Noob note; Is it possible to create a keyframe using the object’s mesh rather than applying a lattice?

Noobie note: What to press after I-Key? I’m not getting any keys in the action window, help please.

Another Noob: No keys here. I got something changing to IPO Curve Editor and choosing Shape in IPO Type

Noob note; Select Action Editor header->Shape Key Editor. Make sure you also selected Buttons Window->Editing (F9)->Relative Keys

Noob Tip: I am seeing a possible bug in 2.49 in which the key sliders will not appear on the Action Editor unless there is at least one window set to Action Editor when the keys are created. To reveal key sliders for keys that have already been created, save the file, re-open it, set one window to ”Action Editor” set the window sub-type to ”Shape Key Editor” then switch the Lattice ”Relative” setting on and off (putting the cursor over the Action Editor window and hitting HOMEKEY will help locate the sliders). Or, by preference, make sure at least one window is set to ”Action Editor” before creating the keys.

Noob note: I couldn’t see the sliders either; then I scrolled up and there they were, off the visible portion of the window. However, I had by then change the window type a few times, so I can’t rule out that that did something first.

105.7. Let the fun begin!

Now you have your object safely locked away inside your Lattice, you can still animate the object itself, inside the Lattice!
105.7.1. Why would I animate the object too?

Take the case of the classic cartoon eyeball which is taller than it is wide. If you just stretched the sphere object itself, instead of using a Lattice to deform it, then you couldn’t properly rotate the eyeballs to look up and down because the whole "egg-shaped" eyeball would rotate and end up lying on its front or back. The eyes would literally pop-out of the head.

Figure 776

*Cartoon eyes: The stretched spheres don’t rotate properly.*

If, however, you use a Lattice to deform the basic sphere to make it into a tall "egg" shape, you can still select the eyeball itself and animate it within the Lattice. Now when you rotate the eyeball, it will look up and down but still maintain its deformed shape within the head.

Figure 777

*Cartoon eyes: Spheres deformed with Lattice can still be rotated with good results.*
106. Bouncing Ball with Lattice

Information

Applicable Blender version: 2.49

106.1. How to make a ball bounce convincingly!

This tutorial assumes basic Blender awareness and some knowledge of using Blender Lattices as well as keyframes basics regarding the Blender Panels. Knowledge of IPO curves will prove useful later as we progress to more advanced techniques.

106.2. How hard can it be to move a ball?

It would be easy to just put a sphere on the screen and animate it to move up and down but in all honesty, it would not look like a bouncing ball. It would not be convincing in any way.

To be believable, the ball must use some of the most fundamental principles of good animation. In particular, the ball must squash and stretch and change speed as it falls, hits the floor, bounces and rises ready to fall again. With a little effort we can make that boring sphere look alive!

106.3. Why use a lattice?

It is possible to make a simple bouncing ball animation without using a Lattice object but with the Lattice we can do more than just bounce the ball. For example, once we have a ball that bounces how we’d like it, we can later add rotation to the ball so it spins through the air and bounces then, as the bounces decrease, the ball can roll to a halt. Doing this without lattice would be a far more complex exercise as a rotating squashed and stretched sphere would look like it was wobbling in space (like having the flat part of a flat tire spin around the tire instead of staying on the bottom, even while the wheel is turning).
106.4. Let’s begin then

To begin, add a UVSphere (SPACE add->mesh>UVShere ) in Top View (NUM7). It is important to add the objects in top view to keep their Z-Axis aligned upwards. Set Smooth and Sub-surf on the sphere if desired. Tab back into Object Mode then immediately add a Lattice(SPACE add>Lattice ). Resize (SKEY) it so it closely surrounds the sphere. Make the edges of the lattice align with the circumference of the sphere as this will make animation easier.

(By default the Lattice Object Name is ”Lattice”. It is good to give all your objects unique and sensible names, especially if you are planning a complex scene. So you might call the Sphere ”Red_Ball” and the Lattice ”Red_Ball_Latt” or something similar for easy reference and recognition later.) (Noob Tip: I have formed the habit of naming everything in ALL CAPS. As the scene gets more complicated I can easily keep track of what I have named and what needs naming.)

Figure 778

Top view of UV-Sphere inside selected Lattice
106.4.1. Make the lattice deform the sphere

Prior to Blender 2.4, objects were parented to Lattices with a Lattice Deform option. In version 2.4+ you can select the object (the sphere) and apply a Lattice Modifier to it (Ob: Lattice). However, if you use this new method then the ball will not move where the Lattice moves and will not squash when the Lattice squashes and we want it to do both of these things.

Luckily you can still use the good old Parent option then use the Modifier palette to make the Lattice Deform "Real". So select the sphere and THEN SHIFT SELECT the Lattice then CTRL-P to make parent and choose the "Lattice Deform" option. If you now select just the sphere, press F9 and look in the Modifiers palette, you’ll see a listing for "Lattice parent deform" with a button for "Make Real". You can either ignore this button or press it. It really won’t matter for now. If we wanted to do some weird things to our ball, like kicking it or deforming it in other complicated ways, then we would have to use the "real" Lattice modifier option.

So, this may not be the purist approach to using a Lattice but it is a convenient way to achieve the results we’re after. Basically, it works and is reasonably intuitive.
If you press "Make Real" you enable the full Lattice Modifier

Information

Applicable Blender version: 2.69

(None of this seems to be necessary in later versions. The full Lattice screen comes up as soon as you Parent it.)

You can easily check if the Lattice is working the way we want it to by selecting the Lattice and resizing, moving or rotating it. **The ball should do everything the Lattice does.** I don’t wish this to be a full lesson in Lattices so if you don’t understand any of the above, or you’re certain your Lattice is not working as it should, then please learn a bit about lattices\(^1\) before proceeding.

106.4.2. Time to animate!

For our basic animation, we’ll use just 23 frames starting with the ball high then falling, squashing, bouncing and ending up back where it started. When this is played back in the 3D window, it will loop and we’ll see the ball bounce forever in one place.

This part is easier done in "SCR:1 - Animation” Viewport configuration. It is also useful to have multiple orthographic views open in the viewport by right clicking on the resize viewport arrow and choosing “split area” then making a top view, side, etc...

---

\(^1\) Chapter 105 on page 881
Go to **Front View** (Num1) Press F10 and set your start (Sta) frame to Frame 1 and your end frame to Frame 23. Then make sure you’re on **Frame 1** (Shift+Left Arrow) to start animating. Note that we are **animating the Lattice**, not the ball. Everything we do to the lattice will directly affect the ball too.

Note: all the modifications to the lattice must be done in ‘Object’ mode. If not, they will affect all the frames.

Select the Lattice (NOT the ball) then do the following on the corresponding frames:

- **FRAME 1**: Press IKEY and set a key for LocRotScale - the ball’s start position (high).
- **FRAME 11**: Move the Lattice to ground level and key LocRotScale again (*keep the fall distance small for now*).
- **FRAME 13**: Leave Lattice in same position as frame 11 and key LocRotScale again.
- **FRAME 23**: Move Lattice back to start position (use Num (N) Panel if you need to) and key LocRotScale again.

(Noob note- This may seem obvious, but move the lattice BEFORE you insert the keyframe.)

These four frames give a basic up and down animation with a pause at the bottom. We can add squash on Frame 12 to finish off.

- **FRAME 12**: Place the cursor at the base of the Lattice then set the Rotation/Scaling Pivot to ”3D Cursor”
Scale the Lattice down along the Z-Axis **SKEY-ZKEY** and see the ball squash. **IKey** LocRotScale again.

When you have set all five keys, you can cycle through the frames and you should see the following result on the Key frames we just set.

Figure 782

**Screenshots of the 3D window, front view, on each of our five key frames.**

If you press **Alt-A** now in the **3D window**, you should see the ball bounce. Even though the squash happens on just one frame, it still reads properly in our minds and is a vast improvement over an animation with no squash at all. *(Press **RMB** or **ESC** to stop the animation playback)*.

If you have a camera and lighting suitably set up you could render the animation out and use Blender’s ”PLAY” button to loop the rendered animation. See the bottom of the page for an OpenGL render made from the steps above. Add material to the ball and a ground plane for a more interesting result.

106.4.3. **Looking at the IPO Curves**

If you want the ball to bounce three times then you could repeat the above instructions three times over - if you have the patience - but Blender has a better, easier way.

Select the Lattice then open up an IPO (**I**nterPO**l**ation) window and zoom into the group of keys. If you select LocZ and SizeZ from the channel list on the right, you should see something like this (I’ve added labels to the screenshot):

*Note the the IPO Type here is "Object". Purists may be disturbed or perplexed by this but if you remember, we’re not really using our Lattice in the purist, Lattice Modifier form. Don’t worry about it though. It works.*
Let’s begin then

Figure 783

*IPO curve for Lattice, showing LocZ and SizeZ channels.*

This shows the relative position on the Z-Axis and size in the Z-Axis of the Lattice. You can see that the Size remains constant until frame 11, then reduces, then goes back and remains constant until frame 23. Similarly, the LocZ curve shows how the ball starts high, falls then stops before rising again. The rounded bottom of the LocZ curve occurs because the IPO curve maps the centre point of the Lattice and when we squash it, the centre point lowers slightly.

Of special interest is that by default, Blender uses Bézier curves for IPOs and this gives us rounded tops on the curve. This means the ball starts moving slowly downward then moves faster until the reaches the bottom. Also, as it nears the top, it slows down again. This is good because this is exactly what happens in reality when a ball rises and falls (*It could be better - but it’s a good start*)

While in the IPO window, select both curves then press **KKEY** and you’ll see each key frame indicated by a vertical line. (Note: You can also press *View->Show Keys* if you can’t remember this shortcut - this has helped me in the past.)
Bouncing Ball with Lattice

Figure 784

*IP*O window set to show key frames
Let’s begin then

Press **AKEY** to select all key frames then duplicate (Shift-D) them. The curves will seem to deform but when you drag the frames to the right, they will sort themselves out. Position them so the "first" frame is at Frame 24 and the new end frame is now Frame 46. Reset the End Frame in the Scene (F10) window then watch the animation again. It’s not bad. You can repeat this process for more bounces. (To have it bounce forever throughout a long animation, ignore the above procedure and just set the "Extend Mode" to "Cyclic" in the Curve menu. You’ll have to adjust the curve a little on the first and last frame but you only do it once and Blender repeats the change for all other cycles.)
Information

Applicable Blender version: 2.69

Noob Note: Instead of IPO window, go to Graph Editor. I was not able to find any way to get yellow lines at each Keyframe, as above, but using put Bezier handles at each keyframe. I need to experiment to find out how to use them. worked as above.

It’s not bad for a start but there’s a lot more to do to this ball before applying for that animation job.

106.5. Saving The Animation

How do you tell Blender where to save the animated frames? The answer is in the “Output” mini-window that you see in the Render settings (F10). Near the top of this are two editable text fields, the first of which is initially set on my Linux system to “/tmp/” and the second to “//backbuf”. The first one is the output pathname or directory prefix used to save the generated frames as JPEG files when you press the “ANIM” button. If it has no “#” characters in it, then it is used as a directory prefix; thus, the default will be to save the animation frames as /tmp/0001.jpg, /tmp/0002.jpg etc. Alternative, if you put in a filename spec with “#” characters in it, the hashes will be replaced with the frame number. Thus, if I set the field to “/home/ldo/Documents/BlenderTuts/ball####.jpeg”, then the frames will be saved to that /home/ldo/Documents/BlenderTuts directory and be named ball0001.jpeg, ball0002.jpeg etc.

106.6. So what next?

In real life and in a typical cartoon, balls don’t just bounce forever in one spot. They move along and slowly lose their bounce before rolling to a halt. And they have more character than our bouncing ball.

Things to consider next:

- Perfecting the squash - maintaining volume
- Adding stretch
- Look at acceleration and deceleration
- Rotate the ball as it bounces
- Reduce the bounce height over time
- Move the ball around as it bounces

See this ANIMATION LINK² (580kb, AVI-DivX) for an idea of how you can achieve interesting results with just a little more effort. but its k? k

² http://members.westnet.com.au/andydolphin/blender/bounce.avi
106.7. Links

Principles of bouncing ball animation: http://www_idleworm_com/how/anm/01b/bball_shtml

Blender 2.49B bouncing ball animation: http://www_youtube_com/watch?v=BEY_6dFdUJY

Blender 2.49B vector blur animation, to add realism to your animations: http://www_youtube_com/watch?v=qY4WcNgEXv8
107. Creating Basic Water Animation
108. Flying Through a Canyon
109. Using the Sequencer to Compile Frames into an Animation
110. Further Rendering Options

Information
Applicable Blender version: 2.68

In previous units on renderer settings, you learned about

• Basic settings\(^1\), and
• Animation rendering\(^2\).

Here we will describe some more renderer settings that can be useful in certain circumstances.

---

1 Chapter 24 on page 177
110.1. Stamping

![Image of Stamp panel]

**Figure 786**

The “Stamp” panel in the Render
context provides options for placing descriptive text on top of each rendered frame. The topmost checkbox enables/disables stamping (off by default), while the other checkboxes control the precise information to include, and you can even specify the text and background colour and font size. The information is inserted at the corners of the image, so it can be included in production renders that get appropriately cropped as part of the post-production process.
110.2. Toon Renders

Blender has long had an option for doing simplified “toon” (cartoon-style outlined) renders. In the Render
Toon Renders

context, look for the “Post Processing” panel and check the “Edge” box. You will also have to set up the lighting and materials for your objects to give a more flat-shaded look.

A more powerful set of options for doing this sort of thing is available with Freestyle\(^3\), which you will learn about later\(^4\).

---

\(^3\) Chapter 160 on page 1239
\(^4\) Chapter 152 on page 1145
110.3. Clay Renders

There is sometimes a need to render a scene without detailed materials and textures, just to see what the object shapes look like. In the Render Layers context, there is an option to override all lighting and materials for objects in the layer with a particular light group and a particular material. It is common to use a plain diffuse, colourless grey material for this purpose, making all the objects look like they are made out of clay, hence the name.

110.4. Transparent Backgrounds

Blender by default provides a “sky” or background for your rendered scene; settings for this can be controlled in the World.
Sometimes you don’t want such a background at all; you simply want the objects in your scene set against a *transparent* background. So, for example, if you insert the image in a Web page, the scene is displayed against the page background, rather than its own image background.

The way to do this is quite simple:

- Choose to render the Sky as Transparent. In the Render
Further Rendering Options

Figure 792

close-up context, look for the Shading panel, where there is a popup menu labelled “Alpha:”, with items “Sky” and “Transparent”. Change this from its default “Sky” to “Transparent”. You have to do this before rendering the image.
• When saving the rendered image, choose a file format (in the Output panel in the Render
context) that includes an alpha channel\(^5\); for example, PNG allows for this, but JPEG does not. With such a format chosen, you further have to remember to select the “RGBA” button, not “RGB”, otherwise the transparent areas will simply be filled with black.

**Note:**

If you are not sure which formats support alpha channels: the formats which do not support alpha channels will not show the “RGBA” button.

\(^5\) [http://en.wikipedia.org/wiki/Alpha%20channel](http://en.wikipedia.org/wiki/Alpha%20channel)
111. Overview
112. Fire
113. Fur
114. Fireworks

Information
Applicable Blender version: 2.48a

Figure 794  Figure 1: Some particle fireworks

[Note: In newer versions of Blender, the reactor particles are gone.]

[if you use 2.6x version of blender, then you could watch the YouTube video {particles from particles part1/2}. It’s a great tutorial, but the part 2 of it uses compositing, which is described in this book a little later. Therefore, you could apply the knowledge you have learnt from this book to animate the explosions!]

How to create a firework from particles? We will use cascaded particle systems especially of the type Reactor. Abstract:

- We create a emitter object in the appropriate size.
- Than we use three successive particle systems:
  - the first of the type Emitter
  - the second of the type Reactor. This system reacts to the death of the emitter particles.
  - the third again of the type Reactor. This systems reacts to the proximity of the second systems and thus creates a ”drag”.
- We create three different materials (one of them animated) and assign them to the three particle systems.

114.1. The Emitter

We use a Plane as emitter object. Scale it to your liking. I have used a relatively large particle system, so my plane has a length of 15 BU (Blender units).
• Add a particle system (Fig 2a, left hand side).
  • Amount: 25
  • Sta: 1
  • End: 250
  • Emit from:
    • Random
    • Faces
    • Even
    • Random
  • Initial Velocity
    • Normal: 22
    • Random: 7
  • AccZ: -9.8
  • Visualisation: Line
    • Back: 1.1

A few particles (25) are created in the first 250 frames of the animation and emitted upwards. Gravitation, velocity and lifetime are adjusted so, that the particles reach the end of their lifetime at the topmost point of their trajectory.

The Line visualization lets the particles appear as long drawn-out line.

• Bake the particle system. Use 500 as the End frame for bake. 300 would be sufficient here, but 500 do no harm.

Noob Note: Bake is in the Bake tab next to particle system tab in particle buttons window.

The plane will get a Halo material.

• Activate Halo in the Links and Pipeline panel.
  • Halo: color red
  • Halo Size: 0.421
  • Hard: 35

I’ve adjusted the size and hardness of the halo so long until I liked it, so there is no specific reason to use these values.
114.2. Reactor 1

- Click on the arrow next to 1 Part 1 in the Particle System panel.
- The settings for the first particle system are no longer shown, now it reads 1 Part 2 (Fig. 2a, right hand side).
- Click on Add New, now it reads 2 Part 2.

You just have created a second particle system. Rename this system, a good naming convention will help you a lot to keep the overview.

Figure 796  Figure 3a: The first reactor system

- Activate React on: Death.
- Life: 104
- Emit from: Particles

You don’t have to set anything for the Target. It is not necessary to set the target object if it is the same object as the reactor. You just have to set the number of the target particle system eventually.

The Reactor particles react on the Death of the particles of the target system. They will be emitted from the point that the particles occupy at their death.

To control the movement of the system, I have made following setting in the Physics panel:

- Particle: 0.345
- Reactor: 10
- AccZ: -0.09
- Brown: 3.86

Because of the Reactor setting the star is moving away from the emitting particles. The Brown movement lets the trajectory appear trembling like affected by wind.

- Set the material number to "2" in the Visualization panel.
- Bake the system, again use 500 as end frame.
114.2.1. Material 2

Figure 797  Figure 3b: Material settings for the 1. Reactor system

- At first you have to assign a new material in the Link and Materials panel of the Editing Buttons.
- Use the material settings from Fig. 3b ,
- The material also gets a Clouds texture with Noise depth “3”, simply leave all other settings unchanged.

The texture is actually superfluous here, but the next particle system is given the same texture, and colors should be adjusted a bit.

- Animate the Alpha value of the material.
  - Set the first Ipo key in frame 1 (Alpha=1). To do that move your mouse cursor over the Buttons window. Press I -> Alpha (and change ipo type to material in the ipo curve editor if you are using that).
  - Set the second Ipo key in frame 86 (Alpha=0.75).
  - Set the third key in Frame frame 101 (Alpha=0.0).

The second particle system is faded off relatively quickly, but the particles don’t disappear suddenly.

114.3. Smoke Trail

Figure 798  Figure 4a: Particle system for the trail

The third (and last) particle system is again a Reactor system and is reacting to the second system. It’s going to react to the Nearness of the particles. Without moving the variation of the particles is created with a texture and a random variation of their lifespan. What Blender considers as close can be changed with the particle Size.
• Create a third particle system (like you created the second).
• Use the settings from Fig. 4a. Important are the settings:
  • Amount: 100000
  • React on: Near
  • Emit from: Particles
  • Life: 75
  • Rand: 0.4
  • Target Sys: 2
  • Material: 3
• Bake the system, again use 500 as end frame.

114.3.1. Material 3

Figure 4b: Material for the Trail particle system

• At first you have to assign a new material (the third) to the object in the Link and Materials panel of the object buttons.
• Assign the existing Clouds texture from material 2 also to material 3, but select a dark blue as target color (in the Map To panel).

114.4. Render

• Render your animation, use end frame 500.

That’s all. I hope you were able to follow the tutorial. Criticism and suggestions, write best on the talk page or improve the article directly.

\[\text{http://en.wikibooks.org/wiki/%20File%3ABlender3D%20Fireworks-Reactor2-Material-2.48a.png}\]
115. Particles forming Shapes

Information

Applicable Blender version: 2.48a

Note all the blender users of version 2.6X, 2.7X: Using sort of a domain to dissolve the particles by using the alpha parameter of the material is how I did it. You should understand along the way. I’ll write the sentences in key sequences to reduce the size. So [s], 0.5, [enter] means to scale the object by 0.5. Don’t worry you’ll learn keyed physics here.

- Open a new blender file.
- Delete the default cube.
- [shift]+[A], text.
- [num0]
- In the menu, below the tool shelf check align to view.
- Select the text object, [alt]+[c], convert to mesh.
- [shift]+[a], add Suzanne.
- [ctrl]+[2], not the numpad.
- Set smooth.
- In the modifier’s tab apply the subsurf immediately.
- If you want you can scale the objects.
- Add a particle system to text object. [I leave the renaming parts to you]
- In the emission subpanel of the text object’s particle system: Number:5000; Start/end(both):1; Emit from: faces, check random and even distribution, random; Physics: none; Uncheck emitter in the render subpanel and choose none rather than halo.; Set all to zero in the field weight’s subpanel(actually I didn’t notice much difference it even being on).;
- Now add a particle system to Suzanne and give it the same particle system but make sure to have it made to a single user(just press the ‘2’ beside the system name).
- [shift]+[a], uv sphere.
- Selecting the sphere, [alt]+[g](just in case).
- [s],2000,[enter].
- [ctrl]+[2], set smooth and apply the modifier.
- Give the same particle system to the sphere.
- Now [num0](assuming you’re not already in camera view).
- [LMB] on the pass partout(the greyed out area except for the camera).
- [shift]+[a], add cube.
- Give the cube a particle system.
• Assign the same particle system but let’s make a few changes: In the physics subpanel select keyed.; In the render subpanel choose halo.; In the menu labeled keys, click the ‘+’ icon thrice and set the target object to text, Suzanne and sphere in order.; Now select the Suzanne’s particle system in the keys menu, check use timing and set it to 200. Now select the sphere’s and set the time to 7025! (well this is just to lower the speed we won’t render this); And set the life time of these particles to 500.(this is in the emission subpanel).

• In the timeline header set the end frame to 300.

• Now for the material. Select the cube and: Give it a new material.; Select halo.; Size: 0.03; Hardness: 16; Add: 1; RGB: As you desire how the particles appear.(I did RGB=0, 0.106, 0.8); Now go to frame 260 and insert a keyframe to alpha value.; Now go to frame 270 and insert make the alpha value zero and insert another keyframe.;

• Set the scene’s gravity off.

• [ctrl]+[F12](I suggest you render this one in xvid rather than png it’s fun)
I will show on this page two ways to let particles take the shape of other objects.

1. keyed particle physics (Img. 1a)
2. a harmonic force field with a damping of 1. The force field is emitted by another particle system, so that each particle is attracted by another particle (Img. 1b).

v2.48
The second method is easier to control, but I’ve found that it may not work exact enough. Even if you use RK4 as calculation method, there are some glitches in the precision of the calculation, so that your particles may not come to a standstill (depending on the size of the particles and their number this may be visible or not).

v2.49
That the particles didn’t come to a standstill has been a bug that Jahka has fixed in 2.49. So if you use Version 2.49 and upwards you will find it easier to work with the harmonic force field.

Note:
Plan Ahead!
Make it easy for yourself. If you know beforehand what will happen at each important frame, you will save a lot of time fiddling with the parameters.

115.1. Keyed Physics

So here we’re going to use keyed particle physics and quite a few different particle systems. Basically this is the way to go:

- Use mesh objects and let them emit particles.
- Each system moves to another system because of the keyed physics.
- Choose a good visualization of the particles and animate that also.
- At last the hard part: sync the different animations.

The animation shall last 300 frames, this will be 12 seconds.

- In the first 2 seconds the word ”Blender” shall appear (frame 1 to 50).
- Than Suzanne shall build up in 3 seconds (frame 51 to 150).
- Suzanne shall be clearly visible for a few frames (frame 151 to 200).
- After that the form shall dissolve and the particles move a bit until they vanish (frame 200 to 300)
115.1.1. Preparing the scene

- Remove the cube.
- Add a text object *Blender*. Name it *Blender-first*.
- Add a Suzanne (*Add->Mesh->Monkey*). Name it *Suzanne-first*.
- Convert the text object to a meshobject, because only mesh objects can emit particles (menu: *Object->Convert Object Type->Mesh*).
- Move the objects to their final positions, also the camera.
- **Clarification required - what are the final positions?** *(Noob note: the author probably means to move the camera and objects to a right position for viewing the animation correctly.)*

We need every visible object twice.

- Duplicate *Blender-first* and call the duplicate *Blender-last*.
- Duplicate *Suzanne-first* and call the duplicate *Suzanne-last*.

One problem is that the objects have different sizes. So how many particles shall be used to create a clearly visible form? Since the most difficult object is Suzanne, I have first chosen an acceptable representation and set everything else accordingly. But I will discuss the settings of the objects in order, and not in the way I did it in reality.

115.1.2. Set up the particle systems

**Blender-first:**

- Add a particle system to *Blender-first*.
  - **Amount**: 20.000
  - **Sta**: 1, **End**: 50, **Life**: 50
- **Emit from**:
  - *Random/Faces/Even/Random*

Leave all other settings at default. This object will appear in the first 50 frames. After that the object has to vanish in the 51st frame.

- Insert a layer key for *Blender-first* in frame 50 (mouse over the 3D window, *I ->Layer*).
- Change to frame 51.
- Move the object to layer 20 (*M ->select layer, bottom right box*). Make that layer visible.
- Insert the next layer key for the object.
- Make layer 20 invisible again (select layer 1).
- Change back to frame 1.

**Suzanne-first**

- Add a particle system.
  - **Amount**: 20.000
  - **Sta**: 50, **End**: 100, **Life**: 200 (we don’t need this long life but the lifetime doesn’t matter as long as it’s long enough)
- **Emit from**:
  - *Random/Faces/Even/Random*
- **Visualization**: None

936
Leave all other settings as default. These particles shall not move and they shall not be visible. They are simply a target to the next system.

- Animate the layer of this object also. Move it out of sight in frame 151.

**Blender-last**

These particles shall move from the shape "Blender" to the "Suzanne" shape.

- Add a particle system to *Blender-last*.
  - **Amount**: 20,000
  - **Sta**: 51, **End**: 51, **Life**: 100
  - **Emit from**: 
    - **Random/Faces/Even/Random**
  - **Physics**:
    - **First/Keyed** It is the first system of a chain (a very short chain in this example) of systems.
    - **Keyed Target**: Suzanne-first, **Ps**: 1. Target is the first particle system of "Suzanne-first".
    - **Set time to Absolute** in the *Extras* panel. We’re going to animate the material of the particles, I want all particles to change at once in a certain frame.

**Figure 801 Image 2a**: Particle system of the first keyed system.

**Suzanne-last**

These particles shall dissolve the form, so at first they take the shape and move around randomly afterwards.

- Add a particle system to *Suzanne-last*.
  - **Amount**: 20,000
  - **Sta**: 151, **End**: 151, **Life**: 150, **Rand**: 0.5. The lifetime is randomized from 151/2 to 151 frames. [Noob Note: In 2.49a, you can’t set the start later than the end, so you must first change the end to 151, then change the start.]
  - **Emit from**:
    - **Random/Faces/Even/Random**
  - **Bake**: **End** frame 300. Though we don’t use baking here, you have to set the **End** frame in the *Bake* panel. Else the last 50 frames wouldn’t be calculated.
  - **Time**: **Absolute**
Figure 802 Image 2b: Animation of Brownian Motion

Animate the Brownian motion of the particles.

- Open an Ipo window.
- Select Ipo Type particles.
- Select the Brown channel (LMB).
- Ctrl-Click with the left mouse button in the Ipo window to create an Ipo-key for the selected channel.
- Create a curve similar to Img. 2b. Brown = 0 to frame 200, than increase to Brown = 4 in frame 217.

115.1.3. Material

Blender-first and Blender-last will get the same material, Suzanne-first is invisible anyway, but Suzanne-last will get a material. The material of the three objects is very similar, but I have animated the visibility of the particles to match the brightness of the objects.
Suzanne-last

- Create a simple Halo material like that in **Img. 2c**.

This is nothing special, relatively small particles with a relatively "sharp" edge. The Add parameter gives more brightness if particles overlap, I think this is a nice effect here.

Blender-first

- Assign the material also to "Blender-first".
- Make the material a Single User Copy by clicking on the small number next to the material name.
- Set Alpha to 0.438.

Blender-last

- Assign the "Blender-first" also to Blender-last”.
- Make the material a Single User Copy by clicking on the small number next to the material name.
- Animate the alpha value of the material.
  - Insert an Ipo key for Alpha in frame 50.
  - Change to frame 150.
  - Set Alpha to 1.
  - Insert an Ipo key for Alpha.

Now the brightness of all systems are matched.

115.1.4. Links

- Download the blend file¹
- Manual about Particle physics²

---

115.2. Harmonic Force Fields

So here we will use Harmonic force fields. The Text ”Blender” shall be transformed to the text ”2.5” and than to the text ”The big leap forward” (Img. 1b).

- Use mesh objects and let them emit particles. Only the particles from the first object are visible and move.
- The other particle systems use an animated Harmonic force field to attract the particles from the first system.
- The particles from the first system take the place of the other particles.
- Choose a good visualization of the particles and animate that also. This is difficult and maybe you should animate the visualization at last.
- At last the hard part: sync the different animations and force fields.

115.2.1. Preparing the scene

- Remove the cube.
- Add three text objects:
  - ”Blender”
  - ”2.5”
  - ”The big leap forward”
- Convert the text objects to mesh objects (menu: Object->Convert Object Type->Mesh).

115.2.2. Set up the particle systems

- Give each of the three objects its own particle system.
- The first object ”Blender” gets following system:
  - Type Emitter
  - Amount =4000. We need a lot of particles, to fill the last text evenly. If you want to make the animation even better, you could animate the Halo size of the particles to match the density of the different objects.
  - Sta(rt) =1, End =10, Life =250. The particles are created from the first to the 10th frame and live for 250 frames.
- Change the calculation method from Midpoint to RK4. We need the extra precision here.

Only the particles of this system will be visible later.

- The objects ”2.5” and ”The big leap forward” will get particle systems with very similar settings:
  - ”2.5”;
    - Type Emitter
    - Amount =4000
    - Sta(r) =30, End =30, Life =70. So all the particles are emitted in frame 30 and live 70 frames. So their force field (which we give them soon) will start in frame 30 also.
If you want a smoother transition you should give the particles a bit more time to be emitted (like from frame 30 to frame 40).

- Emit from Random / Faces / Even / Random.
- Physics None. The target particles shall not move.
- Visualisation None. The target particles are not rendered.
- "The big leap forward": All settings as for "2.5", except Sta, End and Life.
  - Sta = 101, End = 101, Life = 90.

115.2.3. The force fields

![Image 3a](image3a.png)

Figure 804 Image 3a: The object does not get a force field.

The particle systems of the objects "2.5" and "The big leap forward" will get a force field now. The objects don’t get a force field.

- Select the object "2.5".
- Select the particle system in the Field panel of the Physics buttons (Img. 3a).

![Image 3b](image3b.png)

Figure 805 Image 3b: The particle system gets the force field.
• Use field type *Harmonic*. Now the particles from the object "2.5" do attract the particles from the object "Blender".
• The *Strength* of the force field determines the time the particles need to reach the target. Set it accordingly.
• The *Damp* (ing) makes sure, that the particles move to their target but not beyond.

Do the same for the object "The big leap ...", i.e. select the particle system and give it a *Harmonic* force field.

I have used a *Wind* field in the last frames to blow the particles away.

(Noobie Warning: When i followed the tutorials up to this point, i didn’t know how to use wind. I thought selecting *Wind* instead of *Harmonic* would create the effect but then blender froze on me (I am guessing it went away and calculated wind for every single particle). so don’t try wind yet. Wind is instructed in later tutorials.)

### 115.2.4. Links

• The Blend file to download³
• The manual about force fields⁴

---
³ [http://www.snapdrive.net/files/180816/Blender3D_HarmonicFieldText.blend.zip](http://www.snapdrive.net/files/180816/Blender3D_HarmonicFieldText.blend.zip)
116. Billboard Animation

**Information**

Applicable Blender version: 2.49

Billboard\(^1\) visualization of particles - and especially their animation - is one of the more arcane concepts in Blender. We’re going to shed some light on this. Billboard visualization is extremely powerful, everything that can be done with a halo can also be done with a billboard. But billboards are real objects, they are seen by raytracing, they appear behind transparent objects, they may have an arbitrary form and receive light and shadows. They are a bit more difficult to set up and take more render time and resources.

**Billboards** are aligned square planes. If you move an aligned billboard in a circle around an object, the billboards always faces the center of the object. The size of the billboard is set with the Size of the particle.

Texturing billboards is done by using uv coordinates that are generated automatically for them.

- The main thing to understand is that if the object doesn’t have any UV Layers, you need to create at least one in the objects Editing buttons for any of these to work (**Img. 1a**).
- Moreover, material should be set to UV coordinates in the Map Input panel (**Img. 1b**).

---

The simplest thing we can do is to give every billboard its own fraction of an image texture.

We’re going to use a simple image (Img. 2a, right-hand side) and split this into four parts (UVSplit = 2, horizontally and vertically).

- Create the UV coordinates (simply click on New next to UVTexture in the Mesh panel).
- Create a particlesystem.
- Activate Billboard visualization.
- Set UVSplit to 2.
- Offset: Random to randomly choose one of the images sections. None would give only the first of the four fields, so all billboards would be red, linear would first use red, then blue, then white, and then yellow repeatedly.
- Set UVChannel to Split. This creates the necessary UV coordinates, that are restored in the UVlayer. If you use another UV channel, you need a second (or third) UV layer to store the coordinates (see below for an example).
- Fill in the field UV with the name of the coordinates set (here "UVTex").

Figure 809  Image 2b: UV Split for Billboards Animation\textsuperscript{a} Blend file\textsuperscript{b}

\textsuperscript{a}  http://www.vimeo.com/4116347
\textsuperscript{b}  http://www.snapdrive.net/files/180816/BillBoardSplitUVs.blend.zip

- Now create a material for the particle emitter.
- Add a texture if not there already.
- Set Map Input to UV. If you only have one active UV layer this is used by default, but if you want to continue this tutorial you have to fill in the name of the UV set also (i.e. "UVTex").
- Load the texture as Image texture.

Now every billboard gets a random section of the texture (see Img. 2b).
116.2. Animating Alpha in relative particle time

![Image 3a: Using an UV layer for time animation](image)

Now we’re going to combine the texture split effect with an animation of the billboard alpha. This is done in relative particle time\(^2\), i.e. in the lifetime of each particle.

Billboard time is setup completely different than particle time.

- Create a new UV layer (the second one). Name it "UVTex.Blend". Naming is not important here as long as it is unique.
- Select the UV channel Time-Index (X-Y) in the Visualization panel of the particle system. Fill in the name of the newly created UV layer "UVTex.Blend". This creates an additional set of UV coordinates in this UV layer.

Now both UV layers with different UV coordinates will be used. The material settings:

- Activate RayTransp and TraShadow.
- Add a second texture to your material.
- Map Input also UV, but now use the UV layer "UVTex.Blend".
- Map To:
  - Invert Alpha and Invert Spec
  - No RGB (since we’re going to use a colorband texture)
  - DVar = 0 to set Alpha to zero where the colorband is black.

This is one of the possible combinations for using a texture to make a material transparent (Img. 3b), there are several other methods that work as well.

• Use a linear Blend texture.
• Activate Colorband for full control.

Note: The left hand side of the colorband is the first frame of the particle lifetime. The right hand side is the last frame of the particle lifetime.

• Adjust the colorband to your liking.

I’ve mapped the textures so, that “white” means full opacity, black full transparency.

Figure 813  Image 4a: Animating Billboard color. Animation

Figure 812  Image 3c: Texture to control the animation time.

See this animation 3 for the result of the combined textures. And also the Blend file 4 if you want to take a look at it.

116.3. Animating billboard color

Figure 813  Image 4a: 

Animat ing Billboard color. Animation

a http://www.vimeo.com/4132553

3 http://www.vimeo.com/4121571
4 http://www.snapdrive.net/files/180816/BillBoardFadeUVs.blend.zip
I will show here a second example for animating with a billboard texture, because this is so important. We’re going to change the color during the lifetime of the billboard, but you can animate every property that way that can be influenced by a texture. Additionally you can animate the material itself, this is done in absolute time for billboards. So you can mix relative and absolute time animations.

- Open a new file.
- Remove the cube and add a plane.
- Add an UV layer to the plane
- Add a particle system with Billboard visualization and UV Channel Time-Index. Fill in the name of the UV layer.

The particle lifetime is 50 frames.

- Add a material to your plane.
  - Basis color Yellow.
- Use a linear blend texture. If you would use a color band here, you could create an even more colorful animation.
  - Map Input UV
  - Fill in the name of the UV layer.
  - Map To Col. I’ve used a dark blue color here.

Now the linear blend texture sets the amount of blue color that is mixed to the basis color of the material.

- At the left hand side the blend texture has a value of 0, so zero blue is mixed to the base color in the first frame of the particle lifetime.
- At the right hand side the blend texture has a value of 1, so 100% blue is mixed to the base color in the last frame of the particle lifetime.
If you flip the Blend texture, you get a different effect. Now every Billboard gets another starting color, but keeps that color during it’s lifetime.

Have I mentioned that you may use multiple textures on a billboard, combining all effects?

**Figure 814  Image 4b:** Flipped XY for the blend texture
117. Soft Body Animation

### Information

Applicable Blender version: 2.49

Due to rapid updates in Blender, some menu items may be different from those mentioned here. If the menus don’t agree then just do what seems logical.

Softbody makes each individual vertex its own object that falls according to gravity and reacts to outside forces like fields. By adjusting the settings, you change the behaviour of the edges that connect the vertices. For example, you can make it so edges can stretch really far (aka elasticity), allowing the vertices to become distant, or you can make the edge stiff, so the vertices will always stay the same distance apart.

To put this in perspective, picture two cloths, one elastic and one cotton. The elastic one has edges that can extend, so if you view them in wire-frame (with vertices and edges visible) you would see the edges are more extended than an equal distance. The cotton one would only stretch a little bit, so the vertices would stay essentially the same distance apart.

We are going to make a big rubber ball, but not a big bouncy one, a flat (and somewhat lifeless) one. Start with a sphere. I would use a cube sphere or an icosphere, UV spheres don’t deform well as they have too few vertices. A cube sphere is made by subdividing a cube and doing a "To Sphere" in the Edit window, under Mesh Tools.

Move the sphere up and place a plane below it. Make sure to do this in the right views so that it is aligned properly. Gravity acts on the z-axis (sphere should be above the plane relative to the z axis).
Now for the soft body select the ball and go to the object tab then the physics subtab or whatever your version has. Click "enable softbody" and then turn up 'Grav' to 9.8. Click off use goal. Press the > arrow key (a few times) and you should see the ball fall. The center will remain in place but this is not a problem. If you are on a slow machine you will notice lag. This is because blender moves it vert by vert, not efficient.

Note: in Blender 2.49, you must deselect the "Use Goal" button to release the center of the ball. Otherwise, it will just hang there.

Note: In Blender 2.44, click F7 on keyboard, select the "Physics Buttons" button, select "Soft Body".

Figure 815
Changing the starting color of a billboard

When it reaches the plane it will pass through. To fix this we must make the plane affect the softbody. To do this make the plane deflect in its physics buttons.

(Noob Note: To do this in version 2.49 select the plane, go to object buttons -> physics context -> collision subcontext and select Collision. The variables you can play with here are under the Soft Body and Cloth Interaction.)--WithAlligators\(^1\) (talk\(^2\)) 10:00, 9 March 2010 (UTC)

---

another thing you could do is animate the scene. Just put up animation video and set frames at about 50. Go to object mode, select sphere and press i key, and select LocRocScale. =)
117.1. Explanation of Settings

I invite you to correct and expand these definitions:

117.1.1. Softbody

- **Friction**: creates a resistance to movement of the whole object, like being submerged in a viscous fluid.
- **Grav**: the rate of velocity change due to gravity. Results in a constant -z force.
- **Mass**: (Force = mass \times acceleration) affects everything by making the object heavier.
- **Speed**: tweaks the simulation to run faster or slower.
- **ErrorLimit**: raise it and the simulation will solve faster but strange things might happen. Save frequently, as blender might go nuts with this or any physic simulation (but less so after 2.4)
- **Goal**: makes the object try to return to its original position, useful at times, in the tutorial you could turn gravity off and key the ball falling and use this to keep it a ball.
- **use Edges**: uses the edges a means of resistance to movement for the object. Helps to keep it looking possible

117.1.2. Deflection
118. Simple Cloth Animation

Information
Applicable Blender version: 2.63

In this tutorial, we will be making a simple skirt, and using the cloth physics system to make it fall in realistic-looking folds.

118.1. Making the Skirt Mesh

1. Open Blender and delete the default cube, if you aren’t looking down on the scene, press NUM7.
2. **SHIFT+A** → Add → Mesh → Circle
3. The circle will be created, and in the Tool Shelf on the left you should see a panel appear for adjusting its settings. Set the number of vertices to about 12.
4. Switch to Edit Mode with **TAB**. All the circle’s vertices should be initially selected; if not, use **AKEY** to select them all.
5. Press **EKEY** to extrude a second copy of the vertices; press **SKEY SHIFT+ZKEY** to scale the extruded vertices in the X and Y directions. These will make up the hem of the skirt; scale it out to as large as you like. Note that this is positioning the skirt out flat horizontally, instead of hanging down as you would expect; Blender’s cloth animation system will take care of that, and this positioning gives maximum opportunity for the skirt to fall in dramatic folds.
6. Now we will need to subdivide the mesh. The physics can only act on actual vertices, so the more of these we have, the more realistic the cloth effect will be. Select all vertices in the skirt, press **WKEY** and select the “Subdivide” option. A panel will appear in the Tool Shelf for controlling the settings for the subdivision operation; set the number of cuts to, say, 4.
7. While you’re at it, switch to **OBJECT** mode and look in the Tool Shelf for a pair of “Shading” buttons titled “Smooth” and “Flat”
Simple Cloth Animation

Figure 819

, and click on “Smooth”.

118.2. Creating the Vertex Group

1. Now we have to specify that the waist of the skirt will stay fixed in place as it falls: deselect all vertices, and select the innermost ring of vertices. The quickest way to do this is to hold down ALT+SHIFT and click with RMB on one of the edges bordering the hole in the middle. With the entire ring of vertices selected, go to the mesh data tab in the Properties window, find the “Vertex Groups” panel, and click the + sign to create a new group. This will initially be called “Group”; perhaps give it a more meaningful name (like “Waist”), and click “Assign” to put the selected vertices into the new group.

118.3. Animating the Skirt

1. Tab out of Edit Mode into Object Mode. The skirt should still be selected.
2. Go to the Physics tab
in the Properties window (last icon in the row at the top). This will just show a few buttons to begin with
3. Click the “Cloth” button; a whole lot of other settings should appear, most of which can be left at their default values (make sure the checkbox at the top of the “Cloth Collision” panel is checked). However, check the box titled “Pinning”; now you can click in the field just below it to bring up a popup menu of all the vertex groups in the mesh; this should just contain the one entry named “Waist” you created earlier, so select that.

4. Now the magic happens ... rotate the view to an oblique one to give yourself a good view of the process, and hit `ALT+AKEY`. You should now see the skirt fall from its horizontal position to a more natural vertical one, developing some folds in the process.

5. After the animation has run through at least one complete cycle, hit `ESC` to stop it.

### 118.4. Prior to Keeping the Folds

Before doing the next step, we need to enable one of the standard addons that come with Blender. This will let us make a copy of any stage of the physics simulation into a separate object.

Go into the User Preferences window and bring up the “Addons” tab. Look for the “Animation Corrective shape keys” addon (typing “shape k” into the search box should be enough to find it).
Enable it. Now back to the 3D view...

118.5. Keeping the Folds

1. Use the left- and right- arrow keys to step through the animation one frame at a time, until you find a position for the skirt that you like.
2. When the 3D view is showing a nice shape for the skirt, go to the mesh data tab in the Properties window, and look for the “Shape Keys” panel. Click with LMB on the down-arrow just below the + and - signs, and in the menu that appears, you should see the item “Create duplicate for editing”
3. It looks like nothing has happened, but in fact you now have a second copy of the skirt mesh, “baked” into the position corresponding to the current frame of the animation. Try using the arrow keys to move through the animation, and you will see the baked copy remain in the chosen position.

4. At this point, you can delete the original animated skirt mesh (or move it to another layer for future reuse), leaving the nicely-folded copy.
118.6. Extra Practice

1. You will notice at some points during the animation, the folds of cloth pass right through each other, which is of course impossible with real cloth. To prevent this, you could go to the “Cloth Collision” panel in the Physics tab, and click the “Self Collision” checkbox. Rerun the animation (ALT+ALKY) to see the difference; what other effects does it have?
2. Maybe the folds don’t look realistic enough. Go back to the original mesh, bring up “Subdivide” again and subdivide it by a couple more levels. Rerun the animation (ALT+AK EY ). It should take a bit longer for the first cycle, but do the results look better?

3. This YouTube tutorial might also help: http://au.youtube.com/watch?v=mgYhZ3hWwTQ happy animating!
119. Soft Body with Wind
120. Blender Game Engine Basics-
Rolling Ball
121. Platformer: Controls and Movement

This tutorial will teach you the basics of the Blender Game Engine, and how to create a platform game, which is a game where you overcome in-game obstacles by controlling the character’s motions. (e.g. Super Mario)

121.1. Set Up

Figure 825  How it should look so far.
To start, switch to the frontal view **NUM1** and move the starting cube to -3.0 along the Z axis, or three spaces down. If your default settings do not have you starting with a cube, create one now. (Don’t forget to switch to the Blender Game engine. You can do this by going to the button on the top center of the screen that says Blender Render and switch it to Blender Game.) Next, hit **SPACE → Add → Mesh → Monkey** to create Suzanne the Monkey. Any mesh will do, but it’s the easiest of the basic meshes to intuitively determine local direction from. Next, go to the logic window (with Suzanne still selected) and toggle on ”Actor” and then ”Dynamic”. Hit **PKEY** to test. Suzanne should fall, then stop upon hitting the cube. Press **ESC** to exit.

![Figure 826](image)

### 121.2. Controls

Now we will add the controls. First, forward:

In Blender 2.59 these controls are available in the ’Logic Editor’ window.

1. Create a Keyboard Sensor, AND Controller, and Motion Actuator. Connect them by dragging lines between the dots next to their names. (In 2.59 the controller is created automatically, if the other two are connected)

2. Select the empty box next to the word ”Key” on the Keyboard Sensor and hit the up arrow key on your keyboard.

3. Set the dLoc on the Motion Actuator to 0.10 Z and toggle Local Transformation (may appear as simply an L next to the dLoc row).

Next, backward. Repeat the process used for forward, but set the dLoc to -0.10 Z and the key to the down arrow. You can repeat this for left and right if you so choose to have a linear control scheme. We will not be using such a scheme for this tutorial, but you should still be able to follow along just fine. Instead, the character will rotate left and right and move in the new forward and backward.

To rotate right:

1. As before, create a Keyboard Sensor, AND Controller, and Motion Actuator, then connect them.
2. Set the key to the right arrow and set the dRot to -0.10 Y. Repeat for left, with the left arrow and 0.10 Y.

![Figure 827](image)

Finally, the ubiquitous, and some say defining, Platformer move: the jump. Repeat the previous processes, with the space key as the trigger and the linV of the motion effect as 7.50 Z (not local). This doesn’t actually move the character in a certain direction, but sets its velocity. If you’ve done programming for games before, this will probably be familiar to you. Each frame, the engine adds the velocity of the object to its current position. The gravity portion of the engine subtracts from the upward velocity each time. When it reaches a negative, it’s adding a negative number to its altitude, ergo subtracting from it, ergo causing it to fall. This is why using linV to move the character does not cause it to immediately relocate to the target position.
122. Maze: Force and Multiple Levels

This tutorial is intended as an intermediate introduction to the Blender game engine, in the form of a game, and is the sequel to Platformer: Creation and Controls\(^1\). It will require a familiarity with the Blender UI, simple commands (such as AKEY to select) and basic modeling skills. The game we will create within Blender will have the following features:

1. a protagonist controlled by means of the WASD keys
2. a maze surface without walls
3. death on falling off the maze
4. multiple levels
5. dynamic obstacles
6. a goal within the maze that will transfer you to the next level

This tutorial was written for version 2.44 and has been tested for all later versions (as of April, 2008)

122.1. Maze Surface

Now we’ll make the maze. When you are creating the path of the maze surface keep in mind that you need a start and a goal.
1. Clear the scene; Select all (AKEY), delete selected items (XKEY → ENTER)
2. Go into top view (NUM7)
3. Add a grid (SPACE → Add → Mesh → Grid) with X and Y resolution of 16
4. Scale grid by 24 times (SKEY, type 24, ENTER)
5. Enter edit mode with the grid selected (TAB)
6. Go into face select mode (CTRL+TAB → Faces)
7. Start selecting faces so as to make a two dimensional maze (use BKEY to draw selection boxes)
8. With the faces selected, duplicate those faces (SHIFT+D, RMB)
9. Move those faces away from the original grid (GKEY or the movement wiget CTR+ALT+GKEY)
10. Delete original grid
11. Center your maze using GKEY or by pressing the Center button in the Mesh panel of the Editing buttons (F9)

You should now have a two dimensional maze. In the game engine, we only see one side of every face, so this maze will not appear to be there when seen from below, and will be obviously two dimensional when seen from the surface of the maze itself. This is undesirable so we will make our maze 3 dimensional by extruding the maze surface down.

![Image of Maze Surface](image)

**Figure 829** The extruded maze

1. Go into side view (NUM3)
2. Select all the faces (AKEY)
3. Extrude down, -1 unit (EKEY → Region), hold CTR to constrain to 1 unit increments, or manually type in the value -1, like you scaled the grid in the beginning.
4. LMB to accept the operation, or RMB to cancel the move of the faces. If you cancel it, the faces will have extruded, but will simply not have moved. You can undo the operation (CTRL+Z), or delete the vertices/faces you have extruded (WKEY → Remove Doubles).

Your maze is now complete, only lacking someone trapped in it...
122.2. Character

![Figure 830 Extruding a nose](image)

We will create a very basic character sufficient to illustrate the concepts meant to be conveyed in this tutorial. You can make a character as complex or basic as you desire, but it is important to always have an indicator of direction on your protagonist, otherwise the player may become confused. So, we will use a primitive with a 'nose' (i.e. a face or vertex extruded away from the object center in order to provide a point of rotational reference). I’ll use a cone for this tutorial, simply because they don’t roll very easily.
Figure 831  Rotate to the direction character will move

1. Enter top view (NUM7)
2. Add the cone (SPACE → Mesh → Cone, use default values)
3. Select cone and enter Edit mode (TAB)
4. Enter face select mode (CTRL+TAB → Faces)
5. Select a face on the side of the cone
6. Extrude it about 1/4 of a unit or less (EKEY)
7. Merge the extruded face to make the nose pointy (WKEY → Merge → At Center)
8. Enter object mode (TAB)
9. Rotate the cone so the nose is aligned with the positive Y axis (RKEY, align with the green arrow)

You’ve got your character now (Not exactly Pixar-like, but it will do for now). Now we just need to give it motivation.
Note: From points 8 to 9 it would seem that the cone should rotated so that the “nose” is aligned with the Y-axis in object mode, but after doing this I encountered the cone still moved in the original Y-axis direction (before rotation). To remedy this I did the alignment of the “nose” to the Y-axis in edit mode instead, this seems to have solved the problem.

122.3. Motion

We'll now make the character move, via the use of the WASD keys. In order to do this, game logic needs to be associated with the WASD keys. Copy the configuration seen in the screenshot, taking care to include the convex hull polytope collision in the top left as well as depressing the ‘L’ buttons, which make the force and torque local to that object rather than global. If the force was global, the protagonist would continue moving in a straight line, even when turning.

1. Go to the Logic buttons (The purple pac-man icon or F4 )
2. Add four Sensors, Controllers and Actuators.
3. Maximize the logic window (CTRL+UPKEY )
4. Copy the configuration seen in the screenshot below.

![Configuration Screenshot](image_url)

(Note: I made the simulation using Actor->Dynamic since there was no way to use both dynamic and rigid body in 2.49b. After some testing it appears to work correctly.)

dLoc/dRot vs Force/Torque

The character logic in this tutorial is very similar to that of the previous platformer logic, but it differs in that it uses force and torque rather than dLoc and dRot, respectively. The difference between these two is that force and torque move and rotate the object within the bullet physics engine, applying friction and collision to the process, whereas dLoc and dRot move and rotate the object without regard for any other ‘actors’ (objects factored in to the
physics engine’s calculations). Although dLoc and dRot would serve in most maze games, many other instances demand force and torque. However, most of these instances occur in more complicated games with a multitude of interactions with dynamic objects. Later in this tutorial we will add dynamic objects to our maze, and the reasons for using force will become clear.

122.4. Testing

Now the time has come for the first test of our game.

1. Add a light source well above the maze (SPACE $\rightarrow$ Lamp $\rightarrow$ Lamp ), align in front view (NUM1 )
2. Press NUM5 to enter perspective viewmode, which gives a realistic view, rather than a view in which objects stay the same size with distance. Be sure to switch back to orthographic view when you are editing (NUM5 )
3. Enter textured mode (ALT+ZKEY ) -- press ZKEY to switch back to solid view mode
4. Switch into top view (NUM7 ) or camera view once we install the camera (NUM0 )
5. PKEY to play the game
6. ESC to escape testing the game

If you receive a ”No camera” error, disregard it. We’ll be adding a camera later.

If your character doesn’t move at all make sure you drew the connecting ’wires’ between the actuators in the logic panel, as well as setting the ”Actor” ”Dynamic” and ”Rigid Body” buttons to True.

You should now have a nosy cone that speeds around the maze.
(Answer: If I understand your question right. If I used torque to turn and force to move forward and pressed forward then turned it started spinning out of control. My solution was to use rotation instead of torque.)

122.5. Falling

We will now implement the "death on falling off maze" feature. In order to accomplish this, we’ll add something that allows us to check whether the cone has fallen off the maze or not. The simplest way to do this is with a 'skydome' object the entire maze is within, and although there are a number of more elegant ways to accomplish the goal, we will use the skydome method for its simplicity to replicate. From now on we’ll need to test the maze with both layers one and two enabled (SHIFT+2KEY)
1. Add a material to your cone called coneMat (**F5**, press "Add New", Links and Pipeline, Link to Object, MA:coneMat).
2. Add a new cube
3. resize it to gargantuan proportions (**SKEY**, just large enough to encompass the maze, and all within it)
4. Move it to layer 2 (**MKEY**, **2KEY**, **Enter**)

Now that you have a massive cube, go to the logic panel and add one Sensor, Controller, Actuator set, and set them as seen in the screenshot.

1. Sensor: Touch, coneMat
2. Controller: And
3. Actuator: Scene, restart

Enable the actor button and press "ghost" this will let the dynamic obstacles, which are added later on, fall through and not get stuck there!

If you test you game now, you should see the game be restarted when you fall off the maze. As we discussed earlier, faces are one-sided in the game engine, so you should not be able to see the cube.

(Answer: The tutorial says to create the cube in layer 2, although the layer shouldn’t matter. Make sure you test the game with both layers one **and** two selected. Also double check the logic for the 'skycube')

(Answer2: I had the same problem. I fixed this by replacing the cube with a grid, scaled and placed under the maze. The grid had the touch logic mentioned above.)

(Answer3: Same here. I thought I'd remove "coneMat" from the material reference, but that wouldn’t do if the bricks fell down and touched the cube, it’d just restart the level...
the solution: create a property in the cone, a bool value named "isCone" (=true), then in the cube add a sensor 'collision' that checks for the object’s property 'isCone' and keep the rest as shown.)

(Answer4 (**to restart when block hits cube**): Do all as the pic shows you and RMB the cone and go to links and pipelines and rename the MA: to cone or whatever you want, then RMB the cube then in the Touch sensor then rename the MA: to whatever you called the other MA: . . :D this is in 24.9b)

(Answer5: For blender 2.57a you need to place a plane or something under the maze. Then give it (touch -> and -> Scene(restart)) game logic. If it isn’t working make sure that actor is selected under physics tab.)

(Question 2: How do I make the box translucent? Right now all I see, also when testing, is the skybox. Also, when I put the box underneath the maze, it works fine, but then none
of the objects have shading, while when not showing layer 2 everything looks shaded. Can anybody give a solution? This is in 2.48a)

(*Answer*: To make something transparent- press **F5**; press the "Material Buttons" button; under the Links and Pipeline tab press Halo and ZTransp, unpress Shadbuf; under Material make A 0.000.)

(*Answer 2*: My solution was to press the Invisible button (Logic section, next to Ghost in 2.49))

[note: in 2.7X the touch sensor seems to have gone, my workout was to use a collision sensor, AND controller, and scene actuator with mode: restart and added no game property]

I have put in a new way to die. Add a static Plane, give it a property called Killer and place it just below the level. Add an ALWAYS sensor and connect it to a MOTION actuator that has 0.01 as the top last value. This way it will slloooowly come up. Now, select the player and add a COLLISION sensor. For the property, add Killer. Connect it to a GAME actuator, select Start New Game. You’ve just added some tension to your game! If you run out of time, you will touch the floor and restart! If you need more time, just put another 0 in 0.01 so it will look like 0.001 Sorry if you can’t understand it very well, this is the first time I edited a page on Wikipedia + I don’t speak English very well. Have fun! :)

### 122.6. Camera

**SPACE → Camera** near the protagonist cone. There are two easy ways to do the camera: logic camera and child camera. In this case you might be better off with the logic camera, but it really is a matter of personal preference.

- **Logic Camera**: Add to the camera’s logic panel
  1. Sensor: Always
  2. Controller: And
  3. Actuator: Camera, to object "Cone" (or whatever your protagonist is called—look under the object panel when you have the protagonist selected) height 5, min 5, max 10.

- **Child Camera**: Select the camera, then select the protagonist (order is important) then **CTRL+PKEY** to parent the cone to the camera. Align the camera in a view that you like, and test the game.

- **First Person Camera**: Well, this one doesn’t really count as another method, but if you’re willing to redo your motion to just move the camera instead of the character, (just do everything you did for the character for the camera) you can run around in the first person. Or you can just put the camera in the cone because one of the sides always are invisible (look in texture mode) and parent it to the cone. REMEMBER: To access the ingame camera during gameplay, before you start, hit ctrl 0 or you can go to (view > camera)

(*Answer*: Ctrl+0 assigns the selected object as a camera. To solve your problem select your camera and press ctrl+0, to enter camera view press 0)
122.7. Beautification

Blender is a great 3D modeling program, and with such a vast number of tools at your disposal, you should be able to make your game look better than this:

![Figure 835](image)

We’ll add one or two textures to each of our objects.
Figure 836  Press the 'new' button then the 'assign' button to assign a material to a number of faces

1. Select the object you want to texture
2. Go into edit mode if you want your object to have more than one color
3. Select all the faces you are going to assign to a color (CTRL + TAB \rightarrow Faces )
4. Go to the edit panel (F9 ) on the buttons window
5. Near the left there should be a panel that says "Link and Materials". Click on the buttons highlighted in the screenshot
6. Adjust the color of that material by going to the material buttons and changing the "Col" (color) value to something other than white
It looks better now, but when the camera is nearly horizontal, you can see where the camera stops rendering the maze. You can fix this by selecting the camera and, in its edit buttons, changing its clipping range... but there is a better way. Mist.

Mist obscures everything a certain distance away, is the same color as the world texture, and can be handy. We’ll add some mist to our game so the player can’t see too far ahead of him, thus making the game too easy.
We'll make the mist quite close, although you can vary the distance. Go to the Material button, and to the World sub-buttons, then copy the settings in the screenshot. **When you test this out, make sure you are in texture mode to see the mist.**

![Screenshot of material settings](image)

**Figure 839**

*(Answer: Change Start to a smaller value like 15.)*

*(Question: Is the screenshot correct, or are my sizes different. I found that a mist distance of 10 was barely visible, yet a distance of 1 had a much better effect. Is this normal?)*

*(Question: I have been able to create the mist, and can see it when I start the game, but the background colour is still grey, so the maze is obscured everywhere else is still grey.)*

### 122.8. Levels

Now all that remains is to create the next level with some obstacles.

1. Add a cube at the end of the maze, just above the floor level so the cone can touch it  
   *(SPACE → Add → Mesh → Cube)*  
2. Press the Scene dropdown menu and select "ADD NEW" → *Full copy*  
3. You can now go back to the Maze Surface section to make a new maze mesh  
4. Go back to level one via the Scene menu  
5. Select the End of level cube  
6. Change its logic panel to resemble this:

   - Sensor: Touch, coneMat  
   - Controller: And  
   - Actuator: Scene, Set Scene, Scene.001 (or whatever you named your level 2)

*(noob: In my level 2 my cone hits the cube and nothing happens!)*  
*Answer: Make sure that the Sensors, Controllers and Actuators tabs under the Logic panel (F4) are connected with wires.*

*(noob: When I went to level two I can’t see anything!)*
To make it so multiple objects have to be touched (or acquired by the character, as it may be), give each object the logic settings described above and change the actuator type to Message with the subject "goalget". If you’d like the object to disappear after it is collected, add an Edit Object actuator to the object of the type ”End Object”, and link it to the existing AND controller.

Next, select the massive cube that restarts the level upon contact with the character. If you chose not to include one such cube, create an empty at the start of the level (so you can easily find it again later). Give the cube or empty the following logical operators:

- Sensor: Message, goalget
- Controller: And
- Actuator: Property, Add, wincon, -1
- Sensor: Property, Equal, wincon, 0
- Controller: And
- Actuator: Scene, Set Scene, Scene.001 (or whatever you named your level 2)

Then click ”Add Property” and give it the Type Int, the Name wincon, and a value equal to the number of objects needed to be collected to complete the level (if all of them, make it equal to the number contained in the level). This can be expanded to include other multiple win conditions besides the collection of an item by making the completion of each condition subtract from ”wincon”.

You now have a multilevel maze game. Feel free to elaborate on the gameplay mechanics and models so they look better.

Noob note: I typed in where i thought everything should go but it’s not doing anything. I’m not sure of what I’m looking for while in playmode.

122.9. Dynamic obstacles

This part of the tutorial will assume increased skills and knowledge of the Blender interface and basic commands. As such, this section will be written less specifically, and the shortcuts for all basic commands will not be covered here. From this point on, this tutorial is of an
intermediate level. If you cannot follow this part of the tutorial, you can learn the basic functions used below in an earlier tutorial\(^2\).

We will now add some dynamic obstacles. In this case, they will constitute a 'brick' wall that can be broken through by your character.

1. Add a cube
2. Scale it (in edit mode) to the dimensions 1,0.5,0.5
3. Bevel it (WKEY) recursion 1, size 0.03 (press space to enter value manually)
4. In logic panel, set it to Actor, Dynamic, Rigid body, Mass 0.5
5. Go right below that to click Bounds and leave it on "Box". That makes Blender realize that what you added is a box, and should act like it (instead of rolling, it will slide now)
6. Move it to an intersection in your maze (GKEY) and duplicate it until you have a brick wall (ALT DKEY, LMB)

---

\(^2\) http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Learn_to_Model
You now have a barrier that your character can break through.

By using this

122.10. Conclusion

You have now learned enough of the Blender Game Engine (BGE) to create your own game. If you wish to go very far into Blender games, I recommend you learn Python, as trying to make a full game within the graphical interface for the BGE is like trying to dig a grave with the blunt half of a toothpick. Blindfolded. And the toothpick is glued to your forehead. However, you are now well on your way to becoming a game-maker! For a basic beginner tutorial about Python, "Open Source Video Game" series.

If you have any questions, concerns, or 'noob notes', please post them in the discussion page for this tutorial, and not in the tutorial itself.

123. Platformer: Improving the Physics

This tutorial is intended as an improvement on its prequel, Platformer: Creation and Controls\textsuperscript{1}, and will require files created through that tutorial. It is also recommended that you read An aMAZEing game engine tutorial\textsuperscript{2} as well before beginning this tutorial. It will require a familiarity with the Blender UI, simple commands (such as AKEY to select) and basic modeling skills. This tutorial will introduce the following features and improvements:

1. only letting the character jump while touching the ground
2. stop the character from bouncing greatly upon hitting an object
3. where to adjust material friction

This tutorial was written for version 2.45.

123.1. Creating Your Hit Test Object

Copy the cube with \textbf{SHIFT-D}. Go into edit mode, select the bottom four vertices of the cube and delete them. Go back to object mode. Go to the editing panel in the buttons window. In the Link and Materials section, change the ME: value to "Square" and the OB: value to "FloorHit". In the Mesh section, there will be three buttons with the word "center" in them; Center, Center New, and Center Cursor. Press Center New. This will change the origin of the "Square" mesh to the center of all of its vertices, instead of the center of the cube you made it from. Scale it to 0.99% of the original and move it up 0.01 along Z. Now go to the shading panel and make sure you're in the Material buttons subpanel. Find Links and Pipeline, and make sure "ME is selected. Click the X next to the material selection (under the words "Link to Object"). Then select "OB" and press "Add New" and name this material "FloorHit" (again, no quotes). Make it green colored, so you can easily find it while editing, but turn on "Shadeless" and "No Mist" in the Material section and "OnlyCast" in the Links and Pipeline - Render Pipeline section and turn off "Radio", "Traceable", and "Shad(ow)buffer" in the Render Pipeline and "Shadow" in the Shaders section. This will make it completely invisible at runtime and take up little resources.

(question: it wont make it invisible it just flashes rapidly)

123.1.1. Making the sensor require floor contact

Now select Suzanne and go to the logic panel. Add a touch sensor called "jumpcol" (for 'jump collision') and connect it to the same AND controller as the jump keyboard sensor.

\textsuperscript{1} Chapter 121 on page 967
\textsuperscript{2} Chapter 122 on page 971
Set the f to 10 and the MA: to FloorHit. This will make it so your character can only jump while it’s touching something with the FloorHit material. By that same token you can link this to all of your movement-related AND controllers so that the player can’t adjust it’s movements in mid-air. This is a nice physics touch but for most platformer games, where mid-air dexterity is almost essential, it doesn’t work. You also have to use Force and not dLoc, otherwise your character won’t be able to move at all while jumping, useless your character only needs to hit things with his/her head, and not jump over gaps. Note that this still does not keep the character from jumping while touching the hit test object at the sides, so they could still jump if they were touching the side of the collision surface, but at least they can’t jump in mid-air or while touching the bottom of the ground. I have yet to find a solution to this problem not involving Python.

123.2. Excessive Bouncing

Another problem with the original model, as you might have noticed, is that when you run into one of the ground cubes you bounce back a great deal. To fix this, turn to the materials panel with one of your green hit test squares selected. Under the color selectors there should be three buttons that say "RGB", "HSV", and "DYN". Select DYN, and turn the restitution most or all the way up. As you can see, you can also find the friction property from here, if you want your ground to be more or less frictional (like mud or ice).

123.3. Final Notes

Always copy your floors, their respective hit test objects, and other generic objects with ALT-D and not SHIFT-D. This keeps you from duplicating things that remain the same for every one, like the material and mesh, which quickly drain resources if not recycled. Since there’s not much further you can take the Platformer without learning Python, I suggest you start looking up information on the Blender API. Some essential information is to be found in the procedural object creation\(^3\) tutorial. A Blend file of the tutorial’s finished product is coming soon.

Note: A (possibly) simpler method for jump limitation can be found on the discussion page for this tutorial.

124. How to Make an Executable

This tutorial will show you how to make an executable for your game made in Blender.

Note: The methods listed in the "Windows" and "GNU/Linux or Mac OS X" sections work only for the operating system you are on when you create the file. To make it cross platform, use the "BlenderPlayer" method.

124.1. Windows

First create a folder that will hold all your game information. Name it something meaningful, like "Yo Frankie!".

The folder must contain four files that you can copy from your blender installation directory (under windows it should be "C:\Program Files\Blender Foundation\Blender") They are:

1. SDL.dll
2. python24.dll (Or other relevant python file; python25.dll, python26.dll etc.)
3. pthreadVC2.dll
4. zlib.dll

(sometimes you will need the following also...)

1. avformat-51.dll
2. avutil-49.dll
3. avcodec-51.dll

They are in the same folder.)

Not quite a Noob Note: If you are using the latest version of Blender you WILL need the following files)

I am running windows xp media edition and blender 2.46, here is a full list of files i needed:

1. avcodec-51.dll
2. avformat-52.dll
3. avutil-49.dll
4. libfaac-0.dll
5. libfaad-0.dll
6. libmp3lame-0.dll
7. libx264-59.dll
8. pthreadVC2.dll
9. python25.dll
10. SDL.dll
11. swscale-0.dll
12. vcomp90.dll
13. xvidcore.dll
14. zlib.dll

On Blender 2.48a (Windows XP Media Center 2002, SP3), these .manifest files are also required:

1. blender.exe.manifest
2. blenderplayer.exe.manifest
3. Microsoft.VC90.CRT.manifest
4. Microsoft.VC90.OpenMP.manifest

If you use random Python module in your game, you will have to add one more file to your game directory. For Blender 2.49 it would be python26.zip, which you can find in Blender main directory (where blender.exe is). Otherwise there may be some errors during executing the game in system without installed Python.

Since Blender 2.56 you will need to enable Save As Runtime; first open blender with the game that you have created and open the file menu. Click on User Preferences then select Add Ons then Game Engine, check the box Game Engine Save As Runtime and return to the file menu. Save As Runtime will appear as an option in the export menu then save to the new folder that you have created and rename the file yourgamenamexe.exe, and then you can run the game!

If you encounter errors during the "Save As Runtime" process (I'm on Windows 7) you can right click on the Blender icon and select "Run as administrator". So you will have your fresh .exe and you can spread it with a piece of your favourite pepperoni pizza.

124.1.1. Making A Screensaver (Windows Only)

1. First, save your runtime (that’s the .exe addressed above.) via File->Save Game as Runtime. ("Save Runtime" in older versions)
2. Now, go to your .exe game and rename it .scr - for instance, if your game was Not-MyGame.exe, rename it to NotMyGame.scr. You can now right click to Install it, and then use it as your regular screensaver by applying it as you would any other screensaver (right click on desktop, properties... You know the drill.)

Screensavers are not games, and so they should not accept input. At most, they should be videos showing what your game does. If you just rename your regular game as a .scr, it will be remarkably boring, because your game needs input and screensavers do not.

124.1.2. Intel screensaver bug

There is a caveat with Intel Integrated Graphics drivers, found in many laptops though. The graphics driver shuts off OpenGL acceleration for screensavers, for some obscure reason. The way to work around this is to rename the .scr extension to a .Scr as the driver’s algorithm is dependent on case-sensitive characters. If you experience very low framrates in your screensaver, you should attempt this fix, It is tested and reported to work.
124.2. GNU/Linux or Mac OS X

Open blender with the game that you have created and open the file menu. Click on **Save Game as Runtime** and then save to the new folder that you have created and rename the file yourgamename...

and then you can run the game!

124.3. BlenderPlayer

The methods shown above only create an executable for your operating system. Well, BlenderPlayer can fix that.

1. Make a new folder to store all your game data.
2. Then save your .blend file into the directory.
3. You can skip this step and the next step if you do not want a Windows version. For the Windows users, copy blenderplayer.exe to the new folder from a Windows copy of Blender. Then copy all your DLL files for Blender as mentioned for Windows to the folder.
4. Next you have to make an MS-DOS batch file (for UNIX users, this is the shell script equivalent). In a simple text editor, in CR-LF mode if available (Notepad is always in this mode, and NOT a word processor!), copy and paste this text:

   `blenderplayer.exe yourgamename.blend`

   Save it as YourGameName-Windows.bat in your game folder.
5. You can skip this step if you do not want a UNIX (basically Mac OS X and GNU/Linux) port. For GNU/Linux (at least), make a shell script. (A shell script is the UNIX term for a batch file.) In a simple text editor, in LF mode (unfortunately Notepad can’t be used), copy and paste this text:

   `#!/bin/bash
   ./blenderplayer.app/Contents/MacOS/blenderplayer yourgamename.blend`

   Save the file as YourGameName-UNIX.sh in your game folder. You will need to have BlenderPlayer in the same directory as the .blend game file.
6. Write a readme for your program. This is again best done with a simple text editor like Notepad or gedit, but it does not matter which mode it is in. You should include the name of the game, a description, perhaps a walkthrough or hints, and if you made a *NIX port, mention that it requires BlenderPlayer, available with Blender.

124.4. Legal Issues

Blender and the BlenderPlayer fall under the GNU General Public License. Blend files are copyrighted to their respected owners and do not fall under the GPL as long as they are not packed in the BlenderPlayer. If a user does not want the blend files to fall under the GPL, it is recommended not to use the "Save Game as Runtime" feature. To put it another way, the user must keep the blend files and the BlenderPlayer in separate files. More information can be found at [http://www.blender.org/education-help/faq/gpl-for-artists/](http://www.blender.org/education-help/faq/gpl-for-artists/). (Blender 2.4 now has a run game from file actuator.)
124.5. Proprietary Blend Files

Blender has no built-in functionality to "lock" or protect user generated content. As a result, anyone who has Blender can open and/or modify blend files. However, it’s still possible to lock blend files. Common methods involve encrypting the blend file and then temporary decrypting it at runtime. This can be accomplished by using python scripts or by using external 3rd party applications (which are feasible under the GPL v2).
125. Build a Skybox
126. Basic Mouse Pointer
127. Text in BGE

There are a lot of tutorials that show how to make text for the Blender Game Engine, for example to use in menus. Most involve editors, graphics programs, TGA files, UV mapping, scripting, higher magic and so on. Here is a different approach that takes but a minute.

1. Start Blender.
2. Remove the default cube. (X)
3. Add text. (SPACE → Add → Text)
4. You may want to switch to edit mode (TAB) and use the variety of features that Blender provides for editing, formatting and laying out text. They are described in the Blender Manual Section. For a start just use BACKSPACE to delete the letters "Text" and type your own like "This is simple".
5. When finished editing go back to object mode. (TAB)
6. Convert your text to a mesh. (ALT+C → Mesh)
7. Press P

This is as simple as it gets. Of course you can do all kinds of laying out with your text before the conversion in step 6 (check the Blender Manual) as well as modeling, texturing and dynamically manipulating thereafter (as you have a normal mesh). Simply remember that you need to make sure the text is final before you convert it.

This tutorial has been tested with Blender 2.8 RC1.

"However, it should be pointed out that while this is so incredibly simple, it is not poly-count efficient. Remember, there is more to making a game than making it look good--making it run well. If you need a cut-and-dry menu, this is the best way. If you need to worry about performance, then it might be worth it to check out some UV Mapping and external program usage. -- Bullercruz1 (talk) 23:07, 7 February 2009 (UTC)"

It is also important to note that these fonts can’t be dynamic, contrary to bitmap-uvmapped ones...

- How to create Dynamic Text in Blender Game Engine (Youtube)

---

2 http://en.wikibooks.org/wiki/User%3ABullercruz1
3 http://en.wikibooks.org/wiki/User%20talk%3ABullercruz1
4 http://www.youtube.com/watch?v=kcGly1__QsA
128. Platformer: Creating the Engine with Python

Note: Python code is placed in a Text Editor window. It might be helpful to split your 3D View window into a separate part, so that you can use a buttons, 3D view, and text editor window simultaneously.

The initial stages of the Python Platformer tutorial series will mostly have to do with replicating what was done in the logic board Platformer tutorials. If you have not read and understood those tutorials, you may not understand exactly what the function of most of this code is. This tutorial details:

1. An explanation of the "code sections" to be modified, rewritten, or redefined frequently throughout the series
2. Creating an object linked to a pre-made mesh
3. Linking an object to a scene

and will detail by completion:

1. How to move an object in response to keyboard triggers

128.1. Code Sections

We will refer to the sections of the code in this manner throughout the series:

128.1.1. Import Section

The series of import commands at the beginning of the piece of code, like the contents of the head tag in HTML documents. Python has a basic set of commands kept naturally in the language, and the rest are imported so that a large amount of commands aren’t loaded when not needed, causing unnecessary memory expenditure. This lends the advantage of being able to extend the language by writing custom sets of commands to be imported into Python, which is how Blender interfaces with Python. For this tutorial, our import section is:

```python
import Blender
import bpy
```

When you import something as something else, it basically creates a variable equal to the imported module’s name, so that you don’t have to type it out. It is inessential, but it makes the coding go faster. You might want to run a find and replace search on your document afterwards, replacing all instances of the name you imported it as with the real module’s
name and deleting the part that imports the module by another name, as this can make the code run slightly faster.

128.1.2. Essential Footer

This is the collection of commands that you must remember to include at the end of the document, regardless of any changes made to the code, for it to work. It must be noted whether you should change the entire footer (as if a feature was removed from the main code-in-progress) or adding a command to your existing footer (if the text deals with the addition of a single feature). Every article in the main tutorial line should contain the full footer as it should look at that point in the series. For this tutorial, our essential footer is:

```
Blender.Redraw()
```

128.2. Adding the Player Object

To start, create a new document and delete the basic cube. Create a Monkey/Suzanne. In the Editing panel with the monkey selected, change the mesh name (ME:) under Link and Materials to "Hero". Click the F next to the input box to preserve the data block even when nothing links to it. Now delete the monkey object.

The following code will create an object called "Player" in the library and link it to the Hero mesh:

```
player = Blender.Object.New("Mesh","Player")
player.link(bpy.data.meshes["Hero"])
```

In the first line, Blender.Object.New obviously references a new object. The "Mesh" variable should not be changed for the purposes of this code. I don’t know exactly it’s function, so I don’t want to give out misinformation, but I speculate that it has to do with the object type. If the object were to be a lamp or camera type, for example, you would not be able to apply a mesh to it. The second variable, "Player", is the name of the actual object you’re creating. Change it to your liking.

In the second line, we link player (which was equated to our new object) to the pre-existing mesh "Hero", which is the Suzanne mesh we dealt with before. Using this method, you can model your character’s mesh beforehand but have the actual character created dynamically. Using a complication of this code, you can make player.link() link to a variable and not the bit "bpy.data.meshes[["Hero"]]". That variable can reference an existing mesh or it can create a new one. As for the meaning of the link’s value, bpy.data.meshes is an array containing all the meshes in the movie. Likewise, bpy.data.objects contains all the objects in the movie. By going to the Scripts window and going to Scripts->System->Interactive Console you can gain such information as the contents of these arrays. By entering "list(bpy.data.objects)" into the console, you will be rewarded with a list in the format of [[Object "Camera"], [Object "Cube"], [Object "Lamp"] which is the list of objects in the standard new document set-up. So, to reference the item [Object "Cube"] you would use the line "bpy.data.objects["Cube"]" and so on. For these commands to work, you must make sure to import bpy in your import section.
**128.2.1. Appending the Object to the Scene**

Like you must append the mesh to the object, you must also append the object to the scene, or it will just be a floating data block and not actually appear anywhere.

```python
scene = Blender.Scene.GetCurrent()
scene.link(player)
```

If you were to test this code by pressing **ALT-P** while the mouse is hovering over the Text Editor window, it would create an object named Player with the monkey "Hero" mesh at the origin point of your scene. Make sure you included this tutorial’s import section before all of the other code and the essential footer after all of other code.

**version 2.7:**

```python
import bpy

myMesh = bpy.data.meshes["Hero"]  # reference existing mesh
player = bpy.data.objects.new("Mesh", myMesh)  # create new object
player.name = "Player"  # give it a name
bpy.context.scene.objects.link(player)  # link to the scene to show
```
Part IV.

Unit 4: Taking Off with Advanced Tutorials
129. Introduction

Python is a powerful, high-level, dynamic language. The version of Python used in Blender 2.67 is 3.3. If you are unfamiliar with Python, start with the Python book\(^1\). If you are familiar with older (2.x) versions of Python, this page\(^2\) summarizes what’s new in 3.x.

If you are familiar with Python scripting in older versions of Blender, be aware that 2.5x/2.6x is completely different; the old Blender module is gone. Much of the functionality is now available through the bpy module, but don’t expect an exact 1:1 correspondence.

129.1. First Steps In Blender Scripting

Open a new, default Blender document. If you haven’t customized your settings, there will be a Timeline

---

2. http://docs.python.org/py3k/whatsnew/3.0.html
Figure 842

window along the bottom; change this to a Python Console
To start with, let’s find out what objects are present in the document. At the “>>>” prompt, type

```
import bpy

bpy.data.objects
```

You should see the response

```
<collection[3], BlendDataObjects>
```

which isn’t actually all that informative. In fact what you have here is an iterator; to see its contents, just do the usual Python thing and convert it to a list. Try entering this:
list(bpy.data.objects) # or being lazy: bpy.data.objects[:]

This time the response should be

[bpy.data.objects["Camera"], bpy.data.objects["Cube"], bpy.data.objects["Lamp"]]

which shows you how to refer to the three default objects you can see in the 3D View window.

Let’s get a reference to the Cube object for more convenient access: type

Cube = bpy.data.objects["Cube"]

Now let’s try querying the value of one of its attributes: type

Cube.delta_location

You should see the response

Vector((0.0, 0.0, 0.0))

The Vector type comes from the mathutils module provided by Blender. But unlike bpy, this is not automatically imported into the Python Console. So let’s bring it in for subsequent use: type

import mathutils

OK, now let’s try changing the location of the default Cube: type

Cube.delta_location += mathutils.Vector((1, 1, 1))

(Note the doubled parentheses: mathutils.Vector takes a single argument, which is a tuple of X, Y and Z coordinate values.)

Were you watching the 3D View when you pressed ENTER? You should have seen the cube jump to a different position. To make it move again, press UPARROW to bring back the above command, so you can execute it again with ENTER. As soon as you do this, the cube will jump another step, like before. And that’s it—you’re scripting!

129.2. The bpy Module

The contents of the bpy module are divided into several submodules (actually classes, but never mind), among which are:

- bpy.data — This is where you find the contents of the current document.
- bpy.types — information about the types of the objects in bpy.data.
- bpy.ops — operators perform the actual functions of Blender; these can be attached to hotkeys, menu items and buttons. And of course they can be invoked from a script. When you write an addon script, it will typically define new operators. Every operator must have a unique name.
• **bpy.context** — contains settings like the current 3D mode, which objects are selected, and so on. Also accessible in the Console window via the global variable C.
• **bpy.props** — functions for defining properties. These allow your scripts to attach custom information to a scene, that for example the user can adjust through interface elements to control the behaviour of the scripts.

### 129.3. The mathutils Module

The module mathutils defines several important classes that are used heavily in the rest of the Blender API.

• **Vector** : the representation of 2D or 3D coordinates.
• **Matrix** : the most general way of representing any kind of linear transformation.
• **Euler** : a straightforward way of representing rotations as a set of Euler angles, which are simply rotation angles about the X, Y and Z axes. Prone to well-known pitfalls such as gimbal lock.
• **Quaternion** : on the face of it, a more mathematically abstruse way of representing rotations. But in fact this has many nice properties, like absence of gimbal lock, and smoother interpolation between two arbitrary rotations. The latter is particularly important in character animation.
• **Color** : a representation of RGB colours and conversion to/from HSV space (no alpha channel).

### 129.4. See Also

• Blender User’s Manual section on scripting
• Blender 2.67 API Reference
• Blender site Python scripts catalog
• Blender Addon Tutorial by Campbell Barton
• Scripting forum on blenderartists.org

---

7 https://github.com/ideasman42/blender_addon_tutorial
130. Anatomy Of An Addon

An *addon* is a Python script that can extend the functionality of Blender in various ways. It can reside in a file within your Blender user preferences directory, or it can be stored in a text block within the Blender document. In the former case, the addon needs to be *enabled* in each Blender document where you want to use it, by ticking the checkbox in its entry in the Add-Ons list in the User Preferences window for that document. In the latter case, the script can be run by pressing `ALT + P` in the Text Editor window; or you can tick the “Register” checkbox for that script in the Text Editor, to have the addon be automatically enabled as soon as the document is loaded into Blender.

The main thing an addon script typically does is define one or more new *operators*. All the user-interface functions in Blender are performed by operators; these are invoked by being associated with menu items, buttons or hotkeys. Each operator is a subclass of the `bpy.types.Operator` class. The name you give your class in Python is immaterial outside the script where it is defined; it will be referred to from the rest of Blender via its *operator name*, which must be unique within the document. In the same way, your script can invoke other operators defined elsewhere via Blender API functions that take their operator name.

130.1. Text Blocks

A Blender document can contain *text blocks*, which are not the same as *text objects* in a 3D scene (though the former can be converted to the latter). Besides generating text objects, a text block can serve any purpose you like; for example, use it to pass workflow instructions to a colleague along with the document; display a copyright or help message in the initial layout that a user sees on opening the document; or hold a Python script that can be run by the user to perform some useful action related to the document.

130.2. Your First Operator

Open a new, empty Blender document. Bring up the Text Editor
in any convenient window; you will see an empty, grey rectangle. Before you can type in
text, you need to create a text block; do so by clicking the large button labeled “New” in
the window header. As soon as you do this, you should see a popup menu appear listing all
the text blocks in your document, with the current (only) entry named “Text”. You should
also see a red insertion cursor appear at the top left, indicating that you can start typing.

Unlike the Console Window, nothing is automatically imported for you. So as in any other
Python script, you need to mention every module you want to access.

You define your operator as a subclass of a subclass of the bpy.types.Operator. It must
have a bl_idname class attribute which gives the operator name, while bl_label gives the
user-visible name that appears in the spacebar menu. The former must have valid Python
syntax for a name, including a single dot; the part to the left of the dot must be the name
of one of the valid categories of operators, which you can find by typing
Let's define an operator that will add a new tetrahedron object to the document. The class definition should start something like this:

```python
class MakeTetrahedron(bpy.types.Operator):
    bl_idname = "mesh.make_tetrahedron"
    bl_label = "Add Tetrahedron"
```

It has to define an invoke method, which starts off like this:

```python
def invoke(self, context, event):
    return "FINISHED"
```

Anyway, let us compute the coordinates of the vertices for the tetrahedron: with edges with a length of 1 Blender unit, suitable values are $(0, -\frac{1}{\sqrt{3}}, 0)$, $(\frac{1}{2}, \frac{1}{2\sqrt{3}}, 0)$, $(-\frac{1}{2}, \frac{1}{2\sqrt{3}}, 0)$ and $(0, 0, \sqrt{\frac{2}{3}})$. Or in Python:

```python
Vertices = [
    mathutils.Vector((0, -1 / math.sqrt(3), 0)),
    mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
    mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
    mathutils.Vector((0, 0, math.sqrt(2 / 3))),
]
```

Then we create the mesh database, giving it the name “Tetrahedron”:

```python
NewMesh = bpy.data.meshes.new("Tetrahedron")
```

Fill it in with the above vertex definitions and associated faces:

```python
NewMesh.from_pydata(
    Vertices,
    [],
    [[0, 1, 2], [0, 1, 3], [1, 2, 3], [2, 0, 3]]
)
```

The Mesh.from_pydata method is not currently well documented in the Blender API, but its first argument is an array of Vector defining the vertices, the second argument is an array of edge definitions, and the third argument is an array of face definitions. Each edge or face is defined as a list of vertex indices (2 elements in each list for an edge, 3 or 4 for a face), 0-based in usual Python style, being indices into the array of vertex definitions that you passed. Note that you pass either the edge definitions or the face definitions,
but not both: the other one should be passed as the empty list. If this function is not used correctly, it will cause Blender to crash.

We also need to add the following, to tell Blender the mesh has changed and needs updating (as if it couldn’t figure it out itself):

```python
NewMesh.update()
```

(Omitting this produces a minor quirk: right-clicking the newly-created tetrahedron does not highlight its outline in orange as with other objects, though the problem goes away if you enter edit mode on the object and exit again.)

Now to create the object datablock (I also give it the name “Tetrahedron”), and link it to the mesh:

```python
NewObj = bpy.data.objects.new("Tetrahedron", NewMesh)
```

But the object will not appear to the user until it is linked into the scene:

```python
context.scene.objects.link(NewObj)
```

To recap, here is the complete script:

```python
import math
import bpy
import mathutils
class MakeTetrahedron(bpy.types.Operator):
    bl_idname = "mesh.make_tetrahedron"
    bl_label = "Add Tetrahedron"
    def invoke(self, context, event):
        Vertices = [
            mathutils.Vector((0, -1 / math.sqrt(3), 0)),
            mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
            mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
            mathutils.Vector((0, 0, math.sqrt(2 / 3)) ),
        ]
        NewMesh = bpy.data.meshes.new("Tetrahedron")
        NewMesh.from_pydata(Vertices, [], [0, 1, 2, 0, 1, 3, 1, 2, 3, 2, 0, 3])
        NewMesh.update()
        NewObj = bpy.data.objects.new("Tetrahedron", NewMesh)
        context.scene.objects.link(NewObj)
        return "FINISHED"
#end invoke
#end MakeTetrahedron
bpy.utils.register_class(MakeTetrahedron)
```

Note the addition of the register_class call, to make Blender add your operator to its built-in collection.
Now execute your script by typing `ALT + P`. If all goes well, nothing should appear to happen; Blender will define the class and register it as a new operator as you requested, ready for use.

If you hit any syntax errors, Blender should display these in a popup window; go back and correct them, and re-execute the script with `ALT + P`.

### 130.3. Invoking Your Operator

We haven’t (yet) defined any user interface for this operator; so how do we invoke it? Simple.

Go to a 3D View window. Delete the default cube to avoid it obscuring things, and press `SPACE`. This brings up a searchable menu of every operator defined for the current document. Into the search box, type part or all of the string you defined for the bl_label attribute above (typing “tetra” should probably be enough). This will restrict the menu to only showing items that contain that string, which should include the name of your operator; click with `LMB` on this or highlight it and press `ENTER`. If all goes well, you should see your tetrahedron object appear!

![Figure 845](image_url)
130.4. If You Hit An Error

If there is any error compiling or running the script, Blender should display this in a popup. For example, the following simple one-line script

```python
raise RuntimeError("Uh-oh")
```

displays this popup:

![Error popup](image)

**Figure 846**

The full Python traceback message is written to Standard Error, and looks something like this:

```
Traceback (most recent call last):
  File "/Text", line 1, in <module>
RuntimeError: Uh-Oh!
```

On Linux/Unix systems, the message will appear in the terminal session if you invoked Blender from the command line; otherwise it will be appended to your `~/.xsessionerrors` file if you launched Blender from a GUI. On Windows the message appears in the console window.
131. A User Interface For Your Addon

So you’ve defined a new operator in your addon. Now it would be nice to give that addon a proper interface, so the user doesn’t have to hunt through the spacebar menu to find that operator.

The nicest way to do this is to define a panel that shows up in a window somewhere, with controls in it that the user can click on to operate your addon. You can put the panel in all kinds of places, but here we will insert it in the Tool Shelf (which can be hidden or shown on the left side of the 3D View by pressing T).

131.1. Your First Panel

A panel is defined by subclassing the bpy.types.Panel class. You set the value of various attributes (bl_space_type, bl_region_type, bl_category and bl_context) to determine the context in which the panel will appear, and also give a title to the panel (bl_label):

class TetrahedronMakerPanel(bpy.types.Panel):
    bl_space_type = "VIEW_3D"
    bl_region_type = "TOOLS"
    bl_context = "objectmode"
    bl_category = "Create"
    bl_label = "Add Tetrahedron"

Those first three attributes cause the panel to appear in the Tool Shelf, but only while the 3D View is in Object mode. The bl_category line determines the toolbar tab the addon is placed in, and only applies to the toolbars with tabs (added 2.7). Specify any existing tab, or define a new one.

Your class also needs to define a draw method, which defines the items that go into the panel. This example creates a new column of UI elements for the panel, and inserts a single UI element which is a button that will invoke the operator with the name you previously defined when clicked:

def draw(self, context):
    TheCol = self.layout.column(align=True)
    TheCol.operator("mesh.make_tetrahedron", text="Add Tetrahedron")
#end draw
131.2. Adding Undo Support

While we’re at it, go back and add the following line to the operator definition:

```python
bl_options = {'UNDO'}
```

This allows the user to undo the addition of the tetrahedron in the usual way with `CTRL + Z`, and redo it with `CTRL + SHIFT + Z`.

131.3. Put It All Together

Here is the complete script for the addon as it stands now:

```python
import math
import bpy
import mathutils

class TetrahedronMakerPanel(bpy.types.Panel):
    bl_space_type = "VIEW_3D"
    bl_region_type = "TOOLS"
    bl_context = "objectmode"
    bl_category = "Create"
    bl_label = "Add Tetrahedron"

def draw(self, context):
    TheCol = self.layout.column(align=True)
    TheCol.operator("mesh.make_tetrahedron", text="Add Tetrahedron")
#end draw

#end TetrahedronMakerPanel

class MakeTetrahedron(bpy.types.Operator):
    bl_idname = "mesh.make_tetrahedron"
    bl_label = "Add Tetrahedron"
    bl_options = {'UNDO'}

    def invoke(self, context, event):
        Vertices = [
            mathutils.Vector((0, -1 / math.sqrt(3),0)),
            mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
            mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
            mathutils.Vector((0, 0, math.sqrt(2 / 3))),
        ]

        NewMesh = bpy.data.meshes.new("Tetrahedron")
        NewMesh.from_pydata(Vertices, [], [[0, 1, 2], [0, 1, 3], [1, 2, 3], [2, 0, 3]])
        NewMesh.update()
        NewObj = bpy.data.objects.new("Tetrahedron", NewMesh)
        context.scene.objects.link(NewObj)
        return {'FINISHED'}

    #end invoke

#end MakeTetrahedron

bpy.utils.register_class(MakeTetrahedron)
bpy.utils.register_class(TetrahedronMakerPanel)
```
Note the addition of another register _class call for our custom panel.

As before, hit \texttt{\textasciitilde ALT} + \texttt{P} to execute it. Nothing should appear to happen; Blender processes your subclass definitions, and registers them for use, as requested, in the appropriate places.

But now, go back to the 3D View. Make sure you are in Object mode. Bring up the Tool Shelf if it isn’t visible, by pressing \texttt{F}. At the bottom; in the tab you have specified, you should see your new panel appear:

![Add Tetrahedron Panel](image)

Figure 847

Note the triangle next to the title that Blender automatically gives you, to collapse or expand the panel without any extra work on your part. Get rid of any tetrahedron object that might have been created by following the tutorial on the previous page; now click your new “Add Tetrahedron” button, and watch the object be created again!

### 131.4. Space Types, Region Types, Contexts, Oh My!

Those values for \texttt{bl\_space\_type}, \texttt{bl\_region\_type} and \texttt{bl\_context} are (partially) listed here\footnote{http://www.blender.org/documentation/blender_python_api_2_68_release/bpy.types.Panel.html} in the Blender API documentation, but not fully explained. Here’s a list of permissible values for each that I found from looking at source code:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Permissible Values</th>
<th>Source Reference</th>
</tr>
</thead>
</table>

\footnote{http://www.blender.org/documentation/blender_python_api_2_68_release/bpy.types.Panel.html}
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Permissible Values</th>
<th>Source Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>bl_space_type</td>
<td>&quot;EMPTY&quot;, &quot;VIEW_3D&quot;, &quot;TIMELINE&quot;, &quot;GRAPH_EDITOR&quot;, &quot;DOPESHEET_EDITOR&quot;, &quot;NLA_EDITOR&quot;,</td>
<td>space_type_items in</td>
</tr>
<tr>
<td></td>
<td>&quot;IMAGE_EDITOR&quot;, &quot;SEQUENCE_EDITOR&quot;, &quot;CLIP_EDITOR&quot;, &quot;TEXT_EDITOR&quot;, &quot;NODE_EDITOR&quot;,</td>
<td>rna_space.c²</td>
</tr>
<tr>
<td></td>
<td>&quot;LOGIC_EDITOR&quot;, &quot;PROPERTIES&quot;, &quot;OUTLINER&quot;, &quot;USER_PREFERENCES&quot;, &quot;INFO&quot;, &quot;FILE_BROWSE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>R&quot;, &quot;CONSOLE&quot;</td>
<td></td>
</tr>
<tr>
<td>bl_region_type</td>
<td>&quot;WINDOW&quot;, &quot;HEADER&quot;, &quot;CHANNELS&quot;, &quot;TEMPORARY&quot;, &quot;UT&quot;, &quot;TOOLS&quot;, &quot;TOOL_PROPS&quot;, &quot;PREVIEW&quot;</td>
<td>region_type_items in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rna_screen.c³</td>
</tr>
<tr>
<td>bl_context</td>
<td>&quot;mesh_edit&quot;, &quot;curve_edit&quot;, &quot;surface_edit&quot;, &quot;text_edit&quot;, &quot;armature_edit&quot;, &quot;mball_</td>
<td>data_mode_strings in context.c⁴</td>
</tr>
<tr>
<td></td>
<td>edit&quot;, &quot;lattice_edit&quot;, &quot;posemode&quot;, &quot;sculpt_mode&quot;, &quot;weightpaint&quot;, &quot;vertexpaint&quot;,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;imagepaint&quot;, &quot;particlenode&quot;, &quot;objectmode&quot;</td>
<td></td>
</tr>
</tbody>
</table>

Presumably, not all combinations will make sense.

---

² https://svn.blender.org/svnroot/bf-blender/trunk/blender/source/blender/makesrna/intern/rna_space.c
³ https://svn.blender.org/svnroot/bf-blender/trunk/blender/source/blender/makesrna/intern/rna_screen.c
⁴ https://svn.blender.org/svnroot/bf-blender/trunk/blender/source/blender/blenkernel/intern/context.c
132. Adding A Custom Property

Information

Applicable Blender version: 2.57

Addons will commonly do more than unconditionally perform a single action; the user may be able to control their actions in various ways. We can add controls for adjusting settings to our addon panel, and associate these with custom properties that we define for the current scene; Blender will then take care of updating the property values as the user operates those controls, and our operator’s invoke routine can fetch those property values when it runs.

132.1. Defining A Property

Properties need to be defined at the same time our custom classes get registered. We previously did this in top-level statements, but now let’s gather it all together into a register method, like this:

```python
def register() :
    bpy.utils.register_class(MakeTetrahedron)
    bpy.utils.register_class(TetrahedronMakerPanel)
    bpy.types.Scene.make_tetrahedron_inverted = bpy.props.BoolProperty \
    ( 
        name = "Upside Down",
        description = "Generate the tetrahedron upside down",
        default = False
    )
#end register
```

Here we are attaching the property as a new attribute of Blender’s Scene class; Python lets us assign new attributes to just about any object, and Blender takes full advantage of that. Note that the property must be created using one of the property-definition routines provided in bpy.props: choose the one that matches the type of property you want to create. Here we are defining a simple true/false toggle, which the user will control via a checkbox. Whatever name you use for your custom class attribute, an instance of that class will have an attribute with the same name, holding the actual value for that property.

The name will be used as the name of a control for examining or changing this property, while the description will appear as a tooltip when the user hovers the mouse over the control. The default is used as the initial value of the property.

Note also I tried to use a name, make_tetrahedron_inverted, which is less likely to clash with names defined by other addons or parts of Blender.
Let’s also add an unregister method, which undoes everything that register does. This won’t actually be used for now, but it will become relevant later when we extract the addon for separate installation:

```python
def unregister() :
    bpy.utils.unregister_class(MakeTetrahedron)
    bpy.utils.unregister_class(TetrahedronMakerPanel)
    del bpy.types.Scene.make_tetrahedron_inverted
#end unregister
```

To make the checkbox appear, add the following line to our panel’s draw routine:

```python
TheCol.prop(context.scene, "make_tetrahedron_inverted")
```

The first argument to the prop method must be an instance of the class to which we attached our property definition above; in this case, it is the current scene.

Finally, we need to finish off our script with the following bit of boilerplate which will invoke our registration routine in the situations (like the Text Editor) where Blender doesn’t do it for us:

```python
if __name__ == "__main__" :
    register()
#end if
```

**132.2. Using The Property**

Now we actually need to use the property in our operator’s execute routine. We’ll use it to negate a scale factor which will be applied to the Z coordinate of the vertices of the tetrahedron:

```python
Scale = -1 if context.scene.make_tetrahedron_inverted else 1
```

But only the last vertex has a nonzero Z coordinate, so this is the only one that needs a change in its computation:

```python
Vertices = 
[ 
    mathutils.Vector((0, -1 / math.sqrt(3),0)),
    mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
    mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
    mathutils.Vector((0, 0, Scale * math.sqrt(2 / 3)))
]
```

**132.3. Put It All Together**

To recap all our changes, here is the complete updated script:

```python
import math
import bpy
import mathutils
```
class TetrahedronMakerPanel(bpy.types.Panel):
    bl_space_type = "VIEW_3D"
    bl_region_type = "TOOLS"
    bl_context = "objectmode"
    bl_label = "Add Tetrahedron"

def draw(self, context):
    TheCol = self.layout.column(align = True)
    TheCol.prop(context.scene, "make_tetrahedron_inverted")
    TheCol.operator("mesh.make_tetrahedron", text = "Add Tetrahedron")

MakeTetrahedron(bpy.types.Operator):
    bl_idname = "mesh.make_tetrahedron"
    bl_label = "Add Tetrahedron"
    bl_options = {"UNDO"}

def invoke(self, context, event):
    Scale = -1 if context.scene.make_tetrahedron_inverted else 1
    Vertices = [
        mathutils.Vector((0, -1 / math.sqrt(3),0)),
        mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
        mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
        mathutils.Vector((0, 0, Scale * math.sqrt(2 / 3))),
    ]
    NewMesh = bpy.data.meshes.new("Tetrahedron")
    NewMesh.from_pydata(Vertices, [], [[0, 1, 2], [0, 1, 3], [1, 2, 3], [2, 0, 3]])
    NewMesh.update()
    NewObj = bpy.data.objects.new("Tetrahedron", NewMesh)
    context.scene.objects.link(NewObj)
    return {"FINISHED"}

register() :
    bpy.utils.register_class(MakeTetrahedron)
    bpy.utils.register_class(TetrahedronMakerPanel)
    bpy.types.Scene.make_tetrahedron_inverted = bpy.props.BoolProperty(
        name = "Upside Down",
        description = "Generate the tetrahedron upside down",
        default = False
    )

unregister() :
    bpy.utils.unregister_class(MakeTetrahedron)
    bpy.utils.unregister_class(TetrahedronMakerPanel)
    del bpy.types.Scene.make_tetrahedron_inverted

if __name__ == '__main__' :
    register()

As before, execute the script with \[\text{ALT} + \text{P}\]. Check the Tool Shelf in the 3D View, and your panel should now look like this:
Adding A Custom Property

Figure 848

Try executing it with and without the checkbox checked, and you should end up with two tetrahedra pointing in opposite directions.
133. A Separately Installable Addon

Information
Applicable Blender version: 2.57

Embedding a script inside a Blender document is useful for some special purposes, but often you want to be able to reuse an addon across any number of Blender documents, and perhaps distribute it to others for use with their Blender projects. To do this, you will need to save the script as a text file that can be copied into your Blender user preferences. It will also need to have some additional information inserted.

133.1. The Addon Info Dictionary

In order for the addon to be installable by Blender, it will need to define a global called bl_info, the value of which is a dictionary. This contains various information about compatibility with versions of Blender, and also descriptive information to be shown to the user as they browse through the list of installable addons.

Here’s what the info should look like:

```python
bl_info = {
    "name" : "Tetrahedron Maker",
    "author" : "J Random Hacker <jrhacker@example.com>",
    "version" : (1, 0, 0),
    "blender" : (2, 5, 7),
    "location" : "View 3D > Edit Mode > Tool Shelf",
    "description" : "Generate a tetrahedron mesh",
    "warning" : ",
    "wiki_url" : ",
    "tracker_url" : ",
    "category" : "Add Mesh",
}
```

Most of the fields are informational. The “category” value must be one of the predefined ones that you will see listed in Blender’s User Preferences window when you switch to the “Add-Ons” tab; the addon display is sorted by category and by name within category, and the user can list scripts in all categories or in just one category.

The “version” field indicates the version of your script, and can be a tuple of any number of integers; the numbers are shown to the user joined with decimal points (e.g. “(1, 0, 0)” is displayed as “1.0.0”). The “blender” field indicates compatibility with versions of Blender;
Blender versions older than this are supposed to reject the script. (Though what happens when a newer version introduces a backward-incompatible API change is not quite clear...)

133.2. Making The Addon Installable

The contents of your addon script are now complete. In the Text Editor, find the “Save As” option under the “Text” menu, and choose a filename for saving your script—perhaps call it TetrahedronMaker.py.

That’s it. This saved text file is your complete addon, ready for installation into your Blender user settings, or distribution to others for installation in their settings.

133.3. Installing The Addon

To install the addon into your Blender user settings, go to the User Preferences, and bring up the Add-Ons tab. (It doesn’t matter what document you might have open at this stage.) In the window header, click the “Install Add-On...” button, and find the TetrahedronMaker.py file you previously saved; select that, and click the “Install Add-On” button in the file selector. This copies the script file into your personal addons directory, which in Unix/Linux is ~/.blender/2.5x/scripts/addons/. You can also directly copy your script file into this directory, instead of using the “Install Add-On...” button. To uninstall an addon, use the Remove button that appears in its info panel (see below) or delete the script from this directory, together with its .pyc (compiled) version (which you will find in the __pycache__ subdirectory).

133.4. Using The Installed Addon

To make use of the installed addon, open a new Blender document. Go to the User Preferences window, and bring up the Add-Ons tab. Browse through the list of addons (feel free to restrict the display to the “Add Mesh” category as specified above) until you find your Tetrahedron Maker. You can click the white triangle to the left of the name to expand the list item display to show all the details:

![Addon List](image)

Figure 849

Note the buttons that may appear along the bottom: the “Remove” button appears for your own user-installed scripts, not for ones installed systemwide; the “Link to the Wiki” button
is only visible if you provided a URL in the “wiki_url” field of your bl_info; and “Report a Bug” comes up only if there is something in the “tracker_url” field.

Click the checkbox in the top right corner of the item display to enable the addon for this document.

Now switch to the 3D View, bring up the Tool Shelf if it’s not already visible, and you should see that familiar panel appear:

![Figure 850](image)

You know what to do next...
134. Object, Action, Settings

Now that we've covered the basics of writing a working addon and making it installable, let's add some refinements to its functionality.

To start with, users normally add new objects via the Add menu which pops up when pressing \texttt{SHIFT + A}, rather than via a custom panel. Can our script add a new “Tetrahedron” item to that menu? Yes it can.

Also, our script currently requires us to adjust its setting (the “Upside-Down” checkbox) before it performs its action. In user-interface parlance, this is the ordering “Object→Setting→Action”: select an object, specify the settings for the action, then perform the action. Whereas the preferred order in Blender 2.5x is “Object→Action→Setting”: which means the action is performed with some initial settings, which the user is then free to modify while observing their effect. This gives a much smoother workflow, rather than the user having to guess what the effects will be before applying them, and then undoing and trying again if they guessed wrong.

(Of course, since our example script creates a new object rather than modifying an existing one, the initial “Object” step is not relevant here. But it is to other operators.)

So the modifications we need to make to our script are:

- Get rid of the existing Panel subclass.
- Our register function will add a new entry to the Add menu (specifically, the mesh-add submenu) to invoke our Operator subclass.
- When our operator is invoked, a panel will appear, with all the settings controls we previously had, except for the “Add” button. The user can play with these settings, and observe the effect on the newly-created object immediately.

The nice thing is, Blender does most of the hard work for us, so we only need to edit a few lines of code to achieve all the above!

134.1. Adding To The Add Menu

This needs to be done in two steps. First we need a function which will be invoked when Blender creates its Add menu: this will add an entry that invokes our custom operator by its name. Specifically, we will add our custom item to the “Mesh” submenu of the “Add” menu. We can also assign an icon to the menu item; here I'm using the generic plugin icon:
def add_to_menu(self, context):
    self.layout.operator("mesh.make_tetrahedron", icon = "PLUGIN")
#end add_to_menu

# version 2.72b only allows for the icon value from the set:
# ("NONE", "QUESTION", "ERROR", "CANCEL", "TRIA_RIGHT", "TRIA_DOWN",
# "TRIA_LEFT", "TRIA_UP", "ARROW_LEFTRIGHT", "PLUS", "DISCLOSURE_TRI_DOWN",
# "DISCLOSURE_TRI_RIGHT", "RADIOBUT_OFF", "RADIOBUT_ON", "MENU")

Having done that, we change our register function to add our add_to_menu item to a list that Blender uses to create its Add→Mesh menu:

def register() :
    bpy.utils.register_class(MakeTetrahedron)
    bpy.types.INFO_MT_mesh_add.append(add_to_menu)
#end register

Note this bpy.types.INFO_MT_mesh_add object is not currently mentioned in the API documentation; I found it by examining the scripts that come bundled with Blender.

And of course we should clean up ourselves, so the unregister function needs to remove the item we added:

def unregister() :
    bpy.utils.unregister_class(MakeTetrahedron)
    bpy.types.INFO_MT_mesh_add.remove(add_to_menu)
#end unregister

134.2. Fixing Up The UI

Note that previously, our register and unregister functions were attaching a custom property to Blender’s Scene class to hold our setting value. That code is now gone, but we still need the property. Instead, it will now be attached directly to our MakeTetrahedron class.

Also, remember we said we were getting rid of the TetrahedronMakerPanel class? In fact we keep the draw method from that, and move it to our MakeTetrahedron operator, only getting rid of the last button in the panel for invoking the operator. This is because by the time the panel is being drawn, the operator has already been invoked.

We also need to tell Blender that we are conforming to the Object→Action→Settings convention, by adding the "REGISTER" item to our bl_options.

So the header of our operator class now looks like this:

class MakeTetrahedron(bpy.types.Operator) :
    bl_idname = "mesh.make_tetrahedron"
    bl_label = "Tetrahedron"
    bl_options = {"REGISTER", "UNDO"}

    inverted = bpy.props.BoolProperty \
    (name = "Upside Down",
     description = "Generate the tetrahedron upside down",
     default = False)

1032
def draw(self, context):
TheCol = self.layout.column(align = True)
TheCol.prop(self, "inverted")
#end draw

Previously our custom property was called make_tetrahedron_inverted, but here I just call it inverted, because after all it is being attached to our own class, so there should be no worry about name clashes.

Note that I also changed the bl_label text, taking out the word “Add”. This is redundant, because our label will be appearing in a menu that is already titled “Add”.

### 134.3. invoke Versus execute

The last thing to do is rearrange the code for actually creating the tetrahedron object. Previously we had it in a method called invoke, and that method will still be called when our operator is selected from the Add→Mesh menu. Then our draw method will be called, so our panel will also appear. But then, if the user makes adjustments to the controls in our panel, Blender will invoke a different operator method, called execute.

To the user, it looks like they are making adjustments to an already-created object. But in fact our execute method can do exactly the same thing as invoke, namely create a new object every time it’s called! Blender will take care of getting rid of previously-created objects, so the user won’t know the difference.

Nice, isn’t it? But in order for this to work, our code needs to do one thing more: ensure that our newly-created object is the only selected, active object. So the following is added after NewObj has been created and linked into the scene:

```python
bpy.ops.object.select_all(action = "DESELECT")
NewObj.select = True
context.scene.objects.active = NewObj
```

### 134.4. Put It All Together

Note that the object-creation code has been moved into a common routine that I have called action_common. This can then be called from both the invoke and execute methods.

```python
import math
import bpy
import mathutils
class MakeTetrahedron(bpy.types.Operator) :
    bl_idname = "mesh.make_tetrahedron"
    bl_label = "Tetrahedron"
    bl_options = {"REGISTER", "UNDO"}
    inverted = bpy.props.BoolProperty (  
        name = "Upside Down",  
        description = "Generate the tetrahedron upside down",  
        default = False  
    )
```
def draw(self, context):
    TheCol = self.layout.column(align = True)
    TheCol.prop(self, "inverted")
#end draw

def action_common(self, context):
    Scale = -1 if self.inverted else 1
    Vertices = [
        mathutils.Vector((0, -1 / math.sqrt(3), 0)),
        mathutils.Vector((0.5, 1 / (2 * math.sqrt(3)), 0)),
        mathutils.Vector((-0.5, 1 / (2 * math.sqrt(3)), 0)),
        mathutils.Vector((0, 0, Scale * math.sqrt(2 / 3))],
    ]
    NewMesh = bpy.data.meshes.new("Tetrahedron")
    NewMesh.from_pydata(Vertices, [], [[0, 1, 2], [0, 1, 3], [1, 2, 3], [2, 0, 3]])
    NewMesh.update()
    NewObj = bpy.data.objects.new("Tetrahedron", NewMesh)
    context.scene.objects.link(NewObj)
    bpy.ops.object.select_all(action = "DESELECT")
    NewObj.select = True
    context.scene.objects.active = NewObj
#end action_common

def execute(self, context):
    self.action_common(context)
    return {"FINISHED"}
#end execute

def invoke(self, context, event):
    self.action_common(context)
    return {"FINISHED"}
#end invoke

#end MakeTetrahedron

def add_to_menu(self, context):
    self.layout.operator("mesh.make_tetrahedron", icon = "PLUGIN")
#end add_to_menu

def register() :
    bpy.utils.register_class(MakeTetrahedron)
    bpy.types.INFO_MT_mesh_add.append(add_to_menu)
#end register

def unregister() :
    bpy.utils.unregister_class(MakeTetrahedron)
    bpy.types.INFO_MT_mesh_add.remove(add_to_menu)
#end unregister

if __name__ == "__main__" :
    register()
#end if

134.5. Undocumented Blender

That INFO_MT_mesh_add object is one of a bunch of undocumented things lurking in the bpy.types module. They all have names of the form prefix_type_restofname, where
**prefix** is an all-uppercase mnemonic for the category of object (mostly a window type, e.g. INFO for the Info window, which is where the main menu bar appears, though there are also names for major object categories like MESH and LAMP), and **type** indicates the class of object: HT for a window header UI object (bpy.types.Header), MT for a menu (bpy.types.Menu), OT for an operator, and PT for a panel (bpy.types.Panel). The OT ones seem to correspond directly to objects in bpy.ops, but at a lower level; it’s probably easier just to use the official bpy.ops objects. As for the HT, MT and PT objects, these all have append, prepend and remove methods that you can use to customize them: append adds a widget at the end (right or bottom), while prepend puts it at the front (left or top).

Since they aren’t (yet) mentioned in the official Blender documentation, here is a list of all the ones I’ve been able to find:

<table>
<thead>
<tr>
<th>Operator Category</th>
<th>Header</th>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bone Properties</td>
<td>Clip_MT_header</td>
<td>CLIP_MT_camera_presets, CLIP_MT_clip, CLIP_MT_proxy, CLIP_MT_reconstruction, CLIP_MT_select, CLIP_MT_select_grouped, CLIP_MT_select_mode, CLIP_MT_stabilize_2d_specials, CLIP_MT_track, CLIP_MT_track_color_presets, CLIP_MT_track_color_specials, CLIP_MT_track_transform, CLIP_MT_track_visibility, CLIP_MT_tracking_settings_presets, CLIP_MT_tracking_specials, CLIP_MT_view</td>
</tr>
<tr>
<td>Movie Clip Editor</td>
<td>CONSOLE_MT_header</td>
<td>CONSOLE_MT_integrator_presets, CONSOLE_MT_sampling_presets</td>
</tr>
<tr>
<td>Cloth Properties</td>
<td>CLOTH_MT_presets</td>
<td>-</td>
</tr>
<tr>
<td>Console</td>
<td>CONSOLE_MT_console, CONSOLE_MT_language</td>
<td>-</td>
</tr>
<tr>
<td>Cycles Renderer</td>
<td>CY</td>
<td>CY, CLES_MT_integrator_presets, CLES_MT_sampling_presets</td>
</tr>
<tr>
<td>Operator Category</td>
<td>Header</td>
<td>Menu</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
<td>------</td>
</tr>
<tr>
<td>Object Data Context</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operator Category</td>
<td>Header</td>
<td>Menu</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Dopesheet</td>
<td>DOPESHEET_HT_header</td>
<td>DOPESHEET_MT_channel, DOPESHEET_MT_gpencil_channel, DOPESHEET_MT_gpencil_frame, DOPESHEET_MT_key, DOPESHEET_MT_key_transform, DOPESHEET_MT_marker, DOPESHEET_MT_select, DOPESHEET_MT_view</td>
</tr>
<tr>
<td>Filebrowser</td>
<td>FILE_BROWSER_HT_header</td>
<td>FLUID_MT_presets</td>
</tr>
<tr>
<td>Fluid Simulation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graph Editor</td>
<td>GRAPH_HT_header</td>
<td>GRAPH_MT_channel, GRAPH_MT_key, GRAPH_MT_key_transform, GRAPH_MT_marker, GRAPH_MT_select, GRAPH_MT_view</td>
</tr>
<tr>
<td>UV/Image Editor</td>
<td>IMAGE_HT_header</td>
<td>IMAGE_MT_image, IMAGE_MT_image_invert, IMAGE_MT_select, IMAGE_MT_uvs, IMAGE_MT_uvs_mirror, IMAGE_MT_uvs_select_mode, IMAGE_MT_uvs_showhide, IMAGE_MT_uvs_snap, IMAGE_MT_uvs_transform, IMAGE_MT_uvs_weldalign, IMAGE_MT_view</td>
</tr>
<tr>
<td>Operator Category</td>
<td>Header</td>
<td>Menu</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lamp Properties</td>
<td>LAMP_MT_sunsky_presets</td>
<td></td>
</tr>
<tr>
<td>Logic Editor</td>
<td>LOGIC_HT_header</td>
<td>LOGIC_MT_logicbricks_add, LOGIC_MT_view</td>
</tr>
<tr>
<td>Mask Properties</td>
<td></td>
<td>MASK_MT_animation, MASK_MT_mask, MASK_MT_select, MASK_MT_transform, MASK_MT_visibility</td>
</tr>
<tr>
<td>Material Properties</td>
<td></td>
<td>MATER- RIAL_MT_specials, MATER- RIAL_MT_sss_presets RIAL_MT_context_material, RIAL_MT_custom_props, MATER- RIAL_PT_diffuse, MATER- RIAL_PT_flare, MATER- RIAL_PT_halo, MATER- RIAL_PT_mirror, MATER- RIAL PT_options, MATER- RIAL_PT_physics, MATER- RIAL_PT_preview, MATER- RIAL_PT_shading, MATER- RIAL_PT_shadow, MATER- RIAL_PT_specular, MATER- RIAL_PT_sss, MATER- RIAL_PT_strand, MATER- RIAL_PT_transp, MATER- RIAL_PT_transp_game, MATER- RIAL_PT_volume_density, MATER- RIAL_PT_volume_integration, MATER- RIAL_PT_volume_lighting, MATER- RIAL_PT_volume_options, MATER- RIAL_PT_volume_shading, MATER- RIAL_PT_volume_transp, MATER- RIAL_PT_volume_transp_game, MATER- RIAL_PT_volume_transp_options, MATER- RIAL_PT_volume_transp_shadow, MATER- RIAL_PT_volume_transp_specular</td>
</tr>
<tr>
<td>Mesh Properties</td>
<td></td>
<td>MESH_MT_shape_key_specials, MESH_MT_vertex_group_specials</td>
</tr>
<tr>
<td>NLA Editor</td>
<td>NLA_HT_header</td>
<td>NLA_MT_add, NLA_MT_edit, NLA_MT_edit_transform, NLA_MT_marker, NLA_MT_select, NLA_MT_view</td>
</tr>
<tr>
<td>Operator Category</td>
<td>Header</td>
<td>Menu</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
<td>------</td>
</tr>
<tr>
<td>Node Editor</td>
<td>NODE_HT_header</td>
<td>NODE_MT_add,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_CMP_CONVERTOR,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_CMP_GROUP,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_CMP_LAYOUT,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_CMP_OP_COLOR,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_CMP_OP_VECTOR,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_SH_CONVERTOR,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_SH_GROUP,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_SH_LAYOUT,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_SH_OP_COLOR,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_SH_OP_VECTOR,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_SH_OUTPUT,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_TEX_CONVERTOR,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_TEX_DISTORT,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_TEX_LAYOUT,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NODE_MT_category_TEX_OP_VECTOR,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OBJECT_PT_animation,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OBJECT_PT_context_object,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OB-JECT_PT_display,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OBJECT_PT_duplication,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OBJECT_PT_relations,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OBJECT_PT_transform_locks</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Object Properties</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Properties</td>
<td>OBJE-C-T_PT_animation,</td>
<td>OBJE-C-T_PT_constraints,</td>
<td>OBJE-C-T_PT_context_object,</td>
</tr>
<tr>
<td></td>
<td>OBJE-C-T_PT_custom_props,</td>
<td>OBJE-C-T_PT_display,</td>
<td>OBJE-C-T_PT_delta_transform,</td>
</tr>
<tr>
<td></td>
<td>OBJE-C-T_PT_duplication,</td>
<td>OBJE-C-T_PT_groups,</td>
<td>OBJE-C-T_PT_relations,</td>
</tr>
<tr>
<td></td>
<td>OBJE-C-T_PT_transform,</td>
<td>OBJE-C-T_PT_transform_locks</td>
<td></td>
</tr>
<tr>
<td>Operator Category</td>
<td>Header</td>
<td>Menu</td>
<td>Panel</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Outliner</td>
<td>OUTLINER_HT_header</td>
<td>OUTLINER_MT_edit datablocks, OUTLINER_MT_search, OUTLINER_MT_view</td>
<td></td>
</tr>
<tr>
<td>Particle Properties</td>
<td></td>
<td></td>
<td>PARTICLE_PT_boidbrain, PARTICLE_PT_cache, PARTICLE_PT_children, PARTICLE_PT_context_particles, PARTICLE_PT_custom_props, PARTICLE_PT_draw, PARTICLE_PT_emission, PARTICLE_PT_field_weights, PARTICLE_PT_force_fields, PARTICLE_PT_hair_dynamics, PARTICLE_PT_physics, PARTICLE_PT_render, PARTICLE_PT_rotation, PARTICLE_PT_velocity, PARTICLE_PT_vertexgroups</td>
</tr>
<tr>
<td>Operator Category</td>
<td>Header</td>
<td>Menu</td>
<td>Panel</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td>Physics Properties</td>
<td></td>
<td></td>
<td>PHYSICS_PT_add,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_cloth,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_cloth_cache,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_cloth_collision,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_cloth_field_weights,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_cloth_stiffness,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_collision,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_domain_boundary,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_domain_gravity,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_domain_particles,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_dp_advanced_canvas,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_dp_brush_source,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_dp_brush_velocity,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_dp_brush_wave,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_dp_cache,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_dp_canvas_initial_color,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_dp_canvas_output,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_dp_effects,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_dynamic_paint,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_field,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_fluid,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_game_collision_bounds,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_game_obstacles,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_game_physics,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_rigid_body,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_rigid_body_collisions,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_rigid_body_constraint,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_rigid_body_dynamics,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_smoke,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_smoke_adaptive_domain,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_smoke_cache,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_smoke_field_weights,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_smoke_fire,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_smoke_flow_advanced,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_smoke_groups,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_smoke_highres,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_softbody,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_softbody_cache,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_softbody_collision,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_softbody_edge,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_softbody_field_weights,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_softbody_goal,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PHYSICS_PT_softbody_solver,</td>
</tr>
<tr>
<td>Render Layer Properties</td>
<td>PROPER-</td>
<td>RENDER-</td>
<td>LAYER_PT_freestyle,</td>
</tr>
<tr>
<td></td>
<td>TIES_HT_header</td>
<td>RENDER-</td>
<td>LAYER_PT_freestyle_line,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RENDER-</td>
<td>LAYER_PT_freestyle_linset,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RENDER-</td>
<td>LAYER_PT_freestyle_linestyle,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RENDER-</td>
<td>LAYER_PT_layer_options,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RENDER-</td>
<td>LAYER_PT_layer_passes,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RENDER-</td>
<td>LAYER_PT_layers</td>
</tr>
<tr>
<td>Operator Category</td>
<td>Header</td>
<td>Menu</td>
<td>Panel</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td>Render Properties</td>
<td>RENDER_MT_ffmpeg_presets, RENDER_MT_framerate_presets, RENDER_MT_lineset_specials, RENDER_MT_presets</td>
<td>RENDER_PT_antialiasing, RENDER_PT_bake, RENDER_PT_dimensions, RENDER_PT_encoded, RENDER_PT_encoding, RENDER_PT_freesyle, RENDER_PT_game_display, RENDER_PT_game_player, RENDER_PT_game_shading, RENDER_PT_game_sound, RENDER_PT_game_stereo, RENDER_PT_game_system, RENDER_PT_motion_blur, RENDER_PT_output, RENDER_PT_performance, RENDER_PT_post_processing, RENDER_PT_render, RENDER_PT_shading, RENDER_PT_stamp</td>
<td></td>
</tr>
<tr>
<td>Scene Properties</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sequencer Window</td>
<td>SEQUENCER_HT_header</td>
<td>SEQUENCER_MT_add, SEQUENCER_MT_add_effect, SEQUENCER_MT_marker, SEQUENCER_MT_select, SEQUENCER_MT_strip, SEQUENCER_MT_view, SEQUENCER_MT_view_toggle</td>
<td>SEQUENCER_PT_edit, SEQUENCER_PT_effect, SEQUENCER_PT_filter, SEQUENCER_PT_input, SEQUENCER_PT_mask, SEQUENCER_PT_modifiers, SEQUENCER_PT_preview, SEQUENCER_PT_proxy, SEQUENCER_PT_scene, SEQUENCER_PT_sound, SEQUENCER_PT_view</td>
</tr>
<tr>
<td>Operator Category</td>
<td>Header</td>
<td>Menu</td>
<td>Panel</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Texture Properties</td>
<td>TEXT_MT_specials</td>
<td>TEXTURE_MT_envmap_specials, TEXTURE_MT_envmap_sampling, TEXTURE_PT_blend, TEXTURE_PT_clouds, TEXTURE_PT_colors, TEXTURE_PT_context_texture, TEXTURE_PT_custom_props, TEXTURE_PT_distortednoise, TEXTURE_PT_envmap, TEXTURE_PT_envmap_sampling, TEXTURE_PT_image, TEXTURE_PT_image_mapping, TEXTURE_PT_image_sampling, TEXTURE_PT_influence, TEXTURE_PT_magic, TEXTURE_PT_mapping, TEXTURE_PT_marble, TEXTURE_PT_musgrave, TEXTURE_PT_pointdensity, TEXTURE_PT_pointdensity_turbulence, TEXTURE_PT_preview, TEXTURE_PT_stucci, TEXTURE_PT_voronoit, TEXTURE_PT_voxeldata, TEXTURE_PT_wood</td>
<td></td>
</tr>
<tr>
<td>Timeline</td>
<td>TIME_MT_header</td>
<td>TIME_MT_autokey, TIME_MT_cache, TIME_MT_frame, TIME_MT_playback, TIME_MT_view</td>
<td></td>
</tr>
<tr>
<td>User Preferences</td>
<td>USERPREF_MT_header</td>
<td>USERPREF_MT_addons_dev_guides, USERPREF_MT_addons, USERPREF_MT_interaction_presets, USERPREF_MT_keyconfigs, USERPREF_MT_splash</td>
<td>USERPREF_PT_addons, USERPREF_PT_edit, USERPREF_PT_file, USERPREF_PT_input, USERPREF_PT_interface, USERPREF_PT_system, USERPREF_PT_tabs, USERPREF_PT_theme</td>
</tr>
</tbody>
</table>
Object, Action, Settings
Operator Category
3D View

1044

Header
VIEW3D_HT_header

Menu
Panel
VIEW3D_MT_armature_specials,
VIEW3D_PT_background_image,
VIEW3D_MT_bone_options_disable,
VIEW3D_PT_context_properties,
VIEW3D_MT_bone_options_enable,
VIEW3D_PT_etch_a_ton,
VIEW3D_MT_bone_options_toggle,
VIEW3D_PT_sculpt_options,
VIEW3D_MT_brush,
VIEW3D_PT_sculpt_symmetry,
VIEW3D_MT_brush_paint_modes,
VIEW3D_PT_sculpt_topology,
VIEW3D_MT_edit_armature,VIEW3D_PT_tools_armatureedit,
VIEW3D_MT_edit_armature_parent,
VIEW3D_PT_tools_armatureedit_options,
VIEW3D_MT_edit_armature_roll,
VIEW3D_PT_tools_brush,
VIEW3D_MT_edit_curve, VIEW3D_PT_tools_brush_appearance,
VIEW3D_MT_edit_curve_ctrlpoints,
VIEW3D_PT_tools_brush_curve,
VIEW3D_MT_edit_curve_segments,
VIEW3D_PT_tools_brush_stroke,
VIEW3D_MT_edit_curve_showhide,
VIEW3D_PT_tools_brush_texture,
VIEW3D_MT_edit_curve_specials,
VIEW3D_PT_tools_curveedit,
VIEW3D_MT_edit_font,
VIEW3D_PT_tools_latticeedit,
VIEW3D_MT_edit_lattice, VIEW3D_PT_tools_mask_texture,
VIEW3D_MT_edit_mesh, VIEW3D_PT_tools_mballedit,
VIEW3D_MT_edit_mesh_clean,
VIEW3D_PT_tools_meshedit,
VIEW3D_MT_edit_mesh_delete,
VIEW3D_PT_tools_meshedit_options,
VIEW3D_MT_edit_mesh_edges,
VIEW3D_PT_tools_objectmode,
VIEW3D_MT_edit_mesh_extrude,
VIEW3D_PT_tools_particlemode,
VIEW3D_MT_edit_mesh_faces,
VIEW3D_PT_tools_posemode,
VIEW3D_MT_edit_mesh_normals,
VIEW3D_PT_tools_posemode_options,
VIEW3D_MT_edit_mesh_select_mode,
VIEW3D_PT_tools_projectpaint,
VIEW3D_MT_edit_mesh_showhide,
VIEW3D_PT_tools_rigidbody,
VIEW3D_MT_edit_mesh_specials,
VIEW3D_PT_tools_surfaceedit,
VIEW3D_MT_edit_mesh_vertices,
VIEW3D_PT_tools_textedit,
VIEW3D_MT_edit_meta, VIEW3D_PT_tools_vertexpaint,
VIEW3D_MT_edit_meta_showhide,
VIEW3D_PT_tools_weightpaint,
VIEW3D_MT_edit_surface, VIEW3D_PT_tools_weightpaint_options,
VIEW3D_MT_edit_text_chars,
VIEW3D_PT_transform_orientations,
VIEW3D_MT_hide_mask, VIEW3D_PT_view3d_cursor,
VIEW3D_MT_hook,
VIEW3D_PT_view3d_curvedisplay,
VIEW3D_MT_make_links, VIEW3D_PT_view3d_display,
VIEW3D_MT_make_single_user,
VIEW3D_PT_view3d_meshdisplay,
VIEW3D_MT_mirror,
VIEW3D_PT_view3d_meshstatvis,
VIEW3D_MT_object,
VIEW3D_PT_view3d_motion_tracking,
VIEW3D_MT_object_animation,
VIEW3D_PT_view3d_name,
VIEW3D_MT_object_apply, VIEW3D_PT_view3d_properties
VIEW3D_MT_object_clear,
VIEW3D_MT_object_constraints,
VIEW3D_MT_object_game,
VIEW3D_MT_object_group,
VIEW3D_MT_object_parent,
VIEW3D_MT_object_quick_eﬀects,
VIEW3D_MT_object_showhide,
VIEW3D_MT_object_specials,
VIEW3D_MT_object_track,
VIEW3D_MT_paint_vertex,
VIEW3D_MT_paint_weight,
VIEW3D_MT_particle,
VIEW3D_MT_particle_showhide,
VIEW3D_MT_particle_specials,
VIEW3D_MT_pose,
VIEW3D_MT_pose_apply,
VIEW3D_MT_pose_constraints,
VIEW3D_MT_pose_group,
VIEW3D_MT_pose_ik,
VIEW3D_MT_pose_library,
VIEW3D_MT_pose_motion,
VIEW3D_MT_pose_propagate,
VIEW3D_MT_pose_showhide,
VIEW3D_MT_pose_slide,
VIEW3D_MT_pose_specials,
VIEW3D_MT_pose_transform,
VIEW3D_MT_sculpt,
VIEW3D_MT_select_edit_armature,
VIEW3D_MT_select_edit_curve,
VIEW3D_MT_select_edit_lattice,
VIEW3D_MT_select_edit_mesh,
VIEW3D_MT_select_edit_metaball,
VIEW3D_MT_select_edit_surface,
VIEW3D_MT_select_object,
VIEW3D_MT_select_paint_mask,
VIEW3D_MT_select_paint_mask_vertex,
VIEW3D_MT_select_particle,
VIEW3D_MT_select_pose,


<table>
<thead>
<tr>
<th>Operator Category</th>
<th>Header</th>
<th>Menu</th>
<th>Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Manager Properties</td>
<td>WM_MT_operator_preset</td>
<td>WORLD_PT_ambient_occlusion,</td>
<td>WORLD_PT_ambient_occlusion,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_context_world,</td>
<td>WORLD_PT_context_world,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_custom_props,</td>
<td>WORLD_PT_custom_props,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_environment_lighting,</td>
<td>WORLD_PT_environment_lighting,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_game_context_world,</td>
<td>WORLD_PT_game_context_world,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_game_mist,</td>
<td>WORLD_PT_game_mist,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_game_physics,</td>
<td>WORLD_PT_game_physics,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_game_world,</td>
<td>WORLD_PT_game_world,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_gather,</td>
<td>WORLD_PT_gather,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_indirect_lighting,</td>
<td>WORLD_PT_indirect_lighting,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_mist,</td>
<td>WORLD_PT_mist,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_preview,</td>
<td>WORLD_PT_preview,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_stars,</td>
<td>WORLD_PT_stars,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORLD_PT_world</td>
<td>WORLD_PT_world</td>
</tr>
</tbody>
</table>
135. Overview
136. High Dynamic Range imaging (HDRi)

136.1. Introduction

You may have heard various people talk about HDR images. (WETA, Lucas, even Tim Sweeny). HDR images are part of a technology called HDRi which stands for "High Dynamic Range (image)". So... what on earth does that mean?

Here’s a link to Wikipedia’s article on the HDR format\(^1\) which I personally give all my credit to Paul Debevec for putting it to use for computer graphics purposes. Anyway, before you start trying to understand the usefulness of HDRi, please read the wikipedia link.

Also, visit Paul Debevec’s website\(^2\) if you’ve got some more time to spare.

To sum up the excitement of HDR CG, think of it like the hype of the next-generation videogames that are about to come out, except set the stage for 1996 instead of 2006. Paul Debevec pioneered paralax mapping, HDR lighting, image-based modeling, his latest work includes some even more amazing technologies, and for the record he’s my hero too.

To use HDRi images for 3D rendering, you need something called a light probe\(^3\)...  

136.2. Definitions

HDRi

---

2. [http://www.debevec.org](http://www.debevec.org)
3. Chapter 137 on page 1055
HDRI stands for **High Dynamic Range Imaging**, and is basically an image format that contains from the deepest shadow up to the brightest highlight information. While an 'ordinary' digital image contains only 8 bits of information per color (red, green, blue) which gives you 256 gradations per color, the HDRI image format stores the 3 colors with floating point accuracy. Thus the 'depth' from dark to light per color is virtually unlimited. Using HDRI images in a 3D environment will result in very realistic and convincing shadows, highlights and reflections. This is very important for realistic emulation of chrome for example.

**Light Probe**

A Light Probe is a HDRI image containing 360 by 360 degrees (solid angle\(^4\) 4\(\pi\) steradians\(^5\)) image information. In other words: it's a 360 degree spherical panorama image, not only looking around the horizon, but also up and down. Thus a Light Probe image contains all visible information as can be seen from a specific point, wherever you turn your head.

### 136.3. Usage

Given that a Light Probe image is an 'all around' image with a high dynamic range, it’s the perfect solution for your 'world' background, especially for a 3D animation.

---

136.4. Quick Tutorial *(for experienced blendies)*

First of all, you’ll need an HDR image. There is a whole range at [http://debevec.org/Probes/](http://debevec.org/Probes/) that you can download for free. (There are even more at [http://blenderartists.org/forum/showthread.php?t=24038](http://blenderartists.org/forum/showthread.php?t=24038).) I will use the St. Peter’s Basilica probe, but any other HDR image will do just fine.

To apply the HDRI environment to your scene:

- Go to the shading settings (press F5) and click the World button.
- Enable ”Real” to force the horizon to stay still, as opposed to follow the camera.
- If you’re rendering with Blender Internal (ver. 2.49), go to ”Ambient Occlusion” tab and activate ”Ambient Occlusion”, then activate ”Sky Texture”. Skip this step if you’re using external renderers.
- In the ”Texture and Input” tab, click ”Add New” and ”Angmap”.
- Then go to the ”Map To” tab and deactivate ”Blend” and activate ”Hori”.
- Now go to the Texture settings (press F6) and change the ”Texture Type” to ”Image”.
- Click the ”Load Image” button and locate your HDR image.
- If you’re using YafRay or other external renderers, you need to turn on Global Illumination and to set the quality to something other than ”none”.

136.5. Step-by-step Tutorial

136.5.1. Build a simple scene

To see the advantage of using a 360 by 360 world image, the simplest example to demonstrate this is a scene with a mirrored sphere.
1. Add a sphere and a cube to your scene and place them in a bit of an interesting position. (note that I added a second lamp to light up the shadow part of the cube)
2. Perhaps give the cube a different color than the default grey.

1. Give the sphere a mirrored material: go to the Shading -> Material panel (F5) and find the Mirror Trans buttons.
2. Check that Ray Mirror button is pressed. If it is not, check it.
3. Set the **RayMir** value to a value of 0.5 or higher. Your preview should show the reflection of the checkboard environment.

### 136.5.2. Render with HDR (Blender Internal v2.49)

1. Download a HDR image (see Paul Debevec’s website)
2. Go to the shading settings (press F5) and click the World button.

![AngMap enabled](image)

**Figure 854** AngMap enabled

1. Go to "Ambient Occlusion" tab and activate "Ambient Occlusion", then make sure "Raytrace" is chosen as gather method, and activate "Sky Texture"
2. Adjust quality settings:
   a) Increasing number of samples reduces noise, but increases render times
   b) Adaptive QMC is faster, but generates more noise than Constant QMC
3. In the "Texture and Input" tab, click "Add New" and "Angmap"
4. Then go to the "Map To" tab and deactivate "Blend" and activate "Hori".
5. Now go to the Texture settings (press F6) and change the "Texture Type" to "Image".
6. Click the "Load Image" button and locate your HDR image.

### 136.5.3. Render with HDR (Blender Internal v2.69)

1. Download a HDR image (see Paul Debevec’s website)
2. Goto Properties tab and click the World button. In the World Section check the “Real Sky” Button.

3. (optional) Goto “Ambient Occlusion” section and activate “Ambient Occlusion”, then make sure “Raytrace” is chosen as gather method in Gather section.

4. (optional) Adjust quality settings:
   a) Increasing number of samples reduces noise, but increases render times.
   b) Adaptive QMC is faster, but generates more noise than Constant QMC.

5. In the Properties tab click Texture button -> then click on ‘show world texture’ -> then select type as ‘image or movie’ -> then in mapping section select coordinates as ‘Angmap’ -> then in influence section uncheck the ‘blend’ button and check the ‘horizon’ button.

6. In the Images section click on open button and locate your HDR image and Load it.

136.5.4. Render with YafRay

1. Download a HDR image (see Paul Debevec’s website).
2. Goto the shading settings (press F5) and click the World button.
3. In the “Texture and Input” tab, click “Add New” and “Angmap”. Note that the Angmap button is the important thing to tell Blender that this file is a Light Probefile!
4. Then goto the “Map To” tab and deactivate “Blend” and activate “Horiz”.
5. Now goto the Texture settings (press F6) and change the “Texture Type” to “Image”.
6. Click the “Load Image” button and locate your HDR image.

(optional step, as it was not needed for my setup:)
5. Press F10 and change the “Blender Internal” to “YafRay”. You need to turn on Global Illumination and set the quality to something other than “none”. Note that the YafRay renderer does not come standard with the Blender installation. You need to download and install this separately. Your result should look like this: (Rendering: left with Blender, right with YafRay) Click for larger version

Figure 855

Figure 856

Note that the reflecting ball reflects the whole interior from every angle, even though we added just a single image to the World settings!
137. Creating a Light Probe

The light probe is, in the simplest terms, a photograph of your environment. They work in very much the same way that reflection maps do, and are made the same way.

Equipment:

1. A pure silver ball. Try a plastic Christmas tree ball ornament.
2. A camera, preferably digital. If you have a high-end digital camera, you’ll have less work ahead.
3. A place you’d like to capture the lighting from. Try laying different things in your environment to get a good idea.
4. Something to fire the shutter without touching the camera. For digital cameras, Paul Debevec recommends using a program that will take all the pictures for you.
5. A tripod.

Set it up like so. Remember that the height of your camera and the height of the ball relative to each other controls the angle at which the horizon will be shot. In other words, shoot the ball at the same angle that you plan to shoot your 3D scene in. If your scene is animated... consider making a similar rig except attaching your reflective ball to a video camera as was done for Flight of the Navigator¹.

¹ http://en.wikipedia.org/wiki/Flight_of_the_Navigator
1. Note that the diagram is incorrect. The camera will see items reflected from behind the sphere as well.

The process:

1. Set up your rig and take a series of images with varying exposure times.
2. Taking 2 sets of pictures, each offset by 90 degrees, will enable you to get better coverage of the background and eliminate the reflection of the camera taking the picture.
Good article²

² http://gl.ict.usc.edu/HDRShop/tutorial/tutorial5.html
138. Landscape Modeling with Heightmaps

This tutorial will show you how to make advanced terrain such as mountains using Blender and gimp or any other image editing software. Blender has the ability to use height maps to create meshes. Height maps are black and white images with white representing the highest point and black the lowest.

138.1. Creating the heightmap image

**Note:** This entire Tutorial presumes that you are already familiar with other Editing Software, such as GIMP... and already know how to create "textures" with that software. However, you do not have to use another program to obtain a texture. At the end of the next section, they show you how to generate a random 'cloud' texture which you can use directly. Do not worry about GIMP or Photoshop. Just skip the rest of this section and most of the next one.

To begin with, open your image editing software. This part applies to Gimp only (downloadable at [http://gimp.org](http://gimp.org)), if you use another program you will have to do it another way.

First use the "New" menu option to create an image 1600 wide by 1200 tall. Go to **Filters → Render → Clouds → Plasma** (In Photoshop, this is Filter > Render > Clouds). For this example just use the default settings, it doesn’t really matter. Click OK. You should now have a nice colorful image. We don’t want that, we want it in black and white. Make sure your Gradient is set to "FG to BG(RGB)" (this is the default anyway) and that your foreground color is black and the background color is white. Go to **Colors → Map → Gradient Map**. This will convert it to black and white for you.

Save your image as PNG or JPEG.

It should look something like this
138.2. Create grid and add the image as texture

Open Blender and delete the default cube.

Add a grid (SPACE → Add → Mesh → Grid) with resolutions 32 and 32 from top view. Do not scale the grid just yet, zoom instead if you wish to take a closer look at your grid. It will be explained later why you shouldn’t scale now.

Note: When I followed this tutorial it didn’t work - the vertices in the grid were moving sideways rather than vertically. It turns out I needed to TAB into object mode after creating the grid, then hit CTRL+AKEY to reset the transformation, then TAB back into edit mode. If someone could explain why that was necessary, or what it does exactly, that would be helpful.

- **Response 1**: You should create the basic shape and outline in object mode, then edit the details in edit mode, kinda like the names imply.
- **Response 2**: When you create an object using the Front or Side views while having Aligned to View selected in the Edit Methods in Blender Settings Panel, the Local Z axis of the object will be pointing to the Global Y or X axis, respectively. For the matter of this tutorial, if you do that, you’ll be forced to rotate the object 90° in X or Y, before going on. That’s where problems may begin, if you rotate it in Edit Mode which doesn’t change local axis orientations. In that case you’ll be forced to reset transformations (CTRL+A -> Scale and Rotation to ObData). However, if you rotate it in Object Mode, and if you make sure the Local Z axis points upwards after the rotation, you should be seeing good results later on. (To see the Local orientations...
of an object, Press F7 for the Object Panel (the one with three arrows, 4th from the left) and in the Draw pane click the Axis button.)

Click F5 to go to the Shading panel. By default the Material buttons button should be selected (button with red ball), but if it isn’t then click on it. If this window has a panel named Preview and it is empty then look to the right for the Links and Pipeline panel. Here you should find an Add New button beneath Link to Object, click on it. 3 more panels should appear when you do this. You should find the Texture buttons button, it is just to the right of the Material button and is black & yellow. You may also just hit F6. Now you should get two new panels titled Preview and Texture, in the Texture panel you’ll find an Add new button, click it. Where the button just was it should now be a text field saying something like ”TE:Tex.001”, click in the text field and write ”height” instead. Look a bit to the right and down for a dropdown menu allowing you to choose Texture Type, click it and select Image. Two more panels will appear and the rightmost should be Image with a Load button.

**Note:** The Texture buttons button is not part of the windows that pop up after you click Add New button, but it directly to the right of the Material button that is a red ball.

**Note:** If you can’t find the Texture Type menu, press F6. Once you press F6, or the Texture buttons button, you’ll see another panel, also called Texture. This one, however, shows a Texture Type menu after you select Add new. Having two very similar panels can be a nasty trap.

Before you load the image take a look at the Map Image panel. About in the middle there should be 5 buttons, Extend, Clip, ClipCube, Repeat and Checker. Select Clip or your heightmap may wrap around the grid (if this doesn’t make sense then do this tutorial twice, one where you keep Repeat selected and one without. In that case make sure there’s some bright white spots in your height map on each edge).

Click the Load button and load the heightmap you just created in your favourite image editing software.

If you’re going for the random cloud-type image, though, you can make it from within Blender itself - when you add a texture, in the menu where you select ‘image,’ before actually selecting it, pick ‘clouds’ instead, and play with the settings.

![Figure 859](image-url)
Click the *Material buttons* button again (the red ball button) and look in the *Preview* panel. If this just shows a black ball then click on the uppermost button just to the right of the black ball.

![Image of Blender interface](image)

**Figure 860**

### 138.3. Use texture as heightmap

(Blender 2.5+ note: Now you do this using a "Displace" modifier that applies the Texture you created.)

Look to the top right of the rightmost panel, the window should have 3 panes titled *Texture*, *Map Input* and *Map To*. Click on the *Map To* pane. A whole lot of buttons will appear:

- Turn off the *Col* button. "Col" stands for "color," and we don’t want our plane to be *colored* by this texture.
- All of these buttons should be turned off: we’re not going to be using this texture to "Map To" anything. Instead, we’ll be using it to deform the actual geometry.

Go to the *Edit window* (F9) and enter edit mode (TAB) if you’re in *Object Mode*. Go to either front or side view so you can see what you are doing. Click the *Noise* button in the *Mesh Tools* -panel (it’s located in the top left corner of this panel) and your grid should start to change shape.

**Note:** make sure all your vertices are selected with AKEY or whatever you want to use to select. If not selected, *Noise* won’t do anything!

- *(While you could, theoretically, use this to your advantage ... intentionally de-selecting vertices that you don’t want to influence ... in practice that’s quite awkward if for some reason you have to do it again. It’s much easier to leave any such areas, that you don’t want to influence, "completely white" in the image.)*
Continue clicking the button until the terrain has reached the height you want and voilà, you have just made terrain using heightmaps. You may want to subsurf the shape to get a smoother effect. If you wish to scale your new landscape then now is the time. There seems to be a bug or gotcha causing your heightmap to be tiled on your grid rather than resized if you scale the grid before applying the heightmap. Hopefully someone familiar with blender will clarify how this should be done properly, but until then this method will work.
Tips:

1. If you want a more jagged landscape then adjust the contrast on the image editing software.

2. Once you’ve finished using the Noise button in the Mesh Tools panel as shown above, the texture is no longer needed: the effect it has made on the geometry of the object is permanent. If texture-resources are tight, you can remove it now. But it’s advisable to keep it, unchanged, in case you need to re-do your work at some time in the future. If you want to use other kinds of texture-maps (Color, Normal maps, and so-forth), you can use the landscape-image as a handy reference (say in a background-layer in your painting program) for correct placement of these features, but you should not alter the landscape-image itself.

3. Height maps can also be used to make city terrain. Draw white squares on a black background. If you do this make sure you make the squares perfectly parallel to the sides of the image. This prevents jagged edges to buildings. You can also use gray squares to adjust the buildings to different heights.

4. The ”Noise” mesh-editing button displaces vertices in the object’s Z-Axis and negative Z-Axis only. To deform your mesh’s other dimensions, simply rotate your object and ”apply rotation,” or rotate the vertices in edit mode, and apply Noise. Then, rotate it back again to get your original orientation.
5. The "Noise" button permanently modifies your mesh according to the material texture. Each click adds onto the current mesh. For a temporary effect, map the texture to \textit{Disp} (placement) for a render-time effect (\textit{and do not click the "Noise" button at all}). In object/edit mode your object will appear normal, but will render deformed.

6. \textit{Note:} The "Noise" mesh-editing \textit{button}, as used here, is not the same as the "Noise" \textit{texture} that is referred to in other tutorials!
139. How to Do Procedural Landscape Modeling

139.1. Mountains

I was playing around in Blender several months ago and messing with cloud textures when I found a great way to make landscapes entirely within Blender (without height maps from The Gimp or some other application) and decided to make a tutorial (yes, it does use the noise tool).

139.1.1. Making the Mesh

To start, open up Blender and with the cube selected, press the XKEY and click Erase Selected Objects.

Add a grid (SPACE --> Add--> Mesh--> Grid), using whatever numbers you like, remembering that bigger numbers means more vertices. For this tutorial, I’ll use 60 for x and y resolution. Scale the grid up, but only a little bit (I went up to 1.3) as the texture won’t make very tall landscape with a very big grid. Press the F5 key to go to the Materials tab, then add a new material.
139.1.2. Displace and Shade

Now press the F6 key to go the Textures panel, and add a cloud texture in the very first slot (slot 0).

After Pressing F6, look at the windows on the bottom. To the left is the "preview" window and next to that (to the right) is a Texture window with an Add button... click that and then go to the little pull down menu that shows up just below and to the right. From there, find and select "Clouds"... and now, continue!

You may be wondering how we are going to make landscape with a cloud texture, when you could just use the Gimp height map plugin, Terragen, or the A.N.T. modeling script right in Blender. Well, we are going to make the landscape with a height map. The color...
Mountains
determines the height: white = very tall; grey = halfway tall; black = no height. This makes the cloud texture a very good candidate for land.

The next thing we are going to do is adjust the size. You can set the noise size to whatever you want, but I want to have several bigger pieces of landscape, instead of a bunch of little ones so I’m setting noise size to 1.00 and noise depth to 6, as I want a high level of detail. (The Preview immediately shows you the effect of your "tweaks" as you make them.)

**Noob Note:** You can hold shift and click the number next to noise size then just type 1 and press enter instead of using the arrows. The same applies for NoiseDepth, almost every other setting in blender changes like this as well.

At the top, we can select Hard noise or Soft noise. Each gives a different landscape, so experiment with them. Next, go to the Colors tab (it’s right next to the texture button by default). Adjust the brightness and contrast as required. For 'Hard noise,” try a brightness of 1.9 and a contrast of 3.45. For "Soft noise,” a brightness around 1.0 to 1.2 should be fine.

**Noob Note:** The above noob note applies to the brightness setting as well!

![Figure 864](image)

Jump back to material buttons with **F5** and go into the "Map To" panel. Turn off **col** and press **nor** once.

**Noob Note:** I had a difficult time finding the "Map To" so if you are too... This is one of the several small Windows that opens at the bottom of your screen after pressing **F5** and for me, it was on the far, far right, off my screen. I had to use my mouse wheel to scroll the Windows to the side to bring it into view and found it as a Tab on a Window with two other tabs. "Col" and "Nor" are buttons in the Map To Tab.

**Another Noob note:** In version 2.66, the "map to" equivalent is found in the texture window (under the tab "influence") there you can adjust the color and normal settings. they are referred to by their full names.

- **What the buttons are for:** The "Map To" settings determine which various attributes of the material will be affected by our "cloudy texture.”
  - "Col" refers to "col or.” We turn it off here, because we don’t want our surface to look "cloudy.”
  - "Nor” refers to ”surface nor mals.” This is the angle at which light seems to reflect from the surface. (The so-called "bump map.”)
  - Experiment with the other "Map To” buttons, as well! For instance, "Disp” (for "disp lacement) actually causes a map to deform the geometry of a surface... but doing so only during rendering.
In this tutorial, as you will see, we are going to combine several techniques to produce a very rocky surface. Here, we are changing the way that the surface reflects light. Then, we’ll actually deform the surface geometry. ----

Turn the nor value all the way up, to 25 (that will give it a nice rocky look). Go into the Shaders tab and then change the "Diffuse Shader" (the top left selector, defaulting to "Lambert") to "Oren-Nayer," and the "Specular Shader" (the 2nd selector, defaulting to "CookTorr") to "Blinn." Adjust the Rough value in Oren-Nayer to 1.5 (rock is really rough). Also, set the Spec value to 0.01 and Hard to 25. Now we are ready to make some mountains!

- **Trivia note:** In computer graphics, a "shader" is a mathematical function, and they’re customarily named after the clever people who invented them. These functions determine exactly how the cloudy-texture will “map to” the attributes (e.g. "Nor"...) that we selected.

![Figure 865](image)

139.1.3. Making Mountains

Press **TAB** to go into edit mode and press the **AKEY** twice, in case you had any specific vertices selected. Go into the front view and press the "Noise" button (located under mesh tools in **F9**). You should see the vertices jump up a good bit.
If not, you may have scaled your grid up too much, so make it somewhat smaller. Depending on how high you want your mountains, press the Noise button to your required amount, though I pressed it 8 more times. The mesh doesn’t look very good right now, as it is not only blocky, but it is missing that last bit of random detail.

- **Important note!** The mesh-editing button named ”Noise” causes a permanent change to the geometry of the object in the ”Z”-axis, as provided by the texture. (The vertices actually moved, and their new position is permanent.)
- There is also a procedural texture named ”Noise,” but that is just pure coincidence. The two are unrelated, both in what they do and in how they work.

- **Important note!** Those using Blender 2.5 Beta in order to get the height map to affect the geometry you will need to use the displace modifier instead.

If you are not in edit mode, go into it and select all the vertices. Press Fractal (in the same row as Noise under mesh tools) and enter a value of 15 in the random factor. Hopefully, your system can manage all these vertices: if not, then don’t do any fractal subdivide. If you want to, you can use a smaller value in the fractal box and do it several more times for more displacement. Be careful, though: too much randomness will cause vertices to separate, causing tears in the mesh that you will have to fix by hand.

Finally, tab out of edit mode and press Set Smooth. Then, if you want to make the mesh even more smoother, add a Subsurf modifier, with what ever level you want. (I’m going with 1 for faster render times.)

If you desire, you can scale up the mesh however big you want though for close-ups, you may want another level of subsurf or another subdivide. Then, apply colors, set up the lights, and render! A word to the wise, however: this process creates a huge file (about 986kb).

### 139.1.4. Discussion

You have just made mountains all in Blender, without having to generate height maps in The Gimp, or any other program. The next step is to go beyond the tutorial. Try using different noise sizes and noise basis, and even try using other textures like musgrave and marble. Or try using two textures and see the conclusion. The possibilities are almost infinite! Have fun.

Observe how the technique illustrated *this* tutorial is ”the same, yet different” from the one demonstrated in the tutorial for ”height maps”: 
A procedural texture was used to supply changes to the Normal Mapping of the object at render time. (This is the angle at which the object reflects light.) (The "height mapping" tutorial did not do this.)

Then, the mesh-editing button (also...) named "Noise" was used to deform the actual geometry of the mesh. (This is the same technique used in the "Height Map" tutorial, although a different kind of texture.. an image.. was used.)

The texture, once used for the height-mapping (deformations) was left in place, still mapped to the surface Normal’s. The result will be a very mountainous landscape.

Yep! The techniques shown in all of these terrain-modeling tutorials can be combined! And, they frequently are. Very often the most satisfactory results are obtained by combining several different techniques. You could have used an image-map (from the "Height Mapping" tutorial) to deform the geometry, then used the "noisy Normal-mapping" idea from the first part of this tutorial, and even used smoothing. All at the same time. The choice is yours.

When using "Map To," remember that a single material can have several different textures applied to it, each one mapped to the same or to different attributes. This mapping can even be animated.

Experiment! The sky’s the limit!
140. Landscape Modeling I: Basic Terrain

I worked with a group to make a small animation for class and I was responsible for the environment modeling. I really liked the results of the process I used, so I decided to share it with others. By the end of this tutorial you’ll have the know-how to create your own flexible, realistic terrain utilizing multiple textures for different ground types. This tutorial assumes that you have the very basic understanding of using Blender (how to add/remove a mesh, how to change views, etc...) I use the following textures in this demo. Feel free to use them if you don’t have something on hand to use.

Figure 867

NOTE: This page uses a different grass texture for licensing reasons (sorry).

140.1. Creating the Canvas

Figure 868  The grid that will be used to build our landscape.
The "canvas" that we'll use for our terrain is an evenly spaced grid of vertices. Open a new project, delete the default cube, and **add a grid mesh**. Use whatever size you want. The more vertices you have, the more detailed and realistic your landscape will appear, but don’t get crazy with it since we’ll apply subsurfacing at the end to smooth it out. At the same time, you do want enough vertices to prevent sharp edges, and we’ll need them in the second tutorial when we cover texture stenciling. So consider how big you want your landscape and try to find a reasonable balance. I like to start with 100x100. The grid will be pretty small, so scale the entire thing up, let’s say by a factor of 20. This grid will be used to build our landscape by pulling hills and mountains out of it.

**Noob Note:** If you don’t want to have to delete the default cube every time you open a new file, just delete the cube once so you have the blank window (only lamp and camera left). Then select **File - Save default settings** or hit **Ctrl+U**. From now on, each new project you create will start off without the cube.

### 140.2. Molding the Mountains

The key to making good mountains is using the proportional edit mode (**OKEY**) and constantly adjusting the radius of influence. If you’ve already gone through the Mountains Out Of Molehills\(^1\) tutorial then this section will be familiar. One major difference is that in this tutorial I recommend rotating the 3D view around so you have a good view of all three axes instead of working in the front or sides view. Using the proportional editing tool affects multiple vertices, and it helps to see what effect your changes are having as you make them.

- Go ahead and turn on proportional editing, either by pressing **OKEY** or clicking on the grey ring on the 3D View header. You have to be in Edit Mode to select this option. Once proportional editing is enabled, the ring will appear orange and a new drop-down menu will appear next to it with different falloff styles. Select Smooth if it is not already selected.

- Select any random vertex and grab it (**GKEY**). You will see a ring around the vertex you are grabbing. This is the radius of influence, and only vertices inside this ring are affected by the transformation. If you are doing this in the orthographic view from the front, side, or top, then this will be obvious. But if you’re at a view where you can see all three axes, then it may be less obvious.

![Figure 870](image-url)  
**Figure 870** The first mountain created using proportional editing.

- Restrict movement to the z-axis (**ZKEY**) and translate the vertex upward. Throughout this entire process you ONLY want to translate along the z-axis. If you start moving vertices in the x or y directions, things become distorted and you get some nasty creases. Play around with adjusting the size of the radius of influence (**Mouse Wheel**) to get steeper or flatter hills.

![Figure 871](image-url)  
**Figure 871** A nice group of hills

- Keep repeating this process with different size radii and different heights until you have a decent mountain range, but leave an area flat. We’ll be using that spot later in the second tutorial. Don’t be afraid to occasionally translate some vertices down instead of up to create depressions in the hills. Remember, variety is the spice of life. Very few
things in nature are naturally geometric, so mix up your hills and especially make sure they overlap. How often do you see a nice, smooth hill all by itself in nature?

**Note:** You’ll notice in my screenshot that I have reduced the size of my grid. For simplicity’s sake, I didn’t feel like filling an entire 100x100 grid with mountains since this can take some time.

- Well now, that’s looking pretty good! Now, there’s one problem with our hills so far. They’re too smooth! Let’s bumpify them a little. Change the falloff type from Smooth to Random.

![Figure 872](image)

**Figure 872**

- Select a single vertex and grab it (**GKEY**). We’re still working on the z-axis only, to restrict your movement with the **ZKEY**. Now when you move the vertex up and down, all vertices in the radius of influence will also move but with a random falloff instead of smoothly. It only takes a little movement to get the effect we want, so something around 0.5-1.0 is enough. Mix up moving up and down with different vertices, again to add variety to the scene.

![Figure 873](image)

**Figure 873** Rougher hills look more realistic
Once you have your landscape the way you like it, add a subsurf modifier under the Editing tab (F9) and select Catmull-Clark. This will smooth out your terrain a little so that it’s not too rough. Given the number of vertices you already have, it’s not necessary to have a higher render value than 1 unless you just REALLY want it to be smooth, but I don’t recommend it. Land is supposed to be bumpy and rocky, we just don’t want sharp edges.

Noob note: If you’re making mountains using Random Falloff and the peaks stick up too much: in Edit mode, select the points in the area around the peak using circle select, then press WKEY and click ‘Smooth’ until you’re satisfied (or, in the Editing tab (F9), click the ‘Smooth’ button).

Useful Tip Proportional editing can be used on multiple vertices simultaneously. This is especially useful if you’re trying to create a cliff face or a river bed. Use the box tool (BKEY) to select a group of vertices and then translate them. Keep in mind that the size of the radius of influence determines how many vertices around EACH VERTEX will be influenced. So suppose you have a 5 vertex radius, that means that 5 vertices all the way around your selected region will be influenced.

140.3. Texturing the Terrain

Alright! We’ve got some pretty nice hills now! But there’s still a few problems. Hills shouldn’t be white, and hills shouldn’t be SHINY! Let’s dress them up a little, shall we?

- With your landscape selected, go to the Shading Panel (F5) and add a new material.
- Under the Shaders tab, drop the Specular value to 0.
- Go to the Texture tab (F6) and add a new texture.
- In the Texture Type drop down menu, select Image.
- Two new tabs will appear. In the Image tab, click Load and load a texture from file.
- In the Map Image tab, increase the Xrepeat and Yrepeat. Depending on the size of your terrain and the image that you use (please use something that tiles!), these values will vary. I’ve used 10 for each in this tutorial.

![Figure 874](image)

(Noob note: Render the scene (F12) to see the applied texture) (Noob note: A quicker way to do this is by using the render preview tool, 3d view window - render preview, View--> Render Preview or press SHIFT --> PKEY) (Noob note: you may also select shaded in the Viewport Shading menu next to where you select object mode or edit mode to see your texture on your mountains without rendering, however it does slow your computer...}

1077
• Finally, let’s do something about the lighting. Go to Object Mode (TAB) if you’re not already there and select the lamp. Choose the Shading Panel (F5) and then click the icon that looks like a lightbulb to display the Lamp buttons. Change the lamp to a sun and up the energy to 1.5. You may also need to increase the distance if your terrain is large, or rotate it around if you don’t like where it’s pointing. The dashed line coming out of the light is the direction. Play around with different angles and energy values for the sun to get different times of day in your scene.

And there you have it! Your landscape is now textured with some nice grass to make it look a little more realistic. Play around with hillsizes and roughness if you’re not satisfied with your landscape, but try not to be too picky. Nature shouldn’t look too sculpted. Remember, you won’t notice a change in texture unless you render your image.

NOTE
If you went with the suggested 100x100 grid, the rendering process could definitely take some time depending on your system, especially if you have ray tracing and shadows enabled. To boost the rendering speed, go to the Scene panel (F10) and under Rendering, disable the buttons that say Shadow and Ray. Also note that because we’ve created some hills, your camera may now be under the terrain. Switch to the camera view (NUM0) to see what your camera sees and move it if you need to.

Figure 875
Join us next time as we explore how to make the landscape look even better using texture stenciling! And please, if you have any issues with the tutorial, or feedback (positive or negative), drop it in the discussions. I’ll try to keep an eye on it to see what people have to say. - Moohasha

140.4. Reader Contributions
I’m mainly doing this so the hills look better and more realistic. Reading this will consume more time than doing it. I’m making everything clear for beginners. It will only take about 8 minutes more for your hills to end up like this:

Figure 876

1. First step to achieve it is to switch from the default lamp to Sun.
   a) You do this by clicking on the default and go to the shading tab (F5)
   b) Click on Sun
   c) Go to rotate manipulator mode with Ctrl Alt R.
   d) Rotate the sun until the dotted line is in your desired position. That is where the main energy will go. It will differ if you want to achieve the different time of day. You can make the distance greater or less with dist. I kept mine at default 30.

2. Now let’s make more realistic, paler sunlight.
a) In the RGB slider, set R for 1, G for 1, and B for .848.
b) Set energy for 1.63. This will all differ for different times of day, so set your east and west in your head, and the later into the day, the further the sun to the west and the more orange. For midday, keep the energy on 1.63 and put the sun right above your hills. I set mine for earlier in the morning.
3. Now click on the picture of a globe to change the background.
4. Click on the blend button for a more realistic looking sky. On the left of the World toolbar, that will be the color of lower down in the sky and the right sliders will be the color of the top of the sky. Naturally, the top should be darker blue than the bottom.
a) It will differ for different times of the day. So you might want something different from this. But I set up mine for the morning using the settings below:
   • The left HoRGB sliders to 0.50, 0.68, and 1.
   • The right ZeRGB sliders to 0.11, 0.25, and 0.66.
5. Now for the texture. This won’t differ for the times of day, but it will differ for what type of landscape you want.
a) I got the texture from here^2. The best textures to use would be either Desert Canyon, Hill Country, Rough Terrain, Class M Planet, or Red Planet. Use Red Planet for a Rocky, Mars-like look. (Note: these textures are no longer available on this URL as of Nov 2010)
b) I chose Hill Country^3. Click on it, and I know it looks like snot, click on it again, and save the image.
c) Go back to Blender, go to Texture buttons (F6)
d) Click add new
e) Select image for the texture type
f) Go to the image toolbar, and upload the texture. Blender will only allow you to upload from the Blender documents, unless if you click on the up and down arrows on the top left of the screen and choose the place where you saved the texture (or picture).
g) After uploading, the X and Y repeats should be smallish, like 6x6, so the changes aren’t noticeable. It will look ugly in the preview, but it will look nice after its wrapped.
6. Render, and 1 minute later, voila! Those are nice looking hills!
7. Now boast in front of your friends!

Noob Note: You need to have your landscape selected if you are in object mode to change the texture, otherwise it will change the texture of the world.

140.5. Reader Contributions 2

You can have an even better result if you use the texture to “bumpmap” the mountains.

1. Press F5 until you are into Material Buttons
2. Select the Map to tab
3. Click on Nor once (the Col option must stay selected as well)

^2 http://oneodddude.net/FreeTextures.php?action=browse&catid=5
^3 http://oneodddude.net/FreeTextures.php?action=display&id=10&page=1&sort=id&catid=5
4. Slide the *Nor* slider to 5 or more (might differ depending on texture size and repeat options)

5. Render with **F12**

**140.6. Reader Contributions 3**

Alternately from making the hill model manually, you can use a program like L3DT$^4$. It uses various algorithms to generate very detailed and realistic terrain heightmaps. It also lets you edit them in a more intuitive way than Blender does. After you have L3DT make your height map, you can export it as a .x file, which you can import into Blender. **Noob Note**: That can be done by going into File->Import->DirectX(.x). And there you have a very realistic landscape mesh with a lot less work. (Noob Question: I want to use Unity3d game engine to create a game, but i want to use blender to create landscapes. To create massive world landscapes, does anybody have any tips? as Unity limits any mesh to 65000 vertices, which i've already passed with my method without doing half the map.)

-If you are using unity 3d just use it for the terrain. Download the terrain toolbox and just use .raw images. Or simply generate from there and save. 65,000 verts is plenty btw. If you insist on using blender for the terrain then model a high poly terrain fist consisting of around 1 mil+ verts. bake the normal map and ambient occlusion decimate your terrain to around 10k or w/e looks good for the game. Then bam you got 10k terrain that looks like 1mil. But to be honest blender terrain texturing is a pain compared to unity. Anyhow hope that helps.

---

141. Landscape Modeling II: Texture Stenciling

This is a continuation of the previous tutorial, Landscape Modeling I: Basic Terrain\(^1\). In this tutorial, we will make our terrain look even better by using some texture stenciling to add multiple textures where we want them in the landscape. This tutorial assumes that you have a basic understanding of how to use Blender (how to add/remove a mesh, how to change views, etc...)

141.1. Creating the Stencil

The landscape from the previous example looks pretty good, but the entire thing has the same texture, so it doesn’t look very natural. Let’s add some rocks to those hills. If we just add a second texture to our material, it will completely cover the previous one. What we want is to have the first texture only show in certain places and the second texture cover the rest. In order to do this we’ll have to create a stencil, which is like a mask that determines where textures appear on the material. The stencil is a black and white image, similar to a heightmap, except the intensity of each pixel determines how much of the next texture will appear (black = 0%, white = 100%). I highly recommend viewing this\(^2\) tutorial for a more in depth description of how stencils work. If you think you have the gist, then continue on here. We’re going to create our own stencil to determine where we want rock in the landscape by ”painting” on the object. *IMPORTANT* The next few steps will be performing temporary modifications to your scene, so be sure to save your file before you continue so that the changes will not be saved!! Also, if you have a subsurf modifier on the landscape, remove that at this time as it drastically slows down the following process.

- Select the landscape object and switch from ”edit mode” or ”object mode” to ”**Vertex Paint mode**”. This is found in the Mode drop down menu, on the 3D View header. This mode lets you paint the object, and thereby change the color value of each vertex. When in Vertex Paint mode, you’ll notice your object change color to a pixelated version of the texture that is applied to it. This is because with that texture applied, each vertex will be drawn with the colors you see.

**Noob Note**: Vertex Paint mode is in the drop down menu that contains Object mode and Edit mode. Just select the object while in Object mode, click the drop down menu, and select Vertex Paint mode from the list.

---

\(^1\) Chapter 140 on page 1073

• Switch to the Editing menu (F9) and you’ll see a new tab called Paint. Notice the sliders labeled Opacity and Size. Opacity determines how much to blend the selected color with the existing colors when you paint. So 0.2 means that when you click, you’ll get 20% of the selected color mixed with whatever is currently there. Over on the right are different options to combine to colors. We want to mix, so as we paint the colors will mix together and give us a nice smooth blend. Size is the size of your cursor while painting, and thus how many vertices are affected. Keep in mind that does not change as you zoom in and out, so a size of 10 can actually paint more pixels if you’re zoomed way out than a size of 30 if you’re zoomed way in.

![Paint](image)

**Figure 877**

• Change the color to black and click the button that says Set VertCol (in 2.48 version, that button is below the color square and named ‘SetVCol’). This will change the color of your entire object to black. You’ll notice that the object is not lit in Vertex Paint mode, so when the entire object is black it can be difficult to see where your hills are. You’ll have to move the camera around to see the shapes.

[Another newbie recommends: if you switch to the “object” buttons (f7) and turn on “Wire” under “Draw Extra” in the “Draw” panel/tab you should see a wireframe on top of the vertex colors you are painting, which makes it much easier to see where the hills are. Remember to switch this back off when you have finished painting.]

• Now we’re going to paint the places where we want rock to show through. Change the paint color to white. It’s less likely that grass will grow on steep slopes, so start painting
Creating the Stencil

the tops and edges of the steeper hills white by holding down LMB and dragging your mouse (think MSPaint). If you didn’t heed my earlier advice and still have a subsurf modifier in effect, the painting will be very choppy, so remove that now.

- As you’re painting, try to make some spots pure white by going over them again and again, but don’t make any one area of white too large as this will make a huge area be all rock, and we’re trying to blend two textures.
- This process can just be trial and error getting the landscape painted the way you want. Once we apply our stencil later you may decide there’s too much rock in one area, or not enough in another and go back and change it. A few things to keep in mind:
  - 20% opacity means that most of the original texture (grass, in our case) will show through, so the rock won’t be very noticeable if at all. You’ll have to go over the same spots a few times to increase the intensity.
  - You don’t want a dramatic change from grass to rock, so be sure to blend white areas with black. That’s why we’re using the 20% opacity instead of just bumping it up to 100%.
  - Make your patches random and spotty. This will end up creating a more realistic effect once we combine the textures.

Figure 878  Painting the stencil onto the landscape

- Once you’re done you should have something that looks like this. Notice the mixture of white and black in some places, how it doesn’t just go from pure white to pure black as you move down the hills. This will make a more natural blend and it will cause random rocky areas mixed in when the grass. Now we need to turn this into our stencil.
- Go to the overhead view (NUM7 ) and make the projection orthographic if it’s not already (NUM5 ).
- Zoom in/out (Mouse Wheel or NUM+ /NUM- ) until the plane almost occupies the entire window.
- Move the 3D cursor and any lamps or cameras away so that they’re not over the landscape and take a screenshot.
• Open your favorite image editor (I’m a traditionalist, so I still like MSPaint), and cut out the image of landscape. This is now your stencil. Save it under your favorite format.

• Re-open the saved version of your landscape to undo the changes we made to create the stencil.

So why did we make our stencil this way? This allowed us to actually paint on our terrain so that we ensure we get the rock exactly where we want it. Using this method, you can customize your stencil to any object, as long as it has enough vertices. For example, if we just had a flat plane made of 4 vertices, this technique would not have worked because we could only paint the corners. That’s why in the previous tutorial I recommended using a high (but not too high) number of vertices in your grid.

141.2. Applying the Stencil

So now we need to apply the stencil to the landscape to mix our grass and rock textures together.

• Return to either Object Mode or Edit Mode (TAB), it doesn’t matter which.

• Go to the Texture menu (F6) and add two new textures in the material (you should already have the grass texture).

• Make texture 2 (the first new one you added) an image and load your stencil from file. Do not repeat this in the x or y directions. We want it to map to the entire object.

• Make texture 3 an image and load your rock texture from file. This one you do want to repeat, just as you did the grass.

• Now return to the Materials menu and select your stencil texture. It’s a good idea to name your textures, materials, objectives, etc... so that they’re easily identifiable.

• With your stencil texture selected, switch to the tab labeled MapTo. Deselect Col (which maps the texture to the color), and select Stencil and No RGB. Stencil will treat this
141.3. Adding Snow

Since you already have some nice mountains, why not add some snow to them? Adding snow is easy. All you have to do is add a fourth texture AFTER all the others. Make this texture the same as your stencil.

- Make sure you’re in Shading (F5) > Texture Buttons (F6) > Textures.
- Click on an empty panel beside Texture Type
- Click on the little box to the left of Add New
- Choose your stencil from the menu (hint: it helps if you name your textures)
- Render and see the results.

If you made your stencil properly, you should have some nice, snowcapped peaks. It’s not much, but it’s enough for a quick fix. If it isn’t even, you probably didn’t make your stencil properly (meaning pretty much all white on the peaks, and not much anywhere else). Of course, there are better ways to do this, ways I wouldn’t know about; I discovered Blender merely three days before the time of writing. I leave it up to you to see the effect: I only have so much room and bandwidth for pictures!

This effect works by saturating the underlying color with white, depending on the amount of white in your stencil. A light gray will saturate it only a bit, whereas a bright, 100% white will cover it very clearly and efficiently. If you look closely, you’ll see that the light gray on the stencil DOES make a difference, but it’s not immediately visible and requires lots of fiddling with the Render Preview and texture options. You might also try fiddling
with the Stencil and NoRGB option, although it worked fine for me with both turned off (I use Blender 2.48a).

Some challenges:

- Try to change the color of the snow. Hint: RGB
- I’ve yet to do this, but try making snow out of a heightmap.

### 141.4. Multiple Stencils

Remember in the first tutorial when I said to leave part of the landscape flat, because I’d be using it later? Well it’s time to use it. I want to eventually use the landscape as the backdrop for a military base, so let’s texture the ground around where the base will go to give it a dirt ground and road leading to it. *IMPORTANT* Just as before, the next few steps will be performing temporary modifications to your scene, so be sure to save your file before you continue so that the changes will not be saved!!

- Switch to the Vertex Paint mode in the mode menu on the 3D View header.
- Go to an overhead view (NUM7) and make the projection orthographic (NUM5).
- Once again, paint the entire object black by selecting the color black in the Paint tab and clicking on Set VertCol.
- For the next few steps, you may need to TAB back and forth from Vertex Paint mode to Object mode to make sure you’re painting in the correct area. Make the opacity of the painter 1.0 and the size 10 so that we can work very precisely.

![Figure 882](image)

Figure 882  The stencil for our future base

- Paint an area over the flat terrain in the shape of a generic military base, like you see here.
- Reduce the opacity back down to 0.2 and increase the size to 20.
- Paint the road leading away from the base. We’ve reduced the opacity and increased the size so that the road will blend more with the landscape around it instead of being more defined like our base.
• Once you have your stencil looking the way you want, take a screen shot and save it. Then revert back to your previous environment (before you started painting on it).

• Go to the Texture menu (F6) and add two new textures.

• Load your stencil into the forth texture (the first new one), and the dirt image into the fifth texture. Once again, remember to set the x and y repeat for the dirt texture.

• In the Materials menu (F5) select your new stencil and go to the MapTo tab. Deselect Col again, and select Stencil and No RGB. Notice the new preview.

• Wait a second, where’s the dirt path?!? Here’s the problem and the reason I’ve included this section: stencils are cumulative. That is, the first stencil defines which portions of ALL successive textures will be drawn, including other stencils! In order for our new dirt path to show up, we need to make sure it’s part of the first stencil.

Figure 883  Both stencils combined into one

• Open your first stencil (the one you used to add rocks to the hills) in your image editor and combine the new stencil with it. The result should appear somewhat like this. Be sure that when you combine your dirt stencil with your rock stencil that the dirt stencil remains the same size and in the same place. That is, you want the two to be perfectly aligned.

• Reload your first stencil on your material, the one we used for the rocks. Now the preview should look the way we want it to, and if you render you will see your new dirt area on the flat part of the landscape. You can add even more stencils the same way. Here is how all of the textures blend together:
Once again, if you have any issues with the tutorial, or feedback (positive or negative), drop it in the discussions.
142. Landscape Modeling III: Exporting as a Heightmap

In this tutorial, I will show you how to export your beautiful terrain to a heightmap that can be used in most 3D graphics engines. The benefit to doing this as opposed to just exporting your mesh is that many engines have a special process for dealing with terrains as opposed to regular meshes where it divides the terrain up into different sections so that it can subdivide regions closer to the camera more for greater detail, and also cull (not render) regions outside the camera’s field of view, saving precious processing time. This structure is called an oct tree\(^1\) and is a highly optimized way to render large meshes such as terrains.

Before I begin, I must give credit to the Creating a Heightmap from a Plane\(^2\) tutorial on the Blender wiki\(^3\). This is how I learned to do this trick, and most of what I will cover came from this tutorial. I’m simply including it here with the other landscaping tutorials I’ve written for convenience.

142.1. A Word About Heightmaps

I will briefly cover what a heightmap is and how it’s useful for those who may not know. If you are familiar with heightmaps, you can skip ahead to the next section.

---

A heightmap is a grayscale image that uses various shades of gray to represent different elevations across a map. Since the images are 8-bit (with the exception of some RAW formats that are 16-bit), you have 256 different shades of gray, ranging from pure black (0) to pure white (255). Black represents the lowest elevation on the map, while white represents the highest. Many 3D graphics engines already have functions to read in a heightmap and generate terrain from it. The way it does this is it creates a grid of vertices (like we are going to do in Blender in just a moment), and uses the heightmap to determine the elevation of each point on the grid. The more intense the pixel color (the closer it is to white), the higher the elevation of that vertex. In most cases, if the resolution of the heightmap is smaller than the resolution of the terrain, the engine will interpolate the vertices in between those set by the heightmap. For example, if your heightmap is 256x256 and your terrain is 1024x1024, your heightmap will determine the elevation of every fourth vertex, and the three in between will be interpolated.

Note that these values do not represent the absolute height of any given pixel, but rather the height relative to the rest of the map. That is, your heightmap does not represent a landscape with altitudes ranging from 0 to 256. When importing a heightmap, you can specify the minimum and maximum altitudes for the map, and the whole thing gets scaled. For example, suppose you decide the minimum is 1000 feet, and the maximum is 5000 feet. When the terrain is rendered, black pixels will represent 1000, white pixels will represent 5000, and a pixel that is exactly in between black and white (128) will represent 3000 feet (half of the sum of min and max). This makes heightmaps relatively flexible.

Unfortunately, as you may have already noticed, there is a limitation of using heightmaps. Since you only have 256 shades of gray, you only have 256 possible elevations. This causes a problem. No matter how precise your vertices may be in the mesh that you model, no matter how smooth you may have it looking, each point will get rounded off to an integer value between 0 and 255. When used to render a terrain, this can cause a ”stair step” effect as the terrain goes from one discrete elevation to the next instead of making a smooth transition. But there are ways to avoid this, which I will cover later.
I apologize if you’re scratching your head right now saying “Huh?” For a further explanation and example, check the Wikipedia page on heightmaps\(^4\).

### 142.2. Creating the Material

![Figure 887 The terrain that will generate the heightmap](image)

To begin this tutorial, I will assume that you already have a landscape that you want to create a heightmap for. If not, read my first tutorial, Landscape Modeling I: Basic Terrain\(^5\), to quickly create something. **WORD OF CAUTION !!!** If you’ve already created a landscape, try to remember the exact size of the plane that you used. If you’re about to make one, it’s okay to scale the plane to have a larger surface to work with, but REMEMBER how much you scale it by. This will make things easier later. I recommend just working with the default 2x2 plane or grid and zooming in on it. You may also want to backup your scene since we’ll be changing a few things.

To create the material we need, do the following steps:

- Remove any existing materials that may be applied to the terrain.

**Note**: to remove a material, I think you need to go to the links and pipeline window in the shader section and click the little "X" underneath the words "link to Object"

- Add a new material in the Shading tab (F5).
- Go to the Textures tab (F6) and add a new texture. This should be the only texture on your material.
- From the Texture Type drop down menu, select Blend.
- In the same window, find the Colors tab and select Colorband. This will let us define the blend pattern, which by default fades from black with full transparency to a solid cyan. Why cyan? I have no idea. It’s an odd default.


\(^5\) Chapter 140 on page 1073
- Select the black color by clicking on the left side of the color band. You should see a little black and white bar selected.
- Increase the Alpha all the way up to 1 by adjusting the slider labeled "A".
- Select the cyan color and change this to a solid white.
- What you have now should look like my color band below.

![Figure 888: The blend color band](image)

- Return to the Materials tab (the red ball icon next to the cheese looking icon).
- In the Material pane, select the Shadeless option to disable lighting on the material.
- To the right, find the pane labeled Map Input. In the bottom of this pane is a grid that by default reads:

  X Y Z

  XY Z

  XYZ

- Set all three rows to Z so that the texture will map entirely to the Z coordinate.
- In the preview window to the left, if you select the sphere or cube you should see that it goes from black on the bottom to white on the top. That’s the effect we want for the terrain. Remember, in a heightmap, black represents the lowest point and white the highest.

![Figure 889: Map the input to the z-axis and make the material Shadeless](image)
• Finally, switch back to the Editing tab (F9) and click the Set Smooth button to enable Gouraud shading\(^6\) so that everything appears smooth.

### 142.3. Setting up the Camera

That’s all we need to do for the terrain itself. Now what we’re going to do is setup the camera in such a way that when we render the scene we’ll get an orthographic projection straight down on the terrain so that we can save it as our heightmap.

- If you still have any lights or cameras in the scene, delete them.
- Switch to the top view (NUM7) and place the 3D cursor at the origin (0, 0, 0) by left clicking near the origin, hitting \texttt{SHIFT+SKEY} and selecting \texttt{Cursor to Grid}.
- Add a new camera, \texttt{Space->Add->Camera}. This will add a new camera to the scene that is looking straight down.

![The camera needs to be above the terrain](image)

\begin{itemize}
  
  
  \item Switch to a side view (NUM1 or NUM3) and move the camera up the Z axis so that it is above the highest point in your terrain. Even though the view is going to be orthographic, and therefore distance doesn’t matter, the entire terrain still needs to be in front of the camera.
  
  \item Now, with the camera selected, go to the Editing tab (F9) and select the ”Orthographic” button. This will change the camera to an orthographic projection which basically ignores the z-coordinate for all vertices (except for determining which pixels should be in front of others).
  
  \item Just above the orthographic button is a value labeled ”Scale”. Remember earlier when I told you to remember how big your terrain is? This is why.
  
  \item Change the Scale of the lens (default: 6) to match the size of your terrain. If you left the plane the default size, this should be 2. If you scaled the plane up by a factor of 20, as

suggested in the "Landscape Modeling I: Basic Terrain" tutorial, this should be 40 (the plane is initially 2 units square).

- Now go to the scene tab (F10) and under Format, change the SizeX and SizeY to be the size you want your heightmap to be. For most graphics engines, this is required to be either a power of 2 ($2^n$) or one more than a power of 2 ($2^n+1$). So try something like 256 (or 257 if you need it to be $2^n+1$).

![Figure 891](image1.png)

**Figure 891** What the terrain will look like from the camera view

- Now, if you switch to the camera view (NUM0) you should see a "flat" square that completely fills the dotted box which represents the camera's field of view.

![Figure 892](image2.png)

**Figure 892** The rendered image will be your heightmap.

- Render the scene (F12). You should be looking at your heightmap. Hit F3 to save the rendered image and you’re good to go!
Since this image has no color, and some engines require that your heightmap be a grayscale image (only one color channel instead of three), select the BW button in the Format pane before rendering. This will render it as a grayscale image instead of a color image.

Figure 893  Select BW to save as a grayscale image.

142.4. Avoid Stair-Stepping

As mentioned earlier, exporting the heightmap as an 8-bit image (Blender doesn’t support any 16-bit formats that I’m aware of) has the drawback that you only have 256 discrete height values which can cause a stair-step effect when the terrain is subdivided. Ideally, you could use an application that can export the image in a 16-bit raw format, such as Terragen. But this is a Blender tutorial, so we’ll not go into that. =P

142.4.1. Reducing the resolution

One way you can “smooth” out the rendered terrain is to actually reduce the resolution of the heightmap. This may sound counter intuitive, but bear with me. Suppose you have a heightmap that is a simple blend from black to white going from left to right. If your heightmap is 1024x1024, you will get 4 columns of each height since you only have 256 different values. In other words, your grayscale will look something like this:
If you try to render terrain from this, you’ll get 4 points with 0 altitude, 4 with 1, 4 with 2, and so on, creating the stair-step effect.

Now suppose you make the same heightmap, but reduce its size to 256x256. Now you’ll have 1 column for each height, and your grayscale will look something like this:

012345678...
012345678...
012345678...
012345678...
012345678...
012345678...

You may be thinking, “But then my terrain will be smaller, or less detailed.” But it turns out the opposite is actually true. Consider applying the above heightmap to a terrain that is 1024x1024. The values from your heightmap will be applied to every 4th vertex, and the ones in between will be interpolated. So instead of having something like:

0.0 0.0 0.0 0.0 1.0 1.0 1.0 1.0 2.0

which is what you would get with the 1024x1024 heightmap, you’ll actually get something like this:

0.0 0.25 0.5 0.75 1.0 1.25 1.5 1.75 2.0

Where the integers are the values from your heightmap and the fractions are interpolated values. This is assuming that whatever engine you are using will interpolate the values between heights read in from the heightmap.

At the present time, this is the only method I have verified that helps reduce the effects of stair-stepping. As I try different techniques I will update this page with them. For example, I know that Adobe Photoshop can export images in 16-bit raw formats, but I haven’t tried it yet so I don’t want to suggest it as a solution.

As always, I do these tutorials for you, the reader. So if you have any issues with the tutorial, or feedback (positive or negative), drop it in the discussions. I’ll try to keep an eye on it to see what people have to say and update accordingly. Moohasha7 (talk8) 19:02, 17 December 2007 (UTC)
143. Bump Mapping

1 Information

Applicable Blender version: 2.49

Bump Maps are textures that store the relative height of pixels from the viewpoint of the camera. The pixels seem to be moved in the direction of the face normal to or away from the camera. You may either use greyscale pictures or the intensity values of an RGB-Texture (including images).

Bump Maps are easy to apply. They work well on flat surfaces, only to some extent on curved surfaces. On curved surfaces it is more easily noticeable that you don’t create real 3D structures. The visible effect depends on factors like lighting, specularity of your material, camera angle, distance and so forth.

- Add a new texture to your object.
- Activate the Nor button in the Map To panel.
- Set the depth of the bumping with the Nor slider.
- Use the texture type Image and load your bump map.

Bump maps should contain hard transitions between black and white. A gray wedge (e.g. a linear blend texture) would be hardly visible in the rendering.

143.1. Creating Bump Maps

You can easily create Bump Maps with Blender yourself, this is especially useful if you have modeled some small details on a surface and you realize at the end that your scene will get
Bump Mapping

too complex. You could also use the Bump Maps in a 2D application like Gimp or other, similar programs.

I will create an animated bump map in highest possible quality, it is not always necessary to make such an effort. The goal is to create a wave effect and make an image sequence of it, to be used as a bump map. The original object has 600,000 vertices, the object the map is applied to has 8 vertices.

143.1.1. Setting up the scene

Figure 897 Image 2a: Setting up camera and object in the 3D view.
• Open the default scene and remove the cube.
• Insert a plane and change to edit mode.
• Crease its edges with +1 (Shift-E).
• *Subdivide multi* with 11 cuts.
• Change to object mode.
• *Add a SubSurf* modifier with a render level of 6.
• Add a *Wave* modifier.
  • *Time Sta:* -10
  • *Height:* 0.2
  • *Width:* 1.5
  • *Narrow:* 1.5
• Set the camera dead upon the plane.
  • X/Y/Z: 0/0/5. You can use the *Transform Properties Panel* to bring the camera to a certain position, the Z-Position is important in this case.
• Set the camera lens to 80.00 (*Editing Buttons->Camera Panel*).

The plane should now fit exactly into the camera view.

• Save your file.

We’re going to use the Z-Buffer information to create the bump texture. The Z-Buffer contains the distance from the camera, this is exactly what a bump map is. To render the Z-Buffer information as an image, we’re going to use *Composite* nodes. To get the highest possible quality, we will use *Open EXR* as file format, this allows us to store the Z-Buffer information with a numerical accuracy of 32-Bit floating point, instead of a meager 8-Bit value.

### 143.1.2. Render settings

• Change to the *Anim* tab buttons (f10).
• Set *End* to 40.
• Activate *Do Composite*.
• Select *Open EXR* in the *Format* panel, set *SizeX/Y* to both 600 (square image for the square plane).
• Set the *Output* directory to //BumpAnim/>. This creates a subdirectory to the file where the image sequence will be stored. Don’t omit the slashes.
143.1.3. Node editor

Now the setup for the composite nodes.

- Open a Node Editor window.
- Select Composite Nodes.
- Activate Use Nodes.

A Render Layer and a Composite node will be inserted automatically.

- Add->Vector->Map Value.
- Connect the Z -Output of the Render Layer to the Value input, and the Value output to the Image input of the Composite node.

If you render now the image is plain white, we have to talk a bit about the Map Value node. The Offs value is the distance from the camera where the Z-Buffer should start (in negative BU). It is not to important to get the best range, because we use OpenEXR, but if you would like to use PNG instead, you have to select this value carefully.

- Set Offs to -4.8. This is the smallest distance from the camera needed. You can measure this value if you use the Camera Clipping, or if you render and move your mouse with pressed LMB above the render window.
- Set Size to 4. The size value is a bit complicated. This is not directly the value range, instead \( range = \frac{1}{size} \), and \( size = \frac{1}{range} \).
Applying the animated bumpmap

- If you want to include the Z-Values from -4.8 up to -5.05, the range is 0.25, so Size is 4.
- If you want to include the Z-Values from -4.5 to -3.5, the range would be -1, so Size would be also -1.
- If you want to include the Z-Values from -4.5 to -5.5, the range would be 1, so Size would be 1.

Render the animation.

**Figure 899 Image 3a:** The Bump Map applied Video⁹.

http://www.vimeo.com/4959751

- Open a new file.
- Select the default cube and change to the Texture buttons.
- Use the texture type Image.
- Load the first OpenEXR-Image from the directory where you have stored the sequence.
- Activate Sequence in the Image panel, set Frames to 40.
- Change to the Material buttons.
- Activate Nor for the texture and set the Nor slider to 25 in the Map To panel.
- Set the mapping to Cube in the Map Input panel.

This is it. Pretty much the same look as with the real deformation, but using much less resources.
144. Normal Mapping

Noob Warning: This technique is best used for models and animation, and is not well used and applied in the Blender Game Engine.

Normal Mapping in 3D graphics development is the process of using an RGB\(^1\) color-map to create a three-dimensional relief on a two-dimensional plane. The source for the normal map in Blender can either be a texture already installed in Blender, or using an external picture-file (.jpg, .jpeg, .bmp, and so on) and loading it as a normal map. One great aspect of Blender and normal maps is that Blender can very easily be used to create normal maps that can be turned around and used in blender to reduce poly count. This tutorial will show the various ways to create a normal map and how to apply different normal maps to your model in Blender.

![Poly Count: 1]

Figure 900

---

Sections within Chapter:

1. Texture Normal Mapping\textsuperscript{2}
2. Color Map Normal Mapping\textsuperscript{3}

\textsuperscript{2} Chapter 145 on page 1105
\textsuperscript{3} Chapter 146 on page 1109
145. Texture Normals

145.1. The Texture-Normal

To familiarize yourself with normal maps and how they work, we will begin by using the texture engine in Blender to create our first normal map. This process is very useful for creating quick and non-specific normal maps for your projects that need a bit of texture.

To begin, open blender and whatever your basic load settings are, in the 3D view, delete everything so the field is clear. (AKEY to select all, then XKEY to delete)

Move the 3D cursor to the center of the X, Y, and Z axis, and switch to top view (NUM7) or orthographic view (NUM5). Hit Shift-SKEY-4KEY then CKEY to center your view now.

![Figure 903](image)

Add a mesh plane to the field, and scale that plane to five times normal size. (Shift-AKEY, select Add->Mesh->Plane, TAB out of edit mode, SKEY then 5KEY to scale five times size.) This plane is going to be our base—it will remain untextured so it can be used as a comparison. Don’t give it a material.

Now, with the 3D cursor still on the center, add a mesh cube to the field. Scale this cube 3 times in the X and Y directions, and 0.5 times in the Z direction. (Shift-AKEY, select Add->Mesh->Cube, TAB out of edit mode, SKEY, Shift-ZKEY, then 3KEY to scale
3 times in X and Y directions, **SKEY**, **ZKEY**, then .KEY-5KEY for Z.) This cube will serve as our texture comparison.

![Image of Blender interface](image)

**Figure 904**

For this tutorial, let's use the "Musgrave" texture to make a 3D relief.

Select the cube, and then in the Buttons Window select the material index. Give the Cube a material, and make this material any light color you wish to differentiate it from the base plane (darker colors won't show the relief that well). Now select the texture icon in the material window. Add a new texture, and make that texture Musgrave.

-----

Make the settings for Musgrave the following:

- **Type**: Multifractal
- **H**: 0.5
- **Lacu**: 3
- **Octs**: 2
- **iScale**: 0.45
- **NoiseSize**: 0.075

1106
Excellent, now we are ready to show what we have done! If you return to the material window in the material index, then you will probably be wondering what’s wrong—your preview window just shows a sphere with a huge purple splotch! Don’t worry, we just haven’t applied the texture as a normal map yet, it’s still just a color map. Click the "Map To" tab in the material window and you will see a whole row of buttons, menus, and sliders. Currently on the top row of buttons the "Col" button is depressed, which is how the texture knows to apply as a color map. Click the "Col" button to remove the color from your preview window. Now click and depress the "Nor" button and look what happens! An intricate texture embeds itself on the sphere in the preview window. The Musgrave texture has caused a depression texture within the preview. If you happen to click the "Nor" button again, you will see the letters turn yellow and now that means the Musgrave texture is causing an elevation texture. Click it once more and the texture is turned off. Keep the "Nor" button depressed for this tutorial.

Now that you know how that works, let’s see what it did to your cube. First, go to front view (numpad-1) and zoom out a bit so about 10% of the screen is filled with your cube. Select the cube and hit Shift-S-key-4-key then C-key to center your view. In the upper-left corner, add a sun-lamp (Shift-A-key, Add->Lamp->Lamp). Adjust the "Dist" Slider to a very far length, to make sure it reaches the cube. In the upper-right corner (make it a little closer to the cube) add a Camera (Shift-A-key, Add->Camera).
After your first render, I'll let you know that you can adjust the depth of the shading. Select the cube, and in the material index in the "Map To" tab, in the mid-right area, there is a slider called "Nor" that should be set at 0.5. Just to test, set it to 0 and render to see what happens. Then set it to 2 and render to see the results.

After you see it rendered, you probably realized that the edges of the cube were very sharp and didn’t have the rocky texture. This is because the 3D relief on the cube is fake--it’s not actual 3D, it’s the computer just calculating where light should bounce off and in what direction. Imagine how many faces it would have taken to create this texture shading without Normal Mapping.

If you want, you can move the lamp around and see how the light moves around the fake-bumps.

This is best if you just need a non-specific texture, such as asphalt, cement, carpet, or even fabric. Now if you want to do something like make a low-poly brick wall, you will need to a specifically-tailored normal map for such thing. The next section will show you how you can make your own normal map and apply it as well.
146. Color Map Normals

146.1. The Color-Map-Normal

For more advanced Blender users, you probably have at one time or another wanted to create something very detailed and realistic, only to realize that one modeled head or one cool building has taken an enormous amount of memory, and rendering (or worse, animating!) something like that would probably take days! Well there is an awesome trick you can use to create intricate details and design shading, with a relatively low amount of faces. You can use blender to create and apply normal maps, which are RGB colored maps that can be used as a texture to calculate how light will bounce of an objects surface. All you need is blender and photo-editing software to tweak the picture a bit.

146.2. Creating a Normal Map

You can very easily create a normal map once you figure out all the necessary settings. You can start by either making a high-poly count version of your object, or making the material that will be applied to the object to make the normal map.

146.2.1. High-Poly Version

We will first start by making a simple object with a high-poly count. Start up blender, and let’s delete everything there first, then go to top-view, orthographic, and start by adding a camera.

![Figure 909](image_url)
Next, start with a circle, with a radius of 2 and 32 vertices in circumference. Keep it filled. Select the edges of the circle, keeping the inner vertex unselected, and extrude edges only. Scale the new vertices by 1.1. Repeat this with only the outermost vertices 6 more times, until you have a ring of 7 vertices and a center vertex. Now, we will refer to the center vertex as center, the innermost ring as Ring 1, and the outermost ring as Ring 7. Deselect all vertices, then select all vertices of ring 2, 4, and 6 (This can easily be done by holding the Alt and Shift keys, then selecting an edge adjoining two vertices of the same ring for each ring). With these rings selected, move it 0.4 in the Z direction. Now, let’s smooth this bowl out. In the editing index, under the modifiers tab, add a subsurf modifier of 2, and then apply the modifier. Then under the links and materials tab, select Set Smooth. Next after the object looks all nice and smooth, select your Camera and move it positive in the Z direction so it’s positioned directly above the object looking straight down at it, and edit the camera Lens properties so that it is set to Orthographic, and scale the lens so that it includes all the bowl and fills up the camera space as much as possible.

\[\text{Figure 910}\]

146.2.2. Creating the Color-Map Material

Now, to be able for the Render to apply the colors on the right areas of the object. For this, we will start by applying a material the bowl. Make this material 0.0 on the R, G, and B spectra, and depress the shadeless button. Now, go to the textures index and add 3 textures to the material, and set them as “Blend” textures with “Lin” depressed (a linear calculation). For these 3 textures, name them something to do with either ”Red”/”Green”/”Blue” or ”X”/”Y”/”Z” in that order, because doing this will ensure you keep the channels in order. The following image will show all settings that need to be set to make the material work.
As a final note in this subsection, what I suggest doing is deleting the bowl and saving the file as something like "BlenderForNormals.blend" so if you ever want to make another normal, the area and materials are already set up and all you need to do is import or create the object. Just a suggestion.

146.2.3. Applying as a Normal Map

Well we got the image, now let’s apply it and make it come out as a low poly-count texture. So, let’s continue by deleting the high poly bowl and instead add a plane in the middle of the camera. Now, apply a material to the object and make the material hard, soft, rocky, wet, or however you want it to look. After you’ve made the plane how you want, add a texture to the material, and make it an image texture. Load the image as the texture, depress the normal map button, and set the normal spacing to object. Now, on the materials index under the Map To tab, make sure the Col button is relieved and instead depress the Nor button. Just add a lamp above the plane, and Render! You should now have the same shading effect as the original bowl, with about 0.01% of the original faces—one.

If your Render comes out odd, it may be because the shading is being applied too heavily. You can alter this by adjusting the Nor slider directly below the "Mix" drop-down menu. O used about 0.2 and it came out just fine, like this picture.
Congratulations, that’s all there is to normal mapping. It’s a simple technique with many great uses!
147. Introduction

Blender’s *Node Editor* lets you assemble various processing blocks (*nodes*) into combinations which feed data to one another along connections that you specify to produce complex effects. These effects can be used in three different ways: as textures, as materials, or for compositing. The Node Editor makes different kinds of processing blocks available, depending on which of the three kinds of effects you are producing:

- Texture nodes
- Material nodes
- Compositing nodes
148. Texture Nodes

### Information

Applicable Blender version: 2.67

Texture nodes allow you to produce textures that are the result of complex computations. This tutorial will just scratch the surface of what’s possible.

148.1. A Simple “Rainbow” Texture

Start with a new Blender document. Delete the default cube. Add a new plane object. In the Material context in the Object Properties window, click the icon to the left of the material name to assign a material to the plane (there should already be a default unused one called “Material”). In the Texture context, there should already be a texture called “Tex” assigned to this material. Now split the area showing the 3D view into two side-by-side areas. In the right-hand area, bring up the Node Editor. In its area header, you should see a group of 3 little icons next to the menu;

Fig. 914

; click on the middle one for Texture Nodes. You will see appear, further along the area header, a popup menu containing the names of the textures so far created in your document: this should be showing the name “Tex” of the texture you assigned to the material for your plane object. And to the right of that, there should be a checkbox titled “Use Nodes”. Check that, and you should see a pair of initial nodes immediately appear in the editor: an input node titled “Checker” and an output node titled “Output”, with an editable field in it containing “Default”.

1115
Texture Nodes

There must be at least one output node in the texture definition; the data fed to this will make up the final texture. The names you assign in the Name field will appear in the Texture context in the Object Properties window, in a popup menu titled “Output:”, with one item for each output node. Initially this may show “Not Specified”: change it to “Default”.

**Note:**
**Navigation in the Node Editor:** As in most Blender windows, you can scroll around by dragging with MMB, and zoom the view in and out with the mouse wheel.

Each node window has little coloured circles (terminals) on its left and right edges; the ones on the left edge (if any) are inputs for feeding data from other nodes, and the ones on the right edge (if any) are for supplying data to other nodes. Thus, output nodes have no outputs (they’re the final destination for the data), while input nodes have no inputs. Other node types represent intermediate stages in the processing, so they will have both inputs and outputs.

Back in the Node Editor, click on the titlebar of the “Checker” node window and use either X or DEL to delete it. Note that, unlike deleting objects in the 3D view, there is no confirmation popup: the node immediately disappears. (Of course, you can use CTRL + Z to undo operations in the usual way.)

Now go to the “Add” menu (or use the usual SHIFT + A shortcut), find the “Input” submenu, and select the “Coordinates” item. This will add a new input node, which just produces the unadorned texture coordinates as its data. The newly-added node will follow the mouse around; press LMB once you have moved it to a convenient place. You will see the new node has one output terminal, titled “Coordinates”. Left-click on this, and drag to the input terminal in the Output window with the word “Color” and a small rectangular colour swatch next to it. Voilà! A line (effectively a wire) should appear connecting the two terminals, and you should see the big square colour swatch in the Output window change from black to a whole rainbow of colours. That’s your texture!
If you make a wrong connection, you can move or cut it by dragging the output end of the wire away from the input terminal it is attached to with \( \text{LMB} \), to either a new input terminal or simply into an unoccupied space between nodes; when you let go the button, the wire will attach to the new input terminal in the former case, or disappear in the latter case.

At this point, you should be able to hit \( \text{F12} \) to render, and you will see your plane object with the rainbow texture applied. You can see why I chose a Plane object: being flat, the entire texture is visible from one camera angle.
148.2. Scalars Versus Vectors

The wires carry numbers between nodes. These numbers can be of two kinds: a scalar is a single real quantity, like “0.5”, while a vector can consist of two, three or four scalars in a sequence, like “(0.5, 0.75, 0.2, 1.0)”. The number of components in a vector is also known as the dimension of the vector. Two-dimensional vectors can be used to represent texture coordinates, while three-dimensional vectors can represent positions in space. Colours can be represented with 3 dimensions (R, G, B or H, S, V) or 4 dimensions (RGB or HSV plus alpha channel).

Some nodes operate on scalars, while others operate on vectors. And there are nodes where some terminals input or output scalars, while others input or output vectors.

Try this. To the above Coordinates and Output nodes, add a “Separate RGBA” node (under the “Color” submenu of the “Add” menu). Feed the output from the Coordinates node to the “Color” input node of the Separate node. Now connect just the “Red” output terminal from the Separate node to the output node (if you move the newly-created node on top of the existing wire, this should happen automatically):
See how the Output swatch shows just a greyscale ramp running from black on the left to white on the right? This shows how the first dimension of a vector is interpreted as the red component in an RGB colour, but as the X coordinate in a position. Remove the output from the Red terminal (delete the existing wire), and take it from the Green terminal instead (by dragging a new wire from Green to the Color terminal on the Output node); now you will see the ramp going from black at the bottom to white at the top. The second dimension of a vector is the green component in an RGB colour, and the Y coordinate in a position.

The terminals have different colours to remind you what type of data they should be used for (purplish for coordinates, yellow for colours, grey for scalars), but as far as Blender’s Node Editor is concerned, colours and positions are not actually different types. Both are vectors, and one can be interpreted as the other. This can be (ab)used for some creative effects! For example, the name of the “Separate RGBA” node says it’s for separating an RGBA colour into its components, but here we are using it to take apart a coordinate vector instead.

Note also in the above, that the Color terminal on the Output node expects a vector RGB colour, but when you feed it a single colour component (i.e. a scalar), it simply replicates it the necessary number of times to make a vector of the required dimension. Since all components of the RGB colour are the same, you get a shade of grey.
Material nodes look very similar to texture nodes, and indeed there is a fair amount of overlap in functionality. Some important differences are:

- Functions for performing spatial transformations (e.g. rotation and scaling) are only available for texture nodes.
- Functions for altering diffuse versus specular colours and rendering parameters, like translucency, are only available for material nodes.

### 149.1. ASimpleGraduatedMaterial

First of all, let’s set up a really basic modeling scene to show off the node-based material you’ll be creating in a moment.

Open a new Blender document, with the default cube, default light and default camera. Create a plane object. Rotate and position that so it lies behind the cube from the camera’s viewpoint. Scale the plane up to say, 4x, to form a decent-sized backdrop. Assign it a new default material, and a texture with some detail to it; I used a simple Marble with default settings, except under the “Map To” miniwindow I changed the colour to a medium grey from the default magenta, to stop it hurting my eyes.

Now select the cube. Scale it 3x in the Z-axis; the elongated proportions should show off a gradation more nicely. In the “Material” miniwindow, set the “Col” (diffuse) colour to white, and the alpha to zero. In the “MirrorTrans” miniwindow, turn on “RayTransp” and set the “IOR” to some suitably refractive index, say 1.5 for glass.

Hit F12 to do an initial render, just to confirm you’ve got everything nicely arranged.

![Figure 918](https://via.placeholder.com/150)

With the cube still selected, open the Node Editor. By default, the Material Nodes mode should already be selected, and the combo box should be showing the name of the material you assigned to the cube; select it if it’s not. Click the “Use Nodes” button, and immediately two node windows should appear, a Material one and Output one.

Click on the title of the Material node window, and use XKEY or DEL to get rid of it. Go to the “Add” menu, “Input” submenu, and add a new “Geometry” node. Also add a new “Extended Material” node. And from the “Convertor” submenu, a new “Separate RGB” node. In the middle of the Extended Material node window, there is a popup menu showing you the names of the materials in your document; select the name of the material you previously assigned to the cube again.
Material Nodes

Make sure there are no wires running between any of the nodes; now run one from the “Color” output terminal on the Material node to the “Color” input on the Output node, and one from the “Alpha” output on the former to the “Alpha” input on the latter.

Notice that, next to each of the input terminals in the Material window, there is either a field for entering a scalar value (grey terminals), or a button which pops up a little set of controls for letting you specify X, Y and Z components for a vector (blue terminals), or a colour swatch which pops up to let you pick a new colour (yellow terminals). This way, you don’t have to make connections to all the inputs, or indeed any of them; any unconnected inputs will be set to the constant value that you specify.

Anyway. connect a wire from the “Global” output of the Geometry node to the “Image” input of the Separate RGB node. “But geometry isn’t a colour!?” I hear you cry. But as explained on Texture Nodes¹, a vector is a vector. Feeding in a position instead of a colour to Separate RGB means its outputs are not the R, G and B components of the colour, but the X, Y and Z components of the position. So run another wire from the B (i.e. Z) output of Separate RGB to the Alpha input of the Extended Material window. The resulting layout should look like this:

---
¹ Chapter 148 on page 1115

1122
Now you’re ready to render. But before hitting F12, hit JKEY to switch render buffers. That way you still have the previous render to compare with. Once the render window comes up, you can hit JKEY to alternate between the renders.

Here’s what my node example looked like (note I turned the energy of the lamp down to 0.5, otherwise it seemed too bright):

Notice the gradation of transparency along the Z-axis, from fully transparent at the bottom to fully opaque at the top.
For added fun, try taking the material Alpha setting from the R or G outputs of the Separate RGB node instead, just to see the gradation orient along the X or Y axes.
150. Compositing

Information

Applicable Blender version: 2.67

Compositing is the combination of multiple sources of visual input into a single, final image. This is common functionality in expensive, commercial video editors. Some of these (such as Adobe After Effects) use a layer-based compositing engine. Others (such as Apple Shake, The Foundry’s Nuke, and eyeon fusion) use a more powerful node-based compositing engine. Blender features a very advanced and powerful compositing engine through the use of the Nodes Editor window. Although the challenge of learning to use nodes may seem intimidating, it can be very rewarding because of the professional-looking final products that can be easily produced.

150.1. Compositing Example

In this tutorial, we will see how compositing, combined with render layers, can produce some effects that are difficult or impossible to achieve just by straight rendering of a 3D model.

Start with a new Blender document. For a change, let’s use the default cube. Assign it a new material. Keep all the settings at default, but in the Shading panel, set the Emit value to 1.0 and give it an interesting diffuse colour.

Go to the Render context
Compositing

Figure 921

, look for the Post Processing panel, and check the “Edge” box. This will draw a black outline around all objects. If you hit \[
\text{F12}
\] to render right now, you should see something like this:
So far, not very exciting. Now go to the Render Layers context
You should see there is already an initial default layer called “RenderLayer”. If you look in its Layer panel, you should see checkboxes indicating all the passes of the rendering process to include in this layer. Look for the “Edge” checkbox, and uncheck that. Now click the icon next to the list of layers, to add a new layer. Look in its Layer panel, make sure “Edge” is checked, and uncheck all the other checkboxes in the “Include:” section.

Now open up a Node Editor window, and look for the three icons to the right of the menus, showing what kind of nodes to edit:
; click on the middle one (if it’s not already selected) to enable compositing nodes. Now check the “Use Nodes” box to the right of it. You should now see the initial default node setup, with a single Render Layers node feeding the initial default render layer directly to the output:

Add another Render Layers node. From its layer popup menu, select the second render layer you created, the one producing the edge outlines (which should be called “RenderLayer.001” if you didn’t change its name).

Now, add a Blur node (Filter submenu of the Add menu). The default Gaussian kind of blur will do fine. Put nonzero values (e.g. 1) into the X and Y fields (otherwise the blur
Size value will have no effect). Give it a Size value of, say, 20. Connect the Image output of the first render layer (the one doing everything except the edge outlines) into its Image input.

Add an Alpha Over node (from the Color submenu of the Add menu). Feed the Image output from the Blur node into its upper image input, and the Image output from the second render layer (the one producing the outline edges) into its lower image input. Leave the Factor at its default 1.0. Connect the Image output of this Alpha Over node to the Image input of the Composite node (the final output).

When you are done, check that your connections look like this (remember, the exact positions of the nodes are unimportant, except for clarity; what’s important is the connections between them):

*Figure 926*

The effect of this is to blur the rendering of the cube (apart from the edge outline), and then put the edge outline back on top of it. If you hit F12 to render now, you should see something like this:
150.2. Things to Try

What happens if you put different values into the X and Y fields of the Blur node? Try making the X value different from the Y value.

What happens if you get the inputs the wrong way round into the Alpha Over node?

Try the other blur types available from the menu in the Blur node.
150.3. Other Tutorials

Composite Nodes Video Tutorial (2.49b): http://www.youtube.com/watch?v=AAnxoJsdAAM

Vector Blur Tutorial (2.49b): http://www.youtube.com/watch?v=qY4WcNgEXv8

Depth of Field (DOF) Using Composite Nodes (2.49b): http://www.youtube.com/watch?v=HBomEv-bEtw
You may be familiar with the time-travelling machine known as the TARDIS\(^1\), which is much bigger inside than it appears from the outside. Alternatively, you may have come across the concept of a *portal\(^2\)* in science fiction, which lets you instantaneously move from one space/time location to another, just by taking a step.

In this tutorial, we will see how to create an animation where a doorway leads from one world into a completely different world that clearly cannot be occupying the same space as the original world. We will be making use of multiple *scenes* within a single Blender document, as well as matte nodes\(^3\) in the compositor to combine them together. The overall workflow will consist of these steps:

- Create a scene representing the “Outer” world (the world outside the doorway, which is also the world where the observer is located.)
- Assign a specially-coloured material to the doorway in the “Outer” scene, which will be come transparent when composited.
- Define a camera movement panning around the “Outer” world, to accentuate the portal illusion.
- Create a scene representing the “Inner” world, which is visible through the doorway.
- Copy the exact same camera movement from the “Outer” world to the “Inner” one, so the view through the door remains consistent with what is seen on both sides. (This is why it is best to keep the two scenes in the same Blender document.)
- Render out separate animation sequences for the “Outer” and “Inner” scenes.
- Create a third scene purely for compositing purposes, bringing in the two previously-rendered animation sequences.
- Render out the complete composited result sequence.

The actual modelling we are doing here will be very simple, not to say crude, just to illustrate the basic principle; feel free to create your own more elaborate and more interesting scenes, once you have mastered the basic technique!

---

151.1. The Outer Scene

Start with a new Blender document. Change the Scene name to “Outer”. We will use the default cube as our portal object (why not?). Make it taller, so the front face has about the right proportions for a doorway. Add a plane for a floor just underneath. Go back to the portal, \texttt{[TAB]} into Edit mode, select the front face, and \texttt{[E]} set it just a little bit, for a door frame. Switch to face-select mode, and select just the inner face; give this a new bright green material, and be sure to select the “Shadeless” option in the Shading panel under Materials.

Figure 928

settings. Making it shadeless ensures that the whole doorway has a uniform colour regardless of lighting; the exact colour doesn’t matter, so long as nothing else in the scene comes too
close to the same colour. Green is the colour traditionally used for chroma-key\(^4\) work in movies.

![Image of a 3D scene with a doorway and an egg-shaped object]

Figure 929

Your basic scene setup should look something like this. Apart from the doorway material as discussed above, none of the other material assignments really matter. Note the egg-shaped object (stretched-out sphere) I added poking halfway through the doorway: this object will also appear in the inner scene, reinforcing the idea of a doorway between worlds that you can actually move through.

151.2. Animating The Camera

Still in the Outer scene, add an Empty object at the default 3D cursor location. Parent the camera to this; now \(\text{Insert a LocRot keyframe for the Empty at frame 1, then go to, say frame 51, rotate the Empty about the Z axis by -90° (so the view moves across to the opposite side of the but still showing the doorway), and Insert another LocRot keyframe.}\)

While you’re at it, make the following changes in the Render

Further Compositing: A Portal Effect

Figure 930

Context:

- Set the end frame for the animation frame range to 51.
- In the Shading panel, make sure the output format is PNG, and set the Output path to //output frames/. Putting the rendered frames from this scene into their own directory will avoid any mixups with the other scene renders.

Figure 931

If you were to render this scene animation out now, you should end up with something that looks like at right.
151.3. The Inner Scene

In the Scene popup menu, click the “+” icon to create a second scene. Choose the option “Link Objects”: this means the new scene will initially share exactly the same objects as the first scene. (Sharing the same objects, rather than making copies of them, just makes it easier if you need to make any changes to those objects; those changes are automatically visible in all scenes sharing the same objects.) Name the new scene “Inner”. We only want it to share the camera (and its pivot Empty) and lighting, and that purple egg thingy that is travelling between the worlds. So select the portal box and floor, and delete them. Create some new objects to make up this inner world, something like at right. Note I gave the inner world its own floor, with a contrasting colour.
Figure 933  Inner scene with Outer as background

Tip: In the Scene
Context, there is a “Background” field in the Scene panel, where you can choose another scene to overlay this one. This is what I did in the screenshot at right, just so I could make sure those balls in the Inner world lie behind the portal door. Don’t forget to **remove this Background scene setting** when you are done. Otherwise the Outer scene will show up in the render for the Inner scene, which we don’t want!

### 151.4. Inner Scene Animation

**Figure 935**

When you created the Inner scene, it would have inherited the same Render
settings as for the first scene: the same frame rate and number of frames to render. Just make one change: in the Output panel, set the path to //inner frames/, so as to keep the rendered frames separate from the Outer scene.

Now when you render out the animation of this scene, you should end up with something like at right.

151.5. Compositing It All Together

Now, make a third Scene, just for the compositing. In the menu that appears when you click “+” next to the scene name, choose “New” to create a new Scene with nothing in it. Call
this scene “Compositing”. Leave it empty; we won’t actually be rendering any 3D content in this scene.

Open up a Node Editor window, and change the node editor type to Compositing nodes. Check the “Use Nodes” box; you will see the usual initial two nodes, “Render Layers” (representing the rendering of the 3D objects in the scene), and “Composite” for the final output from the compositor. Get rid of the Render Layers node; we won’t need it at all (and anyway, it won’t work without a camera in this Scene).

Instead, \[\text{SHIFT} + \text{A}\] add an Input→Movie Clip node. Click its Open button, go to the “inner frames” subdirectory where the Inner scene has put its rendered frames, and select all the PNG files you find there to make up this movie clip. Click the “Open Clip” button to confirm and return to the Node Editor.

\[\text{SHIFT} + \text{A}\] add a second Input→Movie Clip node. Click its Open button, and this time go the “outer frames” subdirectory where the Outer scene has put its rendered frames, and select all the PNG files you find there to make up this movie clip. Click the “Open Clip” button to confirm and return to the Node Editor.

Now put together the complete node setup as at right. Note the use of a Matte→Color Key (not Chroma Key) node to make the doorway transparent. To choose the right colour, bring up the colour picker for the “Key Color” input terminal, and use the eye dropper to click on the door part of the thumbnail image in the Movie Clip node for the Outer scene. Note I had to add a Filter→Dilate/Erode node with a Distance of -1, otherwise I had a little trace of green showing at the edge of the doorway. The computed colour-key mask then feeds a Color→Mix node which causes the Inner scene to show through exactly where the door is located in the Outer scene, but nowhere else! Simple, isn’t it?

Now, make one final change to the Render
settings, setting the path in the Output panel to \(//\text{composite frames}/\) to keep them separate from the two input scenes.

**Figure 939**

Now when you render out the Compositing scene, you should end up with an animation something like at right.
151.6. More On Lighting

In this example, I gave both scenes the same lighting. But in general there is no reason for this; in fact, giving the two scenes completely different lighting (e.g. night in one, day in the other) would emphasize the jarring discontinuity in moving between them.

However, you might then have to deal with the issue of light spilling from one world to the other through the doorway. This could be faked done by judicious placement of additional lights.

Further exploration of this issue is left up to the reader. ;)

152. Advanced Rendering

Information
Applicable Blender version: 2.67
153. Alternative Renderers

You previously learned about the Blender Internal\(^1\) renderer. This is the old, original renderer that was included from the earliest days of Blender. However, it is not the only way to render scenes created with Blender.

153.1. Cycles

![Example Cycles render showing 1) illumination via an emissive material (middle ball), and 2) colour bleed via indirect diffuse lighting (note coloured light on ground near red and green balls). The glowing middle ball is the only light source in this scene.](image)

Figure 940  Example Cycles render showing 1) illumination via an emissive material (middle ball), and 2) *colour bleed* via indirect diffuse lighting (note coloured light on ground near red and green balls). The glowing middle ball is the only light source in this scene.

Beginning with Blender 2.61 came the new **Cycles** renderer. Its most important new feature is more physically-accurate handling of lighting in the form of *global illumination*\(^2\). What this means is that Cycles automatically implements subtle indirect-lighting effects, where light can bounce off a diffuse surface and provide some illumination to other diffuse surfaces nearby. And it doesn’t distinguish in its lighting calculations between “lamp” objects...

---

1  Chapter 24 on page 177
and non-lamp objects which have “emissive” materials; in Blender Internal, the latter do not provide any light to other objects, whereas in Cycles they do.

Cycles also offers high-fidelity previews in the interactive 3D view. As it continues to be developed, it will perhaps replace the old Blender Internal renderer someday, but not all the features are there yet for this to happen.

See also:
• Manual on Cycles.
• Andrew “BlenderGuru” Price’s Introduction to Cycles.

153.2. Freestyle

This is not a complete renderer in itself, but a new addition to the Blender Internal renderer in version 2.67 of Blender. It adds sophisticated options for accentuating edges to produce cartoon-like renders.

See also:
• Manual on Freestyle.
• Report by Libre Graphics World on the origins of Freestyle.

153.3. External Renderers

There are also a great number of stand-alone renderer programs, both proprietary and Free Software, around (e.g. Aqsis, LuxRender, Octane, RenderMan, Yafaray). These have no capability to create or edit 3D models or scenes, they are designed purely to perform rendering on already-created models and scenes. Several of them—particularly the Free Software ones—are supported by addons to allow them to work with Blender almost as conveniently as its built-in renderers.

---

4 https://www.youtube.com/watch?v=UTwXG3K412g
6 http://libregraphicsworld.org/blog/entry/freestyle-jot-and-the-future-of-non-photorealistic-rendering
7 http://www.aqsis.org
8 http://www.luxrender.net
9 http://www.otoy.com
10 http://renderman.pixar.com
11 http://www.yafaray.org
154. Disadvantages of Other Renderers

Of course, there can be a downside or two to choosing a renderer other than good old Blender Internal.

154.1. Say Goodbye to Your Materials and Lighting

One important thing to note when constructing models is that materials and lighting are renderer-specific. If you have painstakingly set up transparent materials and bump maps and all the rest of it, then decide to switch renderers, you will have to do that work all over again. And you may find that there is no exact one-to-one correspondence between particular features of Blender Internal materials and lights and those supported by the alternative renderer, so you will have to find approximate workarounds.

Of course, the actual geometry of your models remains unaffected.

154.2. High-Quality Renderers Are S-L-O-W

If you are accustomed to hitting $\text{F12}$ and seeing an image appear after just a few seconds with Blender Internal, using one of these other renderers will likely come as a shock. To get a good-quality render can easily take 10-100 times as long as with Blender Internal. You can speed things up by choosing lower-quality settings, but then the results tend to be filled with noise and not fit for much more than preview purposes.
155. Introduction to Cycles

Information
Applicable Blender version: 2.67

Cycles is a renderer which first appeared in Blender 2.61. It offers more physically-accurate handling of lighting, based on a completely different handling of materials from the old Blender Internal renderer.
155.1. A Simple Cycles Example

![Image of Blender interface showing Material settings]

**Figure 941**

Start with a new Blender document. From the renderer menu
at the top of the screen, select “Cycles Render”. Select the default cube. Go to the Material Context
Figure 943

in the Properties
Window, and you should see something like at right.

What happened to diffuse/specular shader settings, transparency, mirror, etc?

All that is gone. Instead, Cycles defines its materials in terms of something called a BSDF\(^1\), or Bidirectional Scattering Distribution Function. When light hits the surface of an object, it can be reflected, absorbed or transmitted (through the material, giving rise to transparency or translucency), or more typically a combination of all three. Ignoring absorption (which means the light is lost anyway), the way the light is reflected can be

represented mathematically as a BRDF\(^2\), and the way it is transmitted as a BTDF\(^3\); Cycles unifies the two into the general concept of a BSDF.

If you look in the window at right, you will see little in the way of actual material settings except for the choice of a “Diffuse Color” for the material, and above it a “Use Nodes” button. There is a little bit more in the “Settings” panel below (including what colour to use to show the object in the 3D viewport), but we will ignore that for now.

By default, the material is assigned a simple *diffuse* BSDF (non-shiny surface), and the only parameter exposed for you to play with is the diffuse colour. To get access to more, you will need to click the “Use Nodes” button. But don’t do that yet.

Instead, *delete* the default lamp. We are going to light our scene entirely with an emissive material. Why? Because, with Cycles, we can. In real life, we can usually see the sources of light in our scene, they are not invisible the way the Blender Internal renderer treats them.


Add a new UV sphere object, and position it above the cube. Go to the Materials Context, and assign it a new material. You should see a few more settings appear this time, as at right (if you see the “Use Nodes” button as before, then click it).
Go go the menu next to the label “Surface:”. Clicking on this will show you (in the left column) the list of available BSDFs:
Select “Emission”. The “Surface” panel should now look like this:
If you hit F12 to render at this point, you will probably end up with something like this. This shows the emissive sphere shedding light on the diffuse cube, which shows Cycles in action, but is otherwise not very interesting. Also note the noise, particularly on the upper surface of the cube.

Let’s see if we can spice it up a bit.
Add a plane below the cube, and scale it out a bit to look more like a floor. You can give it the same material as the cube. While we’re at it, go back to the glowing sphere and increase the Strength of the emission material to 10.

Now if you render, you should see something like this:

OK, so that’s slightly more interesting (if you look carefully, you can see the lower part of the cube pick up some light bouncing off the floor), but that noise is even more terrible than ever. Can we do something about that?

Yes we can.
Go to the Render Context
in the Properties window. Look for the Sampling panel (this is specific to the Cycles renderer, you won’t have seen it while doing renders with Blender Internal). See the two numbers in the column headed “Samples:,” in particular the one labelled “Render:”. Change the number from the default 10 to 100.
Now if you hit $F_{12}$, you should see something like at right: the noise is noticeably less.

**However:** note the increase in render time. On my quad-core Core i7 machine, the previous image rendered in less than a second at 1500×2000 resolution, while this one took closer to 6 seconds—almost exactly a factor of 10.

You can crank up the number of render samples some more, and get an even better-quality result, but it will take even longer. This is the tradeoff with all high-quality renderers, not just Blender Cycles: you can get better results, but at the price of longer render times.
155.2. Real-Time Rendering Previews

Figure 953

Cycles has another little trick up its sleeve. In the 3D view
window, look for the shading menu, where you can choose solid/wireframe/textured etc previews.

Notice anything different? With Cycles enabled, there are extra “Material” and “Rendered” items in this menu. Try selecting “Rendered”, and suddenly you will be seeing a full Cycles render happening in the 3D view! Try rotating the view, zooming and out etc, and watch the render being redone every time: initially it starts out very blocky and noisy, then gradually refines itself if you don’t touch anything.

Remember the two render samples values we encountered above? Now you know what the lower “Preview” one is for: it controls the quality of rendering done in preview mode. You can also set this value to 0, which means “infinite”: rendering becomes a never-ending
process, where the quality of the image gets better and better, the longer you leave it. Of course, you can interrupt it at any time, just by doing something to the view.

Of course, all the usual object/edit-mode functions etc remain available, but they’re a bit hard to use, because there is no selection feedback in this view.

155.3. Nodes? What Nodes?

This example has been a very simplistic use of Cycles materials. Much more sophisticated uses are possible, by combining various BSDFs and putting them through all kinds of processing. But that requires delving into the Node Editor.

155.4. See Also

- Video tutorial[^5] by Peter Drakulitch showing how to use a despeckle filter to reduce “fireflies” (anomalous bright dots) in Cycles.

[^5]: http://www.youtube.com/watch?v=DSP9EMUGs5g
[^6]: http://www.blenderguru.com/4-easy-ways-to-speed-up-cycles/
[^7]: http://www.youtube.com/watch?v=ENy9TAkxt8
156. A Glass Material in Cycles

This tutorial will redo the previous Ray Tracing\textsuperscript{1} lesson, this time using Cycles rendering. Start with a copy of the same document you created last time; we will keep the same geometry, but redo all the materials, and then you can compare the final results to see how the different renderers perform.

Open the ray-tracing document. Switch the renderer

\textsuperscript{1} Chapter 78 on page 711
to Cycles. We previously defined two materials: the world background with the “magic” texture, and the glass for the cubes. So we will need to redo these.

For all but the most basic plain diffuse materials, Cycles requires you to use the Node Editor. You should have done the prior introduction\(^2\) to this; please review that, if not. Cycles material nodes are not the same as Blender Internal material nodes\(^3\); but the basic mechanics of node editing are the same.

---

2 Chapter 147 on page 1113
3 Chapter 149 on page 1121
156.1. The Magic Sky

Let’s try fixing the background material first. Go to the World
context in the Properties
window. It should look something like at right. What happened to all the world settings?
Nearly all of them have disappeared!

But see that big “Use Nodes” button? It’s big so that you will find it hard to miss. Click it.
OK! Now there are a few more settings, but still not much. For all the fun stuff, we must go into the Node Editor.

You probably have a Timeline
window across the bottom of your Blender screen layout. Change the window type to Node Editor.
, and increase its height. (Or add a new window if you don’t already have one, and make it a Node Editor.) In its header, next to the menu titles, you should see a group of 3 icons
indicating what type of nodes you want to edit: if you hover over them, from left to right, you should see tooltips identifying them as respectively “shader nodes” (i.e. Cycles materials), “compositing nodes” and “texture nodes”. It is the “shader nodes” we want.

Note:
**Cycles doesn’t use the Texture Node Editor.** It may be confusing to see this mode of the Node Editor still available with Cycles chosen as the renderer, but don’t bother using it. All setup of textures in Cycles is done within the Shader/Material Node Editor.

With shader nodes selected, you will see another pair of icons

appear immediately to the right of these three: these indicate whether to edit shader nodes for a selected Object, or for the World. It is the World that we want.
Soon as you select the World shader, the following should appear in the Node Editor window. Note the special “Background” and “World Output” nodes: you must have these in the World shader, but note that “Color” input terminal on the Background node? That’s just itching to have something plugged into it.
Bring up the menu to add a node, with $\text{SHIFT} + \text{A}$ . Look for the Texture submenu, which should look like at right. Select the “Magic Texture” item.
This will add a new node representing the texture; connect its “Color” output to the “Color” input on the Background node, like at right.

Now if you hit \[F12\] to render, you should see your new magic World background.

### 156.2. Here Comes The Glass

Make sure the cubes are selected in the 3D view. Go to the Materials
context in the Properties window. As before, you will see very few settings, and a big “Use Nodes” button. Click it.

In the Node Editor, remember there are two icons for selecting what type of shader/material nodes to edit, the Object one and the World one? Click the Object one this time.
As before, you will see an initial default node setup, like at right.

This time, there is only one node that needs to be present for the node setup to work correctly, and that is the Material Output node. Click with RMB on the node titled “Diffuse BSDF”, and press DEL to get rid of it.
Now bring up the Add \texttt{[SHIFT] + A} menu, and this time look for the Shader submenu. We will need three items from here, so add them one at a time:

- A Glossy BSDF to give the shiny surface (note the default Roughness setting in this node is 0.2, set it to zero)
- A Refraction BSDF to give the effect of light refracting through the transparent material, and
- A Mix Shader to combine the two.

Ah, but how do we combine the two? Remember the \texttt{Fresnel factor} we talked about in the Blender Internal tutorial? Well, in Cycles, there’s a node for that!
In the Add $\text{SHIFT} + \text{A}$ menu, bring up the Input submenu. In there, you will see a Fresnel node type. Add one of these. You will see it starts with a default IOR (Index of Refraction) value of 1.45, which is about right for glass.
Finally, connect together your little collection of nodes like this. See how the Fresnel factor controls the mixing proportion of the Glossy and Refraction shaders? A larger input factor to the Mix shader means a higher proportion of its second (lower) shader input, while a smaller factor gives a higher proportion of its first (upper) shader input. The higher output Fresnel factor corresponds to the regions closer to the edges of the object, where you want more reflection, while the lower value corresponds to the interior regions, where you want more transparency.

**Figure 972**
And finally finally, hit $F12$ to see what the result looks like.
Note:
Does it look grainy, and not as clear as this? Increase the number of samples in the Sampling panel in the Render context, as you learned to do in the previous tutorial\(^a\). The picture here was done with 500 samples.

\(^a\) Chapter 155 on page 1151

Note:
Why not just use the Glass BSDF? You might have seen this in the Add Shader menu, above. However, this doesn’t seem to produce the right effect: it seems little different to the Refraction BSDF, without providing much in the way of glossy reflections.
156.3. Adjustable Refraction

You may have noticed that the above collection of nodes includes *two* different fields labelled “IOR”: the one on the Fresnel node, and the one on the Refraction BSDF. The former governs the transition between transparency and reflectivity, while the latter governs the actual refraction through the material. In the real world, the two would always be the same, since they are the same physical quantity.

With the right IOR\(^4\), this same node setup can be used to represent other transparent materials. Instead of having to set the value in two places, why not just set it in one?

![Node setup for adjustable refraction](image)

To do this, add `SHIFT + A` another node, from the Input submenu, of type Value. This will feed a fixed value that you specify into any number of output terminals. Connect its Value output to the two IOR inputs, on the Fresnel and Refraction BSDF nodes. Here I have set its value to 1.45, which is a suitable value for glass.

156.4. A Reusable Custom Shader

What if you wanted to have multiple transparent materials in a document? Would you need to go through all the above setup every single time?

---

A Reusable Custom Shader

Naturally you wouldn’t. Instead, you can define a custom node group, and insert that into a Node Editor setup wherever you want, as many times as you want.

Start with the node setup as in the previous screen shot. Select RMB the Value node supplying the IOR value, and DELETE the rest. Now look at the remaining four nodes, the Fresnel input and the three shader nodes (apart from the material output)? Select these, and only these, in any of the usual ways: press A once or twice to deselect everything, then RMB on the first node and SHIFT + RMB on the rest, or drag a BOX selection around the desired nodes.

![Node Editor screenshot showing node selections and group creation process](image)

**Figure 976**

Now, with these nodes selected, select “Make Group” from the “Node” menu, or use the keyboard shortcut CTRL + G. Also press N to bring up the Properties shelf at the right side of the Node Editor window. The result should look like at right. Notice a couple of things:

- The greenish background indicates you are editing a node group, not the entire node setup
- The blocks with yellow headers, labelled “Group Input” and “Group Output”: these define the input and output terminals for the entire node group: inputs to the group appear as outputs on the Group Input block, and outputs from the group appear as inputs to the Group Output block. Any terminals within the group not connected to these will not be visible outside the group.

You can press TAB to switch out of editing the node group and back into editing the entire node setup, where you will see your group appear as a single block entitled “NodeGroup”. Try this if you want to have a look, then press TAB to get back into editing the group again, because we haven’t finished setting it up yet.

1189
First of all, we need an input to specify the IOR value. Click on the IOR input terminal on the Fresnel node, and drag to the right edge of the Group Input node. Blender should automatically create an output terminal named “IOR” on the Group Input node, with a wire running to the Fresnel IOR input.
Now click on this Group Input IOR terminal, and drag another wire to the IOR input on the Refraction BSDF node.

Glass often has a colour. This colour affects light passing through the material, while glossy reflections remain uncoloured.

To create a colour input terminal for our node group, just drag from the “Color” input terminal on the Refraction BSDF node to the right edge of the Group Input node; as before, Blender will automatically add a new Group Input terminal and connection.
Now press \[\text{TAB} \] to finish editing your custom node group. This will take you back to the overall node setup, with your custom node still selected. Its name will be shown in the Properties panel in the Properties shelf at the right; change this from the default “NodeGroup” to something more meaningful, like “Custom Glass”.

And now you can add back the input Value node you deleted, to supply a value to the IOR terminal. And similarly you can add an RGB node to feed into the glass colour. Or, since each value only needs to feed one input terminal, you can type them directly into the unconnected inputs on your Custom Glass node.
And furthermore, your custom node is now present in the Add Group menu, ready for you to insert somewhere else, in this or another node setup.

Note that the node definition itself is not duplicated when you insert another instance of your custom node. Each instance operates on its own separate input values and produces its own corresponding separate output values, but any changes you may subsequently make to the internal definition of the node group will automatically take effect everywhere you’ve already used it.
157. Dealing with Fireflies in Cycles

Information
Applicable Blender version: 2.68

Figure 982  See the little white dots? (Click to view the full-size image, and look closely.)
Cycles is a wonderful renderer, capable of some exquisite lighting effects. However, sooner or later, you will encounter the problem of fireflies, which are isolated bright pixels scattered over various parts of the image. Unlike simple noise (which can be reduced by increasing the number of render samples, or alternatively by simple filtering), fireflies are caused by numerical instabilities in the rendering computation, because after all computers can only calculate the formulas to a finite precision. They seem an inevitable consequence of trying to use realistic physics formulas to create our renders.

But are they so inevitable? In fact there are various tricks and tweaks we can use to keep them out of our renders. There are pros and cons to each technique (in terms of the amount of work involved and unwanted side-effects), so it is up to you to decide which to use and when.

Fireflies tend not to afflict the simplest renders. This means that it takes work to come up with a tutorial example sufficiently complex to exhibit them. If you already have one of your own renders which is being plagued with fireflies, and you came here hoping to find a fix, then great—you can skip ahead to the part with the fixes. Otherwise, please have some patience while we construct an example.

157.1. Making An Example

This example arose out of a real model I was trying to construct: a house with louvred windows made out of frosted glass. Some interaction involving light coming in through the panes of one window, bouncing around the diffuse walls of the room and out another
window, together with the combination of shaders making up the glass material, led to the appearance of the fireflies. This example will cut the situation to the bare minimum I could come up with to exhibit the problem, namely a pair of adjoining rooms with two windows.

![Figure 984](image.png)

**Figure 984** Loop cut to demarcate rooms (view from underside)

Start a new Blender document. Switch the renderer to Cycles. Select the default cube, and Tab into Edit mode. Scale the cube out horizontally a bit so the room is not so narrow and tall. Switch to face-select mode. Select the bottom face and Del ete it. I found that the room needed a ceiling to show the fireflies, but not a floor, so why not get rid of it?

Give your cube a Solidify modifier, so the walls have a nonzero thickness. The exact thickness doesn’t matter.
Next, make a single loop cut \textbf{CTRL} + \textbf{R} around the sides of the shape to define the boundary between the front and rear rooms. Then press \textbf{F}, and the vertices of the new loop should be joined to form a new face which is the wall between the rooms.

\textbf{Figure 985} Wall filled in between rooms.
Now we need to make holes for the windows, and for a doorway between the rooms. Still in face-select mode, select the front face (the one you see in [NUM1] view), and inset it a little way. If you inset it too far, you may find the height gets too small, so after the initial insetting, select just the middle face and scale it horizontally \[ \Delta + \mathbf{x} \] to make a reasonable-looking window.

Do the same with the wall on the right side of the front room, and also on the wall between the rooms. A real doorway would extend to the floor, but our simple hole in the wall is sufficient for this exercise.

157.1.1. Add The Windows

Add a new horizontal plane. Shrink it along the Y-axis to 20% of its length along the X-axis. Add a couple of array modifiers: one along the Z-axis with a constant offset of something like 0.2 and a count of about a half a dozen, and another along the X-axis with a constant
Dealing with Fireflies in Cycles

offset around 2.2 and a count of 4. Position your resulting array of louvres within the hole for the front window.

Before going any further, we mustn’t forget to make the windows out of frosted glass. Assign a new material to your window object. Bring up the Node Editor, and set up a material for the window glass as at right. Set the roughness on the Glossy BSDF to zero, but note the small, but nonzero Roughness setting on the Refraction BSDF: I deliberately tuned this to maximize the production of fireflies. A zero setting will make them go away, but that defeats the point of this exercise, doesn’t it?

(The room walls can be left at the default diffuse material assigned by Blender.)

After setting up your window material, duplicate your louvres object and rotate and position the copy within the hole for the side window. Leave the hole between the rooms empty (it is supposed to be a doorway, after all).

157.1.2. Completing The Recipe

As the final part of our recipe for fireflies, change the type of the Lamp object to Sun, and change its angle to close to horizontal so it will shine in through the side window. Give it
a strength of 3. Position the camera to look directly into the front window. Also increase
the number of render samples to 100; that should be sufficient to keep down the noise.

So, in summary, we have sunlight coming in low through louvres in a side window in the
front room, bouncing around between front and back rooms, and exiting through louvres
in the front window, the louvres all being made of lightly-frosted glass.

Figure 989  Fireflies! (Click to examine more closely.)

If all goes well, hitting [F12] to render should produce an image like at right.
157.2. Fixing The Problem 1: Renderer Tweaks

![Relevant renderer settings](image)

**Figure 990** Relevant renderer settings

OK, now that we can create the problem, how do we solve it?

Probably the first things to try are one or two renderer settings. Look for the Sampling and Light Paths panels in the Render
In the Sampling panel, look for the “Clamp” field. If nonzero, this imposes a maximum value on the light-intensity calculations at each pixel. Normally 1.0 corresponds to full white, but some points can be brighter than this. Try changing the default 0 value to, say, 3, and rerender.

In our simple example, this should be enough to fix the fireflies. However, I have come across a case or two where this reduced the intensity of some bright indirect lighting, leading to a more subdued appearance for the overall render.

So let’s try the next thing. Set the Clamp back to 0, and this time look in the Light Paths panel, for the “No Caustics” checkbox. Caustics\(^2\) can be an important part of realistic lighting effects, but if your scene doesn’t need them, disabling them can help get rid of

fireflies, and perhaps speed up the render as well. However, the tooltip for this checkbox warns that the result can be a darker image.

In our simple case, checking this box does work.

The third renderer setting to try is the field just below the No Caustics checkbox, labelled “Filter Glossy”. This applies deliberate blurring to certain kinds of light bounces, sacrificing a bit of lighting accuracy for the sake of avoiding fireflies. And again, in our case, this option works: setting it to a value of, say, 1, does indeed fix the fireflies.

But, at some point, you may find that none of these three techniques will work for you: they may make no difference to the render, or may cause unacceptable loss of quality in places. After all, being settings that apply to the render as a whole, they can be something of a blunt instrument.

So for our next fix, we will need to resort to the compositor.

157.3. Fixing The Problem 2: The Despeckle Filter

The approach to fixing the fireflies problem is to apply some kind of processing to the rendered image. If you are familiar with image-editing programs like Gimp or Photoshop, you will have come across the despeckle filter, whose job is precisely to smooth out random dots that don’t fit in with the rest of the image. In principle you could use an image-editing program to touch up your renders (and some people producing professional-quality renders do), but what happens if you are rendering an animation? Imagine having to fix up hundreds or thousands of frames by hand!

Blender, too, has a bunch of image-processing operations available in its compositor, including a Despeckle filter. And the nice thing is, these operations can be applied automatically after rendering each frame.
Open up a Node Editor
Figure 993

window in your Blender document (you can reuse the Timeline...
window at the bottom of the default window layout, just make it a bit taller). Look for the icons
Dealing with Fireflies in Cycles

Figure 995

indicating what type of nodes to edit: click on the one showing little layers or sheets, representing the compositor (in the middle in Blender 2.68, on the left in earlier Blender versions). Immediately you should see a “Use Nodes” checkbox appear to the right of these icons: check that to enable node-based compositing. You should get a default node setup like at right.

Figure 996

Move the two existing nodes a bit further apart, to make way for a new one in-between. Press $\text{SHIFT} + \text{A}$ to bring up the Add menu, and look in the “Filter” submenu for the “Despeckle” entry. Move the new Despeckle node into the gap you previously cleared, and if you position it right, it should automatically connect itself into the chain like this.

To see the effect of your changes, switch the 3D view window to an Image Editor window. Make sure the image being shown is the “Render Result”. Next to the menu for selecting the image slot (which should be showing “Slot 1”), there is a menu for selecting which layer of the image to show:
The despeckle filter is designed specifically to get rid of isolated anomalous pixels. This is unlike blur filters, which average a bunch of pixels together, and can spread the firefly across a larger area instead of removing it.

But what do those “Threshold” and “Neighbor” parameters actually mean? The following explanation was put together from studying the Blender source code, mainly https://developer.blender.org/diffusion/B/browse/master/source/blender/compositor/operations/COM_DespeckleOperation.cpp.

The target pixel being processed is compared with its eight neighbours. However, these neighbours are not treated equally: each one is given a weight that governs its relative importance to the computation. The horizontal and vertical neighbours each have a weight of 1, while the diagonal neighbours are each given a lower weight of $\sqrt{\frac{1}{2}}$ (approximately 0.7). This reflects the fact that they are slightly further away along the diagonals, therefore they have correspondingly less influence on the outcome.
For each neighbour pixel, the “Threshold” input parameter is compared against the difference between each of the neighbour’s R, G and B components (normalized to 0 being black and 1 being maximum intensity) and those of the target pixel; if any of the corresponding pairs of components have a difference exceeding the threshold, then the neighbour pixel value is accumulated onto an average (weighted by neighbour weights) that the code calls color_mid_ok—the presumed “correct” value of the target pixel, if you like. All neighbour pixels, whether within or outside the threshold, are accumulated onto another (also weighted) average called color_mid. The value w is the total weight of all neighbours that contributed to color_mid_ok.

Then the value of w is divided by the total weights of all neighbouring pixels \((4 \times 1 + 4 \times \sqrt{\frac{1}{2}})\), to produce a fraction in the range \([0.0 .. 1.0]\), and the resulting fraction compared to the “Neighbor” input parameter. Also the difference between the components of color_mid (the average of all the neighbours) and those of the original target pixel are compared to the “Threshold”. If either comparison returns less than or equal, then the pixel is considered not to need correction. But if both comparisons are greater, then the target pixel is adjusted from its initial value towards the color_mid_ok average, according to the “Fac” input socket value. If “Fac” is 1.0 (the default), then the pixel is completely replaced with color_mid_ok; otherwise it becomes the corresponding blend of this and its original value.

“Fac” can be used to fine-tune the effect of the Despeckle. For example, if this was fed from an inverted edge-detection (“Kirsch”) filter, then it can be used to reduce the effect along sharp edges, which are otherwise likely to confuse the filter.
158. Fireflies in Cycles, Continued

**Information**

Applicable Blender version: 2.68

You previously read\(^1\) about techniques for controlling fireflies in renders done with Blender Cycles, and how, when all else fails and tweaking renderer parameters doesn’t help, it is time to roll out the Despeckle filter. Sometimes a despeckle applied across the entire image may be too blunt, leading to unwanted effects in parts of the image where there are no fireflies.

But never fear. There are yet more options in Blender’s compositor that we have yet to explore, to give us even finer control over the application of despeckling, and hopefully avoid the final, desperate measure of hand-retouching (shock! horror!) individual blemishes in an image-editing program.

The basic principle is, fireflies are caused by specific interactions of types of materials and lighting, hence they will only occur in particular parts of the image. By separating out the problematic materials/lighting cases, we can selectively apply the filter just to them, minimizing side-effects on parts of the image that look just fine.

We will present a way to do the separation.

### 158.1. Finer Despeckling: Separate Lighting Passes

#### 158.1.1. Separating The Lighting Passes

The Cycles renderer has the capability to separate out different kinds of light paths into separate *passes* for individual processing. Consider the diagram on the Blender wiki\(^2\), showing how the direct lighting, indirect lighting and colour calculations are broken down by diffuse, glossy and transmission light paths, before being combined together with emission and environment lighting. We can split out all these passes, and use compositor nodes to recreate the standard combination as described there. But we can also intersperse our own processing onto particular passes, leaving the others untouched.

---

\(^1\) Chapter 157 on page 1195  
To tell Blender that we want to extract the light passes, go to the Render Layers
Figure 999

context in the Properties
window, and look for the Passes panel. Notice the four groups of 3 buttons each for “Direct”, “Indirect” and “Color” grouped under “Diffuse”, “Glossy”, “Transmission” and “Subsurface”? (Depending on your Blender version, the “Subsurface” group might not be present.) Click all these buttons, and also check the “Emission” and “Environment” boxes just below.
Now if you go back to the compositor window, you should see that the RenderLayers node has sprouted a whole lot of extra output terminals, one for each of the buttons/checkboxes you clicked.

Next, we want to recombine these to mimic the behaviour that Blender provides by default. If you go back to that Blender Wiki diagram above, you will see that, for each shader type (diffuse, glossy etc.), the direct and indirect light passes are added together, and the sum is then multiplied by the colour calculation. The result from all the passes is then added together.
Figure 1002  How **not** to do it: notice the repeating patterns?

The Blender compositor has standard node types for adding and multiplying colours. Armed with this information, you might immediately set to work putting together an intricate node setup to implement the formula depicted in that diagram, perhaps ending up with something like at right.

Show this to a seasoned computer programmer, and they will perform the gesture known as a “facepalm”\(^3\). Yes, technically this will work, but it is quite complicated-looking and error-prone. Supposing you get a connection wrong: how would you find it? How would you debug your node program?

For, make no mistake, **nodes are a programming language**. Putting together a node setup is very much like writing a computer program. One of the important principles is **don’t repeat yourself**. That is, if you find yourself doing the same sequence of steps more than once, it makes sense to spell it out once, and then next time just tell the computer to do the same thing again.

**Note:**
In programming, **laziness is a virtue**. Programmers spend a lot of their time thinking up ways to avoid work, by getting the computer to do it.

---

So let us see how a programmer would approach this same problem. To start with, consider the most basic operation, which is: add the direct and indirect components, and multiply by the colour. So create a pair of Mix nodes, one to do the Add and the other to do the Multiply, and wire them appropriately. Turn them into a group $\text{CTRL} + \text{G}$, and add group inputs and outputs as in the diagram.

To change the names of the inputs and outputs, you can select them in the list that appears in the Properties shelf $\text{N}$ in the Node Editor window, then type a new name in the appropriate field just below the list.
Having done all the wiring, you can give it a name. Here I call it “Pass Combine”. See how naming the inputs and outputs helps make it clearer what the node is for? And if you want to see the details, just TAB into the node for more. This technique is called abstraction, where you start by seeing only the overview, but you can progressively peel back the layers to see more and more detail, but only where you want to. This is an important technique for dealing with complexity, which is what programmers do every day.
We will need four instances of this group, plus another bunch of Mix nodes to add them all together. We are adding 6 quantities, so we will need 5 Mix nodes. Again, I make a group to combine all these adders, just to make things neater.
I call the resulting group “Add6”. Blender only provides nodes to add two quantities at a time, yet here we have made our own custom node that can take 6 inputs at once. Neat, huh?
So now we combine our building blocks into a new building block that computes the combination of all the passes, and looks like this.

Note the ordering of the group inputs, to ensure a nice and neat arrangement when we connect this node up below. You can rearrange the inputs by selecting one from the list in the Properties Shelf and using the up- and down-arrow buttons next to the list to change its position.
And then when we connect that building block (here called “Combine All”) into all the RenderLayers outputs, our complete node setup now looks like this.

Compare this with the original simple-minded recreation of the pass-combining algorithm: which would you rather be presented with when you open a Blender document?

**Note:**

Groups within groups: When you have one node group within another, you may become confused over the behaviour of the \( \text{[TAB]} \) key: will it exit the current group, or take you into an inner one? If you select an inner group, it will go into that, of course. But if you’re trying to get out, click on a node that isn’t a group. You always have two of these, the Group Input and Group Output nodes, handily marked out by their yellow title bars. So click on one of those before pressing \( \text{[TAB]} \), and that takes you out of the group.

158.1.2. Fixing The Fireflies

Anyway, now that we have separated the lighting passes, such that we can recombine them to produce the original image anyway, how do we actually go about fixing the fireflies?
First we have to isolate which passes are producing the fireflies. Click the “Backdrop” checkbox in the header of the compositor Node Editor window. Now, $\text{CTRL} + \text{SHIFT} + \text{LMB}$ on the RenderLayers node, and you should see a new Viewer node automatically appear and connect itself to the first output terminal on that node. At the same time, the background of the window changes to show the image produced by that output terminal. The first terminal should be showing the complete image, including the fireflies.

Keep pressing $\text{CTRL} + \text{SHIFT} + \text{LMB}$, and the Viewer node will connect to each output terminal in turn. Some may be all black or all white, but don’t worry, just keep going. When you come to the Diffuse Indirect output, you should see something like at right, mostly dark, but with noticeable fireflies. Make a note and keep going; I also found that the Glossy Indirect output was another source of problems in this case.
So we need to insert a Despeckle node between the Diffuse Indirect output from the RenderLayer node, and the corresponding Diffuse Indirect input on our Combine All node. But instead of just making a simple Despeckle node, let’s make a custom node group. Why? Because we’ll need it in two places. So rather than having to set it up twice, just do the setup once, and insert two instances. That way, we can adjust the despeckle settings in just one place, and have it automatically take effect wherever there is an instance. Also, maybe we want to try other filters in combination with or instead of Despeckle; again, we would only need to make the change in one place, and it would automatically affect all instances. “Don’t repeat yourself”, remember?
So here we are, with a couple of instances of our custom “Fix Fireflies” node group inserted in the most troublesome light paths.

![Fireflies gone!](image)

**Figure 1012** Fireflies gone!

And here is the resulting render.

### 158.2. Conclusion

Fireflies can be troublesome, particularly because there is no 100%-foolproof way of getting rid of them. After all, if there were, why not just build it in as an automatic part of every render? This pair of pages has presented a range of techniques for dealing with them, from simple to complex. Of course it makes sense to try the simple ones first, and only if they’re not good enough, is it worth expending effort on something more complex.

### 158.3. See Also

- This video[^4] by Bartek Skorupa, which was the inspiration for this page.

[^4]: http://cgcookie.com/blender/2012/12/10/compositing-cycles-render-passes-blender/
159. Procedural Eyeball in Cycles

You previously learned\(^1\) how to model an eyeball using just procedural textures with the Blender Internal renderer. This page will redo the exercise using the Cycles renderer.

**Note:** The BI version of the tutorial relied on a quirk of the Musgrave texture, in that a certain combination of settings produced a nice pattern of radial ridges for modelling the iris of the eye. While Cycles also has a Musgrave texture, I was not able to reproduce the same effect. However, Cycles has a much more powerful material node system, and in particular by transforming to polar coordinates\(^2\) and applying a radial scaling, I was able to get a suitable pattern of radial ridges using just a simple Noise texture.

159.0.1. Why Procedural?

Rather than mess around with intricate manipulations of procedural texture generators, the previous tutorial Creating Pixar-Looking Eyes\(^3\) used an image for their iris texture. This simplifies some things, but it has its own drawbacks:

- How do you create this image texture? Do you hand-paint it? If the resolution is not high enough, or the patterns or colours are not right, you must redo it.
- It’s a separate file you have to remember to include with your project. The Cycles renderer does not (yet) support packing images into the .blend file.

As you will see below, a procedural node setup gives you plenty of opportunities to tweak parameters, to produce effects that are subtly (or not-so-subtly) different. This allows for a great deal of variety, with very little effort—once you have worked out the node setup, of course.

159.1. Creating the Mesh

The modelling part of the exercise is exactly the same as in the BI version. If you already have a mesh that you did for the BI tutorial, feel free to reuse that and skip to the next section. Otherwise, continue reading.

---

\(^1\) Chapter 86 on page 785
\(^3\) Chapter 85 on page 773
The mesh will consist of two modified UV spheres, one just slightly inside the other. The outer mesh will have a material that is both transparent and reflective; at the front of the eye, this will represent the *cornea* (where the light enters the eye), while over the rest of the eye, it will add shininess to the eyeball. The inner mesh will make up the remaining three major parts of the eye that are visible from outside:

- the *sclera*, the white part of the eyeball
- the *iris*, the variously-coloured ring of muscle that surrounds the hole that actually lets in the light, and
- the *pupil*, the hole where the light goes into the interior of the eye.

Start in Object mode. Get rid of the default cube. **SHIFT** + **A** dd a new UV sphere mesh; 24 rings and segments should be sufficient. Switch to front view **NUM1**, and check the “Align to View” box that should have appeared in the panel at the bottom of the Tool Shelf. This will be the inner mesh.

**TAB** into Edit mode; make sure the entire mesh is selected; **SHIFT** + **D**uplicate it, and **S**cale it slightly up to create the outer mesh. (You may find it easier to work in wireframe **Z** mode.) **R**ende the outer mesh you just created for now, to make it easier to work on the inner one.
Select RMB the single vertex at the front of the inner mesh. Now press NUM+ four times to extend the selection to include the first four rings of vertices out from this front vertex. The selection should look like at right.
Now flatten the selected vertices with the sequence \texttt{S Y 0KEY ENTER}. Next, reduce the protrusion of the resulting flattened disc with \texttt{G Y} and moving it a little closer to the rest of the eyeball. The result should look like at right.
This will do for shaping the inner mesh. Now to do the outer one. Unhide it $\text{ALT} + \text{H}$.

Select $\text{RMB}$ just the frontmost vertex. In the Mesh menu, set Proportional Editing to “Connected” and Proportional Editing Falloff to “Root”. Now move the selected vertex forward with $\text{G}$, and use the mouse wheel at the same time to adjust the proportional editing influence until you make a bulge that is about the right proportions for a human cornea.

OK, that’s the modelling done, now on to the fun part—creating the materials in Cycles.
159.2. UV-Mapping the Iris

The iris pattern needs to be correctly located so that the radial striations are symmetrically arranged around the centre. To control the placement of the iris texture, we need to set up a UV map.

Set your layout to have both a 3D view and a UV/Image Editor view, as at right. Create a new image in the Image Editor; this will be just a dummy for the UV unwrapping, so its size and contents do not matter.
Creating the Materials

159.3. Creating the Materials

159.3.1. The Cornea

For the outer mesh, you can set up a material similar to the one previously discussed in A Glass Material in Cycles\(^4\). Only, instead of an IOR of 1.45 (glass), use a value like 1.33 (water), since water is the main constituent of the transparent tissue (as indeed of all human tissue).

159.3.2. The Sclera

The material for the white of the eye needs a little tracery of red blood vessels, but not too much. Here the network of blood vessels is provided by a Wave texture node with a very high distortion setting. This is then put through a Bright/Contrast node: enhanced contrast to sharpen the edges, and reduced brightness to make the blood vessels very pale. This value is then fed to a Mix RGB node to mix between the white of the main part of the eyeball and the red of the blood vessels.

The original tutorial added some shininess to this material. However, since the cornea material is already shiny, and already overlaying the entire eyeball, it seemed redundant to have shininess here as well.

---

\(^4\) Chapter 156 on page 1169
159.3.3. The Iris

This is the fun one, because it will require the most intricate Cycles node programming.

As previously mentioned, we have to convert some texture coordinates from rectangular to polar coordinates. The node group at right will achieve this. It looks quite complicated! However, it becomes easier to understand if you take it step by step:

- The two rows of 3 nodes each at the upper left (each containing a Subtract followed by two Multiply nodes) take the incoming X (upper row) and Y (lower row) values, subtract 0.5 to convert the range from 0..1 to -0.5..+0.5, multiply by 2 so the range is now -1..+1, and takes the square of each value. These are then added and the square root (Power of 0.5) of the result taken, to give the distance of the point from the origin, in the range 0..1. In other words, it is computing the equation $r = \sqrt{x^2 + y^2}$. This is the Mag output from the node group.

- The bottom-most row of nodes divides X by Y (actually it should be Y by X, but that doesn’t matter for our purposes) to compute a slope, and then uses the arctangent function to get the angle of this slope. This value is in radians, so it is divided by 1.571 ($\frac{\pi}{2}$ or close enough) to convert it to the range 0..1. This becomes the Angle output from the node group.

---

Now we use the above node group in *this* node setup. Note the “Separate RGB” and “Combine RGB” nodes: they are not separating/combining RGB colour components, but *XYZ coordinate components*. In both cases, the components are scalar reals, so mathematically speaking, this (ab)use of the separate/combine RGB functions is perfectly all right. Note also how we ignore the B component (i.e. the Z coordinate), since we are only dealing with a two-dimensional texture.

After separating out the X and Y values, these are fed through the Rectangular→Polar conversion node group we created above. But then note how the Mag value is put through a division by 4 to stretch out the texture radially: this is the secret to getting the radial ridges in the iris texture. After the coordinate components are recombined, they are used to control a Noise texture, which then gives a bump map to the iris material.

**Figure 1020**

**But we’re not done yet.** There is still some more node magic to wield, to get a radial gradation in colour from the centre to the edge of the iris. To build that, we will need another node group, as at right. This one is called “Rescale”: it takes a value in an input range (defined by the “In Low” and “In High” inputs) and linearly transforms it to an output range (defined by the “Out Low” and “Out High” inputs). Or, using mathematical symbols $x$ for the input value, $y$ for the output value, and $x_0$, $x_1$, $y_0$ and $y_1$ for In Low, In High, Out Low and Out High respectively, this node group implements the transformation $y = (x - x_0) \frac{(y_1 - y_0)}{(x_1 - x_0)} + y_0$. 
And now, here’s how we add a use of the Rescale node group to our iris material node setup. We use it to transform the Mag polar coordinate (distance from centre), and then use that to drive a colour ramp that actually controls the diffuse colour of the iris. Here I have done a gradation from light green to dark green; feel free to substitute whatever eye colours and gradations you choose.

159.3.4. The Pupil

Here I just used a simple black diffuse material. The original tutorial added some subtle suggestion of red blood vessels, similar to the sclera; you could do that here if you want, but I thought the effect was too subtle to see, so I didn’t bother.
159.4. The Final Result

And here is what the final render might look like.

159.4.1. Parameters to Tweak

The above node setups are quite complex, but they offer many opportunities for experimentation.

For example, in the Sclera material, try tweaking the Bright/Contrast settings, to see how that affects the result. Make the red blood vessels more prominent, and the eye looks bloodshot!
In the Iris material, you can change the eye colour (of course). But also try changing the radial striations: see how they look if they are larger. Why did I put the Rescale node there? It was to let you increase or decrease the effect of the colour ramp, without having to edit the ramp itself.
160. Introduction to Freestyle

**Information**

Applicable Blender version: 2.67

New in Blender 2.67, the **Freestyle** renderer adds a whole range of *non-photorealistic* effects to the Blender Internal renderer. It seems in some ways like the decades-long quest for photorealism in computer graphics has come full circle, and people are now deliberately seeking how to achieve more cartoony or line-drawing-style effects!

160.1. A Simple Freestyle Example

Start with a new Blender document. Delete both the default cube *and* the default lamp. In the World
context, check the Environment Lighting box and set its energy to 1.0. This will give your scene a flat, shadowless light that suits a cartoony effect.

Create a Circle mesh object. **TAB** into Edit mode; all the vertices should be selected, so you can add a face joining them all just by pressing **F**. Next, select just one vertex with **RMB**. Go to the Mesh → Snap menu and select “Cursor to Selected”. **TAB** out of Edit mode, and go to the Object → Transform menu and select “Origin to 3D Cursor”. Putting the geometry origin at one edge of the circle, rather than its centre, makes it easier to apply the upcoming transformation via an array modifier.
back into Edit mode. Select two vertices equidistant from the one you used to position the geometry origin. Turn on proportional editing (Mesh → Proportional Editing → Connected). Now press $S$ to scale the two selected vertices closer to each other, and use the mouse wheel to regulate the proportional-editing falloff to get a reasonable leaf or petal shape, as at right.

Once you’ve got a decent shape, select all the vertices and rotate them by a small angle, say, 5°, e.g. $R\ Y\ E\ N\ T\ E\ R$. This will keep the overlapping copies of the object from running into each other and producing some unpleasant rendering effects.

back into Object mode. Now add an Empty at the current position of the 3D cursor. Rotate it about the Z-axis by 60°: $R\ Z\ E\ N\ T\ E\ R$. Since this shares the same geometry origin as your circle, it can be used to apply a rotation to the latter without it turning into a spiral.
Select your circle again. Add an Array modifier: uncheck Relative Offset (and ensure Constant Offset is off as well), and turn on Object Offset. Click on the field for entering the object name, and in the popup menu that appears, select the name of your Empty (it should be called “Empty”). Set the Count to 6. You should now see a leaf-like or flower-like arrangement of 6 copies of your circle. While you’re at it, give it a suitably plant-like colour, like leaf green.

Now go to the Render Context.

\[\text{Figure 1025}\]

Look for the “Freestyle” checkbox near the bottom, and check it. Switch to the Render Layers Context.
A Simple Freestyle Example

Figure 1026

, and you should see that a “Freestyle” panel has appeared. Click the “+” button next to the “Freestyle Line Set” list to create a new entry. You can leave all the settings for the new Line Set at their defaults.

Now hit $\text{F12}$ to render, and you should end up with something like this:
160.2. See Also

- Video tour\textsuperscript{1} of just about every Freestyle setting.

\textsuperscript{1} http://www.youtube.com/watch?feature=player_embedded&v=J3LI_MTnY7U
161. Overview
162. Introduction

Welcome to the wonderful yet complex world of computer animation! Through these pages I will try to show you everything old and new about the new animations system in Blender 2.4. But, before we get started, there are some basic notions about datablocks you should know. Animation in Blender is based on the fact that you have something moving in a Blender scene. For example, a ball bouncing on a floor plane:

- So you have a scene datablock, which holds some info about the scene itself, as you can see in the Render button window (F10 key).
- You populate this scene with various objects (which in this case refer to containers for data, not the actual mesh data that shapes the object itself). The only goal of an object is to hold the whereabouts of the data you want to see in your scene. It also holds the object instance's properties such as "does it have soft body or particle options, and do we draw its name?" Most of the info on an object can be seen in the Object Window (F7 key).

An object links to all of the data you can see in 3D views such as mesh, curves, nurb, lattices, armatures, metadata, the empty property, text, camera and lamps.

So the ball you just added to the scene is in fact a mesh, linked to an object that is in turn linked to the current scene.

Now there are also datablocks you can't see in 3D view, such as material, texture, Ipo, action and image. Instead, you have a special window in which to edit them. This is the idea behind the Blender interface, where in each datablock has a window for you to edit the data.

So back to this bouncing ball: It's also moving across the plane! So an "Ipo" datablock is linked to the object, telling it where in space the object will be at each frame of the animation. This Ipo is editable in the Ipo window when selecting the ball in 3D view.

In Blender, the work you are performing is always on the currently active (selected) object and data.

Looking at the OOPS (object-oriented programming system) view (or SHIFT-F9 key), we can get a good idea of the internal data structure:

Figure 1028

Again, you are working in the scene "Scene", with an object "Sphere" linked to the mesh data block "Sphere" and the Ipo datablock "ObIpo". Why is that important? Because from there, you can start playing with the datablocks, linking them all around your projects to reuse old work. For example you can create more than one Ipo, and use the one you want, or tell more than one object to use the same Ipo, or to use the same object in more than one Scene.
Introduction

Most of the linking job can be done in the Edit button window (F9KEY). Where you can tell an object to use another mesh’s data block for Ip, material, texture or image. There is always a little dropdown menu button for you to select an already-existing data block.

Now, when it comes to animation, you have to understand the way Blender handles data very well, because using Blender is always a matter of plugging data blocks together when working with Ipos, actions and NLA objects.
163. Guided Tour:

Here I'll show you all the stuff you need to know about the interface when animating. Where is it? How does it work? Why use it?

We are going to talk about:

- Armature Object\(^1\)
- Mesh Object\(^2\)
- Constraints\(^3\)
- Timeline Window\(^4\)
- IPO Window\(^5\)
- Action Window\(^6\)
- NLA Window\(^7\)
**164. Armature Object**

The Armature Object in itself is a tool for the animator to move an object or group of vertices in a reliable way. An armature is made of bones, which can be parented to each other, or connected to each other. It was built with the idea of a skeleton in mind. And in fact, in the 3D world with animation inclusive, it’s considered to be the skeleton.

You can add it using the SPACEKEY in 3D view and selecting Armature. You’ll then enter into Edit Mode where you can add or move bones to build your default rig. An armature has 3 states. You can switch using the dropdown menu in the header of the 3D view or use the TABKEY to switch between Edit mode <-> [Object mode|Pose mode] and CTRL-TABKEY to switch between Object mode <-> Pose mode:

- **Object Mode**: Your armature is like any other Object, you can move it around the scene, scale it, rotate it and edit options in the button window.
- **Edit Mode**: Your armature is in what we call rest position, you can modify the bones it contains.
- **Pose Mode**: Your armature is ready to be animated, each bone can be moved, scaled or rotated, constraints get applied, you can pose your character and animate the bones’ behavior over time.

Take note that Pose mode is now a state of the armature you can switch on/off using CTRL-TABKEY. So when in Pose, you are still in object mode (you can select another object, contrary to the edit-mode)

Note: The following 3 pages of this tutorial contain screenshots and discuss techniques that are only available in Blender 2.40a and later. Refer to the Blender 2.40a release notes on Armature draw types and Armature envelopes.

---

1 Chapter 165 on page 1253  
2 Chapter 166 on page 1265  
3 Chapter 167 on page 1277  
4 [http://www.blender.org/cms/Blender_2_40_alpha.598.0.html](http://www.blender.org/cms/Blender_2_40_alpha.598.0.html)
165. Armature Object in Object Mode

165.1. The Armature Object

Armature Object is like any other object type:
- It has a center, a position, a rotation and a scale factor.
- It can be edited.
- It can be linked to other scenes, and the same armature data can be reused on multiple objects.
- All animation you do in object mode is only working on the object, not the armature’s contents like bones.

Try it now: add an armature to your scene: SPACEKEY -- Add -- Armature.

![Figure 1029](image.png) How to add an armature bone in Blender 2.62

Or you can press the Shift + A keys, and select single bone from the armature menu.
How to add an armature bone in Blender 2.62

When you add a new armature, you’ll enter editmode automatically. To switch between modes, use the TABKEY or the dropdown menu in the Header of the 3Dview window (This might not be the case with blender 2.49b, you won’t enter edit mode in that version):
165.2. The Edit Panel When in Object Mode

This is how the edit panel looks after you have added a new armature and switched to object mode (TABKEY):
• Link and Materials panel:
  • The AR: field let you rename your armature Datablock. The dropdown is a quick way to select which Armature datablock you want to connect to this armature. You can keep more than one version for the same character. Useful when you have a special move to achieve in a shot, you can turn on an armature for a special purpose.
  • The F button is an option to assign a Fake user to the Armature. Again if you have more than one armature for your character, it’s a good idea to turn the Fake on, because if your armature datablock is not used (linked) it’s not going to be saved in your .blend files. You can always do batch Fake-assignment of armatures by opening the Datablock browser (SHIFT-F4KEY), go in Armature datablock, select all the armatures you want to keep, and Press the FKEY.
  • The OB: field is just to Rename your armature Object to something more cool and useful than Armature... Armature.001...
• Armature panel:
  • Editing Options:
    • X-Axis Mirror Edit: Not really useful now, it’s more of an editmode option. This feature tells Blender you want to replicate all of your bones on one part of the Armature to the other. It’s a clean way to just do half the job ;). The axis of mirroring is X so left<-->right in frontview (NUMPAD_1KEY) and the center is the center of the armature object. We will see this feature in detail in the next page.
    • X-Ray: This option will let you see the armature through anything in the scene, solid or not. It’s useful to see where your bones are in your character so you can select them.
    • Automatic IK is a Posemode option. It lets you pose a chain of bones as if the bone you were holding was an ik target. More info in Posemode page.
  • Display Options: These options give you the chance to visualise your bones in various ways. Also note that there is some specific options and features regarding the display mode you’re in.
    • Octahedron: This is the default view. Nothing exciting except you have a good idea of the rolling of the bones.
Stick: This display mode is really useful when you have a lot of bones in your view. It lets you “unclutter” the screen a bit. It draws the bones as tiny sticks.
• B-Bones: It’s more a feature than a display mode. This is only useful to visualise the effect you get when you activate the B-bones (Bézier-Bones). Each bone acts like a curve handle and lets you get extremely curvy poses. This will be exposed in the following pages.
Figure 1035

- Envelope: Again it’s more a feature than a display mode. But in this case the visualisation will be useful to tweak your rig later. Envelope lets you easily tell which part of your character this bone will animate and it’s visually possible to change the zone of influence exclusively in this display mode. The zone is only visible in Editmode or Posemode though.
• Draw Axes: To draw the axes on each bone of the armature when you are in Edit mode or Pose mode. Useful when you want to know where you are and which axis to use in a constraint for example. Mental note: Y is up, Z is depth and X is side, contrary to object for which Z is up, Y is depth and X is side.
• Draw names: This lets you see names of bones whatever the mode you are in. It’s useful again to edit your armature, create parent dependencies or add constraints.
• Ghost: This option lets you see a ghost of the armature in frames behind and over the current time. This is only working when you have an action linked to the armature, as we will see later.

• Step (Armature_button_obj.jpg needs update): This option lets you choose the frames interval between ghost instances.

• Deform options:
  • Vertex Groups & Envelope: These two toggles let you choose if you want the armature to deform your character using the Vertex Groups and/or the Envelopes. We will see that later.
• Rest position: This will bring the character back to factory default (item as Edit-mode), and no actions will be applied to the armature so you can easily edit it in the middle of an animation.
• Delay Deform: This was useful before as the old system was very slow. What it does is when you do a manipulation to the rig, it waits until you finish to update the view. Can still be useful though.

165.3. Extra Practice

This YouTube tutorial might also help: Link\(^1\) The short tutorial might be a help Link 2\(^2\)

\(^1\) http://youtube.com/watch?v=QbFvrlssNo
\(^2\) http://www.youtube.com/watch?v=T1-tyJVokr8
Now you’ve got your armature, but it’s not much use until you add some more bones to it. Think about your body for a moment -- you’ve got this thing you call a ’skeleton’, which for our purposes corresponds more or less to an armature object. Your skeleton consists of a number of bones (about 206, to be precise), but generally these are not independent from each other. If you move your femur (the bit of your leg between your pelvis and your knee) then conveniently the rest of your leg moves with it. In that example, the tibia/fibula would probably be counted as one bone, with the femur as their ’parent’ bone. In this way, you build up a hierarchy of bones, making animation much simpler.

Editing an Armature Object gives you the chance to add, move or connect bones together. Whilst in edit mode, you will see all of the bones within the currently selected Armature.

When you create a new armature in Object mode a single bone will automatically be created for you, centered at the cursor position. Blender will then switch straight to Edit mode to allow you to add further bones. At this point we’re just defining the default ’rest’ position of the bones and specifying how they connect together -- you’ll have to wait until the next chapter to find out how to create specific poses.
166.1. Now the basics about bones

Figure 1039

Having created and selected an armature in Object mode, you can add and modify the bones in this armature by switching to Edit mode.

- You can add a new bone at cursor position by pressing SPACEKEY in the 3DView --> Add --> Armature.
- A bone has two ends: a root (the lower part) and a tip (the upper part). You can select and move the tip or the root independently with RMB, or you can select the entire bone by clicking on its body.
• You can extrude a new bone from the selection using EKEY. This will create a bone connected to the original one, meaning the Root of the new bone will follow the Tip of the original one. You can also CTRL-LMB to extrude a new bone. It will extrude to where you clicked.

• Alternatively, you can connect two existing bones by selecting them one after the other and pressing CTRL-PKEY. You can then choose either 'Connected’ (the child bone - the one you selected first - will automatically be moved so that it touches the parent) or 'Keep offset’.

• You can use SHIFT-DKEY to duplicate a bone

• Using the WKEY menu, You can subdivide your bone or flip the name of the bone between Left-Right (See Naming convention below).

• You can delete the bone with XKEY

• You can select a chain of bones (connected together) using LKEY, when you hover your mouse over a bone.

### 166.2. The edit panel

![Image of the edit panel](image)

**Figure 1040**

- **Armature Bones Panel**
  - OB: this field lets you rename your bone.
  - "Child of” Dropdown: lets you choose which bone will be the parent of this bone. If a parent is selected, there will be a small button labelled "con”, meaning connected. Setting the parent defines the relationship between your bones. When one bone has another as its parent, it will do everything the parent does, such as rotate, move and
scale. A dotted line between the parent and child will appear. If you select Connected, the Root of the Children will go stick to the tip of the parent, giving you a chain of bones like the 2 bones in your arm.

Figure 1041    none

- Segm: If you set this value to something greater than 1, it will cut your bone into several little segments and deform them on a bezier curve - referred to as a 'B-Bone'. You need to create a chain of bones to really show off this feature though. In the example below, the image on the right has 1 segment, and the one on the left has 3 segments each (these are shown in Object mode to show the effect more clearly):
• Dist: This is the area of influence of the bone. It can be visualised using the Envelope\textsuperscript{3} display mode. We generally don’t touch this field as there is an easier and faster way to change this option. Turn Envelope on and select a bone. Then using ALT-S, you can scale the zone of influence. This has the advantage that you can do it on multiple bones simultaneously, and it works in both editmode and posemode:

\footnote{\textsuperscript{3} Chapter 170 on page 1289}
• Weight: This specifies how strongly this bone will influence the geometry around it, relative to the other bones. If two bones crossing each other, both with envelope influence, have the same weight (like 1:1) they will influence the surrounding geometry equally. But if you set one to 0.5, the geometry will be affected more significantly by the other one, with weight 1. For example, in this image, 2 bones using envelope influence try to move the same geometry. The 2 on the left have the same weight, you can see the geometry didn’t move. On the right, one of the bones has 0.5 so the bone with weight 1 is winning the tug-of-war!
Hinge: This tells the bone to remain motionless in a chain. It doesn’t copy the rotation and scale of the parent. Useful for mechanical rig I would say, as you can animate the rotation of the hinge bone without having to correct it because the parent rotated:
- **Deform:** This lets you say if you want the bone to deform the geometry at all. Switching it off is like setting the weight to 0, except it’s faster this way. Useful when using a bone as a target or a controller, i.e. a bone you just want to use to control other bones, but not the geometry itself.
- **Mult:** to deform geometry you can use vertex group\(^4\) and/or Envelope\(^5\). The ability to mix both of these methods is handy for using one to tweak the other. For example, you might use envelope everywhere but tweak difficult places manually with vertex group. We’ll discuss this in more detail later on.
- **Hide:** This option lets you hide the bone. You can use it to hide the less important bones when you want to see what you’re doing or for when you come to animate later

---

\(^4\) Chapter 171 on page 1295  
\(^5\) Chapter 170 on page 1289
Naming convention

on. For example, when you animate you don’t need to see the entire chain of the leg, just the controllers. The values you select here apply to both Editmode and Posemode.

166.3. Naming convention

In many cases, rigs are symmetrical and can be mirrored in half. In these cases, it is helpful to use a left-right naming convention. This is not only useful for your own sake, but it gives Blender a hint that there is a pair of equivalent bones, and enables the use of some very cool tools that will save you some significant work.

- It’s helpful to name your bones with something useful telling you what it’s there for, such as leg, arm, finger, back, foot, etc.
- If you get a bone that has a copy on the other side, however, like the arm (you have 2 arms right?), then the convention is to call them arm.Left and arm.Right.
- Other alternatives are also possible, like _L, _LEFT, _left, .L, and .Left. Anyway, when you rig try to keep this left-right thing as accurate as possible; it will pay off later on.
- You can copy a bone named blah.L and flip it over using WKEY --> flip name. So the bone will be blah.L.001 after you copy it, and flipping the name will give you blah.R. Blender handily detects if the .001 version already exists, and increments the number for you.

This is an example of naming in a simple rig:

Figure 1046
166.4. Mirror Editing

Now we come to the X-Axis Mirror Edit feature. This handy little number allows you to define only half of your character and tell Blender to automatically repeat the same actions on the other side. It’s cool, it’s simple and it saves a whole lot of time.

We will create a little guy out of sticks for the occasion -- don’t worry about the geometry yet.

- Create a new, empty scene. Since the mirror editing feature mirrors along the X Axis, make sure you’ve got the front view selected (NUMPAD _1KEY) so that the X Axis runs from left to right. Add a new armature to the scene (SPACE, Add|Armature). Enable 'Draw names' from the 'Display options' section of the Edit button panel, so we can see what we’re doing.
- Now enable mirror editing by pressing F9 on the buttons window and clicking the X-Axis Mirror button in the Armature panel under Editing options. You’ll also need to use the center of the armature (indicated by a purple dot) as the center of your rig, otherwise the symmetry will go wrong when we come to create the mirror image.
- Name the first bone you have "Back". You can scale it to make the entire back of the guy.
- Select the tip of this and extrude a new bone from it to do the Head. Name it Head.
- Select the tip of Back again and do SHIFT-EKEY to tell Blender you’re starting a mirrored chain of bones. Blender will automatically extrude another bone and will create an exact mirror of whatever you do. Take note that the name of both bones areBack_L and Back_R. Blender also tries to keep to the naming convention. Unfortunately, since we extruded from the Back bone, the names aren’t quite right anymore.
- To change the names: Start by editing one of the names as Arm. Add the suffix to it (_L or _R). Then hover your mouse over the name field and do CTRL-CKEY. You just copied the name of the bone! Select the other bone, hover you mouse over the name field and do CTRL-VKEY. This will paste the name as-is. But as there is already a bone with the same name, Blender will add .001 after it. No problem; just go into 3Dview and do WKEY --> Flip name. There you have it -- a working mirror again.
- Mirror editing works using names. If you move a bone named blah_L and there is a bone named blah_R in the same armature, Blender will mirror the move you do to it, so make sure you follow name convention correctly.
- Then we can continue: extrude an other bone to make the lower part of the arm using EKEY or CTRL-LMB. The new set of bones should be arm_L.001 arm_R.001.
- Then we will add the legs. Up till now we have always worked from the tips of the bone. This is easy as Blender understands you want to create children of the selected bone, but to make the legs you need to extrude from the root of "Back". So go ahead, select the root of "Back" and do SHIFT-EKEY to start a pair of chains. Rename them to "leg"+suffix.
- Now take note that doing so will not parent or connect the new bones to anything. We don’t want it to be connected to the tip of "Back", it would look silly. But we want it to follow the body!
- The way to go is to parent the two legs we just created to the "Back" bone. The old way (pre 2.40) was to select all bone and select the parent manually in the drop down. In the new version, editmode and posemode have an active bone. The active bone is the last bone you selected. In this case we can’t work with more than 2 bones selected. Select the child (a leg) then select the parent (Back) and Do CTRL-PKEY. A menu will popup
● Now you can go into Pose mode and pose your guy as you want.
● You can move the entire guy just by moving the "Back" bone, since this is how we built him. This bone is the highest in the bone hierarchy, "The daddy of all bones", you could say!

FASTER WAY TO NAME YOUR BONES
1) Create one side of the armature complete with correct bone names like the way this tutorial describes.
2) Copy the side of the armature you just created and paste it on the opposite side to form a complete armature.
3) On the side that you just duplicated, your names would have numbers added to them. Now select each bone on 3D View and hit "W" then select "FLIP NAME". MAKE SURE YOUR PARENTING IS THE SAME AS THIS TUTORIAL DESCRIBES!
167. Armature Object in Pose mode

Posemode is a very versatile place where you Animate your character, create and manage constraints and apply your rig to your character.

Contrary to Editmode, Pose mode isn’t an obligatory mode where you can’t do anything else. It’s now part of the UI like any other object. A good example of it is you can be in posemode and still select another object.

167.1. So What Can You Do?

When you are done building your armature, you can go into Posemode to add constraints and start creating actions. There are also some new tools accessible in Posemode that you may want to look at. You can easily get into "pose" mode by selecting the mode from IPO type list box in the left portion of the lower screen.

The panel has changed a bit too:
What’s new in the panels?:

- You can use the Automatic IK feature in the Edit button (F9) to pose a chain of bones like it was an ik chain. It’s usefulness is very limited though. It works well only if there is no other ik solver in the chain, and if your chain is isolated from the rest of the rig.
- Ghost: in the armature panel the ghost option lets you see the action linked to the armature over time. Also called onion skinning.
• There are two number fields to better tweak the effect of B-Bones. The in/out is used to tell the scale of the virtual handle of the bezier curve. In is the Root of the bone, and Out is the Tip. The bigger the value, the bigger the effect of rotation.
There is now a Constraint panel where you can add a constraint to a bone, like any other object in the scene. This will be shown later.

You can pose your rig using GKEY, SKEY and RKEY. Note that if the bone is part of a chain it can’t be moved (except if it’s the first of the chain, moving all the chain as they are all children), so you rotate the bone instead.

You can do ALT-SKEY on one or more bones while in Envelope display mode to tweak the envelope size in real time while animating. Useful when for example you move the hand and some part of the character isn’t in the influence zone; the result will be that some vertices will stay behind.

You can do CTRL-CKEY to copy stuff from a bone to bones. The options are location, rotation, scale and constraint. Constraint is very handy when you wan to copy a constraint to other bone. The way it works is easy.

The W-KEY menu gets some neat options too:

- Select constraint target: Will select the target of the bone’s constraint currently selected.
- Flip name: Yep, you can flip name in Posemode too.
• You can pose your character and select all bones you want to see included in the action and press I-KEY. You can insert a key just for loc, rot or size. Avail will add a key to all available channels in IPO window (all channels you previously added something).

• When you insert key for your armature, a new action is created and linked to the armature if there was no action before. You can also see the curves of each selected bone of the armature in the IPO window. We will see action window and IPO window later.

• You can parent a bone to an external object by selecting this object then selecting the bone in question so it’s active (The armature is in Pose mode so you can select a bone). Do CTRL-PKEY. Then when you move the bone the object will follow. This kind of Hard relationship doesn’t include any bending at all. It’s useful when doing robot rigs as you are just moving objects around.
168. Mesh Object

This section will explain how to deform your mesh using the armature.

There are two ways to tell Blender which vertex will go with which bone: Vertex group, and Envelope.

There is also a tool useful when animating which is part of the mesh object: the Shape key, to create a preset deformation. For example: deform the face to look like a smile.

- Connection between Armature and Mesh\(^1\)
- Envelope\(^2\)
- Vertex Groups & Weight Paint \(^3\)
- Shape Key\(^4\)

---

1  Chapter 169 on page 1285
2  Chapter 170 on page 1289
3  Chapter 171 on page 1295
4  Chapter 172 on page 1305
169. Connection between Armature and Mesh

How to tell Blender: "use this armature to deform this mesh"

169.1. The Armature Modifier

Blender now has a Modifier stack (Edit button, F9KEY). As such, we should use it over existing methods to pair mesh and armature, as the modifier stack is optimised and simple to use. Note: You don’t need to parent the mesh to the Armature anymore. The only case you could need to do this would be animating the Armature object itself. Then the mesh should also follow the armature. In this case select mesh, then armature, and do CTRL-PKEY --> Object.

![Armature Modifier](image)

Figure 1052
Connection between Armature and Mesh

The clean way to do so is to go in the Editbutton window (F9KEY) and press "Add modifier" in the Modifier panel, then select "armature" in the dropdown menu. Then you’ll get a new modifier "Armature" like the previous picture. Change the OB: field to the name of the armature object that should control the mesh. This step is very important! Without the armature object being defined, Blender won’t know how to modify the mesh since there may be multiple armatures within your world. To limit the effect of the modifier, you can enter the name of a vertex group in the VGroup: field. This will minimize unwanted distortions in very dense meshes. There are also fields to enable/disable the modifier when rendering, enable/disable when working to only move the armature (could get handy with massive character), and when editing (that’s very handy, you can edit the topology while it’s deformed). There are also two toggles to tell Blender what it should use to deform: Vertex Groups and/or Envelopes. You may have noticed these options are repeated also in the Editbutton --> Armature panel, but as the tooltip says: these two are used when you use virtual modifier (the old way) to keep compatibility with old files.

Parenting the mesh to the "armature" will create an old-way link, still visible in the modifier stack, but not very useful. The first entry with the "make real" button is what appends if you do a CTRL-PKEY to "armature". You should not use that kind of connection when you see that. Press "make real" to get a working modifier.

169.2. The Old Way

This way is not recommended but can still be useful. When doing CTRL-PKEY to "armature", you will get a menu like this:

- Don’t Create Groups will just create a virtual modifier so you can deform the mesh (the "make real" button)
- Name Groups is almost useless now as blender will create a group for you when you do weight painting.

Figure 1053
• **Create From Closest Bones** is a function to remember when you want to bake all your envelopes to vertex groups.

### 169.3. Tip: Bake envelope to vertex groups

The workflow is very simple. When you are done with the envelope’s tweaking and you have gotten the best out of it, delete the Armature modifier and parent the mesh to the armature. To parent it, go to object mode, first select the mesh and then the armature, then press CTRL-PKEY. Select *Create From Closest Bones*.

Do ALT-PKEY and redo the Armature modifier. Now all the envelope influence are converted to Vertex Groups. This way you can further tweak influence zone using Weight paint. More info in the following pages.
170. Envelope

170.1. What is Envelope

Envelope is a new visual tool to help you rig your characters faster and easier. It can often save you a lot of time. Each bone has a special area around it, allowing you to tell Blender what part of the geometry will follow each bone. This zone is customizable so you can move, scale and blend them together.
170.2. Edit Envelope

You can edit this white zone in Editmode or posemode by going in Envelope display mode (Buttons Window → Armature → Display Options → Envelope), selecting bones and using SKEY or CTRL-ALT-SKEY.

In Editmode: you can select the Tip, the Body or the Root and scale using SKEY. This area in the middle will assign a weight of 1 to all vertices contained in here. All vertices with a weight of 1 will completely follow this bone. The white transparent area around the center is a zone of influence which loses power as you go away from the center. This area is scaled when selecting the body of a bone and doing CTRL-ALT-SKEY. In Posemode: You can only scale the zone of influence with ALT-SKEY when in Envelope display mode. It’s real time, and lets you tweak the influence while you animate. So if you notice there is a vertex not following in the new pose you just did: Just select the bone it should follow, and scale the zone a bit until the vertex goes back with his friends. Example:

Figure 1055
170.3. Envelope Options

It’s possible to enable/disable the use of Envelope in the Modifier stack using the "Envelope" toggle.
There are also two important buttons in the Armature Bones panel: Deform and Mult.
Enabling the Deform button will tell Blender to deform geometry with this bone. It’s useful because in a more complex rig not all the bones are there to deform, some bones are just there to move other bones.

The Mult option will tell Blender to multiply the weight it gets from envelope (let’s say 0.7) with the weight you painted in weight paint (let’s say 0.5). The result will be $0.5 \times 0.7 = 0.35$ so in fact you just tweaked the envelope influence to 0.3 when it was at 0.7. If you don’t want vertices to be part of the zone, you can always paint it with 0, as $0 \times$ (something) will always give 0. This way you can give custom shape to your envelope. More on weight paint on next page.
In this example of a formerly flat surface you can see that all the selected vertices are not following the bone when it is moved upwards. This is because I painted a weight of 0 on them. In weight paint you’ll see nothing. But just the fact that they are part of the group with a weight of 0 will make that possible. If Mult is off and you have both a vertex group and envelope, Blender will add value.
171. Vertex Groups & Weight Paint

171.1. What Are Vertex Groups?

Vertex groups are very useful. You can use a vertex group to:

- Group vertices together while you model (keep a selection and come back to it later).
- Define which vertices softbody simulation affects.
- Define which vertices emit particles.
- Define which part of a mesh will follow a specific bone.

Vertex groups are specific to the Mesh object and can be modified in Editmode.

If you have vertices assigned to multiple groups (for example, in a character you may have some vertices in the "upper arm" vertex group that are also in the "lower arm" vertex group), you can assign weights to those vertices to specify how much relative influence the different groups have. A weight can range from 0 to 1 and is assigned when you create the group. Let’s take a peek at the GUI of vertex groups in the Editbutton(F9KEY):
From top down:
- The dropdown menu lets you select an existing vertex group or rename the current one.
- The weight numfield lets you choose the weight value assigned when you add vertices.
- You can add a new group or delete the current one.
- Assign or remove selected vertices to/from current group.
- Select/deselect all vertices in current group.

171.2. Weight Paint

As mentioned above, you may often find that you have some vertices that are assigned to more than one vertex group. By assigning weights, you can specify the relative influence each of the vertex groups have. You have two options to assign weights: 1) manually selecting each vertex and typing in a weight value, or 2) use weight painting to - you guessed it - paint weights.
Weight painting lets you paint weight values on the mesh like you were painting on a wall with a can of spray paint. It is a Mode of the 3Dview and is accessible in the 3Dview’s header in the dropdown menu with Objectmode, Editmode and such. A hotkey is also available: CTRL-TABKEY.

In Weightpaint Mode, the first thing you’ll notice is the blue color of the mesh. Blender provides an easy way to quickly visualise the weight value of each vertex. This is the color spectrum used:

![Color Spectrum](image)

**Figure 1061**

When you are in Weightpaint mode you can paint all over the mesh as if it was a solid object on your desk. The paint only works on vertices so don’t try to paint in the middle of an edge or a face, it will never work. To help you in your task there is a new panel in Editbutton:
The weight slider is just the same thing as the weight numfield we saw earlier in the vertex groups button. It’s just easier to work with. It’s simply the weight you want to apply to the vertices. In painting terms, think of this as the color.

The buttons from 0 to 1 are shortcuts for weight value, to speed up the workflow.

The opacity slider (and shortcuts) tell Blender what is the percent of the weight value you want to apply in one shot. If you set opacity and weight to 1 the vertex will turn red instantly. In painting terms, think of this as the pressure.

"All faces" tells Blender if you want to paint on all faces in the mesh or just the visible one.

"Vertex Dist" tells blender to use vertex distance instead of faces. When active, the painting will only check if the vertex is in the brush, then apply a weight value. If it’s off, all vertices part of the faces in the brush will receive weight value. Turning on Vertex Dist can give good results when you have a lot of polys in your mesh.
• "Normals" will apply vertex normals before painting. This means Blender will take consideration of the direction the vertex is pointing when painting: the more it’s facing away from view, the less it will receive value.

• "Spray" really makes it like spraying paint. Without it, a single click will only paint one value. With Spray on, each time you move the mouse a paint shot will be added. To get a good effect, use a small opacity value so the weight will increase slowly.

• "X-mirror" will tell Blender to apply the weight paint on the other group if there is one. Like Hand.L --> Hand.R. If you paint the group hand.L and there is a hand.R the paint will be copied over. For this to work your groups must be created, the name of the groups have to follow name’s convention (left right) and both side of the mesh need to be identical.

• "Wire toggle" toggles the visibility of wire while painting. Useful to find where the vertices are (activate the edit mode option 'Draw all edges' to see even better).

• "Mix"/"Add"/"Sub"/"Mul"/"Filter" is how you want to apply the paint based on what is already there. Mixing will do a mean from brute weight value and current weight value, "Add"/"Sub" will directly add or subtract value, "Mul" will multiply (exponential painting) and "Filter" will paint based on alpha value.

171.3. Vertex Groups and Armatures

So what use are vertex groups in rigging? You can specify what vertices will move when a bone moves. When you want to paint a mesh for an armature, do the following:

• Make sure the Mesh has an Armature modifier.

• Select the armature and enable Armature Posemode (CTRL-TABKEY).

• Select the mesh and enter Weightpaint mode (CTRL-TABKEY). (Question: if we’re in Pose Mode for the Armature, how are we supposed to select the mesh? Ans: right click on it.)

• Select the bone you want to paint for with RMB.

• Paint the parts you want that bone to affect.

You’ll notice that, if there is no group created when you first paint, Blender will create a group for you, and give it the same name as the selected bone. This is important, because when the "Vert. Groups" toggle is on in the Armature modifier, Blender will try to match bones with Vertex Groups based on the same names.

What happens when we try to blend groups together? See this simple example of 2 bones trying to bend a tube:
The Groups are painted so the body of each bone is in red and the zone between the two bones are gradually going from 1 to 0. This will bend nicely. If, for a special reason, you want a side to react differently, you can always move the bone while painting and try the new modification you just did. By the way, having Subsurf on while painting can be very cpu expensive. It’s a good idea to turn it off.

171.4. Using Weight Painting with Armatures

Armatures are used for many purposes, but one common use is to deform a mesh with an armature. This example will demonstrate how weight painting can improve armature-deformed meshes.
In this example, we have two objects; each has an armature modifier applied. The one on the left is going to be the "before" and the one on the right will be the "after".

For the object on the left, take a look at the vertex groups as initially assigned (from left to right: Bone1, Bone2, Bone3, and Bone4). These same vertex groups were assigned for the object on the right:
**Important:** A bone in an armature will only act upon those vertices that are in a vertex group with exactly the same name as the bone.

- In Blender 2.37 and previous, this was the ONLY way to get a bone to deform a mesh.
- In Blender 2.40 and on, selecting the "Envelope" button in the armature modifier will allow bones to deform even if you haven’t assigned any vertex groups yet.

If you enter Weight Paint mode (CTRL-TAB with object selected) right after assigning the vertex groups, you can see that the vertex groups as assigned all have a weight of 1.0:
OK: both objects have vertex groups assigned and they have armature modifiers. Let’s grab a bone (select the Armature, CTRL-TAB to enter Pose Mode, select Bone4, GKEY to grab, and move) to deform the mesh. We haven’t made the objects different from each other, so after moving their armatures in the same way . . there’s still no difference. That’s good.
172. Shape Keys

172.1. Shape Key?

Shape keys are modifications of the original mesh that you can animate and mix with each other. Previously called Relative Vertex Keys (RVK), one of their major uses is to create facial expressions.
The idea behind Shape keys is simple. The basic, undeformed mesh you start with is the "Basis" shape. You can add a variety of different versions of this shape and store each one as a Shape Key for use in animation (other software sometimes refers to these as "morph targets"). You can’t add or delete vertices as Shape Keys only store the positions of vertices and not the creation/deletion of them.

Ok, to start out, take a plane. I’ll add a new shape to it and move a vertex away:

When I play with the influence, this key has over the basic shape, the result will be as follows (0.5 in this example):
If I play with the slider from 0 to 1, Blender will gradually apply the Key 1 shape with a constantly varying amount of deformation. So from 0 to 1, it will slide from the basis shape to the Key 1 shape. The movement of the vertices is linear from start position to end position and you can even set an influence greater than 1 or lower than 0 and Blender will extrapolate the movements of the vertices relative to the basis shape (marked as a dotted line above). This feature allows you to set general shapes such as a smile and then exaggerate the shape without needing to remake it.
172.3. Shape Keys step-by-step

Here's a hand-held walk-through of how shape keys are used.

Start with the default cube or a more interesting mesh of your choice.

1: Select your object in Object mode. Go to F9 Editing window. Find and select the "Shapes" panel. Press the "Add Shape key" button. This adds a key called "Basis"
and this stores the "basic" mesh in its undeformed state. Make sure the "Relative" button is pressed (should be default).

2: Press the "Add Shape key" button again. It now says "Key 1" and you have a slider and some other settings. Go into Edit Mode, grab a vertex and move it. Exit Edit Mode. The mesh returns to normal but you’ve just added a real Shape key and Blender has stored it.

3: Repeat step 2 for as many different shapes as you like. You can rename the keys to whatever you want. Normally you create each new shape by first selecting the "Basis" key but if you select an existing key from the list and immediately press "Add Shape Key" then enter Edit Mode, the mesh will already be deformed. This is useful for making similar but unique keys.

172.3.1. Using Shape Keys

1: Starting on frame 1, select each key one by one from the pop-up list (or go to the Action Window, press the sliders button and select the Keys from the list there) and click on the slider and move the slider forward then back to zero. Sometimes just clicking on the slider at the zero point is enough to set the key.

2: Move forward ten frames, select Key 1 from the list and move the slider to 1.00. You’ll see your object deform. Move more frames and slide another key. And so on and so on. You can move them forwards and/or backwards as you move through the frames and they’ll just add together if they have to. Each time you move the slider, you set a keyframe for that Shape Key.

Figure 1072

Setting Shape Keys

172.3.2. IMPORTANT NOTE:

You should add shape keys to a finished mesh. Don’t work on a mirrored mesh or a partially finished model. Adding geometry (vertices, faces, loops, joining etc...) can result in the loss of the shape keys or to unpredictable results. Not always, but probably when you least expect it. There are scripts available to make some of these things possible.

That’s the basics. Note that shapes will constantly transform between keys so if you set a key at frame 1 to zero and at frame 10 you set the slider to 1 then at frame 5 the slider will be at 0.5 - which you may or may not want. If you want it to hold shape for a while before changing (e.g. staying at zero until frame 7), you’ll need to set a key at the beginning and
end of the time frame you want it to stay the same (So you would set it a zero at the start, then zero again at frame 7 then to one at frame 10). You can also edit the IPO curves (use Shapes pop-up) to really mess with the transformations.
173. Lip-Sync with Shape Keys

173.1. Lip-Sync with Shape Keys

Here I will attempt to explain my recent dealings with using Blender Shape Keys to produce convincing lip-sync (Lip-synchronisation, i.e.: "speech") for simple, humanoid characters.

This is aimed at people with an understanding of Blender fundamentals like vertex loops, face loops, sequencer and of course, Blender’s new Shape Key system. If these terms mean nothing to you, then you may well struggle to keep up. If you’re familiar with them then I hope this tutorial will prove to be a breeze and your characters will be speaking so fluently you’ll have trouble shutting them up!

Other Lip-sync tutorials, if you can find them, recommend using other software like Magpie, Papagayo and others but while I’ve no doubt they provide a valuable service and maybe make syncing easier, I will be using only Blender for this tutorial. I haven’t tried using lip-sync software yet so I can’t really say if it’s easier or not.

You will find links to interesting audio files you can use for testing animation and lip-sync near the bottom of the page.

173.2. The hard work first

173.2.1. Setting up for Lip-Sync

First, set up your Blender screen so you have everything you need for this project. You’ll need a front 3D Window, an Action Window, the Buttons Window (showing Editing - F9 - panels) and a Timeline Window. If you’ve got the room, a Side-view 3D Window would be handy too.

The basic sound units are called phonemes and the mouth shapes we use to represent these phonemes for lip-sync are called visemes (or sometimes, phoneme shapes) and there are many references for these around the web. Legendary animator Preston Blair created one of the most popular viseme sets\(^1\), which is great for cartoon-style characters. Other visemes are aimed at more-realistic, humanoid characters. The shapes you choose depend on the style of your model. \(I’ll\ try\ to\ provide\ some\ useful\ links\ later\)

\(^1\) http://www.garycmartin.com/mouth_shapes.html
Sample viseme shapes.

The first and most difficult step in good lip-sync is making the shape keys for these visemes. How well these are made ultimately determines the success of the animation and it is worth spending time getting them right, although they can be modified and tweaked later. So choose your favourite set of visemes (or even look in a mirror and use your own face as a reference) and start setting your keys. A model with good topology especially well formed edge loops around the mouth area will be a big help here!

What on Earth are topology and edge loops?!

Topology refers to the way your 3D mesh defines the object, in this case your character’s head. Edge loops refers to the flow of consecutive edges around the character’s major features. Typically, good edge loops flow around the eyes and around the mouth in a somewhat deformed, “circular” manner. Selecting and deforming a single loop of edges and vertices surrounding a facial feature is much quicker than having to individually select a lot of edges that don’t flow naturally around that feature. Similarly, deforming a single loop or collection of related, nested loops is much easier and quicker than trying to deform a seemingly random set of edges. You can easily see these loops in the character screenshots above. The series of edges surrounding the mouth simply stretch from wide ellipses to almost circular to create a useful variety of mouth shapes. The faces defined by paired edge loops are referred to as face loops. The close-up image below shows selected face loops.

There are many tutorials on the web about these topics so if you need more information before proceeding then a quick search is probably a good idea.

Setting the basic viseme shape keys

First, select your undeformed mesh and create your basis key. Go to Editing (F9) window and go to the “Shapes” panel. Press the “Add Shape Key” button. Enter and exit edit mode to set the basis key. Then create your first key Key 1 and name it “M”. Enter edit mode and if your character’s mouth isn’t already closed (some people make them that way) then close it by carefully selecting the faces and loops around the mouth. You will usually use Size-Z plus a bit of grabbing and shifting to achieve this. Don’t forget to include the
faces on the inside of the lips or the deformation will be unpleasant. When you’re happy with the shape, exit Edit mode and there you have it. Your character can now say “Mummmm” whenever you like. Test it by moving the Shape Key slider back and forth but make sure to leave it at zero before making more keys. *(If you made your character with a closed mouth then you can just add the new "M" key then enter and exit edit mode to set it.)*

![Figure 1074](image)

**Figure 1074** Selecting face loops

**Selecting face loops**

For most new keys, you will select the basis key first then press ”**Add Shape Key**” then make the required shape from scratch in edit mode. However, some mouth shapes are very similar, like "OH and OOO” or "EE and SS” and it would be easier if you could start with something close to what you want rather than shifting everything from scratch every time. Luckily, Blender allows you to do just this. Once you’ve made your "EE” key, for example, you can select it and immediately press ”**Add Shape Key**” then enter edit mode and the mouth will already be deformed and you only need to make subtle changes to it to make your "S" shape.

**Remember that the keys you make are for sounds, not letters.**

In general, you’ll need shape keys for the following sounds

- M, B, P
Lip-Sync with Shape Keys

- **EEE** (long "E" sound as in "Sheep")
- **Err** (As in "Earth", "Fur", Long-er" - also covers phonemes like "H" in "Hello")
- **Eye, Ay** (As in "Fly" and "Stay")
- **i** (Short "I" as in "it", "Fit")
- **Oh** (As in "Slow")
- **OOO, W** (As in "Moo" and "Went")
- **Y, Ch, J** ("You, Chew, Jalopy")
- **F, V**

These can often be used in combination with each other and with jaw bone rotations and tongue actions to also produce other sounds like "S", "R", "T", "Th" and a short "O" as in "Hot" - or these can also be specifically made with their own shapes. This decision depends largely on your character. Start with the essentials and make others if you need them.

**NOTE:** I use one jawbone in my current character and this is also used to control the mouth shapes. It doesn’t drive the shapes but it moves the bottom teeth and tongue (*which can also be controlled separately*) and the faces that make up the chin part of the character mesh. For some visemes, I move the jawbone into a logical position before adding the shape key. For example, I open the jaw for the "OH" key and close it for the "M" key. Later, when animating, the jawbone is animated along with the Shapes for a very convincing result.
Once all your viseme shapes are set the time comes to get your character to speak. (Normally you would animate the body first and leave the lip-sync till near the end).

If you haven’t already done so, load your audio file into a Blender **Video Sequencer Window** and position it where you want it. Currently, Blender only supports 16 bit wav format audio files so you may need some editing or conversion software to process the file.
Lip-Sync with Shape Keys

if it isn’t in this format. "Audacity” is a good, open-source (free) editor that will suit this purpose and much more.

Figure 1076  Blender Soundblock Panel

Blender Video Sequence Editor Window showing loaded Audio Strip

Go to the Scene Window (F10) and press the "Sound block buttons” button --(in the three buttons near the frame counter. It looks like an audio wave)--. Press the "Sync " and "Scrub " buttons. The "Sync " button makes the playback in the 3D window closely match the audio when you press Alt-A (it does this by dropping image frames if necessary and it generally provides only a rough guide of how things match-up) . The "Scrub " button is important for lip-sync as it means that whenever you change frames, Blender plays the audio at that point (Currently in some Blender builds you have to press Alt-A at least once to get this feature to start working).

Figure 1077  Blender Soundblock Panel

Blender Soundblock Panel
Select your character and your Shape Keys should be listed in the **Action Window**, in the order in which you made them (*I don’t think they can be shuffled*). You will see a small triangle button labelled "**Sliders**" at the top of the list - press it to show the sliders for each shape. If you drag the mouse back and forth in this window, you should hear the audio play as you cross frames. This is how you will identify the main viseme/phoneme key frames.

**Figure 1078**  Shape Key Sliders

Shape Key Sliders

### 173.3. Getting down and dirty

Before you begin your lip-sync, you obviously need to know what your character says. It might be worthwhile writing it down and even speaking it over and over, in time with the audio, to get a feeling for the sounds you’ll be dealing with. Some sounds are what I’ll call "**key sounds**" and others are almost dead, non-descript “in-between” sounds that fill in the gaps between the key sounds. Obvious key sounds are those where the lips close and those where they are tightly pursed or wide and round, other key sounds can differ with every piece of audio. Don’t make assumptions about the shapes you’ll use based on the words you know are there. What you are animating are the actual sounds - not letters or words (*Keith Lango has much to say about this on his website and I recommend reading it*)
173.3.1. The Timeline Window

Go to the Timeline Window. This window seems to have been largely overlooked in previous documentation yet it provides the basics for timed animation plus a few other goodies to make your animation life a little easier. Here you can turn auto-keying on and off at will (you’d normally go to the hidden User Preferences window which is a pain and easy to forget), navigate frames, play and pause the animation in the 3D window, turn Audio Sync on and off, set the start and end frames for the animation and set frame markers. This last feature is the key to our project.

In recent Blender releases, the audio “Scrub” feature works in most windows. As you scrub through the audio, listen for where the key sounds occur. As you hit a key sound, scrub back and forth to find where that sound commences. In the Timeline Window, press ”M” to set a frame marker at this frame. The marker can be labelled by pressing CTRL-M in the Timeline Window while the marker is selected (yellow). Enter a sensible name for the marker that indicates what the marker is for (like the phoneme sound and/or which word it starts or ends). Markers are selectable and moveable and can be deleted just like other Blender items.

NOTE: Depending on the speed of your system, you may find you get more pleasing audio scrubbing and better 3D window playback if you turn off subsurf for your model and hide any unimportant parts of the scene on different layers. The fewer things Blender has to calculate as you scrub or play-back, the faster it can draw the frames to maintain sync with the audio.

Figure 1079

Turn off these buttons to disable subsurf setting in 3D window

Figure 1080  Timeline Window
Blender Timeline Window

Scrub through the whole audio - or sections of it in a long piece - marking and labelling all the key sounds.

173.3.2. Setting the keys

Now you have everything you need for your first lip-sync pass. Start at the first frame and click once on all your Shape Key sliders in the Action Window to set them all to zero. Move through the frames from start to finish setting shape keys where you marked the key sounds in the Timeline Window. If your character has a jaw bone and tongue bone(s), you will need to set these where required as you go.

Trouble in paradise? A quick lesson in handling Shape Keys

If you haven’t set shape keys before you might notice one interesting dilemma - they have great memories! Once you set a slider to any value, it stays at that value until you set another value somewhere. The shapes change in a linear fashion between keys. At first, this appears to be a problem if you want to key "MOO" because after you set the "M" key slider to 1 (one), it will stay there, making it impossible to get your character to say "OO" while his lips are trying to stay shut. So, you have to set the "M" slider on the "M" sound, then as the audio goes into the "OO" sound, you must set the "M" slider back to zero and then set the "OO" slider to its full value.

This introduces another problem. After you set the "OO" key, your "M" sound is messed up because the mouth is now also being affected by the "OO" shape that follows it. So, you must make sure the "OO" sound is set to zero when you want the lips closed in the "M" position.

In general, you’ll find yourself setting each shape 3 times

• once to determine where you want the mouth to begin moving to this shape (slider set to zero)
• once to set the slider at the desired level for this phoneme
• once more to end this shape and move into the next one (slider set to zero)

The same principle applies to the jaw bone and tongue - 3 keys to each move.

Figure 1081  Varying shape key settings

Setting multiple shape keys
Lip-Sync with Shape Keys

As you get more comfortable with this procedure, you’ll find you can leave some shapes set longer or adjust them to different levels as they can provide some interesting mouth shapes when combined with other shapes.

### 173.3.3. Setting the in-between sounds

Once the keysounds are properly set, you should be able to scrub slowly through the Action Window and watch your character speak in time with the audio. It won’t be perfect but it’s a start. To fix his speech impediment, you now have to fill in the sounds between the key sounds. Mostly these will be dull vowel sounds (“err, uh, ah”) and silence. These shapes are set in exactly the same way but here you’ll have to really watch the 3D view as you set the sliders. Try combinations of sliders like ”EE” and ”OH” to get the perfect shape for each individual sound. You have to be guided by your character. Does he look like he’s saying the sound you’re hearing? *(Remember that exactly what’s being said is not important - it’s only the sound that matters).* Test each sound as you set it by scrubbing a few frames over and over and watching your character mouth the sounds.

All that’s left, hopefully, is some polishing and tweaking. If it’s not perfect then don’t despair. Like other areas of animation, it can take a while to get a feeling for lip-sync and as the tools and workflow become more familiar you can pay more attention to the important work.

### 173.4. Putting it all together

When you’re reasonably happy, it’s time to combine the audio and video and watch the result. Since Blender can’t do muxing (combined audio/video) you’ll need to composite it with the editing software of your choice (OSX users can use recent versions of iMovie, virtualDub is often recommended for Windows users and Avidemux2 is often recommended for Linux users.).

What Blender can do is provide a **fully synced** version of the audio file the same length as the animation - even adding silence at the start and end if need be to maintain the synchronisation. To make this synced audio file, go back to the ”Sound block buttons” panel and press ”MIXDOWN “. This saves a .wav file using the filename and location you entered in your output box *(you did didn’t you?)* plus a frame count *(something like ‘speech.avi0001_0400.wav’)*. Then save your animation by pressing the ”ANIM ” button.

Combine the audio and video in your video editor and export a muxed file. You may find when you play it back that the mouth seems to be just slightly out of sync. This is for two reasons: sound travels much slower than light, so we see the lips move before the sound reaches our ears, and the lag is more the further away the person is (about 3 milliseconds of delay for every metre), and the more exaggerated their expressions as they shout. The second reason is the way the brain processes faces and expressions and mixes it with sounds heard to comprehend speech. This comprehension phenomenon is barely understood and is a common challenge in animation, and some physiologists think our brains read lips and facial expression as a way of setting up to understand the context of sounds received and comprehending the meaning behind language. To solve it, you can go back into Blender,
Using Blender to render Audio AND Video TOGETHER.

select the audio in the Sequencer Window and move it one or two frames later, then press "MIXDOWN" again to create a new .wav file with a split second of silence at the start. Remix this with your video and watch the results.

From here on its all a matter of testing and tweaking until you’re happy!

173.5. Using Blender to render Audio AND Video TOGETHER.

Ever since Blender 2.3, it has been possible to render video with the audio attached. Once you have your animation done, and are ready to render: In the buttons window, click scene (F10). In the format tab, choose FFMpeg. There will now be three tabs. Click on Audio. Click Multiplex, and choose your audio codec. Click Video. Choose your video codec (including AVI). Now, in another section of the window, there will be an Anim tab. Click Do Sequence. And click ANIM. When you watch the video, you’ll notice that it has sound.

Note: The mac version of blender doesn’t have the FFMpeg codec in blender by default.

173.6. Audio Files

You can find some interesting audio files selected for animators at http://www.animationmeat.com/practice/practice.html. These files come complete with a pre-marked phoneme sheet.

173.7. P.S.

One final note. Watch how the pros do this. When actors are doing voice overs for major releases their actions are recorded and even integrated into the final animation. If you have a digital camera, you may also try recording your own mouth performing your dialogue and approximating its positions to your animation. This can give you a great visual reference, possibly frames for frames if your frame rates match, and save you time.
174. Constraints

174.1. The Constraint

A constraint is what makes everything easier, magic, automatic, customised (add more words here) in a rig. It tells a bone or an object to do something special based on the position of another object, and the position of the constrained object itself. There are many constraint types for you to play with. Most will work everywhere but, the IK solver will only be available in the Armature Editmode or Posemode.

There are no strict rules to follow when using constraints. As long as they save you time and make everything work by itself. A constraint should never be "time-consuming" or difficult to use. Think about the animator who is going to work with this rig (it could be you!). So, do everything in a smart way.

It’s possible to copy constraints from one object/bone to a bunch of objects/bones. A useful thing to know when doing a repetitive task like rigging all the fingers of a hand. Just select all bones/objects that you want to give a copy of the constraint, and then select the bone/object containing the constraints. Press \texttt{SHIFT + CTRL-C} in 3DView, and select Object Constraints from the popup menu. The idea behind this is to copy the constraints of the active object to the selection.

When working on an armature in Posemode, the bones will change color if they contain a constraint. Green for almost all, except for the IK constraint, which turns the bone Yellow.

174.2. The Constraint Panel

You can add a Constraint to an object or a bone by going in Object button window (F7) for objects and bones. Look for a Constraint panel like this (note, it’s usually empty):
Constraints
d
The panel also appears in Editbutton(\texttt{F9}) when you are in Armature Editmode or Pose-mode. So what you get:

- A button to add a new Constraint. The choice you have is listed down this page.
- When you add a new Constraint, A block gets added in the stack. The UI is almost the same as the Modifier Stack. Each block represents an entry. You can delete it with "X", move it up or down in the stack, close or open it.
- Constraints are evaluated from first to last. So if you have two Constraints working on the same channel, let say Location, The last one will most probably win the chance to move the object. But...
- Most of the constraints have an influence slider to determine how much it will influence the stack. If the last constraint has an influence of 0.5 it will mix the result with the one before.
- You can animate the influence of the Constraint by moving the time, changing the Influence slider and adding a key with the \textbf{Key} button.
- The \textbf{Show} button will display the influence IPO curve in an IPO window for editing. (The IPO window must be opened before pressing the 'show' button).
• You can change the name of the Constraint by clicking on the name when the constraint is open.
• By Clicking on the white jacket of the Constraint you select which one is active for edition, same as "show" button.
• If most of the Constraint you can enter the name of the Object you want to work with as a target or reference. For a bone, you need to enter in which Armature object it is, then an other field for the bone name will appear. When filling those fields, remember you can use autocompletion using TAB.

174.3. The Constraint Index

• Copy Location\(^1\)
• Copy Rotation\(^2\)
• Track-To\(^3\)
• Floor\(^4\)
• Locked Track\(^5\)
• Follow Path\(^6\)
• Stretch-To\(^7\)
• IK Solver\(^8\)
• Action\(^9\)

---

1 Chapter 175 on page 1327
2 Chapter 176 on page 1331
3 Chapter 177 on page 1333
4 Chapter 178 on page 1337
5 Chapter 179 on page 1339
6 Chapter 180 on page 1341
7 Chapter 181 on page 1343
8 Chapter 182 on page 1345
175. Copy Location

175.1. Copy Location
The Copy Location constraint does as the name states: it will copy the location of the target to the source (constrained object). Less Influence will drag the constrained object less and less to the target.

If it’s an armature, a new field will appear to let you tell which bone will be the target. Don’t forget TABKEY completion while writing the name of your object/bone!

You can tell Blender to work only on the selected axis. Many uses are possible :)

**175.2. The Constraint Panel**

![Copy Location Constraint Panel](image)

- The Target field will let you select which Object the constraint holder will follow.

**175.3. Where To Use It**

Most of the time this little constraint is useful to stick objects to one another. By playing with the Influence you can tell when it will work, when it will remain motionless.

A good use of it is to ask a character to pick up something. By having a bone or empty for each side of the relationship (hand <-> glass), as the hand approaches the glass, you can align the two empties and fire the constraint up (1.00) to stick them together. You add another child-bone in the middle of the hand to tell where the glass will be. Thus moving the hand will move the glass. On the side of the glass just add an empty and make it parent of the glass. Add a copy location to the empty pointing to the bone in the hand we just did. There you go. Of course when the hand rotates the glass will not. For that you will need to add a Copy Rotation Constraint.

Before Blender 2.40, the above method was a good way of faking parent relationship without rotation. But now we have the hinge option which does the same.
Create this kind of tracking device using the X Y Z toggle button

Figure 1085
176. Copy Rotation

176.1. Copy Rotation

Figure 1086
This constraint copies the rotation of the target. As simple as that. It can be an object or a bone. As you can see in the example, only the rotation gets copied.

176.2. The Constraint Panel

![Copy Rotation Panel](image)

Figure 1087

- You have 3 buttons to select which axis get copied over.

176.3. Where To Use It

Can be used with Copy Location to fake parent relationship. As you can key the influence you can make a character pick something up and hold it in his hands. Check the .blend for the hand-glass scene.

 (?)link to the Blend(?)

You can also use this to align a plane with a 2D effect on it to the camera at all times. This works better than pointing it at the camera in some cases, such as a ring of atmospheric halo around a planet, where you don’t want it disappear behind the planet.
177. Track-To

177.1. Track-To

Figure 1088
The Track-To constraint lets you influence the Rotation of the constrained object by making it track a target with one of the constrained object’s axis.

177.2. The Constraint Panel

- You can enter the name of the target you want to track.
- You can select which axis is going to track the target.
- You can select which axis is going to stay up.

Figure 1089
A good example of use is the make a camera track an object. The setting to use on a camera is track: -Z and up: Y. You can turn Axis drawing in object button window to help you choose the good axis.

Another example with armature would be the eyes of a character:
Figure 1091

(?)link to the Blend(?)
178. Floor

Using the floor constraint will keep a bone from passing through an object from a given direction. It is useful when making floors of course but also when making walls and other items which are obstacles for the armature.

There is also an offset value which is very useful when say for example you have a foot where the mesh stretches down below the actual tip of the armature you can then use the offset to make the bone stop before it actually reaches the obstacle object.
179. Locked Track

179.1. Locked Track
180. Follow Path

180.1. Follow path

Figure 1092

180.2. The Constraint Panel

Figure 1093

180.3. Where To Use It

Figure 1094

(?)link to the Blend(?)
181. Stretch-To

181.1. Stretch-To

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
</table>

Stretch To causes the affected object to scale the Y axis towards a target object. It also has volumetric features, so the affected object can squash down as the target moves closer, or thin out as the target moves farther away. Or you can choose not to make use of this volumetric squash-'n'-stretch feature, by pressing the NONE button. This constraint assumes that the Y axis will be the axis that does the stretching, and doesn’t give you the option of using a different one because it would require too many buttons to do so.

This constraint affects object orientation in the same way that Track To does, except this constraint bases the orientation of its poles on the original orientation of the bone! See the page on Tracking for more info. Locked Track also works with this constraint. Options

R

| Pressing the R button calculates the rest length as the distance from the centers of the constrained object and its target |

Rest Length

| Rest Length determines the size of the object in the rest position |

Volume Variation

| Volume Variation controls the magnitude of the effect |

Vol

| The Vol: buttons control along what axes the volume is preserved (if at all) |

Plane

| The Plane buttons define which local orientation should be maintained while tracking the target |
Figure 1095
182. IK Solver

182.1. The IK solver
IK Solver

The IK solver constraint is a wonderful tool for all animators. IK stands for "Inverse Kinematic" and is the opposite of FK (Forward Kinematic).

- **FK**: You have a dependency to the root of the chain. In Blender, a FK chain is a chain of bones connected together. You have to animate the bones rotation one by one to get it animated. It takes longer, but gives you entire control over the rig.
- **IK**: Both ends are roots. All bones in the chain are trying to rotate to keep both ends on targets. Now this Constraint got most of the attention during Animation refactoring, hopefully we have a lot of toys to play with now.

The IK solver has a special shortcut in **Pose mode** to be added easily to a bone. If you select a bone and press **CTRL-IKEY** , You get a little menu asking for more info on the new constraint, the target: to a new empty object or without target. It’s now possible to work without target. Though you have less freedom (no rot feature, difficult parent relationship).

You can also select the target and then the IK constraint holder and press **CTRL-IKEY** . With this way of selecting ensure that your target is selected, but the bone you want to apply the constraint to is active (the last one selected). The menu will then let you add a constraint to the current bone with a target. If the target would itself be part of the IK chain, you get an error message - so make sure the target bone is not connected to the bone you want to add the constraint to.

It’s also possible to remove all IK constraints from selected objects or bones with **ALT-IKEY** .

**Q**: 'CTRL-IKEY' doesn’t seem to do anything

**A**: Either the 3D Window is out of focus (R-click in empty space to solve) or you’re not in Pose Mode ('CTRL-TAB', selected bone will be magenta in color)

**A**: In the 2.48 version of Blender, the shortcut is **SHIFT-I**
182.2. The Constraint Panel

- You can rename the constraint.
- You can select which Object or bone will be the target. Don’t forget Tab completion.
- The Rot button let you tell Blender to use the rotation of the target to influence the rest of the chain:

![The Constraint Panel](image)
• The Tip button lets you tell Blender which part of the bone is the target, the Tip or the Root. It’s interesting to use tip, because this way the Bone holding the IK constraint can be used to deform geometry.
- Len lets you tell Blender the length of the chain the IK solver will try to rotate. If set to 0, the entire chain will enter in the constraint. If for example the len is 4, only the 4 last bones of the chain will try to touch the target.

![Figure 1100](image)

- Also if you set len to 0 and your chain’s root is a child of another bone, The IK solver will reach and rotate all the bones until it gets to the end of the parent relationship. If all the bones are linked up to a master root, then all other sub-branches will be affected. If there is another IK target in other sub-branches of the rig, Blender will try to mix them. This concept of multiple IK targets in a rig is called Tree IK and can be used to get completely automated animations. For example like a doll: if you pull one hand, all the body will follow. In the 3D-view you’ll see a yellow line from the IK solver to the root of the chain it covers. This line appears when you select the bone containing the IK solver.
• PosW and RotW let you tell Blender if this IK solver will influence the final result more of less in the case of a Tree IK setup. With these options it’s possible to use an IK solver just for location and an other one just for rotation.

• Tolerance and iterations are performance and precision options. IK solving is done in more than one pass, the more passes you calculate, the more accurate results you get. The tolerance is the distance from the IK solver to the target you can accept. If Blender manages to place the target near enough, it will stop doing iterations. The Iterations value is a hard limit you set to limit the time blender can reach on each IK solver per frame. Try to set it to a very low value to know why Blender needs more than one pass ;).

• You can set the general influence this constraint will have over bones, and it’s animatable.
182.3. Where To Use It

In any chain of bones you don’t want to animate by hand but you want both ends to be at precise location. The best example is a leg: The leg is connected to the body and to the foot. You don’t need to animate the 2 bones in the legs, just place the body and the foot, the leg will follow automagically.
In DOF it is now possible to set it for bones in an IK chain. This way you can set what will block where. This is very useful when doing a mechanical rig as you can limit the move or better, lock completely an axis.
There you can set a limit on each axis, or completely Lock it.

- No limit gives it complete freedom (which is the same as [min:0 max:360] or [min:0 max:0]).

- The stiffness lets you tell Blender if an axis is more difficult to rotate than the rest. If all bones have a stiffness of 1 on X and you try to curve that chain in a way that all bones need to turn on X to follow the target, the Solving will find really weird poses to find a way to touch the target without rotating on X.
183. Timeline Window

183.1. Timeline Window
184. IPO Window

184.1. IPO Window
185. Data Type

185.1. IPO Data Type
186. NLA Window
Since there has been nothing written on this page for a while, I asked for some basic information on another forum. I'll just quote what I learned from that forum, and this can be massaged into a real page of documentation over time. I won't attribute the individual various quotes, but thank you all for helping out. Remember, ANYONE can edit a Wiki, so create an account and make this thing better.
188. The NLA Window

188.1. Forum Notes

It’s quite easy and maybe that’s why there’s no specific tutorial. Let’s say you want to make two actions, AC:Hit and AC:Kick. Start with posing Hit and an Action will automatically be created in the Action Editor consisting of all the Bones that use Action IPO’s. That’s done so return to Frame 1 which will be your default Stance of AC:Hit.

Now, in the Action Editor, click the X (delete) next to AC:Hit and the datablock menu will disappear. (If you Add New instead of deleting then it will copy selected bones to the new action and you don’t always want that). If you want a new default pose for AC:Kick, then Pose it or the same stance will be used as was the default in AC:Hit. Pose and Keyframe your Kick action and name it.

Over in the NLA Editor you can now use Shift-A to add NLA-Strips of your Actions, Grab and Scale them and use the Transform Properties tab to input how they Blend.

If you select an Action with the dropdown menu, at first its name will appear in the NLA window along with its keys. To make this Action into an NLA strip, point at the Action’s name in the NLA and press CKEY.

Close any open Actions by clicking the scary X in the Action Editor. If you don’t do this, only this action will play. Now in the NLA editor, play the animation.

If you see any keys (diamonds) in the NLA window, instead of strips (rectangles), you’re still editing an action. It’s so much easier if you have both the Action and NLA windows open so you can see whether an Action is open or not. (Edited by CD38 23 Feb 2006)

188.2. Walkthrough

With no Actions selected, both the Action Editor and the NLA Editor appear empty. Here, the NLA Editor window does list one Object called -Empty because that object is not an armature but it has some IPO curves attached.
Select an Action you’ve already made. Here, an Armature named Yui has bones involved in a one-frame action called -At Ease.

Convert the listed Action to an NLA Strip in the NLA Editor by pressing the CKEY with the mouse hovering over the Action to be converted. No change in the Action Editor; it is still available as an Action.
Once converted, note the changes in the NLA Editor. The Action icon appears next to the Armature’s name:

This is actually a button though it does not look like it, and you can toggle it between the Action and NLA Strips icon by clicking on it:
More soon.
189. Introduction to NLA Editor

189.1. NLA (Non-Linear Animation)

WARNING - This page assumes the reader to understand the IPO window and the Action Editor window, as well as rigging a character with an armature object. This tutorial will make little sense without this previous knowledge.

Imagine this—yourself, sitting at your computer late at night, beating away at a huge blender animation. You didn't think it would take as long as it did, but you lost your composure staring into the jungle of colorful IPO lines, little white and yellow Action diamonds, and that annoying green current frame line. You know that the NLA window would help you make sense of it all, but you are afraid of opening that Pandora's Box because of the problems that will follow it. Never fear, for this tutorial will clean up all those problems and revolutionize the way you blend for the rest of your life.

189.2. Setting up the Scene

It will be easier for you if you start with a small demo file than if you go straight for the big prize. Give a character or other armature-rigged object a few SEPARATE actions (remember to name them something distinct, like "Walk" or "Run" as you always should with everything). For your own sanity, you will want to have a path or an IPO that correlates with the actions in question. All of the blender screenshots I will be using come from a file with a very basic stick person, rigged with an armature skeleton. He has two actions; a normal walk cycle, and then another, hunched over one, as if to pass beneath a low ceiling. If you use this idea in your own test file (and I thoroughly recommend it) do yourself a favor and give them both the same stride length! Give this guy an IPO or a path to follow that keeps his feet from slipping, and make sure that it has a linear interpolation mode. The rest of the scene consists of a floor-plane and an arch too small for him to walk under (hence the crouching walk). Place this arch exactly one walk cycle away for now, we will move it around later.

Figure 1112

Complete the scene before going on to the next step.
189.3. Adding Action Strips

Now, he moves forwards as you scroll through the frames, but how do we get him to walk forward, duck, and walk under the arch, too? First of all, you need to select the armature object and create a link to the normal walk. By pressing the up or right arrows, or pressing "alt+a", you should be able to see him walk up to the arch, stop walking, but keep sliding through, with his head sticking out the top. As ridiculous as this seems, right now, however, you are on the right track. Split your window now and open the NLA window with

![Figure 1113](image)

At first glance, this window looks almost identical to the action window we all know and love. This is not totally off of the mark. The NLA window is, in essence, an abbreviated version of the action and IPO windows.
You see a space with the name of your armature (named "Armature" in my demo) and in that row you see a few key diamonds. These show the ipo you have put on the person. I made it so the IPO extended on forever, using the first ten frames as a guide. In a subset beneath the armature object, you see the name of an action. The bullet next to it means that the armature is currently linked to that object. In that row, you see key diamonds, and those correlate with the keys you put into the action in question. If you switch actions in the action window, you see that the NLA window also changes. But how do you get it to keep the first and play the second later?

Go to the first frame you want him to walk in (most likely number one) and place your cursor in the NLA window. Press "shift+a" to see a dropdown menu. Pick the name of the first walk cycle. You should see a new subset space appear, with the name of the first walk in it. This space should be occupied by an action strip. Two colors of action strips are yellow and pink, yellow meaning selected and pink meaning deselected, just like IPO vertices. This strip takes up the amount of frames the walk did. The NLA window has now saved your first action. Now to toggle to the next action, move the frame line to the end of the first strip, then press "shift+a" again, this time clicking the other action on the dropdown menu.
189.4. Getting the Strips to Play

Now, as cool as this seems so far, if you press "alt+a", you will be disappointed and confused. The animation will only play one of the actions. This is a simple problem to fix. If you look carefully, you will see that the armature is still linked to the action it played. This data is overriding any other data from the NLA window. Press the "X" in the action window right next to the name of the action. Press "alt+a" again. It works!

This is, however, a jerky and instantaneous switch from one action to the other. Making it less weird is easy. Press the "N" key with your cursor in the NLA window. You will see a small box with a bunch of functions in it (this will be explained in detail on later pages).
This little box is the lifeblood of the NLA in blender. It contains all the tools you will need to be able to run this feature smoothly. I will illustrate a few of them right now, but most others will be shown in the section on this window.

Make sure you have highlighted the *second* action strip, and look at the space where it says "Blendin". The number there is the number of frames blender will use to smooth the transitions *in to* the highlighted action. Depending on how fast your character is walking, you may need to change the number a bit, but I set my "blendin" for seven. Whatever number you used, however, move the second strip *back* that same amount of frames. The wedge on the end of the action strip should end as the other strip ends.
189.5. Conclusion

You now have the necessary skills to complete much more involved and complex animations. You can, however, increase this even more by continuing to read the other NLA tutorials in this wikibook.

Good Luck!
190. The Stride feature

At the moment, one of the best documentation for Blender Stride features can be found here: Blender Stride Tutorial\(^1\), which takes on where the Official Blender Stride Page\(^2\) takes off. Good luck! A simpler and shorter, but still very good tutorial can be found here: Blender wiki: NLA Editor and Stride Path\(^3\).

\(^1\) http://www.telusplanet.net/public/kugyelka/blender/tutorials/stride/stride.html
\(^2\) http://www.blender3d.org/cms/Advanced_Stride_support.720.0.html
\(^3\) http://wiki.blender.org/index.php/NLA_Editor_and_Stride_Path#Stride_Support
191. Relative Vertex Keys

- Letters in brackets i.e.: (z) mean there is addition information at the bottom of the page.

191.1. Introduction:

This tutorial is meant to stop all the RVK (Relative Vertex Keys) questions.

191.2. Window Layout:

Set the left half of the screen as 3D View. The other half is divided in two. The top is Action and the bottom is IPO (set to vertex display).

191.3. Setting your Neutral Pose

Make sure you are on the first frame (a). With the cursor over the 3D View, select the mesh you want to animate. (mesh in object mode) and press the I key. Select Mesh from the pop up menu then Relative Keys from the next pop up menu. A line will appear in the IPO view. This line is your neutral pose.

191.4. Setting up your additional Pose Lines

Now, figure out how many key frames you will need. If you want to move both eyebrows up and down then you will need 4 additional IPO lines.

Left Brow Up Left Brow Down Right Brow Up Right Brow Down

Press the up arrow (cursor key) to move to forward 10 frames. Press the I key while over the 3D View and select Mesh. Repeat until you see a total of 5 lines in the IPO window.

191.5. Set your Poses

Right click on the Neutral pose line in the IPO window. This sets the mesh to the neutral pose. Now Right click on the next line up in the IPO window. Enter edit mode in the 3D View and move the vertices as desired (in this case you will be moving verts to get the left Brow up pose). Press Tab to exit edit mode. Now right click your Neutral pose line in
the IPO window. You will see your object in its neutral state. Right click the next line up and you should see the changes you just made to your object. Set up all your mesh poses following the above instructions.

191.6. Name your Poses

Right click on the Key names in the Action window. Change the name and click OK.

191.7. Time to Animate (b)

Click on the arrow next to the Sliders text. This will give you access to the pose sliders. Move to frame 20 to start your action. Move the pose slider but release the mouse when set to 0. Now move 10 frames forward and move the same slider to 1.00 (maximum). Use this method to set up all your actions(c). Remember to add a 0 value frame to end the pose.(d).

191.8. Adjust your Slow in & Out

In the IPO View select from the menu to find the IPO curves. You can get back to the Pose lines by selecting KeyIPO from the same menu. Right click the spline you want to edit and press TAB to enter edit mode. Move the handles to adjust slow in/out.(e)

(a) In this case moving to a frame has nothing to do with animation. It is done so that your pose lines are separate from each other. (b) Select your key frame marker and use the usual commands to move <g> and duplicate <d> them. (c) Be subtle by not pushing the slider all the way to 1.00. (d) Try overlapping your poses. (e) When setting slider values they can sometimes go into the negative value. This will give you weird results. Although sometimes they can make your animation more interesting. To fix this edit the IPO, select the point where the line dips below zero and press the V key. Do the same at the other end of the curve if needed.

Warning! Blender has a limit to the number of verts you can use.

----

Click here to read the advanced animation tutorial guided tour.

1 http://en.wikibooks.org/wiki/Advanced_Tutorials/Advanced_Animation
192. Working Example: Bob

In this tutorial, we are going to be constructing a fully functional, humanoid character, with a complete rig\(^1\), and we are going to animate him performing a walk cycle.

192.1. Getting Started

Figure 1118

bob.blend had an incorrect link and has been taken off until further notice or someone else supplies a model.

\(^1\) http://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro%20Terminology%23R
• Build the Rig$^2$
• Deform the Mesh$^3$
• Create a Walk Cycle$^4$

---

2 Chapter 193 on page 1381
3 Chapter 194 on page 1385
4 Chapter 195 on page 1387
193. Building the Rig

If you think you already know what a rig\(^1\) is, then you probably need to read the definition of "rig"\(^2\) and "rigging"\(^3\) before we get started. It’s important to note that an armature is not a rig, but a rig can be an armature. Assigning a mesh to be deformed by an armature is not rigging.

A rig\(^4\) should always be designed for the types of animations your character is going to be performing. Only make your rig as complex as it needs to be to allow for the types of actions you need.

To make everything with the armature easy to deal with, we’re going to make our character in the crucifix pose. If he’s not, you will have headaches trying to deal with bone roll angles. Once Blender can easily allow the user to roll the bone to align with a roll target, then I’ll edit this tutorial for that. But in the meantime, we will use vertical legs and horizontal arms. We will build the legs from the side view and arms from the top view.

---

Center the cursor (shift+c) and add an armature. In Object Mode, press alt+r to clear the rotation. You have to have a bone for the hip, and it needs to stick out of his front or his back, so take your pick, because they both look bad. Don’t point the bone upward at some odd angle, we need to be able to roll the hips easily, and to that end, we will place the bone horizontally.

In front view, place the cursor and add a bone. **IMAGE**

In side view, move points and extrude them until your chain looks like this. Note the slight bend in the knee. This is very important! **IMAGE**
Snap your cursor to the root of this chain (shift+s) and add a bone. Now select the points at the hip joint and the ankle joint, and snap the cursor to the selection. **IMAGE**

Select the tip of the newest bone and snap it to the cursor. **IMAGE**

Now give these bones some names. It’s a good idea to use the same names I do to avoid confusion, since I will refer to the bones by name. Select upperleg.l and then shift+select leg.l, and press ctrl+p to make upperleg.l the child of leg.l. Do this again, but make leg.l the child of hip. **IMAGE**

In front view, center your cursor and select pivot point.²

² [http://en.wikibooks.org/wiki/Blender_3D%3A_HotKeys%2FKey%2FPeriodKey](http://en.wikibooks.org/wiki/Blender_3D%3A_HotKeys%2FKey%2FPeriodKey)
194. Deform the Mesh

This is where you do the animating.
195. Create a Walk Cycle

This is where you create the walk cycle.
196. Working example: Piston, Rod and Crank

This page relates to Blender v.2.42a

196.1. Piston, Rod and Flywheel

Figure 1120 Image 1: Surprisingly difficult: the animation of Piston [Kolben], Rod [Pleuelstange] and Flywheel [Schwungrad]

A setup like that shown in Image 1 is e.g. typical for a steam engine. It is surprisingly difficult to animate this setup, because one has to translate a rotating movement (of the Flywheel) to a horizontal movement (of the Piston). This alone wouldn’t be too difficult, but the Rod has to stay attached to the Piston. The shown setup uses three empties and two armatures, each with two bones.

The horizontal direction is the Y-direction, if this is different in your model you have to exchange Y with your horizontal direction.
196.1.1. Setup

- Use Ctrl-A -> Apply scale and rotation on all mechanical parts in object mode.
  This will spare you from bad surprises if you rotate the flywheel afterwards.

We need an object which follows the rotation of the flywheel. We use an Empty, which is
parented to a Vertex.

**Figure 1121 Image 2:** Make vertex parent of an Empty.

- Change to edit mode of the flywheel. Select a Vertex in the middle of the crank.
- Move the cursor to the Vertex (Shift-S -> Cursor -> Selection).
- Change to object mode and insert an Empty (ERotation).
• Change back to edit mode of the flywheel. The vertex is probably already selected, now select with Ctrl-RMB the Empty and press Ctrl-P -> Make vertex parent (Image 2).

Figure 1122 Image 3: The positions of the three Emptys.

We need two more Emptys:
• Place the second Empty (EGelenk) in the center of the joint between Rod and Piston.
• Place the third Empty (ESteuerung) near to the joint.
• Now select at first EGelenk, than Shift-RMB ESteuerung and parent EGelenk to ESteuerung with Ctrl-P.

We’re going to insert two armatures, each with two bones. The first armature, helps translate the rotation to a horizontal movement. The second armature drives the Piston and the Rod. The cursor should be positioned at the Empty ERotation (like in Image 3), else set it there.

• Add an armature (AHelfer). The root of the first bone (BHelfer1) has the same position as ERotation, the tip has to be positioned to the Empty EGelenk (select Empty first, Cursor->Selection, than select bonetip, Selection->Cursor).
• Extrude another small bone (BHelfer2) in horizontal direction. BHelfer2 is automatically Child of BHelfer1. The second armature that is driving the movement of piston and rod will be inserted in the opposite direction, i.e. from right to left in our example.
• Position the cursor on the piston.
• Add an armature (AGestaenge).
• Move the tip of the first bone (BKolben) to EGelenk.
• Extrude the first bone and place the tip of the second bone (Bpleuelstange) to ERotation.

Connecting the two bones will ensure that the rod cannot disconnect from the piston.

**Figure 1123 Image 4:** The alignment of the two armatures.

Now we’re going to add the "logic".
Figure 1124  Image 5: The constraint settings for BHelfer1.

- Add a Copy Location constraint to BHelfer1 which points to ERotation. To do this change to the pose mode of the armature AHelfer and select BHelfer1. In the Constraints panel, click Add Constraint -> Copy Location and type ERotation into the Ob: field.
- BHelfer1 needs a second constraint: Track To to EGelenk (Image 5).

Now the root of the bone BHelfer1 follows the rotation of the Flywheel. It’s tip follows the joint, but with slight deviations upwards and downwards. The position of BHelfer2 governs the horizontal position of the Piston. We just have to “extract” the horizontal position, for that we’re going to use a CopyLocation constraint, but only in Y-direction. There is no offset for a copy location constraint - else we could have done with one empty less.
Figure 1125  Image 6: Constraints of ESteuerung.

- ESteuerung gets a CopyLocation constraint in Y-direction to AHelfer -> BHelfer2. You have to inactivate X and Z (Image 6).
- Make ESteuerung the parent of AGestaenge.

The armature AGestaenge gets its horizontal movement from BHelfer2 via ESteuerung.

Nearly finished:
- Give BPleuelstange a Track To constraint to ERotation.
- Parent the piston and the rod (the mesh objects) to their bones.
196.1.2. Overview about the relations between armature bones and objects

- Schwungrad is vertex parent of ERotation.
- BHelfer1 has a Copy Location X/Y/Z constraint to ERotation.
- BHelfer1 has a Track To Constraint to EGelenk.
- ESteuerung has a Copy Location Y constraint to BHelfer2.
- ESteuerung is parent of AGestaenge.
- ESteuerung is parent of EGelenk.
- BPleuelstange has a Track To constraint to ERotation.

Figure 1126 Image 7: Parent-Child Relations are drawn with slim arrows, Copy Location Constraints are drawn with thick black arrows, Track To Constraints are drawn with thick blue arrows.
• BKolben is parent of Kolben.
• BPleuelstange is parent of Pleuelstange.

The Parent-Child relations between the bones are inserted automatically through extruding, you have to insert the other relations yourself.

196.1.3. Finishing Touches

• Animate the rotation of the flywheel.

The driving object is the flywheel, all the other movements are synchronized with its rotation.

If you’ve done everything right, your animation should look like in Image 8.

Figure 1127  Image 8: Our working Piston, Rod and Flywheel animation.
196.2. Links

The German original of this tutorial (same author)\textsuperscript{1}

Another method using constraint system\textsuperscript{2}

\textsuperscript{1} http://en.wikibooks.org/wiki/%3Ade%3ABlender%203D%2FTutorials%2FArmatures%2FKolben%20und%20Zylinder
\textsuperscript{2} http://blenderartists.org/forum/showthread.php?t=140734
197. Working example: Cutting Through Steel

This tutorial has been created with Blender v2.48a

Figure 1: Cutting out a logo, the result of this tutorial

In order to simulate a laser beam which is cutting through a steel plate, we have in Blender (at least) two possibilities:

1. an animated Mesh with many Shapekeys
2. an animated texture

The latter method is considerably easier to implement and the result is nevertheless convincing enough. We will proceed as follows:

• You need an animated alpha mask for the points at which the metal is changed. For this use a text object as a path. A cube follows the path and emits a particle system. The results are rendered as animation and the images stored.
• Then load these pictures and use them as an animated texture on a plane.
• With a second particle system the sparks are simulated.
• With a third particle system we simulate the annealing of the weld. Again, this sequence is used as an animated texture.
• Smoke is created with a fourth particle system.

The result is shown in Fig. 1.

This guide is based on the well-known tutorial Cutting Through Steel\(^1\), but remade with the current Blender particle system and with constraints. You need to have basic knowledge of Blender.

\(^1\) http://www.blendernation.com/tutorials/blender-3d-intermediate-tutorial-cutting-through-steel/
197.1. Creating the Alpha-Map

• Start Blender. Save your file. Delete the cube.

We should save the file right at the beginning, because we will save the animated textures in subdirectories to the current directory. Particle caches are also created as subdirectories.

• Set the End value to 150 in the Anim panel of the Render buttons. This allows you to specify the total length of the animation.

• In the Output panel use “//AlphaMap/” as output directory. When we render the animation the images are than saved in the subdirectory ”AlphaMap” to the current directory.

The animated alpha map consists of gray-scale images whose luminance information is used to calculate the mask. Bright pixels produce transparency, dark pixels remain opaque.

• Use PNG as output format. This avoids compression artifacts which occur with the JPEG format.

I’ve left the resolution at 800x600, but you need to set your desired resolution here.
• Create the shape you want to cut out as Curve object, or use a text object and convert this to a curve. I’ve done the latter, I’ve used a text-object (a “W”), and converted this to a Curve object (Object-> Convert Object Type ...-> Curve ).
• With the function Center in the Curve and Surface panel I’ve brought the object in the middle of the 3D-coordinate space.
• The filling of the object is not needed here, therefore activate the option 3D for the curve object, even though the object should remain two-dimensional.

Now we need again a cube. The cube will follow the curve. It’s particle system will create a glowing trail, that is later used as alpha map.

![Particle System](image)

**Figure 1130  Figure 2b:** particle system of the cube.

• Insert a cube.
• Scale the cube as small as the track of the laser beam (the welder) shall become.
• Select the cube, than also select the curve object with Shift-RMB .
• **Ctrl-P -> Path Constraint** creates a Follow Path constraint.
• Select only the cube and activate the option CurveFollow in the Constraints panel in the Object buttons.

If you press Alt-A now and let run the animation, the cube will follow the shape of the curve object, but not necessarily in the desired direction and not from the desired location. So some work needs to be done:

• Change to the Edit mode of the curve object.
- Curve->Toggle Cyclic opens the curve object, by adding (Subdivide) of one or more control points you achieve the desired movement. W->Switch Direction reverses the direction of the motion of the cube.

By adding a Time Ipocurve to the curve you could set the duration and speed of the animation, but I’ve left the preset duration of 100 Frames. The last 50 Frames the path will glow a bit and the smoke will vanish.

- Add a particle system to the cube, call this Alpha.
- Set the particle lifetime to 150 (or higher) (Fig. 2b). The particles will live the entire length of the animation.
- Bake the particle animation.

- The cube gets a material:
  - Halo
  - RGB 1/1/1, that is completely white
  - XAlpha
  - HaloSize: 0.03
  - Hardness: 40

I want to achieve with these settings, that we will get a grayscale image, that is completely white where the material shall become transparent. We don’t need partial transparency, since a relatively sharp cutting edge shall be created. Slight irregularities in the periphery are wanted.

![Figure 1131](image)

Figure 1131  Figure 2c: A frame of the AlphaMap.

To render the animation, the camera is centered directly over the object.

- View->Top
- Strg-Alt-Num0 sets the camera to the current view. Select the camera.
- With the Transform Properties panel in the 3D-window (Object->Transform Properties) set the coordinates of the camera exactly vertically above the center of the 3D window (X/Y=0).
- In the Editing buttons of the camera set the option Orthographic in the Camera panel. Scale the size of the animation with the Scale value.
- The the world color to black in the World buttons.
- Render the animation.
Blender now generates an image sequence from 1 to 150 in the subfolder *AlphaMap* (Fig. 2c).

**197.2. Welding sparks**

![Figure 3a: Adding a new Scene](image)

Now we’ll create a new scene, in which the different effects are joined.

- Rename your current scene to *AlphaMap*.
- Create a new scene as *FullCopy* (Img. 3a). Name this new scene *Cutter*.

The welding sparks are created using a particle system.

- Add a *UVSphere* with 16 segments and 16 rings.
- Delete the lower half of the sphere in Edit Mode and scale it to approximately the same size as the cube.
- Switch to Object Mode.
- Select the cube in addition to the sphere. Copy the *Follow-Path*-Constraint from the cube to the sphere.

Note that you copy attributes from the active to the selected objects. The active object is the one you’ve selected last.

**Noob Note:** Using Blender 2.65, the easiest way I found to do this was to use the ‘3D View: Copy Attributes Menu’ addon. (To enable the addon press Ctrl+Alt+U to bring up User Preferences, click the ‘Addons’ tab, type ‘copy’ into the search box, located at the top left of the tab, and put a check in the box to the right of the addon that’s found, ‘3D View: Copy Attributes Menu’.) First RMB click the sphere, then Shift+RMB click the cube, the one with the follow path constraint. With the 2 selected press Ctrl+C and choose ’copy object constraints’ from the popup menu. If the sphere gets offset in the process, just move it manually to the position of the cube or the first waypoint on the path.
• Create a particle system for the sphere.
  • Name: Sparks
  • Amount: 4200
  • Life: 5
  • Emit From: Random/Verts
  • Normal: 0.757
  • Random: 0.397
  • Rotation Random: 0.116
  • AccZ: -1.37

Except for the lifetime the values are relatively arbitrary, I have just experimented with the values until I was halfway satisfied with the results. The sparks have a slight acceleration in negative Z direction to sink down.

• Visualization:
  • Line (which corresponds as much as possible to the setting Vect in the particle system before 2.46)
  • Speed
  • Back: 0.04
  • Front: 0.0

You achieve a long spark with these settings.

• Bake the particles. Change to the Bake panel and click on the Bake button. The particle animation is now permanently saved.

The Bake end value is also the final value for the normal particle animation, even if you don’t bake. If you need more than 250 frames, you need to increase this value.

197.3. Using the alpha map on an object

The alpha map is now used as texture on a plane. Therefore we have to position the texture exactly like the previously rendered animation, so that the sparks run in sync with the blending out of the plane.

• Add a new plane to your scene (Add->Mesh->Plane).
• Scale the plane at about twice it’s size - as big as you need it for the final shot.
The main problem is now to fit the texture exactly to the plane. We will give the plane UV coordinates, than fit the plane to the ratio of the texture and finally adjust the position in the 3D window with UV coordinates.

![Draw type: Textured, Shaded, Solid, Wireframe, Bounding Box](image)

**Figure 1134  Figure 4a:** Setting the *Draw Type*

- Switch to *Draw Type Textured* (Fig. 4a).
- Split the 3D window, and open in one part the *UV/Image Editor*.
- Switch to edit mode of the plane.
- Unwrap the plane (*Mesh->UV Unwrap*).
- Load an image of the alpha map in the image editor (not the first one, so you can see the course of the map).

Normally the texture is not orientated the way I would like it to be.
• Click the padlock icon in the toolbar of the UV/Image Editor (Update other windows in real time).
• Rotate the UV vertices in the UV/Image Editor until the texture fits (e.g., while holding the Ctrl key)
• Switch to object mode.

Figure 1135  Figure 4b: Material settings for the plane

• Add a new material to the plane and name it Rust.
• Select the fifth texture slot and add a new texture. Name it AlphaMap with the parameters:
  • Map Input: UV
  • Map To:
    • Alpha
    • Spec
    • Nor
    • NoRGB
  • DVar: 0

With these (Fig. 4b) settings we achieve, that the white pixels in the texture set the Alpha and the Spec value to zero (DVar). Because the texture delivers RGB colors we have to activate NoRGB, because we need intensity values. We don’t need RayTransp, because the world background is black anyway. We can’t use ZTransp, because Halos are not rendered in front of materials with ZTransp (probably a bug in Version 2.48a). With Nor we get a 3D effect.

Figure 1136  Figure 4c: Texture settings for the animated alpha map

• Switch to the Texture buttons.
• Type: Image Texture
• Load the first image of the alpha map sequence.
  • Image: Sequence
  • Frames: 150
  • Map Image: Extend (Fig. 4c)

Now we adjust the UV coordinates.
• *Object->Transform->Scale to Image Aspect Ratio*. This scales the ratio of the plane automatically to the aspect ratio of the image texture.
• Change to a frame where you can judge the particle animation and it’s fitting to the texture.
• Switch to edit mode. Scale the UV coordinates in the UV editor until the texture fits to the particles.
• Switch back to object mode.

197.4. Material for the plane

![Image of material](image-url)

Figure 1137  Figure 5: Material for the plane

We will now give the plane a better material. To judge the material we will first re-focus the camera, give it a texture and make some material settings. If you already have a good metal material, you can use this of course directly and use the Alpha texture from above on your existing material.
• Select the camera.
• Turn *Orthographic* in the *Camera* buttons off.
• Position the camera as desired.
• Select the plane.
  • I’ve used the rust texture that is linked at the bottom of the page as image texture.
Working example: Cutting Through Steel

- **Map Input:** Orco, SizeX/Y each 0.5. The size change is to use a larger part of the texture on the final image. But this depends on the size of the camera and the texture.
- **Map To:** Col/Nor
- In the second texture slot I’ve mapped a Stucci texture to Spec.
- This abridged sentence means: select the texture slot. Set Map To to Spec. Deselect Col. Change to the Texture buttons. Select Texture type Stucci.
- The Specularity is thus determined by a texture. The spec value is increased by the texture (DVar=1). Therefore you have to set the Specularity in the Shaders panel to the smallest value the material shall have (e.g. 0.08).

If you have done a test render, you’ll see that the particle track of the cube is still there.

- We don’t need the cube anymore, you may delete it. In the Scene Cutter we use the already generated AlphaMap.

Texture with OSA (Antialiasing) are somewhat blurred, for our purpose we use CatRom instead of the default Gauss method.

- Set in the Render panel CatRom as AntiAliasing filter.

We need a new output directory for the animation, to not overwrite the AlphaMap we’ve created earlier.

- Set the output directory to ”//Render/” in the Output panel.
197.5. Lighting the torch

The torch itself shall cast light, therefore we parent a Lamp to the Sphere and animate the energy of the lamp.

- Change to frame 1.
- Select the Sphere.
- Place the 3D cursor on the Sphere. **Object->Snap->Cursor to Selection**
- **Add->Lamp->Lamp**
- Select the lamp in addition to the Sphere.
- **Object->Parent->Make Parent->OK**
- Select the lamp and move it a bit up (i.e. in positive z-direction). The lighting shall emit from the sparks, not from the hole.

I find it cumbersome to animate the energy of the lamp by setting ipo-keys in the lamp buttons. Instead I do it directly in the 3D window.

- Change to the *Ipo Curve Editor* in one of the open windows.
- Change the ipo type to *Lamp*.
- Activate the *Energy* channel with **LMB** click in the ipo window.
- By holding **Ctrl** key pressed, you create by left-clicking in the ipo window the points of the ipo curve.
Working example: Cutting Through Steel

These values may be larger than 1. However, the last maximum value should be reached in frame 100, and decreases significantly to frame 105. The sparks are only issued up to frame 100, and live up to the 105th frame. After that the metal is glowing a bit.

Your result may look somewhat like mine in Fig. 6. If the amplitude of the curve is not large enough, you can scale the y-pocurve at the y-axis.

Figure 1139  Figure 7: Better sparks

You may animate the material for Line visualization during the lifetime of each individual particle if you use Halo for the material, so you could change the sparks color from white to red.
We will show this in the next step, but confine ourself here to make a better, not animated material (Fig. 7).

- Add a material to the Sphere, name it Sparks.
- Activate Halo in the Links and Pipelines panel.
- Set the RGB color for Halo to white.
- Activate Lines/X Alpha/Shaded in the Shaders panel.
- Halo Size: 0.1
- Add: 0.8

197.7. Smoke

![Figure 1140] Figure 8a: Sparks and Smoke

Now were going to create an individual material animation for every particle during its own lifetime.

We will use particles with a simple texture and animate the alpha value of the material. We’re going to duplicate the Sphere and give it a new particle system.

- Duplicate the Sphere with Object->Duplicate. The new sphere already bears the Path constraint.
- Remove the Sparks system from the new Sphere.
Creating a new particle system named Smoke:

- **Amount:** 300
- **Emit from:** Random/Verts
- **Initial velocity:**
  - **Object:** 0.02
  - **Normal:** 0.1
  - **Random:** 0.01
  - **AccZ:** 0.05
- Bake this particle system.

Change to the Material buttons.
- Create a new material and call it Smoke.
- **Alpha:** 0.034. This is the basic visibility for the smoke texture.
- Add an ipo key for **Alpha** in frame 1.
- Change to frame 100.
- Set **Alpha** to 0.0 and add the second ipo key.

Now the smoke will disappear within the lifetime of each particle, independently of the lifetime of the particle.

- **Halo**
  - **Halo Size:** 0.224
  - **Hard:** 12
  - **Add:** 0.014
  - **Halo Tex** This is the crucial setting to use a texture for the shape of the halo.
  - **X Alpha**
• Create a new texture, you may also call it *Smoke*.
• *Texture Type: Image*
• Load an image with random, smoke-like structures, like that from *Fig. 8b*.

If the fading goes too quickly, or the texture is too transparent / opaque, change the animation of the *Alpha* value.

You see, even though we use only a few objects and materials, it is extremely helpful if we designate meaningful names to the objects, materials, textures etc.
197.8. After Glow

Now at last we will create another animated texture, that shall simulate the annealing of the steel plate after it is being cut through.

**Figure 1142**  **Figure 9a:** A Frame of the Glow-Map

- Change to the scene AlphaMap.
- Add a new scene again as a Full Copy.
- Name this scene Glow.
- Enter the output directory "/Glow/" in the Output-Panel of the Render buttons.

The texture shall have nice semi transparencies.

- Therefore we select a different output format in the Format panel, namely RGBA (RGB with Alpha).
- Selecting Premul in the Render panel the world background will become fully transparent, and the particle trace semi transparent.

We use the existing particle system, but change it’s material settings.

- Call the material of the cube Glow.
- Increase the HaloSize to 0.04. Our new texture has to be larger than the cutout of the plane, else it will not be visible.

Now we’re going to animate the material of the halos. Again this works only because we have Point visualization of the particles.

- Change to frame 1.
- Set an IPO key for the RGB color (here white).
- Go to 3rd Frame.
- Change the Halo color to 1/1/0.42 (light yellow). Set the next IPO key.
- Go to 6th Frame. Change the Halo color to 1/0/0 (red). Set the next IPO key.
- Go to 11th Frame. Change the Halo color to 0/0/0 (black). Set the next IPO key.

The particle trace will fade out during 11 frames.

- Render the animation.
Go back to the scene Cutter.
Select the plane.
Load the newly created texture in the third texture slot as an animated image texture.
  * Add New. Name the texture Glow.
  * Map Input: UV
  * Map To: Col/Emit

We need the alpha values in the image for changing the emit value. Also the alpha blends the glow texture nicely with the plane texture.

  * Texture Type: Image
    * Select the first image from the subdirectory Glow.
    * Activate Sequence.
    * Frames: 150

Figure 1143  Figure 9b: A finished frame of the animation.
• Extend

The settings for the texture are identical with those of the texture $AlphaMap$ (Fig. 4c), except of course for the directory in which the images reside.

In Fig. 9b, see a finished frame of the animation. For the video in Fig. 1 I’ve changed the animation a bit, scaled the emitter objects a bit smaller, changed the sparks Color and used a different camera perspective.

Suggestions, critics and approval please write on the commentary page of this article. If you find some obvious mistakes you may correct the article directly of course.

197.9. Links

Figure 1144 Rust Texture

• The Blend File

2 http://www.snapdrive.net/files/180816/CuttingThroughSteel.zip
198. Overview

This set of tutorials is for Blender users who stumble up on the basics of certain games, such as making a HUD, menu, or even a simple button. This is also a place where users who know cool ways to spice a game up or explain troublesome aspects of making certain parts of a game genre’s content work (like how to get Blender to calculate the damage of a bullet shooting).

There are a couple subsections to this. One is for those who don’t like the messiness of python. Learning python to the point of being able to create a game with it will take months, maybe years, just to learn it, not to mention how long it would take to type the specific code and troubleshoot. So, the first section is for those who are much more comfortable with using the GUI Blender screen to make the majority of their game, and the tutorials exist to help them enhance their game.

**Note:** No matter how much GUI you’d like to use in game creation, there is a certain amount of python you will HAVE to use to be able to really make your game good. Make sure to at least read up on it. Sorry.

Jump to *Game Creating Techniques within a GUI* ¹

Then there is the second subsection. This section is to help those who are comfortable with python learn how to use the code in ways they never thought of, and to show those who don’t do so well with it just what python can do. While it’s a simple language, it can still be incredibly complicated at times, and very, very picky.

**Note:** DO NOT SUBMIT ANY CODE YOU DO NOT WANT COPIED A MILLION TIMES! This section is for helping the broad and the narrow range of Blender users to learn how to use python better, and there will be no expectation of attribution for submitting code you found out yourself.

Jump to *Game Creating Techniques with Python* ²


199. Advanced Game Engine Techniques (GUI)

199.1. Making Blender Games Graphically

If you’re reading this section, I’m guessing that you have either made a game before or at least are in the process of making one right now. Let’s face it: It’s probably much harder than you imagined it. A large amount of people take video games and the work put into them for granted. And there are probably quite a few times in which you wanted to do something so simple—such as a menu or even a button—but didn’t even know where to start or what to do.

This is why this section exists.

The next few pages will all be tutorials with different techniques on how to make objects in Blender move and respond to things like your mouse, keyboard (a.k.a. “HotKeys”) and making it all look like what a real game does. They will be simple versions of a menu, or a button, in which you can use this and put it into your own idea with your own graphics and your own little tweaks.

There will be a certain amount of Python necessary in the next few tutorials, mainly just to allow the mouse icon to appear on screen. However, you can do the rest of the tutorials in the 3D View Window, and under the Logic Index in the Tab window.
200. Creating Pop-Up Menus

In this tutorial, we will be making a Title Screen and a Main Menu Screen to come from that Title Screen. While most people hardly pay attention to these areas on a real video game, they do make the game seem much better to play, and gives the player a certain choice of what they can do before they play the game. Before beginning this, make sure you familiarize yourself with several logic sensors and actuators, such as "Scene" and "Property", as they will heavily be relied upon. It is also best if you have several Pictures ready to use for your game or are ready for additional functions with certain programs (a Word Processor Program and Image Editing Program [that has a transparency setting] can help move along your game.)

200.1. Making An Easy Title Menu

The Title Screen will be very simple -- it will be the "Press Enter to Continue" kind. This will lead to a more interactive kind of Main Menu, in which you can use either key commands or the mouse pointer. This tutorial will not be the most visually pleasing, but then again, you can always add whatever graphics you would like. Again, it would be wise to have handy a word-processing program and a program like Microsoft Paint. "Print Screen" will be a useful function to use while following this tutorial -- the corresponding button is generally located to the right of the F12 key in the row of function keys on your keyboard.

If you have never used different scenes before, you’re about to get a crash course. Also, Blender hotkeys and actions will not be explained with (A-key) or (numpad-6); it is assumed you have already learned at least how to perform basic Blender functions.

200.1.1. Making the Menu

First, start up Blender and delete everything in the scene. Then, move to top orthographic view (press numpad 7, or if you have not a numpad, go to the hidden top menu and in the System & OpenGL section select "emulate numpad").
The first thing you should do is add a new scene. In the Information view panel at the top, click the SCE: drop-down menu and click on ADD NEW. Label this new scene something like "Main Menu". Now go back to your original scene and name it something like "Title Menu". These names will be important when it comes to changing the scenes around. So, on your "Title Menu" Scene, begin by adding a Camera. Move this Camera in the Z direction about a point, just to get it above the grid. Now, set the camera view to Orthographic. Now switch to Camera View. Add a plane that is scaled to cover the entire surface of the Camera’s view-bounds. Move that plane just a little bit in the -Z direction. Then, add another plane, but scale this plane to be a thin rectangle about 2/3rds down the Y-length of the Camera, centered in X-direction.

(Image Shown with Materials for visual purposes, DON’T ADD MATERIALS)

*Now this next step isn’t necessary, but if you want a good-looking game you will probably need this step.*

Let’s add some UV textures. Open a good photo/image-editing program like Photoshop, GIMP, or Microsoft Photo Editor; something that preferably supports Transparency. Type
some text appropriate for your game such as, "Press any key to continue." What I do is add lots of extra space and add additional text that I will use in the main menu too, such as "New Game", "Continue", "Story Mode", etc. so it is all in one image for multiple UV textures. If your editor supports it, set the background color to transparent. If not, set it to black so it will register as 0 on the alpha channel in Blender. Save the image (GIF or PNG are reasonable choices for use with transparency). Now, in Blender, split the 3D screen into 2 screens, and change one screen over to UV face select. Select your small rectangle, and switch to Edit Mode and Unwrap the face in the 3D window, then open your saved image in the UV face window. Scale your face in the UV window so it holds only the "Press Any Key to Continue" graphic. If you wish, also add a starting Image on the larger rectangle.

200.1.2. Setting Up The Actions

Now this step is necessary. Select the large background rectangle, in the Buttons Window at the bottom switch it to the Logic Tab. This will be very simple. Add one Sensor, one Actuator, and one Controller. Make the sensor a Keyboard Sensor, depress the "True Pulse" button, and in the key area depress the "All Keys" button. Make the Controller an "AND" controller. Make the Actuator a Scene Actuator. Select the Drop-Down box and make it "Set Scene" wit "SCE:Main Menu". Before you test the game, make sure to save and add a Camera to the "Main Menu" Scene. Otherwise the game WILL crash.

If you want the option of returning to this scene, instead of one Actuator make two. Make both of them Scene, but make one "Suspend Scene" with "SCE:Title Menu" and make the other Actuator "Add Overlay Scene" with "SCE:Main Menu". Also, that means in the Main Menu Scene later you’ll have to add some key to hit or some action to "Remove Scene" "SCE:Main Menu" and "Resume Scene" "SCE:Title Menu".

200.2. Author’s Starting Menu Example

The following contains actual in-progress work by the original Author of this page. The work and ideas are heavily copyrighted and it is highly encouraged (begged) that you do not rip this content off--the author has submitted this work generously to help less advanced users more efficiently.

The following is my work on a game I am making, and I hope it helps you too.
This will get you to the next menu, which will be on the next section.

### 200.3. A Main Menu

This menu will be more difficult, using a mouse-python function to use and make the mouse appear when you play your game and a maze of sensors and actuators entangled.

Here is the first thing you need: a python script to make the Mouse show ---

*This code is attributed to the author of the chapter "Blender Game Engine/A Simple Mouse Pointer" and this is not my own code.*

```python
import Rasterizer as r
r.showMouse(1)
```

Put this in the text editor, and save the text as something simple like "Mouse". Now, on your Main Menu scene, select the camera and add 1 sensor, 2 controllers, 1 actuator, and 1 property. Name the property "Switch" "Int" Type, and set it to 0. Set up your logic as follows:
A change will need to be made in order to make yours work. The python controller should be Script:Mouse, not Script:showpointer. If you can’t see the connections:

- Connect the Sensor to the 2 controllers
- Connect the AND controller to the actuator
- Leave the Python controller open-ended

If you play the game, you will see the mouse then! Now, back to the Menu, there are multiple kinds of Menus you can make when it comes to Menus popping up. The one I believe works best is a 3-layered button. To explain what this means, I’ll run you through the steps of making one. Let’s start with the layers themselves. (For this to work best, make the background of any images you use have transparency, so you can make invisible-yet-clickable faces.) Create a rectangle facing the camera where you want your first menu option to be. Copy the object until you have 3 rectangles, and make each one very slightly in front of the last. Now, Select the back rectangle, and on this one apply the UV face of the option’s words. The second rectangle is the UV face for a graphic outline around the words if the option is selected in the game. It’s not necessary but then again, it helps the player with selecting options and it looks nice. The top rectangle will be the selectable one--make the UV face applied only over a completely transparent area. Now, for the logic.

Text-Rectangle:

-No Logic Needed

Outline-Rectangle:

-Give it a Property named "Selected", Int Type, starting at 0.

-Make a Property Sensor, True Pulse, "Selected" Property is Equal to 1, Connected to an AND controller, Connected to a Visibility Actuator at "Visible"

-Make a Property Sensor, True Pulse, "Selected" Property is Equal to 0, Connected to an AND controller, Connected to a Visibility Actuator at "Invisible"
Creating Pop-Up Menus

- Make a Property Actuator, "Selected" Property is Assigned Amount 1
- Make a Property Actuator, "Selected" Property is Assigned Amount 0
- Create AND Controller and connect both Mouse Sensors. Make this AND Controller connect to the Outline-Rectangle’s Property Actuator "Selected" Assign=1.

Transparent-Rectangle:

- 2 Mouse sensors: "Mouse Over" and "Left Button". Set them to "True Pulse".

*(Click Image to Enlarge)*

![Figure 1149](image-url)

Now here is the trickier part to explain. To make things a little more simple, name that last Outline-Rectangle’s AND controller connected to the 2 mouse sensors. Select all 3 layers, and duplicate them 3 times. Make each one (in camera view) below the last, making sure to keep them parallel on the Z axis. Now, to make only one selected at a time, take the named controller of the first, and connect it to the Outline-Rectangle’s Property Actuator "Selected" Assign=0 of second and third button. Do the same from the second button to the first and third one, and same with the third to the first and second. It should look like the picture:

*Click Image to Enlarge*
This logic arrangement should yield (when the game is played) options in which if you click one it will light up, and if you click another, that one will go down and the other will light up.

Now this looks nice aesthetically, but the use of it is now all you have to do is make some Scene Actuators. Add 2 more actuators to each of the Transparent Planes. Use the same method as you did with the Properties, but instead of "Property Assign 1/0" make 1 AND controller, 1 Scene Overlay and 1 Scene Remove for each transparent button. Now make 3 additional Scenes, and either make an entirely new menu for each, or to be easier just make colored rectangles on the scene, different colors for each scene -- either way, make sure that, if the scenes overlay, the additional scene won’t cover up the buttons of the Main Menu Scene. So, now connect the 2 Mouse Sensors to the corresponding AND Controller, and connect that to the Corresponding "Overlay Scene" Actuator and 2 Opposing "Remove Scene" Actuators. Do this with the other 2 Transparent Rectangles. Make sure your new scenes also have cameras and that they are scaled properly.

*Click Image to Enlarge*
You can use this technique to make Menus and Sub-Menus Galore! It’s fairly simple to make multiple sublevels of this and get back to the original scene with this method.

I hope this helped you make your menus work well.
201. Creating Dropping Menus

In this section, you are going to learn a variety of ways to make menus with motions. These menus can be used in more ways than the simple pop-Up menus, such as in-game if you need to select something you can use this to bring up a menu smoothly. In this section there is heavy use of Properties, ”Property” Logic Blocks, and especially IPO usage. When you do it once, it will be very much easier to do it again.

201.1. Making Moving Selectors

To kick this tutorial off, let’s just do a simple icon that will be next to the selected menu item. There will be 6 possible menu items, which can be controlled with both the arrow keys and the mouse. Let’s begin by booting up Blender, and deleting everything--then adding a camera.

Set this camera to orthographic. Now I like making things look nice, but here are the basics of what you will need for this tutorial:

- Make 6 Planes, all different objects, and put them in a vertical list.
- Make a circle next to the first plane. This will act as the Selector.

So after you’ve made you objects, it should look similar to this:
Figure 1153

For me, I made mine look more like this, a little more detailed:

Figure 1154

So now that we have our menu set up, it’s time to set up the properties that will tell the selector how to move. Select the selector that will be moving and give it a property name "Selection". Make it 'Int' type, and start it out at "1". To get this selector to move the way we want it, we have to set up its movements. Make sure you are on frame 1, and put the cursor on the first menu item, then Insert Keyframe for "Loc". Next, move to frame 2, and put the cursor on the second menu item, then insert "Loc" Keyframe, and continue in this fashion for all your menu items. To get this applied in the Game Engine, in the logic
bricks, add an "Always" Sensor (True Pulse Enabled), connected to an "AND" connector, and connected to a "IPO" Actuator, set to "Property" with Prop:Selection. Now we can do 3 things with this selector to have it move like a selector in a video game:

**Up/Down Arrow Keys**
To make the up and down arrow keys work properly, Select the Selector and add four sensors, controllers, and actuators. Make two sensors keyboard, with one set to "Uparrow" and one set to "Downarrow" (do not activate pulse triggering). Make the other two sensors Property Sensors, with True Pulse. For the first, make it "Equal", Prop:Selection, Value:0. For the other, make it "Equal", Prop:Selection, Value:7. For the Actuators, make all four "Property" sensors. For two of them, make them "Add", Prop:Selection, and make the first "Value:-1" and the second "Value:1". The other two should be "Assign", Prop:Selection, with the first at "Value:1" and the next as "Value:6". Now connect them as follows:

*Click To Enlarge Image*

![Image](image.png)

**Figure 1155**

"Keyboard:Uparrow"--"AND"--"Prop:Selection/Add/Value:-1"

"Keyboard:Downarrow"--"AND"--"Prop:Selection/Add/Value:1"
"Prop:Selection/Equal/7"--"AND"--"Prop:Selection/Assign/Value:1"

"Prop:Selection/Equal/0"--"AND"--"Prop:Selection/Assign/Value:6"

Now you can play your game, and the arrow keys should work just fine!

**HotKeys**
If you don’t know what a HotKey, it’s a way to access menu items or action by pressing a specified letter, instead of just clicking or arrow keys. This method will require a different step when you make your UV text textures, as you will need to somehow change one letter (either the color or possibly underline) to let people know that that is a HotKey action.

The HotKey system is easy to set up right alongside the IPO/Selection property. In each menu item, highlight or make special one unique letter in each menu item. Then, with the selector selected, set up 6 keyboard logic sensors, each one for a different letter. Add 6 controllers, and 6 actuators as well. Make all the actuators "Property", "Assign, Prop:Selection, starting with Value:1 progressing to Value:6"

**Mouse Selection**
Our final selection method we can add is the mouse scroll over. Set up the Mouse Sensor to Scroll Over for all 6 invisible selection planes. Then, make the AND Controllers and connect to your original set of "Set Property" Actuators. that matches the Object’s IPO property number. It’s fairly simple.

**Make the Selection**
The final thing to do is, once the selections are set up, make another 8 sensors, 7 controllers, 6 and actuators. Now make the 7th one a keyboard sensor for the ENTER key, as most people usually think they can start a game by pressing ENTER. The 8th Sensor is for another Mouse Sensor for 'Left Click” so that if any of them is highlighted and you Left-Click the mouse, then it will be equivalent to pressing the ENTER key. That may be confusing as, unless you set up the dozen extra sensors, controllers, and actuators, you don’t need to scroll over the selection to pick it, so that 8th sensor is your choice whether you want to add it. Connect the 7th and 8th sensor to the 7th controller. If you have the 8th sensor, make it an OR controller; otherwise, make the controller AND. As for the first 6 sensors, they should be Property Sensors for "Prop:Selection" "Value:[1-6]". Connect each to their own separate controller. Now connect the 7th controller to all 6 Actuators, and the first 6 controllers connect to their own Actuator alongside the 7th. The Actuators can be whatever you want them to: whatever the selection causes to happen when you select the item selection.
201.2. Make the Menu Move

So we created a selection-based moving icon on a menu, but what might happen if you select that item and need a sub-menu in-game? You can’t very well pause the game every time (unless it’s a pause menu). This is where making the menu itself move comes in very handy. In this section, you will make an object clickable, and once clicked it will give out a submenu, which in itself will be able to give out a submenu.

The IPOS
202. The ”5-Layer” Button

202.1. Scheduled Construction

This chapter is scheduled to be created by the Author. Sorry for the inconvenience.
203. Creating Object Outlines

203.1. Scheduled Construction

This chapter is scheduled to be created by the Author. Sorry for the inconvenience.
204. Advanced Game Engine Techniques (Python)

204.1. Needs Expert

This chapter is not yet created, but it is something that would be very helpful to know about Blender. This book would benefit very much so if readers were to be so generous as to give helpful information on this subject, and expand it further. Thank You.

204.2. Additional Resources

- Blender 3D: Blending Into Python
- GLSL Programming in Blender

204.3. External Links

- http://www.youtube.com/watch?v=7hbCEyvVYHI

---

2 http://en.wikibooks.org/wiki/GLSL%20Programming%2FBlender
205. Hacking Blender

<table>
<thead>
<tr>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applicable Blender version: 2.68</td>
</tr>
</tbody>
</table>

Blender is an **Open Source** project. That doesn’t just mean you get to use it for free\(^1\), you also get to see how it works, and you can even make your own changes and share them with others.

Blender is also a large software project (well over a million lines of code), with a great many active contributors over a lifespan of more than a decade, and it continues to be developed at a rapid rate. This can make things somewhat intimidating for less-experienced programmers.

This unit assumes you have some decent programming experience under your belt. Blender is mainly programmed in the C\(^2\), C++\(^3\), and Python\(^4\) programming languages. It can be built using either the CMake\(^5\) or SCons\(^6\) build systems.

### 205.1. Getting the Blender Source Code

The official Blender source is kept in Git\(^7\) repositories located at developer.blender.org. There are actually several separate repositories:

- **blender-main**\(^8\) — the main part of the Blender source, excluding most Python addons.
- **blender-addons**\(^9\) — the Python addons included in the standard Blender distribution.
- **blender-addons-contrib**\(^10\) — additional useful Python addons.
- **blender-translations**\(^11\) — localized language translations for text messages.

---

\(^1\) [http://en.wikipedia.org/wiki/Free%20software](http://en.wikipedia.org/wiki/Free%20software)
\(^4\) [http://www.python.org/](http://www.python.org/)
\(^5\) [http://www.cmake.org/](http://www.cmake.org/)
\(^6\) [http://www.scons.org/](http://www.scons.org/)
\(^7\) [http://git-scm.com/](http://git-scm.com/)
• blender-tests\textsuperscript{12} — some interesting example .blend files used for testing and demonstrating Blender functionality.
• blender-dev-tools\textsuperscript{13} — tools that are useful for performing maintenance tasks on the Blender source, but are not actually needed for building Blender.
• blender-cloud\textsuperscript{14} — looks like a framework for offering a new cloud-based Blender service.

### 205.2. Layout of the Blender Source

Say you’ve checked out a copy of the main Blender source tree. The top level looks like this:

• https://developer.blender.org/diffusion/B/browse/master/build_files/build_files/ — files used during the build process
• https://developer.blender.org/diffusion/B/browse/master/CMakeLists.txt — top-level control file for CMake
• https://developer.blender.org/diffusion/B/browse/master/COPYING — note about Blender licensing (GPLv2)
• https://developer.blender.org/diffusion/B/browse/master/doc/doc/ — documentation files, among them:
  • https://developer.blender.org/diffusion/B/browse/master/doc/blender_file_format/doc/blender_file_format/ — the format of .blend files
  • https://developer.blender.org/diffusion/B/browse/master/doc/build_systems/doc/build_systems/ — how to build Blender, and hack the build system
  • https://developer.blender.org/diffusion/B/browse/master/doc/manpage/doc/manpage/ — the man page
• https://developer.blender.org/diffusion/B/browse/master/extern/extern/ — non-Blender-specific libraries, primarily developed elsewhere, included in the source
• https://developer.blender.org/diffusion/B/browse/master/GNUmakefile — simple build script for those who can’t be bothered to go through the CMake setup process
• https://developer.blender.org/diffusion/B/browse/master/intern/intern/ — libraries which are non-Blender-specific but primarily developed here, also glue code for interfacing to external libraries not included in the Blender source. Notable subdirectories:
  • https://developer.blender.org/diffusion/B/browse/master/intern/bsp/ — Constructive Solid Geometry routines
  • https://developer.blender.org/diffusion/B/browse/master/intern/cycles/ — the Cycles renderer
  • https://developer.blender.org/diffusion/B/browse/master/intern/elbeem/ — the fluid simulator

\textsuperscript{12} https://svn.blender.org/svnroot/bf-blender/trunk/lib/tests
\textsuperscript{13} http://developer.blender.org/diffusion/BDT/
\textsuperscript{14} http://developer.blender.org/diffusion/BC/
Layout of the Blender Source

- https://developer.blender.org/diffusion/B/browse/master/intern/guardedalloc/intern/guardedalloc/ — thread-safe memory management with consistency checking
- https://developer.blender.org/diffusion/B/browse/master/release/release/ — additional files to be included in the Blender distribution, including GUI icons and fonts
- https://developer.blender.org/diffusion/B/browse/master/source/source/ — the main part of the Blender source, further divided (ignoring the CMakeLists.txt and SConscript files which you will find just about everywhere) into
  - https://developer.blender.org/diffusion/B/browse/master/source/blender/source/blender/ — the bulk of the source, of which some useful parts are
  - https://developer.blender.org/diffusion/B/browse/master/source/blenderplayer/source/blenderplayer/ — some additional files for building the Blender Player executable
  - https://developer.blender.org/diffusion/B/browse/master/source/creator/source/creator/ — the Blender mainline
  - https://developer.blender.org/diffusion/B/browse/master/source/icons/source/icons/ — some files specific to the Windows build
  - https://developer.blender.org/diffusion/B/browse/master/source/tests/source/tests/ — some test scripts

205.2.1. Common Subdirectory Layout

Within many of the subdirectories in https://developer.blender.org/diffusion/B/browse/master/source/blender/source/blender/ and https://developer.blender.org/diffusion/B/browse/master/intern/intern/, you will see the following pattern:

- A bunch of .h files in the directory, and
- an intern subdirectory.

The .h files define the functionality exported to other modules, while the intern subdirectory contains the .c or .cpp files that actually implement the module. Sometimes the .h files are put into an extern subdirectory instead of the upper directory level.

(And yes, these meanings of intern and extern are not the same as the meanings of intern and extern at the top directory level.)
205.3. Blender’s “Genetic Code”: “DNA” and “RNA”

You will find references to “DNA” (or “SDNA”) and “RNA” throughout Blender’s source code. The analogy to the terms from genetics is weak at best, but what they refer to is:

- “DNA” or “SDNA” (“structure” DNA?) is the system for mapping Blender’s in-memory data structures to the on-disk .blend file format. A .blend file is little more than a memory dump, which makes it quick to write. However, the file needs to be readable by Blender builds on machines with different endianness\(^\text{15}\), 32 versus 64-bit\(^\text{16}\) pointers, etc, not to mention future versions with different capabilities. Thus, the saved .blend file includes a detailed description of the layout of all the data structures saved in the file, and this description is stored in the “DNA1” block at the end. This block is generated by the makesdna tool, which is built and run automatically as part of the overall build process, so its output can be included directly into the Blender executable. It parses all the .h files in the directory https://developer.blender.org/diffusion/B/browse/master/source/blender/makesdna/source/blender/makesdna/, so all data structures that could get saved into .blend files must be defined here, and they must be careful to use a limited subset of C that the parsing tool can handle.

- “RNA” defines the Python interface to Blender’s internal data structures and routine calls. Here\(^\text{17}\) is Ton “Mr Blender” Roosendaal explaining DNA and RNA.

205.4. Special Globals: “G” and “U”

There is a frequently-referenced global variable named “G”, of type struct Global, declared in https://developer.blender.org/diffusion/B/browse/master/source/blender/blenkernel/BKE_global.h. The variable is defined in https://developer.blender.org/diffusion/B/browse/master/source/blender/blenkernel/intern/blender.c. This same file also defines the global “U”, of type struct UserDef, declared in https://developer.blender.org/diffusion/B/browse/master/source/blender/makesdna/DNA_userdef_types.h.

205.5. Naming Conventions

Some (but not all) global symbols have prefixes on their names indicating (roughly) where they come from. Here is a partial list.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Meaning</th>
<th>Where Found</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUD_</td>
<td>audaspace sound library</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/intern/audaspace/intern/audaspace/">https://developer.blender.org/diffusion/B/browse/master/intern/audaspace/intern/audaspace/</a></td>
</tr>
<tr>
<td>BKE_</td>
<td>lowest-level (non-UI) Blender operations</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/blenkernel/source/blender/blenkernel/">https://developer.blender.org/diffusion/B/browse/master/source/blender/blenkernel/source/blender/blenkernel/</a></td>
</tr>
<tr>
<td>BLF_</td>
<td>Font/text-handling</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/blenfont/source/blender/blenfont/">https://developer.blender.org/diffusion/B/browse/master/source/blender/blenfont/source/blender/blenfont/</a></td>
</tr>
<tr>
<td>BLI_</td>
<td>common library routines</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/blenlib/source/blender/blenlib/">https://developer.blender.org/diffusion/B/browse/master/source/blender/blenlib/source/blender/blenlib/</a></td>
</tr>
<tr>
<td>BLO_</td>
<td>loading/saving .blend files</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/blenloader/source/blender/blenloader/">https://developer.blender.org/diffusion/B/browse/master/source/blender/blenloader/source/blender/blenloader/</a></td>
</tr>
</tbody>
</table>

\(^{15}\) http://en.wikipedia.org/wiki/Endianness

\(^{16}\) http://en.wikipedia.org/wiki/64-bit

\(^{17}\) http://www.blendernation.com/2008/12/01/blender-dna-rna-and-backward-compatibility/
<table>
<thead>
<tr>
<th>Prefix</th>
<th>Meaning</th>
<th>Where Found</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA_</td>
<td>include files containing all type definitions that get saved into .blend files</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/makesdna/source/blender/makesdna/">https://developer.blender.org/diffusion/B/browse/master/source/blender/makesdna/source/blender/makesdna/</a></td>
</tr>
<tr>
<td>ED_</td>
<td>editor UI routines</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/editors/source/blender/editors/">https://developer.blender.org/diffusion/B/browse/master/source/blender/editors/source/blender/editors/</a></td>
</tr>
<tr>
<td>FRS_</td>
<td>Freestyle renderer</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/freestyle/source/blender/freestyle/">https://developer.blender.org/diffusion/B/browse/master/source/blender/freestyle/source/blender/freestyle/</a></td>
</tr>
<tr>
<td>GHOST_</td>
<td>platform-independent UI layer</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/intern/ghost/intern/ghost/">https://developer.blender.org/diffusion/B/browse/master/intern/ghost/intern/ghost/</a></td>
</tr>
<tr>
<td>IMB_</td>
<td>image-format handling</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/imbuf/source/blender/imbuf/">https://developer.blender.org/diffusion/B/browse/master/source/blender/imbuf/source/blender/imbuf/</a></td>
</tr>
<tr>
<td>MEM_</td>
<td>memory management</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/intern/memutil/intern/memutil/">https://developer.blender.org/diffusion/B/browse/master/intern/memutil/intern/memutil/</a></td>
</tr>
<tr>
<td>MOD_</td>
<td>modifiers</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/modifiers/source/blender/modifiers/">https://developer.blender.org/diffusion/B/browse/master/source/blender/modifiers/source/blender/modifiers/</a></td>
</tr>
<tr>
<td>NOD_</td>
<td>node editor</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/nodes/source/blender/nodes/">https://developer.blender.org/diffusion/B/browse/master/source/blender/nodes/source/blender/nodes/</a></td>
</tr>
<tr>
<td>RE_</td>
<td>common renderer handling</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/render/source/blender/render/">https://developer.blender.org/diffusion/B/browse/master/source/blender/render/source/blender/render/</a></td>
</tr>
<tr>
<td>STR_</td>
<td>string routines</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/intern/string/intern/string/">https://developer.blender.org/diffusion/B/browse/master/intern/string/intern/string/</a></td>
</tr>
<tr>
<td>WM_</td>
<td>window management</td>
<td><a href="https://developer.blender.org/diffusion/B/browse/master/source/blender/windowmanager/source/blender/windowmanager/">https://developer.blender.org/diffusion/B/browse/master/source/blender/windowmanager/source/blender/windowmanager/</a></td>
</tr>
</tbody>
</table>

### 205.6. User-Interface Implementation

The UI code is structured into several layers. This code also handles finding of user-preference files and shared application data. Starting from the lowest, the layers are:


### 205.7. See Also

- Building Blender[^18] — platform-specific instructions on the Blender Wiki
- Development resources[^19] at blender.org, including
  - Architecture overview[^20]
  - Official developer blog[^21]
- Mailing lists[^22]

[^19]: http://www.blender.org/development/
[^21]: http://code.blender.org/
[^22]: http://lists.blender.org/mailman/listinfo/
206. Introduction to Game Engine Source

Mission Statement: The purpose of this section is to show a programmer how to make sense of the blender game engine source code. It is not intended for those who cannot code in C++. If you’re one of the people who have a basic understanding, I’m being careful to use keywords that if you google, should provide enough information to understand.

When you press P, several things are sent to the GE before anything can be done. What might these be?

```
StartKetsjiShell(struct ScrArea *area,
char* scenename,
struct Main* maggie1,
struct SpaceIpo *sipo,
int always_use_expand_framing)
```

Blender uses a lot of structs and classes. You need to have a working understanding of these as well as inheritance before we can move on. For a refresher: http://www-numi.fnal.gov/offline_software/srt_public_context/WebDocs/Companion/cxx_crib/inheritance.html

The SCA_IObject class https://developer.blender.org/diffusion/B/browse/master/source/gameengine/GameLogic/SCA_IObject.cpp

This class encapsulates a lot of other things, so we can start here and move downwards to the things that it controls. First off it uses vectors to store all the different Sensors, Controllers and Actuators that are linked to the object. A vector is like an array, but it is dynamic and has built in functions.

We will begin by examining how sensors are added.

```c++
typedef std::vector<SCA_ISensor *> SCA_SensorList;

SCA_SensorList m_sensors;
```

The first line here is a typedef so it just tells us that we can create a vector of SCA_ISensor by using the name SCA_Sensor list.

The second line creates the vector with the name, m_sensors

```c++
void SCA_IObject::AddSensor(SCA_ISensor* act)<br />
{ m_sensors.push_back(act); }
```

This function allows the parents of an SCA_IObject to add new sensors by calling: SCA_IObject.AddSensor(keyboard);
So now you know how Objects in the GE create sensors (and actuators and controllers, its the same :) So lets look at how Sensors are grabbed! Since they are dynamically added the program can’t make assumptions about how many are there or what they will be. Thus there is this helper function:

```
1''SCA_ISensor* SCA_IObject::FindSensor(const STR_String& sensorname)
2{
3    SCA_ISensor* foundsensor = NULL;
4
5    for (SCA_SensorList::iterator its = m_sensors.begin();!(its==m_sensors.end());its++)
6    {
7        if ((*its)->GetName() == sensorname)
8            foundsensor = (*its);
9            break;
10    }
11    return foundsensor;
12''
```

Put simply, you give this the name of a sensor and it returns a pointer to the sensor.

for the newbies: I know you learned all about classes when i asked you to, but just in case:) the first word, ”SCA_ISensor*” this tells us that the function will return a pointer to a SCA_ISensor. And based on the functions arguments, we know that when you call FindSensor you must give it a string between the parenthesis.

in line 3 you create an empty pointer which you will use to store the sensor that you find. Then you loop and go through each sensor in the vector of sensors (remember, it was named m_sensors) until you find the one that matches the name. If you don’t find one, you return NULL.

void SCA_IObject::Suspend(void) What this does is it loops through all of the sensors and sends each one a "suspend" call. What this does is change a variable named, "m_suspended” which makes stops the sensors from running when they are called with their Activate() function.
Part V.

Appendices
Part VI.

Reference Material
207. Glossary

207.1. A

- **Alpha Channel**\(^1\) is an additional channel in a 2D image for transparency. In an image element which stores a color for each pixel, an additional value is stored in the alpha channel containing a value between 0 and 1. A value of 0 means that the pixel does not have any coverage information; i.e. there was no color contribution from any geometry because the geometry did not overlap this pixel. A value of 1 means that the pixel is fully opaque because the geometry completely overlapped the pixel.

- **Ambient Light** is light that doesn’t seem to come from a specific source, but is just there. Look under the desk - it’s pretty dark, but there’s some light there. In the real world, this is caused by stray photons bouncing around and occasionally ricocheting under the desk. Ambient light is the basic, minimal amount of light in the whole scene. Adding too much ambient light makes a scene look washed out. Since the light doesn’t come from anywhere, all sides of an object are illuminated equally, and it won’t have any shading on it.

- **Ambient Occlusion**\(^2\) (AO) is a ratio of how much ambient light a surface point would be likely to receive. It simulates a huge dome light surrounding the entire scene. If a surface point is under a foot or table, it will end up much darker than the top of someone’s head or the tabletop.

- **Armature**\(^3\) is the interconnection of bones that form the skeleton of an animated figure. The Inverse Kinematics library contains the code to make armatures move. The armature must still be rigged\(^4\) with 3D objects to give shape to its head, hands, trunk, feet, etc.

207.2. B

- **Background image**: a 2D image (“picture”) that is placed “behind” the entire 3D scene, like a backdrop on a movie set. Blender permits the placement of these images in all six directions from the origin: back, front, top, bottom, left, right.

- **Bake**: to precompute computationally-intensive elements of an animation. For example, in a physics simulation involving the behaviour of fluids or clothing, you would set up the physical parameters, then compute (bake) the positions and shapes of the objects over the duration of the animation. Afterwards, you can assign materials and lighting,

\[^1\] http://en.wikipedia.org/wiki/Alpha%20compositing
\[^2\] http://en.wikipedia.org/wiki/Ambient%20occlusion
\[^3\] http://en.wikipedia.org/wiki/armature_%28sculpture%29
\[^4\] http://en.wikipedia.org/wiki/rigging
and then render the frames to produce the actual animation. Doing the baking as a separate step, and saving the results from that, means you can change your mind about the materials and lighting and rerender the frames more quickly.

• **Bézier surfaces**\(^5\) were first described in 1972 by the French engineer Pierre Bézier who used them to design automobile bodies. Bézier surfaces can be of any degree, but bicubic Bézier surfaces generally provide enough degrees of freedom for most applications.

• **BF** is Blender Foundation

• **Blend** - to Blend, working with Blender; also Blender’s file extension.

• **Bounce Light** : Simple lighting situations have a single light, called a key light, illuminating one side of an object. This creates strong shading and definition of the volume of the object. However, a 3D light will often make the contrast too great - the dark side of the object is completely black since no light is hitting it. In reality it would still be lit a little, just not as much as the brightly lit side, because of light bouncing around the room and hitting the dark side of the object. In realtime 3D, bounce light is not calculated, so you have to create it yourself. Either add a little ambient color, or put a second, less bright directional light pointing the opposite direction to give a little light to the shadows.

• **Bump mapping**\(^6\) is a technique where at each pixel, a perturbation to the surface normal of the object being rendered is looked up in a texture map and applied before the illumination calculation is done. Bump Mapping use a gray-scale image map to change the direction of surface normals. You can use this to simulate height, so that you can paint wrinkles and bumps. 50% grey means neutral (no change is made), lighter means higher, darker means lower. Note that the position of faces is not actually changed; by rotating just the normals, lighting will change too, to give the illusion of a height difference. This has downsides too: the outline of objects isn’t changed, so the trick is given away. For similar effects you can use Displacement Mapping and Normal Mapping.

207.3. C

• **Caustics** in optics is a bundle of light rays. For example a caustic effect may be seen when light refracts or reflects through some refractive or reflective material, to create a more focused, stronger light on the final location. Such amplification, especially of sunlight, can burn — hence the name. A common situation when caustics are visible is when some light points on glass. There is a shadow behind the glass, but also there is a stronger light spot. Nowadays, almost every advanced rendering system supports caustics. Some of them even support volumetric caustics. This is accomplished by raytracing the possible paths of the light beam through the glass, accounting for the refraction, reflection, etc.

---

\(^5\) [http://en.wikipedia.org/wiki/B%C3%A9zier%20surface](http://en.wikipedia.org/wiki/B%C3%A9zier%20surface)

207.4. D

- **Depth of Field**\(^7\) (DOF) is the distance in front of and behind the subject which appears to be in focus. For any given lens setting, there is only one distance at which a subject is precisely in focus, but focus falls off gradually on either side of that distance, so there is a region in which the blurring is tolerable. This region is greater behind the point of focus than it is in front, as the angle of the light rays change more rapidly; they approach being parallel with increasing distance.

- **Diffuse Light** is even, directed light coming off a surface. For most things, the diffuse light is the main lighting we see. Diffuse light comes from a specific direction or location, and creates shading. Surfaces facing towards the light source will be brighter, while surfaces facing away from the light source will be darker.

- **Directional Light** is a light that has a specific direction, but no location. It seems to come from an infinitely far away source, like the sun. Surfaces facing the light are illuminated more than surfaces facing away, but their location doesn’t matter. A Directional Light illuminates all objects in the scene, no matter where they are.

- **Displacement Mapping**\(^8\) uses a greyscale heightmap, like Bump Mapping, but the image is used to physically move the vertices of the mesh at render time. This is of course only useful if the mesh has large amounts of vertices, but the (relatively) new "Simple Subdiv" subsurf option allows you to add more vertices at render time which will be moved by the displacement. This makes it much slower than Bump Mapping, as there need to be many more faces to render, but it is much more realistic.

207.5. E

- **Environment Maps** (EnvMaps) is the method of calculating reflections. Involved rendering images at strategic positions and applying them as textures to the mirror. Now in most cases obsoleted by Raytracing, which though slower is easier to use and more accurate.

207.6. F

- **Focal Length**\(^9\) of a lens is the distance along the optical axis from the lens to the focus (or focal point). The inverse of a lens’ focal length is called its power.

- **Focus**\(^10\) of a lens is the point onto which collimated light parallel to the axis is focused.

- **Foreshortening**

---

10 [http://en.wikipedia.org/wiki/Focus%20%28optics%29](http://en.wikipedia.org/wiki/Focus%20%28optics%29)
• **Fresnel**\(^\text{11}\) lens is a type of lens invented by Augustin-Jean Fresnel. Originally developed for lighthouses, the design enables the construction of lenses of large size and short focal length without the weight and volume of material which would be required in a lens of conventional design.

207.7. **G**

• **GE** is Game Engine.

• **Global Illumination**\(^\text{12}\) (GI) is a superset of radiosity and ray tracing. The goal is to compute all possible light interactions in a given scene, and thus obtain a truly photo-realistic image. All combinations of diffuse and specular reflections and transmissions must be accounted for. Effects such as colour bleeding and caustics must be included in a global illumination simulation.

• **Gouraud shading**\(^\text{13}\) is a method used in computer graphics to simulate the differing effects of light and colour across the surface of an object. In practice, Gouraud shading is used to achieve smooth lighting on low-polygon surfaces without the heavy computational requirements of calculating lighting for each pixel. The technique was first presented by Henri Gouraud in 1971.

207.8. **H**

• **High Dynamic Range Image**\(^\text{14}\) (HDRI) is a set of techniques that allow a far greater dynamic range of exposures than normal digital imaging techniques. The intention is to accurately represent the wide range of intensity levels found in real scenes, ranging from direct sunlight to the deepest shadows. The use of high dynamic range imaging in computer graphics has been popularised by the work of Paul Debevec. Blender uses Yafray for these techniques.

207.9. **I**

• **Index Of Refraction**\(^\text{15}\) (IOR) is about the way that light passes through different types of materials... diamond, glass, water etc. When a light ray travels through the same volume it follows a straight path. However if it passes from one transparent volume to another, it bends. This is why a straw in water looks bent. The amount of bending differs between materials. The angle by which the ray is bent can be determined by knowing two things: the angle at which the incoming ray has been cast and the Index of Refraction. This IOR value is unique for every material. Glass has an IOR of about 1.5


and water 1.3. By increasing the IOR value for a Blender material, you can control how much the environment behind the transparent object is distorted, and thus improving the realism of the shader.

- **Interpolation**\(^{16}\) (IPO) is an animation curve: it indicates how the object must "move" between an initial and a final position, at the rate determined by the rendering engine. Objects can be animated in many ways. They can be animated as Objects, changing their position, orientation or size in time; they can be animated by deforming them; that is animating their vertices or control points; or they can be animated via very complex and flexible interaction with a special kind of object: the Armature.

- **Inverse Kinematics**\(^{17}\) (IK) is the process of determining the movement of interconnected segments of a body or model, starting from the desired motion of the endpoints of the armature. Using ordinary Kinematics on a hierarchically structured object you can for example move the shoulder of a puppet. The upper and lower arm and hand will automatically follow that movement. IK will allow you to move the hand and let the lower and upper arm go along with the movement. Without IK the hand would come off the model and would move independently in space. The Blender Armature System includes Inverse Kinematics. For general armatures there are many possible solutions to the IK.

207.10. J

- **JPEG**\(^{18}\) Acronym for Joint Photographic Expert Group (pronounced jay-peg) is a commonly used standard method of lossy compression for photographic images. The file format which employs this compression is commonly also called JPEG; the most common file extensions for this format are .jpeg, .jfif, .jpg, .JPG, or .JPE although .jpg is the most common on all platforms.

207.11. K

- **Keyframe** is a frame in an animated sequence of frames that was drawn or otherwise constructed directly by the user. When all frames were drawn by animators, the senior artist would draw these frames, leaving the "in between" frames to an apprentice. Now, the animator creates only the first and last frames of a simple sequence; the computer fills in the gap. This is called tweening.

---

\(^{16}\) http://en.wikipedia.org/wiki/Interpolation

\(^{17}\) http://en.wikipedia.org/wiki/Inverse%20kinematics

\(^{18}\) http://en.wikipedia.org/wiki/JPEG
207.12. L

- **Luminosity**\(^{19}\) (more properly called luminance) is the density of luminous intensity in a given direction. In astronomy, luminosity is the amount of energy a body radiates per unit time. It is typically expressed in the SI units watts, in the cgs units ergs per second, or in terms of solar luminosities, \(L_s\); that is, how many times more energy the object radiates than the Sun, whose luminosity is \(3.827 \times 10^{26}\) W.

207.13. M

- **Motion Blur**\(^{20}\) is the simulation of the phenomenon that occurs when we perceive a rapidly moving object. The object appears to be blurred because of our persistence of vision. Doing motion blur makes computer animation appear more realistic. It can be thought of as adding back some of the time dependence expressed in the Rendering Equation.

207.14. N

- **Nabla**\(^{21}\). *Ton wrote:* Almost all procedural textures in Blender use derivatives for calculating normals for texture mapping (with an exception "Blend" and "Magic"). The texture normal, the derivative, is calculated by using four samples in the texture formula:

\[
\begin{align*}
    s_0 &= \text{texture}(x, y, z) \\
    s_1 &= \text{texture}(x+nabla, y, z) \\
    s_2 &= \text{texture}(x, y+nabla, z) \\
    s_3 &= \text{texture}(x, y, z+nabla)
\end{align*}
\]

\[
\begin{align*}
    \text{normal}[0] &= s_0 - s_1 \\
    \text{normal}[1] &= s_0 - s_2 \\
    \text{normal}[2] &= s_0 - s_3
\end{align*}
\]

Up to now, the "nabla" offset was a constant \((0.025)\) which worked fine in most cases, but doesn’t give proper control over the way a texture is sampled, for example to make the effect smoother or sharper. This feature especially is useful in combination with the ColorBand feature.

- **Non-Linear Animation** (NLA) allows the animator to edit motions as a whole, not just the individual keys. Nonlinear animation is not just about editing and manipulating groups of keyframes, but it also allows you to combine, mix, and blend motions to create entirely new animations.

- **Nonuniform Rational B-Splines**\(^{22}\) (NURBS) is a computer graphics technique for generating and representing curves and surfaces.

---

\(^{19}\) [http://en.wikipedia.org/wiki/Luminosity](http://en.wikipedia.org/wiki/Luminosity)

\(^{20}\) [http://en.wikipedia.org/wiki/Motion%20blur](http://en.wikipedia.org/wiki/Motion%20blur)


• **Normal** (Surface Normal) to a flat surface is a three-dimensional vector which is perpendicular to that surface. A normal to a non-flat surface at a point p on the surface is a vector which is perpendicular to the tangent plane to that surface at p.

• **Normal Mapping** is similar to Bump Mapping, but instead of the image being a greyscale heightmap, the colours define in which direction the normal should be shifted, the 3 colour channels being mapped to the 3 directions X, Y and Z. This allows more detail and control over the effect.

207.15. **O**

• **Orange**[^23] is the first Blender open movie project.

• **Oversampling** (OSA), also called **Anti-Aliasing** is the technique of minimizing aliasing when representing a high-resolution signal at a lower resolution. In most cases, anti-aliasing means removing data at too high a frequency to represent. When such data is left in a signal, it causes unpredictable artifacts.

207.16. **P**

• **Phong** shading term is used indiscriminately to describe both an illumination model and an interpolation method in 3D computer graphics. Phong reflection is a local illumination model and can produce a certain degree of realism in three-dimensional objects by combining three elements - diffuse, specular and ambient for each considered point on a surface. It has several assumptions - all lights are points, only surface geometry is considered, only local modelling of diffuse and specular, specular colour is the same as light colour, ambient is a global constant.

• **Point Light** is a light that has a specific location and radiates equally out in all directions. Examples of point lights would be candles or bare lightbulbs. Surfaces close to the point light are brighter than those which are far away. Point lights have attenuation, which controls how quickly the light intensity drops off as you move away from it. Lights with high attenuation are very localized, while lights with low attenuation will spread farther.

• **Polygonization** (of meta-surfaces) is the process of approximating the meta-surface via polygons so it can be displayed/rendered in Blender.

• **Purple** runs as a normal Verse client. It implements a node database to mirror the contents of its host. It loads the plug-ins, which reside in libraries, from local disk as DLLs or shared objects depending on the platform.

[^23]: [http://orange.blender.org](http://orange.blender.org)
207.17. Q

- **Quaternion**\(^{24}\) is a representation of 3D rotations with four numbers. It can be interpreted as an extension of complex numbers to 3D. The interpretation of the four numbers is not very intuitive for a human, but the numerical advantage of quaternions is that it is the smallest mathematical representation that does not suffer from the gimbal lock\(^ {25}\) singularity\(^ {26}\) problem. This problem occurs for example with Euler angle\(^ {27}\) representations, when a small change in the 3D orientation can give rise to a large change in Euler angles.

207.18. R

- **Radiosity** is a more accurate but also more process-intensive technique than raytracing, that calculates patterns of light and shadow for rendering graphics images from three-dimensional models. One of the many different tools which can simulate diffuse lighting in Blender.

- **Raytracing** works by tracing the path taken by a ray of light through the scene, and calculating reflection, refraction, or absorption of the ray whenever it intersects an object in the world. More accurate than Scanline, but much slower.

- **Render**: to generate actual viewable images from a 3D model or scene. This may or may not need to happen in real time; for example an interactive game requires real-time rendering, whereas a feature film does not. These situations require very different rendering techniques.

- **Refraction** in geometric optics is the change in direction of a wave due to a change in velocity. It happens when waves travel from a medium with a given refractive index to a medium with another. At the boundary between the media the wave changes direction; its wavelength increases or decreases but frequency remains constant. For example, a light ray will refract as it enters and leaves glass.

- **Relative Vertex Keys** (RVK) are part of a keyframe animation system that operates on vertex level objects. Each (shape) key is stored as a morph target such that several keys may be blended together to achieve complex mesh animation. With RVK you can create facial expressions, speech, and other detailed animated keyframed movements within your mesh-based models.

- **Rig**: the controls that aid in the manipulation of a digital character.

- **Rigging** is the process by which a person creates constraints and relationships between objects that will generate controls to aid in the manipulation of a digital character.

• **Scanline** is one row of pixels in the final render. Also the term for one of the methods of rendering which Blender can use. It is much faster than Raytracing, but allows fewer effects, such as reflections, refractions, motion blur and focal blur.

• **Seed**: a starting number for generating a random-looking number sequence. Using the same seed will always give you the same sequence. Technically, such a sequence is not truly random, it is only *pseudorandom*.

• **Shader**: an algorithm for computing the appearance of a given material based on the colour, angle and intensity of the light. *Specular* shaders produce a more shiny, mirrorlike finish, while *diffuse* shaders give a duller surface appearance. There are also *toon* shaders, which are deliberately designed to produce an effect more akin to a cartoon drawing, with delineated object borders and less gradation of colours over a surface.

• **Shadows**: simulated lights don’t normally cast shadows. And, they also pass through solid objects - so a light inside a closed box would actually illuminate things outside the box as if the box were transparent. The shading on objects is only calculated based on the angle of the surface.

• **Specular Light** refers to the highlights on reflective objects, like diamonds, billiard balls, and eyes. Specular highlights often appear as bright spots on a surface, at a point where the light source hits it directly. Ambient, Diffuse, and Specular are called the three components of a light source. Each one is given a color, which, when added together, create the final color of a light. For most lights, the main overall color of the light is defined by the Diffuse color. Sunlight or lightbulbs would be white, while moonlight would be a darker blue, and a candle would be yellow. You can use the ambient color to adjust the overall color range of the light source; or, you can get a slight tint to shadows by making the diffuse component yellow and the ambient a slight blue. In many lights, the ambient color is left at black, meaning that it won’t have any effect. Specular components are often left at white, but you can make them different colors to get interesting effects. Most of the time you can completely ignore the specular and diffuse settings on a light, but just be aware that the way you set the color is by specifically setting the diffuse color. The final color that an object appears to be is a combination of the light hitting it and the color of the surface.

• **Spotlight** is a light with both location and direction. A spotlight sends out a cone of light defined by the spotlight angle, and illuminates only objects within that cone. Spotlights also have attenuation, as well as a parameter that controls whether the spot of light is sharply defined or has smooth edges. These 4 types of lights are listed in order of computational complexity; the more lights you have, the more work the computer has to do. Generally it’s a good idea to use directional lights whenever possible, since they’re the cheapest, and use pointlights and spotlights sparingly.

• **Stucci** is one of the classes of blender textures. *Stucci* is not an English word, but is used in Blender as the plural of stucco.\(^{28}\)

• **Subdivision Surface** (Subsurf) is the tool which subdivides your model at render-time, without affecting your mesh at design-time. There are two subsurf algorithms in Blender to choose from - *Simple Subdiv*, which doesn’t affect the shape of your mesh, and is used to add detail to displacement mapping or render-time radiosity, both of which operate on a per-vertex basis. The other is *Catmull-Clark*, a common subdivision algorithm which smooths out curves, and allows you to make complicated smooth surfaces (e.g. people, plants, etc.) with very few faces. However this algorithm can sometimes (read: often) have strange results with meshes containing triangles or vertices with many edges (“poles”), unless it is correctly handled.

• **Sub Surface Scattering** (SSS) is a mechanism of light transport in which light penetrates the surface of a translucent object, is scattered by interacting with the material, and exits the surface at a different point. All non-metallic materials are translucent to some degree. In particular, materials such as marble, skin, and milk are extremely difficult to simulate realistically without taking subsurface scattering into account.

207.20. T

• **Tuhopuu** is an experimental version of Blender that is like a code playground, developers can put their new code in there to be tested and played with by users before it gets put into the official Blender. Tuhopuu is Finnish for "Tree of destruction".

• **Tweening** is short for in-betweening, the process of generating intermediate frames between two images to give the appearance that the first image evolves smoothly into the second image. Tweening is a key process in all types of animation, including computer animation. Sophisticated animation software enables one to identify specific objects in an image and define how they should move and change during the tweening process. Another word for tweening is interpolation\(^29\).

207.21. U

• **UV Mapping** (UV) This refers to the process of re-parameterizing a 3d object with dimensions x, y and z into a 2d plane with coordinates u and v. Most texturing requires this step because it tells the program HOW to apply a 2d image map onto a 3d object. If all your textures must be 2d and flat, the easiest way to determine what pixel goes where is if your model is flattened and made 2d. It also establishes a relationship between a 2d image and the mesh such that if the mesh deforms, the image map will deform along with it. Think of it as skinning a cat and pinning its hide onto cardboard to facilitate painting it!

207.22. V

- **Verse** is a network protocol that lets multiple applications act together as one large application by sharing data over a network. If one application makes a change to shared data, the change is distributed instantly to all the other interested clients.

207.23. W

- **WC** is Weekend Challenge.
- **WIP** is Work In Progress.

207.24. X

207.25. Y

- **Yet Another Free Raytracer (YafRay)** is an open source ray tracing program that uses an XML scene description language. It has been integrated into, and is often used to render scenes made in, Blender.

207.26. Z
208. Frequently Asked Questions
209. Tutorial Links List

This page includes a categorized list of Blender tutorials written or spoken in English. This is by no means a comprehensive list of tutorials, so adding links is encouraged. For tutorials that are not in English, please refer to the About page.

If you would like to learn about editing pages, you can find information in the Introduction to Wikipedia.

209.1. General Blender Information

- Blender Documentation - Includes information on Blender functionality, developing for Blender, and creating Addons.
- To Those Learning 3D - Recommendations for people first diving into Blender.

209.2. Blender Tutorial Websites

This section includes links to websites that host multiple tutorials or provide links to other Blender tutorials. This section does not contain links to individual tutorials.

- BlenderGuru - Run by Andrew Price, BlenderGuru includes free tutorials as well as full training courses.
- Blender Cookie - Part of the CG Cookie Network. Includes many free tutorials. Other tutorials and full courses are available to members with a subscription.
- Dark Scarab Tutorials - Many free tutorials covering various topics in Blender.
- BlendTuts - Free video tutorials on a wide array of topics.
- BlenderDiplom - Free tutorials mostly focused on visual effects, but includes other topics as well.
- Blender Tutor - Includes a series for Blender beginners as well as tutorials for more advanced users.

2. Chapter 209.18 on page 1478
• BlenderArt Magazine\(^\text{12}\) - Blender magazine that includes tutorials in each issue.
• Blenderpedia\(^\text{13}\) - Free video tutorials, mostly about creating scenes and environments.
• 3D Total Blender Tutorials\(^\text{14}\) - Includes many tutorials about various topics in Blender.
• BlenderCourse\(^\text{15}\) - 120 page Blender E-Book created for Blender 2.63
• Tutorials For Blender3d\(^\text{16}\) - Many Blender Game Engine tutorials for Blender 2.6
• Blender Tutorials Vimeo Group\(^\text{17}\) - This group the collects video tutorials posted on Vimeo.
• Blender Underground\(^\text{18}\) - Many downloadable videos that cover the basics of Blender.
• Super3boy’s Blender Tutorials\(^\text{19}\) - Video tutorials dealing with the basics of different aspects of Blender.
• Greybeard’s Blender Video Tutorials\(^\text{20}\) - Downloadable video tutorials that go over many topics.

These sites include links to Blender tutorials on other sites

• BlenderNation Tutorials\(^\text{21}\) - List of tutorials that have been posted on BlenderNation
• Blender3d Club\(^\text{22}\) - Includes links to various Blender tutorials
• SurfnLearn.com : Blender 3D Tutorials\(^\text{23}\) - Links to various Blender Tutorials
• Learningblender.com\(^\text{24}\) - Categorized links to various Blender Tutorials

These sites include tutorials that use Blender versions prior 2.5.

• Dave Jarvis’ Blender Tutorials\(^\text{25}\) - Free tutorials using Blender 2.4x
• Kator Legaz\(^\text{26}\) - List at bottom includes a couple Blender tutorials
• BlenderMasters\(^\text{27}\) - Links to tutorials and some embedded YouTube tutorials. All 2.4x and older.
• Selleri\(^\text{28}\) - Handful of tutorials on a very old version of Blender.
• Cogfilms Tutorials\(^\text{29}\) - PDF downloads of tutorials in 2.4x
• Pavaler.se\(^\text{30}\) - A couple of tutorials on modeling and animation.

---

12 http://blenderart.org/
13 http://www.blenderpedia.com/
14 http://www.3dtotal.com/index_tutorial.php?catDisplay=4
15 http://blendercourse.com/English.aspx
16 http://www.tutorialsforblender3d.com/
17 https://vimeo.com/groups/blendertuts/videos
18 http://blenderunderground.com/video-tutorial-list/
19 http://www.youtube.com/profile_videos?user=super3boy
20 http://www.ibiblio.org/bvtutute/
21 http://www.blendernation.com/category/education/tutorials/
22 http://www.blender3dclub.com
23 http://www.surfnlearn.com/view_tutorials/Blender_3D/All/
24 http://www.learningblender.com
25 http://www.davidjarvis.ca/blender/
26 http://articles.katorlegaz.com/
28 http://www.selleri.org/Blender/
29 http://www.cogfilms.com/tutorials.html
30 http://www.palaver.se/page.php?catid=90
209.3. Blender Interface

- Blender Basics: 2 Minute Tutorials - The Interface
- Blender Interface Theme Repository
- Basic Editing
- Blender Hotkeys
- Changing Views
- First Impression
- Getting Started

209.4. Modeling

209.4.1. Mesh Modeling

- Video - DupliVerts Tutorial
- How to solve Blender’s smoothing problems: discussion about smoothing strategies: Smooth/Solid, Auto Smooth, EdgeSplit modifier...
- Heightmaps
- Extrusion Controlled by IPO
- Basic objects
- Modeling Techniques and Strategies
- Easily Remove Orphan Edges and Vertices
- Non-destructive bevel effect

209.4.2. NURBS and Subsurface Modeling

- Subsurf modeling
- Metaballs
• Abstract SubSurf modeling

209.4.3. Modeling Specific Objects

• Wooden Crate
• Double-Helix
• Turtle
• Leaf Shader
• Sears-Roebuck Dairy Barn
• Golf Ball
• Celtic Knot
• Quick and Easy Tree
• Ice Cube (pdf tutorial)
• Water I (pdf tutorial)
• Water II (pdf tutorial)
• Dice
• Die with round corners
• Logo
• Cutting through steel
• Candle
• Landscape Cartoon (pdf tutorial)
• Text
• Hair Tutorial
• Wikipedia: Human Body Proportions

48 http://www.deviantart.com/view/26691152/
49 https://www.youtube.com/watch?v=eg4xIQxsFak
50 http://www.deviantart.com/view/27132715/
53 http://www.harkyman.com/searsbarn01.html
55 http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_celticknot_en.htm
57 http://caron.yann.free.fr/blender/IceCube.pdf
58 http://www.selleri.org/Blender/tuts/Water.pdf
59 http://www.selleri.org/Blender/tuts/Water2.pdf
60 http://www.blendernation.com/tutorials/blender-3d-beginner-tutorial-a-die/
61 http://www.youtube.com/watch?v=sp53YwtWdfY/
64 http://download.blender.org/documentation/oldsite/oldsite.blender3d.org/93_Blender20tutorial%20Candle.html
65 http://www.selleri.org/Blender/tuts/CartoonishLandscape.pdf
209.5. Texturing

- Video - Basic Materials
- Making a Lightsaber with Halos
- The Unofficial Texturing Tutorial
- Material Indice Tutorial
- Transparency and Refraction
- Reflections
- Texturing landscapes according to slopes
- Using Texture Stencils
- Textures with Alpha
- Textures with Bumpmapping

209.5.1. UV Mapping

- 2 Minute Tutorial: Blender Basics - UV Mapping (Project from View)
- Video - UV Mapping
- UV Mapping & Texturing
- Complex material for a sword

209.5.2. Animated Textures

- Video - Changing Colors Of Objects Mid Animation
- animating masks for simulating ice freeze
- Animated Procedural Textures (pdf tutorial)

60 http://www.youtube.com/watch?v=2kk2BkVQkyk
70 http://blenderartists.org/forum/showthread.php?t=62611
77 http://ww-users.cs.umn.edu/~mein/blender/tutorials/dust/alpha.html
78 http://ww-users.cs.umn.edu/~mein/blender/tutorials/dust/bump.html
79 https://www.youtube.com/watch?v=eg4x1QVxFak
80 http://www.youtube.com/watch?v=mVhhZ2KRr4Q
82 http://www.3dtotal.com/index_tutorial_detailed.php?roPos=1&catDisplay=4&id=665
83 http://www.youtube.com/watch?v=Eljv69HOLR4
85 http://www.cogfilms.com/tutorials.html
209.5.3. Texture Nodes

- Video - Blender Nodes
- Vector Blur usage with Blender

209.5.4. 2D Texture Painting Techniques

These tutorials do not directly involve Blender, however they cover useful 2D knowledge for advanced Blender users.

- Steven Stahlberg’s Tutorials *exposed
  - Fixing Lighting Irregularities in Self-Tiling Maps
  - Texturing with Gimp

209.6. Lighting, Shadows and Rendering

- 2 Minute Tutorials: Blender Basics - An Outline of Lighting and Rendering in Cycles
- Basic 3 Point Lighting
- Radiosity I
- Radiosity II
- Ramp Shaders
- Simulating Radiosity
- Ambient Occlusion
- Soft Shadows and Area Lights
- Soft Lights (pdf tutorial)
- Blender’s Mist

---

86 http://www.youtube.com/watch?v=m1spWQSaw
87 http://feeblemind.tuxfamily.org/blog/index.php?post/2006/11/05/
88 http://www.androidblues.com/howto.html
89 http://www.3drender.com/light/ErnTutorial/tiling.htm
90 http://otothecleaner.free.fr/tutorials/GimpTexture/gimpTexture.htm
91 http://www.youtube.com/watch?v=s1aBGcmiDgU
92 http://www.andrew-whitehurst.net/3point.html
93 http://blenderman.free.fr/tut/radiosity/uk/
94 http://download.blender.org/documentation/html/chapter_rendering_radiosity.html
95 http://www.blender.org/development/release-logs/blender-234/ramp-shaders/
96 http://jmsoler.free.fr/didacticiel/blender/tutor/lumiere_radios_en.htm
100 http://www.users.cs.umn.edu/~mein/blender/tutorials/dust/mist.html
209.7. Compositing

- Matching Real Lighting\(^{101}\)

209.8. Animation

- Video - Animation Basics \(^{102}\)
- Simple Animations\(^{103}\)
- Effects\(^{104}\)
- Walking Blues\(^{105}\)
- Non Linear Action Editor - NLA I\(^{106}\)
- Non Linear Action Editor - NLA II\(^{107}\)

209.8.1. Armatures and IK

- Video - Basic Armatures\(^{108}\)
- Dancing Flor\(^{109}\) * exposed
  - Animation Workshop II\(^{110}\) * exposed
    - Animation recode project\(^{111}\)
    - Action Constraints tutorial made easy\(^{112}\)
    - Driven Hand Rig\(^{113}\)
    - Constrained Mechanics\(^{114}\)
    - Ikas Blender 3D - Introduction\(^{115}\)

209.9. Particles

- Video - Particle Basics\(^{116}\)

---

101 [http://www.andrew-whitehurst.net/fx_light.html](http://www.andrew-whitehurst.net/fx_light.html)
102 [http://www.youtube.com/watch?v=FAZFfLmbD2k](http://www.youtube.com/watch?v=FAZFfLmbD2k)
108 [http://www.youtube.com/watch?v=GbFvrilssNo](http://www.youtube.com/watch?v=GbFvrilssNo)
109 [http://otothecleaner.free.fr/tutorials/Flor/flor.html](http://otothecleaner.free.fr/tutorials/Flor/flor.html)
116 [http://www.youtube.com/watch?v=4ylN9yjCP_4](http://www.youtube.com/watch?v=4ylN9yjCP_4)
Tutorial Links List

- Video - Grass with Particles\(^{117}\)
- Video - Explosions with Particles and the Explode Modifier\(^{118}\)
- Particle Interaction\(^{119}\)
- Static Particles\(^{120}\)
- Making a Rain Effect\(^{121}\)
- Setting a prey-predator relationship using Boids particles\(^{122}\)
- Particle and field basics\(^{123}\)

### 209.10. Fluid Simulation

- Video - Fluid Simulation\(^{124}\)
- Fluid Simulation Basics\(^{125}\)

### 209.11. Game Engine

- Video - Blender Game Engine Basics\(^{126}\)
- Video - Making Dominoes\(^{127}\)
- Game Engine Development\(^{128}\)
- New fully integrated game engine? \(^{129}\)
- [irc://irc.freenode.net/gameblender #GameBlender]\(^{130}\)
- Walkthrough Tutorial\(^{130}\)
- Mouse Look 1st Person. Options include capping, invert mouse pitch and adjust mouse sensitivity.\(^{131}\)
- Viewports. Creating a split screen.\(^{132}\)
- Python game functions. Sample Code Included. Updated to 2.48\(^{133}\)
- Car Setup. Use Bullet Physics vehicle wrapper.\(^{134}\)
- Python scripting for the Game Engine\(^{135}\) at cgmasters.net.

\(^{117}\) [http://youtube.com/watch?v=M9aG0xB19IM]
\(^{118}\) [http://www.youtube.com/watch?v=At3hIc-423c]
\(^{119}\) [http://www.blender.org/development/release-logs/blender-234/particle-interaction/]
\(^{123}\) [http://www.deviantart.com/view/27104504/]
\(^{124}\) [http://au.youtube.com/watch?v=yMBx2pYiqnY]
\(^{125}\) [http://www.deviantart.com/view/27479896/]
\(^{126}\) [http://www.youtube.com/watch?v=WGycLDs_dLg]
\(^{127}\) [http://www.tutorialsforblender3d.com/Game_Engine/MouseLook/MouseLook_First_1.html]
\(^{128}\) [http://www.tutorialsforblender3d.com/Game_Engine/Viewports/Viewport_1.html]
\(^{129}\) [http://www.tutorialsforblender3d.com/Game_Engine/Vehicle/Vehicle_1.html]
\(^{130}\) [http://www.tutorialsforblender3d.com/GameFunctions/GameLogicPage1.html]
\(^{131}\) [http://www.tutorialsforblender3d.com/Game_Engine/MouseLook/MouseLook_First_1.html]
\(^{132}\) [http://www.tutorialsforblender3d.com/Game_Engine/Viewports/Viewport_1.html]
\(^{133}\) [http://www.tutorialsforblender3d.com/GameFunctions/GameLogicPage1.html]
\(^{134}\) [http://www.tutorialsforblender3d.com/Game_Engine/Vehicle/Vehicle_1.html]
\(^{135}\) [http://www.cgmasters.net/free-tutorials/python-scripting/]

1474
• Python scripting series of tutorials

209.12. Python and Plugins

• Povanim Export Script
• AI Path Importer
• 3D-No Plugins; Put your 3D Blender space on web!
• Randomizer Script
• Different Useful Scripts
• Lsystem tree maker
• Python API Introduction
• Python API, Making a Square Mesh
• Python API, Iterations
• Python API, Automating Vertex Creation
• Python API, Automating Face Creation
• Python API, Making Potatooid
• Python Script, To build an Empty for EnvMap
• Python Script, Bezier Curves Import
• Python Script, Paths import
• Python Script, Importing Adobe Illustrator Format
• Python Script, Mesh Explosion
• Python Script, Level Of Detail
• Python Script, Wire Shadows and extrusions
• Python Script, Changing the active camera instantly
• Using the Superficial Scattering Script

136 http://www.youtube.com/goranmilovano
137 http://jmsoler.free.fr/util/blenderfile/fr/povanim_en.htm
138 http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_import_ai_en.htm
139 http://www.thoro.de/portfolio/verschiedenes/3DNP.html
141 http://www.selleri.org/Blender/scripts/text.html
142 http://marief.soler.free.fr/Monsite/lsystem_en.htm
143 http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script00.htm
144 http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script01.htm
145 http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script02.htm
146 http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script03.htm
147 http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script04.htm
148 http://jmsoler.free.fr/didacticiel/blender/tutor/english/python_script05.htm
149 http://jmsoler.free.fr/didacticiel/blender/tutor/english/eng_scriptmirror.htm
150 http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_curvesimport_en.htm
151 http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_paths_import_en.htm
152 http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_import_ai_en.htm
153 http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_meshexplosion_en.htm
154 http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_LDD_en.htm
155 http://jmsoler.free.fr/didacticiel/blender/tutor/python_wireshadows_en.htm
Tutorial Links List

- City Block Generator\textsuperscript{158}
- Blender Camera Calibration with Live Camera\textsuperscript{159}
- Mesh shaker and tutorial\textsuperscript{160}
- Batch STL\textsuperscript{161}
- Vertices to a Curve Converter\textsuperscript{162}
- Zutils, Z-Buffer Utilities\textsuperscript{163}

209.13. Related Programs

- YafRay\textsuperscript{164}
- SPE - Python IDE for Blender\textsuperscript{165}
- Wings 3D Subdivision Modeler\textsuperscript{166}
- Verse Gimp-Blender Plugin\textsuperscript{167}
- Kerkythea Renderer\textsuperscript{168}
- Equinox 3D\textsuperscript{169}
- Povray export\textsuperscript{170}
- Adobe Illustrator Paths import\textsuperscript{171}
- Inkscape SVG import\textsuperscript{172}
- Voodoo Camera Tracker\textsuperscript{173}
- Lionhead The Movies\textsuperscript{174}

209.13.1. Distributed Computing

- BURP - Big and Ugly Rendering Project\textsuperscript{175}
- Global Rendering-Farm\textsuperscript{176}

\textsuperscript{160} http://saltshaker.sourceforge.net/
\textsuperscript{161} http://blender.formworks.co.nz/index.pl?p=2z/batch_stl.html
\textsuperscript{164} http://www.yafray.org
\textsuperscript{165} http://pythonide.stani.be
\textsuperscript{166} http://www.wings3d.com/
\textsuperscript{167} http://users.pandora.be/blendix/verse/old/demo.html
\textsuperscript{168} http://www.kerkythea.net
\textsuperscript{169} http://www.equinox3d.com
\textsuperscript{170} http://jmsoler.free.fr/util/blenderfile/fr/povanim_en.htm
\textsuperscript{171} http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_import_ai_en.htm
\textsuperscript{172} http://jmsoler.free.fr/didacticiel/blender/tutor/cpl_import_svg_en.htm
\textsuperscript{173} http://www.digilab.uni-hannover.de/docs/manual.html
\textsuperscript{174} http://www.dmmodding.com/main/index.php?option=com_smf&Itemid=79&topic=180.0
\textsuperscript{175} http://burp.boinc.dk/
\textsuperscript{176} http://renderworld.futureware.at/

- Blender 3D: Blending Into Python\textsuperscript{177}
- Blender 3D: HotKeys\textsuperscript{178}
- Blender 3D: Import and Render a SolidWorks Model\textsuperscript{179}
- Blender 3D: MemoBook\textsuperscript{180} * exposed
  - Blender 3D: Noob to Pro\textsuperscript{181}

209.15. FAQ

- Blender FAQ\textsuperscript{182} (Generated on September 24, 2001)

209.16. Miscellaneous

These are must reads for CG artists.

- How to succeed in Animation\textsuperscript{183}
- Classical Film and Video Knowledge Base\textsuperscript{184}
- Quick Tips in Design&GFX\textsuperscript{185}

209.16.1. Open Movies

- NaNo - Blender Internet Virtual Movie Studio\textsuperscript{186}

209.16.2. IRC

- irc://irc.freenode.net/blender
- irc://irc.freenode.net/blenderchat
- irc://irc.freenode.net/blenderclasses
- irc://irc.freenode.net/blenderqa
- irc://irc.freenode.net/blendercoders
- irc://irc.freenode.net/blenderwiki
- irc://irc.freenode.net/gameblenderdev
- irc://irc.freenode.net/gameblender

\textsuperscript{177} http://en.wikibooks.org/wiki/Blender%203D%3A%20Blending%20Into%20Python
\textsuperscript{178} http://en.wikibooks.org/wiki/Blender%203D%3A%20HotKeys
\textsuperscript{179} http://en.wikibooks.org/wiki/Blender%203D%3A%20Import%20and%20Render%20a%20SolidWorks%20Model
\textsuperscript{180} http://en.wikibooks.org/wiki/Blender%203D%3A%20MemoBook
\textsuperscript{181} http://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro
\textsuperscript{182} http://www.museum.state.il.us/ismdepts/library/linuxguides/blender/blender_faq_0.html
\textsuperscript{183} http://genedeitch.awn.com/
\textsuperscript{184} http://www.rondexter.com/
\textsuperscript{185} http://www.atpm.com/9.07/design.shtml
\textsuperscript{186} http://nano.prods.free.fr/
• irc://irc.freenode.net/verse

209.16.3. Tests

• Blender Benchmarks\textsuperscript{187}

209.17. Other Lists

Please read more about on talk\textsuperscript{188} page.

• LANGUAGES (czech) \textsuperscript{189}

209.18. About

This links list is language filtered and extended version of personal collection originally provided by IamInnocent. So if you looking for tutorials in other languages check this link at www.elysiun.com\textsuperscript{190}.

• German Blenders should have a look at http://de.wikibooks.org/wiki/Blender_3D:_Tutorial_Linkliste

If you want to add Blender tutorial link in some other language you can add it temporary on talk\textsuperscript{191} page. We will later made such WikiBooks in other languages too.

Thank you all who contributed to this nice and useful links collection! Feel free to add your name or link if you think you need to be mentioned here.

\textsuperscript{187} http://www.eofw.org/index.php
\textsuperscript{188} http://en.wikibooks.org/wiki/Talk%3ABlender%203D%3A%20Tutorial%20Links%20List
\textsuperscript{189} http://www.youtube.com/watch?v=fsHW7J9dTNE
\textsuperscript{190} http://www.elysiun.com/forum/viewtopic.php?t=13380
\textsuperscript{191} http://en.wikibooks.org/wiki/Talk%3ABlender%203D%3A%20Tutorial%20Links%20List
210. Hotkeys

Blender’s user interface is very flexible and often provides more than one way to do something. Many operations that can be done by clicking on buttons and menus can also be done with keyboard shortcuts called "hotkeys". The hotkey is usually much faster than the corresponding mouse action, so it’s a good idea to learn them as soon as possible.

An entire WikiBook (titled Blender 3D: HotKeys¹) is devoted to Blender hotkeys. We encourage you to refer to it as often as necessary.

¹ http://en.wikibooks.org/wiki/Blender%203D%3A%20HotKeys
211. Output Formats

Blender can render still images and video to many different file formats. Here is an alphabetical list:

- **AVI Codec** - AVI codec compression. Available codecs are operating system dependent. When an AVI codec is initially chosen, the codec dialog is automatically launched. The codec can be changed directly using the Set Codec button in AVI Codec settings.

- **AVI Jpeg** - AVI but with Jpeg compression. Lossy, smaller files but not as small as you can get with a Codec compression algorithm. Jpeg compression is also the one used in the DV format used in many digital camcorders.

- **AVI Raw** - Audio-Video Interlaced (AVI) uncompressed frames.

- **BMP** - Bit-Mapped Paint is an early lossless format.

- **Cineon** - format produced by a Kodak Cineon camera and used in high-end graphics software and directed toward digital film.

- **DPX** - Digital Moving-Picture eXchange format; an open professional format (close to Cineon) with meta-information about the picture; 16-bit uncompressed bitmap (huge file size). Used in preservation.

- **FFMPEG** - Fast Forward Moving Pictures Expert Group is a collection of free and open source software libraries that record, convert and stream digital audio and video in numerous formats. You must have the proper codec installed on your computer for Blender to call it and use it to compress the video stream through FFMPEG, but there are preset formats to choose from, such as DV, SVCD, and DVD.

- **Frameserver** - Blender puts out frames upon request as part of a render farm. The port number is specified in the OpenGL User Preferences panel.

- **HamX** - Blender's own self-developed 8 bits RLE (Run Length Encoded bitmap) format; it creates extremely compact files that can be displayed quickly. To be used only for previsualization of animations (Play button).

- **Iris** - the standard Silicon Graphics Inc (SGI) format used on Unix OS machines.

- **JPEG** - Joint Photographic Experts Group (name of the consortium which defined it), an open format that supports very good compression with little loss of quality. Only saves RGB value. Re-saving images results in more and more compression and loss of quality.

- **JPEG 2000**

- **MultiLayer** - an OpenEXR format that supports storing multiple layers of images together in one file. Each layer stores a renderpass, such as shadow, specularity, color, etc. You can specify the encoding used to save the MultiLayer file using the codec selector (ZIP (lossless) is shown and used by default).

- **OpenEXR** - an open and non-proprietary extended and highly dynamic range (HDR) image format, saving both Alpha and Z-depth buffer information.

- **PNG** - Portable Network Graphics, a lossless image format often used in web design.

- **QuickTime** - A proprietary multimedia framework for video and images.
• Radiance HDR
• Targa
• Targa Raw
• TIFF - Tagged Image File Format created by Aldus for desktop publishing.

If the selection seems daunting, here are pointers:

If you need transparency in your images (i.e., an alpha channel that allows any part of the rendered image to have varying degrees of opacity), or you will be compositing, you generally want to use:

• Multilayer
• PNG
• OpenEXR
• Targa

Of the above four formats, you will find that PNG and Targa images can be opened and edited by most any bitmap editing application, such as GIMP or Photoshop. However, OpenEXR and Multilayer offer more options within Blender, and may produce smaller, lossless files.
212. Image Portfolio

212.1. Summary

This is the Blender 3D: Noob to Pro\(^1\) image portfolio page, where all the categories of the images used in the book are here in one place for your reference.

212.2. Categories

Blender 3D\(^2\)
Blender 3D icons\(^3\)
Blender 3D screenshots\(^4\)
Non Blender 3D screenshots\(^5\)
Blender 3D splash screens\(^6\)
Blender 3D viewports\(^7\)
Blender 3D suzanne primitive\(^8\)

212.3. A sampling of images from the above categories

Here's a random sample of 200 images from the over 1,800 images in the above categories

\(^1\) http://en.wikibooks.org/wiki/Blender%203D%3A%20Noob%20to%20Pro
\(^2\) http://en.commons.org/wiki/Category%3ABlender%203D
\(^3\) http://en.commons.org/wiki/Category%3ABlender%203D%20icons
\(^4\) http://en.commons.org/wiki/Category%3ABlender%203D%20screenshots
\(^5\) http://en.commons.org/wiki/Category%3ANon%20Blender%203D%20screenshots
\(^6\) http://en.commons.org/wiki/Category%3ABlender%203D%20splash%20screens
\(^7\) http://en.commons.org/wiki/Category%3ABlender%203D%20viewports
\(^8\) http://en.commons.org/wiki/Category%3ABlender%203D%20suzanne%20primitive
Figure 1156

Figure 1157

Figure 1158

Figure 1159

Figure 1160
A sampling of images from the above categories

Figure 1161

Figure 1162

Figure 1163

Figure 1164
A sampling of images from the above categories

Figure 1169

Figure 1170

Figure 1171

Figure 1172

Figure 1173
Figure 1174

Figure 1175

Figure 1176
A sampling of images from the above categories

Figure 1177

Figure 1178
Asampling of images from the above categories

Figure 1185

Figure 1186

Figure 1187

Figure 1188

Figure 1189
Figure 1190

Figure 1191

Figure 1192

Figure 1193

Figure 1194
A sampling of images from the above categories

Figure 1195

Figure 1196

Figure 1197

Figure 1198

Figure 1199
A sampling of images from the above categories

Figure 1205

Figure 1206

Figure 1208
A sampling of images from the above categories

Figure 1214

Figure 1215

Figure 1216

Figure 1217

Figure 1218
Figure 1219

Figure 1220

Figure 1221

Figure 1222

Figure 1223

1498
A sampling of images from the above categories

Figure 1224

Figure 1225

Figure 1226

Figure 1227

Figure 1228

Figure 1229
Figure 1230

Figure 1231

Figure 1232

Figure 1233

Figure 1234
A sampling of images from the above categories

Figure 1235

Figure 1236

Figure 1237

Figure 1238

Figure 1239
Image Portfolio

Figure 1240

Figure 1241

Figure 1242

Figure 1243
A sampling of images from the above categories

Figure 1244

Figure 1245

Figure 1246

Figure 1247

Figure 1248
A sampling of images from the above categories

Figure 1254

Figure 1255

Figure 1256

Figure 1257

Figure 1258
Figure 1259

Figure 1260

Figure 1261

Figure 1262
A sampling of images from the above categories

Figure 1263

Figure 1264

Figure 1265

Figure 1266

Figure 1267
A sampling of images from the above categories

Figure 1273

Figure 1274

Figure 1275
A sampling of images from the above categories

Figure 1283

Figure 1284

Figure 1285
Figure 1286

Figure 1287

Figure 1288

Figure 1289
A sampling of images from the above categories

Figure 1290

Figure 1291

Figure 1292

Figure 1293

Figure 1294
Figure 1295

Figure 1296

Figure 1299
A sampling of images from the above categories

Figure 1300

Figure 1301

Figure 1302

Figure 1303
Figure 1304

Figure 1305

Figure 1306

Figure 1307
A sampling of images from the above categories.

Figure 1311

Figure 1312

Figure 1313
Figure 1314

Figure 1315

Figure 1316

Figure 1317
A sampling of images from the above categories

Figure 1318

Figure 1319

Figure 1320

Figure 1321

Figure 1322
Figure 1323

Figure 1324

Figure 1325

Figure 1326
Figure 1329

Figure 1330

Figure 1331

Figure 1332
A sampling of images from the above categories

Figure 1338

Figure 1339

Figure 1340

Figure 1341

Figure 1342
Figure 1346

Figure 1347
A sampling of images from the above categories

Figure 1349

Figure 1350

Figure 1351
Figure 1352

Image Portfolio

http://en.wikibooks.org/wiki/Category%3ABlender%203D%3A%20Noob%20to%20Pro%20Project
213. Blender Glossary

Please add words and phrases to the alphabetical glossary at Blender 3D: Noob to Pro/Glossary.

213.0.1. General Terminology

- **2D** (adjective): two-dimensional (flat)
- **3D** (adjective): three-dimensional
- **axis** (noun): one of the primary directions used to define a coordinate system; plural: axes
- **coordinates** (noun): a string of numbers (usually two or three) which denote a location
- **coordinate system**: a scheme for denoting locations by means of coordinates
- **disappearing taskbar**: a taskbar which appears only when the mouse pointer reaches an edge of the display
- **geometry**:
  1. the branch of mathematics concerned with positions, directions, angles, lengths, areas, volumes, and so on
  2. the portion of a 3D model that deals with shapes
- **GIMP**: an open-source software tool for editing 2D computer graphics
- **illusion of depth**: the human propensity to imagine a 3D scene when presented with a flat (2D) picture of it
- **light** (verb): to describe the intensity, color, direction, etc. of the light sources in a 3D scene
- **model** (noun): an abstract description of a 3D object (or scene) which is suitable for rendering
- **model** (verb): to create models
- **numpad**: a numeric keypad
- **orthographic view**: a 2D view which represents a scene’s parallel edges with parallel edges; contrast with: perspective view
- **perpendicular** (adjective): forming a 90-degree (right) angle
- **perspective view**: a 2D view which represents a scene’s parallel edges with edges that converge toward a vanishing point
- **pose** (verb): to position objects and their parts in a 3D scene
- **render** (verb): to generate a 2D view from a 3D model of a scene, by means of a computer
- **rig** (noun): to describe how different parts of an object are capable of moving relative to one another
- **texture** (verb): to describe how a 3D object interacts with light (scattering, bending, etc.)

---

1 Chapter 207 on page 1453
213.0.2. Blender User Interface Terminology

- **active window**: the window currently responding to keystrokes
- **blender unit**: the height and width of each grid square in a 3D View window
- **header**: a row of controls along the top or bottom of a window
- **panel**: a rectangular area in a Buttons window which can be rearranged relative to other panels
- **window** (noun): a rectangular area of Blender’s user-interface which can be split or resized
- **window type** (noun): one of the sixteen varieties of windows in Blender’s user interface:
  - **Scripts Browser**: This window is used to initiate any Python\(^2\) scripts saved in Blender to add functionality.
  - **File Browser**: Browsers the files on your computer in Blender.
  - **Image Browser**: Browsers the files on your computer in Blender with visuals of images displayed.
  - **Node Editor**: The enhanced material editing system in Blender in which you can customize the input/output of materials or scenes and composite them together.
  - **Buttons Window**: Displays the Blender scene and object editing options.
  - **Outlines**: Breaks down the entire collection of objects and their properties in an organized list.
  - **User Preferences**: Allows you to change Blender’s controls and preferences.
  - **Text Editor**: Simple text editor for any notes/Python code.
  - **Audio Window**: Allows you to upload, enhance, and save audio files into the Blender library.
  - **Timeline**: Shows the animation’s beginning, ending, and current frame, as well as a timeline with marks indicating all the key positions of an object.
  - **Video Sequence Editor**: Feature for the composition of sound, scenes, videos and other cinematographic elements.
  - **UV/Image Editor**: Allows you to add and alter image files in Blender and also apply these images onto the faces of meshes in an editable fashion as a material.
  - **NLA Editor**: Allows you to change the key positions of all actions/IPOs.
  - **Action Editor**: Allows you to alter the key positions of an armature and it’s collection of bones.
  - **IPO Curve Editor**: Allows you to insert saved key points of the positions, transformations, and settings of objects of the course of a series of frames.
  - **3D View**: Window through which you work with, add, and place objects in a 3D world.

213.0.3. Blender Modeling Terminology

- **Quad** \(^{n.}\): A face with four sides.
- **Mesh** \(^{n.}\): A collection of faces, edges, and vertices which can be modeled and manipulated in Edit Mode.

\(^2\) [http://en.wikibooks.org/wiki/Python](http://en.wikibooks.org/wiki/Python)
• **Vertex** *(pl. vertices)* *n.* - A 3-dimensional coordinate, which in groups comprise a polygon. With default settings, it is represented in Blender by a purple dot when unselected, or a yellow dot when selected.

• **Edge** *n.* - A wire-like line representing the boundary of 2 adjacent vertices.

• **Face** *n.* - A planar connection of edges representing a boundary, field, or solid surface. Identified individually in Edit Mode as a black box in the middle of the corresponding face.

• **Icosphere** *n.* - A sphere composed of $n$ triangular faces composed in a manner to give the best "smoothness" for the lowest memory consumption.

• **UVSphere** *n.* - A sphere composed of $n$ square faces arranged in rings to allow the smoothest application of real-time movement of vertices/faces and application of images onto the spectrum of faces.

• **Lamps** - Category of 5 light-emitting objects:
  - Lamp - Light is emitted in the scene with a uniform spherical output which fades with distance, decreasing eventually to 0. The distance can be specified in its options.
  - Sun - Light is emitted in the scene with a uniform spherical output and remains uniform regardless of the distance from it.
  - Spot - Light is emitted in the scene in a predetermined conical area with light properties similar to lamp and also initially calculates the shadow (lack of light) present behind an object (Known as ray shadow).
  - Hemi - Sun-like light emitted in a 180 degree arc. Works just like a Sun lamp, but with less functionality. Best used for quick, broad illumination.
  - Area - Light which works similar to a Spot lamp but shape of the cone is definable.

• **Ray shadows** *n.* - Method of generating shadows cast by light by calculating the angle and faces of the interfering object to create a smooth, sharp and complete shadow. Memory-intensive, best quality.

• **Buffer Shadows** *n.* - Method of generating shadows cast by light by calculating the angle of a mesh’s edge and creating a set amount of shadow "squares" on the shadow-receiving objects which are calculated from a set buffer-ratio. Memory-friendly, while possibly lower quality.

• **Camera** *n.* - An object which acts as the viewpoint (when active) for the scene when the scene is to be rendered.

• **Armature** *n.* - An object which contains 'bones'. Bones are sub-objects which are connected with each other in a chain, each bone-link is parented to the bone before it. The purpose is to parent any objects to the bone, and also you may parent a mesh to the entire armature and have selected vertices of the mesh parented to bone(s) percentage-wise (0% means no effect, 50% means vertices copy half the transformation value, 100% means vertices transformed as full child of bone.)

• **Empty** *n.* - An object with no mesh or relating object data. It is useful for using in object input fields where the object needs no specific properties e.g. parenting it to an object for organisational purposes.
214. Materials Directory: Every Material Known To Man
215. Sources of free 3D models

Here are some sources of free 3d models from across the web. Take them apart, put them back together, understand what makes them tick, to improve your own modeling.

215.1. Blender-Specific

These sites offer .blend files for download.

- The Official Blender Model Repository
- Blender for Architecture
- http://opengameart.org — more Blender models
- http://katorlegaz.com/3d_models/index.php -- they have furniture, arcade video games, joysticks, toys, vehicles, road and sidewalk items, and simple human models
- Yorik’s site — some Blender files for his architectural projects are available for download.

215.1.1. Sites Requiring Registration


215.2. Non-Blender-Specific

These sites offer models in other formats.

- http://archive3d.net - 15,000+ free models from archive 3d

This seems to have some licensed models and might be legal trouble see Discussion at http://blenderartists.org/forum/archive/index.php/t-237569.html

- http://sketchup.google.com/3dwarehouse/ - Google’s 3d warehouse repository; take the collada version, when available (the Google Earth downloads are actually .zip files with a collada inside them, so just rename and unzip)

Note: some of the 3d warehouse models can’t be understood by blender due to a zillion repeating elements, others will show up invisible (one sided, or inside out), be gigantic in size, or all parented to some crazy spot out in space. Fixing these to be usable will push your blender skills to new levels in some cases.

1 http://www.blender-models.com/
2 http://blender-archi.tuxfamily.org/Models
3 http://yorik.uncreated.net/
Sources of free 3D models

**Tips:** I’ve tried importing a few of these 3D Warehouse models, and so far I’ve only noticed a couple of issues:

- The model imports into a new Blender scene, called something like “SketchupScene” or “SketchupScene001”. You may also find additional scenes created with nothing in them, that you can delete. If you try rendering, you may not see anything, because the default camera is only linked into the original default scene named “Scene”. Just select the camera and hit `CTRL+LKEY` to link it into the new scene.
- You may notice parts of the model appearing and disappearing as you try viewing it from different angles. This is because it is scaled very large (several hundred Blender Units on a side). Try scaling it down so it’s no more than a few BU on a side.
- There will usually be a lot of doubles, so remove them with `WKEY` -> remove doubles.
- There may be many separate objects, so select what you want to combine and hit `CTRL+J` to join them all into one object.

- [https://www.yobi3d.com](https://www.yobi3d.com) - 3D model search engine with previews in 3D
- [http://free3dbase.com](http://free3dbase.com) - furniture models without registering
- [http://artist-3d.com](http://artist-3d.com) - wide variety of free models
- [http://nasa3d.arc.nasa.gov](http://nasa3d.arc.nasa.gov) - all kinds of free models from the space program
- [http://www.3dm3.com/modelsbank/](http://www.3dm3.com/modelsbank/) - around 300 free models
- [http://www.amazing3d.com/free/free.html](http://www.amazing3d.com/free/free.html) - free section on amazing 3d about 75 models of all kinds of things.
- [http://www.corporatemedianews.com/2002/03_mar/features/3dmodellibrary.htm](http://www.corporatemedianews.com/2002/03_mar/features/3dmodellibrary.htm) - free models from corporate media news; a very interesting collection from klingon space ships to footballs.
- [http://www.3plants.0catch.com/download.html](http://www.3plants.0catch.com/download.html) - about 70 free 3d plant models
- [http://www.3delicious.net](http://www.3delicious.net) - 3d delicious, lots of models, but way too many popover ads! (click the picture, then click the bigger preview in the next page to download)
- [http://www.top3dmodels.com/products/3d-models/free](http://www.top3dmodels.com/products/3d-models/free) - 20 free models
- [http://www.top3d.net/free-3d-models/](http://www.top3d.net/free-3d-models/) - about 85 models, including washing machines, tires, and jewelry
- [http://dmi3d.comeze.com](http://dmi3d.comeze.com) - a few hundred free models of cars, race cars, trucks, tanks, backhoes, etc.
- [http://www.scifi3d.com/list.asp?intGenreID=14&intCatID=36](http://www.scifi3d.com/list.asp?intGenreID=14&intCatID=36) - free models of scifi empires like, Aliens, Babylon5, Blade Runner, BS Galactica, Original SciFi, Other SciFi, Star Trek, Star Wars
- [resources.blogscopia.com](http://resources.blogscopia.com) - models in Blender and other formats.
- [http://www.hobbycncart.com/](http://www.hobbycncart.com/) - Free relief models (all models are free) in .STL .OBJ and depth map (.BMP) formats.
- [http://www.craftsmanspace.com/free-3d-models](http://www.craftsmanspace.com/free-3d-models) - Free 3D models (Creative common licenses) in .STEP, .IGES, .STL .OBJ and .BLEND formats.
- [http://tf3dm.com](http://tf3dm.com) — models in various common formats, including some in .blend; can be downloaded without registration (subject to slight delay). However, most seem to be under “personal use only” or “non-commercial use” licences.

---

4 [http://resources.blogscopia.com/category/models/](http://resources.blogscopia.com/category/models/)
215.2.1. Sites Using .RAR Format

Separated out because they may not be decodable with Free Software.

- http://www.3dmodelfree.com/ - 3d model free, lots of variety here
- http://dlegend.com/html/free-3dmodels.html - design company with a few hundred free 3d models
- http://3ddb.blogspot.com/search/label/Models - lots of free luxury style models in sets (has a giant picture at the top, just scroll down).

215.2.2. Sites Requiring Registration

- http://www.turbosquid.com/Search/Index.cfm?keyword=&max_price=0 - 13,000+ free models at 3d stock site turbosquid (registration required for download)
- http://www.3dxtras.com/3dxtras-free-3d-models-list.asp?catid=-1 - 3d extras, lots of variety, but too many popover ads.
- http://dd-freebies.blogspot.com/search/label/3D%20models - a few baubles and ornaments
- http://www.exchange3d.com/free-3d-models/cat_35.html?noredirect=1&act=viewCat&catId=35 - about 100 free models, some even made in blender!
- http://www.sharecg.com/b/5/3D-Models?PSID=e3aa02d1ef780c432e9f9d7e95409369 - wide assortment of free models
- http://www.cg-files.com/3dmodels.html - from tires to fans (lots of popover ads)
This page contains links to 2D images and drawings that can be useful for constructing models.

- http://www.shipschematics.net - Starship Schematics Database
- http://www.luft46.com/profiles/profiles.html - 3 views
- http://www.aviastar.org/index2.html - 3 views
- http://www.rcgroups.com/forums/showthread.php?t=557457 - 3 views on a lot lot lot of airplanes
- http://www.mgussin.freeuk.com/00Plans.htm - old cars
- http://www.airwar.ru/other/draw_1w.html - War Planes
- http://jpracing.racerplanet.com/ - Cars, Trucks, Buses
- http://www.newhomesource.com — site run by builders, but low-res plans are viewable online

216.1. Registration Required

- http://www.the-blueprints.com/ — requires registration for full-quality downloads
- http://smcars.net/

216.2. Payment Required

- http://www.monsterhouseplans.com/ - source of over 23,000 floor plans
- http://www.eplans.com/ - floor plans, but if you navigate around a bit to find em.
- http://www.emporis.com/application/ - heights and details of buildings; photos available for purchase
- http://skyscraperpage.com/ - building heights, diagrams, but downloads and screenshots are prohibited

216.3. Shouldn’t Really Be Here?

- http://www.archiplanet.org/wiki/Main_Page - building encyclopedia, can’t find any actual plans
217. Materials, Textures, Photos

Here are some sources of materials, textures and photos from across the Web.

217.0.1. Materials

- Large Free Repository of Materials

217.0.2. Textures

- Textures Library
- Mayang’s Free Textures Hi-Res
- Jeremy Engleman’s Public Textures Hi-Res (doesn’t seem to display properly)
- Image*After Free Images Hi-Res
- Free Textures Mid-Res
- Sky Maps
- CG Textures
- Texture Labs

217.0.3. Photos

- http://www.med.harvard.edu/AANLIB/cases/caseNA/pb9.htm - Brain scan
- http://www.morguefile.com - the morgue file
- http://www.sxc.hu - Stock exchange
- http://www.everystockphoto.com everystockphoto
- http://www.imageafter.com - Image*After
- http://www.aboutpixel.de - aboutpixel.de
- http://www.freephotosweb.com/freephotosweb - Free Photos Web
- http://www.bigfoto.com - Big Foto

---

1 http://matrep.parastudios.de/index.php
2 http://textures.z7server.com/
3 http://www.mayang.com/textures/index.htm
4 http://www.art.net/~jeremy/photo/public_texture_frameset.html
5 http://www.imageafter.com/
6 http://digitalcraftsman.com/textures/textures.htm
8 http://cgtextures.com/
9 http://texturelabs.org/
• http://www.freephotosbank.com - FreePhotosBank.com
• http://www.freejpg.com.ar - FreeJPG
• http://www.stockvault.net - Stockvault.net
• http://www.freepixels.com - FreePixels
• http://www.freerangestock.com - Freerange Stock
• http://pixabay.com/ — requires registration
Part VII.

Advice
218. Asking for Help

So you’ve come to learn Blender, eh? You’ve made a great choice. Blender is one of the most powerful 3D animation and 3D creation tools out there, especially if you’re short on cash. Learning how to use Blender can be a daunting task, so don’t give up! With the help of this wikibook, you can become a Blender power user and put those Maya folks to shame.

If you ever get stuck in a tutorial for some reason, there are a number of places you can turn for help. The best way to get help is with an Internet Relay Chat (IRC) client such as X-Chat1. Connect to irc.freenode.net and talk to blender users in the following channels.

- [irc://irc.freenode.net/blenderwiki #blenderwiki]
- [irc://irc.freenode.net/blender #blender]
- [irc://irc.freenode.net/blenderchat #blenderchat]
- [irc://irc.freenode.net/blenderqa #blenderqa]
- [irc://irc.freenode.net/gameblender #gameblender]

If you can’t get help there, click the “discussion” tab at the top of the page that you’re having trouble with, and explain your problem on that page. Wait at least 24 hours for help.

If you’re still not getting help, try asking for help in the BlenderArtists.org forums2.

es:Blender 3D: novato a profesional/Clases particulares de principiante3

---

1 http://xchat.org
2 http://blenderartists.org/forum
3 http://es.wikibooks.org/wiki/Blender%203D%20novato%20profesional%20Clases%20particulares
219. Tips for a Successful Project

The following tips may improve your chances of enjoying a successful project with Blender.

219.0.4. Organize early, organize thoroughly

In Blender projects, you may work with complex scenes containing hundreds of items: models, lights, cameras, scripts, materials, and more. This can be overwhelming if it is not properly organized.

We suggest that you organize as you go, giving each item a descriptive name. There will be ways to search for items by name, so start early. Similarly, give each file a descriptive name and organize files into folders (or directories): a separate folder for each project, with sub-folders for renders, texture images, background images, and so on.

219.0.5. Don’t bite off more than you can chew

One of the greatest challenges faced by Blender users is their own imagination. While it’s great to be creative and imaginative, you have to pace yourself. Be aware of your limits and the limits of your computer.

When making something from scratch, start with a very simple version of it and add details gradually.

Test frequently; see how well your recent changes work before proceeding to the next step. In this way, you will meet with fewer problems, and the ones you do run into will be simpler and easier to fix because there will be fewer possible causes to consider.

Monitor the complexity of your projects, watching for ”lag” or excessive disk activity which might mean you are nearing your computer’s limits.

When working on the computer, take frequent breaks to rest your eyes and stretch your muscles. Eat, sleep and exercise regularly. While focused time at the computer is necessary, inspiration and solutions to problems often come when our bodies are relaxed and our mental focus is elsewhere. While you may be tempted to go wild, keeping a level head while swimming in your imagination will give you a much more satisfying result with fewer headaches along the way.
220. Modeling Realistically

Everyone who starts a new career or hobby in 3D Modeling also seems to look around their immediate environment for things to model. Things like your computer monitor, your keyboard, and even the desktop which they are resting are all common "first models." Developing an eye for geometry takes time and this is a great chance to practice.

For this tips and techniques discussion, I’ll start with the concepts of furniture and walls, but the ideas really extend to anything and everything you can model in Blender, from spaceships to fantasy demon-women, from your barbecue deck blueprints to biologically accurate squids.

220.1. Assemble Things, Don’t Chisel Them

Let’s start with the furniture around you.

You may think it’s easy to model your desk using a couple of boolean operations on cubes. But it rarely comes out looking quite right. It seems like such a good idea at first. Then you find that the drawers won’t open realistically. The corners are all amazingly sharp and crisp. The writing surface seems to be at the wrong scale for thickness. The woodgrain goes in the same direction everywhere. You then realize it will be hard to bevel just the few edges that need beveling. The more you look at it, even with good render settings, the more it looks like dollhouse furniture instead of a real life, full sized desk.

Real furniture is not chiseled out of a half-ton cube of mahogany, because trees don’t grow that thick, and it’s a real waste to chip out the spaces for drawers. Instead, cabinetmakers tend to assemble a piece of furniture from many component parts. Think of those "self-assembly" kits from the local superstore, or even the showroom examples from a nearby unfinished knotty pine store.

Model several kinds of boards and fittings, then copy and assemble them appropriately. You don’t need to model every nail and dowel, and you don’t even need to know what a dovetail joint\(^1\) is. But you can make realistic furniture when you build things from their natural components.

• Cut lumber in a variety of sizes and thicknesses.
• Measure real example furniture and take note of the construction details.
• Choose varying woodgrains by duplicating materials and adjusting them to be more individual.
• Align those woodgrains or other materials in an appropriate direction and scale for the model.

\(^1\) http://en.wikipedia.org/wiki/dovetail%20joint
• Bevel just the parts or edges which are naturally worn or intentionally beveled.
• Any cloth, glass or metal fittings are separate components using their own materials.
• Create an "Empty" type object, give it a descriptive name, and parent all of the pieces to it.

There are a couple more benefits to this form of component modeling:
• Working with things made from multiple real materials is easier: one object, one material.
• The model is more flexible, because they can be reconfigured to other styles more easily.
• Components come in handy for other models: adapt a desk’s drawers in kitchen cabinets and bedroom furniture.

220.2. Separate Objects for each Material

Figure 1353  skateboards, modeled in parts

A common question for new modelers is how to make one mesh that uses more than one material. For example, a skateboard with metal trucks, rubber tires, and a wooden deck. While Blender does provide an interface to allow such a combination, it is not usually the best approach for modeling realistically.

If you model the skateboard as separate parts, based on the way different real parts are assembled, then you have a lot more control over the final model. You can replace the wheels or use trucks of different styles later. You can adjust the mesh that defines the shape of the deck, without having to re-assign the areas that should be one material or the other. And lastly, you can choose to use subsurface tricks on the various parts, while avoiding them on other parts. Even if the whole model needs subsurfaces, it becomes a bit hard to control where one material starts, and another material ends.
220.3. Removing the Fourth Wall

Just as with furniture, you may model your first building interior as a hollowed-out cube. It seems straightforward to make a big cube, turn it inside out, and call it a living room. There are a lot of drawbacks to working with a room that was carved out of a single chunk of solid rock.

Buildings and rooms are assembled from parts. Just like the furniture modeling tip, design your rooms as a collection of separate pieces.

- You don’t need to measure out the internal beams and joists, but remember they’re there.
- Each interior or exterior wall should be its own object or assembly.
- Take care to note the correct dimensions and placement of doorways, windows, ceiling.

The benefits of a component-modeled interior include:

- Easier to see inside, just hide some walls on a different layer.
- Walls are much easier to move around to reconfigure the room layout.
- The same modeling work on one area can be copied to other rooms more easily.
- A more realistic architecture with consistent scaling is achieved quickly.

220.4. Proportions and Measurements

For realism, it’s vitally important to get the right proportions for familiar objects. If your audience sees a bookshelf with 5” thick shelves, or a human hand which has a 5” long thumb, their brain is going to tell them that something is wrong. They might not be able to decide why, but they’ll tell you it looks fake.

Even when you’re animating fantasy characters, you should develop an understanding for proportion. Many cartoon characters have very large heads when compared to their bodies; this allows room for greater expression and makes the characters seem younger. Deciding how many ”heads high” each character should appear will ensure that your figures all maintain proper proportions to each other and to their environment.
To get good proportions, you need to think about measurements.

• Grab a ruler or find some existing blueprints.
• Think in terms of those measurements for the duration of the project.
• Choose a base scale that will let you work comfortably within a 500x500x500 unit volume.
• Blender limits cameras to 1000 unit distances, for better numerical accuracy.

You can mix and match base units, by using Empty objects as parents. For example, you can model your furniture in inches or centimeters, and model your house in feet or meters. Then when you append your bed.blend’s objects, just parent that bed to a new Empty object, and scale the Empty. This will conveniently scale all of the separate component pieces of the object together.

There’s only one big wrinkle with working with multiple scales: materials should be designed with a certain base scale in mind. Many material surface properties are scaled according to the units you choose for a given object, or the world units. Just consider this as you design, and check your work critically.
221. Modeling tips

This is not really a tutorial, but a list of handy tricks you will probably use a lot when modeling.

1: Extrusion: to extrude, press EKEY in edit mode with the vertices selected, move and click to place the extrusion. You’ll basically need this for every model in blender, without it, most models would be really hard to create.

2: Set Smooth: setting smooth will smoothen everything, without increasing the amount of polygons and vertices. You can use it for models with a smooth surface. To apply set smooth, select the mesh, go to the editing buttons (F9) and in the Links and Materials tab, press Set Smooth. If you press the Set Solid button, it will go back to normal.

3: Remove Double: when you remove double vertices, they will melt together, this is good for attaching things to each other. to remove double vertices, select the vertices, go to editing (F9) in edit mode, and in the Mesh tools tab, press Rem Doubl, the limit button next to it is the distance that the vertices have to have to be melted together.

Example use of these techniques:

Extrusion:  http://www.geocities.com/gauravnawani/tutorials/beginner/a-vase-modeling.html  (they explain subsurf here too, but I’d recommend set smooth, because it doesn’t increase the number of polygons and subsurf does)


Set smooth:  http://www.blender.org/documentation/html1/x2681.html

If you want to add more handy techniques, please add them.
**222. Cheat the 3D**

**222.1. Ways to Improve Performance**

In 3D Graphic Design, there are many issues to consider. First, consider how the project moves, how the project performs. Next, consider how you create objects in your project, especially when working with meshes and lighting.

**222.1.1. Mesh**

**Modifying an object’s properties**

When you add a modifying property to an object, the computer has to calculate that property every time it moves in the animation. These modifying properties include soft bodies, particles, or mirror textures. They can significantly slow down the computer.

To make things move faster, pre-calculate and "bake" the modifier into the object. To bake a modifier, such as a soft body movement, save the modifier as a permanent animation. That way no matter how the object changes, it moves the same way. As a result, your computer does not calculate how the object moves. The move is already set.

There is a drawback. If the object moves and hits another section with different slopes, it will continue to move as if it was in the original baking site. You will have to calculate and bake the section again to get new results.

**Making 2D backgrounds**

Scenes will have a foreground, background, sky, and more.

Your computer will take more time to render a scene that is big, open, and filled with modeled objects. This wastes time and memory, especially when modeling an object far in the distance. I’m guessing however, you do not want to make a quick, plain model. So what do you do?

That is easy. You make a 2D background.

- Put the distant image or background on a plane.
- Verify that everything on the plane around the image is black.

If it is not black, set the Alpha to 0 if the image was saved in a format that supports Alpha. This will retain the detail but reduce the number of faces the computer must count in the scene.

- Set the image to Billboard to prevent the image from skewing by perspective.
222.1.2. Materials

Using UV maps

For those who do not know the term, a UV map is an image applied to a 2D plane. The 2D plane is then applied to the mesh.

Here is how to create a UV map:

- Spread out the image onto a 2D plane.
- Apply the 2D plane over the face of the mesh using the 3D view.
223. Performance vs. Quality

223.0.3. Mesh

**Polygon Count** - when you work with meshes in 3D, be aware that the memory usage in Blender with reference to meshes comes from the number of faces (or vertices) the mesh contains. That means that if you have many useless faces (such as 55 faces on the side of a mesh that are as flat as one face), the number of faces will directly affect the Render time of Images and Animations. Also remember that for smooth rounded meshes, you do not need an infinite number of faces to make it look really nice and smooth. You actually don’t need that many faces to keep a smooth slope looking smooth when viewed from the side. The viewer’s eye will not actually identify every flat face, but will trace it as a smooth curve.

**Face Structure** - 4-side (quad) vs. 3-side (tri) - Poly Count is very important when working in 3D graphics, and depending on the type of mesh you are making you could be wasting a vast number of faces because they are not the right structure. For example, if you want a smooth object, you can make it look mostly smooth when viewed from the side if you make it with well-structured 3-vertex faces. You will also yield the same results with fewer faces than if you use 4-vertex faces. Another example is that if you need to apply UVTexture, or have something to animate, a mesh being evenly deformed will yield a lower face-count if it is a 4-vertex versus a 3-vertex face-structure.

It is worth bearing in mind, however, that most graphics libraries deal exclusively with triangles. This means if you are planning to export your mesh to a game or other external 3D application, whether you use quads or triangles will make no difference as all quads will likely be converted into two triangles anyway.

223.0.4. Lighting

**Using RayShadows or Buffer Shadows** - There are a few options you have for using shadows. Ray Shadows use an advanced algorithm to trace the edge of any interfering objects and create a perfect shadow onto the receiving object(s); however, the Ray Shadow calculation is memory-intensive and can seriously slow down your Render-Time. Buffer Shadows, on the other hand, use a different algorithm for similar results. The difference is that buffer shadows use a bit-rate of shadow ”pixels” that fill in the shadowing area. You can adjust the bit-rate to make the shadow higher or lower quality. This calculation is much more memory-friendly, and your Render-Time will not jump up as much as with Ray.
Performance vs. Quality

Shadows. An interesting topic because this will change with better hardware performance and eventually won’t matter. Until we get into 3D.
Part VIII.

Miscellaneous Tutorials
224. Modeling a Gingerbread Man

In this tutorial you will learn how to make a simple gingerbread man. In a later tutorial you will be able to make an animation with this gingerbread man.

In this tutorial we will tie together everything we’ve talked about up to this point, including extruding, subdividing and rendering, and throw in basic lighting.

224.1. Modeling

First, start Blender. You should see the usual top view of a cube in the 3D window, surrounded by a grid ‘floor’.

Review— Zoom in or out with SCROLL or CTRL+MMB. Pan with SHIFT+SCROLL and CTRL+SCROLL. Make sure you are in orthographic view. Press NUM5 to toggle between orthographic view and perspective view. You can tell you’re looking at an orthographic view while looking down from the top (NUM7) of the cube: wherever you pan the window, you never see any part of the cube except the top.

- Display editing controls in the buttons window by clicking on the Editing context button
Modeling a Gingerbread Man

224.1.1. Adding Vertices

- Select the cube by clicking **RMB** on it. (It may already be selected.) Remember, selected objects are outlined in pink.
- Switch from object mode to edit mode by pressing **TAB**, which toggles between object and edit modes. In edit mode, at first, you’ll see colored dots at the vertices of the cube. Selected vertices are highlighted in yellow. Unselected vertices are pink. (You’ll see the dots when editing in vertex select mode. In edge select or face select mode, you’ll see colored edges and faces instead.)
• Select all vertices of the cube. Press **AKEY** once. If the vertices are yellow, you’ve selected all of them. If they are pink, you’ve deselected all of them. If necessary, press **AKEY** again so that all vertices are selected/yellow.

![Figure 1356](image_url)

- Subdivide the faces of the cube, using any of the following methods. (All vertices of the cube should still be selected.)
  - Click the Subdivide button in the Mesh Tools panel in the buttons window.
  - With the mouse pointer in the 3D window –
    - Press **WKEY** to display the Specials menu, then choose Subdivide.
    - Press **SPACE** to display the toolbox, then choose Edit → Edges → Subdivide.
    - Click the 3D window’s Mesh menu, and choose Edges → Subdivide.
  - Your cube now has more vertices. **Subdividing** edges adds vertices so you can create more complex shapes.
224.1.2. Selecting a Subset of Vertices

We’ll select six vertices on the upper half of one side of our cube, where we’ll extrude an arm.

- Deselect all vertices by pressing `AKEY`.
- View the cube from the front (`NUM1`).
- Select the six vertices on the top half of the left side of the cube (see below) using one of the following methods.
  - Press `BKEY` and drag a rectangle around the top left and middle left vertices (viewing from the front).
  - Press `CKEY` to see a circle around your mouse pointer. `SCROLL` to change the size of the circle. Position the circle around the top left and middle left vertices, together or one at a time, and click `LMB`. Click `RMB` to finish.
- Take a closer look at the selected vertices by viewing the model from a different angle (drag with `MMB`).
- If you find that you have only selected two vertices and not six, make sure the "Occlude Background Geometry" button is off. That button is the right-most of the selection mode buttons, below. (It’s called "Limit selection to visible" in Blender 2.45 and earlier. It doesn’t appear if Blender is drawing in wireframe style.) Try selecting the vertices again.
If you still selected just two vertices, change to a wireframe drawing by pressing ZKEY, which toggles between wireframe and solid drawing types. Try selecting again.

Yet another way to select the six vertices is to select the two faces they define. Click the Face Select button from the selection mode buttons (above), or press CTRL+TAB to display a Select Mode menu and choose Faces. Rotate the cube to view the left side and click RMB in the center of one of the two upper faces. Hold SHIFT and click RMB in the center of the other upper face.
224.1.3. Extruding Arms

- View from the front by pressing NUM1.
- Extrude the selected vertices/faces by pressing EKEY to display an Extrude menu, then choosing Region. Hold CTRL to snap your position to the grid, then move your mouse left to put the new vertices on the adjacent gray line of the grid one unit to the left. Click LMB.
- Repeat so that your model looks like below (from front view, NUM1).
• Deselect all vertices/faces with **AKEY**.
• Perform the same extrusion on the right side of the cube, selecting six vertices and extruding twice as explained above.
• The gingerbread man’s arms are in place, as in the illustrations below.
Figure 1361
224.1.4. Extruding Legs

- Make sure all vertices are unselected, using AKEY once or twice.
- View from the front (NUM1).
- Select the six vertices on the left half of the cube’s bottom. Extrude them downward to a point in between the first and second heavier gray lines beneath the cube. (The gray lines in the grid represent Blender units.) Holding down CTRL, the extruded region may snap to the heavier gray lines—hold down CTRL+SHIFT and the region will snap to tenths of Blender units. Click LMB to finish.
- An alternative to positioning the extrusion with the mouse is simply typing the distance. Enter 1.5 to extrude 1 1/2 units out. On a Mac, enter the number 1, press fn with the key that is right under LKEY and MKEY on Azerty (the one with /:), and press the number 5.
Figure 1363
• Extrude the same region again, to the third gray line (1.5 again). It should look like this:
Shift the lower leg to the outside as follows.

- Select the bottom 12 vertices of the leg (which look like 4 from front view), using **BKEY**.
- Grab the selection with **GKEY**. Press **XKEY** to limit movement to the x axis. Move the vertices to the left by half a square, holding **CTRL** or **CTRL+SHIFT** to snap to the grid, and click **LMB**.
Figure 1366
• Create a second leg on the right side, in the same fashion.
224.1.5. Dropping the Groin

Lengthen the groin (where the two legs join):

- Deselect all vertices by pressing AKEY.
- Select the 3 vertices at the groin (which look like 1 from front view), using BKEY.
- Grab the vertices by pressing GKEY. Press ZKEY to limit movement to the z axis. Move the vertices down 1/2 of a square, or type -0.5 to specify the distance. (Older versions of Blender require NKEY before typing -0.5.)
Figure 1369
224.1.6. Adding a Head

- Switch the 3D window from Edit mode back to Object mode by pressing **TAB**.

Noob Note: I found it easier to remain in edit mode while creating the cube as this makes the cube part of the original mesh. This allows you to add the subsurf to all parts at once.

- Click **RMB** on the object to select it then press **SHIFT + SKEY** and select *Cursor → Selection*. This will make sure the cube you’ll add next will be near where you want it.

- Press **SPACE** and put your mouse on the mesh option and select cube. In others versions, you can also hit **SPACE** and, in the menu that comes up, choose *Add → Mesh → Cube*.

- Press **GKEY** and put your new cube about 1/3 of the way down the neck (to achieve this, you can press **GKEY** and **ZKEY**: enter 1.33).
Now we will make it look more like a gingerbread man by making it thinner.

- Select all with **AKEY**.
- Go to side view with **NUM3**.
- Press **SKEY** for scale and press **YKEY** for Y-axis and then move your mouse to the middle until it is about 0.3 (use **CTRL** for fixed values).
- Remember X-axis is the Red arrow/line, Y-axis is the Green one, and Z-axis is Blue (like RGB video mode).
• Use the **MMB** to spin the view around and examine your handiwork.

At this point, it doesn’t look entirely like a gingerbread man, does it? It’s a bit too ... chunky. For the last bit, we’ll smooth it out.

• Make sure you’ve selected the body in object mode.

• Select the editing panel in the buttons window (or hit **F9**).

• In the Modifiers tab, Add a ”Subsurf” modifier.

• Set the level of the subdivisions to 2, and the number of render levels to 3.

**Noob question:** When I add the cube for the head, it stops me from being able to edit the body - it will only select the head to apply subsurf to, even if the body looks like it’s selected!

**Answer:** When you created the cube you made a second object. To select a different object, press tab to enter **Object mode**. Select the body. Then enter edit mode again if you want to edit the body.

• You can press the **ZKEY** to switch back and forth between wire-frame view and solid view.
• (Noob Note: Easiest way to really get a feel for what is going on in the 3d world is to split into four screens and setting each one to NUM7, NUM3, NUM1, and NUM0 to see all angles and what it will look like at render.)

Noob Question: How?

Answer: To split an area move the cursor to an area between two current areas (e.g. between the 3D view and the buttons), when you see the double ended arrow (used to move the divide) click RMB and select Split Area, you will then see a line appear dividing the area in two. Move this to where you want the divide and click LMB.

• In the 'Link and Materials' section, select 'Set Smooth'.

Noob question: Where? Assuming this refers to the 'Materials' section on the 'Properties' window, there is no 'Smooth' setting.

(Note that here I had the same problem as before, with superposed vertices. Select all vertices, then press WKEY and select Remove Doubles to clean your model. You will see that it will look much better after removing the extra vertices with Remove Doubles)

Figure 1373

• Press the ZKEY to return to wire-frame view.

• Now repeat the process above to smooth the head.
This guide will show you how to intuitively get the best frame of your 3D scene with no effort!

- Press **TAB** for Object view mode.
- Press **NUM0** to get the Camera View.
- Select the camera by clicking **RMB** on the outermost rectangle.
- Press **GKEY** and move your mouse to adjust the position of the camera (**XKEY**, **YKEY**, **ZKEY** and **CTRL** may be useful here).
- In addition, you can press **NUM7** to get the Top View and press **RKEY** to rotate the camera to the best angle.
- After you are happy with the position, press **F12** to render it.

If your render comes out a little dark, try moving the lamp closer to the gingerbread man.

Noob note: Another way to move around the camera is pressing **SHIFT + FKEY** after pressing **NUM0** to enter Fly mode. The keys for fly mode appear in the header of the 3D view pane.
Noob note: Ctrl+Alt+NUM0 "teleports" the camera to your 3d view.

Noob Note: By pressing X, Y or Z twice you will use a local base of the space, with those it’s much easier. For example if you are facing the Z axis from 45 degrees, and you want to go left 1 unit, using the global base, you will have to go 1.72 (around sqrt(2)) along X and the same along Y, instead moving by 1 in the local frame of reference.

224.3. Applying Textures

This builds on the previous guide: Modeling a Volcano\(^1\).

Note: It seems that textures can only be applied to one object at a time, so this must be done twice (i.e. The head and body are two separate objects.) The settings that were chosen can successfully be applied to each object for a consistent result. Some settings can not be applied equally for consistent results.

\(^1\) http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Modeling_a_volcano
N00b Note: if you join the 2 objects before applying the textures you do not have to do the process 2 times, just select the 2 objects, CTRL+J and the accept

- In "Object Mode," select the body (or the head.)
- Press **F5** to open the shading panel or use the shading panel button.
- In the "Links and Pipeline" panel, under "Link to Object," click "Add New."

![Figure 1376](image)

- Press **F6** to open the "Texture Buttons" panel or use the textures button.
- In the "Texture" panel, click "Add New."

![Figure 1377](image)

- Change the "Texture Type" to "Stucci."
In the new "Stucci" panel, change "Noise Size" to something near 0.025 and leave the "Turbulence" at 5.00.

Note: When finished with this section of the guide, come back to this panel and try different combinations of "Plastic," "Wall In," "Wall Out," and "Soft Noise" / "Hard Noise." Press F12 to render after each change to see the effect.

Press F5 again or use the "Material" button directly on the left of the "Texture" button. Then look for the "Map To" panel.
Applying Textures

Figure 1380

- In the "Map To" panel, deselect "Col/or/" and select "Nor/mal/.", and change the "Nor" Value to approximately 1.30.
- In the "Map Input" panel, change the texture coordinates to "Object" by clicking the corresponding button.
- In the "Material" panel, change the "R/ed/" slider to approximately 0.400 and the "G/reen/" slider to approximately half that, about 0.200. Blue can be set at 0.00.

Figure 1381
Note: While it is true that textures can only be applied to one object at a time, textures as well as materials can be shared between objects. In this case it is best to let both the head and the body share the same material.

- To do this, simply select the object without the materials (head or body).
- Press F5 to open the shading panel or use the shading panel button.
• In the "Links and Pipeline" panel, under "Link to Object," click the arrow next to (left of) the "Add New" button.
• Select the brown material.

The steps in this section give a nicely textured, brown surface to the "Gingerbread."

Figure 1384

Now all you need to do is add eyes and gumdrop buttons!
225. Modeling a simple space-ship

225.1. Modeling a simple spaceship using Blender 2.49b

This is a simple tutorial on how to build a simple spaceship using blender 2.49b. One of the best things about blender is the adaptability that can be accessed through its user interface. This tutorial will give you a look at some of the included blender scripts. If you would like to make your own, however, you can refer to the scripting chapter of this wiki book. So now, I guess we can get started.

**Step 1:** First, open blender. You should get the default blender scene with the cube in the center. If you don’t, try resetting your blender settings. Select the box in the center of the screen.

**Step 2:** Now we’re going to shape the box into any shape we want. For now, we are going to shape it into a sort of triangle. If you want to use it as a box, that’s fine, but I suggest following this tutorial using it as a sort-of triangle. To be able to modify it, in the lower buttons area (with stuff like Modifiers, Shapes, Multires, Mesh, and Link and Materials) you should see a drop-down menu that is currently on Object Mode. Change that to Edit Mode or hit the `tab` button. Now you will be able to modify different aspects of your box.

**Step 3:** With your box selected, hit Ctrl+Tab, and choose Faces. This allows you to modify the different faces. Faces are basically the different sides of your object, Edges are the edges of your object, and Vertices are points on your object where edges connect.

**Step 4:** Now, on your box, right click on one of the sides to select that side. If you want, first take a look around the box and then choose a side, but don’t select the bottom or top face. To rotate around the box, hit the 8, 2, 4 or 6 button on your number pad, the one to the right of the arrow keys usually. Those buttons allow you to rotate around your objects and change your view. After you select the face you want, then rotate so that the face is facing towards you and looks like a square, and so that the grid around it looks like a flat horizontal line.

**Step 5:** There should be three arrows converging in the center of your face (or in the center of your box), and either the red or the green one should now be in the center of your face, and the other should be going off to the left or right, with the blue arrow going straight up or straight down. Use the 4 or 6 number pad button to rotate your view so you can see whichever arrow was in the center of your face, and left click mouse button on it, and hold the left click button, and drag the arrow around. Drag it until you have a rectangle. [http://i238.photobucket.com/albums/ff55/bryguy336/uh.png](http://i238.photobucket.com/albums/ff55/bryguy336/uh.png) [http://i238.photobucket.com/albums/ff55/bryguy336/box.png](http://i238.photobucket.com/albums/ff55/bryguy336/box.png)

**Step 6:** Now to resize that face. With that face still selected, hit the S key, and move the mouse around. This should enable you to change the size of the face, and once you click,
it should stop resizing and stay at that size. Experiment and get the hang of it, and then resize it so that it is an itsy bitsy teeny tiny box, and your rectangle more like a triangle. Congratulations! You have just made your first shape/object
226. Create an animated GIF wallpaper
(Blender/GIMP)

This is my first tutorial. I’ll be teaching you to create this -

The quality is low because it is a gif. if it’s a png or avi the quality’ll be much better.

Figure 1385  Created for a tutorial for Blender particle systems
227. Part 1 - Preparing the Scene

Information
Applicable Blender version: 2.68

227.1. Start a new scene in Blender

- Delete the default cube.

227.2. Prepare the individual particles

Go to layer 2 -

Add a UV Sphere with 8 segments and 6 rings (Go to the toolshelf and change the values)
Add a new material with any bright color. Change the emit value to 2 or higher -
Prepare the individual particles

![Material settings](image)

Note - if you want a single-coloured version, you can skip a few of the following steps -

### 227.2.1. Duplication of the particles

Duplicate the sphere and move it nearby ( \texttt{SHIFT} + \texttt{D} ). Duplicate the material by clicking on the ‘plus’ button indicated in the picture below. Change the color to another
Important note - Not clicking the plus button will change the color of the previous sphere also.

**Figure 1389** Material settings
Repeat this process until you are satisfied with the no. of spheres with different colours. Now create a group (CTRL + G) Name it anything you like in the toolshelf (T toggles the toolshelf).

Now you’re ready to start creating the animation and particles!

227.3. Defining the motion of the particles

Go back to layer 1.

227.3.1. Creating the path for the particles to follow

If you haven’t learnt about Bezier curves\(^1\) already, go ahead and do so now.

Add a bezier curve, and tab into edit mode. Now you have to model the path by extruding and subdividing the curve. The shape of the curve defines the path of the particles. After you are done with the curve, you can proceed to create the emission object.

\(^1\) http://en.wikibooks.org/wiki/Blender_3D%3A_Noob_to_Pro%2FIntro_to_Bezier_Curves
227.3.2. Creating the 'emitter' of the particles

Add a UV Sphere with 32 segments and 16 rings. This is going to be the emitter, i.e. the object that gives out those coloured spheres.

This is going to have a completely transparent material since hiding it hides the whole thing.

So go to material properties, add a new material. Scroll down to the Transparency panel, check it and change the alpha value to zero, making it completely transparent. Also change the specular intensity to zero. Leave everything else as such.

227.3.3. Making the sphere follow the path

In this part, you are going to make the sphere follow the curve you had modeled earlier. Select the cube, and add a Follow Path Constraint. Select the target, i.e. the curve and click on Animate Path. All these steps speak for themselves, there’s no need for me to explain. You could check follow curve, but since this is a sphere this is not needed. All it does is make the object face the direction it is moving towards.

As for the speed of the object, you can change it by -

- Select the curve.
- Go to Object properties -

![](Image)

*Figure 1391 The Object Properties*

- Scroll down to Path Animation panel.
- Change Path Animation Frames value to the no. of frames you want the animation to last. I prefer it to be 150.

In the end, make a few changes until you are satisfied with the result. Now you are ready to proceed to part 2.
228. Creating Weapons based on 2D Images

Alright, this is my first tutorial here, I made this a while back, but hopefully it will be a good addition to this Wikibook. It was originally made for a game called Fable - The Lost Chapters\(^1\), but I think it is worthy of another place in the world. Please note that this is a WIP and will be updated time to time.

228.1. Modeling Technique 1

Modeling Technique 1 Part 1 Video\(^2\)

Part 1:

1. After emptying the screen, go to view and click background image, load, then choose a picture of the weapon you want
2. Go to top view and add a square, then delete two of the vertices and place one of the remaining on a point on the picture, and the other out of the way.
3. Select both vertices and subdivide.
4. Move the generated point to the next good-looking spot on the picture
5. With that selected still, select the outside vertex also, and subdivide.

(Note: A much easier way is to select one vertex, move it to where you want it, select the other vertex, move it to the next spot, then extrude the second vertex to the next point, rinse and repeat. This requires a lot less effort.) Another guy’s note: For an easier way, just click CTRL+LMB where you want the next point to appear.

1. Continue until you are on your third to last one, then select your outside vertex and move it where you would move the next vertex.
2. Select the first and last vertices and go to mesh >> make edge/face
3. Extrude to half your preferred thickness, then extrude the rest of the way.
4. Select the center vertices on the blade, and scale up.

Modeling Technique 1 Part 2\(^3\)

Part 2:

cont.)

1. Then move vertices to your liking.

---

\(^1\) [http://en.wikipedia.org/wiki/Fable_%28video_game%29](http://en.wikipedia.org/wiki/Fable_%28video_game%29)
\(^2\) [http://youtube.com/watch?v=isQzBvPGIx8](http://youtube.com/watch?v=isQzBvPGIx8)
\(^3\) [http://youtube.com/watch?v=R3UgOX82MX4](http://youtube.com/watch?v=R3UgOX82MX4)
2. Select the vertices of the handle, go to mesh>>vertices>>separate.
3. Add a modifier, choose subSurf, turn up the level until it looks close to what you want without too many vertices. Click apply next to the modifier.
4. Modify vertices (using proportional edit helps) to your liking.
5. Go to object mode, and turn off double-sided on any meshes that are.
6. If black appears on any parts of the mesh, highlight it, go to edit mode, select all vertices, go to mesh>>normals>>recalculate outside.
7. If there is still black, select those faces and go to mesh>>normals>>flip.
8. If there is still black, then you are missing a piece of mesh. Highlight the vertices around the hole, go to mesh>>vertices>>fill.
9. If black did not appear, then select everything (in object mode) and go to object>>join objects and say yes.

228.2. Modeling Technique 2

Video Here

Blade:

1. Select all with the 'A' key, and delete everything.
2. Go to view and choose background image >> use background image >> load and pick the sword you'll be doing.
3. Close the dialog after you see it in the background (you can change the brightness of it by changing the 'blend' option)
4. Make a bezier circle by pressing spacebar and going to add>>bezier>>bezier circle.
5. put a bar at each main point of your weapon (anywhere the curve changes direction)

Bezier Controls

1. Modify the bars until they match.
2. You might want to go into wireframe view.
3. Go down and turn up the bevel depth a little, to give it some sharpness.
4. To lower the poly count you should turn down the DefResolIU number.
5. Go back to object mode, hit spacebar, go to object>>convert object type>>to mesh.
6. Modify vertices to your liking.

For the handle:

1. Do steps 1-7.
2. Turn up the bevel resolution, to give it some roundness.
3. Repeat steps 8-10

For That one thing (see video):

Just watch the video, but here is a summary.

Extrude and flatten a circle, use proportional edit to make it easier on you when you curve the circle.

http://files.filefront.com/modeling+technique+2+agkavi/;9221627;/fileinfo.html

1598
For hilt guard:

1. Repeat steps 1-6
2. Add some extrusion.
3. Repeat steps 8-10.
229. Modeling with Meta Balls
230. Match Moving

Match moving is the technique of recreating the position of the camera used in recording live action footage. This information can then be used within Blender to merge 3D objects with live action film. For a more detailed discussion of the concept, take a look at the Wikipedia article on Match Moving\(^1\).

Blender cannot perform match moving itself, you must use a 3rd party tool to determine the camera position and the way it moves, then import this data into Blender. While there are many software tools to do this, this page references two free options: Voodoo and Icarus.

230.1. Icarus

Icarus\(^2\) is a discontinued University of Manchester project which can be used for non-commercial work. The download links from the official page no longer function, but Windows and MacOS X versions are available from this Icarus video tutorial\(^3\) by Colin Levy.

230.2. Voodoo

Voodoo\(^4\) is an actively developed free match mover available for Windows and Linux. Here is a tutorial on using Voodoo and Blender\(^5\)

\(^1\) [http://en.wikipedia.org/wiki/Match%20Moving](http://en.wikipedia.org/wiki/Match%20Moving)  
\(^2\) [http://aig.cs.man.ac.uk/research/reveal/icarus/](http://aig.cs.man.ac.uk/research/reveal/icarus/)  
\(^3\) [http://peerlessproductions.com/tuts/pages/Icarus.html](http://peerlessproductions.com/tuts/pages/Icarus.html)  
\(^4\) [http://www.digilab.uni-hannover.de/docs/manual.html](http://www.digilab.uni-hannover.de/docs/manual.html)  
\(^5\) [http://fictionality.co.uk/doku.php?id=tutorials:matchmoving](http://fictionality.co.uk/doku.php?id=tutorials:matchmoving)
231. Match Moving/Motion Tracking with Icarus and Blender
232.2. Making The Clayman

Upon start, delete the default cube (X-KEY) and switch to front view with NUM1. Now add a mesh plane and under The Edit Buttons Window, Mesh Tools Tab click the subdivide button. Now select the 3 vertices on the left and delete them. (B-KEY for Border Select Tool)

If you can’t select the vertices then deselect the Limited Selection to Visible button.
Now select/deselect all vertices with A-KEY (we want them selected) In the Modifiers Tab in the Edit Buttons Window, Click Add Modifier > Mirror You should now see something like this.

**Figure 1394**

Now select the 3 right vertices and extrude them on the X axis by movement of 1.0 units by pressing E-KEY (Extrude > Only Edges ), X-KEY (to constrain it to the X axis) and holding CTRL to constrain it to simple movements. Do this twice.

**Figure 1395**

Now extrude the legs by selecting the 3 bottom-right vertices and extruding them on the Z axis by 1 unit. Do this twice as well.

**Figure 1396**

Now extrude the top of the clayman on the Z axis (in units of 1.0) 7 times so that it looks like this.

**Figure 1397**
Now let’s make the arms by extruding the 2 boxes that are 3 boxes down from the top. Let’s extrude it on the X axis by 1 unit 4 times so that it looks like this.

Figure 1398

Now comes the extrusion of the whole body. As you can see, we only have a flat shape of a rough "Block". So let’s move our view around with the NUMPAD arrows and extrude it on the Y axis. Select all vertices with A-KEY. Extrude > Region on the Y axis until it reaches 2.0 units. After done correctly, it should look like this.

Figure 1399

With the Clayman successfully extruded, it’s now time to add some definition to him by adding a subsurface modifier. In the Edit Buttons window, under Modifiers, click Add Modifier > Subsurf and set the Levels bar to 2. It should look somewhat like this.

Figure 1400

Now, Select all vertices with A-KEY, and click the Set Smooth button in the Links and Materials tab. Let’s get to shaping the Clayman. Using the Border Select Tool (press B to get the Border Select Tool), grab the according vertices to make a shape like this.

Figure 1401

After that’s done, select the head vertices and grab them on the Z axis and move them up by 0.2 to make it look like this.

Figure 1402

Now select all vertices with A-KEY, and scale them down (S-KEY) on the Y axis until it reads 0.6000. And finally, select the underside of the foot (the vertices that make it up) and subdivide it to make it more flat on the bottom.

232.3. Adding Materials

Start by going to the Material Buttons window (F5) and clicking on Add New, and going down to the column of 3 rectangles that have one gray one and two blank white ones. Click on the gray one and in the top-right corner of the pop-up window, you’ll see a Hex Code. Click on the current hex code and type in this new hex code to get the right color: 73BCF7. Now hit F6 to go to the Texture buttons window and click on Add New. Change the Texture type to Stucci. Now you’ll see a new tab appear. On it, for NoiseSize enter 0.150. Now go back to the Materials Buttons window. On the far right there will be three
tabs in one. On the Map To tab, Deselect Col and select Nor. Now your example should look like this.

Figure 1403

232.4. Inserting Armatures

Now let’s move on to inserting armatures in our clayman. Let’s start by going into object mode (alternate between Object and Edit mode with TAB) and adding an armature. Press Space > Add > Armature. It automatically puts you in Edit mode upon adding the object. Switch to Object mode and grab it along the Y axis by 1.0 units so that it’s inside the clayman. Sure, you can’t see it now, but turn on X-axis Mirror Edit and X-Ray in the Edit Buttons window.

Figure 1404

Now switch back to edit mode, and select the top of the bone. Extrude it on the Z axis by 1.4 units two times so that the tip of the second extrude is right in the center of the two arms. Now extrude it on the X axis by 3.0 units, then grab the tip of it and move it on the Z axis by 0.1700 units. Now extrude it on the X axis by 2.0 units twice. And do the same to the other side. It should look like this.

Figure 1405

Now let’s extrude the neck. Extrude the top bone along the Z axis by 1.0 unit to make a pretty good size neck. Then extrude it up on one side so that the position reads like so. If you can’t get it exact then at least try to get it as closest to the number as you can.

Figure 1406

Then do the same to the other side so that it looks like 2 antennae. Now let’s extrude the hips and legs. Let’s start by extruding the bottom bone by 2.0 units on the X axis and for the Z axis, -1.0 units. Then extrude the foot by -2.0 on the Z axis. And last, select a forearm bone (select a whole bone by clicking the middle of it) and in the Edit Buttons window, you’ll see a tab called Armature Bones. Deselect the Con button in that tab, and do the same with the other forearm bone. This allows us to be able to move the forearm out, instead of having it locked to another bone.

232.5. Applying The Armature

Ok, now we’re going to apply the armature to the mesh so that when we move the bones, the mesh moves along with them. Let’s start by switching to object mode and selecting
Applying The Armature

the clayman mesh, and under the Modifiers tab, click apply on the Mirror modifier. You may see a pop-up, just click OK. Not only have we just made room in the Modifiers tab, we applied the mirror modifier to the mesh, so now we will have to edit both sides if we want to change something. But worry not, we won't need to change anything from here on. With that new space in the modifiers tab, let's add an Armature modifier. You may see a line that says "OB:" type in the name of the Armature in here (the default name for an armature is "Armature" unless you have made more than one) also, deselect the Envelopes button, for we will not be using envelopes in this tutorial. Here is what you should have.

Figure 1407

Now, select the Armature and press CTRL + TAB. If you already have a bone selected, it should be highlighted blue now. We have just switched to Pose Mode. Now, while in Pose Mode, select the clayman mesh (if you can't select it, zoom in closer to get some of the bones out of the way) and press CTRL + TAB on the clayman mesh. We have just entered Weight Paint Mode. This allows us to assign vertices to the bones so that the mesh moves with the bones. Let's start by setting up the weight painting. You should see a new tab called Paint in your Edit Buttons window. Adjust your settings so that they conform to this.

Figure 1408

Start by selecting the top-right bone of the head and start weight painting the front and back (you'll have to switch your view so that you can see the back to get the painting in there) Weight Paint it according to this.

Figure 1409

Now Weight Paint the Neck. (pictures not shown of back view, but be sure to get the back anyway)

Figure 1410

Now the Shoulder.

Figure 1411

Now the Forearm.

Figure 1412

Now The Hand.

Figure 1413
Create a Clayman

And after getting the other side of the body, let’s get the upper chest.

Figure 1414

Now the middle chest.

Figure 1415

Now the lower chest.

Figure 1416

Now for the hips.

Figure 1417

Now the Feet.

Figure 1418

After doing the other side of the leg, switch back to Object Mode with CTRL + TAB, and select the Armature. You should already be in Pose Mode with the Armature. Now select a bone and grab it to move it. If you have Weight painted correctly, the Clayman mesh should move with the bone. There’s two tips to moving the bones around in Pose Mode.

1) In the Edit Buttons window, whether Automatic IK is turned on or not affects how the bones move.

2) Where your view is affects how the bones rotate. (unless you have it constrained to an axis)

If you find that a part of your clayman isn’t moving, just switch back to Weight Paint mode for that bone and repaint it.


233. Organic Modeling

Subsurface modeling

Organic modeling is considered by some the most challenging. Non-organic can mostly be accomplished by extrusion and scaling. Organic modeling on the other hand involves mainly curves, as nature has a thing against straight lines. Because of this, organic modeling is usually done with subsurfaces. To subsurf a mesh, first select it and navigate to the ’Editing’ tab. Then go to the modifiers stack and add a new Subsurf modifier.
In Blender 2.5 Alpha 0, Subsurf has been removed from the modifiers list. Instead hit Ctrl, followed by a number which will specify the subsurf level. For example Ctrl-1 adds a new Subsurf modifier of level 1. This also works in Blender 2.4. Increasing the level greatly increases the number of verts in your model, so make the level relative to the number of vertices in your original model (pre-subsurfed). Subsurf often works best in conjunction with smoothing, so be sure to set your object to smooth, again in the 'Editing' tab, or in 2.5 A0 under 'Object Tools', which you can bring up by hitting the T key in the 3D viewport.
In this way you can create a smoother, higher-poly shape based on that of the original mesh. This is controlled by the vertices, edges, and faces of the original. In order to control the rounding of your mesh, you can use two methods: loop cuts, which is a very sloppy method as it adds more verts to your mesh, which serve little purpose and can get in the way of modeling; and Edge Creasing. The latter can work extremely well in most circumstances. By default all edges are declared uncreased, and so allow complete rounding in subsurfing, by creasing the edges using Shift-E you can better control the amount of rounding on your mesh, and most importantly, without adding extra verts. However, unfortunately Edge Creasing is not available in Blender 2.5A0. Yet, unfortunately, loop cuts and extra verts are the only option.

Now, start shaping your mesh into an organic shape. There are various tutorials for modeling bodies and faces, but it is often a good idea to use references. Only use quads - that is, shapes with four vertices. Triangles do not subsurface well, they create bad looking rough surfaces - avoid if at all possible. Also avoid Poles, which are vertices connected to anything
other than 2 or 4 other vertices, as they create literal creasing in your subsurfed mesh, that
is, sudden bunching up and pinching of faces.

To make the object shape properly, you will need good edgeloops and edgeflow. This
means that all your vertices and/or faces line up in a continual line or curve around your
model. It is possible to select edgeloops all in one, fantastic when you have to resort to
them in controlling rounding, by holding down Alt when selecting a vert. This really
expands into topology, which is an advanced subject. I would recommend visiting http://
www.subdivisionmodeling.com/forums, although it has just been closed down, which
was a great place to start, however it still (at the time of revision) is active and well worth
a look if you are struggling with modeling heads. It is best not to have too many vertices to
avoid making the subsurfed shape look rough - in other words, the original shape should
be quite low-poly.
234. Understanding the Fluid Simulator

234.1. Understanding the Fluid Simulator

When I first encountered the Fluid Simulator I had a hard time understanding its behavior, especially the Start time and End time didn’t seem to make any sense at all. Going on a Google spree revealed that many people have problems figuring out the secrets behind fluid simulation, and I didn’t find any truly helpful guides. In this little guide I’ll try to explain it in a newbie friendly way. It may not be entirely correct, although it might help newbies understanding how it works.

234.2. First of all

Start time and End time are in seconds. Don’t forget this. Even if your simulation seems to go insanely fast when you set Start time to 0 and End time to 10 and having 250 frames in your animation with 25 frames per second, there is a good reason for this. For now, just remember this, don’t let your mind wander and believe that the values are in milliseconds or that you have to do some wicked math dividing/multiplying with frames and so on.

Also notice that the domain is the bounding box for the whole fluid calculation. EVERY-THING is done inside this box. It acts as the floor, ceiling and walls for all of the fluid. This is very important, as the number 1 reason why I couldn’t get a good fluid simulation going. If I have time, I will do a section on Fluid > Control, but for now, I will say that it adds a LOT of calculation time. Running on an I7, ATI Radeon 8970 Video, Asus P6X58D Premium, 64-bit Windows 7 and 64-bit Blender, I crashed my computer with the lowest quality settings. So just remember that the domain MUST surround the area in which you do calculations. Also note that after you set up your simulation, the domain becomes the actual liquid, so give it proper material and try not to bake until you’re pretty sure of your simulation.

234.3. Setting up the scene

We’ll learn how the fluid works the practical way. plane

• Start with the default box, this simulation will be very simple.
• Let’s work in wireframe mode, press the ZKEY to turn off solid mode.
• Go in to camera view by pressing Numpad0.
• With the box selected, scale it up to two times by pressing SKEY , then 2 , then ENTER. This fits the camera fairly well.
• Press Numpad 7 for a top view.
• With the box selected, press Shift-D (don’t move the mouse or else the duplicated box will move) then press ENTER to confirm the duplicated box’s location. If you do move the box, just press Escape then the new box will be kept but the move cancelled.
• While the new box is selected (and in exactly the same spot as the other box), press SKEY, then .5, then ENTER to scale it to half size.
• Stay away from the mouse, accuracy is important here and I’ll explain why later.
• Now we want to move the new box into one of the upper corners. Press the GKEY, then press the XKEY, type in -1, press ENTER and the box should move to the left wall of our larger box.
• We want the box in a corner, so press GKEY Y 1 Enter, the box should now be in the top left corner from our current view.
• However, we’re in 3 dimensions, not 2 so click Numpad 1 for a side view. This time we’ll move the box up along the Z-axis: G Z 1 Enter.
• Excellent, our setup is done.

234.4. Setting up the simulation

• Make sure you’re in Object Mode, and that you followed the above steps precisely.
• Select the smaller box and click F7 twice. You should get a panel where the rightmost pane says “Fluid Simulation”. Click Enable.
• Our small box will be the fluid, so just click the Fluid button. That’s all there is to do with the small box.
• Now select the large box. The Physics panel should still be visible, click Enable in the Fluid Simulation pane and then select Domain.
• By default your animation should have 250 frames. Rendering should also be set to 25 frames per second by default, this tutorial assumes this setup.
• Since we got 250 frames and 25 frames per second that means our animation is 10 seconds long. So here comes the tricky part, which actually isn’t that tricky at all:
  • Start time is by default set to 0 seconds. This means that on the very first frame the simulation has just begun. You could increase this value to say, 1 second and that would mean that on the first frame the fluid simulation has already run for 1 second. We don’t want to do this, so keep it at 0 seconds.
  • End time is by default set to 0.3 seconds. What does this mean? This means that on the 250th frame the simulation has run for 0.3 seconds. However, by default our animation is 250 frames long with 25 frames per second, making those 0.3 seconds stretched over 10 seconds. Basically this means that we’re watching the show in slow motion, or slightly less than 1/33 the realtime speed. So now you may think ”it looks quite realtime to me!”, and yes, it does, but why does it do that? Well, that’s hard to explain. Consider this: In a world without friction, how far would a drop of water fall after 1 second? The answer is about 4.9 meters. So, if a drop of water falls from 4.9 meters it will take 1 second before it reach the ground. How long would it take the waterdrop to reach the ground if it falls from 3 centimeters? About 0.078 seconds. So why do i mention 3 centimeters? Because by default the size of our domain is 3x3x3 centimeters, or really small. If you’re like me, you were probably thinking that the
fluid was flowing around in a bathtub or a barrel, not in the wrapping of a cupcake.

Set End time to 10 seconds.

- Since our imagination likes big things, let’s crank up that cupcake to say, a swimming pool. Make sure the big box is selected in Object Mode In and look at the Fluid Simulation pane. Just to the left of the "BAKE" button there should be 3 other buttons, possibly named "St", "A", "B". Click A for advanced options.
- Some new boxes should appear, Gravity (should be -9.81 for the Z-axis, nothing else), Water and the option we’re looking for, "Realworld-size". Also Gridlevels and Compressibility, but let’s not care about those now.
- The "Realworld-size" value says how large our domain is in meters, and as you can see it’s 0.03 meters by default, or 3 centimeters. We want it huge, so crank it up to 10, which is the limit for Blender 2.45. Now our swimming pool is 10x10x10 meters (don’t drown!), remember this because scale matters with fluid. Do not think we’re playing with cupcakes again ;)
- Now click BAKE, and read on while your computer is chewing zeroes and ones.
- Remember how I told you to be very accurate about placing that second box? And how I began talking about gravity, falling waterdrops and stuff? Well, now you’re going to see why.
- As stated, our "swimming pool" is 10x10x10 meters. The smaller box we added is exactly half the size (well, in terms of length/width/height, not volume), or 5x5x5 meters. Remember that a drop of water would fall 4.9 meters in 1 second? And that our animation got 25 frames per second? This means that the bottommost part of our blob of water will be exactly 5 meters above the "ground", and that after 25 frames our water should be very close to the ground.
- If you got a fast computer, Blender should be done baking by now. Go to frame 25, for example by using the arrow keys (up/down goes 10 frames forwards/backwards, right/left goes 1 frame forward/backward). Take a close look at the blob, then go forward 1 frame. Notice how the blob hits the ground? Rings a bell, doesn’t it? ;)
- Although, we’re not done! We gotta render our swimming pool. It’s easy, but takes time, hit Ctrl-F12 and go make dinner.
- When the rendering is done, press Ctrl-F11, and think of a 10x10 meter large pool. You might want to keep an eye on your kids if your local swimming pool acts this way, though.

234.5. Final notes

Scale matters. It’s really difficult to understand fluid dynamics on a very small scale, especially when you don’t even know what scale is used. The "Realworld-size" value seems to be left out in many guides, I would recommend you set it to something you can relate to, or you’ll end up with simulations that look really slow/fast or having an End time value that seemingly makes no sense. Further I’m not a mathematical genius, for all I know I could be way off with my explanation, although this way the values makes sense to me, and I’m able to make fluid simulations without "guessing" on values for End time.
234.6. Extra Practice

This YouTube tutorial on fluids might also help: Link\(^1\) and this Realistic Water Texture\(^2\)

234.7. Links

- YouTube: Comparison of different values for resolution and real-world size\(^3\)

---

\(^1\) [http://au.youtube.com/watch?v=yMBx2pYiqnY](http://au.youtube.com/watch?v=yMBx2pYiqnY)


\(^3\) [http://www.youtube.com/watch?v=okHt4z3FggMhd=1](http://www.youtube.com/watch?v=okHt4z3FggMhd=1)
235. Creating a jewel in Blender

In this tutorial we will create a jewel in Blender. It is fairly simple. I recommend you do this tutorial if you are a noob, because it explains some basic features, but I suggest you read the tutorial syntax and the pages at the very beginning of this Wikibook first.

235.1. Modeling the jewel

Start up Blender if you haven’t already. There is a cube in top view (it looks like a square because it is in top view.) Delete it by pressing the X key. Then, to begin modeling, add a circle by pressing SPACE → Add → Mesh → Circle. Set the vertices to 10 and make sure it is not filled in. Then press OK.

![Image](Image)

Figure 1423

Next, we will extrude the vertices down. First enter side view by pressing Numpad 3 on your keyboard. As you can see, the circle is flat and not filled in. We will give it some depth. Switch to Edit Mode (TAB) and extrude the circle by pressing the E key and selecting “Only Edges”. Move the mouse down and click to confirm the position (you may want to limit to Z axis by pressing the Z key).
Figure 1424

OK, what we just did is turn the circle into a hollow cylinder by extruding. But we don’t want a cylinder. We want the bottom to be a nice tip. To do this, press Alt-M. This creates a Merging menu. Select "At Center". Now the bottom is a nice tip, like we want it!

Figure 1425
Now we will edit the top of the jewel. Press A to deselect everything and press the B key. This enters Box-Select Mode. Drag a box over the top vertices to select them.

Now extrude the vertices upwards a bit (again: E key and "Only Edges"). Next, we will scale down these vertices to look a bit more like a jewel. Make sure the ring of vertices are selected and press the S key. This enters Scale Mode. Scale down the top vertices a bit and click to confirm.
To look around your jewel model use the Middle Mouse Button or Alt-Left Click. Your jewel is looking fantastic! But there’s a big gaping hole at the top. We’ll fix that. First, enter side view (Numpad 3). Now extrude the topmost ring of vertices but don’t move them anywhere with the mouse. If you are feeling doubtful, just press 0 and then Enter (or just click right mouse button). This makes a duplicate of rings placed over the original. Next merge this new ring with Alt-M -> At Center. This merges the duplicate ring, thus filling up your hole.

At last! Your jewel is finished! Feel free to rotate around it and make further adjustments if you are more advanced with using Blender.
235.2. Shading

Switch back to Object Mode (TAB) and show the Shading Panel (F5). Enable the Material Buttons (click on the button with a red ball). Add new material by clicking on "Add New" button in the "Links and Pipeline" tab. Copy the settings in the screenshot below. If you are having trouble setting the precise value to a slider, just click on the number. This allows a manual type-in. First, make it green by setting R to 0, G to 1, and B to 0. Next set the alpha slider to 0.458 (it looks like an A). Now press "Ray Mirror" (raytracing reflection) to turn it on and set it to 0.13. Now press "Ray Transparency" and set the IOR value to set 1.44. When you’re done it should look like this:
235.3. The finishing touch

To improve the effect, add a plane underneath the jewel. In the Object Mode (TAB) press SPACE >> ADD >> MESH >> PLANE. Scale it 5 times using the S key. Then move it down a bit using the G key (press the Z key to restrict movement to the Z axis).

You may try to render your jewel now. Press the F12 key. You may find that camera doesn’t see whole jewel. Move and rotate the camera (using the G and R keys) to set it in the right position. You may want to switch to "Camera View" (Numpad 0) and try out "Camera Fly Mode" (SHIFT F). Try also moving the lamp and see what happens.

I’ve found that the jewel looks best with Ambient Occlusion on. So go to the Shading window, then the World buttons, click the Amb Occ tab and click the Ambient Occlusion button.

Here is an example of what you can do:

![Figure 1430](image)

235.4. External links

- [http://www.blender.org](http://www.blender.org)
• http://www.blenderartists.org
236. Modeling a picture

236.1. Modeling a picture

Ever seen an awesome looking picture you wanted to turn into a 3D model? Like a logo or a symbol? Well, it’s actually pretty easy... it just takes some time to do.

- First off, you’re going to need a picture to trace. I’m currently doing a project for a friend to do with devils and demons, so I chose a demonic looking face for this tutorial: Demonic Face

- Now open Blender and start a new project. Delete the default cube. Before you start tracing the face, you need to set the face as the background image. To do this, click ‘view’, then ‘Background Image’. A box should pop up with only one button in it (Use Background Image), click it. Now some settings appear, we’re only interested in one of them for this tutorial. Click the small button with a picture of a miniature folder on it (it looks kind of like a feather pen). It’s the first one under the Use Background Image button. From there, select the picture you want to trace. Like this: Background Selection

- OK, now for the long part. Zoom in to the new background image just a little bit. Now, add a Bézier curve, and size it down a little. Hit F9 and, in Curve Tools, find and click the Poly button. Now there should be a few more vertices to work with and the curve should be just a bunch of joined lines. Select one point at a time and using the GKEY move it to a point along the background image(or face in this case). Do the same for all of the rest of the vertices, making sure you only have one vertex selected at a time or you’ll move more than just the vertex you want to. Once this is done, select one of the end vertices of the curve (it doesn’t matter which end) and use SHIFT+DKEY to copy that vertex. Move the newly copied vertex to a point along the edge of the face a small ways away from the vertex you copied it from. Continue doing this until you have a complete outline (of the whole face or just one part, like the ear). Here’s what it should look like (I did the left ear): Tracing

(user note: hitting CTRL-LMB instead of SHIFT-DKEY will add a vertex that is already connected.)

1 http://www.masterpiecepumpkins.com/Graphics/Devil2%20(1.5)_______________PM.JPG
2 http://k.domaindlx.com/genis/images/bg_select.jpg
3 http://k.domaindlx.com/genis/images/points.jpg
To get the outline for the whole face, just do exactly the same thing around all of the edges. We still have a problem though: most of the points aren’t joined by a line, so all we have is a bunch of dots. This is easily solvable. Using the BKEY or the right click of the mouse, we select a bunch of vertices at a time (somewhere between 5 and 10), and hit the FKEY a few times. Every time you hit the FKEY it should connect two of the points. Do this until all of the selected points are connected, then deselect them and select another group and use FKEY to join them. Keep doing this until all of your points are connected. To connect the last two points, select all the points and press the CKEY, to close the polygon.

[edit: A better option would be to select a vertex on one of the ends of the whole line, hold down the CTRL and left-click on a certain point on the image. This will create a new vertex, immediately connected to the vertex you selected.]

Now that we’ve got the entire face traced (or outlined if you want to call it that), we can make it 3D. Hit F9 again and find the Ext1 and Ext2 properties, shown here: Ext1 & Ext2. Change the values and see what happens. They correspond to the depth of the outline. Try changing them around until you find what looks good. Now, you’ll notice that the lines just stick out straight. I’m still investigating how to actually model a head from the outlined face... so if anyone has any ideas, feel free to add them to this page.

In order to make it have depth you should make the outline out of mesh points instead of a curve. Add a primitive mesh and delete all the vertices in edit mode, then ctrl click to all point outline. Add depth to the surface in a side view (split views so you can see what you’re moving). It helps to have 2 or more reference images, but you can wing it. Usually the final result has to be subsurfed.

(USER EDIT: I accidentally started it with mesh instead of curve. You can do the same thing with extrude, but I have no idea how to go on after that) (USER EDIT LATER: If you subsurf it, it creates a relatively 3D looking image. Its really cool)

(Another user, even later: If you want to turn your curve into a mesh, hit Alt-C while in Object Mode. Note that this is NOT reversible.)

(user edit: You can delete one vertex of a plane, in order to get a line. You may find easier to outline the picture extruding and moving points of the line you created.)

(user edit: you can use this tracing technique to make solid and symmetric models, else, you would really have to use normal modelling)

236.2. Printing a Rendered Image

Render your image. Exit or minimize the "Blender:Render" window. In blender, go to File -> Save Image... Then save your image. Then you can print it as you would print any other picture, using The Gimp, Paint, Microsoft’s Photo Editor, or many others.

http://k.domaindlx.com/genis/images/make3D.jpg
237. Modeling with the Spin Tool

![Image of objects modeled with the spin tool](image)

**Figure 1431** A collection of objects modeled with the spin tool

The Spin tool is a great tool for modeling objects you might make on a lathe quickly and easily.
Lathe objects have circular cross sections along a certain axis. That is to say, when you cut such objects perpendicular to a certain axis you’ll get circles. Examples of such objects includes rods, poles, wineglasses, and pails. A Blender render at the left shows some of these.

With the Spin tool you only have to "model" half the outline of your object. The object is completed after you spin this outline. A bit of cleanup here and there and your model is finished.
238. Spin Tool Introduction

238.1. How the Spin Tool Works

The Spin tool works by making copies of the selected vertices in a radial array around an axis indicated by the 3d cursor. Each copies of vertices are connected to previous vertices that corresponds to it with necessary geometry, i.e. edges and planes.

A picture explains this more clearly.

![Selected vertices before using the Spin tool](image)

**Figure 1432** Selected vertices before using the Spin tool
Spin Tool Introduction

Note that the copied vertices are arranged in a radial array around our 3d cursor and parallel to our view plane.

238.2. Typical Work Flow

1) Make half of the outline of our object with connected vertices. If you want to model a wineglass, make the half of the outline of the wineglass.

2) Spin our outline. After this the Spin tool would complete our object.

3) Clean up the resulting mesh. The mesh created by the Spin tool is not so perfect so we had to “clean” it up.

Modeling Half of the Outline

To start we make half of the outline. Here we do it by creating vertices.
Open Blender. Don’t remove the default cube cause we are going to use it. If you don’t have any object after you open Blender (like mine), add a mesh object. Any of them will do. I tend to use the plane. At this time it is good to give your object a proper name. Name it sensibly, like “wineglass” if we are modeling a wineglass. This will help us locate it if there comes a time when we have a lot of objects in our scene. We don’t want to have all objects to be called cube.001, sphere.003 or something. That could get confusing.

Hit Tab key to enter Edit Mode, if we are not in there yet. Select all vertices by hitting AKey, then delete them with XKey -> Vertices. Then go to the front view be hitting Num1.

Now, we are going to make the outline by creating vertices. Press and hold CtrlKey then click the left mouse button. A new vertex would be created. Click the left mouse button again, another vertici would be created but this time it is connected to the previous vertici by an edge. Click again to add more vertices. We are going to use this to create our outline.

You might notice that the 3d manipulator (red, green and blue arrows) could get in the way. Deactivate it by hitting Ctrl+Space Bar, then select Enable/Disable, or by clicking the white pointing hand icon in the 3d view window.

Let’s start making the outline. Delete our previously created vertices first. Using what we have learned, let’s create vertices again but this time let’s add them to form some sort of outline. let us be creative here. It could be anything you want. Here I make two to illustrate two situations that we might encounter when modeling with the Spin tool. That is modeling objects that are hollow or non hollow.

![Figure 1434](image)

**Figure 1434**  Half outline of a drinking glass
Here, the first one, is an outline of a glass. Here, we are modeling an object that is not hollow. We had two vertices that are located in the center of our would be glass bottom. We need to align the two central vertices perfectly along the z axis. Select this two vertices then scale it along the x axis to zero (SKey, xKey, 0Key, Enter).

![Figure 1435 Half outline of a napkin ring](image)

The second one I will make into a napkin ring. This time our outline is closed and no vertices are located in the center of our would be napkin ring. Here we are modeling an object that is hollow.

To make the closed outline, select the two vertices on the open side then press FKey. The two vertices would be bridged by an edge, thus closing the outline.

Adjust vertices when necessary.

For those who may like to have an image in the background to guide them. Upload a background image by selecting the View menu from the 3d View Window then select "Background Image". A new internal window would appear. Click "Use Background Image" Button, then click "Load". Navigate to where the Image is located select it then click "SELECT IMAGE". Our image would appear on the 3d Window as a background. Bellow, I used a picture of a wineglass.
Spinning Our Outline

Now that the outline is finished, we are ready to use it with the Spin tool.

Two things you must know is that the Spin tool is dependent on the location of the 3d cursor, and view where we activate our Spin tool.
Here is our setup with the vertices all selected. In the next pictures are results when this shape is spun with the 3d cursor at different locations.
Figure 1438  Shape spun with 3d cursor at the origin
Here we have the same shape but is spun around in different views.
Figure 1440  Shape seen in top view
Figure 1441  Shape spun in top view
Figure 1442  Shape seen in an arbitrary view
Note that its important only to place the 3d cursor properly relative to the view where you are going to use the Spin tool

**Placing Our 3d Cursor**

We can see that the location of our 3d cursor is very important in Spin modeling so we need to know how to place it properly. If you prepare it to be, the cursor would already be in position after we make our outline but accidents happen and we accidentally misplaced our 3d cursor. Here are some ways we could make our 3d cursor go to the place where we want it to be.

**Snapping**

Snapping the 3D cursor is a quick and simple way to place our 3d cursor to its proper location. In the 3d window, hit Shift + SKey. A list of options would appear. We are interested with the last three options, namely the cursor snaps options. They are the Cursor->Selection, Cursor->Grid and Cursor->Active. The name are pretty descriptive but we’ll give a short description here.
Cursor->Selection places the cursor to the exact location of our selected element or elements. In case of multiple selected elements, our cursor is placed on the median of the selected elements. In edit mode, select a vertex and use Cursor->Selection snap to it. Our 3d cursor would jump to the exact place where our selected vertex is located.

Cursor->Selection snapping is especially useful when modeling non hollow objects because there are vertex or vertices located at the center of our model to snap to. Just select one central vertex and snap to it.

**Figure 1444** Here our 3d cursor is not at the center of our drinking glass outline. We select one of the central vertex and do Cursor->Selection snapping.
Cursor->Grid snaps the cursor to the nearest cross of the visible grid. Try clicking at a center of a square in our Blender’s grid and use it. See its effect.

Cursor->Grid snapping is useful for spin modeling hollow models. Usually if you are careful, our object outline would be on a plane that contains one of the axises. If we make our outline in front view as advised, go to the top view (or side view depending on what we are modeling). If you are doing okay, you will see all our vertices aligned perfectly along the x axis. It just a matter of LMB close to a cross on the grid that contains our objects center then snap to it.
Cursor->Active might not be so helpful in spin modeling. Cursor->Active snaps the cursor to the active element (usually the element that is last to be selected). Try it by selecting several vertices, then do Cursor->Active snap. The vertex where the 3d cursor goes is the active element in your selection.

Spin Tool Parameters

The spin accepts two parameters to execute its function. These are Degrees (degr) and Steps.

**Figure 1446**

Degrees specifies the angle at which the selected geometry will be rotated from its initial position around the axis. It accepts values in degrees. A 360 degrees value being a whole turn around the axis. Values lesser than 360 produces something like a wedge is sliced from the side of the form.
Sample Outline

Figure 1447

Sample Outline Spun with Degrees parameter set at 245 degrees

Figure 1448

1648
p Sample Outline Spun with Degrees parameter set at 360 degrees

Figure 1449

Steps specifies the number of "copies" of the selected geometry the spin tool makes that it arranges in a radial array around the 3d cursor. A higher value results in much rounder form.

Figure 1450  none
Cleaning Up the resulting Mesh

After using the spin tool, a little up work might be necessary, especially if you specified a 360 degree turn. Though the mesh looks clean to the eye, the tool actually make geometries (vertices) that are in the same blender position as another one. So what might look like one vertex may actually be two. A simple way to clean up our mesh would be to select the whole geometry then activating the "remove doubles" from the specials menu ( Wkey(Specials Menu) -> remove doubles or Wkey->6key). This would remove these problem geometries, finds vertices that are too close to each other and merging them to one.
238.3. Post Modeling

After the lathe able parts are done it would be ready to adding non latheable parts. For example a cup may have a bowl-like body, that we could use the spintool. Alas the handle can’t be so we had to put it there after. Depending on the geometry added. This geometries could be formed from the mesh itself or be adding in a separate mesh.
239. Illustrative Example: Model a Wine Glass

Let's start with a classic spin tool model. Here we go step by step in making a wine glass... or any other latheable models... using the spin tool.

239.1. Model half the outline

Using what you have learned earlier, create a simple outline of the wine glass. Just the half part and leave the center part open. As a recap, go first to front view. Select the cube (or if you have no object create one) and press Tab to go to edit mode. Delete all vertices of the object, then using Ctrl+ LMB, add connected vertices. Keep holding Ctrl and clicking until finished. Adjust vertices as required.
239.2. Spinning the outline

Remember to align the two end points in the open side. Select the two vertices and scale at the x-axis to zero (Skey->Xkey->0key). Move the 3d cursor to the center by snapping to the selection (Shift+S - 4key). Then select all vertices by hitting Akey twice.
p Wineglass outline in preparation for spinning

Figure 1454

Now go to top view (Num7). Select the editing button (F9Key) and find the mesh tools tab. Change Degr to 360 for a complete turn and change steps to 20 or higher to form a much rounded shape.
Parameter settings for the project

Figure 1455

Press the Spin button.
Select all vertices by pressing A key twice then apply remove doubles operation (WKey->6Key/Remove doubles). Now the model is finished. Make it shade smooth using set smooth (Wkey -> set smooth). If you like, add a Subsurf modifier to the object to make it geometrically smoother. If dark bands appear, recalculate normals outside (Ctrl+N), to eliminate them.
Finished wineglass rendered with no textures

Figure 1457
240. Illustrative Example: Model a Mug
241. Creating Ogg-Theora movies using Blender

Wikimedia Commons requires that movies be uploaded as Ogg-Theora (OGG) files. As of Blender 2.42a, this is not a built-in feature of Blender. To get OGG files from your finished animation isn’t difficult, though. However, you’ll need additional software.

There are basically two ways to generate OGG files: you can use one of the many fine video editors or you can use special conversion programs. Video editors like LiVES or Cinerella allow you to load your AVI or your rendered frames, manipulate them, and create the OGG file from it. Please refer to the editor’s documentation on how to achieve this.

A disadvantage of a video editor is they are huge pieces of software, duplicating functionality that you already used when you created your animation file/s with blender. It’s actually not necessary to install a video editor just for converting your animation to OGG Theora format.

241.1. Converting saved frame picture files to Ogg Theora

It’s actually possible to convert frame pictures that you saved before to OGG format movies. The ffmpeg2theora software package¹, which is available in source or binary for all relevant systems, is capable of batch-processing files into an Ogg format movie. For example, if your frames were saved as PNG (with filenames `filename001.png`, `filename002.png`, etc.), you could convert them to a soundless OGG file with:

```
ffmpeg2theora filename%03d.png -o output.ogv
```

Sound is possible too, as well as being able to set the quality and frame rates. Consult the `ffmpeg2theora` documentation for more.

241.2. Converting AVIs to Ogg Theora

`ffmpeg2theora` can also convert AVI movies to OGG. Usage example:

```
ffmpeg2theora --optimize my.avi
```

¹ [http://www.v2v.cc/~j/ffmpeg2theora/](http://www.v2v.cc/~j/ffmpeg2theora/)
242. Creating animated GIFs using Blender and Gimp

This tutorial will guide you through how to make a simple animated Gif Using Blender and Gimp. This is useful for creating Avatars for forums etc. This tutorial assumes basic knowledge of blender and Gimp, see the basic animation tutorial\(^1\).

To start off you will need an animation, this usually should be no longer than 25 frames long.

1. Open Blender. and delete the default cube and add a UV sphere, the default settings for the sphere work fine.
2. Now set the camera size in the scene buttons (F10) to 50 by 50 (I am creating an avatar for deviant art where the required size is 50 by 50 pixels, you may change this if you want)
3. set the frames to start at frame 1 and end at frame 20.
4. select the sphere and insert a LOC keyframe at frame 1 and 21, then go to frame 11, move the sphere and insert another LOC keyframe. this will create a looping animation.
5. Set the image type to PNG or JPEG (it doesn’t matter) and render the animation.

Now to combine the images into an animated GIF using Gimp.

1. Open the first image with gimp.
2. Now click File-> open as Layer or press "Ctrl-Alt-O". Select the next frame and it will be added as a new layer. Repeat this for all of the images, or select all of the images by pressing "Ctrl-A".
3. If you press Filters->Animation->Playback it should play the animation. It will probably have a low frame rate making it "choppy", this will be fixed in the next step.
4. Change the frame rate to 40 ms(25 frames per second). Choose file->Save as-> "Name".gif, then choose Save as Animation.

Note: Don’t know wheter this is an additional feature of Gimp 2.6.8 or not, but i found out following: In Gimp 2.6.8, within the export wizard, you have to choose option: -save as animation- first and next at the option: -single picture where not mentioned- the option: one single picture per layer. -Sorry i use the german version of gimp-

You should end up with something like this:

\(^1\) [http://en.wikibooks.org/wiki/Blender_3D%3A_Noob_to_Pro%2FBasic_Aimation](http://en.wikibooks.org/wiki/Blender_3D%3A_Noob_to_Pro%2FBasic_Aimation)
Creating animated GIFs using Blender and Gimp

Figure 1458
243. 3D Tiling Backgrounds For The Web

243.1. Overview

This tutorial will guide you through the process of making 3D tiling backgrounds for use with web pages, your desktop, or anything else for that matter. We will be using Blender and a graphic editing program such as Adobe Photoshop or GIMP. I will provide detailed explanation to cater to beginners, however more experienced Blenderists can probably get away with just following the picture diagrams provided. You may also find the diagrams useful if English is not your native language, or if you hate reading instructions.

----

243.2. Create The Object You Wish To Tile

Start up Blender and look at your lonely cube. We will use this cube as a starting point for the sake of demonstration, but feel free to use any shape you like. Press "Tab" to enter Edit Mode. Press the "E" key on your keyboard and the Extrude menu will appear. Select "Individual Faces". As you then drag your mouse cursor you will see some numbers move in the bottom left in the window and text saying "Shrink/Fatten". I recommend setting it to 1.0000 to keep it simple. Hold down the "Ctrl" key while dragging to do so in set increments.

Next, with the six faces of the cube still selected, press the "S" key to scale those faces. I recommend scaling to 0.8000.
Good. Now that we have created our object we will prepare to tile it.

243.3. Specify Your Tiling Area

"Tab" back into Object Mode and press "NumPad 7" to go to the Top View, or manually click "View" at the bottom of the window and select "Top".

Press "spacebar" and from the menu that appears select "Add" > "Mesh" > "Plane". The plane has appeared, but is obstructed by our cube object, so press "S" to scale the plane to 5.0000.
You’ll notice that I’ve colored my plane black. This is only to make it easier for you to see. You need not bother with this as we will be deleting the face of this plane shortly.
We now have an easily visible boundary representing the area which will be tiled. If at any point we decide we no longer need or want this we can move it to another layer by pressing "M " and selecting a layer to move it to.

243.4. Tile Away!

Now the fun part begins. If you have created 2D tiling backgrounds before, this concept will be very familiar to you.
While in **Object Mode**, select your cube object. At this point you have a couple of options. One is to make duplicates of the cube object. Another is to make **linked** duplicates of the cube object. I recommend making linked duplicates because you can later edit the mesh of one object in order to change the mesh of all the duplicated objects. This can be especially useful if you later plan to animate your tiling background (*careful not to distract from the foreground*). It is also useful if you want to experiment with new designs easily without having to re-place all your objects.

With your cube object still selected, press **"Alt+D"** to make a linked duplicate. (*Non-linked duplication is done with "Shift+D") Now hold down **"Ctrl"** to move in set increments and move the object to one of the corners of our plane. Make sure the center of the object (represented by a pink dot) is aligned with the very corner of the plane. At this point you may notice it’s somewhat difficult to tell whether the center of the object is exactly on the corner of the plane, and that’s why we are going to press **"NumPad 5"** or click **"View"** and select **"Orthographic"**. For all practical purposes we can spend the rest of the time we are building the tiling pattern in Orthographic View because this view is essential for tiling.

Now with your duplicate object still selected, scale it (**"S"** key) so that is somewhat smaller than the first. Then rotate it using the **"R"** key. While rotating you can constrain to a particular axis by typing **"X"**, **"Y"**, or **"Z"** respectively.

We will now make linked duplicates (**Alt+D**) of our rotated and scaled cube object and place one in each corner exactly on the grid (remember to hold **"Ctrl"** while dragging). If you place an object in one corner, you must place it in all four corners because corners touch both the X axis and the Y axis.
Now as you will notice in the following diagram, I made an object that is crossing over the edge of our plane. This is good. This is how to make natural tiling backgrounds. However! Whenever we do this we must be absolutely certain to do the same on the opposite side, or else our backgrounds will not tile properly.

So now we’ve created a few objects of different sizes and orientations, however they have all been along the same spot on the \( Z \) axis. So let’s give our pattern some depth - after all, that is the joy of working in 3D!

Before we do this, we’ll want to get our guide plane out of the way. So right click on the plane to select it, then ”Tab ” into Edit Mode . Press ”X ” and from the Erase menu
choose "**Only Faces**". Now "**Tab**" back into **Object Mode**. There! We now have only the segments of the plane as our guide.

![Image of 3D modeling scene](image.png)

**Figure 1465**

Hold down the **middle mouse button** while dragging the mouse to see what our design looks like in three dimensions. Now right click one of the cube objects, duplicate a linked copy (**Alt+D**), and press "**Z**" to constrain movement to the Z axis.
Navigate in this way along the X and Y axis as well and once you’ve found a good spot, **scale** and **rotate**. Remember to make a duplicate on the opposite side whenever you cross the outline of the plane guide. You can go on like this and populate your tiling pattern with as many objects as you wish. The grid is your friend during this process, so you should always have your finger on "**Ctrl**" while moving the duplicate of an object that crosses a border of the guide plane. Also, any object that will "tile" across the border must be at the same point on the Z axis as its counterpart on the other side of the seam. Press "**NumPad 7**" periodically to see where you are from a 2D standpoint. This is the view from which we will eventually render the image, so this perspective is the one that counts. Beginners,
remember that mouse wheel zooms in and out, and "Shift+middle mouse button " allows you to "drag" your way around.

![Figure 1467](image)

Keep in mind that in Orthographic View we do not perceive the depth of objects. Those far away and those near by appear to be at the same distance. This is what allows us to make a tiled image, but it also limits the apparent depth of the scene. We can compensate for this by scaling down the objects we want to appear further away. Or, as in this example, we can just make each object a different size and place some in front of others.

243.5. Camera Settings

We will now position the camera directly over our cluster of objects. Press "NumPad 7 ", center the view on the cluster using "Shift+middle mouse button ", and zoom out a couple notches with the mouse wheel. From the 3D View Window’s menu, click "View " > "Align View " > "Align Active Camera to View ". Now you may be wondering why everything appears to be distorted. This is because when we changed to the camera’s perspective, the view automatically reverted to Perspective View because by default the camera is set to that view. But just as we changed to Orthographic View in the 3D View Window, we can change the view of the camera as well. While in Object Mode , swivel the view until you see the camera. It is represented by a pyramidal wireframe with a black triangle atop the opening. Right click to select it. Now press ‘F9 ’ or click the Editing button (it’s icon is four vertices joined in a square). Now in the Camera panel you will see a button labelled "Orthographic ". Press it. Above the button is a value labelled Scale . Set it to around 20. (See figure below)
243.6. Lighting & Materials

Place some lights in your scene, and add some materials to your objects. **Lighting** and **materials** are subjects which demand their own tutorials, so if you don’t know how to do these things yet, please consult the Wiki.

**Note:** I advise lighting your scene pretty evenly in order to make the tiling seem contiguous.

**Note:** You could also only use Sun lamp, so the light is clean all over the mesh!

243.7. Rendering

Now that you’ve presumably got your lighting and materials as you want them, it’s time to render the scene. Under **User Preferences** click "Render " > "Render Settings " or just press "F10 ". In the **Format** tab you can choose the dimensions of your rendered image, the file format you prefer, and the quality. I’m going with 800x600 at 100% quality.
243.8. 'Shopping

And it’s time to begin post-production. Open your rendered image in your preferred image editor. I will be using Photoshop in this example. Now find and mark the four corners of your tile (on a new layer of course). Just eyeball it.

We will use guides to mark the tile boundaries. In Photoshop guides can be inserted by selecting "View > New Guide... ". Guides can be positioned with the Move Tool. You can zoom in and make sure your guides are accurately positioned by holding "Ctrl " while typing "+ " or "- ". You can now hide or delete the layer with the markers, as that was only to help us get accurate guides.

Should you decide to make an animated tiling background I recommend layering all your frames on top of one another in your image editor before editing in order to keep the position uniform. You can then animate them using Adobe ImageReady (comes with Photoshop) or find decent low-budget and occasionally free GIF animation programs online.

Figure 1469
Now select an area just outside of the guides with the Marquee Tool. Make sure Feather is set to 0px and that the marquee is rectangular and Style is set to Normal (meaning no Fixed Aspect Ratio or Fixed Size). Also, it will help you to have Snap enabled, so go to View and make sure it is enabled for guides.

Once you have selected the area, copy (Ctrl+C) and paste (Ctrl+V). Then drag to the right using the Move Tool and that piece should snap to the inside of the rightmost vertical guide.
Select the Eraser Tool and choose a brush size. I’m going with a diameter of 65. You’ll want to use a soft gradient-like brush for this. Now erase the left edge of the newly pasted selection so that it blends into the picture. Don’t erase any of the right edge.

Press "Ctrl+E" or alternatively, select "Layer" > "Merge Down".

Alright, so that procedure you just performed copying from left to right - now do it bottom to top. Once again, erase the edge. Do a Save As.

Finally, select the square center area that will become your tile and do "Image" > "Crop".

Now scale your new tiling background to a web-friendly size. Save As a JPEG, GIF, or PNG. You’re done!

Note: If your pattern still isn’t tiling quite perfectly, load the version with the guides again and repeat the copy-paste-erase process. Remember to merge down your layers each time or the corners may not tile correctly. If still no joy, try tiling the background in a web browser, taking a screenshot, pasting that into your graphics editor, and touching up from there.

Here is the final result:
Figure 1473
244. Cool Things That Aren’t That Obvious in Blender

Cool things in blender that aren’t that obvious. Useful tips and tricks in Blender.

244.1. Attribution

Many of The Following Tips and Tricks have been contributed by members of the CGsociety.org\(^1\), a Public Society for Digital Artists. The tips have been extracted from a CGsociety thread\(^2\). They have been roughly edited to improve readability.

244.2. File Browser Functions

244.2.1. Delete, Move, Rename, and Make Directory

When you are inside a file browser for loading or saving something and you want to create a new directory, just add the name to the path on top of the window and confirm 'Makedir'. you can also delete(x), move(m), or rename(n) a file. you can do action on multiple files by seling with right click.

244.2.2. Preview images when loading them as a texture

Whenever you are loading images as a texture, you can hold down Ctrl while clicking on the 'load'

244.2.3. Trick for Creating Quick File Revisions

After you have saved a blend file or an image you can then save it in progression that is: car.blend. or car.JPG
Next time do ”Save As” then press the + (plus) key which will advance the blend file by 1 every time it’s pressed. example: car .blend becomes car 1.blend. press again car 2.blend and so on.

\(^1\) http://www.cgsociety.org/
\(^2\) http://forums.cgsociety.org/showthread.php?t=52560&page=1&pp=15
The - (minus) key will subtract one. I've gotten into the habit of saving frequently. Yeah I know there is now the undo feature but I like this better because it gives you a history in case you need to back a few levels of a build. You get a saved version at the level you choose.

Note: Blender automatically detects the number... meaning it does not need to be in any position. For instance: If you have a file named 001starport.png or .blend or whatever, pressing the + (plus) key will automatically name it 002starport.png. If you want to name it starport1.png, it will change it to starport2.png.

Two rules: The filename has to have a number. It can be 0, or 1, or 3.141569.

If the file number is a negative, pressing + (plus) key will increase the "magnitude" of the negative number. I may have used magnitude wrong, if so, I mean pressing the + (plus) key will make -0.04 drop to -0.05. The - (minus) key will bring you only to 0, and then it will start to eat itself up.

244.2.4. Open Recent

Control O

244.3. Object/Vertex Manipulation

244.3.1. Constrain Movement to one Axis or to a plane

when moving objects/vertices or set of objects/vertices ([G] key) if you move in the direction of the global X axis (Up/Down) and then press the MMB , movement will be constrained to only move in the X axis, or if you move the vertices in the direction of the Y axis and then press MMB it will be constrained to move only in the Y axis. The same is true of the Z axis.

You can achieve the same effect by using the X, Y or Z keys while in grab mode. You simply have to press X key, Y or Z, once to lock to X Y or Z global axis,*

To Constrain the Movement to two axes (a plane): Press Ctrl+X to move in the Z-Y-Plane. Ctrl+Z =XY, Ctrl+Y =XZ.*

Alternatively, Select scaling mode and select the axis not to scale with the selecting button at the same time as you hit Shift .

• in every case You can hit the X,Y or Z button again to constrain movement to a different set of axes. Normally this different set of axes is local. However you can change the identity of this set to global, local, normal, or view by pressing Alt+Space . which cycles through the different identities.

Note: All of these shortcuts work with scaling and Rotating as well
244.3.2. **Shrink/fatten mesh in direction of vertex normals**

When you’re mesh-editing, **Alt+S** will shrink/fatten the mesh selection in the direction of the vertex normals.

244.3.3. **Vertex Parenting**

You can parent object to a Mesh, in that case you are parenting to the center of the mesh. BUT if the mesh is translated somehow (let’s say by an armature’s pose) the center remains in the same spot, and thus the child object doesn’t receive any transformation at all.

To solve this, you can parent the child object to a vertex (or a face) within the mesh, and any transformation that the vertex receives is passed to the child.

There are only 2 options, to parent to any 3 vertex within the mesh or to parent to just one vertex. If you parent to 1 vertex then only location information is passed, with 3 vertex all transformations (rotation, location and size) are passed to the child.

**How to do it?** Starting in object mode select the child(ren), hold **Shift** and select the parent, enter edit mode, select one or three vertex, press **Ctrl+P** . That’s it!

244.3.4. **Work around to welding Verts**

For Edge loop (Verts) position both loops together as close as possible then hit W then 4 (not on numkey pad). You can adjust how far the effect of collapse can go in the Edit window (a button on the right labeled Limit: ***, where * is a number).

As for individual Verts, e.g. Two vertices welded to become one, select both Verts, scale until they are very close then hit W then 4.

you can also do this with the snap combo

select the vertex you want to weld together **Ctrl+S**, Cur -> Sel **Ctrl+S**, Sel -> Cur [W], Remove Doubles

Also, whenever Blender pop up a menu with different options, you can just type in a number to choose one of the options (use the numbers not on the **NumPad** )

244.3.5. **Make individual objects the camera and Change them back**

If you select certain objects and press **Ctrl+0** (zero) it will make them the camera. I use it all the time to align spotlights.

Select your camera and hit **Ctrl NumPad 0** to make it the active camera again
244.3.6. Ordering Meshes in Vertex Groups

If you are preparing to skin your meshes and you are ready to create the vertex groups, you should pay attention to the order in which you create them, because once they are created there is no way to re-arrange them on the vertex-group list.

That means that if you are a ultra-by-the-book person and you would like the vertex group alphabetically ordered on the list then you must create them in alphabetical order.

.. Or, if you would like them to be ordered according to their function (shoulders, then arms, then forearms, then palms, etc. you must create them in that order.

This may all sound like a stupid thing to care about, but If you have a character with 39 vertex groups you may quickly find that when one of them needs fixing it is a little difficult since they were randomly created.

244.3.7. Position and scale along face normal,

- **Shift V**: Position camera along face normal, **Alt S**: scale selected vertices along face normal

244.3.8. Using Fake Users

pressing **Shift+F4** will turn the window into a "Data Select Window" where you can assign and unassign fake users to almost everything by selecting the name and pressing the F key

Creating a fake user allows you to keep useful data blocks (materials, textures, base meshes) at hand even if they are not linked to an object. You can use it to set a default material that would have the shader you like best.

244.3.9. Align a selection of vertices on a plane

If you want to perfectly align a selection of vertices on a plane, you just have to follow these little steps:

1.) Before you are selecting the vertices you want to align, position your 3D cursor in the plane that you want to align to (you could select the 4 vertices of a big plane and hit **Shift+S / Cursor->Selection** for example, but you can position it anywhere)

2.) Now select those vertices you want to align

3.) Choose "3D Cursor" under "Rotation/Scaling Pivot"

4.) Now with the **[S]** -key start scaling mode, hit the key of the axis you want to move the vertices on (X,Y,Z)

5.) Holding down the **Ctrl-Key**, you can now move the vertices in one line towards the cursor, until the value for the chosen axis is 0.000. Alternatively, just enter, using the keyboard, the scale factor you want (0 in this case).

6.) Hit LMB. The vertices are perfectly aligned along a plane through the 3D cursor.

1682
This even works very well while in perspective view mode, so you can align on the fly and don’t have to switch to front/side/top view all the time.

**244.3.10. Welding Vertices**

You can weld vertices by selecting them in edit mode and pressing $\text{Alt} + \text{M}$.

**244.3.11. View wireframe of hidden Verts**

To view the wireframe of hidden Verts, make sure you are in WIREFRAME MODE and then turn SubSurf on and change the level to 0 If you already knew about this then

**244.3.12. Select a true loop**

Shortcut is $\text{Shift} + \text{Alt} + \text{right Button}$ of the mouse, serves to select true loop, in vertices as in edges like in faces.

**244.3.13. Selecting one object from a single mesh comprised of multiple objects**

If you have more than in Edit Mode, you can place your mouse cursor next to one of the Verts in the desired object, then press the "L" key to select all of the Verts linked to that one. "Alt+L” reselects in the same manner.

**244.3.14. Precise Zoom and Select/Deselect**

Selecting: If you Hold down the $\text{Ctrl} + \text{LMB}$ (left mouse button) and drag the mouse, it will allow you draw a selection as opposed to using the B button which gives you a square.

Deselecting: To draw an area to deselect, Hold down the $\text{Ctrl} + \text{Shift} + \text{LMB}$ (left mouse button) and drag the mouse.

Zooming: Hold down the $\text{Ctrl} + \text{MMB}$. Move your mouse vertically to can get a more controlled zoom versus scrolling the Mouse wheel.

This feature may not be present in 2.37 or earlier versions.

**244.3.15. Mouse Gestures**

Left click and draw:

- a straight line - moves the selected object.
- a circle - rotates the selected object (note: this must be drawn fairly circle-like).
- a V - scales the selected object.
244.3.16. Selecting Obscured or Hidden Objects

Say you are in front or side view and you want to select an object, but it is obscured or
hidden behind other objects. If you press Alt RMB over a group of objects, a menu will
be displayed in the 3D window allowing you to pick the object you wish to select.

244.3.17. Select or Deselect Multiple Vertices

In Edit mode, when you click the RMB near a vertex that vertex (face or edge) will be
selected, RMB again will reselect. By holding the Shift key this will allow you to add each
selected vertex (face or edge) in that highlighted group.

Pressing the U key (Undo in Edit mode) will also remove the last selection you made.

Alternatively, you can Press B and then draw a box with MMB. Anything caught in the
box will be deselected. Also works with BB and the draw selection. Draw with MMB and
you reselect.

244.3.18. Selecting multiple items

You can hold Shift and use right mouse button to select multiple items to append.

244.3.19. Measuring, length, distance on an object.

Hit "F9" (editing), you should have split (2) windows. One "3d" the other "buttons" go to
the Mesh Tools 1 panel and press the Edge Length, Edge Angles and the dimensions will
appear on your selections in the 3d view.

244.3.20. Adding Connected Vertices

In Edit Mode, if only one vertex is selected, pressing "E" will add a vertex, on a freely
defined place, connected to the selected one. As will holding CTR L and left clicking the
mouse where you want the new vertex to be positioned.

Note: It must be an Image texture and in wireframe mode to be visible.

(2.37a)

244.3.21. Recalculate Normals

Ctrl + N = Recalculate normals outside (you might have to select faces before doing so)
Shift + Ctrl + N = Recalculate normals inside

These two hotkeys are useful when you extrude some edges and see a kind of seam in
between (due to normals pointing in different directions).
Then, after selecting an edge, Ctrl + NumPad(+) selects the face associated with this edge. Ctrl + NumPad(-) deselect the face.

244.3.22. Create a Quad from two Tris

Alt + J when having two Tris selected makes a Quad.

244.3.23. Remove Doubles

To Remove Doubles use hotKey: W. You can adjust the "limit" option so that "Remove Doubles" has more or less tolerance. This option is located in editing window under the mesh tools panel, (i.e. weld vertices that are further?)

244.3.24. Combine edit levels on a mesh.

When in Edit mode for a mesh (TAB key) you can choose the level that you wish to edit at. At the bottom of the 3D window, there are four buttons. Vertex, edge, face & back-face cull.

By default the vertex level is selected, if you hold Shift and press the edge button, you can use both at once.

244.3.25. Change Select Mode

to change select mode (vertex, edge or face) you can press Ctrl+Tab. But this way you can’t use the Ctrl+Key to ADD the select modes.. Still could be useful, if you don’t have a header for the window you’re working in..

244.3.26. Precision Warping

When using the warp tool (Shift+W ) you may find that there are times when you have trouble perfectly closing a 360-degree loop. This is because Blender will warp based on the total width of the selection, which may not necessarily be what you want.

Getting around this is simple, just select two verts to denote the new endpoints, duplicate them (Shift+D ), scale the two verts times two, so they are just twice as far apart. Then select what you want to warp plus those two marker verts, and warp 720 degrees.

When done, click a vert on your mesh and type L to select everything linked to it. Then type H to hide it. Once you’ve hidden all of your mesh, all that remains are the two marker verts. Do a Select All (A ) and type X to delete them. Now unhide your mesh using Alt+H and you have just the warped mesh, extra guide verts are all cleaned up.
244.3.27. Precision Cutting

The Knife Tool can actually be quite precise if you take advantage of the snap feature. Press **K**, choose "Knife(Exact)" and then hold the **Ctrl** key while choosing where you wish to cut and you will find that the path to be cut will now snap to nearby vertices.

Keep in mind that the vertices being snapped to don’t have to be the ones you are cutting. Say you want to cut the midsection out of a UV sphere and you want the cut to be two grid units in height. While viewing the side of the sphere, add a plane, and scale it to be two grid units tall, and wide enough so that it extends beyond the sphere. Now select the vertices of the sphere (because what we have selected is what gets cut) and when you cut it, snap to the four verts of the plane. Now hit **Enter** to apply your perfect cut.

Using guide geometry such as a plane to cut other geometry "cookie-cutter" style can be extremely useful when accuracy is needed. Remember to align your view before cutting, since your view will determine the angle from which the geometry is cut.

244.4. Working with Meshes

244.4.1. Turning Sub-Surfed Mesh into Normal Mesh

If you have a sub-surfed mesh you can turn THAT sub-surf mesh into a normal mesh. Just select the sub-surfed mesh and press **Alt+C** (Conversion).

244.4.2. How to remove (numb) black spots on a Mesh

If a Sub-Surfed mesh becomes (numb) black on some places, that’s because of the normals. Select all and press **Ctrl+n** and then confirm. now it should look prettier!

if the above solution does not work, save your Blend file, Quit Blender then restart. Use **Ctrl O** to open the last file and your mesh will have returned to correct shaded state.

244.4.3. Select all holes in a mesh and fill them

**Shift+M** * selects all Non-manifold edges/vertices (holes) in a mesh **. Then all you have to do is hit **Ctrl+F** to auto-fill those holes with 'beauty fill'.

**Shift+M** is an alternative shortcut for 'Select Non-manifold’. You’ll find this in the select menu when in mesh edit mode. The listed short cut there is **Ctrl+Alt+Shift+M** . **Shift M** is obviously a lot more comfortable on the fingers though!

•

Although 'Non-manifold' usually refers to holes in your mesh, it is not necessarily only holes e.g., an edge with three faces coming out of it is also a non-manifold edge!
244.4.4. Fill in four or fewer vertices

Select the vertices and press [F], this will fill in the empty space around them.

To clean up a filled in space, select all the vertices for the area, and press [F]. Choose OK to make FCon. For example: add a plane in wireframe mode, extrude it several times, select all vertexes, then hit [F].

244.5. Animation

244.5.1. Animation Preview in all windows at the same time

It is well known that Alt + a is for previewing an animation on the 3D window. But that’s not all of it. Divide your screen into multiple 3D Windows, each from a different point of view.

Press Alt + Shift + a

Enjoy!!!

If you have an Action/Ipo Window and 3D windows open, and you issue the Alt + Shift + a command from the Action (or the Ipo) window, it will animate both (the action and the 3D) in sync!! Great for visualization of Ipo’s effect on your model.

244.5.2. Choose animation mode, Convert mouse movements to IPO

-T in IPO window: Choose animation mode, i.e., linear, bezier, constant -[R] in IPO window: Record mouse movements, and convert to IPO

244.5.3. Animate procedural textures

To animate procedural textures, press 'i' with the mouse pointer in the materials window, and select the type of Key-Frame you wish to set in the pop up menu. advance a few frames, tweak your materials, and set another key frame.

244.6. UV Mapping, Particles and Texturing

244.6.1. Blender color picker

Blender has a PhotoShop-esque color picker. Simply click on the color preview next to the sliders to use it. Hit enter when you have the color you want.
244.6.2. Saving your face groups selections

Regarding UV mapping and Face Groups Selections there seems to be the general misconception that you can’t save your face groups selections on Blender.

Most people already know that from within the Face Select Mode (Potato Mode) you can switch into Edit Mode and whatever selection you do while in Edit Mode is passed back to Face Select Mode when you exit the Edit Mode.

Well, Did you ever wonder why Material Index Groups (that are nothing more than face groups with a common material on them) have those little ‘Select’ and ‘Deselect’ buttons there? Sure they come handy for later modification of the material index but that is not all about them.

Do this: Before starting the UV unwrapping job, cut your mesh by creating as many material indexes as you need, you can even assign each one a different color so you can be sure that there is no face orphan. Once you have the mesh all cut and sliced (so to speak) you enter in Face Select Mode, then switch into Edit Mode, select the index containing the faces you want to unwrap, press ‘Select’, leave Edit Mode and Voile! You now have an entirely useful face group waiting for you to unwrap. No more manual (and imprecise) face selection is needed.

If you later need to change the mapping of those faces, don’t fear. Just make sure there isn’t any face selected on Potato Mode, do as you did first (enter edit mode, select the index, exit edit mode) and there are your very same faces selected again with the UV mapping you already assigned to them.

Note: Another benefit of have precise face selection groups is that, initially, you don’t have to worry about UV coordinates overlapping, since you know have the way to select ONLY the faces you want to. For example, you unwrap all your faces by groups and when you are done you can start thinking about scale and position within the texture map, not like before when you have to solve those things as you go.

244.6.3. Bulk Texture Change

Consider a scenario in which you have a scene with a 100 mesh objects, and 50 of them have one texture and 50 of them have another.

If you want to change the texture of the first 50, but don’t want to change each individually, do the following. Add a Plane out of the view of the camera. Add your new texture (Material) to the plane. Then use the “Copy to material Buffer” button in the header of the Material buttons. Select one mesh object of the same sort that you want to change, open Material buttons and Paste from Material Buffer.

All the mesh objects with the same texture will now have the new texture.

Alternatively, If you have a material that you want to apply to a lot of objects at once:

1. Select all the objects you want to apply the material to. 2. Apply a material. (this only applies to the last selected object) 3. press Ctrl+L > Materials. (this links the material of the last selected object to all the other objects)
244.6.4. Negative Meta-Balls

Add->Metaball as usual. Exit EDIT mode and Add->Metaball. This time before you exit EDIT mode, hit the Negative button in the EDIT buttons window. Then leave edit mode.

If you move the negative Metaball around, you can see the effect it has on the positive metaball.

Be careful though, as negative metaballs are not displayed in the same manner as positive metaballs, you will only see the Pivot point not a meta-mesh.

This is a little test you can try to see the amazing effects negative metaballs can produce.

Make 1 Metaball, make it big. Place three spheres (UV) inside, make them emit particles, one 100, one 200, one 300 particles. Parent three negative metaballs, one to each sphere, and use dupli-vert on each sphere. Make the 100 duplicate metaball quite big, the 200 medium and the 300 small. Hit Alt A to run animation in 3D window.

(Click here for this author’s negative-metaball thread... oops, it’s not there anymore, well, not the AVI anyway!) ³

(Click here for this author’s negative-metaball AVI.) ⁴

244.6.5. Maintain the UV layout when moving/scaling/rotating UV co-ords.

When you have the UV image/editor window open and have loaded an image you want to UV map to a mesh, click on the UV tab in the header bar and turn off ‘Snap UV to pixels’.

This will help to maintain the UV layout when moving/scaling/rotating UV co-ords.

244.7. Rendering

244.7.1. Tricks, related to the view ports and the render buffers

First. Switching among screens

So you have your screen made off the 3D window, the buttons window and the info window... but you are doing some fine tuning to the mesh in two places simultaneously, and they both need to zoom in the 3D window. You could scroll or zoom out, translate the view and zoom in again. None of them an elegant solution.

Another situation. You are working on a model and are using an image for reference. You are not tracing over the photo, just take a look at it often to make sure you don’t deviate too much from the concept. So you open the photo in a 2D program and keep switching back and forth from Blender.. or you have the photo open in an image window and keep maximizing and minimizing the window... another hassle

⁴ http://www.selleri.org/Blender/movies/Metaball.avi
Cool Things That Aren’t That Obvious in Blender

Worry no more!!! Blender can handle multiple virtual screen (ala Linux) and you can come and go from them with just one key stroke.

Just press Ctrl+Left Arrow or Ctrl+Right Arrow (for all of you OS X users, add a Shift ) and you are switching screens. Go ahead! By default EVERY .blend file comes with 3 screens ... and of course you can add/delete as many as you see fit.

the magic button to add or delete screens is right beside the Tools menu, up there in the info window.

244.7.2. Using the render buffers

Ok, so you set your scene and press RENDER, a nice window comes up and you see your hard work coming to existence (that’s the default behavior, if your change it on the display buttons then this may not work for you).

Do you realize that the window containing your render image is also a render buffer? Actually they are 2 buffers for your to play with. Whenever the render window is open (and you can re-open it by pressing F11 without having to wait again for the render) if you press the J key you can switch from Buffer A and B. (the last active one is what you save when you press F3). You can even switch buffers in the middle of a rendering (but I advice against that when rendering very complex scenes, you have been warned!)

The cool thing about having two separate render buffers is that you can have instant before-and-after images for things that you change in the scene. For example you are searching the perfect position for a light source in a scene, you place it and do a render, place the light in another position, switch to the second buffer and do a new render. Now, with the render window open, just press J to see how the change on the light’s position influence your scene and that makes your decision easier.

By the way, the render window can be zoomed (by the normal ways or by pressing Z ) to do a closer inspection of the image.

244.7.3. Render window Tricks

To zoom into the render window, use the ZKEY .

To find out what the (Red, Green, Blue, Alpha) values of rendered image are, left click and hold the button of your mouse.this will reveal the RGBA values of the pixel below the mouse cursor. i.e. R 127, G 255, B 13, A40. The values will appear in the bottom left corner of the render window. You can also hold the button and drag the mouse around. This will display the values of the pixels your mouse pointer passes over.

With the render window open, you can press AKEY to view an alpha version of the image. Press AKEY again to go back to the normal colour view.

To do a before/after comparison after making a change, hit JKEY to switch render buffers, then hit F12 to render. In the render window, use JKEY to alternate between the previous render and the current one, so you can easily see the differences.
244.7.4. Working while you Render

If you use a X/X11 based window manager, you do not need to watch blender while it renders, go to a different virtual desktop. Blender doesn’t have to keep X informed of what’s going on and rendering speed may increase.

244.7.5. Border Rendering

In the rendering buttons find the buttons marked "Border" and "Crop". If you depress "Border", you can get a rendering of any part of what the camera sees. Just do the following :

Go into a camera view using NumPad 0, press Shift+B. Then, mark the limits of the rendering as you want them using LMB. Next, render the usual way and the section you marked will be rendered first, then it will be integrated to the complete rendering. If you wish that *only* the chosen section would be rendered then click on the button marked "Crop" also.

244.7.6. Creating a cluster of particles which takes little time to render

Render some particles, and make the picture into an alpha mapped tga in GIMP or whatever graphics editing application you use.

Load the image onto a plane. Adjust the alpha settings accordingly. Parent the plane to the emitter. Press dupli-verts.

You now have a cluster of particles which takes relatively little time to render. Of course it doesn’t have to be an alpha map of particles. That’s entirely up to you.

244.7.7. Alpha from render view

When cut & pasting stuff from render window to {insert your favorite image editor here} using Alt+PrtScr, cut and paste the render first, come back to render window and press "A". It changes the view to alpha and you get black & white mask to cut the background nicely in the {again, favorite image editor}. Nice when you do testing in low res.

244.7.8. View alpha texture as wire.

Ctrl+d in 3d very usefully for preview without rendering.

Also, if you have an object (works best on a mesh plane) with an image texture, you can use Alt+V key outside edit mode. This will adjust the object’s size values so that the image won’t be stretched when projected.
244.8. Miscellaneous

244.8.1. Restoring your “lost” work.

If you go to the temp folder where you have Blender save its temp .Blend files, reload the most recent one and this will save you losing the whole of your work. You don’t even need to save a .Blend file for this to work. You can change the settings for this in the tool window at the top of the Blender screen.

244.8.2. Built in Hot-Key List

Since the few last versions (since 2.28 I think) blender has a built-in all inclusive hot-key list. Just open a text-editor window, and right besides the option to create a new text-buffer there is a menu option called “KEYLIST.intrr”. Select that option and the full list is loaded in memory.

--Edit: There may be many hot-keys missing, especially the newest ones, like M to mirror a mesh, K for the Knife tool, Alt+Z for textured view... but the list is a good start at least.

244.8.3. Un-compiled PlugIns

Blender can load plug-ins for texturing, sequence editor, etc. However, Blender comes with a few of such PlugIns un-compiled.

In Linux they are located on the plug-ins sub-directory of the default Blender install, and all that you need is a Make command to compile them. I don’t know how to compile them in Windows, but there they are, just waiting for you to awake them!!!

244.8.4. Blender “Easter Eggs” (Weird things included in blender)

All Publisher versions of Blender have been shipping with a Monkey mesh called Suzanne. Just open the main tool box (Space Bar ) -> Add -> Mesh -> and right below the other primitives you’ll see the Monkey.

Why/What it is for? Only NaN programmers know*. It is supposed to be a private joke among the blender developing team. Since then, its considered as a sort of mascot for blender. However, it is incredibly useful as a quick complex object for testing textures, shaders, etc..

By the Way, Suzanne isn’t the only joke included... but I won’t spoil the surprise. You will bump with them on your daily work, that is for sure.

• NaN was the company that originally developed Blender

Try this: run blender with the -Y argument (open the command prompt/terminal, go to your blender executable file folder, and type blender -Y)
244.8.5. Weird Error Message

Sometimes, when trying to use a boolean on a tri-based mesh, Blender gives the prompt: "Wanna Crash?" > Yes Please!

but clicking it doesn’t crash. This is because Blender is a lot more stable now compared to when that 'crash' request was coded. It also used to appear when using beauty fill after face fill. (Ctrl+F in edit mode)

Blender 2.37 now has a 'widget', which replicates the red/blue/green axis symbol in 3DSMax in the 3d windows. Rotation scaling and movement of objects/Verts/faces etc., can be manipulated using the widget, or in the usual manner of earlier versions of Blender.

244.8.6. Turn your blender animation into a screen-saver (Windows)

to turn your blender animation Windows binary file into a Windows screen saver, rename the EXE file into SCR and right click it and install!

244.8.7. Discover the FPS rate of a Window

If you hit Ctrl+Alt+T key in a window, Blender will tell you how much time it takes to render a single frame of that window, in milliseconds. Valuable Benchmark

244.9. ???

using construction widget press Shift to get precision mode for fine tuning. Release left mouse button (LMB) and holding Shift down press it again, then you’ll get moving along another axis.

244.10. Sculpt Mode Hotkeys

- F: an interactive brush resize
- Shift F: an interactive brush strength adjuster
- Ctrl F: in interactive texture angle adjuster for your brush.
- Shift B: a rectangular zoom selection for close-up work
- Alt B: hides all but selected rectangle
- A: toggles airbrush
- S: smooth
- D: draw
- G: grab
- L: layer
- I: inflate
- P: pinch
- V: toggles add and subtract in draw mode
- Use X, Y and Z to toggle axis mirroring.
245. Troubleshooting

245.0.1. ATI Radeon Slowdown Problems

Go the ATI site driver downloads section and select the appropriate OS/Graphic card. This will (most likely) link you to the dl for the current Catalyst 4.4 drivers.

At the bottom of that page is a link to "Previous driver versions".

D/L the Catalyst 3.7 driver package. Run the EXE and it will extract the driver install package to:

C:\ATI\SUPPORT\"/

In this directory will be a directory named (for XP/Win2K users: \w xp-w2k-7-93-030812a1-010735c-efg\"

This is where the driver install package is located. DO NOT RUN THE SETUP. You don’t need to install the old driver.

Navigate down thru the dir structure to the following dir: C:\ATI\SUPPORT\w xp-w2k-7-
93-030812a1-010735c-efg\2KXP_INF\B_10679

In this dir you’ll find a file called: atioglxx.dl__ This is a ”packed” version of the ATI OGL driver.

The next step specifies how you can extract these files to your hard disk using the ‘exp-
and.exe’ utility included on the cd.

The ‘I386’ folder on the Windows XP CD contains a utility ‘expand.exe’ that can be used to uncompress all compressed dll files. It is a commandline utility, so you have will have to run it from either the command prompt or the Run dialog. Some examples of its usage are:

```
expand X:\I386\ADROT.DL_ C:\ADROT.DLL
The above command decompresses the compressed DLL
```

ADROT.DL_ on the WinXP CD, copies it to C:, and changes the extension to .DLL .

Just extract that file (atioglxx.dll) to your Blender install directory. Usually C:\Program
Files\Blender Foundation\Blender\"/

Launch Blender.... no more slowdown.

Addendum: I found this solved a problem of crashing on start up after updating my Catalyst
driver from 7.2 to 7.8, that is expanding the old 7.2 atioglxx.dll_ to atioglxx.dll and copying
it to the Blender directory.
245.0.2. For people who the above solution leads to Blender crash at start up

Thanks to Xenobius at Blenderartists Forum

This solution is tested on ATI radeon express 200 (x200) integrated video card. However it should work on other ATI card.

Download the Nvidia 53.03 Driver HERE\(^1\)

Extract the driver to C:\NVIDIA

Copy the nvoglnt.dll from the C:\NVIDIA folder to your blender program folder (i.e. C:\Programs Files\Blender 2.40\)

Rename nvoglnt.dll (the one in the blender program folder) to atioglxx.dll

Run blender...voilà! Blender runs like it should!

[This works, because it can’t use proper gl calls and uses no hardware acceleration so speed goes crappy...]

246. Creating Blender Libraries

You’ve finally made that perfect object, armature or material: a gamepiece, a robot, a fully rigged vampire character, or a millimeter-accurate model of the Empire State Building. Besides using this work in your own artistic project, you have made the courageous decision to share that creation with the world.

Sharing your creative work is a great way to "give back to the community," even if you don’t write Blender code and you can’t translate the Blender documentation to Swahili.

246.1. How to Make a Library

So how do you make a library? In Blender, you don’t need to export to a special format. In fact, you don’t need to do anything special beyond saving your regular .blend file. Every .blend is a library file. Users can Append what they like from your .blend file, and ignore parts which they don’t need for their own project.

This scheme has some benefits and some drawbacks.

The benefit of using .blend files as a library format is that it’s super easy to include extra stuff to help the user see the objects. If the user loads the .blend file directly, it works like the pretty packaging for foods, including a quick and easy way to get a pretty "serving suggestion" rendering of the library contents. What you save in your .blend is what the user will see when they load it, including all your user interface settings, lighting types, and camera positions.

The drawback of using .blend files as a library format is that it’s super easy to include unintended things, such as extra meshes, unused material and texture channels, and other things which the user will not find helpful. Blender doesn’t save things which are no longer referenced anywhere, but it cannot read your mind if you leave a spare mesh on layer 13 which uses some abandoned Material.034.

Also, some people are not accustomed to the way that Blender saves all of the user interface settings along with the .blend file. When they load your mesh, they see your way of working. This can be instructive, but unless that’s your intention, it’s best to try to stick to a simple and clean user interface setup for your library files.

For best results, you need to apply some discipline to publish a clean and useful library.
246.2. Library Usefulness Checklist

After having used several library .blend files from various sources, I propose that anyone making libraries follow a few suggestions:

- keep to a certain object, theme or area of focus for each library file
- all the test cameras and lights prefixed with a dash; e.g., -Camera, -HemiLight.001, etc.
- any other components not intended for Appending prefixed with a dash; e.g., -ground
- all the test cameras and lights on the last one or two layers (lower right layer button)
- any composite object intended for Appending organized in a group to hold it together
- any groups, objects, materials, textures intended for Appending given meaningful names
- document your unit scheme; e.g., 1 blender unit == 1 imperial foot, etc.
- any other layer contains test-render-ready objects or scenes
- choose rendering and world settings which will not take an hour to make a simple test render
- make visible upon loading the layers required for a camera, a good lighting angle, and a shared object
- make visible upon loading one small text file which lists layers and objects
- make visible upon loading any python script, with instructions on how to start it in a big comment
- make your licensing expectations clear: artistic license, creative commons, etc.
- pack the texture files and other data before saving that final .blend for publishing
- sign your work, stable email address or website url if possible

The dash prefixes for test-rendering cameras, boxes, floors and lights will help the user know at a glance what to Append and what not to Append from your library.

Here’s a quick way to throw out all the stuff you really don’t need, including extra meshes, materials and user interface complexity.

- save your current .blend (and make a nice backup file too)
- shut down Blender entirely
- open up Blender again, which will load the default settings
- delete the cube and cameras from the default settings
- Append all the useful parts of your library .blend file (including the useful test-rendering items)
- select the proper test-rendering camera for users to try out your model quickly (select, then Ctrl+KEYPAD0)
- adjust the views to ensure important things are visible and ready to render
- save the new library .blend, ready to publish

Blender saves the default settings in a file called .b.blend on your disk. If your own preferred default settings are still too complicated for newcomers to understand, you can move that file away temporarily to get the "factory" built-in default settings which the Blender team produces as a part of each new version of the software. Move the file back again when you want to go back to your individual way of working.
246.3. Publishing Your Library

It’s helpful to include the .txt file and/or post it separately so that people can read a summary before loading the blend file. This should include any credits, usage notes, layer explanations, and licensing information. For you Unix folks, remember to run it through unix2dos to enforce \r\n CRLF newlines, readable by people with less flexible tools such as Windows Notepad.

It’s also of immense benefit to put up small test-renders of your library objects or materials. They don’t need to be large but they should give an honest view of the work you’re sharing before a potential user takes the time to download library files that will not be useful to them.

So, where do you publish your work of artistic genius?

- http://www.e2-productions.com/bmr Blender 3D Model Repository
- http://blenderartists.org/ forums
- http://www.deviantart.com/
- http://www.blendswap.com
- your own website

If you post things on your own website, try not to rely on a free site that will over-run your bandwidth limits and disappear two months later. Search engine links will sometimes live on for years, just frustrating those who were hoping to find a millimeter-accurate model of the Empire State Building.

246.4. Beyond Libraries

If you have even more time to spare, consider writing up a tutorial on how you achieved any tricky results!

246.5. Thank You

For every artist who chooses to share their creative works with the community, there are a dozen artists, or even hundreds, who thank you immensely.
247. Add some depth with stereo

This tutorial contains some tips for how to work with stereo images.

Stereo viewing is to see the same thing from two slightly different angles. This is what humans normally do with their two eyes. There are many ways to view a stereo image. A perfect method is to use a stereo monitor. But they are quite expensive, and many are of very low quality. In the other end of the price-scale you can use crossviewing. Put the two images next to each other, and look at one with one eye, and the other with the other eye. Needs a bit of practice though. A popular solution is red/blue anaglyph glasses, but they give very bad colors.

247.1. The stereo camera

I wanted a stereo camera rig that was easy to work with. It should have three cameras (center, left, and right), have an easy way to set separation (should be 1/30 of the distance) and the center cam should be used to control position etc, the two others should just follow.

247.1.1. Create it

Manually

1. Reset the cameras position, rotation and size (you can use \texttt{ALT} + \texttt{G}, \texttt{ALT} + \texttt{R} and \texttt{ALT} + \texttt{S}). You may want to note these values first, so you can change them back later. I just make sure there’s an IPO-curve for them, for example by making a keyframe (\texttt{F}).
2. Create two new cameras. Reset their position, rotation and size too.
3. Name them \texttt{Camera.Right} and \texttt{Camera.Left} or similar. Set LocX to 1 for \texttt{Camera.Right} and -1 for \texttt{Camera.Left}. (Press \texttt{N} to see data for selected object, in this window you can change name and values.) (Select a camera by clicking \texttt{F5} several times on the cameras, until the right one is selected.)
5. Switch to front view. (\texttt{F2})
6. Select \texttt{Camera.Left}. Then select \texttt{Camera} while holding down \texttt{SHIFT} so both are selected. Press \texttt{CTRL} + \texttt{F} and press \texttt{ENTER} to register \texttt{Camera} as parent. Then press \texttt{CTRL} + \texttt{L} and select \texttt{Camera Data}. Repeat with right \texttt{Camera.Right} and \texttt{Distance Cube}.

1701
Add some depth with stereo

With a script

Editor’s note
I tried making a script that creates the rig, it almost works. Any help finishing it?

```python
import Blender
from Blender import *

# Prepare
scene = Scene.getCurrent()
camera = Object.Get("Camera") # TODO validate that it is a camera
oldLocation = camera.loc
oldRotation = camera.rot
oldSize = camera.size

camera = Camera.New("ortho")
camera.link(c)
scene.link(camera)

camera = Camera.New("ortho")
camera.link(c)
scene.link(camera)

dEmpty = Object.New("Empty", "Distance")
scene.link(dEmpty)

# Configure
camera.loc = (0,0,0)
camera.rot = (0,0,0)
camera.size = (1,1,1)
cameraLeft.loc = (-1,0,0)
cameraLeft.rot = (0,0,0)
cameraLeft.size = (1,1,1)
cameraRight.loc = (1,0,0)
cameraRight.rot = (0,0,0)
cameraRight.size = (1,1,1)
dEmpty.loc = (0,0,-60)
dEmpty.rot = (0,0,0)
dEmpty.size = (1,1,1)
scene.update(1)

# Connect
camera.makeParent([cameraLeft, cameraRight, dEmpty], 0, 0)
# do that CTRL+KEY thing
cameraLeft.link(Camera.Get("Camera"))
cameraRight.link(Camera.Get("Camera"))

# Reset original values
camera.loc = oldLocation
camera.rot = oldRotation
camera.size = oldSize

# Finish
Blender.Redraw()
```
247.1.2. How to use it

- Never change the cube or the two side-cameras. Only change the center camera. Use that one for positioning, rotation etc.
- To set the separation: As always, select the center camera. Resize it (with \[ S \]) so you can see the end of the cube if needed. Point at the end of the cube with the mouse pointer, and press \[ S \]. Move the mouse pointer to the point of the main motive, that is closes to the camera. The end of the cube may not end exactly there, but that doesn’t matter.
- To render (or preview) with one of the side cameras, select it and press \[ CTRL + P \].

247.1.3. What needs improvement

The cube is visible

Instead of using a cube, I’d rather use something that doesn’t render. It could be an "empty", but see below.

The cube is hard to see

It can be hard to see where the cube ends, even in a simple scene. You can select the center camera AND the cube, then it is clearly visible. But you must remember to only select the camera, before you insert a keyframe, so your changes to the cube doesn’t get saved.

Distance plane is at infinity

The distance plane is where "zero depth is". When viewing a stereo image, the distance plane is where the medium is. In this rig the distance plane is at infinity, meaning everything is in front of it. While stuff popping out in front of the screen is cooler than stuff being "inside" the screen, it’s a lot harder to make it look nice. Specially because with everything in front of the screen, it’s easy to get stuff that is just way to close to the viewer. It can get so hard to see that the 3d-effect is completely gone.

A different solution is to make the side cameras point at the end of the cube, or add a plane to the rig, and point at that. But then the cameras are no longer parallel, and that creates distortion.

The compromise solution is to (conceptually) render the images too wide, and then crop the excess from the left side of the left image, and the right side of the right image. Then it will look like it points just like in the previously mentioned solution, but without the distortion.

But this give a lot of problems. First, I’d like to do this a smarter way, instead of just following the path describe above. But I don’t think that’s possible in Blender. (I think povray can actually do this.) So I need to render the image too wide. But if I increase width in output, it actually renders the same width of the motive, but decreases height. Then I need to do some weird math to get the right FOV, and I don’t know half the formulas.
Cropping must be done outside Blender, and the rest of "the production line" is hard to get back into Blender if wanted.

I guess a couple of planes in the rig close to the cameras could simulate the cropping, but that is of limited value. To make an adjustable distance plane with them seems quite hard to me, it would need some scripting I guess.

### 247.2. Stereo viewing with the rig

This is where it gets exciting, now you are actually getting something to look at.

1. Create a new screen, you could call it *Stereo View* .
2. The screen should have one big area from side to side.
3. Set the area to *3D View*.
4. Unlock it (The *Locks layers and used Camera to Scene* -lock)
5. Select *Camera.Right* and press $\text{CTRL} + \text{F}$
6. Split the area in half so there is two parts next to each other
7. In the *right* area, select *Camera.Left* and press $\text{CTRL} + \text{F}$
8. Adjust zoom in both areas so the frame that shows what is rendered is completely visible, but fill as much as possible. If you can’t make them same size, the two areas are not same size.
9. Use cross-view method to see the 3d-effect. Look at the left area with the right eye and right area with the left eye. (It’s a skill you need to learn and practice.)
10. Press $\text{SHIFT} + \text{ALT} + \text{A}$ to see your scene animated in stereo.

If you cannot see these, there is a lot of help with viewing them on the web. Use a search engine to find them.

### 247.3. Stereo rendering

#### 247.3.1. Anaglyph

Create two render layers in the *Render Layers* tab.
**Editor’s note**
You need to find how to associate one camera with one render layer

Then go the *Node Editor* and click on the button with a human face. Click on *Uses nodes* and remove the created items by selecting the items and clicking on `DEL`. Now, using the *Add* menu, you need to do this diagram:
Add some depth with stereo

Once done, return to the *Buttons window* and select the button *Do Composite* on the *Anim* tab:

Then click on the button *Render* on the *Render* tab:
You should see your objects as an anaglyph:

Figure 1477
Figure 1478
248. Ways to create a "fluffy" effect (materials and lights)

248.1. Spherical Blend Texture

This technique maps a spherical blend texture to the outsides of an object.

Create a new material and name it something intelligent. Create a new texture for this material, change the texture type to Blend, and then in the texture properties, change the blend shape to "Sphere".

![Figure 1479](image)

Back in the material buttons, go the "MapInput" tab and change the texture coordinates to Blank-Blank-Z and Nor and as demonstrated in the next screenshot:

![Figure 1480](image)

Finally go the "MapTop" tab, and depress the Emit button and set the Texture Blending Mode to "Add".
Ways to create a "fluffy" effect (materials and lights)

That’s all there is to it, and here is how it looks:

---

248.2. Backlighting

This is a technique that a rather famous blender user called "@ndy" uses. Very simple and effective.
All you need to do is place a Hemi light BEHIND the object you want to light in respect to the active camera.

Breakdown: First add a Hemi lamp to your scene:

Next, Select the lamp THEN press and hold down the Shift key, and select the Camera. Press Control-C to bring up the copy attributes menu, and copy location AND rotation.
Now select JUST your lamp, press R to rotate it, then press the X key TWICE to rotate around the local X axis. Using your numpad, key in ”180” to rotate the object 180Degrees.

All that remains to do is to press G to grab the lamp, then press Z TWICE to move along the local Z axis, and move the lamp until it is past and behind the object of interest. your resulting setup should look something like this:
And here is the rendered result:
Ways to create a "fluffy" effect (materials and lights)

Figure 1486

• Color ramp\(^1\) with input set to normal.
  Pretty straightforward, but many advise against it.
• Minnaert shader
  Available in 2.37, "Darkness"<1 actually brightens edge. A cool shader, but not very useful for this purpose.

---

\(^1\) http://www.blender3d.org/cms/Ramp_Shaders.348.0.html
249. Human Body

This tutorial should cover the modelling, skinning and animation of human body, plus facial expressions.

There are some tools to generate human body from parameters like:

- [http://www.makehuman.org/](http://www.makehuman.org/) makehuman\(^1\) free software program (gpl). The models generated are under MIT license. The models generated can be easily imported in blender. Use lightwave(obj) export. The exported file is located at ...\Documents\makehuman

![Figure 1487](image.png)

---

Delete the original cube first. The human object is smaller than the standard cube. Use the UVImage editor to see the UV mapping but it actually uses a texture stored in the image file texture.png

Figure 1488


links to anatomy sites:
• [http://www.fineart.sk/](http://www.fineart.sk/) fineart

---

Backlighting

tutorials: Blender_3D:_Tutorial_Links_List#Human\(^5\)

\(^5\) http://en.wikibooks.org/wiki/Blender_3D%3A_Tutorial_Links_List%23Human
250. Rendering Information

Only some links to wikipedia articles for now

- wikipedia:Rendering (computer graphics)\(^1\)
- wikipedia:Specular reflection\(^2\)
- wikipedia:Diffuse reflection\(^3\)
- wikipedia:Flat shading\(^4\)
- wikipedia:Gouraud shading\(^5\)
- wikipedia:Phong shading\(^6\)
- wikipedia:Lambertian diffuse lighting model\(^7\)
- wikipedia:Phong reflection model\(^8\)

---

1 [http://en.wikipedia.org/wiki/Rendering%20(computer%20graphics)]
4 [http://en.wikipedia.org/wiki/Flat%20shading]
5 [http://en.wikipedia.org/wiki/Gouraud%20shading]
6 [http://en.wikipedia.org/wiki/Phong%20shading]
7 [http://en.wikipedia.org/wiki/Lambertian%20diffuse%20lighting%20model]
251. Using Blender Libraries

You can append libraries in two ways. You can make a local copy of data blocks (like objects, meshes, ...) of the content of a .blend file in your .blend file (appending ) or you can use data blocks from another .blend file (dynamic linking ).

You can Append with the command in the 3d view File -> Append or SHIFT+F1 . When you give this command a file browser window opens. There are two buttons Append and Link at the bottom of the window. The default action is appending . But you can use dynamic linking selecting the link button.

At this point select the .blend file to append. You can select one of the following data blocks type to append:

- Group
- Mesh
- Object
- Scene
- Text
- World
- (not complete yet)

Note that this is a complete list, when you append only block types present in the file will appear. Select the desired type. Now you can select the particular data block to append by selecting its id.

251.1. Indirect linking

When you give an append or link command almost all relations between data blocks in Blender get expanded. For example, when you link (or append) a specific Group, all its objects, the meshes associated with the objects, the materials and the animations will be linked (or appended) too. That is called "indirect linking". When you use dynamic linking such indirect linked data is not stored when you save a .blend file, when you load the file again blender will look for the indirect linked data blocks in the library file.

251.2. Groups

When you append a Group, blender will also create links in the current Scene to the objects that are part of the group. The Objects then become visible. However, when you decide to dynamic link a Group, it won’t do that. To use the objects in your blender project
you can use the group as a **duplicator** "**SHIFT + A** KEY -> Group menu -> group id to duplicate".

### 251.3. See also

- [http://www.blender.org/cms/Library_Linking.769.0.html](http://www.blender.org/cms/Library_Linking.769.0.html)
- [http://www.blender.org/cms/Blender_Architecture.336.0.html](http://www.blender.org/cms/Blender_Architecture.336.0.html)
252. Beginning Modeling Final Project

Now that you’ve gotten the hang of 3D modeling, it’s important to get some community feedback on your progress. Don’t be an idiot and skip this part, or you’ll regret it later. Basically this will help you track your progress and give you something that you’ll be working on over a long term and something you’ll be proud of.

- First, you need to come up with a project idea. You can choose your own modeling project, or choose one from the list below.

- Second, you need to create a model of your idea. Spend a couple of hours on it, and give it some details.

- Third, once you believe you’ve come far enough with the model, post it in the Works In Progress\(^1\) forum on BlenderArtists.org(formerly elysiun.com) (you will have to create an account if you haven’t already). Post several screenshots of your model from within the Blender (note: creating screenshots is outside the scope of this wikibook, though see note lower down the page). You can post whatever subject and message with your posting that you would like, or you can use this suggested subject and message:

Subject: Beginning Modeling Final Project - <project name>

Please assist me with any feedback on my model, keeping in mind that I am an absolute beginner still. I appreciate your help.

- Wait for feedback. It usually comes very quickly. If you have any questions about feedback that you are given, don’t be afraid to ask your questions in the forum.

- When you and others that have viewed your work feel that you are ready, save your model in some place you can get back to easily. You will continue working on this project once you’ve learned some new skills.

- Move on to the next page.

\(^1\) http://blenderartists.org/forum/forumdisplay.php?sf=16
• List of ideas:
• A Computer and keyboard
• A fishing rod
• A train engine
• A skyscraper
• A robot
• A Tank (real or made up)
• An airplane
• A truck or car
• Household appliances
• A Weapon
253. Using Inkscape to make advanced Bezier curves

253.1. Introduction to Inkscape

Inkscape is a free program that uses SVG (Scalable Vector Graphics) for its file format, and these SVG files can be imported into blender as Bezier curves. Inkscape has some great tools for making advanced shapes that would take forever to make in Blender itself. We will use Inkscape because it is free, and it is very easy to learn.

253.1.1. Installing Inkscape

- Mac OS X and Windows: Go to Inkscape.org\(^1\) and click download. there will be installation files for each operating system.
- Linux: Go into the terminal.

For Arch Linux, type \texttt{pacman -S inkscape}
For Debian based distributions, type \texttt{sudo apt-get install inkscape}
For Fedora and rpm based distributions, type \texttt{yum -y install inkscape}
For any other distribution, check your package manager to see if it has a package for inkscape. if not, download the source code at Inkscape.org\(^2\) and run PKGBUILD in the directory of the source.

Inkscape is a pretty large program, so it will take a while to download and install.

253.2. Getting Started

Because blender doesn’t import any effects or filters from SVG files, we will only have to learn basic path modeling. This is very easy to learn, and will take no time at all. Once it’s finished installing, open Inkscape. You will see a large empty page and a bunch of buttons to the left. Don’t mind the empty page, we won’t be needing it. We will re-size this once we are done with the tutorial. Before we get started, I will show you how to use some of the controls. You will probably be right clicking a lot because you’re used to blender, but that’s okay. Let’s start out with a star to practice some of the controls. Click the Star/Polygon tool to the left, and click anywhere on the paper and drag.

\(^1\) http://inkscape.org/
\(^2\) http://inkscape.org/
253.2.1. Simple Controls

go back to "Object Mode" by clicking the cursor icon to the left. Now, let’s try out some of
the controls:

<table>
<thead>
<tr>
<th>Action</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In/Out</td>
<td>CTRL+SCROLL</td>
</tr>
<tr>
<td>Move along Y Axis</td>
<td>SCROLL</td>
</tr>
<tr>
<td>Move along X Axis</td>
<td>SHIFT+SCROLL</td>
</tr>
<tr>
<td>Move along both axes</td>
<td>Hold MMB and Drag</td>
</tr>
<tr>
<td>Select Path/Curve</td>
<td>LMB</td>
</tr>
<tr>
<td>Select All</td>
<td>CTRL+A</td>
</tr>
<tr>
<td>Select all paths/curves within a</td>
<td>Hold LMB and drag (Like selecting icons on</td>
</tr>
<tr>
<td>rectangle</td>
<td>your desktop)</td>
</tr>
</tbody>
</table>

These are only a few of the controls, you will learn more controls later in this tutorial.

253.2.2. Editing your Bezier path

Go back to the Star/Polygon tool so we can edit the star. You will see 2 dots appear on the
star. You can drag these around, and see what happens. Another thing you can do is add
more points to the star, change the spike ratio, make it rounded, and make it randomized
with the "CHANGE:" Dialog right above your image.

![Figure 1489](image)

If you want to edit each node separately without symmetry, go back to 'Select and Transform
Objects’ mode
and click Path>Object to Path. Now you can just go to 'Edit Paths by Nodes' mode
and play around with the shape a bit.

By clicking and dragging, you can move a node or curve an edge. When you make a curve, 2 nodes will show up that you can drag and edit the curve with more precision.

To add a node in the path, select an edge and press the plus button.
to remove a node, press the minus button, and, well, the buttons pretty much explain themselves, so you can just play around and see what you get.

After you think you know how to edit paths pretty well, let’s try to make a path from scratch. Click the 'Draw Bezier Curves' button.
and click to add nodes for the shape you want. If you click and drag, you will make a node and curve the node while dragging the mouse. To finish the path, go around to the first node that you made and click on it. This will finish the path and make it a solid shape. When it is done, a outline, or stroke of the shape will appear. If you want it to show as a solid shape, you can click one of the colors on the bottom and it will fill the path with that color.

Now, move the star inside the path (In 'Select and Transform Objects’ mode, of course), without it overlapping the borders of the path. If the star is too big, scale it down and hold ctrl to keep the same scale on the X and Y axis. Select both your path and the star, and press Path->Difference to cut a star-shaped hole inside your path.
Congratulations, You have made a completely pointless random shape and learned the basics of creating a shape in Inkscape! Now, It’s time to get this into Blender! Save your SVG image, and open up blender. Press File>Import>Paths(.svg, .ps, .eps, .ai, gimp) (Blender 2.49). Select your SVG file and the settings are fine how they are. Press OK and see your path appear in blender (You may have to delete the default cube to see it) From here, you can Extrude, bevel, and do whatever you want to you bezier path in blender.

The result may look something like this:

Figure 1494
254. Light Mapping

254.1. Needs Expert

The original writer of this section is not knowledgeable about the subject of "Light Mapping" and hopefully can benefit from someone who has much more experience with it.
255. Platonic Solids

The Platonic solids or Platonic polyhedra are the convex polyhedra where all faces are copies of the same regular polygon, and the same number of edges meet at every vertex. There are five of these shapes: the tetrahedron (like a pyramid but with a triangular base): cube, octahedron, dodecahedron and icosahedron.

Recent versions of Blender include an addon called “Regular Solids”, which lets you instantly generate these and a whole bunch of other similar shapes. However, the following steps do not require any addons.

Information

Applicable Blender version: 2.67

255.0.1. The Tetrahedron

Bring up the Add Mesh menu (Shift + A), and select a Cone. Set the number of Vertices to 3, leave Radius 1 at its default value of 1.000 and Radius 2 at 0.000. Now, set the Depth to $\sqrt{2} \approx 1.414$. To make sure that you have a regular tetrahedron, you can check the lengths of the edges (in Edit Mode, press N to open the Properties panel and locate the checkbox Length in the section Edge Info).

255.0.2. The Cube

This happens to be a built-in shape in Blender. Just bring up the Add Mesh menu, and select Cube. Done!

255.0.3. The Octahedron

This shape is the dual of the cube—it has vertices where the cube has faces, and faces where the cube has vertices. To make it, first create a cube. Press [TAB] to switch to Edit mode. All the vertices should already be selected. Press [W] to bring up the Specials menu, and select the Bevel function (or select it directly with [CTRL] + [F] ). As you move the mouse, you will see each vertex of the cube turn into a triangular face; don’t bother getting the shape exactly right, simply press [LMB] to finish the drag. Then, look in the panel that should have appeared at the bottom of the Toolshelf on the left of the 3D view (press [T] to toggle its visibility); you should see an editable numeric field labelled “Offset”. Type the value 1.0 into this field, and that should exactly form the octahedron shape.
Finally, bring up the Specials menu again, and this time select Remove Doubles.

### 255.0.4. The Icosahedron

Bring up the Add Mesh menu, and select an Icosphere. Set the Subdivision to 1. Simple!

### 255.0.5. The Dodecahedron

This shape is the dual of the icosahedron. To create it, make an icosahedron as above. Then do what you did to make an octahedron out of a cube: press TAB to switch to Edit mode. All the vertices should already be selected. Press W to bring up the Specials menu, and select the Bevel function. As with the octahedron, press LMB to finish the drag. Then type a number for the Offset: a value of 0.3035 seemed to be the closest I could find.

Then, bring up the Specials menu again, and this time select Remove Doubles. However, the default Merge Distance of 0.0001 will not be enough to remove all the doubled vertices; change this to 0.001, and you should see the message “Removed 40 vertices” briefly flash up.

![Figure 1495](image)

### 255.0.6. Exercise

What’s the dual of the tetrahedron? Try applying the Bevel operation to one of those; what do you end up with?

### 255.1. External Link

Wikipedia article¹

---

256. Modeling techniques and Workflow
257. Polygonal Modeling

As the name suggest, polygonal modeling involves constructing the models out of polygons. Strictly, software packages works only with triangles. Blender could show you quads and some software packages could even let you work with polygons with more than 4 sides (n-gons) but these packages work internally only with triangles. These triangles are hidden so that you could concentrate more on modeling.

While different modelers works differently, they would still follow certain workflows (some call this techniques). These are familiarly called box modeling and polygon-by-polygon modeling (poly-by-poly modeling).

**Box modeling** is a top-down approach where modelers start with a primitive (usually a cube (box), hence the box in box modeling). Then from this primitive, the model’s form is build up where details are gradually added.

**Poly-by-poly modeling** is almost the opposite of box modeling. It is the bottom-up approach where modelers start with a plane or even a vertex. Using extrusion and other tools, more geometries are added. Polygon by polygon the model is gradually build.

None of the two is better than the other but there are instances where one workflow lends much better to the situation. One typical advantage of box modeling is that at early stage, you are able to conceive first the form (the whole) of the model and is better equipped to do general corrections without bothering yet with the details. Poly-by-poly otherwise give you more control on the geometry and is much more easier to use in modeling complex forms like the human ear. Complications do arise when working with the two. In box modeling, it is typically difficult to manage the geometry when adding details. Experience is necessary so as not to create a mess. Poly-by-poly modeling otherwise has its own quirks. Since you are going detail by detail, it is easy to make a mess with the models form (i.e. wrong proportions).

While the two are opposites, they compliment each other beautifully. Most modelers would combine the two workflows in a variety of proportions, combining the strength of each. For example one might model a human body using box modeling while the head and the ears are done using poly-by-poly modeling.

**Blocking with primitives** is added to enrich approaches is modeling. It is basically box modeling in conjunction with divide-and-conquer approach. Different parts are modeled separately with their own primitives and later attached with the others to form the whole.
258. Box Modeling

Easy to undertake and flexible, box modeling is a favorite of beginners and veterans alike. It is fun to work with and general results are visible in a short time. It is a powerful workflow that any modelers should know.

258.1. Before We Start

Before doing any modeling, it is vital to plan first. Gather references and make a general plan on how to tackle the modeling phase. Being ready will save you a lot of complications later.

258.2. The Work Flow

With box modeling, start with a primitive that is appropriate for your subject. Most start with a box and generally a good primitive to start. Then, from the primitive, using a variety of tools, mold the essential form of your model. Also called the roughing phase. Don’t delve on details here, those are to be tackled later. Finally, on this form, we go to the nearly recursive process of adding details. Layer by layer, details are added until the required amount of detail is achieved.
Start with a Primitive

Figure 1496

Select the proper primitive for your work. Most modelers start with a cube. The cube is the most flexible primitive available and is suitable to almost all form of subjects. But, in many cases, selecting other form of primitives would cut out most of the modeling required. A gun is a cinch to model using a cylinder. With a little adjustment, a torus forms a good doughnut. In an instant a ball can be made out of a sphere. So produce your primitive to work with.
Rough It Out

p The Form

Figure 1497

Take the primitive and start modifying it to capture the essential form of your subject. Tools like extrude, loop cut, scale and grab are very handy for this. Avoid worrying about details at this stage. Those are to be done later.
Adding Details, Details and more Details

Now, we approach the most difficult and unquestionably the most fun part. Using a variety of modeling tools, modify the form again to incorporate details. Add details layer by layer, from general to specific. Planning, studying and experience would help you go through. Continue until you achieve the desired level of detail.

Adding details requires subdivision or addition of polygons. The knife and the loop cut tool is handy for subdividing meshes. Extrusion is great for adding details like horns and fingers. Face and edge loop must be herded to other directions at times and warrants a study by itself. Blender provides you with required tools to achieve all of this.

At this stage, beginners and experienced modelers alike will find their meshes getting more and more difficult to work with as the mesh gets a more and more dense at each level of details added. Planning, an eye to the edge flows and experience alleviate this. So plan and keep practicing.
259. Illustrative example: Model a Chair (Swan Chair)

Now let’s start with real modeling. In this tutorial we will study in greater depth how to model using box modeling work flow. Let start with a swan chair. It is great piece to model for its a popular piece of furniture so reference images are easy to find. It also have a simple geometric structure so its shape easy to grasp and also contains simple edge and face loop flow so as not to necessitate difficult edge loop face loop flow herding techniques.
The techniques learned could also be used to model other chairs (Example: the Egg chair, Tulip chair or Parson’s chair which is advised to be modeled too) and other subjects.
260. Model a Chair-Preparations

Many people do not know what a Swan chair look like. Its time to open up the internet browser and search for images. Or if you have an actual Swan chair with you, your lucky. You can look at a real model while modeling. This would simplify decisions and remove the need for guessing certain details that you are not available with image searches alone.

260.1. Knowing our model

We need to know what we are modeling look like. You can’t do this without references to guide you. A simple image search with Google would provide you the references you need. Gather several images that gives you different views of the chair. A front and a side view is great to use as a background image to guide as while modeling. Also, gather at least one image that shows the chair at an oblique angle so that it will provide a much more ”3d” view. This will shows more clearly the shape of the chair, more than the front and side view alone would give you.

260.2. Loop study

Take time to study the model. For simple models like this, it would be quite quick, especially with experience. For this project, the loops are as shown bellow.
The pink loop goes around the edge of the chair defining the chair’s edges and thickness. The light green, light blue and light purple loops follow and create the form of the chair. The crossing green loops forms the bottom of the chair. The light blue and green loops contribute for the form of the "wings", while the purple and green loops form the back. Its a simple loop structure, its topologically (sorry for using the term) the same as this cube extruded to form a T (upside down so the loops would match more).
The T shape piece loops

Figure 1502

While modeling keep these loops in mind and try to achieve the loops. For this project, the loops are achieved with simple extrusions of a cube, just like the T piece above, but in a form that looks more like the chair.
261. Model a Chair-The Seat

After studying the subject, we are ready to tackle modeling it. Start up Blender.

261.1. Start with a Primitive

For this project we would use a cube. The cube already has several face loop we need and none of that we don’t, so this primitive is a good starting point.

Opening Blender, we are already supplied with the default cube which is handy. If you don’t have the default cube because you change the setting or remove it, simply add a new cube. Name this primitive something sensible like "Swan Chair” because it would become our chair later. Move the cube or adjust the background image until the cube is centered at our image. After doing that we proceed shaping our cube to create the basic form of our chair.

261.2. Rough it out

Since we are modeling a symmetrical object, lets take advantage of it and use the mirror modifier. Cut the cube in the front exactly in half by using loop cut at center (Shift + RKey -> middle click, or Ctrl + RKey -> middle click on this editor’s computer). For those with no middle buttons you could use subdivide. Select the vertical edges (go to edge select mode first, Ctrl + Tab -> 2) then use subdivide tool (WKey -> 1). Remove the left half by deleting the vertices. Then add a mirror modifier in the modifier stack. This is available at the edit buttons, select the modifiers tab the click the "Add Modifier" button and select "Mirror" from the selection. Activate "do clipping" from the mirror modifier panel that appeared to prevent accidental movement of the central vertices.

(Noob Note: If you follow these instructions, you’ll have a gap between the mesh and its mirror. I fixed this by increasing the "Merge Limit” option in the Mirror modifier menu to .1.)
Model a Chair-The Seat

The cube primitive with mirror modifier on

Figure 1503

Move the vertices so that it would follow the shape of the bottom of the chair image.

Shaping the bottom

Figure 1504

1752
Note that the reference images used does not match very well. This is because of perspective and camera angle distortion. In this case use the side image since it shows less distortion. Use the front reference image as an eyeballing guide for the front side of the chair. An oblique reference as stated earlier in planning stages is helpful to guide you in this condition.

Add an edgeloop using the loop cut tool (Shift+RKey) as shown in the image below. Move the newly created vertices to follow the references.

p Shaping the bottom

Figure 1505

It is good practice that while modeling you had to view your model at various views not only the standard front, side and top views. Remember that you are modeling a 3d object. What looks good in this some views are not necessarily good in other views. This would result in complications like the familiar flat face look in face models. Moving your view around would help you prevent this. Shown below is the view of the model at an oblique view.
p Shaping the bottom oblique view

Figure 1506

Now extrude the back part of the model to form the back part of the chair. Adjust the newly formed vertices to follow your guide images as shown below.
p Shaping the back

**Figure 1507**

It's a good practice to see the model at various views while modeling here is how it looks like now at an oblique view:
p Shaping the back oblique view

Figure 1508

Select the following faces. We are going to extrude it to form the sides for the chair.
p Shaping the sides, faces to select

Figure 1509

Extrude the faces and adjust newly formed vertices to conform with the guide images.

p Shaping the sides

Figure 1510
And now the oblique view.

p Shaping the sides, oblique view

Figure 1511

The back still does not look good so add the following edge loop.
p Shaping the back again

![Figure 1512](image1)

Adjust it.

p Shaping the back again

![Figure 1513](image2)

Remember to rotate your view to see problem areas.
p Shaping the back again, oblique view

Figure 1514

Add this edge loop too.
p Shaping the back again

Figure 1515

Adjust.

p Shaping the back again

Figure 1516

And keeping with our good practice.
Shaping the back again, oblique view

Say, the form is finished. The loops are all in place and the form is easily identified as a rough model of the Swan chair.

261.3. Adding More Details

Now the basic form of the model is finished and with all important loops in place detailing this model is easy. Let's start by defining the back. Add these edge loops.
Add these loop

Figure 1518

Move the newly created vertices to fit the references.

Adjust the form

Figure 1519

Be sure that the model looks right at various angles. The references images collected earlier will help. Adjust vertices if necessary.
Our model

Figure 1520

The sides need to be taken care of too so add these edge loops.
Add these loops

Then adjust the vertices.

This is how the model now looks like.
Our model

Figure 1523

Continue by adding these loops.
p Add these loops

**Figure 1524**

And adjust as usual.

p Tweak

**Figure 1525**

Check that it looks good at other views too. Move vertices as necessary.
Our model

Figure 1526

Keep repeating this procedure. Add loops then adjust. Here is the loops that was added to the model. Tweaked after adding each.
More loops

Figure 1527

The outline of the chair needs rounding up. Add these loops and tweak so it looks like the one shown.
Rounding loops

**Figure 1528**

This is now how the mode looks like.
Our model

Figure 1529

It's rather tedious to add more loops at this time so let's do a cheat. Select all vertices (press AKey a few times) and then subdivide (WKey -> 1Key) to add more vertices.
Subdivide the whole mesh

The model looks blocky so let’s smooth it out. While the whole chair is still selected smooth the vertices by clicking Smooth a few times (Edit buttons -> Mesh tools -> Smooth; also available at WKey->Smooth). It would smooth out the model.

Smoothing the model

Admire the work (and tweak if necessary).
This is optional. Add this loop and scale along normal (Alt + Skey) to scale it in. Adjust vertices if necessary.
Model a Chair-The Seat

p Modeling the seams

Figure 1533
262. Model a Chair-The Feet

Now the seat is finished, time for the legs for it to stand on.

262.1. Starting Primitive

The leg is mainly made up of cylinders so a cylinder is a very good primitive to start. In object mode add a cylinder with 16 vertices. Center the cylinder on the upper part of the telescope.

Adding the cylinder primitive

Tip: to make the cylinder centered relative to the seat's center, while in object mode select the seat then hit Shift+S key (Snap options) then select Cursor->Selection. The 3d cursor would be moved to the center of our seat. Now when you add the cylinder, the cylinders center would be located at the cursor which is also at the seat's center. Now all you have to do is to move the cylinder along the y and z axis because it would be properly located relative to the x axis.

Hide or move the Seat to another layer so that it would not intrude while modeling the leg.
262.2. The Upper Telescope

Go to edit mode and scale the cylinder until its radius match the radius of the upper telescopic element of the chair’s leg. Then move the top and bottom vertices to match the reference.

p Modifying the primitive to fit reference

Extrude the bottom part and place it a little lower. Extrude again and right click so that the newly created vertices would remain in their position. Scale the vertices a little. Extrude again and move the extruded region up the cylinder.
p Shaping the bottom of the telescope

Figure 1536

Remove the top and bottom vertices that cap the ends.
We will be using subsurf modifier to make this part smoother. Add this loop to constrain the smoothing on this area.
Now let's start with the lower part. Add a cylinder in object mode and adjust the newly created vertices to match the reference.

262.3. The Lower Telescope

Now let's start with the lower part. Add a cylinder in object mode and adjust the newly created vertices to match the reference.
Start modeling the lower telescopic part.

The legs would be extruded from this cylinder. Add this loop to prepare.
p Add this loop to enable extrusion of legs

Select the faces between the newly added loop and the bottom loop. Extrude this faces but right click after extrusion so the extruded faces remain in their position. Now scale them constrained along the xy-plane (Skey->Shift+Zkey) a little. This is how it should now look.
Forming the base

In top view select the two topmost faces and extrude to form the back leg. Shape the tip according based on the reference. Here is the steps taken to shape the tip. First after extruding, Constrained scale the tip along the x-axis (SKey->XKey) to make the tip thiner. Then move the tip lower. Deselect all, then select the top vertices of the tip and lower this vertices further.
p Extruding a leg

Shape the base as shown bellow. This is done by selecting the vertices where the leg connects to the base then constrained scaling it along the y-axis to zero (Skey->YKey->0key). Then move the scaled vertices further back.
p Shaping the leg

Figure 1543

Then add an edge loop as shown below. Constrained scale the newly created edgeloop along the x-axis to make it thinner.
p Shaping the leg

Figure 1544

We will be using the subsurf modifier to smooth our model so lets add the following edge loops so that the model will smooth properly. Add an edgeloop at the tip.
Adding control loop

And this loops on the side.

Adding control loops

Also remove the vertex that cap the top because we will not be needing it and it would cause smoothing artifact when subsurfed.
Shaping the leg

Figure 1547

Now how about the other legs? We will be using Spin duplicate tool to make those. In top view select the central vertex then snap our 3d cursor to it.
p Relocate 3d cursor to the center of the base

Now remove the other part of the cylinder as shown. We would be left with a quarter part of the whole leg assembly.
Select all the vertices that are left. Change the parameters of the spin tool to this: degrees to 360, steps to 4. Click on the "Spin Dup". If you have multiple 3d views, your mouse cursor would turn into a question mark. Move your cursor to the top view and then click. The other legs would appear as shown bellow. This legs are made of separate mesh and the original leg have a duplicate at exactly the same position creating double vertices. Connect the mesh and remove the doubles by selecting the whole mesh then remove the doubles (Wkey->Remove Doubles).
p Spin duplicating other legs

Figure 1550

262.4. The Stops

Now let's create the Black Stops on every tip of the leg. We would be creating this joined to the legs as one object then separate it later. Its just that it seems more easy that way.

Without leaving edit mode, add a cube. scale an move it to one of the tip. Move the cube so that it would be lower that usual to separate it from the other mesh making it easier to edit it without disturbing the others.
p Primitive for the stops

Figure 1551

Shape the cube to match the tip. This should be easy by now. The whole step is left out.

p Shape the primitive

Figure 1552

Subsurf would be used to this too so add extra loops to control how the mesh would be smooth.
Now make copies of the stops using the Spin Duplicate tool. Don’t forget to remove the doubles.

Select all the tips then move them together up until they intersect with the tips of the legs.
Positioning stops

Figure 1555

Now let's separate separate meshes to individual objects. Press Pkey and select "all loose part" option.

Separating the Stops

Figure 1556

Notice that the other part of the mesh would suddenly change in appearance. Don’t worry. It just means that those meshes are now separate objects by themselves. If you go to object view you would now be able to select the leg and the tips as separate objects.

There are some issues though when you use the subsurf modifier on the leg base as shown.
Unwanted smoothing effect

Figure 1557

Select the leg and go to edit mode. Add the following edge loop.
p Adding control loop

Scale the base loop too as shown.
Figure 1559

The issue should now be solved.
p Much better

Figure 1560

This is how the whole leg assembly should look. All have subsurf modifier on.
There is still an issue though. This is not important in most part but will be taken care of for this time.

When one of the leg stops is selected in object mode, it would show that its center is not at the center of the mesh. The center is where the gizzmo (the red, blue and green arrow) would be located.
p object center not at the center of the mesh

Figure 1562

To correct this select the offending object. Click the Mesh menu (located at the header) and navigate to "Transform" and select "Center New" from the options. Blender would automatically calculate the new center based on the objects mesh. Now when the object is selected, the center would be located at a much more appropriate location.
p Center at proper place

Figure 1563

Do the same to the other stoppers.

Now if you haven’t named each individual part yet, You can do it now. Name each part sensible names like uppertelescope, lowerterlescope, etc.

262.5. The Whole Chair

Unhide or Show the layer where your chair seat is so that it would unite with the legs. Now this is how the whole model should look like.
The Whole Chair

p Finished Model

Figure 1564
263. Illustrative Example: Modeling a Simple Human Character

Figure 1565
We will be modeling this very simple human figure. This time many details are left out to save time and space. It is assumed that enough knowledge is gained from previous tutorials for readers to understand this stage. Shortcut keys are also left out. Read first the chair modeling tutorial if this comes out too difficult to read.
264. Modeling a Human Character - Preparations

Actually, this model is made without any background reference images but enough knowledge of human figure makes this possible. Modeling the human body or any model in that case requires knowledge of it beforehand. Even with the background image references, there are still some details (like the armpit) that is not easily visible or are difficult to comprehend with just simple orthogonal projections. It is advised to make some study on basic human figure and proportions first.

For those who likes to have a background reference image to use while modeling, use this orthogonal views of the model. You could still try and test your knowledge on the human figure later by trying to model one without image references.
265. Modeling a Human Character - Modeling
266. Blocking the Figure

As with many models done in box modeling, let’s start with a cube. The model is symmetrical so let’s make use of it. Add a loop\(^1\) running vertically at the middle and delete the vertices\(^2\) on the left, leaving you with only half of the cube. Now add a mirror modifier\(^3\).

![Initial box](http://wiki.blender.org/index.php/Doc:2.4/Manual/Modeling/Meshes/Editing/Subdividing/Loop_Subdivide)

![Image](http://wiki.blender.org/index.php/Doc:2.4/Manual/Modeling/Meshes/Editing/Basics/Deleting)

![Image](http://wiki.blender.org/index.php/Doc:2.4/Manual/Modifiers/Generate/Mirror)

Now add a loop running horizontally and fashion out the torso.

---

1  [Loop_Subdivide](http://wiki.blender.org/index.php/Doc:2.4/Manual/Modeling/Meshes/Editing/Subdividing/)
2  [Deleting](http://wiki.blender.org/index.php/Doc:2.4/Manual/Modeling/Meshes/Editing/Basics/)
3  [Mirror](http://wiki.blender.org/index.php/Doc:2.4/Manual/Modifiers/Generate/Mirror)
Forming the torso

Figure 1567

Add a vertical loop on the torso so that we will have more geometry to work on.
Adding more geometry

Figure 1568

Extrude the head and the legs. Add loops around the head and the bottom of the legs and extrude out the head and feet.
p Extrude head and legs
p The model at another view

Figure 1570

Now add a loop around the torso and extrude out the arms. This is all for blocking
p Extruding out the arms

Figure 1571
p From another view

Figure 1572
267. Detailing and Finishing

Add a loop that goes through the torso and the arms and another at the sides. This geometry will enable us to round and shape the figure.

p Adding more geometry and rounding the figure

Extrude out to form a rough hand. Add an extra loop around the hand and extrude out the thumb.
Extruding the hand and thumb

Add more loops around the arm, thumb and hand. Work out this additional geometry to shape the parts.

Shaping the hand

Add this loop to add more geometry on the legs and to the torso.
p Adding geometry

Figure 1576

And then shape.
Shaping

Add more loops on the leg and shape out the form.
p Forming the legs

Figure 1578

Now time to shape the foot add more geometry and shape out the foot.
Initial form of the foot

Figure 1579
Now take a look at your model. Adjust the form until satisfied. Work finished.
p Doing finishing touches

Figure 1581
268. Illustrative Example: Model a Car (Box)
269. Illustrative Example: Model a Dragon
270. Polygon by Polygon modeling

Although quite demanding, many modelers savor the control poly-by-poly modeling allows. However, its demanding nature makes many modelers, beginners and experts alike, to avoid it. Still, poly-by-poly modeling, if properly used, is a powerful tool.

270.1. Before we start

For this workflow, being ready is of great importance. Have several references of your subject, especially a front and side view. Also, have minutes of study on the subject and try to make out an approach in modeling it. Being ready is crucial for this.

Figure 1582

p Image used as a reference available at the commons
270.2. The Workflow

Poly-by-poly modeling provides the most free modeling workflow ever. This freedom, however, causes confusion on how to approach modeling the subject. Searching the internet for tutorials on modeling the face using this method, you will find hundreds and each will be different from each other. Some start with the eyes, others with the mouth, others the ridge of the nose. And then each will proceed differently from that. No wonder its confusing.
Even though poly-by-poly modeling is such a free form method and constitutes a very vogue way to start and continue, a general guideline is provided in the hope that it will help modelers in using this approach.

270.2.1. **To Start**

Poly-by-poly modeling rather sets you free on choosing how and where to start. The only requirement is that you have a geometry, a vertex or a plane to start with. Many beginners are stumped by this. Somehow such liberty leaves them undecided.

Starting geometry

![Starting geometry](image)

**Figure 1584**

A very good approach is to start by creating the important loops first. For example, in modeling the face, you could start by creating the eye, mouth and face loops. With the loops in place, it is easy to build other geometries around them.
Another good approach is to start with the most important part of the subject. For the face, this is the eyes and the mouth. You could model these parts first and then proceed adding geometry from there.
As said, poly-by-poly modeling lets you free, so if you would like to start on other parts first, say the nose, then you could do so.

270.2.2. To Continue

p Continue Adding more geometry. Notice how the loops are placed.

Figure 1587

Continuing from your beginnings is not as easy as connecting-the-dots as it first appears to be. Rather than proceeding in a connect the dots fashion, proceed by thinking of edge and
face loops of your model first then creating and adjusting geometry to fit them. Such view would ease decision on placing your geometry.

270.2.3. To Finish

When you find that you don’t need to add more geometry, you can call it quits. But still, it's a good practice to take another look of your model and make trial renders of it. There might be an awry edge loop, geometries that mess the model, or triangles that you wanted
out. Do some fixing and adjusting and when you finally have the model good, give yourself a pat on the back, OMG ITS A FACE YOU DID IT YAYAYAYAYA
271. Illustrative Example: Model a Woman Face
272. Illustrative Example: Model a Car (Polygon-By-Polygon)
273. Blocking with Primitives
274. Animation Notes and FAQ

274.1. Blender 3D: Animation Notes and FAQ

274.2. IMPORTANT

This page is under heavy construction. It will probably not be edited better until early May 2012. If someone sends me information on how to convert a OpenOffice odt file to a wikidoc format, then it may be done sooner. Until then this will be quite a work in progress.

274.3. Authors & Contributors

See here¹.

274.4. Introduction

I found it quite cumbersome to find all of the little quirks, problems, and tricks in multiple sources whenever I would forget something. Therefore, I compiled all of the things I found important—primarily with character animation. Almost all the information here is consolidated from many sources. Some sources still need to be cited and any help on this would be much appreciated. For that reason I did not intend to make this public but I think there is enough need for this type of information so here it is.

Just as a special aside, I made these notes to help myself with my animation project. Although I have organized them and posted them online for my and others benefit, I will not be dedicating any large amount of time to this website. All of my extra time needs to be allocated to the animation project. However, I do not mind suggestions and am willing to possible use them. I want to make sure that the viewer understands my time is very limited.

There may be many typos or confusing areas of organization. I tried to organize the mess of notes as best as possible but I am sure there is an even better way. Feel free to fix any aspect of this.

Any suggestions or comments feel free to e-mail me at wiki [at] pagodaproductions.com.

¹ http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Authors_%26_Contributors
274.5. Todo List

See here².

274.6. Animation FAQ

274.7. Armatures

Q: I managed to create an acceptable walk cycle finally, now when I reopend the file to add additional animation, It keeps falling back to walk cycle, is their something i am doing wrong. Even after adding the LocRotScale key frame, it still ignores them, and goes back the corisponding frame for the walk. Uggghhhhh!!!

Q: What is the best approach for rigging a character in Blender?

Q: How do I attach a separate object to a bone?

Q: When you try to scale the root bone of the armature(which scales the mesh), the bones move out of the natural placement causing unwanted positioning and distortion. Is there any way around this?

Q: What is a pole vector?

Q: How do I know that my armature is correctly positioned in global space in edit, object, and pose mode with proper bone rolls and axis pointing in proper directions? What are the best methods for building? And what axis is up Y or Z?

274.8. Hotkeys

Ctrl-C/Ctrl-V Trick One simple way to get the right name is to select the Lattice, go to F9, Link and Materials panel and where it says Ob:Lattice or Ob:Lattice.001 etc., move the mouse over this field and press Ctrl-C (don’t click on it, just hover over it). This copies the Lattice name. Then select your object, go to the Lattice Modifier panel, hover the mouse over the Ob: field and press Ctrl-V to paste the name in. Now it should stay there and your Lattice should work in Edit Mode.

H hides bones

Alt+H shows all bones

Shift+H hides everything except the chain

Ctrl+I [Pose Mode] will automatically add an IK contraint

M [Pose Mode] to move a bone to a bone-layer, select it in POSE mode then press ”m” and click on the desired layer button. When the bone is selected, you can see which bone layer

² http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Todo

1844
it is on in the Editing buttons / Selected Bones panel. Whichever of the 16 layer buttons is enabled is the layer the bone will be on.

Shift+M [Pose Mode] You can use the hotkey SH-M to display a floating bone-layer panel in the 3d viewport. Select the armature, change to POSE mode, then change to the Buttons/Editing panel (F9). Under the Armature-Panel, Display Options SH-LMB the 8th button under the Display Options Bone-Layer buttons to enable it. Check out this[^3] by BlenderArtists.com.

Alt-N normalize the bone orientation This can fix problems sometimes.

Alt+P clears parent

Alt+S [Pose Mode] in edit mode allows b-bones shape to scale visual changes without affecting the bones.

W [Edit Mode] subdivisions bones

W [Pose Mode] will calculate paths to see how a bones movement is mapped out along a path or If you’ve named your bones correctly ( with .L and .R at the end of the name ) , you can flip the mirrored bone name by pressing ”W” and “flip name” . A relevant post on BlenderArtists.com is available here[^4].

### 274.9. Approaches, Techniques, Tips and Tricks

Constraining IK or FK In the Armature Bones Panel is where you can limit the movement of the bone for IK and Limit Rotation Constraint for FK.

Customizing Frame Skipping Steps(F10 playback) allows for a customizable way of skipping frame in increments.

Copying Constraints in pose mode 1. Select all bone(s) you wish to copy the constraints to, from a particular bone 2. Now, select the bone you wish to copy constraints from 3. Ctrl C --> Constraints (All)

You can do CTRL-CKEY to copy stuff from a bone to bones. The options are location, rotation, scale and constraint. Constraint is very handy when you want to copy a constraint to other bone. The way it works is easy. The WKEY menu get some neat options too:

Select constraint target: Will select the target of the bone’s constraint currently selected.

Flip name: Yep, you can flip name in Pose mode too. Calculate/Clear path: This is a visual way to see the action linked to your armature. You can select just some bones and ask Blender to show you the paths of the bones.

It’s possible to copy constraints from one object/bone to a bunch of objects/bones. A useful thing to know when doing a repetitive task like rigging all the fingers of a hand. Just select all bones/objects that you want to give a copy of the constraint, and then select the bone/object containing the constraints. Press CTRL-CKEY in 3DView, and select Object


Constraints from the popup menu. The idea behind this is to copy the constraints of the active object to the selection.

Rigging Q: What is the best approach for rigging a character in Blender?
A: Apollux Honestly, I don’t think that there is a golden set-up that will solve all your problems. For example, when I design a character rig I need to know beforehand what type of actions he will perform.

If you want general pointers, I guess this would do: Always set your rigs in a half relaxed fashion. totally relax your hand for a few minutes and see the position of the palm and fingers, that is position you should model and rig them on the 3D world. Same goes for mouth, legs, arms, etc. etc. etc.

When in doubt over IK or FK always choose IK, since it is quite easy to switch a IK rig into FK when needed and then back to IK.

Bone’s axis orientation can’t be an afterthought!! It is no coincidence that every self-respecting rigging tutorial for blender mention it... And don’t trust blindly on the automatic axis orientation fix command (Ctrl-N), since it can introduce some odd solutions on complex armatures. Always check each bone by hand, even if Blender says they are fixed.

Ultimate rig design is not the in-and-all of character animation. Sometimes I would spent crazy amounts of time preparing a rig for a special sequence, and in the end realize that if I had used a simple FK rig tricked by hand during animation I would get the same results in half of the time and half the frustration. Not because it can be done means that it must be done. BlenderArtists post here.

Item Pickup A good use of it is to ask a character to pick up something. By having a bone or empty for each side of the relationship (hand <-> glass), as the hand approaches the glass, you can align the two empties and fire the constraint up (1.00) to stick them together. You add another child-bone in the middle of the hand to tell where the glass will be. Thus moving the hand will move the glass. On the side of the glass just add an empty and make it parent of the glass. Add a copy location to the empty pointing to the bone in the hand we just did. There you go. Of course when the hand rotates the glass will not. For that you will need to add a Copy Rotation Constraint. Before Blender 2.40, the above method was a good way of faking parent relationship without rotation. But now we have the hinge option which does the same.

274.10. Problems and Questions

Separate Object/Bone Attachment Q: How do I attach a separate object to a bone?
A: To do that simply Ctrl-Tab into Pose Mode with the armature selected then select the object/mesh you want to parent to a bone then shift-select the bone you want to be the parent and Ctrl-P>MakeParent to”>Bone.

Armature Scaling Problems Q: I have been trying to scale my character which has many similarities to the mancandy and ludwig rigs. However, when you try to scale the root

http://blenderartists.org/forum/showthread.php?t=18480
bone of the armature (which scales the mesh), the bones move out of the natural placement causing unwanted positioning and distortion. Both the mancandy and ludwig rigs have this same problem. Is there any way around this?

A: Why are you trying to scale the root bone (to scale the whole model)? Are you doing this in pose mode or object mode? If you are trying to scale the whole model try it in Object Mode. Also check if you are scaling around the cursor instead of median point.

Q: What is a pole vector?

A: Vertex Pusher 2) Pole vector is actually a term used in Maya. It refers to the direction a bone is set to point towards in Maya rigging. For example, the direction you want the knees to point towards can be set using pole vectors. Apparently, Blender should be getting this feature soon. Right now you have to add target bones so that the knees will only bend one way (see Ryan Dale’s BSocD tutorial), but with the option to use pole vectors you won’t need to do this in the future.

Bone Orientation Q: How do I know that my armature is correctly positioned in global space in edit, object, and pose mode with proper bone rolls and axis pointing in proper directions? What are the best methods for building? And what axis is up Y or Z?

A: 1. Build up all the bones, as you did before. (Every foot, arm, etc. should be a bit bent, and drawn from the proper view.)

2. Select all these armatures, and with Ctrl-J join them into one armature. (Or with parent/child connection, as is necessary.)

3. Select this armature, go to ”Editing” (F9), and then turn on ”draw axes”. Then you can see the axes of the bones. You will see, that the axes are different. Some bones has the Z-axis up, some has the Z-axis to the left, etc.

4. First you should tell Blender that this is the original position of your skeleton/model by pushing Ctrl-A. This is applying rotation. This means, that now all the rotations of the bones will be ’0, 0, 0’, so if you push later Alt-R (clear rotation), you will get this position. (Turn on numerical menu with N, to see what happens when you make this apply rotation command.)

5. Select the whole skeleton/model again. Go to edit mode. Then push A, to select all the bones. (They should be yellow now.) Then hit Ctrl-N, and you will see all the axises will be changed to stay on the same way.

6. That is, your skeleton now is ready to define the IK solvers, and then the skinning, and finally the animation.

http://blenderartists.org/forum/showthread.php?t=25653

A: Vertex Pusher 4) Yes you should always add in top view [numpad 7]. An armature bone always has its axes set (Y is always up X side to side and Z depth) and you cannot change this like you can with mesh objects, so it seemingly won’t matter which view you add a bone while in Edit Mode but in Object Mode your armature object will have a 90 degree

---

6  http://blenderartists.org/forum/showthread.php?t=110721
rotation around the X axis (if you add it in front view) which can and usually does create problems down the road. If for some reason you want to add bones in front view simply start by adding the first armature bone in top view ad then switch to front view to add additional bones. You can just delete the first bone or rotate it while in Edit Mode.

Blender’s default views have the Z as the "up" axis while the armature system is coded with the Y as the "up" (like most 3D apps)

When you rotate a bone in the front view, when the bone is aligned to that view and the Z is the up axis, you will give a roll value the bone because it is rotating perpendicular to its coded up axis ... this can cause you problems in some situations when you want a "neutral" roll value in Pose Mode... in most cases you'll want to recalculate the roll value with Ctrl-N (which will remove the visible rotation and insert a value in the "Roll:" field in the Transform Properties subwindow) and give it a non zero roll value in Edit Mode so that in Pose Mode it is properly aligned and rotated for poses and constraints ...

You won't get that behavior if you rotate in either the top or side views if the bone is aligned to the view ...

It’s just that if you have the Y axis (the axis the bone rolls on) perpendicular to the Global Y axis then you will have to recalculate the bone roll angles to get it aligned properly for pose space .

By "bone is aligned to the view" I mean what it is like when you first add a bone in a preset view, i.e. head at bottom and tip up at top in Edit Mode with no rotation applied.

http://blenderartists.org/forum/showthread.php?t=110721

A: Fligh If you look at your left hand, palm down, from above, and assume for this exercise that all four fingers have their X-Axis pointing towards the thumb and have a Roll Angle of zero (same as if you created an Armature in Top View), but the thumb would need a Roll Angle of about 90. So if you rotate the first digit of the fingers around their Local X (R-XX) they would go down perpendicular to the back of the hand, but if you rotate the thumb (Roll Angle 90 and again around the Local X) it would go Left, towards the fingers.

Ahh.... but who bothers to pose bones like that? You just grab the IK Target and move it! Well the Transform Matrix is divided into four chunks (I think? I'm not sure of this but it helps to think of it [or look at it] this way and if you actually test it in Blender it works), Bone Space (the structure of the bone including Roll Angle), Armature Space (the structure of the Armature = the sum of all BoneSpace), Pose Space (transforms relative to Rest Position = recorded changes in BoneSpace within ArmatureSpace) and World Space (the sum of all the above relative to the (transforms of) the Armature Object.

http://blenderartists.org/forum/showthread.php?t=102209

A: Fligh Anyhow, In Blender, In Top View (always add armatures in Top view) the Z-Axis is Facing you and Y is Up. So when you add the first Bone it lies along the Y-Axis. You cannot change that parallel-to-Y and any future Bones you extrude will use that bones axis as reference. If you add an Armature in Front view the bone's (local) Z-axis will point to the Global -Y (Y-Negative) and can lead to problems later on.

http://blenderartists.org/forum/showthread.php?t=102609&highlight=bone+orientation
A: Vertex Pusher Well I guess I may have a little something to contribute to this ... but I have been trying to learn the armature system in depth for the past few months and this particular issue came up with a complicated rig I was working with ... and I basically "discovered" that you really shouldn’t have any other axis other than the Y as the "up" axis. And precisely because the bone roll angle issue.

It seems that despite how the view ports are configured (with the Z as the "up" axis) the default "up" axis is the Y ... for everything ... This is a bit annoying but if you have, like me, configured Blender to start with the front view open and have the Transform Properties window always open, you will see that everything when created in the front view is actually rotated 90 degrees along the X axis once you tab into Object Mode and that you need to Ctrl-A all objects so created (I guess Blender "out of the box" has the top view open ? ... it’s been a while so I can’t remember ...) . This isn’t all that important for most things but for the armature system this does create a problem - bone roll values that you don’t want.

Just as a simple test: Open up Blender and add an armature in the front view. Grab the tip and move it to a corner of the grid so that it is angled 45 degrees. Tab into Object mode. Open up the Transform Properties window. You will notice that your armature is rotated 90 degrees along the X axis. So ... Ctrl-A the armature to have it’s "up" axis as Z ... And suddenly you will see the bone rotate along its roll axis. Tab back into Edit Mode, select the entire bone and Ctrl-N to recalculate the bone roll angles ... the bone will rotate back to the way it was ... but with a change in its roll value (-45 or 45 depending on which way it is angled) ... Now repeat the above but this time create the armature in top view ... And you will realize that despite being angle at 45 degrees to the view like above no roll value ... not even after recalculating the bone roll angles (Ctrl-N) ...

Now I am assuming that this occurs because the Y axis is the one used to calculate the bone’s roll ... and that if you have anything other than the Y as the "up" axis the roll values get screwed up because now the roll axis (Y) is tangent to the up axis instead of being the up axis. Just turn on "Draw Axes" and look at what the "up" axis is for an individual bone is ... the Y.

And just another bit of proof ... The really great new "limit" constraints (loc,rot and scale) added in the last release ... Try and apply the limit rotation constraint to the first armature (the one with Z up and rotation applied) . Now turn LimitX on with no min or max values and do not turn on the "local" co-ordinate space ... it will fall flat along the Y axis as if created in the top view ... This is occurring because despite the fact that you have applied the 90 degree rotation along the X axis to the object, the constraint is enforcing the global up axis ... which is ... the Y.

Now the only work around that I could come up with was to create an empty and parent a Y up armature to it then rotate the empty 90 degrees to be able to use the Z up view ports and also making sure the mesh also had the proper orientation as the armature. This prevents me from accidentally applying the rotation to the armature and I can use the numbpad hotkeys to navigate the views ... ... Else you could just clear the roll values manually if you insist on having the Z as the up axis ... though you won’t be able to get rid of the rotation that is caused by being tangent to the Y axis without odd roll values ...

Sorry for the long winded response, but this has been bugging me for a while ... Hopefully with the refactoring for v2.5 later this year there will be an option as to which axis will be the "up" axis with regards to the various views ..
274.11. General Armature Information

Armature Object is like any other object type: It has a center, a position, a rotation and a scale factor. It can be edited. It can be linked to other scenes, and the same armature data can be reused on multiple objects. All animation you do in object mode is only working on the object, not the armature’s contents like bones. Link and Materials panel: The AR: field let you rename your armature Datablock. The dropdown is a quick way to select which Armature datablock you want to connect to this armature. You can keep more than one version for the same character. Useful when you have a special move to achieve in a shot, you can turn on an armature for a special purpose. The F button is an option to assign a Fake user to the Armature. Again if you have more than one armature for your character, it’s a good idea to turn the Fake on, because if your armature datablock is not used (linked) it’s not going to be saved in your .blend files. You can always do batch Fake-assignment of armatures by opening the Datablock browser (SHIFT-F4KEY), go in Armature datablock, select all the armatures you want to keep, and Press the FKEY. The OB: field is just to Rename your armature Object to something more cool and useful than Armature... Armature.001...

Delay Deform: This was useful before as the old system was very slow. What it does is when you do a manipulation to the rig, it waits until you finish to update the view. Can still be useful though.

Weight: This specifies how strongly this bone will influence the geometry around it, relative to the other bones. If two bones crossing each other, both with envelope influence, have the same weight (like 1:1) they will influence the surrounding geometry equally. But if you set one to 0.5, the geometry will be affected more significantly by the other one, with weight 1. For example, in this image, 2 bones using envelope influence try to move the same geometry. The 2 on the left have the same weight, you can see the geometry didn’t move. On the right, one of the bones has 0.5 so the bone with weight 1 is winning the tug-of-war! Deform: This lets you say if you want the bone to deform the geometry at all. Switching it off is like setting the weight to 0, except it’s faster this way. Useful when using a bone as a target or a controller, i.e. a bone you just want to use to control other bones, but not the geometry itself. Mult: to deform geometry you can use vertex group and/or Envelope. The ability to mix both of these methods is handy for using one to tweak the other. For example, you might use envelope everywhere but tweak difficult places manually with vertex group. We’ll discuss this in more detail later on. There are two number fields to better tweak the effect of B-Bones. The in/out is used to tell the scale of the virtual handle of the bezier curve. In is the Root of the bone, and Out is the Tip. The bigger the value, the bigger the effect of rotation. You can do ALT-SKEY on one or more bones while in Envelope display mode to tweak the envelope size in real time while animating. Useful when for example you move the hand and some part of the character isn’t in the influence zone; the result will be that some vertices will stay behind.

Tip: Bake envelope to vertex groups The workflow is very simple. When you are done with the envelope’s tweaking and you have gotten the best out of it, delete the Armature modifier and parent the mesh to the armature(CTRL-PKEY). Parent it to "armature" when asked
and "Create From Closest Bones". Do ALT-PKEY and redo the Armature modifier. Now all the envelope influence are converted to Vertex Groups. This way you can further tweak influence zone using Weight paint. More info in the following pages. You can edit this white zone in Editmode or posemode by going in Envelope display mode, selecting bones and using SKEY or ALT-SKEY The Mult option will tell Blender to multiply the weight it get from envelope (let say 0.7) with the weight you painted in weight paint (let say 0.5). The result will be 0.5*0.7=0.35 so in fact you just tweaked the envelope influence to 0.3 when it was at 0.7. If you don’t want vertices to be part of the zone, you can always paint it with 0, as 0*(something) will always give 0. This way you can give custom shape to your envelope. More on weight paint on next page.

Deform with only things weight painted Deform + Multiply with only things that are weight painted within the envelope radius

Process: Make bones. Make good envelope transformations(including some overlap). Alt+P to make virtual parent(from nearest bones)this will already weight paint parts based on envelope influence

"All faces" tells Blender if you want to paint on all faces in the mesh or just the visible one. "Vertex Dist“ tell blender to use vertex distance instead of faces. When active, the painting will only check if the vertex is in the brush, then apply a weight value. If it’s off, all vertice part of the faces in the brush will receive weight value. Turning on Vertex Dist can give good results when you have a lot of polys in your mesh. Constraints are calculated from first to last. So if you have two Constraints working on the same channel, let say Location, The last one will most probably win the chance to move the object. But... Most of the constraints have influence slider to tell how much it influence on the stack. If the last constraint have an influence of 0.5 it will mix the result with the one before. Most of the time this little constraint is useful to stick objects to one another. By playing with the Influence you can tell when it will work, when it will remain motionless.

274.12. Building Armatures

Ludwig’s Stretchy Spine In the spine Ludwig model keep in mind the following things. The SpineStretch.null is necessary. It must be set to Hinge and Deform to keep the bones from scaling. IKSpine must have Deform turned off(none selected). Spine 4 or the last bone child in the chain(closest to the neck) must have Deform turned off(none selected). Scaling problem is usually tied(maybe always) tied to an improper child/parent relationship to a bone that is involved with stretching.

Created a mirrored copy without using X-Axis Mirror select the bones that you want to mirror , put the 3D cursor at the center : And make shift + d , and directly , S , X , -1 ...

Other Information You can extrude a new bone from the selection using EKEY. This will create a bone connected to the original one, meaning the Root of the new bone will follow the Tip of the original one. You can also CTRL-LMB to extrude a new bone. It will extrude to where you clicked.

Alternatively, you can connect two existing bones by selecting them one after the other and pressing CTRL-PKEY. You can then choose either 'Connected’ (the child bone - the one
you selected second - will automatically be moved so that it touches the parent) or 'Keep offset'. aa Using the WKEY menu, You can subdivide your bone or flip the name of the bone between Left-Right (See Naming convention below). You can delete the bone with XKEY You can select a chain of bones (connected together) using LKEY, when you hover your mouse over a bone. In many cases, rigs are symmetrical and can be mirrored in half. In these cases, it is helpful to use a left-right naming convention. This is not only useful for your own sake, but it gives Blender a hint that there is a pair of equivalent bones, and enables the use of some very cool tools that will save you some significant work. It’s helpful to name your bones with something useful telling you what it’s there for, such as leg, arm, finger, back, foot, etc. If you get a bone that has a copy on the other side, however, like the arm (you have 2 arms right?), then the convention is to call them arm.Left and arm.Right. Other alternatives are also possible, like _L, _LEFT, _left, _L, and .Left. Anyway, when you rig try to keep this left-right thing as accurate as possible; it will pay off later on. You can copy a bone named blah.L and flip it over using WKEY --> flip name. So the bone will be blah.L.001 after you copy it, and flipping the name will give you blah.R. Blender handily detects if the .001 version already exists, and increments the number for you.

274.13. Useful Rigs

Bassam’s(slikdigit) Mancandy 1.0 http://freefactory.org/posts/candy-for-everyone
Bassam’s(slikdigit) Mancandy 2.0 One of the most complex rig I have available for Blender. It has lattice based stretching. http://freefactory.org/posts/candy-for-everyone
Calvin’s 05, 2017 This is an alternate foot roll method to Ludwig’s rig.
Calvin’s handy02
Clean3D’s Mouserig http://blenderartists.org/forum/showthread.php?t=79305
Cognis’s AnimTest Interesting use of empty’s as a bone.
Daniel Martinez Lara’s 3-plender leg This is a complex leg rig. It has many IPO driven bones. http://www.daniel3d.com/pepeland/misc/3dstuff/blender/leg/3-plender_leg_v0-1.zip
Jason Pierce’s(sketchy) Ludwig http://jasonpierce.animadillo.com/resource/ludwig/ludwig.html
Kugvelka’s Walkcycle
Martin Georgiev’s(Animarto) Walk_anim
Master Yoda
Michael Thoenes’s Suzanne Rigged http://creationanimation.com/sites/thoenes/animation/3dtutorials.htm
Nathaniel Shaw’s Generi
Noodlesgc’s (Mike Roberts) W1r3z http://www.esnips.com/doc/276d8bd1-0070-4ee4-bd8c-e787b507d6a9/W1r3z.blend
Nozzy’s Driven hand http://blenderartists.org/forum/showthread.php?t=18754
Nozzy’s Skinny Guy http://blenderartists.org/forum/showthread?t=30994
Otothecleaner’s Flor
Virgilio’s Otto 1.6 Interesting constraint to keep the feet on the floor. http://uploader.polorix.net/files/99/otto_v1.6.zip
Rbackman’s Bounce9
Rbackman’s Zeyne
Simple’s Character
Tugkan’s Sharlo
Woodman5k’s Bunny http://web.pdx.edu/~wlf/Bunny.rar
Yagapayanata’s Rig
Yagapayanata’s Rig(2, 4, 6 legs)
275. Customization

275.1. Changing the Theme

Like many other programs with a graphical user interface, Blender allows you to customize or modify many aspects of its appearance. A collection of such customizations is called a theme.

Theme controls are found in the User Preferences window. Click LMB on the "Themes" button to activate a drop-down menu which can be used to select different themes. Below this is an "Add" button that can be used to create new themes. If any themes have been added, a "Delete" button will appear, along with other controls to adjust the current theme.

This book presents screen shots using the default theme. If you are new to Blender, you should continue using the default theme as you progress through the book, to avoid confusion.
276. Mist - Make Objects Opaque

How Blender’s Mist works

If you render Objects within Blender’s Mist, they mix up with the Background-Color,

because Blender decreases their Alpha-Value by increasing Mist-Intensity and distance from the Camera.

The Problem
This does a well job if your scene has a constantly-colored Background, but

in case of a real Background or World-Texture it looks not convincing.

All objects are looking like ghosts.

The Solution explained briefly
This page will show you two ways to get rid of that Problem.

The major thought is to mix Objects with an opaque color, instead of making them transparent.

The more Transparency, the more of the opaque color will be added.

Because Blender delivers a (dynamic) Alpha-Value with Mist enabled,

we can use this value as a factor for increase or decrease of mixing the objects

with a certain color (or even to enhance or lower the contrast of materials, etc.)
Here’s a render result with mist and the "Mixing-Technique". You see, that you don’t see shining the Background through.

The first solution goes with the help of an external compositing program and won’t be explained in depth as we want to focus on how to solve this issue within blender since it is open source.

**Solution 1: Make use of an external composite software.**

Just render your Background and your Objects separately with Alpha-Channels.

Then you import these files into a composite program on two layers.

(One for the Objects and one for the Background).

Between these layers you set a new "Color-Layer" with a solid greyish-blue color (because this fits the color of the atmosphere) and create a clipping mask.

A "clipping mask" means that the "Color-Layer" is only visible where the objects of the top layer are.
And where there’s no object you can see the Background.

As the object is partially transparent (because of Blender’s Mist),
you will see the greyish-blue color shining through.

The more the object is away, the more transparent it is,
and the more the color-Layer will shine through the Objects.

**Solution 2: Make use of Blender’s Composite-Nodes.**

Since Solution 1 seems not to be a big deal as we cannot afford expensive packages, we are also able
to achieve this ”Mix-Technique” by Blender’s built-in Composite-Nodes.

To continue reading it would be good, if you know a little about Blender’s Compositing-Nodes.

Now, here’s the interesting part of the tutorial, the Graph of the Nodes in the Node-Editor:
Mist - Make Objects Opaque

Description:

**Step 1 Render Layer1**
In the Render Settings Tab you assign the Objects which you don’t want to be transparent to Render Layer1.


![Figure 1591](image)

It is important that you turn off "Sky" and that you turn on "IndexPass". (The Option "Mist" delivers the same Value as the Alpha-Output in the Node RenderLayer1)

"IndexPass" will be explained in Step 5.

**Step 2 Render Layer2**

This Layer renders only the Background, the Sky. In my case I had to enable other elements also, because otherwise the groundplane won’t render.

I don’t know why, but this doesn’t matter in our case.

**Step 3 Separating RGB+Alpha**

The "Image output" of the Node RenderLayer1 delivers RGB+A, that’s a little distracting, because you can see an Alpha-Output also. Select "Add" -> "Color" -> "Separate RGBA" in the Node-Editor Window.

**Step 4 Combining RGBA**

Now the Separated RGB gets combined again to RGB, but this time with a new Alpha of Step 5.
Step 5 Making the transparent Objects opaque

The good thing is, that Blender’s Object-ID Alpha Value does ignore mist.

So we can add an ID-Mask Node to get the Alpha of the Object into the new Image.

Here you must set the ID of the Object to the same number as in the ID-Mask Node.

Select the Object and set its ID Pass-Index!

Beside is a screenshot where you set the Object ID.

![Figure 1592](image)

In the red marked section of the buttons window, you can set the ID of the object.

Step 6 Mixing the Object with a Color

Here you add a Mix-Node to mix the Object with a ”Horizon-Color”.

The Color should be set to a bright greyish-blue as this is the color of the air inner the atmosphere.

Any color is possible, you may think of a dark red in a fire-hollow or of black if somewhere out in space.
**Step 7 Setting the Factor of how much of the color should be added**

Blender delivers an Alpha-Value to the Objects due to the Mist.

If an object is far away or if the Mist-Intensity is very high,

the Alpha-Value of the Object decreases, which means the Alpha-Value becomes more black.

And if the Object is close, it has accordingly high Alpha, which means getting white.

Black means a Value of R-G-B 0-0-0 and White a Value of R-G-B 1-1-1.

Since we want to use these values as a factor of how much to blend the Object with our "Horizon-Color", we need to invert this Value.

(Close Objects = High Alpha = Factor almost 1 - but we need Blend Factor close to 0, because we want low mist as the Object is close)

So let’s add an "Invert-Color-Node".

Get the Settings of the Node-Graph for this Node.

This Node inverts Black to white, dark-grey to bright grey, etc.

We now use this inverted alpha-value (or Mist-value)

as a factor for mixing the Horizon-Color with the Object.

**Step 8 Layering the colored Objects over the Sky-Background**

Now you add an Alpha-Over-Node which will layer our Objects over the Sky-Background.

Be aware to use the settings shown in the screenshot and that the order of the two Image-Inputs

of the Alpha-Over-Node is very important.
The second Input always gets over the first Input.

**Step 9 Add an Output-Node**

Finally you need an Output-Node and to enable "Do Composite" in the RenderSettings.

**Step 10 Example**

Here an Example, of how it worked out in my project:

![Figure 1593](image)

**Figure 1593** Close Distance - Almost no Mist

![Figure 1594](image)

**Figure 1594** Far Distance - Low Mist or atmospheric opacity

![Figure 1595](image)

**Figure 1595** Further Distance - (!)The Object is even scaled
Summary

Be sure, you got every step right - then all will work out properly.

What is almost of more importance, that you understood the logic behind this,

so that you learn about Blender’s Compositing-Nodes and the 01-Logic ;)

Since ”Mist” means something like ”Bullsh**” in German I did not believe that it really

is like that in Blender - and it isn’t! Blender is a quite nice and powerful tool.

And I hope that it’ll ever be Open-Source.
277. Contributors

<table>
<thead>
<tr>
<th>Edits</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01mf02</td>
</tr>
<tr>
<td>25</td>
<td>AM088</td>
</tr>
<tr>
<td>1</td>
<td>AdRiley</td>
</tr>
<tr>
<td>1</td>
<td>Addihockey10 (automated)</td>
</tr>
<tr>
<td>26</td>
<td>Admijr</td>
</tr>
<tr>
<td>242</td>
<td>Adrignola</td>
</tr>
<tr>
<td>1</td>
<td>Akhram</td>
</tr>
<tr>
<td>2</td>
<td>Aldnonymous</td>
</tr>
<tr>
<td>18</td>
<td>Allefant `enwikibooks</td>
</tr>
<tr>
<td>2</td>
<td>AllenZh</td>
</tr>
<tr>
<td>46</td>
<td>AmieKim</td>
</tr>
<tr>
<td>9</td>
<td>Anarchistamy</td>
</tr>
<tr>
<td>7</td>
<td>AndrewBuck</td>
</tr>
<tr>
<td>102</td>
<td>AndyD</td>
</tr>
<tr>
<td>1</td>
<td>Anonymous Dissident</td>
</tr>
<tr>
<td>65</td>
<td>Arch dude</td>
</tr>
<tr>
<td>1</td>
<td>Arch dude (usurped)</td>
</tr>
<tr>
<td>53</td>
<td>Argento</td>
</tr>
<tr>
<td>1</td>
<td>Aschoeke</td>
</tr>
<tr>
<td>1</td>
<td>Ask `enwikibooks</td>
</tr>
<tr>
<td>6</td>
<td>Astronouth7303</td>
</tr>
</tbody>
</table>

1  http://en.wikibooks.org/wiki/User:01mf02

1865
<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Atallcostsky</td>
<td><a href="http://en.wikibooks.org/wiki/User:Atallcostsky">22</a></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Bacon=enwikibooks</td>
<td><a href="http://en.wikibooks.org/wiki/User:Bacon%257Eenwikibooks">26</a></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Badalia</td>
<td><a href="http://en.wikibooks.org/wiki/User:Badalia">27</a></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Beuc</td>
<td><a href="http://en.wikibooks.org/wiki/User:Beuc">29</a></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Bijee=enwikibooks</td>
<td><a href="http://en.wikibooks.org/wiki/User:Bijee%257Eenwikibooks">31</a></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>BimBot</td>
<td><a href="http://en.wikibooks.org/wiki/User:BimBot">33</a></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Blenderizer</td>
<td><a href="http://en.wikibooks.org/wiki/User:Blenderizer">34</a></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Blueskies=enwikibooks</td>
<td><a href="http://en.wikibooks.org/wiki/User:Blueskies%257Eenwikibooks">35</a></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Brandished</td>
<td><a href="http://en.wikibooks.org/wiki/User:Brandished">37</a></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Brimbard</td>
<td><a href="http://en.wikibooks.org/wiki/User:Brimbard">38</a></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Bruce89</td>
<td><a href="http://en.wikibooks.org/wiki/User:Bruce89">40</a></td>
<td></td>
</tr>
<tr>
<td>163</td>
<td>Bullercruz1</td>
<td><a href="http://en.wikibooks.org/wiki/User:Bullercruz1">41</a></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Camel</td>
<td><a href="http://en.wikibooks.org/wiki/User:Camel">42</a></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CarsracBot</td>
<td><a href="http://en.wikibooks.org/wiki/User:CarsracBot">43</a></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Casimir=enwikibooks</td>
<td><a href="http://en.wikibooks.org/wiki/User:Casimir%257Eenwikibooks">44</a></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Chelseafan528</td>
<td><a href="http://en.wikibooks.org/wiki/User:Chelseafan528">46</a></td>
<td></td>
</tr>
</tbody>
</table>
Changing the Theme

2 Chuckhoffmann
22 CommonsDelinker
4 Craigallan.za
19 Crouch
1 Cspurrier
1 Cymru.lass
4 Damian Yerrick
3 Dan-aka-jack
1 Danhash
9 Darkfire
7 Darklama
3 Darkonc
2 DavidCary
1 Defender
1 Dennis G. Jerz
19 Derbeth
1 Dessydes
6 Dirk Hünniger
3 Dolsson5
5 Dooglus
2 Dougc
2 Downdate
12 DuLithgow
16 Electro
5 Enfwm

Contributors

147 EvanCarroll
6 Fede.Campana
1 Frank H
1 Freakazo v2.1
3 Ftiercel
5 Furrykef
64 Gabio
9 Geocachernemesis
1 Girdi
2 Glaisher
11 Greenbreen
2 Gumba gumba
1 GustavTheMushroom
1 HWV258
1 Habstinat
7 Hagindaz
2 Harrybrowne1986
2 Heinrich5991
14 Herbythyme
2 Herreraotic
3 HethrirBot
2 Hoo man
6 Hrakaroo
1 Hydriz
2 Ideasman

75 http://en.wikibooks.org/wiki/User:Freakazo_v2.1

1868
Changing the Theme

7  Iluvblender
1  Inductiveload
3  IqAndreas
5  Ivucica
2  J36miles
1  JamesCrook
72  JamesNZ
1  Jesse Merriman\textsuperscript{enwikibooks}
1  Jfmantis
66  Jguk
4  Jmartens
2  John.delannoy
2  Jollyroger
35  Jomegat
1  Jorge Morais
1  Joystick Tutorial
1  Jsbrowndog
1  Jshadias\textsuperscript{enwikibooks}
1  JuethoBot
5  Kayau
2  Kbellis
5  Kerina yin
1  Kernigh
1  King of Hearts
2  Kwi

\textsuperscript{97} http://en.wikibooks.org/wiki/User:Iluvblender
\textsuperscript{98} http://en.wikibooks.org/wiki/User:Inductiveload
\textsuperscript{99} http://en.wikibooks.org/wiki/User:IqAndreas
\textsuperscript{100} http://en.wikibooks.org/wiki/User:Ivucica
\textsuperscript{101} http://en.wikibooks.org/wiki/User:J36miles
\textsuperscript{102} http://en.wikibooks.org/wiki/User:JamesCrook
\textsuperscript{103} http://en.wikibooks.org/wiki/User:JamesNZ
\textsuperscript{104} http://en.wikibooks.org/wiki/User:Jesse Merriman\textsuperscript{enwikibooks}
\textsuperscript{105} http://en.wikibooks.org/wiki/User:Jfmantis
\textsuperscript{106} http://en.wikibooks.org/wiki/User:Jguk
\textsuperscript{107} http://en.wikibooks.org/wiki/User:Jmartens
\textsuperscript{108} http://en.wikibooks.org/wiki/User:John.delannoy
\textsuperscript{109} http://en.wikibooks.org/wiki/User:Jollyroger
\textsuperscript{110} http://en.wikibooks.org/wiki/User:Jomegat
\textsuperscript{111} http://en.wikibooks.org/wiki/User:Jorge Morais
\textsuperscript{112} http://en.wikibooks.org/wiki/User:Joystick Tutorial
\textsuperscript{113} http://en.wikibooks.org/wiki/User:Jsbrowndog
\textsuperscript{114} http://en.wikibooks.org/wiki/User:Jshadias\textsuperscript{enwikibooks}
\textsuperscript{115} http://en.wikibooks.org/wiki/User:JuethoBot
\textsuperscript{116} http://en.wikibooks.org/wiki/User:Kayau
\textsuperscript{117} http://en.wikibooks.org/wiki/User:Kbellis
\textsuperscript{118} http://en.wikibooks.org/wiki/User:Kerina yin
\textsuperscript{119} http://en.wikibooks.org/wiki/User:Kernigh
\textsuperscript{120} http://en.wikibooks.org/wiki/User:King of Hearts
\textsuperscript{121} http://en.wikibooks.org/wiki/User:Kwi
2 Laleena
12 Lazy-lump
1079 Ldo
1 Learnerktm
22 Lee Carre
9 LeftClicker
1 LlamaAl
34 LokiClock
1 Lordmyth
1 Lsmoura
1 Lxxxy
1 Lynx7725
1 MC10
13 Madcello
63 Malaz
4 Marc-André Àšbrock
11 MasterSkrat
1 Mats Halldin
1 Mattb112885
1 Maveric149
13 Mdd4696
5 Merrilllee
2 Michaelnelson
1 Michaelx153
20 Mike.lifeguard

Changing the Theme

4 Miyazaki enwikibooks
50 Moohasha
13 Morerunes
1 Mouse among men enwikibooks
13 Mtjlt
1 Mxn
68 N comme Nul
9 Nanobug
1 Nanodeath enwikibooks
1 Nczempin
2 Neilwightman enwikibooks
1 Neoptolemus
10 Nick.anderegg
15 Nkansahrexford
2 Nowic
1 NuclearWarfare
30 Null Point
5 Odalcet
1 Orbisonitrum
17 Panic2k4
1 ParallaxTZ
10 PaulJC
1 Pavroo
543 Pearts
11 Pedro Fonini

Contributors

2 Pengo
1 Perhelion
6 Peteturtle\textasciitilde enwikibooks
1 Polluks
2 Pquijal
172
173
174
175
176
184 Quantum Anomaly
32 QuiteUnusual
16 Radialronnie
9 Ramac
1 Ravichandar84
1 RaymondSutanto
9 Recent Runes
1 Red4tribe
5 Reece
1 Remi
2 Remi0o
4 Resul4e
33 Reyk
1 Rgriffogoes
1 Robstafarian
1 RogerWickes
11 Rpyle731
2 Scar\textasciitilde enwikibooks
8 Serpinium
2 Sesu Prime

187 http://en.wikibooks.org/wiki/User:Remi0o
194 http://en.wikibooks.org/wiki/User:Scar\textasciitilde enwikibooks

1872
Changing the Theme

3 ShadoCrytr\textsuperscript{197}
1 Sheridan\textsuperscript{198}
2 Siggimund\textsuperscript{199}
7 Sigma \textsubscript{7}\textsuperscript{200}
1 Simeon\textsuperscript{201}
1 Simon W\textsuperscript{202}
1 Sinistra D32\textsuperscript{203}
1 Sjc\textsuperscript{\textasciitilde}\textsuperscript{\textasciitilde}\textsubscript{enwikibooks}\textsuperscript{204}
3 Slady\textsuperscript{205}
3 Slashme\textsuperscript{206}
2 Snarius\textsuperscript{\textasciitilde}\textsuperscript{\textasciitilde}\textsubscript{enwikibooks}\textsuperscript{207}
2 Socratesone\textsuperscript{208}
10 Soeb\textsuperscript{209}
119 SoylentGreen\textsuperscript{210}
9 Soylentgreen\textsuperscript{211}
414 Spiderworm\textsuperscript{212}
878 Stepheng3\textsuperscript{213}
1 SumOfwHoly\textsuperscript{214}
15 Sumoncil\textsuperscript{215}
1 Sunny256\textsuperscript{216}
1 Super Dave\textsuperscript{\textasciitilde}\textsuperscript{\textasciitilde}\textsubscript{enwikibooks}\textsuperscript{217}
3 Super3boy\textsuperscript{218}
3 Swift\textsuperscript{219}
3 Syum90\textsuperscript{220}
36 Tannersf\textsuperscript{221}

\textsuperscript{197} http://en.wikibooks.org/wiki/User:ShadoCrytr\textasciitilde\textsubscript{enwikibooks}
\textsuperscript{198} http://en.wikibooks.org/wiki/User:Sheridan
\textsuperscript{199} http://en.wikibooks.org/wiki/User:Siggimund
\textsuperscript{200} http://en.wikibooks.org/wiki/User:Sigma_7
\textsuperscript{201} http://en.wikibooks.org/wiki/User:Simeon
\textsuperscript{202} http://en.wikibooks.org/wiki/User:Simon_W
\textsuperscript{203} http://en.wikibooks.org/wiki/User:Sinistra_D32
\textsuperscript{204} http://en.wikibooks.org/wiki/User:Sjc\textasciitilde\textsubscript{enwikibooks}
\textsuperscript{205} http://en.wikibooks.org/wiki/User:Slady
\textsuperscript{206} http://en.wikibooks.org/wiki/User:Slashme
\textsuperscript{207} http://en.wikibooks.org/wiki/User:Snarius\textasciitilde\textsubscript{enwikibooks}
\textsuperscript{208} http://en.wikibooks.org/wiki/User:Socratesone
\textsuperscript{209} http://en.wikibooks.org/wiki/User:Soeb
\textsuperscript{210} http://en.wikibooks.org/wiki/User:SoylentGreen
\textsuperscript{211} http://en.wikibooks.org/wiki/User:Soylentgreen
\textsuperscript{212} http://en.wikibooks.org/wiki/User:Spiderworm
\textsuperscript{213} http://en.wikibooks.org/wiki/User:Stepheng3
\textsuperscript{214} http://en.wikibooks.org/wiki/User:SumOfwHoly
\textsuperscript{215} http://en.wikibooks.org/wiki/User:Sumoncil
\textsuperscript{216} http://en.wikibooks.org/wiki/User:Sunny256
\textsuperscript{217} http://en.wikibooks.org/wiki/User:Super_Dave\textasciitilde\textsubscript{enwikibooks}
\textsuperscript{218} http://en.wikibooks.org/wiki/User:Super3boy
\textsuperscript{219} http://en.wikibooks.org/wiki/User:Swift
\textsuperscript{220} http://en.wikibooks.org/wiki/User:Syum90
\textsuperscript{221} http://en.wikibooks.org/wiki/User:Tannersf
Contributors

3 Techtonik222
1 Tegel223
1 The enemies of god224
11 Thenub314225
1 ThomasB‘enwikibooks226
3 Tualha227
89 Turtle Man228
10 Twofingers229
1 Uncle G230
1 UsedHONDA231
2 Van der Hoorn232
31 Wavez233
5 Webaware234
2 Wikidieter235
3 WindsorSpring236
11 Winterbourne237
6 Withinfocus238
2 Woodstocket239
1 Wwwwolf240
37 Wynnmc241
16 Xania242
2 Xerol243
3 Xlinuxkdex244
5 YMS245
18 Yosofun enwikibooks246

244 http://en.wikibooks.org/wiki/User:Xlinuxkdex
2 ZarabethLanger
23 ZeroOne
13 Zilch\"enwikibooks
4 Zoohouse

List of Figures

- cc-by-sa-3.0: Creative Commons Attribution ShareAlike 3.0 License. http://creativecommons.org/licenses/by-sa/3.0/
- cc-by-sa-2.5: Creative Commons Attribution ShareAlike 2.5 License. http://creativecommons.org/licenses/by-sa/2.5/
- cc-by-sa-2.0: Creative Commons Attribution ShareAlike 2.0 License. http://creativecommons.org/licenses/by-sa/2.0/
- cc-by-sa-1.0: Creative Commons Attribution ShareAlike 1.0 License. http://creativecommons.org/licenses/by-sa/1.0/
- cc-by-2.0: Creative Commons Attribution 2.0 License. http://creativecommons.org/licenses/by/2.0/
- cc-by-2.5: Creative Commons Attribution 2.5 License. http://creativecommons.org/licenses/by/2.5/deed.en
- cc-by-3.0: Creative Commons Attribution 3.0 License. http://creativecommons.org/licenses/by/3.0/deed.en
- PD: This image is in the public domain.
- ATTR: The copyright holder of this file allows anyone to use it for any purpose, provided that the copyright holder is properly attributed. Redistribution, derivative work, commercial use, and all other use is permitted.
- EURO: This is the common (reverse) face of a euro coin. The copyright on the design of the common face of the euro coins belongs to the European Commission. Authorised is reproduction in a format without relief (drawings, paintings, films) provided they are not detrimental to the image of the euro.
- CFR: Copyright free use.
List of Figures


Copies of the GPL, the LGPL as well as a GFDL are included in chapter Licenses\textsuperscript{251}. Please note that images in the public domain do not require attribution. You may click on the image numbers in the following table to open the webpage of the images in your web browser.

\textsuperscript{251} Chapter 278 on page 1949
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Michael Otto (user Mayqel)</td>
<td>GFDL</td>
</tr>
<tr>
<td>2</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>3</td>
<td>Abdull</td>
<td>GFDL</td>
</tr>
<tr>
<td>4</td>
<td>Smjefferson602</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>5</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>6</td>
<td>SoylentGreen</td>
<td>CC-BY-SA-2.5</td>
</tr>
<tr>
<td>7</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>8</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>9</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>10</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>11</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>12</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>13</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>14</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>15</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>16</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>17</td>
<td>Original uploader was BANZ111, at en.wikibooks</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>18</td>
<td>User:BANZ111</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>19</td>
<td>Marco Polo at en.wikipedia</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>20</td>
<td>Marco Polo at en.wikipedia</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>21</td>
<td>Marco Polo at en.wikipedia</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>22</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>23</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>24</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>26</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>27</td>
<td>Emijrpbot, Hazard-Bot, JarektBot, LjL, MADE, Maximax-inax, SieBot</td>
<td>GFDL</td>
</tr>
<tr>
<td>28</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>29</td>
<td>LilSweden</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>30</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>31</td>
<td>JamesNZ (JamesNZ (talk))</td>
<td>PD</td>
</tr>
<tr>
<td>32</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>33</td>
<td>Anoadragon453</td>
<td>GPL</td>
</tr>
<tr>
<td>34</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>35</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>36</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>37</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>38</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>39</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>40</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>41</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>42</td>
<td>Anoadragon453</td>
<td>GPL</td>
</tr>
<tr>
<td>43</td>
<td>Lawrence D’Oliveiro</td>
<td>GPL</td>
</tr>
<tr>
<td>44</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>45</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>46</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>47</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>48</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>49</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>50</td>
<td>Lawrence D’Oliveiro</td>
<td>GPL</td>
</tr>
<tr>
<td>51</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>52</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>53</td>
<td>JamesNZ, Julian Herzog, SieBot, YaCBot</td>
<td>GPL</td>
</tr>
<tr>
<td>54</td>
<td>JamesNZ, Julian Herzog, SieBot, YaCBot</td>
<td>GPL</td>
</tr>
<tr>
<td>55</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>56</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>57</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>58</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>59</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>60</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>61</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>62</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>63</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>64</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
</tbody>
</table>

279 http://commons.wikimedia.org/wiki/User:SoylentGreen
280 http://commons.wikimedia.org/wiki/User:SoylentGreen
282 http://commons.wikimedia.org/wiki/User:JamesNZ
283 http://commons.wikimedia.org/wiki/User_talk:JamesNZ
287 http://commons.wikimedia.org/wiki/User:JamesNZ
<table>
<thead>
<tr>
<th>Figure</th>
<th>Label</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>65</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>66</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>67</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>68</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>69</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>70</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>71</td>
<td>Original uploader was Lazy-lump(^{288}) at en.wikibooks(^{289})</td>
<td>PD</td>
</tr>
<tr>
<td>72</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>73</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>74</td>
<td>JamesNZ(^{290})</td>
<td>PD</td>
</tr>
<tr>
<td>75</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>76</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>77</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>78</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>79</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>80</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>81</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>82</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>83</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>84</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>85</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>86</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>87</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>88</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>89</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>90</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>91</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td>PD</td>
</tr>
<tr>
<td>92</td>
<td>Ldo, Zundark</td>
<td>PD</td>
</tr>
<tr>
<td>93</td>
<td>Ldo, Zundark</td>
<td>PD</td>
</tr>
<tr>
<td>94</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>95</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>96</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>97</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>98</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>99</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>100</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>101</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>102</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>103</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td>PD</td>
</tr>
<tr>
<td>104</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>105</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>106</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>107</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>108</td>
<td>JamesNZ(^{291})</td>
<td>PD</td>
</tr>
<tr>
<td>109</td>
<td>CategorizationBot, JamesNZ, JarektBot, Julian Herzog, SieBot, YaCBot</td>
<td>PD</td>
</tr>
</tbody>
</table>


\(^{289}\) [http://en.wikibooks.org](http://en.wikibooks.org)

\(^{290}\) [http://commons.wikimedia.org/wiki/User:JamesNZ](http://commons.wikimedia.org/wiki/User:JamesNZ)

<table>
<thead>
<tr>
<th>Figure</th>
<th>Author(s)</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>110</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>111</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>112</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>113</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>114</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>115</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>116</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>117</td>
<td>Ldo</td>
<td>GPL</td>
</tr>
<tr>
<td>118</td>
<td>Ldo</td>
<td>GPL</td>
</tr>
<tr>
<td>119</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td>GPL</td>
</tr>
<tr>
<td>120</td>
<td>Ldo</td>
<td>GPL</td>
</tr>
<tr>
<td>121</td>
<td>Ldo</td>
<td>GPL</td>
</tr>
<tr>
<td>122</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td>GPL</td>
</tr>
<tr>
<td>123</td>
<td>Ldo</td>
<td>GPL</td>
</tr>
<tr>
<td>124</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td>GPL</td>
</tr>
<tr>
<td>125</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>126</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>127</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>128</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>129</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>130</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>131</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>132</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>133</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>134</td>
<td>PvtKing</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>135</td>
<td>Emijrpb, JamesNZ, Slobot, Stepheng3, YaCBot</td>
<td>GPL</td>
</tr>
<tr>
<td>136</td>
<td>bamacsguy</td>
<td>GPL</td>
</tr>
<tr>
<td>137</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>138</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>139</td>
<td>bamacsguy</td>
<td>GPL</td>
</tr>
<tr>
<td>140</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>141</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>142</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>143</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>144</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>145</td>
<td>PvtKing</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>146</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>147</td>
<td>Arturo Reina commonswiki, Ausis, Bayo, BotMultichillT, Japs 88, JarektBot, Julian Herzog, MGA73bot2, SieBot, YaCBot, YiFeiBot</td>
<td>GPL</td>
</tr>
<tr>
<td>148</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>149</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>150</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Figure</th>
<th>Author</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>151</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>152</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>153</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>154</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>155</td>
<td>Jake.lewis</td>
<td>GPL</td>
</tr>
<tr>
<td>156</td>
<td>Jake.lewis</td>
<td>GPL</td>
</tr>
<tr>
<td>157</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>158</td>
<td>Toadster</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>159</td>
<td>Myself</td>
<td>GFDL</td>
</tr>
<tr>
<td>160</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>161</td>
<td>Jake.lewis</td>
<td>GPL</td>
</tr>
<tr>
<td>162</td>
<td>Jake.lewis</td>
<td>GPL</td>
</tr>
<tr>
<td>163</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>164</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>165</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>166</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>167</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>168</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>169</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>170</td>
<td>Original uploader was Wwwwolf at en.wikibooks. Later version(s) were uploaded by Spiderworm at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>171</td>
<td>Original uploader was Wwwwolf at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>172</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>173</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>174</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>175</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>176</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>177</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>178</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>179</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>180</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>181</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>182</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
</tbody>
</table>

298 http://commons.wikimedia.org/wiki/User:JamesNZ
299 http://commons.wikimedia.org/wiki/User:JamesNZ
300 http://commons.wikimedia.org/wiki/User:JamesNZ
301 http://commons.wikimedia.org/wiki/User:JamesNZ
302 http://commons.wikimedia.org/wiki/User:JamesNZ
303 http://commons.wikimedia.org/w/index.php?title=User:Toadster&action=edit&redlink=1
304 http://commons.wikimedia.org/wiki/User:JamesNZ
305 http://commons.wikimedia.org/wiki/User:JamesNZ
306 http://commons.wikimedia.org/wiki/User:JamesNZ
307 http://commons.wikimedia.org/wiki/User:JamesNZ
308 http://commons.wikimedia.org/wiki/User:JamesNZ
310 http://en.wikibooks.org
312 http://en.wikibooks.org
314 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>183</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>184</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>185</td>
<td>Falstaff</td>
<td>FDL</td>
</tr>
<tr>
<td>186</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>187</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>188</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>189</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>190</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>191</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>192</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>193</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>194</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>195</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>196</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>197</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>198</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>199</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>202</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>203</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>204</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>205</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>206</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>207</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>208</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>209</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>210</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>211</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>212</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>213</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>214</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>215</td>
<td>Anonymous_man</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>216</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>217</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Figure</th>
<th>Author/Creator</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>218</td>
<td>Ldo⁴³⁰</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>219</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>Blender Foundation⁴³¹</td>
<td>GPL</td>
</tr>
<tr>
<td>221</td>
<td>Falstaff⁴³²</td>
<td>GFDL</td>
</tr>
<tr>
<td>222</td>
<td>Ldo</td>
<td></td>
</tr>
<tr>
<td>223</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>224</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>225</td>
<td>Original uploader was Siesta⁴³³ at en.wikibooks⁴³⁴</td>
<td>GFDL</td>
</tr>
<tr>
<td>226</td>
<td>Ldo⁴³⁵</td>
<td>PD</td>
</tr>
<tr>
<td>227</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>228</td>
<td>Ldo⁴³⁶</td>
<td>PD</td>
</tr>
<tr>
<td>229</td>
<td>Blender Foundation⁴³¹</td>
<td>GPL</td>
</tr>
<tr>
<td>230</td>
<td>Blender Foundation⁴³⁵</td>
<td>GPL</td>
</tr>
<tr>
<td>231</td>
<td>Blender Foundation⁴³⁹</td>
<td>GPL</td>
</tr>
<tr>
<td>232</td>
<td>pearts⁴⁴⁰</td>
<td>GPL</td>
</tr>
<tr>
<td>233</td>
<td>Blender GNU licence</td>
<td>GPL</td>
</tr>
<tr>
<td>234</td>
<td>Original uploader was Megaloman⁴⁴¹ at en.wikibooks⁴⁴²</td>
<td>GPL</td>
</tr>
<tr>
<td>235</td>
<td>Original uploader was Lirtferk⁴⁴³ at en.wikibooks⁴⁴⁴</td>
<td>GPL</td>
</tr>
<tr>
<td>236</td>
<td>Original uploader was Megaloman⁴⁴⁵ at en.wikibooks⁴⁴⁶</td>
<td>GPL</td>
</tr>
<tr>
<td>237</td>
<td>Original uploader was Megaloman⁴⁴⁷ at en.wikibooks⁴⁴⁸</td>
<td>GPL</td>
</tr>
<tr>
<td>238</td>
<td>Original uploader was Megaloman⁴⁴⁹ at en.wikibooks⁴⁵⁰</td>
<td>GPL</td>
</tr>
<tr>
<td>239</td>
<td>Hendric⁴⁵¹</td>
<td>GFDL</td>
</tr>
<tr>
<td>240</td>
<td>Hendric⁴⁵²</td>
<td>GFDL</td>
</tr>
<tr>
<td>241</td>
<td>Original uploader was Megaloman⁴⁵³ at en.wikibooks⁴⁵⁴</td>
<td>GPL</td>
</tr>
</tbody>
</table>

---

330 http://commons.wikimedia.org/wiki/User:Ldo
331 http://commons.wikimedia.org/w/index.php?title=Blender_Foundation&action=edit&redlink=1
334 http://en.wikibooks.org
335 http://commons.wikimedia.org/wiki/User:Ldo
336 http://commons.wikimedia.org/wiki/User:Ldo
342 http://en.wikibooks.org
344 http://en.wikibooks.org
346 http://en.wikibooks.org
348 http://en.wikibooks.org
350 http://en.wikibooks.org
354 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>242</td>
<td>Original uploader was Skeep at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>243</td>
<td>Koltonaugust at en.wikibooks</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>244</td>
<td>Original uploader was Morrolan at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>245</td>
<td>Original uploader was Morrolan at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>246</td>
<td>Original uploader was Morrolan at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>247</td>
<td>Original uploader was Morrolan at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>248</td>
<td>Original uploader was Morrolan at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>249</td>
<td>Original uploader was Morrolan at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>250</td>
<td>Original uploader was Morrolan at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>251</td>
<td>Original uploader was Morrolan at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GFDL</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>252</th>
<th>Original uploader was Morrolan at en.wikibooks</th>
<th>GFDL</th>
</tr>
</thead>
<tbody>
<tr>
<td>253</td>
<td>Original uploader was Morrolan at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>254</td>
<td>Original uploader was Morrolan at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>255</td>
<td>Original uploader was Morrolan at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>256</td>
<td>Original uploader was Morrolan at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>257</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>258</td>
<td>Original uploader was Morrolan at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>259</td>
<td>Original uploader was Morrolan at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>260</td>
<td>Arch dude at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>261</td>
<td>Arch dude at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>262</td>
<td>pearts at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>263</td>
<td>pearts at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>264</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>265</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>266</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>267</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>268</td>
<td>Original uploader was Wynnmc at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>269</td>
<td>Original uploader was Wynnmc at en.wikibooks</td>
<td>GFDL</td>
</tr>
</tbody>
</table>

391 http://en.wikibooks.org
393 http://en.wikibooks.org
395 http://en.wikibooks.org
397 http://en.wikibooks.org
399 http://en.wikibooks.org
401 http://en.wikibooks.org
403 http://en.wikibooks.org
405 http://en.wikibooks.org
406 http://commons.wikimedia.org/wiki/User:Arch_dude
407 http://commons.wikimedia.org/wiki/User:Arch_dude
408 http://commons.wikimedia.org/wiki/User:Pearts
409 http://commons.wikimedia.org/wiki/User:Pearts
411 http://en.wikibooks.org
413 http://en.wikibooks.org
415 http://en.wikibooks.org
417 http://en.wikibooks.org
419 http://en.wikibooks.org
421 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>270</td>
<td>Original uploader was Wynnmc at en.wikibooks, GFDL</td>
</tr>
<tr>
<td>271</td>
<td>Original uploader was Wynnmc at en.wikibooks, GFDL</td>
</tr>
<tr>
<td>272</td>
<td>Original uploader was Wynnmc at en.wikibooks, GFDL</td>
</tr>
<tr>
<td>273</td>
<td>Aka, Aleksandrit, Bohême, Calandrella, Cathy Richards, GeorgHH, JarektBot, MB-one, Maikking, Man vyi, Meisam, Neq00, Nyttend, Père prlpz, Rachel, Radouch, Ranveig, Rhadamante, Sanya3, Stefan4, Suguri F, Warburg, Wst</td>
</tr>
<tr>
<td>274</td>
<td>Arch dude, GFDL</td>
</tr>
<tr>
<td>275</td>
<td>Arch dude, GFDL</td>
</tr>
<tr>
<td>276</td>
<td>Original uploader was AverieZen at en.wikibooks, GPL</td>
</tr>
<tr>
<td>277</td>
<td>Original uploader was AverieZen at en.wikibooks, GPL</td>
</tr>
<tr>
<td>278</td>
<td>Original uploader was AverieZen at en.wikibooks, GPL</td>
</tr>
<tr>
<td>279</td>
<td>Original uploader was AverieZen at en.wikibooks, GPL</td>
</tr>
<tr>
<td>280</td>
<td>Original uploader was AverieZen at en.wikibooks, GPL</td>
</tr>
<tr>
<td>281</td>
<td>Original uploader was AverieZen at en.wikibooks, GPL</td>
</tr>
<tr>
<td>282</td>
<td>Original uploader was AverieZen at en.wikibooks, GPL</td>
</tr>
<tr>
<td>283</td>
<td>Original uploader was AverieZen at en.wikibooks, GPL</td>
</tr>
<tr>
<td>284</td>
<td>Original uploader was AverieZen at en.wikibooks, GPL</td>
</tr>
<tr>
<td>285</td>
<td>Original uploader was AverieZen at en.wikibooks, GPL</td>
</tr>
<tr>
<td>286</td>
<td>JonnyJack, CC-BY-SA-3.0</td>
</tr>
<tr>
<td>287</td>
<td>JonnyJack, CC-BY-SA-3.0</td>
</tr>
<tr>
<td>288</td>
<td>JonnyJack, CC-BY-SA-3.0</td>
</tr>
</tbody>
</table>

423 http://en.wikibooks.org
425 http://en.wikibooks.org
427 http://en.wikibooks.org
428 http://commons.wikimedia.org/wiki/User:Arch_dude
429 http://commons.wikimedia.org/wiki/User:Arch_dude
431 http://en.wikibooks.org
433 http://en.wikibooks.org
435 http://en.wikibooks.org
437 http://en.wikibooks.org
439 http://en.wikibooks.org
441 http://en.wikibooks.org
443 http://en.wikibooks.org
445 http://en.wikibooks.org
447 http://en.wikibooks.org
449 http://en.wikibooks.org
452 http://commons.wikimedia.org/w/index.php?title=User:JonnyJack&action=edit&redlink=1
<table>
<thead>
<tr>
<th></th>
<th>Figure</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>289</td>
<td>JonnyJack</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>290</td>
<td>JonnyJack</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>291</td>
<td>JonnyJack</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>292</td>
<td>JonnyJack</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>293</td>
<td>JonnyJack</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>294</td>
<td>JonnyJack</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>295</td>
<td>JonnyJack</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>296</td>
<td>JonnyJack</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>297</td>
<td>JonnyJack</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>298</td>
<td>JonnyJack</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>299</td>
<td>JonnyJack</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>300</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>301</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>302</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>303</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>304</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>305</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>306</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>307</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>308</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>309</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>310</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>311</td>
<td>Buttflyhoney</td>
<td>CC-BY-SA-3.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Number</th>
<th>Image Title</th>
<th>Author</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>312</td>
<td>Butterflyhoney</td>
<td>AverieZen</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>313</td>
<td>Butterflyhoney</td>
<td>AverieZen</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>314</td>
<td>Butterflyhoney</td>
<td>AverieZen</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>315</td>
<td>Butterflyhoney</td>
<td>AverieZen</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>316</td>
<td>Butterflyhoney</td>
<td>AverieZen</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>317</td>
<td>Butterflyhoney</td>
<td>AverieZen</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>318</td>
<td>Butterflyhoney</td>
<td>AverieZen</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>319</td>
<td>Butterflyhoney</td>
<td>AverieZen</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>320</td>
<td>Original uploader was AverieZen [304] at en.wikibooks [305]</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>321</td>
<td>Original uploader was AverieZen [306] at en.wikibooks [307]</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>322</td>
<td>Original uploader was Josellis [308] at en.wikibooks [309]</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>323</td>
<td>Original uploader was AverieZen [310] at en.wikibooks [311]</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>324</td>
<td>Original uploader was AverieZen [312] at en.wikibooks [313]</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>325</td>
<td>Original uploader was AverieZen [314] at en.wikibooks [315]</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>326</td>
<td>Original uploader was AverieZen [316] at en.wikibooks [317]</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>327</td>
<td>Original uploader was AverieZen [318] at en.wikibooks [319]</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>328</td>
<td>pearts[307]</td>
<td></td>
<td>GPL</td>
</tr>
<tr>
<td>329</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>330</td>
<td>Original uploader was AverieZen [320] at en.wikibooks [321]</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>331</td>
<td>Original uploader was AverieZen [322] at en.wikibooks [323]</td>
<td>GPL</td>
<td></td>
</tr>
</tbody>
</table>

482 http://commons.wikimedia.org/w/index.php?title=User:Buttflyhoney&action=edit&redlink=1
485 http://en.wikibooks.org
487 http://en.wikibooks.org
489 http://en.wikibooks.org
491 http://en.wikibooks.org
493 http://en.wikibooks.org
495 http://en.wikibooks.org
497 http://en.wikibooks.org
499 http://en.wikibooks.org
500 http://commons.wikimedia.org/wiki/User:Pearts
502 http://en.wikibooks.org
504 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>332</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>333</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>334</td>
<td></td>
<td></td>
</tr>
<tr>
<td>335</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>336</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>337</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>338</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>339</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>340</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>341</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>342</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>343</td>
<td>Original uploaded by AverieZen (Transferred by pearts)</td>
<td>GPL</td>
</tr>
<tr>
<td>344</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>345</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>346</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>347</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>348</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>349</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>350</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>351</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>352</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>353</td>
<td>Paul James Chatman</td>
<td></td>
</tr>
<tr>
<td>354</td>
<td>Paul James Chatman</td>
<td></td>
</tr>
<tr>
<td>355</td>
<td>Paul James Chatman</td>
<td></td>
</tr>
<tr>
<td>356</td>
<td>pearts</td>
<td>GPL</td>
</tr>
</tbody>
</table>


1891
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>357</td>
<td>pearts533</td>
<td>GPL</td>
</tr>
<tr>
<td>358</td>
<td>pearts534</td>
<td>GPL</td>
</tr>
<tr>
<td>359</td>
<td>pearts535</td>
<td>GPL</td>
</tr>
<tr>
<td>360</td>
<td>pearts536</td>
<td>GPL</td>
</tr>
<tr>
<td>361</td>
<td>pearts537</td>
<td>GPL</td>
</tr>
<tr>
<td>362</td>
<td>pearts538</td>
<td>GPL</td>
</tr>
<tr>
<td>363</td>
<td>pearts539</td>
<td>GPL</td>
</tr>
<tr>
<td>364</td>
<td>pearts540</td>
<td>GPL</td>
</tr>
<tr>
<td>365</td>
<td>Original uploader was AverieZen541 at en.wikibooks542</td>
<td>GPL</td>
</tr>
<tr>
<td>366</td>
<td>Original uploader was AverieZen543 at en.wikibooks544</td>
<td>GPL</td>
</tr>
<tr>
<td>367</td>
<td>pearts545</td>
<td>GPL</td>
</tr>
<tr>
<td>368</td>
<td>Original uploader was AverieZen546 at en.wikibooks547</td>
<td>GPL</td>
</tr>
<tr>
<td>369</td>
<td>pearts548</td>
<td>GPL</td>
</tr>
<tr>
<td>370</td>
<td>pearts549</td>
<td>GPL</td>
</tr>
<tr>
<td>371</td>
<td>pearts550</td>
<td>GPL</td>
</tr>
<tr>
<td>372</td>
<td>pearts551</td>
<td>GPL</td>
</tr>
<tr>
<td>373</td>
<td>Original uploader was AverieZen552 at en.wikibooks553</td>
<td>GPL</td>
</tr>
<tr>
<td>374</td>
<td>Original uploader was AverieZen554 at en.wikibooks555</td>
<td>GPL</td>
</tr>
<tr>
<td>375</td>
<td>Original uploader was AverieZen556 at en.wikibooks557</td>
<td>GPL</td>
</tr>
<tr>
<td>376</td>
<td>Original uploader was AverieZen558 at en.wikibooks559</td>
<td>GPL</td>
</tr>
<tr>
<td>377</td>
<td>Original uploader was AverieZen560 at en.wikibooks561</td>
<td>GPL</td>
</tr>
<tr>
<td>378</td>
<td>Original uploader was AverieZen562 at en.wikibooks563</td>
<td>GPL</td>
</tr>
</tbody>
</table>

533 http://commons.wikimedia.org/wiki/User:Pearts
534 http://commons.wikimedia.org/wiki/User:Pearts
536 http://commons.wikimedia.org/wiki/User:Pearts
537 http://commons.wikimedia.org/wiki/User:Pearts
538 http://commons.wikimedia.org/wiki/User:Pearts
539 http://commons.wikimedia.org/wiki/User:Pearts
540 http://commons.wikimedia.org/wiki/User:Pearts
542 http://en.wikibooks.org
544 http://en.wikibooks.org
545 http://commons.wikimedia.org/wiki/User:Pearts
547 http://en.wikibooks.org
548 http://commons.wikimedia.org/wiki/User:Pearts
549 http://commons.wikimedia.org/wiki/User:Pearts
550 http://commons.wikimedia.org/wiki/User:Pearts
551 http://commons.wikimedia.org/wiki/User:Pearts
553 http://en.wikibooks.org
555 http://en.wikibooks.org
557 http://en.wikibooks.org
559 http://en.wikibooks.org
561 http://en.wikibooks.org
563 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Original uploader</th>
<th>Original uploader URL</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure</td>
<td>Description</td>
<td>License</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td>396</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>397</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>398</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>399</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>401</td>
<td>DDD3x</td>
<td>CC-BY-3.0</td>
<td></td>
</tr>
<tr>
<td>402</td>
<td>Telmer6</td>
<td>CC-BY-SA-3.0</td>
<td></td>
</tr>
<tr>
<td>403</td>
<td>Mooroon</td>
<td>CC-BY-SA-3.0</td>
<td></td>
</tr>
<tr>
<td>404</td>
<td>Mooroon</td>
<td>CC-BY-SA-3.0</td>
<td></td>
</tr>
<tr>
<td>405</td>
<td>MercedMike</td>
<td>CC-BY-SA-3.0</td>
<td></td>
</tr>
<tr>
<td>406</td>
<td>MercedMike</td>
<td>CC-BY-SA-3.0</td>
<td></td>
</tr>
<tr>
<td>407</td>
<td>Ldo, OgreBot 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>408</td>
<td>Ldo, OgreBot 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>409</td>
<td>Ldo, OgreBot 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>410</td>
<td>Emijrpbot, JamesNZ, Slobot, Stepheng3, YaCBot</td>
<td></td>
<td></td>
</tr>
<tr>
<td>411</td>
<td>parts</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>412</td>
<td>Radialronnie. Original uploader was Radialronnie at en.wikibooks</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>413</td>
<td>Original uploader was Radialronnie at en.wikibooks</td>
<td>GFDL</td>
<td></td>
</tr>
<tr>
<td>414</td>
<td>parts</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>415</td>
<td>Original uploader was Radialronnie at en.wikibooks</td>
<td>GFDL</td>
<td></td>
</tr>
<tr>
<td>416</td>
<td>Original uploader was Radialronnie at en.wikibooks</td>
<td>GFDL</td>
<td></td>
</tr>
<tr>
<td>417</td>
<td>Original uploader was Radialronnie at en.wikibooks</td>
<td>GFDL</td>
<td></td>
</tr>
</tbody>
</table>

603 [http://en.wikibooks.org](http://en.wikibooks.org)
608 [http://commons.wikimedia.org/w/index.php?title=DDD3x&action=edit&redlink=1](http://commons.wikimedia.org/w/index.php?title=DDD3x&action=edit&redlink=1)
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>418</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>419</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>420</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>421</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>422</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>423</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>424</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>425</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>426</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
</tbody>
</table>

630 [http://en.wikibooks.org](http://en.wikibooks.org)
<table>
<thead>
<tr>
<th>Number</th>
<th>Original uploader</th>
<th>Original version(s)</th>
<th>Later version(s)</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>427</td>
<td>Sumoncil</td>
<td>427</td>
<td>428</td>
<td>GPL</td>
</tr>
<tr>
<td>428</td>
<td>Sumoncil</td>
<td>428</td>
<td>429</td>
<td>GPL</td>
</tr>
<tr>
<td>429</td>
<td>Sumoncil</td>
<td>429</td>
<td>430</td>
<td>GPL</td>
</tr>
<tr>
<td>430</td>
<td>Sumoncil</td>
<td>430</td>
<td>431</td>
<td>GPL</td>
</tr>
<tr>
<td>431</td>
<td>Sumoncil</td>
<td>431</td>
<td>432</td>
<td>GPL</td>
</tr>
<tr>
<td>432</td>
<td>Sumoncil</td>
<td>432</td>
<td>433</td>
<td>GPL</td>
</tr>
<tr>
<td>433</td>
<td>Sumoncil</td>
<td>433</td>
<td>434</td>
<td>GPL</td>
</tr>
<tr>
<td>434</td>
<td>Sumoncil</td>
<td>434</td>
<td>435</td>
<td>GPL</td>
</tr>
</tbody>
</table>

664 http://en.wikibooks.org
666 http://en.wikibooks.org
668 http://en.wikibooks.org
670 http://en.wikibooks.org
672 http://en.wikibooks.org
674 http://en.wikibooks.org
676 http://en.wikibooks.org
678 http://en.wikibooks.org
680 http://en.wikibooks.org
682 http://en.wikibooks.org
684 http://en.wikibooks.org
686 http://en.wikibooks.org
688 http://en.wikibooks.org
690 http://en.wikibooks.org
692 http://en.wikibooks.org
694 http://en.wikibooks.org
696 http://en.wikibooks.org
698 http://en.wikibooks.org
1896
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>436</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>437</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>438</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>439</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>440</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>441</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>442</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>443</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>444</td>
<td>Original uploader was Sumoncil at en.wikibooks. GPL</td>
</tr>
</tbody>
</table>

http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>445</td>
<td>Original uploader was Sumoncil(^{733}) at en.wikibooks(^{734}). Later version(s) were uploaded by Adrignola(^{735}) at en.wikibooks(^{736}).</td>
<td>GPL</td>
</tr>
<tr>
<td>446</td>
<td>Original uploader was Sumoncil(^{737}) at en.wikibooks(^{738}). Later version(s) were uploaded by Adrignola(^{739}) at en.wikibooks(^{740}).</td>
<td>GPL</td>
</tr>
<tr>
<td>447</td>
<td>Original uploader was Sumoncil(^{741}) at en.wikibooks(^{742}). Later version(s) were uploaded by Adrignola(^{743}) at en.wikibooks(^{744}).</td>
<td>GPL</td>
</tr>
<tr>
<td>448</td>
<td>Original uploader was Sumoncil(^{745}) at en.wikibooks(^{746}). Later version(s) were uploaded by Adrignola(^{747}) at en.wikibooks(^{748}).</td>
<td>GPL</td>
</tr>
<tr>
<td>449</td>
<td>Original uploader was Sumoncil(^{749}) at en.wikibooks(^{750}). Later version(s) were uploaded by Adrignola(^{751}) at en.wikibooks(^{752}).</td>
<td>GPL</td>
</tr>
<tr>
<td>450</td>
<td>Original uploader was Sumoncil(^{753}) at en.wikibooks(^{754}). Later version(s) were uploaded by Adrignola(^{755}) at en.wikibooks(^{756}).</td>
<td>GPL</td>
</tr>
<tr>
<td>451</td>
<td>Original uploader was Sumoncil(^{757}) at en.wikibooks(^{758}). Later version(s) were uploaded by Adrignola(^{759}) at en.wikibooks(^{760}).</td>
<td>GPL</td>
</tr>
<tr>
<td>452</td>
<td>Original uploader was Sumoncil(^{761}) at en.wikibooks(^{762}). Later version(s) were uploaded by Adrignola(^{763}) at en.wikibooks(^{764}).</td>
<td>GPL</td>
</tr>
<tr>
<td>453</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>454</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>455</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>456</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>457</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
</tbody>
</table>

\(^{734}\) http://en.wikibooks.org
\(^{736}\) http://en.wikibooks.org
\(^{738}\) http://en.wikibooks.org
\(^{740}\) http://en.wikibooks.org
\(^{742}\) http://en.wikibooks.org
\(^{744}\) http://en.wikibooks.org
\(^{746}\) http://en.wikibooks.org
\(^{748}\) http://en.wikibooks.org
\(^{750}\) http://en.wikibooks.org
\(^{752}\) http://en.wikibooks.org
\(^{754}\) http://en.wikibooks.org
\(^{756}\) http://en.wikibooks.org
\(^{758}\) http://en.wikibooks.org
\(^{760}\) http://en.wikibooks.org
\(^{762}\) http://en.wikibooks.org
\(^{764}\) http://en.wikibooks.org

1898
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>458</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>459</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>460</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>461</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>462</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>463</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>464</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>465</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>466</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>467</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>468</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>469</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>470</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>471</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>472</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>473</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>474</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>475</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>476</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>477</td>
<td>pearts&quot;^3&quot; GPL</td>
</tr>
<tr>
<td>478</td>
<td>pearts&quot;^6&quot; GPL</td>
</tr>
<tr>
<td>479</td>
<td>pearts&quot;^7&quot; GPL</td>
</tr>
<tr>
<td>480</td>
<td>pearts&quot;^8&quot; GPL</td>
</tr>
<tr>
<td>481</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>482</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>483</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>484</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>485</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>486</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>487</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>488</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>489</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>490</td>
<td>Original uploader was Wynnmc&quot;^67&quot; at en.wikibooks&quot;^70&quot; GFDL</td>
</tr>
<tr>
<td>491</td>
<td>Original uploader was Wynnmc&quot;^47&quot; at en.wikibooks&quot;^72&quot; GFDL</td>
</tr>
<tr>
<td>492</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>493</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>494</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>495</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>496</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>497</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>498</td>
<td>pearts&quot;^73&quot; GPL</td>
</tr>
</tbody>
</table>

---

## List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>499</td>
<td>SoylentGreen GFDL</td>
</tr>
<tr>
<td>500</td>
<td>SoylentGreen GFDL</td>
</tr>
<tr>
<td>501</td>
<td>SoylentGreen GFDL</td>
</tr>
<tr>
<td>502</td>
<td>SoylentGreen GFDL</td>
</tr>
<tr>
<td>503</td>
<td>SoylentGreen GFDL</td>
</tr>
<tr>
<td>504</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>505</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>506</td>
<td>MercedMike GPL</td>
</tr>
<tr>
<td>507</td>
<td>MercedMike GPL</td>
</tr>
<tr>
<td>508</td>
<td>Blender Foundation GPL</td>
</tr>
<tr>
<td>509</td>
<td>MercedMike GPL</td>
</tr>
<tr>
<td>510</td>
<td>MercedMike GPL</td>
</tr>
<tr>
<td>511</td>
<td>MercedMike GPL</td>
</tr>
<tr>
<td>512</td>
<td>MercedMike GPL</td>
</tr>
<tr>
<td>513</td>
<td>MercedMike GPL</td>
</tr>
<tr>
<td>514</td>
<td>MercedMike GPL</td>
</tr>
<tr>
<td>515</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>516</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>517</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>518</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>519</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>520</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>521</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>522</td>
<td>Original uploader was Embri at en.wikibooks GPL</td>
</tr>
<tr>
<td>523</td>
<td>Original uploader was Embri at en.wikibooks GPL</td>
</tr>
<tr>
<td>524</td>
<td>Original uploader was Embri at en.wikibooks GPL</td>
</tr>
<tr>
<td>525</td>
<td>Arturo Reina commonswiki, Bayo, Jarekt, JarektBot, YaCBot GPL</td>
</tr>
<tr>
<td>526</td>
<td>Embri, Original uploader was Embri at en.wikibooks GPL</td>
</tr>
<tr>
<td>527</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>528</td>
<td>Ldo, OgreBot 2</td>
</tr>
</tbody>
</table>

774 http://commons.wikimedia.org/wiki/User:SoylentGreen
775 http://commons.wikimedia.org/wiki/User:SoylentGreen
776 http://commons.wikimedia.org/wiki/User:SoylentGreen
777 http://commons.wikimedia.org/wiki/User:SoylentGreen
778 http://commons.wikimedia.org/wiki/User:SoylentGreen
779 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
780 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
781 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
782 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
783 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
784 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
785 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
786 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
788 http://en.wikibooks.org
790 http://en.wikibooks.org
792 http://en.wikibooks.org
794 http://en.wikibooks.org
795 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Page</th>
<th>Figures</th>
</tr>
</thead>
<tbody>
<tr>
<td>529</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>530</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>531</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>532</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>533</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>534</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>535</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>536</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>537</td>
<td>Cycn, JarektBot, Judithcomm, Knorrepoes, Mattes, Panchos, Wilhelm meis, Wst, YaCBot</td>
</tr>
<tr>
<td>538</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>539</td>
<td>Bilderbot, JarektBot, MGA73bot2, Maksim, Mdd, Timeshifter, WikipediaMaster, YaCBot</td>
</tr>
<tr>
<td>540</td>
<td>Lawrence D'Oliveiro</td>
</tr>
<tr>
<td>541</td>
<td>programmers of Blender</td>
</tr>
<tr>
<td>542</td>
<td>pearts(795)</td>
</tr>
<tr>
<td>543</td>
<td></td>
</tr>
<tr>
<td>544</td>
<td>Original uploader was Lirtferk(796) at en.wikibooks</td>
</tr>
<tr>
<td>545</td>
<td>Adrignola, Badalia</td>
</tr>
<tr>
<td>546</td>
<td>Original uploader was Badalia(797) at en.wikibooks</td>
</tr>
<tr>
<td>547</td>
<td>Original uploader was Badalia(798) at en.wikibooks</td>
</tr>
<tr>
<td>548</td>
<td>Original uploader was Badalia(799) at en.wikibooks</td>
</tr>
<tr>
<td>549</td>
<td></td>
</tr>
<tr>
<td>550</td>
<td>Adrignola, Badalia</td>
</tr>
<tr>
<td>551</td>
<td>Adrignola</td>
</tr>
<tr>
<td>552</td>
<td>Adrignola</td>
</tr>
<tr>
<td>553</td>
<td>Adrignola</td>
</tr>
<tr>
<td>554</td>
<td>Adrignola</td>
</tr>
<tr>
<td>555</td>
<td>Adrignola</td>
</tr>
<tr>
<td>556</td>
<td>Adrignola</td>
</tr>
<tr>
<td>557</td>
<td>Original uploader was AverieZen(800) at en.wikibooks</td>
</tr>
<tr>
<td>558</td>
<td>Original uploader was AverieZen(801) at en.wikibooks</td>
</tr>
<tr>
<td>559</td>
<td>Original uploader was AverieZen(802) at en.wikibooks</td>
</tr>
<tr>
<td>560</td>
<td>Original uploader was AverieZen(803) at en.wikibooks</td>
</tr>
</tbody>
</table>

---

795 http://commons.wikimedia.org/wiki/User:Pearts
797 http://en.wikibooks.org
799 http://en.wikibooks.org
801 http://en.wikibooks.org
803 http://en.wikibooks.org
805 http://en.wikibooks.org
807 http://en.wikibooks.org
809 http://en.wikibooks.org
811 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>No.</th>
<th>Original uploader</th>
<th>Original uploader link</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>566</td>
<td>Az1568</td>
<td></td>
<td></td>
</tr>
<tr>
<td>567</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>568</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

References:

1902
<table>
<thead>
<tr>
<th>Figure</th>
<th>Original uploader</th>
<th>Source</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>580</td>
<td>Yoyotweak</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>581</td>
<td>Mrfelis</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>582</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>583</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>584</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>585</td>
<td>Mrfelis</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>586</td>
<td>Mrfelis</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>587</td>
<td>Mrfelis</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>588</td>
<td>Mrfelis</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>589</td>
<td>Mrfelis</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>590</td>
<td>Mrfelis</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>591</td>
<td>Mrfelis</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>592</td>
<td>Mrfelis</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>593</td>
<td>Mrfelis</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>594</td>
<td>pearts</td>
<td></td>
<td>GPL</td>
</tr>
<tr>
<td>595</td>
<td>pearts</td>
<td></td>
<td>GPL</td>
</tr>
<tr>
<td>596</td>
<td>Kieran</td>
<td>en.wikibooks</td>
<td>GFDL</td>
</tr>
</tbody>
</table>

845 http://en.wikibooks.org
847 http://en.wikibooks.org
849 http://en.wikibooks.org
851 http://en.wikibooks.org
853 http://en.wikibooks.org
855 http://en.wikibooks.org
858 http://en.wikibooks.org
860 http://en.wikibooks.org
863 http://en.wikibooks.org
866 http://en.wikibooks.org
869 http://en.wikibooks.org
870 http://commons.wikimedia.org/wiki/User:Pearts
871 http://commons.wikimedia.org/wiki/User:Pearts
873 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>597</td>
<td>Original uploader was Kieran at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>598</td>
<td>Original uploader was Kieran at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>599</td>
<td>Original uploader was Kieran at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>600</td>
<td>Original uploader was Kieran at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>601</td>
<td>Original uploader was Kieran at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>602</td>
<td>Original uploader was Kieran at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>603</td>
<td>pearts at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>604</td>
<td>Original uploader was Kieran at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>605</td>
<td>Original uploader was Kieran at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>606</td>
<td>pearts at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>607</td>
<td>Kieran at English Wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>608</td>
<td>Original uploader was Johno at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>609</td>
<td>Original uploader was Johno at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>610</td>
<td>Original uploader was Johno at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>611</td>
<td>Original uploader was Johno at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>612</td>
<td></td>
<td></td>
</tr>
<tr>
<td>613</td>
<td>Original uploader was Johno at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>614</td>
<td>Original uploader was Darkonc at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>615</td>
<td>Original uploader was Darkonc at en.wikibooks</td>
<td>GFDL</td>
</tr>
</tbody>
</table>

875 http://en.wikibooks.org
877 http://en.wikibooks.org
879 http://en.wikibooks.org
881 http://en.wikibooks.org
883 http://en.wikibooks.org
885 http://en.wikibooks.org
886 http://commons.wikimedia.org/wiki/User:Pearts
888 http://en.wikibooks.org
890 http://en.wikibooks.org
891 http://commons.wikimedia.org/wiki/User:Pearts
893 http://en.wikibooks.org/wiki/
895 http://en.wikibooks.org
897 http://en.wikibooks.org
899 http://en.wikibooks.org
901 http://en.wikibooks.org
903 http://en.wikibooks.org
905 http://en.wikibooks.org
907 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>616</td>
<td>Darkonc</td>
</tr>
<tr>
<td>617</td>
<td>Darkonc</td>
</tr>
<tr>
<td>618</td>
<td>Darkonc</td>
</tr>
<tr>
<td>619</td>
<td>Darkonc</td>
</tr>
<tr>
<td>620</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>621</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>622</td>
<td>Ldo</td>
</tr>
<tr>
<td>623</td>
<td>Ldo</td>
</tr>
<tr>
<td>624</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>625</td>
<td>Gilles Tran</td>
</tr>
<tr>
<td>626</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>627</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>628</td>
<td>Ldo</td>
</tr>
<tr>
<td>629</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>630</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>631</td>
<td>Ldo</td>
</tr>
<tr>
<td>632</td>
<td>Ldo</td>
</tr>
<tr>
<td>633</td>
<td>Ldo</td>
</tr>
<tr>
<td>634</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>635</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>636</td>
<td>Ldo</td>
</tr>
<tr>
<td>637</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>638</td>
<td>Ldo</td>
</tr>
<tr>
<td>639</td>
<td>Ldo</td>
</tr>
<tr>
<td>640</td>
<td>Ldo</td>
</tr>
<tr>
<td>641</td>
<td>Ldo</td>
</tr>
<tr>
<td>642</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>643</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>644</td>
<td>Ldo</td>
</tr>
<tr>
<td>645</td>
<td>SoylentGreen</td>
</tr>
<tr>
<td>646</td>
<td>SoylentGreen</td>
</tr>
<tr>
<td>647</td>
<td>SoylentGreen</td>
</tr>
<tr>
<td>648</td>
<td>SoylentGreen</td>
</tr>
<tr>
<td>649</td>
<td>SoylentGreen</td>
</tr>
</tbody>
</table>

908 http://commons.wikimedia.org/wiki/User:Ldo
909 http://commons.wikimedia.org/wiki/User:Ldo
911 http://commons.wikimedia.org/wiki/User:Ldo
912 http://commons.wikimedia.org/wiki/User:Ldo
913 http://commons.wikimedia.org/wiki/User:Ldo
914 http://commons.wikimedia.org/wiki/User:Ldo
915 http://commons.wikimedia.org/wiki/User:Ldo
916 http://commons.wikimedia.org/wiki/User:Ldo
917 http://commons.wikimedia.org/wiki/User:Ldo
918 http://commons.wikimedia.org/wiki/User:Ldo
919 http://commons.wikimedia.org/wiki/User:Ldo
920 http://commons.wikimedia.org/wiki/User:SoylentGreen
921 http://commons.wikimedia.org/wiki/User:SoylentGreen
922 http://commons.wikimedia.org/wiki/User:SoylentGreen
923 http://commons.wikimedia.org/wiki/User:SoylentGreen
924 http://commons.wikimedia.org/wiki/User:SoylentGreen
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>650</td>
<td>SoylentGreen\textsuperscript{925} using a file from the releases notes of Blender version 2.32</td>
<td>GFDL</td>
</tr>
<tr>
<td>651</td>
<td>SoylentGreen\textsuperscript{926} using a file from the releases notes of Blender version 2.32</td>
<td>GFDL</td>
</tr>
<tr>
<td>652</td>
<td>SoylentGreen\textsuperscript{927}</td>
<td>GPL</td>
</tr>
<tr>
<td>653</td>
<td>SoylentGreen\textsuperscript{928}</td>
<td>GPL</td>
</tr>
<tr>
<td>654</td>
<td>SoylentGreen\textsuperscript{929}</td>
<td>GPL</td>
</tr>
<tr>
<td>655</td>
<td>SoylentGreen\textsuperscript{930}</td>
<td>GFDL</td>
</tr>
<tr>
<td>656</td>
<td>SoylentGreen\textsuperscript{931}</td>
<td>GFDL</td>
</tr>
<tr>
<td>657</td>
<td>SoylentGreen\textsuperscript{932}</td>
<td>GFDL</td>
</tr>
<tr>
<td>658</td>
<td>SoylentGreen\textsuperscript{933}</td>
<td>GFDL</td>
</tr>
<tr>
<td>659</td>
<td>SoylentGreen\textsuperscript{934}</td>
<td>GFDL</td>
</tr>
<tr>
<td>660</td>
<td>SoylentGreen\textsuperscript{935}</td>
<td>GPL</td>
</tr>
<tr>
<td>661</td>
<td>SoylentGreen\textsuperscript{936}</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>662</td>
<td>SoylentGreen\textsuperscript{937}</td>
<td>GPL</td>
</tr>
<tr>
<td>663</td>
<td>SoylentGreen\textsuperscript{938}</td>
<td>GPL</td>
</tr>
<tr>
<td>664</td>
<td>SoylentGreen\textsuperscript{939}, Krzysztof P. Jasiutowicz</td>
<td>GFDL</td>
</tr>
<tr>
<td>665</td>
<td>SoylentGreen\textsuperscript{940} (Edited by: Weeix\textsuperscript{941})</td>
<td>GPL</td>
</tr>
<tr>
<td>666</td>
<td>SoylentGreen\textsuperscript{942}</td>
<td>GFDL</td>
</tr>
<tr>
<td>667</td>
<td>Weeix\textsuperscript{943} (talk\textsuperscript{944}) 14:15, 2 November 2010 (UTC)</td>
<td>GPL</td>
</tr>
<tr>
<td>668</td>
<td>Dobz116\textsuperscript{945}</td>
<td>GFDL</td>
</tr>
<tr>
<td>669</td>
<td>MercedMike\textsuperscript{946}</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>670</td>
<td>AbiBot, BotMultichill, Emijrbot, GeorgHH, Hazard-Bot, JarektBot, Ken g6</td>
<td>GFDL</td>
</tr>
<tr>
<td>671</td>
<td>Adrignola, Ask enwikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>672</td>
<td>Original uploader was Dan13\textsuperscript{947} at en.wikibooks\textsuperscript{948}</td>
<td>GFDL</td>
</tr>
<tr>
<td>673</td>
<td>Adrignola</td>
<td></td>
</tr>
</tbody>
</table>

\textsuperscript{925} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{926} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{927} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{928} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{929} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{930} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{931} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{932} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{933} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{934} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{935} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{936} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{937} [http://commons.wikimedia.org/wiki/User:SoylentGreen](http://commons.wikimedia.org/wiki/User:SoylentGreen)
\textsuperscript{938} [http://commons.wikimedia.org/wiki/User:Weeix](http://commons.wikimedia.org/wiki/User:Weeix)
\textsuperscript{942} [http://commons.wikimedia.org/wiki/User:MercedMike](http://commons.wikimedia.org/wiki/User:MercedMike)
<table>
<thead>
<tr>
<th>Figure</th>
<th>Image</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>674 en:Dan13</td>
<td>CC-BY-SA-2.5</td>
<td></td>
</tr>
<tr>
<td>675 Adrignola</td>
<td></td>
<td></td>
</tr>
<tr>
<td>676 Adrignola</td>
<td></td>
<td></td>
</tr>
<tr>
<td>677 Adrignola</td>
<td></td>
<td></td>
</tr>
<tr>
<td>678 Adrignola</td>
<td></td>
<td></td>
</tr>
<tr>
<td>679 Adrignola</td>
<td></td>
<td></td>
</tr>
<tr>
<td>680 Adrignola</td>
<td></td>
<td></td>
</tr>
<tr>
<td>681 Adrignola</td>
<td></td>
<td></td>
</tr>
<tr>
<td>682 Adrignola</td>
<td></td>
<td></td>
</tr>
<tr>
<td>683 Adrignola</td>
<td></td>
<td></td>
</tr>
<tr>
<td>684 Adrignola</td>
<td></td>
<td></td>
</tr>
<tr>
<td>685 Adrignola</td>
<td></td>
<td></td>
</tr>
<tr>
<td>686 Weeix</td>
<td>PD</td>
<td></td>
</tr>
<tr>
<td>687 MercedMike</td>
<td>CC-BY-SA-3.0</td>
<td></td>
</tr>
<tr>
<td>688 Ldo, OgreBot 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>689 Ldo, OgreBot 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>690 MercedMike</td>
<td>CC-BY-SA-3.0</td>
<td></td>
</tr>
<tr>
<td>691 MercedMike</td>
<td>CC-BY-SA-3.0</td>
<td></td>
</tr>
<tr>
<td>692 Original uploader was Hrakaroo at en.wikibooks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>693 Original uploader was WeirdHat at en.wikibooks. Later version(s) were uploaded by Rdp at en.wikibooks.</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>694 Original uploader was Icky-wiki at en.wikibooks</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>695 Arturo Reina commonswiki, Bayo, JarektBot, MGA73bot2, YaCbot, YiFeiBot</td>
<td></td>
<td></td>
</tr>
<tr>
<td>696 Original uploader was Hrakaroo at en.wikibooks</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>697 Original uploader was ThomasB at en.wikibooks</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>698 Original uploader was Chinmay gautam at en.wikibooks</td>
<td>CC-BY-SA-3.0</td>
<td></td>
</tr>
<tr>
<td>699 Original uploader was Chinmay gautam at en.wikibooks</td>
<td>CC-BY-SA-3.0</td>
<td></td>
</tr>
</tbody>
</table>

http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
http://en.wikibooks.org
### List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Original uploader</th>
<th>Original source</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>700</td>
<td>Chinmay Gautam</td>
<td>en.wikibooks</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>701</td>
<td>Chinmay Gautam</td>
<td>en.wikibooks</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>702</td>
<td>Hrakaroo</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>703</td>
<td>Hrakaroo</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>704</td>
<td>Hrakaroo</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>705</td>
<td>Hrakaroo</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>706</td>
<td>Wallygrom</td>
<td></td>
<td>CC-BY-SA-2.0</td>
</tr>
<tr>
<td>707</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>708</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>709</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>710</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>711</td>
<td>MercedMike</td>
<td></td>
<td>GPL</td>
</tr>
<tr>
<td>712</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>713</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>714</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>715</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>716</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>717</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>718</td>
<td>MercedMike</td>
<td></td>
<td>GPL</td>
</tr>
<tr>
<td>719</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>720</td>
<td>MercedMike</td>
<td></td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>721</td>
<td>MercedMike</td>
<td></td>
<td>GPL</td>
</tr>
</tbody>
</table>

973 [http://en.wikibooks.org](http://en.wikibooks.org)
975 [http://en.wikibooks.org](http://en.wikibooks.org)
<table>
<thead>
<tr>
<th>Figure</th>
<th>Author</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>722</td>
<td>MercedMike</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>723</td>
<td>MercedMike</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>724</td>
<td>MercedMike</td>
<td>GPL</td>
</tr>
<tr>
<td>725</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>726</td>
<td>Ldo, OgreBot 2</td>
<td>GPL</td>
</tr>
<tr>
<td>727</td>
<td>MercedMike</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>728</td>
<td>JamesNZ</td>
<td>PD</td>
</tr>
<tr>
<td>729</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>730</td>
<td>Original uploader was ZeroOne at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>731</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>732</td>
<td>Apoc2400, Badzil, Ephemeron, JarektBot, Mapmarks, Saperaud commonswiki</td>
<td>GPL</td>
</tr>
<tr>
<td>733</td>
<td>Original uploader was ZeroOne at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>734</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>735</td>
<td>Original uploader was ZeroOne at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>736</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>737</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>738</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>739</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>740</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>741</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>742</td>
<td>Quantum Anomaly at English Wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>743</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>744</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>745</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>746</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>747</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>748</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>749</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>750</td>
<td>Original uploader was Quantum Anomaly at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>751</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>752</td>
<td>Quantum Anomaly</td>
<td>GPL</td>
</tr>
<tr>
<td>753</td>
<td>Original uploader was Quantum Anomaly at en.wikibooks</td>
<td>GPL</td>
</tr>
</tbody>
</table>

998 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
999 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
1000 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
1001 http://commons.wikimedia.org/w/index.php?title=User:MercedMike&action=edit&redlink=1
1002 http://commons.wikimedia.org/wiki/User:JamesNZ
1004 http://en.wikibooks.org
1006 http://en.wikibooks.org
1008 http://en.wikibooks.org
1010 http://en.wikibooks.org/wiki/
1012 http://en.wikibooks.org
1014 http://en.wikibooks.org
List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>754</td>
<td>Original uploader was Quantum Anomaly at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>755</td>
<td>Original uploader was Quantum Anomaly at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>756</td>
<td>Original uploader was Quantum Anomaly at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>757</td>
<td>Original uploader was Quantum Anomaly at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>758</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td>PD</td>
</tr>
<tr>
<td>759</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>760</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>761</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>762</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>763</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>764</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>765</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>766</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>767</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>768</td>
<td>Original uploader was AndyD at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>769</td>
<td>Original uploader was AndyD at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>770</td>
<td>Original uploader was AndyD at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>771</td>
<td>Original uploader was AndyD at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>772</td>
<td>Original uploader was AndyD at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>773</td>
<td>Original uploader was AndyD at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>774</td>
<td>Original uploader was AndyD at en.wikibooks</td>
<td>GPL</td>
</tr>
</tbody>
</table>

1016 http://en.wikibooks.org
1018 http://en.wikibooks.org
1020 http://en.wikibooks.org
1022 http://en.wikibooks.org
1023 http://commons.wikimedia.org/wiki/User:Ldo
1024 http://commons.wikimedia.org/wiki/User:Ldo
1025 http://commons.wikimedia.org/wiki/User:Ldo
1026 http://commons.wikimedia.org/wiki/User:Ldo
1028 http://en.wikibooks.org
1030 http://en.wikibooks.org
1032 http://en.wikibooks.org
1034 http://en.wikibooks.org
1036 http://en.wikibooks.org
1038 http://en.wikibooks.org
1040 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>775</td>
<td>Original uploader was AndyD at en.wikibooks GPL</td>
</tr>
<tr>
<td>776</td>
<td>Original uploader was AndyD at en.wikibooks GPL</td>
</tr>
<tr>
<td>777</td>
<td>Original uploader was AndyD at en.wikibooks GPL</td>
</tr>
<tr>
<td>778</td>
<td>Original uploader was AndyD at en.wikibooks GPL</td>
</tr>
<tr>
<td>779</td>
<td>Original uploader was AndyD at en.wikibooks GPL</td>
</tr>
<tr>
<td>780</td>
<td>Original uploader was AndyD at en.wikibooks GPL</td>
</tr>
<tr>
<td>781</td>
<td>Original uploader was AndyD at en.wikibooks GPL</td>
</tr>
<tr>
<td>782</td>
<td>Original uploader was AndyD at en.wikibooks GPL</td>
</tr>
<tr>
<td>783</td>
<td>Original uploader was AndyD at en.wikibooks GPL</td>
</tr>
<tr>
<td>784</td>
<td>Original uploader was AndyD at en.wikibooks GPL</td>
</tr>
<tr>
<td>785</td>
<td>Adrignola, AndyD</td>
</tr>
<tr>
<td>786</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>787</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>788</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>789</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>790</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>791</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>792</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>793</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>794</td>
<td>SoylentGreen GPL</td>
</tr>
<tr>
<td>795</td>
<td>SoylentGreen GPL</td>
</tr>
<tr>
<td>796</td>
<td>SoylentGreen GPL</td>
</tr>
<tr>
<td>797</td>
<td>SoylentGreen GPL</td>
</tr>
<tr>
<td>798</td>
<td>SoylentGreen GPL</td>
</tr>
<tr>
<td>799</td>
<td>SoylentGreen GPL</td>
</tr>
</tbody>
</table>

1042 http://en.wikibooks.org
1044 http://en.wikibooks.org
1046 http://en.wikibooks.org
1048 http://en.wikibooks.org
1050 http://en.wikibooks.org
1052 http://en.wikibooks.org
1054 http://en.wikibooks.org
1056 http://en.wikibooks.org
1058 http://en.wikibooks.org
1060 http://en.wikibooks.org
1062 http://commons.wikimedia.org/wiki/User:SoylentGreen
1063 http://commons.wikimedia.org/wiki/User:SoylentGreen
1064 http://commons.wikimedia.org/wiki/User:SoylentGreen
1065 http://commons.wikimedia.org/wiki/User:SoylentGreen
1066 http://commons.wikimedia.org/wiki/User:SoylentGreen
### List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Caption</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>800</td>
<td>SoylentGreen1067</td>
<td>GFDL</td>
</tr>
<tr>
<td>801</td>
<td>SoylentGreen1068</td>
<td>GPL</td>
</tr>
<tr>
<td>802</td>
<td>SoylentGreen1069</td>
<td>GPL</td>
</tr>
<tr>
<td>803</td>
<td>SoylentGreen1070</td>
<td>GPL</td>
</tr>
<tr>
<td>804</td>
<td>SoylentGreen1071</td>
<td>GPL</td>
</tr>
<tr>
<td>805</td>
<td>SoylentGreen1072</td>
<td>GPL</td>
</tr>
<tr>
<td>806</td>
<td>SoylentGreen1073</td>
<td>GPL</td>
</tr>
<tr>
<td>807</td>
<td>SoylentGreen1074</td>
<td>GPL</td>
</tr>
<tr>
<td>808</td>
<td>SoylentGreen1075</td>
<td>GPL</td>
</tr>
<tr>
<td>809</td>
<td>SoylentGreen1076</td>
<td>GPL</td>
</tr>
<tr>
<td>810</td>
<td>SoylentGreen1077</td>
<td>GPL</td>
</tr>
<tr>
<td>811</td>
<td>SoylentGreen1078</td>
<td>GPL</td>
</tr>
<tr>
<td>812</td>
<td>SoylentGreen1079</td>
<td>GPL</td>
</tr>
<tr>
<td>813</td>
<td>SoylentGreen1080</td>
<td>GPL</td>
</tr>
<tr>
<td>814</td>
<td>SoylentGreen1081</td>
<td>GPL</td>
</tr>
<tr>
<td>815</td>
<td>Original uploader was Porlando1082 at en.wikibooks1083. Later version(s) were uploaded by Adrignola1084 at en.wikibooks1085.</td>
<td>GPL</td>
</tr>
<tr>
<td>816</td>
<td>Original uploader was Porlando1086 at en.wikibooks1087. Later version(s) were uploaded by Adrignola1088 at en.wikibooks1089.</td>
<td>GPL</td>
</tr>
<tr>
<td>817</td>
<td>Original uploader was Porlando1090 at en.wikibooks1091. Later version(s) were uploaded by Adrignola1092 at en.wikibooks1093.</td>
<td>GPL</td>
</tr>
<tr>
<td>818</td>
<td>Ldo</td>
<td></td>
</tr>
<tr>
<td>819</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1089 [http://en.wikibooks.org](http://en.wikibooks.org)
<table>
<thead>
<tr>
<th>Fig.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>820</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>821</td>
<td>Ldo</td>
</tr>
<tr>
<td>822</td>
<td>Ldo</td>
</tr>
<tr>
<td>823</td>
<td>Ldo</td>
</tr>
<tr>
<td>824</td>
<td>Ldo[1094]</td>
</tr>
<tr>
<td>825</td>
<td>Original uploader was LokiClock[1095] at en.wikibooks[1096]</td>
</tr>
<tr>
<td>826</td>
<td>Original uploader was LokiClock[1097] at en.wikibooks[1098]</td>
</tr>
<tr>
<td>827</td>
<td>The original uploader was LokiClock[1099] at English Wikibooks[1100]</td>
</tr>
<tr>
<td>828</td>
<td>Malaz</td>
</tr>
<tr>
<td>829</td>
<td>Malaz</td>
</tr>
<tr>
<td>830</td>
<td>Malaz</td>
</tr>
<tr>
<td>831</td>
<td>Malaz</td>
</tr>
<tr>
<td>832</td>
<td>Jackson Williams (Malaz)[1101], Original uploader was Malaz[1102] at en.wikibooks[1103]</td>
</tr>
<tr>
<td>833</td>
<td>Malaz</td>
</tr>
<tr>
<td>834</td>
<td>Jackson Williams (Malaz)[1104], Original uploader was Malaz[1105] at en.wikibooks[1106]</td>
</tr>
<tr>
<td>835</td>
<td>Malaz</td>
</tr>
<tr>
<td>836</td>
<td>Jackson Williams (Malaz)[1107], Original uploader was Malaz[1108] at en.wikibooks[1109]</td>
</tr>
<tr>
<td>837</td>
<td>Malaz</td>
</tr>
<tr>
<td>838</td>
<td>Malaz</td>
</tr>
<tr>
<td>839</td>
<td>Jackson Williams (Malaz)[1110], Original uploader was Malaz[1111] at en.wikibooks[1112]</td>
</tr>
<tr>
<td>840</td>
<td>Jackson Williams (Malaz)[1113], Original uploader was Malaz[1114] at en.wikibooks[1115]</td>
</tr>
<tr>
<td>841</td>
<td>Malaz</td>
</tr>
<tr>
<td>842</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>843</td>
<td>Ldo, OgreBot 2</td>
</tr>
</tbody>
</table>

---

1109 [http://en.wikibooks.org](http://en.wikibooks.org)
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>844</td>
<td>Ldo, OgreBot 2, Waldir</td>
<td>GPL</td>
</tr>
<tr>
<td>845</td>
<td>Lawrence D’Oliveiro</td>
<td>GPL</td>
</tr>
<tr>
<td>846</td>
<td>Lawrence D’Oliveiro</td>
<td>GPL</td>
</tr>
<tr>
<td>847</td>
<td>Lawrence D’Oliveiro</td>
<td>GPL</td>
</tr>
<tr>
<td>848</td>
<td>Lawrence D’Oliveiro</td>
<td>GPL</td>
</tr>
<tr>
<td>849</td>
<td>Lawrence D’Oliveiro</td>
<td>GPL</td>
</tr>
<tr>
<td>850</td>
<td>Lawrence D’Oliveiro</td>
<td>GPL</td>
</tr>
<tr>
<td>851</td>
<td>Wayne Harrison</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>852</td>
<td>Adrignola</td>
<td></td>
</tr>
<tr>
<td>853</td>
<td></td>
<td></td>
</tr>
<tr>
<td>854</td>
<td></td>
<td></td>
</tr>
<tr>
<td>855</td>
<td></td>
<td></td>
</tr>
<tr>
<td>856</td>
<td></td>
<td></td>
</tr>
<tr>
<td>857</td>
<td>BotMultichill, Cholo Aleman commonswiki, Denniss, Emijrpbot, Hazard-Bot, JarektBot</td>
<td></td>
</tr>
<tr>
<td>858</td>
<td>Original uploader was Aidan.Sullivan at en.wikibooks. Later version(s) were uploaded by Adrignola, Swift, Dal308 at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>859</td>
<td>Original uploader was Ascen at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>860</td>
<td>Original uploader was Ascen at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>861</td>
<td>Original uploader was Aidan.Sullivan at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>862</td>
<td>Original uploader was Aidan.Sullivan at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>863</td>
<td></td>
<td></td>
</tr>
<tr>
<td>864</td>
<td></td>
<td></td>
</tr>
<tr>
<td>865</td>
<td></td>
<td></td>
</tr>
<tr>
<td>866</td>
<td></td>
<td></td>
</tr>
<tr>
<td>867</td>
<td>Original uploader was Moohasha at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>868</td>
<td>Moohasha, Original uploader was Moohasha at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>869</td>
<td>Original uploader was Moohasha at en.wikibooks.</td>
<td>GPL</td>
</tr>
</tbody>
</table>


1914
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>870</td>
<td>Moohasha, Original uploader was Moohasha at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>871</td>
<td>Moohasha, Original uploader was Moohasha at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>872</td>
<td>Original uploader was Moohasha at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>873</td>
<td>Moohasha, Original uploader was Moohasha at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>874</td>
<td>Original uploader was Moohasha at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>875</td>
<td>Moohasha, Original uploader was Moohasha at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>876</td>
<td></td>
<td></td>
</tr>
<tr>
<td>877</td>
<td>Original uploader was Moohasha at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>878</td>
<td>Moohasha, Original uploader was Moohasha at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>879</td>
<td>Moohasha, Original uploader was Moohasha at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>880</td>
<td>Original uploader was Moohasha at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>881</td>
<td>Moohasha</td>
<td></td>
</tr>
<tr>
<td>882</td>
<td>Moohasha, Original uploader was Moohasha at en.wikibooks</td>
<td>GFDL</td>
</tr>
</tbody>
</table>

---

1139 http://en.wikibooks.org
1142 http://en.wikibooks.org
1144 http://en.wikibooks.org
1147 http://en.wikibooks.org
1149 http://en.wikibooks.org
1152 http://en.wikibooks.org
1154 http://en.wikibooks.org
1157 http://en.wikibooks.org
1160 http://en.wikibooks.org
1162 http://en.wikibooks.org
1165 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>URL</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure</td>
<td>Description</td>
<td>License</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td>893</td>
<td>Moohasha\textsuperscript{1196}, Original uploader was Moohasha\textsuperscript{1197} at en.wikibooks\textsuperscript{1198}</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>894</td>
<td>SoylentGreen\textsuperscript{1199}</td>
<td></td>
<td></td>
</tr>
<tr>
<td>895</td>
<td>SoylentGreen\textsuperscript{1200}</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>896</td>
<td>SoylentGreen\textsuperscript{1201}</td>
<td></td>
<td></td>
</tr>
<tr>
<td>897</td>
<td>SoylentGreen\textsuperscript{1202}</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>898</td>
<td>SoylentGreen\textsuperscript{1203}</td>
<td></td>
<td></td>
</tr>
<tr>
<td>899</td>
<td>SoylentGreen\textsuperscript{1204}</td>
<td></td>
<td></td>
</tr>
<tr>
<td>900</td>
<td>Jeremy B., Original uploader was Bullercruz1\textsuperscript{1205} at en.wikibooks\textsuperscript{1206}</td>
<td>GFDL</td>
<td></td>
</tr>
<tr>
<td>901</td>
<td>Jeremy B., Original uploader was Bullercruz1\textsuperscript{1207} at en.wikibooks\textsuperscript{1208}</td>
<td>GFDL</td>
<td></td>
</tr>
<tr>
<td>902</td>
<td>Jeremy B., Original uploader was Bullercruz1\textsuperscript{1209} at en.wikibooks\textsuperscript{1210}</td>
<td>GFDL</td>
<td></td>
</tr>
<tr>
<td>903</td>
<td>Jeremy B., Original uploader was Bullercruz1\textsuperscript{1211} at en.wikibooks\textsuperscript{1212}. Later version(s) were uploaded by Adrignola\textsuperscript{1213} at en.wikibooks\textsuperscript{1214}.</td>
<td>GPL</td>
<td></td>
</tr>
<tr>
<td>904</td>
<td>Bullercruz1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>905</td>
<td>Bullercruz1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>906</td>
<td>Bullercruz1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>907</td>
<td>Bullercruz1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>908</td>
<td>Bullercruz1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>909</td>
<td>Jeremy B. Original uploader was Bullercruz1\textsuperscript{1215} at en.wikibooks\textsuperscript{1216}. Later version(s) were uploaded by Adrignola\textsuperscript{1217} at en.wikibooks\textsuperscript{1218}.</td>
<td>GPL</td>
<td></td>
</tr>
</tbody>
</table>

\textsuperscript{1196}http://en.wikibooks.org/wiki/en:User:Moohasha
\textsuperscript{1197}http://en.wikibooks.org/wiki/en:User:Moohasha
\textsuperscript{1198}http://en.wikibooks.org
\textsuperscript{1199}http://commons.wikimedia.org/wiki/User:SoylentGreen
\textsuperscript{1200}http://commons.wikimedia.org/wiki/User:SoylentGreen
\textsuperscript{1201}http://commons.wikimedia.org/wiki/User:SoylentGreen
\textsuperscript{1202}http://commons.wikimedia.org/wiki/User:SoylentGreen
\textsuperscript{1203}http://commons.wikimedia.org/wiki/User:SoylentGreen
\textsuperscript{1204}http://commons.wikimedia.org/wiki/User:SoylentGreen
\textsuperscript{1205}http://en.wikibooks.org/wiki/en:User:Bullercruz1
\textsuperscript{1206}http://en.wikibooks.org
\textsuperscript{1207}http://en.wikibooks.org/wiki/en:User:Bullercruz1
\textsuperscript{1208}http://en.wikibooks.org
\textsuperscript{1209}http://en.wikibooks.org/wiki/en:User:Bullercruz1
\textsuperscript{1210}http://en.wikibooks.org
\textsuperscript{1211}http://en.wikibooks.org/wiki/en:User:Bullercruz1
\textsuperscript{1212}http://en.wikibooks.org
\textsuperscript{1213}http://en.wikibooks.org/wiki/en:User:Adrignola
\textsuperscript{1214}http://en.wikibooks.org
\textsuperscript{1215}http://en.wikibooks.org/wiki/en:User:Bullercruz1
\textsuperscript{1216}http://en.wikibooks.org
\textsuperscript{1218}http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>910</td>
<td>Jeremy B. Original uploader was Bullercruz1 at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
</tr>
<tr>
<td>911</td>
<td>Jeremy B. Original uploader was Bullercruz1 at en.wikibooks.</td>
</tr>
<tr>
<td>912</td>
<td>Bullercruz1</td>
</tr>
<tr>
<td>913</td>
<td>Jeremy B. Original uploader was Bullercruz1 at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
</tr>
<tr>
<td>914</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>915</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>916</td>
<td>Lawrence D’Oliveiro</td>
</tr>
<tr>
<td>917</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>918</td>
<td>Lawrence D’Oliveiro</td>
</tr>
<tr>
<td>919</td>
<td>Lawrence D’Oliveiro</td>
</tr>
<tr>
<td>920</td>
<td>Lawrence D’Oliveiro</td>
</tr>
<tr>
<td>921</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>922</td>
<td>Ldo</td>
</tr>
<tr>
<td>923</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>924</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>925</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>926</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>927</td>
<td>Ldo</td>
</tr>
<tr>
<td>928</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>929</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>930</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>931</td>
<td>Ldo</td>
</tr>
<tr>
<td>932</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>933</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>934</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>935</td>
<td>Ldo</td>
</tr>
<tr>
<td>936</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>937</td>
<td>Ldo, OgreBot 2</td>
</tr>
<tr>
<td>938</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
</tr>
<tr>
<td>939</td>
<td>Ldo</td>
</tr>
</tbody>
</table>


1918
<table>
<thead>
<tr>
<th>Figure</th>
<th>Image Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>940</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>941</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>942</td>
<td>Ldo</td>
<td></td>
</tr>
<tr>
<td>943</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>944</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>945</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>946</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>947</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>948</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>949</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>950</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>951</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>952</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>953</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>954</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>955</td>
<td>Ldo</td>
<td></td>
</tr>
<tr>
<td>956</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>957</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>958</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>959</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>960</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>961</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>962</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>963</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>964</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>965</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>966</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>967</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>968</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>969</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>970</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>971</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>972</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>973</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>974</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>975</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>976</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>977</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>978</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>979</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>980</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>981</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>982</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
</tbody>
</table>

1234 http://commons.wikimedia.org/wiki/User:Ldo
1235 http://commons.wikimedia.org/wiki/User:Ldo
1236 http://commons.wikimedia.org/wiki/User:Ldo
1237 http://commons.wikimedia.org/wiki/User:Ldo
1238 http://commons.wikimedia.org/wiki/User:Ldo
1239 http://commons.wikimedia.org/wiki/User:Ldo
1240 http://commons.wikimedia.org/wiki/User:Ldo
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>983</td>
<td>Ldo</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>984</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>985</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>986</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>987</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>988</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>989</td>
<td>Ldo, OgreBot 2</td>
<td>PD</td>
</tr>
<tr>
<td>990</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>991</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>992</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>993</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>994</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>995</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>996</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>997</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>998</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>999</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1001</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1002</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1003</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1004</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1005</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1006</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1007</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1008</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1009</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1010</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1011</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1012</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>1013</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1014</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1015</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1016</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1017</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1018</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1019</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1020</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1021</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1022</td>
<td>Ldo</td>
<td>PD</td>
</tr>
<tr>
<td>1023</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>1024</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1025</td>
<td>Ldo, SchlurcherBot, YaCBot</td>
<td></td>
</tr>
<tr>
<td>1026</td>
<td>Ldo, OgreBot 2</td>
<td></td>
</tr>
<tr>
<td>1027</td>
<td>Ldo</td>
<td>PD</td>
</tr>
</tbody>
</table>


1920
<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1028</td>
<td>Original uploader was Gabio at en.wikibooks [1246]</td>
<td>GPL</td>
</tr>
<tr>
<td>1029</td>
<td>Nkansah Rexford</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>1030</td>
<td>Nkansah Rexford</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>1031</td>
<td>Original uploader was Gabio at en.wikibooks [1248]</td>
<td>GPL</td>
</tr>
<tr>
<td>1032</td>
<td>Original uploader was Gabio at en.wikibooks [1250]</td>
<td>GPL</td>
</tr>
<tr>
<td>1033</td>
<td>Original uploader was Gabio at en.wikibooks [1252]</td>
<td>GPL</td>
</tr>
<tr>
<td>1034</td>
<td>Original uploader was Gabio at en.wikibooks [1254]</td>
<td>GPL</td>
</tr>
<tr>
<td>1035</td>
<td>Original uploader was Gabio at en.wikibooks [1256]</td>
<td>GPL</td>
</tr>
<tr>
<td>1036</td>
<td>Original uploader was Gabio at en.wikibooks [1258]</td>
<td>GPL</td>
</tr>
<tr>
<td>1037</td>
<td>Original uploader was Gabio at en.wikibooks [1260]</td>
<td>GPL</td>
</tr>
<tr>
<td>1038</td>
<td>Original uploader was Gabio at en.wikibooks [1262]</td>
<td>GPL</td>
</tr>
<tr>
<td>1039</td>
<td>Original uploader was Gabio at en.wikibooks [1264]</td>
<td>GPL</td>
</tr>
<tr>
<td>1040</td>
<td>Original uploader was Gabio at en.wikibooks [1266]</td>
<td>GPL</td>
</tr>
<tr>
<td>1041</td>
<td>Original uploader was Gabio at en.wikibooks [1268]</td>
<td>GPL</td>
</tr>
<tr>
<td>1042</td>
<td>Original uploader was Gabio at en.wikibooks [1270]</td>
<td>GPL</td>
</tr>
<tr>
<td>1043</td>
<td>Original uploader was Gabio at en.wikibooks [1272]</td>
<td>GPL</td>
</tr>
<tr>
<td>1044</td>
<td>Original uploader was Gabio at en.wikibooks [1274]</td>
<td>GPL</td>
</tr>
<tr>
<td>1045</td>
<td>Original uploader was Gabio at en.wikibooks [1276]</td>
<td>GPL</td>
</tr>
<tr>
<td>1046</td>
<td>Original uploader was Gabio at en.wikibooks [1278]</td>
<td>GPL</td>
</tr>
</tbody>
</table>

1247: http://en.wikibooks.org
1249: http://en.wikibooks.org
1251: http://en.wikibooks.org
1253: http://en.wikibooks.org
1255: http://en.wikibooks.org
1257: http://en.wikibooks.org
1259: http://en.wikibooks.org
1261: http://en.wikibooks.org
1263: http://en.wikibooks.org
1265: http://en.wikibooks.org
1267: http://en.wikibooks.org
1269: http://en.wikibooks.org
1271: http://en.wikibooks.org
1273: http://en.wikibooks.org
1275: http://en.wikibooks.org
1277: http://en.wikibooks.org
1279: http://en.wikibooks.org
1280: http://en.wikibooks.org
### List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1047</td>
<td>Original uploader was Gabio&lt;sup&gt;1280&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1281&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1048</td>
<td>Original uploader was Gabio&lt;sup&gt;1282&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1283&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1049</td>
<td>Original uploader was Gabio&lt;sup&gt;1284&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1285&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1050</td>
<td>Original uploader was Gabio&lt;sup&gt;1286&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1287&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1051</td>
<td>Original uploader was Gabio&lt;sup&gt;1288&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1289&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1052</td>
<td>Original uploader was Gabio&lt;sup&gt;1290&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1291&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1053</td>
<td>Original uploader was Gabio&lt;sup&gt;1292&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1293&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1054</td>
<td>Original uploader was Gabio&lt;sup&gt;1294&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1295&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1055</td>
<td>Original uploader was Gabio&lt;sup&gt;1296&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1297&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1056</td>
<td>Original uploader was Gabio&lt;sup&gt;1298&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1299&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1057</td>
<td>Original uploader was Gabio&lt;sup&gt;1300&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1301&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1058</td>
<td>Original uploader was Gabio&lt;sup&gt;1302&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1303&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1059</td>
<td>Original uploader was Gabio&lt;sup&gt;1304&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1305&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1060</td>
<td>Original uploader was Gabio&lt;sup&gt;1306&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1307&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1061</td>
<td>Gabio</td>
</tr>
<tr>
<td>1062</td>
<td>Original uploader was Gabio&lt;sup&gt;1308&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1309&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1063</td>
<td>Original uploader was Gabio&lt;sup&gt;1310&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1311&lt;/sup&gt; GPL</td>
</tr>
<tr>
<td>1064</td>
<td>Original uploader was Stalepanda&lt;sup&gt;1312&lt;/sup&gt; at en.wikibooks&lt;sup&gt;1313&lt;/sup&gt; GFDL</td>
</tr>
</tbody>
</table>

1281 http://en.wikibooks.org
1283 http://en.wikibooks.org
1285 http://en.wikibooks.org
1287 http://en.wikibooks.org
1289 http://en.wikibooks.org
1291 http://en.wikibooks.org
1293 http://en.wikibooks.org
1295 http://en.wikibooks.org
1297 http://en.wikibooks.org
1299 http://en.wikibooks.org
1301 http://en.wikibooks.org
1303 http://en.wikibooks.org
1305 http://en.wikibooks.org
1307 http://en.wikibooks.org
1309 http://en.wikibooks.org
1311 http://en.wikibooks.org
1313 http://en.wikibooks.org

1922
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1065</td>
<td>Original uploader was Stalepanda at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>1066</td>
<td>Original uploader was Stalepanda at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>1067</td>
<td>Original uploader was Stalepanda at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>1068</td>
<td>Original uploader was Gabio at en.wikibooks</td>
<td>GPL</td>
</tr>
</tbody>
</table>
| 1069   | Gabio | |}

---

<table>
<thead>
<tr>
<th>Figure</th>
<th>Original uploader</th>
<th>Source</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1089</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1090</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1091</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1092</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1093</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1094</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1095</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1096</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1097</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1098</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1099</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1100</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1101</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1102</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1103</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1104</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1105</td>
<td>Gabio</td>
<td>en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1106</td>
<td></td>
<td></td>
<td>FDL</td>
</tr>
<tr>
<td>1107</td>
<td>Halley</td>
<td>en.wikibooks</td>
<td>FDL</td>
</tr>
<tr>
<td>1108</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1109</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1110</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1111</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1112</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1113</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1343 http://en.wikibooks.org
1345 http://en.wikibooks.org
1347 http://en.wikibooks.org
1349 http://en.wikibooks.org
1351 http://en.wikibooks.org
1353 http://en.wikibooks.org
1355 http://en.wikibooks.org
1357 http://en.wikibooks.org
1359 http://en.wikibooks.org
1361 http://en.wikibooks.org
1363 http://en.wikibooks.org
1365 http://en.wikibooks.org
1367 http://en.wikibooks.org
1369 http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1114</td>
<td>Original uploader was Wavez at en.wikibooks</td>
</tr>
<tr>
<td>1115</td>
<td>Original uploader was Wavez at en.wikibooks</td>
</tr>
<tr>
<td>1116</td>
<td>Soylentgreen at en.wikibooks</td>
</tr>
<tr>
<td>1117</td>
<td>Soylentgreen at en.wikibooks</td>
</tr>
<tr>
<td>1118</td>
<td>Soylentgreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1119</td>
<td>Soylentgreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1120</td>
<td>Soylentgreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1121</td>
<td>Soylentgreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1122</td>
<td>Soylentgreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1123</td>
<td>Soylentgreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1124</td>
<td>Soylentgreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1125</td>
<td>Soylentgreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1126</td>
<td>Soylentgreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1127</td>
<td>Soylentgreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1128</td>
<td>SoylentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1129</td>
<td>SoylentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1130</td>
<td>SoylentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1131</td>
<td>SoylentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1132</td>
<td>SoylentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1133</td>
<td>SoylentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1134</td>
<td>SoylentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1135</td>
<td>SoylentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1136</td>
<td>SoylentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1137</td>
<td>SoyLentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1138</td>
<td>SoyLentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1139</td>
<td>SoyLentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1140</td>
<td>SoyLentGreen at commons.wikimedia.org</td>
</tr>
<tr>
<td>1141</td>
<td>SoyLentGreen at commons.wikimedia.org</td>
</tr>
</tbody>
</table>

1371 http://en.wikibooks.org
1373 http://en.wikibooks.org
1374 http://commons.wikimedia.org/wiki/User:Soylentgreen
1375 http://commons.wikimedia.org/wiki/User:Soylentgreen
1376 http://commons.wikimedia.org/wiki/User:Soylentgreen
1377 http://commons.wikimedia.org/wiki/User:Soylentgreen
1378 http://commons.wikimedia.org/wiki/User:Soylentgreen
1379 http://commons.wikimedia.org/wiki/User:Soylentgreen
1380 http://commons.wikimedia.org/wiki/User:Soylentgreen
1381 http://commons.wikimedia.org/wiki/User:Soylentgreen
1382 http://commons.wikimedia.org/wiki/User:SoylentGreen
1383 http://commons.wikimedia.org/wiki/User:SoylentGreen
1384 http://commons.wikimedia.org/wiki/User:SoylentGreen
1385 http://commons.wikimedia.org/wiki/User:SoylentGreen
1386 http://commons.wikimedia.org/wiki/User:SoylentGreen
1387 http://commons.wikimedia.org/wiki/User:SoylentGreen
1388 http://commons.wikimedia.org/wiki/User:SoylentGreen
1389 http://commons.wikimedia.org/wiki/User:SoylentGreen
1390 http://commons.wikimedia.org/wiki/User:SoylentGreen
1391 http://commons.wikimedia.org/wiki/User:SoylentGreen
1392 http://commons.wikimedia.org/wiki/User:SoylentGreen
1393 http://commons.wikimedia.org/wiki/User:SoylentGreen
1394 http://commons.wikimedia.org/wiki/User:SoylentGreen
1395 http://commons.wikimedia.org/wiki/User:SoylentGreen
1396 http://commons.wikimedia.org/wiki/User:SoylentGreen
1397 http://commons.wikimedia.org/wiki/User:SoylentGreen
1398 http://commons.wikimedia.org/wiki/User:SoylentGreen
1399 http://commons.wikimedia.org/wiki/User:SoylentGreen
1400 http://commons.wikimedia.org/wiki/User:SoylentGreen
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1141</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1142</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1143</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1144</td>
<td>Roger McLassus</td>
<td>GFDL</td>
</tr>
<tr>
<td>1145</td>
<td>Jeremy B. Original uploader was Bullercruz1 at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>1146</td>
<td>Jeremy B. Original uploader was Bullercruz1 at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>1147</td>
<td>Jeremy Buller. Original uploader was Bullercruz1 at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>1148</td>
<td>Jeremy B. Original uploader was Bullercruz1 at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>1149</td>
<td>Jeremy B. Original uploader was Bullercruz1 at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>1150</td>
<td>Jeremy B. Original uploader was Bullercruz1 at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
</tbody>
</table>

1395 http://commons.wikimedia.org/wiki/User:SoylentGreen
1396 http://commons.wikimedia.org/wiki/User:SoylentGreen
1397 http://commons.wikimedia.org/wiki/User:SoylentGreen
1398 http://commons.wikimedia.org/wiki/User:Roger_McLassus
1400 http://en.wikibooks.org
1402 http://en.wikibooks.org
1404 http://en.wikibooks.org
1406 http://en.wikibooks.org
1409 http://en.wikibooks.org
1411 http://en.wikibooks.org
1413 http://en.wikibooks.org
1415 http://en.wikibooks.org
1417 http://en.wikibooks.org
1419 http://en.wikibooks.org
1421 http://en.wikibooks.org

1926
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1151</td>
<td>Jeremy B. Original uploader was Bullercruz at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>1152</td>
<td>Jeremy B. Original uploader was Bullercruz at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>1153</td>
<td>Jeremy B. Original uploader was Bullercruz at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>1154</td>
<td>Jeremy B. Original uploader was Bullercruz at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GFDL</td>
</tr>
<tr>
<td>1155</td>
<td>Jeremy B. Original uploader was Bullercruz at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
</tr>
<tr>
<td>1156</td>
<td>Guillaume22 at en.wikibooks. GFDL</td>
</tr>
<tr>
<td>1157</td>
<td>Original uploader was LuizAlvarez at en.wikibooks. GPL</td>
</tr>
<tr>
<td>1158</td>
<td>Original uploader was Goeland86 at en.wikibooks. GPL</td>
</tr>
<tr>
<td>1159</td>
<td>Ausis, Bayo, Damian Yerrick, Emijrpbot, Fred J, Jafeluv, JarektBot, Matthias M., Msikma commonswiki, SieBot, WikipediaMaster, YaCBot</td>
</tr>
<tr>
<td>1160</td>
<td>BenutzernameAufCommons CC-BY-2.5</td>
</tr>
<tr>
<td>1161</td>
<td>User:Toni Grappa GPL</td>
</tr>
<tr>
<td>1162</td>
<td>SoylentGreen GFDL</td>
</tr>
</tbody>
</table>

References:


1927
List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1163</td>
<td>Jawboot[^1450] at English Wikibooks[^1451]</td>
<td>GPL</td>
</tr>
<tr>
<td>1164</td>
<td>User:Toni Grappa[^1452]</td>
<td>GPL</td>
</tr>
<tr>
<td>1165</td>
<td>en:User:Siggimund[^1453]</td>
<td>GPL</td>
</tr>
<tr>
<td>1166</td>
<td>SoylentGreen[^1454]</td>
<td>CC-BY-2.5</td>
</tr>
<tr>
<td>1167</td>
<td>Imageday[^1455]</td>
<td>GFDL</td>
</tr>
<tr>
<td>1168</td>
<td>Guillaume22[^1456]</td>
<td>GFDL</td>
</tr>
<tr>
<td>1169</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1170</td>
<td>SoylentGreen[^1457]</td>
<td>PD</td>
</tr>
<tr>
<td>1171</td>
<td>Alex Grace</td>
<td>GFDL</td>
</tr>
<tr>
<td>1172</td>
<td>Original uploader was Totophe64[^1458] at en.wikibooks[^1459]</td>
<td>GPL</td>
</tr>
<tr>
<td>1173</td>
<td>User:Toni Grappa[^1460]</td>
<td>GPL</td>
</tr>
<tr>
<td>1174</td>
<td>Guillaume22[^1461]</td>
<td>GFDL</td>
</tr>
<tr>
<td>1175</td>
<td>Original uploader was Gabio[^1462] at en.wikibooks[^1463]</td>
<td>GPL</td>
</tr>
<tr>
<td>1176</td>
<td>Original uploader was Totophe64[^1464] at en.wikibooks[^1465]</td>
<td>GPL</td>
</tr>
<tr>
<td>1177</td>
<td>SoylentGreen[^1466]</td>
<td>GFDL</td>
</tr>
<tr>
<td>1178</td>
<td>User:Toni Grappa[^1467]</td>
<td>GPL</td>
</tr>
<tr>
<td>1179</td>
<td>Mangarm[^1468]</td>
<td>GPL</td>
</tr>
<tr>
<td>1180</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1181</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1182</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1183</td>
<td>Toni Grappa[^1469]</td>
<td>GFDL</td>
</tr>
<tr>
<td>1184</td>
<td>Original uploader was ZeroOne[^1470] at en.wikibooks[^1471]</td>
<td>GPL</td>
</tr>
<tr>
<td>1185</td>
<td>User:Toni Grappa[^1472]</td>
<td>GPL</td>
</tr>
<tr>
<td>1186</td>
<td>User:Toni Grappa[^1473]</td>
<td>GPL</td>
</tr>
<tr>
<td>1187</td>
<td>Toni Grappa[^1474]</td>
<td>GPL</td>
</tr>
</tbody>
</table>

---

[^1451]: http://en.wikibooks.org/wiki/  
[^1454]: http://commons.wikimedia.org/wiki/User:SoylentGreen  
[^1455]: http://commons.wikimedia.org/wiki/wiki/Imageday  
[^1456]: http://commons.wikimedia.org/w/index.php?title=User:Guillaume22&action=edit&redlink=1  
[^1457]: http://commons.wikimedia.org/wiki/User:SoylentGreen  
[^1459]: http://en.wikibooks.org  
[^1461]: http://commons.wikimedia.org/w/index.php?title=User:Guillaume22&action=edit&redlink=1  
[^1463]: http://en.wikibooks.org  
[^1465]: http://en.wikibooks.org  
[^1466]: http://commons.wikimedia.org/wiki/User:SoylentGreen  
[^1471]: http://en.wikibooks.org  
<table>
<thead>
<tr>
<th>List of Figures</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1188</strong> Original uploader was Gabio(^{1475}) at en.wikibooks(^{1476})</td>
</tr>
<tr>
<td><strong>1189</strong> The original uploader was MikaYuoadas(^{1477}) at French Wikiversity(^{1478})</td>
</tr>
<tr>
<td><strong>1190</strong> Arturo Reina commonswiki, Bayo, JarektBot, MGA73bot2, YaCBot, YiFeiBot</td>
</tr>
<tr>
<td><strong>1191</strong> Original uploader was Sumoncil(^{1479}) at en.wikibooks(^{1480}). Later version(s) were uploaded by Adrignola(^{1481}) at en.wikibooks(^{1482}).</td>
</tr>
<tr>
<td><strong>1192</strong> Original uploader was Sumoncil(^{1483}) at en.wikibooks(^{1484}). Later version(s) were uploaded by Adrignola(^{1485}) at en.wikibooks(^{1486}).</td>
</tr>
<tr>
<td><strong>1193</strong> Blender Foundation</td>
</tr>
<tr>
<td><strong>1194</strong> Original uploader was ZeroOne(^{1487}) at en.wikibooks(^{1488})</td>
</tr>
<tr>
<td><strong>1195</strong> Soylentgreen(^{1489})</td>
</tr>
<tr>
<td><strong>1196</strong> Banlu Kemiyatorn(^{1490})</td>
</tr>
<tr>
<td><strong>1197</strong> Blender Foundation</td>
</tr>
<tr>
<td><strong>1198</strong> User:ToniGrappa(^{1491})</td>
</tr>
<tr>
<td><strong>1199</strong> John Whelan. Original uploader was Johnwhelan(^{1492}) at en.wikibooks(^{1493}). Later version(s) were uploaded by Adrignola(^{1494}) at en.wikibooks(^{1495}).</td>
</tr>
<tr>
<td><strong>1200</strong> Original uploader was Argento(^{1496}) at en.wikibooks(^{1497}).</td>
</tr>
<tr>
<td><strong>1201</strong> Arturo Reina commonswiki, Bayo, Emijrpbot, Hazard-Bot, JarektBot, Julian Herzog, MGA73bot2, SieBot, YaCBot</td>
</tr>
<tr>
<td><strong>1202</strong> Blender Foundation</td>
</tr>
<tr>
<td><strong>1203</strong> b:en:User:Lazy-lump(^{1498})</td>
</tr>
</tbody>
</table>

\(^{1476}\)http://en.wikibooks.org
\(^{1478}\)http://en.wikiversity.org/wiki/fr:
\(^{1480}\)http://en.wikibooks.org
\(^{1482}\)http://en.wikibooks.org
\(^{1484}\)http://en.wikibooks.org
\(^{1486}\)http://en.wikibooks.org
\(^{1488}\)http://en.wikibooks.org
\(^{1489}\)http://commons.wikimedia.org/wiki/User:Soylentgreen
\(^{1490}\)http://commons.wikimedia.org/w/index.php?title=User:Banlu_Kemiyatorn&action=edit&redlink=1
\(^{1493}\)http://en.wikibooks.org
\(^{1495}\)http://en.wikibooks.org
\(^{1497}\)http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1204</td>
<td>The original uploader was Greggreg at English Wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1205</td>
<td>Gabio</td>
<td></td>
</tr>
<tr>
<td>1206</td>
<td>Original uploader was Argento at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1207</td>
<td>SaphireS</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>1208</td>
<td>ben:User:Spiderworm</td>
<td></td>
</tr>
<tr>
<td>1209</td>
<td>Original uploader was AverieZen at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1210</td>
<td>ben:User:Spiderworm</td>
<td></td>
</tr>
<tr>
<td>1211</td>
<td>Original uploader was Allefant at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1212</td>
<td>Romain Behar. Original uploader was Romainbehar at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1213</td>
<td>John Whelan. Original uploader was Johnwhelan at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>1214</td>
<td>Arturo Reina commonswiki, Bayo, Fryed-peach, JarektBot, MGA73bot2, YaCBot, YiFeiBot</td>
<td></td>
</tr>
<tr>
<td>1215</td>
<td>me</td>
<td>GFDL</td>
</tr>
<tr>
<td>1216</td>
<td>Toni Grappa</td>
<td>GFDL</td>
</tr>
<tr>
<td>1217</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1218</td>
<td>Guillaume22</td>
<td>GFDL</td>
</tr>
<tr>
<td>1219</td>
<td>Original uploader was Gabio at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1220</td>
<td>Boyage. Original uploader was Boyage at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1221</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1222</td>
<td>Romain Behar. Original uploader was Romainbehar at en.wikibooks</td>
<td>GPL</td>
</tr>
</tbody>
</table>

1508 [http://en.wikibooks.org](http://en.wikibooks.org)
1510 [http://en.wikibooks.org](http://en.wikibooks.org)
<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1223</td>
<td>Original uploader was Robpers2003 at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1224</td>
<td>User:Toni Grappa at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1225</td>
<td>Original uploader was Totophe64 at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1226</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1227</td>
<td>Boyage, Original uploader was Boyage at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1228</td>
<td>SoylentGreen</td>
<td>CC-BY-2.5</td>
</tr>
<tr>
<td>1229</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1230</td>
<td>The original uploader was SchmS at English Wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>1231</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1232</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1233</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1234</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1235</td>
<td>me</td>
<td>GFDL</td>
</tr>
<tr>
<td>1236</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1237</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1238</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1239</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1240</td>
<td>Toni Grappa: Veröffentlichung mit freundlicher Genehmigung von Paddy - blend.polis</td>
<td>GPL</td>
</tr>
<tr>
<td>1241</td>
<td>User:Bastique, User:Ramac et al.</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>1242</td>
<td>SaphireS</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>1243</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1244</td>
<td>Original uploader was Mrfelis at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1245</td>
<td>The original uploader was MikaYuoadas at French Wikiversity</td>
<td>GPL</td>
</tr>
</tbody>
</table>


1931
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1246</td>
<td>me</td>
<td>GFDL</td>
</tr>
<tr>
<td>1247</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1248</td>
<td>Original uploader was Stalepanda at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>1249</td>
<td>Toni Grappa</td>
<td>GFDL</td>
</tr>
<tr>
<td>1250</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1251</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>1252</td>
<td>Original uploader was Darkonc at en.wikibooks. Later version(s) were uploaded by Argento at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>1253</td>
<td>Frogulis</td>
<td></td>
</tr>
<tr>
<td>1254</td>
<td>Guillaume22</td>
<td>GFDL</td>
</tr>
<tr>
<td>1255</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1256</td>
<td>Original uploader was Greensweater at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1257</td>
<td>Guillaume22</td>
<td>GFDL</td>
</tr>
<tr>
<td>1258</td>
<td>Original uploader was Stalepanda at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>1259</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1260</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1261</td>
<td>SaphireS</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>1262</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1263</td>
<td>SoylentGreen</td>
<td>GPL</td>
</tr>
<tr>
<td>1264</td>
<td>User:Toni Grappa</td>
<td>GFDL</td>
</tr>
<tr>
<td>1265</td>
<td>blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1266</td>
<td>Arturo Reina commonswiki, Bayo, JarektBot, MGA73bot2, YaCBot, YiFeiBot</td>
<td>GPL</td>
</tr>
<tr>
<td>1267</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
</tbody>
</table>

1550 http://en.wikibooks.org
1552 http://commons.wikimedia.org/wiki/User:SoylentGreen
1554 http://en.wikibooks.org
1556 http://en.wikibooks.org
1558 http://en.wikibooks.org
1560 http://en.wikibooks.org
1561 http://commons.wikimedia.org/wiki/User:Frogulis
1562 http://commons.wikimedia.org/w/index.php?title=User:Guillaume22&action=edit&redlink=1
1564 http://en.wikibooks.org
1565 http://commons.wikimedia.org/w/index.php?title=User:Guillaume22&action=edit&redlink=1
1567 http://en.wikibooks.org
1568 http://commons.wikimedia.org/wiki/User:SoylentGreen
1571 http://commons.wikimedia.org/wiki/User:SoylentGreen
<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1268</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1269</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1270</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1271</td>
<td>pearts</td>
<td>GPL</td>
</tr>
<tr>
<td>1272</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1273</td>
<td>Original uploader was Gabio at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1274</td>
<td>SVG version was created by User:Grunt and cleaned up by 3247, based on the earlier PNG version, created by Reidab</td>
<td>PD</td>
</tr>
<tr>
<td>1275</td>
<td>Mangarm</td>
<td>GPL</td>
</tr>
<tr>
<td>1276</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1277</td>
<td>Original uploader was Megaloman at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1278</td>
<td>SoylentGreen</td>
<td>GPL</td>
</tr>
<tr>
<td>1279</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1280</td>
<td>Original uploader was Darkone at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>1281</td>
<td>SoylentGreen</td>
<td>GPL</td>
</tr>
<tr>
<td>1282</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1283</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1284</td>
<td>Toni Grappa</td>
<td>GFDL</td>
</tr>
<tr>
<td>1285</td>
<td>Arturo Reina commonswiki, Bayo, Emijrpbot, Hazard-Bot, JarektBot, MGA73bot2, YaCBot</td>
<td></td>
</tr>
<tr>
<td>1286</td>
<td>SoylentGreen</td>
<td>GPL</td>
</tr>
<tr>
<td>1287</td>
<td>Toni Grappa</td>
<td>GFDL</td>
</tr>
<tr>
<td>1288</td>
<td>Arturo Reina commonswiki, Bayo, Jarekt, JarektBot, YaCBot</td>
<td></td>
</tr>
</tbody>
</table>

---

### List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Author</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1289</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1290</td>
<td>Toni Grappa</td>
<td>GFDL</td>
</tr>
<tr>
<td>1291</td>
<td>SaphireS</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>1292</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1293</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1294</td>
<td>Unknown</td>
<td>GFDL</td>
</tr>
<tr>
<td>1295</td>
<td>Romain Behar. Original uploader was Romainbehar at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1296</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1297</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1298</td>
<td>Boyage</td>
<td>GFDL</td>
</tr>
<tr>
<td>1299</td>
<td>Arturo Reina commonswiki, Bayo, Emijrpbot, Hazard-Bot, JarektBot, MGA73bot2, YaCBot</td>
<td>GPL</td>
</tr>
<tr>
<td>1300</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1301</td>
<td>Arturo Reina commonswiki, Bayo, JarektBot, MGA73bot2, YaCBot, YiFeiBot</td>
<td>GPL</td>
</tr>
<tr>
<td>1302</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1303</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1304</td>
<td>Original uploader was Spiderworm at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1305</td>
<td>Original uploader was Gabio at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1306</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1307</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1308</td>
<td>Soylentgreen</td>
<td>GPL</td>
</tr>
<tr>
<td>1309</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1310</td>
<td>SoylentGreen</td>
<td>GPL</td>
</tr>
<tr>
<td>1311</td>
<td>Binky1206</td>
<td>GPL</td>
</tr>
<tr>
<td>1312</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
</tbody>
</table>


1934
<table>
<thead>
<tr>
<th>Number</th>
<th>Original uploader</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1313</td>
<td>Original uploader was Bgks at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1314</td>
<td>Mangarm</td>
<td>GPL</td>
</tr>
<tr>
<td>1315</td>
<td>Original uploader was Mrfelis at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1316</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1317</td>
<td>Original uploader was Megaloman at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1318</td>
<td>Original uploader was Sumoncil at en.wikibooks, Later version(s) were uploaded by Adrignola at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1319</td>
<td>Original uploader was Sumoncil at en.wikibooks, Later version(s) were uploaded by Adrignola at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1320</td>
<td>me</td>
<td>GFDL</td>
</tr>
<tr>
<td>1321</td>
<td>Original uploader was Gabio at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1322</td>
<td>Original uploader was Greensweater at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1323</td>
<td>Toni Grappa</td>
<td>GFDL</td>
</tr>
<tr>
<td>1324</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1325</td>
<td>Original uploader was MikaYuoadas at fr.wikiversity</td>
<td>GPL</td>
</tr>
<tr>
<td>1326</td>
<td>Yhevhe</td>
<td>GFDL</td>
</tr>
<tr>
<td>1327</td>
<td>Toni Grappa</td>
<td>GFDL</td>
</tr>
<tr>
<td>1328</td>
<td>SoylentGreen</td>
<td>GPL</td>
</tr>
<tr>
<td>1329</td>
<td>Thomas Dinges</td>
<td>GFDL</td>
</tr>
<tr>
<td>1330</td>
<td>WebBird</td>
<td>GFDL</td>
</tr>
<tr>
<td>1331</td>
<td>b:en:User:Spiderworm</td>
<td>GPL</td>
</tr>
<tr>
<td>1332</td>
<td>Original uploader was Argento at en.wikibooks</td>
<td>GPL</td>
</tr>
</tbody>
</table>

1623 http://en.wikibooks.org
1624 http://commons.wikimedia.org/w/index.php?title=User:Managarm&action=edit&redlink=1
1626 http://en.wikibooks.org
1629 http://en.wikibooks.org
1631 http://en.wikibooks.org
1633 http://en.wikibooks.org
1635 http://en.wikibooks.org
1637 http://en.wikibooks.org
1639 http://en.wikibooks.org
1641 http://en.wikibooks.org
1644 http://fr.wikiversity.org
1646 http://commons.wikimedia.org/wiki/User:SoylentGreen
1650 http://en.wikibooks.org
<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1333</td>
<td>Romain Behar, Original uploader was Romainbehar at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>1334</td>
<td>Guillaume22 at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>1335</td>
<td>Original uploader was Bgks at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>1336</td>
<td>Original uploader was Badalia at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>1337</td>
<td>Original uploader was Darkonc at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>1338</td>
<td>Original uploader was Totophe64 at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>1339</td>
<td>Blender Foundation</td>
<td>GFDL</td>
</tr>
<tr>
<td>1340</td>
<td>User:Toni Grappa</td>
<td>GPL</td>
</tr>
<tr>
<td>1341</td>
<td>Soylentgreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1342</td>
<td>Soylentgreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1343</td>
<td>Original uploader was Sumoncil at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>1344</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1345</td>
<td>Guillaume22</td>
<td>GFDL</td>
</tr>
<tr>
<td>1346</td>
<td>SoylentGreen</td>
<td>GFDL</td>
</tr>
<tr>
<td>1347</td>
<td>Guillaume22</td>
<td>GFDL</td>
</tr>
<tr>
<td>1348</td>
<td>Original uploader was Sumoncil at en.wikibooks.</td>
<td>GPL</td>
</tr>
<tr>
<td>Page</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>1349</td>
<td>Original uploader was ZeroOne at en.wikibooks GPL</td>
<td></td>
</tr>
<tr>
<td>1350</td>
<td>Original uploader was Sumoncil at en.wikibooks. Later version(s) were uploaded by Adrignola at en.wikibooks. GPL</td>
<td></td>
</tr>
<tr>
<td>1351</td>
<td>Original uploader was ZeroOne at en.wikibooks GPL</td>
<td></td>
</tr>
<tr>
<td>1352</td>
<td>Original uploader was Darkone at en.wikibooks. Later version(s) were uploaded by Argento at en.wikibooks. GFDL</td>
<td></td>
</tr>
<tr>
<td>1353</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1354</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1355</td>
<td>The original uploader was Greggreg at English Wikibooks GPL</td>
<td></td>
</tr>
<tr>
<td>1356</td>
<td>Original uploader was SchmS at en.wikibooks GFDL</td>
<td></td>
</tr>
<tr>
<td>1357</td>
<td>The original uploader was SchmS at English Wikibooks GFDL</td>
<td></td>
</tr>
<tr>
<td>1358</td>
<td>Original uploader was SatanClaus at en.wikibooks GPL</td>
<td></td>
</tr>
<tr>
<td>1359</td>
<td>SatanClaus at English Wikibooks GPL</td>
<td></td>
</tr>
<tr>
<td>1360</td>
<td>Original uploader was Argento at en.wikibooks GPL</td>
<td></td>
</tr>
<tr>
<td>1361</td>
<td>Original uploader was Argento at en.wikibooks GPL</td>
<td></td>
</tr>
<tr>
<td>1362</td>
<td>SatanClaus at English Wikibooks GPL</td>
<td></td>
</tr>
<tr>
<td>1363</td>
<td>N comme Nul at English Wikibooks GPL</td>
<td></td>
</tr>
</tbody>
</table>

---


1937
<table>
<thead>
<tr>
<th>List of Figures</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1364</strong></td>
</tr>
<tr>
<td><strong>1365</strong></td>
</tr>
<tr>
<td><strong>1366</strong></td>
</tr>
<tr>
<td><strong>1367</strong></td>
</tr>
<tr>
<td><strong>1368</strong></td>
</tr>
<tr>
<td><strong>1369</strong></td>
</tr>
<tr>
<td><strong>1370</strong></td>
</tr>
<tr>
<td><strong>1371</strong></td>
</tr>
</tbody>
</table>

\(^{1710}\)http://en.wikibooks.org/wiki/
\(^{1712}\)http://en.wikibooks.org/wiki/
\(^{1714}\)http://en.wikibooks.org
\(^{1716}\)http://en.wikibooks.org
\(^{1718}\)http://en.wikibooks.org
\(^{1720}\)http://en.wikibooks.org
\(^{1722}\)http://en.wikibooks.org
\(^{1724}\)http://en.wikibooks.org
\(^{1726}\)http://en.wikibooks.org
\(^{1728}\)http://en.wikibooks.org
\(^{1730}\)http://en.wikibooks.org
\(^{1732}\)http://en.wikibooks.org
\(^{1734}\)http://en.wikibooks.org
\(^{1736}\)http://en.wikibooks.org
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1372</td>
<td>Original uploader was Darkonc at en.wikibooks. Later version(s) were uploaded by Argento at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>1373</td>
<td>Original uploader was Darkonc at en.wikibooks. Later version(s) were uploaded by Argento at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>1374</td>
<td>Original uploader was Darkonc at en.wikibooks. Later version(s) were uploaded by Argento at en.wikibooks.</td>
<td>GFDL</td>
</tr>
<tr>
<td>1375</td>
<td>Original uploader was Argento at en.wikibooks.</td>
<td></td>
</tr>
<tr>
<td>1376</td>
<td>DDD3x</td>
<td>GPL</td>
</tr>
<tr>
<td>1377</td>
<td>DDD3x</td>
<td>GPL</td>
</tr>
<tr>
<td>1378</td>
<td>DDD3x</td>
<td>GPL</td>
</tr>
<tr>
<td>1379</td>
<td>DDD3x</td>
<td>GPL</td>
</tr>
<tr>
<td>1380</td>
<td>DDD3x</td>
<td>GPL</td>
</tr>
<tr>
<td>1381</td>
<td>DDD3x</td>
<td>GPL</td>
</tr>
<tr>
<td>1382</td>
<td>DDD3x</td>
<td>GPL</td>
</tr>
<tr>
<td>1383</td>
<td>DDD3x</td>
<td>GPL</td>
</tr>
<tr>
<td>1384</td>
<td>DDD3x</td>
<td>GPL</td>
</tr>
<tr>
<td>1385</td>
<td>Vessesh Hebbbar</td>
<td>PD</td>
</tr>
<tr>
<td>1386</td>
<td>Vessesh Hebbbar</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>1387</td>
<td>Vessesh Hebbbar</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>1388</td>
<td>Vessesh Hebbbar</td>
<td>CC-BY-SA-3.0</td>
</tr>
</tbody>
</table>

1738 http://en.wikibooks.org
1740 http://en.wikibooks.org
1742 http://en.wikibooks.org
1744 http://en.wikibooks.org
1746 http://en.wikibooks.org
1748 http://en.wikibooks.org
1749 http://en.wikibooks.org
1750 http://en.wikibooks.org
1751 http://commons.wikimedia.org/w/index.php?title= User:DDD3x&action=edit&redlink=1
1752 http://commons.wikimedia.org/w/index.php?title= User:DDD3x&action=edit&redlink=1
1753 http://commons.wikimedia.org/w/index.php?title= User:DDD3x&action=edit&redlink=1
1754 http://commons.wikimedia.org/w/index.php?title= User:DDD3x&action=edit&redlink=1
1755 http://commons.wikimedia.org/w/index.php?title= User:DDD3x&action=edit&redlink=1
1756 http://commons.wikimedia.org/w/index.php?title= User:DDD3x&action=edit&redlink=1
1757 http://commons.wikimedia.org/w/index.php?title= User:DDD3x&action=edit&redlink=1
1758 http://commons.wikimedia.org/w/index.php?title= User:DDD3x&action=edit&redlink=1
1759 http://commons.wikimedia.org/w/index.php?title= User:DDD3x&action=edit&redlink=1

1939
List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Author/Creator</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1389</td>
<td>Vessesh Hebbar</td>
<td>CC-BY-SA-3.0</td>
</tr>
<tr>
<td>1390</td>
<td>Vesseshhebbar</td>
<td>PD</td>
</tr>
<tr>
<td>1391</td>
<td>Vesseshhebbar</td>
<td>PD</td>
</tr>
<tr>
<td>1392</td>
<td>Learsbot, Learsdata, Webaware</td>
<td></td>
</tr>
<tr>
<td>1393</td>
<td>Original uploader was Bootaleg at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1394</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1395</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1396</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1397</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1398</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1399</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1401</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1403</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1404</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1405</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1406</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1407</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1408</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1409</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1410</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1411</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1412</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1413</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1414</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1415</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1416</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1417</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1418</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1419</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1420</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1421</td>
<td>Original uploader was Nuclearpidgeon at en.wikibooks</td>
<td>GPL</td>
</tr>
<tr>
<td>1422</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1423</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1424</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1425</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1426</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1427</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1428</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1429</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1430</td>
<td>Rosver</td>
<td>CC-BY-3.0</td>
</tr>
<tr>
<td>1431</td>
<td>Rosver</td>
<td></td>
</tr>
<tr>
<td>1432</td>
<td>Rosver</td>
<td></td>
</tr>
<tr>
<td>1433</td>
<td>blender Foundation</td>
<td></td>
</tr>
<tr>
<td>1434</td>
<td>Blender Foundation</td>
<td></td>
</tr>
<tr>
<td>1435</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1436</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1437</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1438</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1439</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1440</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1441</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1442</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1443</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1444</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1445</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1446</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1447</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1448</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1449</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1450</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1451</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1452</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1453</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1454</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1455</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1456</td>
<td>Blender Foundation</td>
<td>GPL</td>
</tr>
<tr>
<td>1457</td>
<td>Rosver</td>
<td></td>
</tr>
<tr>
<td>1458</td>
<td>Rosver</td>
<td></td>
</tr>
<tr>
<td>1459</td>
<td>Original uploader was Quantum Anomaly at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>1460</td>
<td>Original uploader was Quantum Anomaly at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>1461</td>
<td>Original uploader was Quantum Anomaly at en.wikibooks</td>
<td>GFDL</td>
</tr>
<tr>
<td>1462</td>
<td>Original uploader was Quantum Anomaly at en.wikibooks</td>
<td>GFDL</td>
</tr>
</tbody>
</table>


1941
<table>
<thead>
<tr>
<th>Figure</th>
<th>Original uploader</th>
<th>Original uploader at</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>1463</td>
<td>Quantum Anomaly</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
<tr>
<td>1464</td>
<td>Quantum Anomaly</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
<tr>
<td>1465</td>
<td>Quantum Anomaly</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
<tr>
<td>1466</td>
<td>Quantum Anomaly</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
<tr>
<td>1467</td>
<td>Quantum Anomaly</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
<tr>
<td>1468</td>
<td>Quantum Anomaly</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
<tr>
<td>1469</td>
<td>Quantum Anomaly</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
<tr>
<td>1470</td>
<td>Quantum Anomaly</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
<tr>
<td>1471</td>
<td>Quantum Anomaly</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
<tr>
<td>1472</td>
<td>Quantum Anomaly</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
<tr>
<td>1473</td>
<td>Quantum Anomaly</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
<tr>
<td>1474</td>
<td>Soeb</td>
<td>en.wikibooks.org</td>
<td>GPL</td>
</tr>
<tr>
<td>1475</td>
<td>Fabrice TIERCELIN</td>
<td>en.wikibooks.org</td>
<td>GFDL</td>
</tr>
</tbody>
</table>

1783 http://en.wikibooks.org
1785 http://en.wikibooks.org
1787 http://en.wikibooks.org
1789 http://en.wikibooks.org
1791 http://en.wikibooks.org
1793 http://en.wikibooks.org
1795 http://en.wikibooks.org
1797 http://en.wikibooks.org
1799 http://en.wikibooks.org
1801 http://en.wikibooks.org
1803 http://en.wikibooks.org
1805 http://en.wikibooks.org
1807 http://en.wikibooks.org
| 1476 | Original uploader was Soeb\(^{1809}\) at en.wikibooks\(^{1810}\) | GPL |
| 1477 | Original uploader was Soeb\(^{1811}\) at en.wikibooks\(^{1812}\) | GPL |
| 1478 | Fabrice TIERCELIN\(^{1813}\) | GFDL |
| 1479 | Radialronnie |  |
| 1480 | Radialronnie |  |
| 1481 | Radialronnie |  |
| 1482 | Radialronnie |  |
| 1483 | Adrignola, Radialronnie |  |
| 1484 | Radialronnie |  |
| 1485 | Radialronnie |  |
| 1486 | Radialronnie |  |
| 1487 | othman ahmad | GPL |
| 1488 | Othman Ahmad | GPL |
| 1489 | Original uploader was Tjb0607\(^{1814}\) at en.wikibooks\(^{1815}\) | GPL |
| 1490 | Inkscape Developers | GPL |
| 1491 | http://www.inkscape.org/ | GPL |
| 1492 | Inkscape Developers | GPL |
| 1493 | User:Tjb0607\(^{1816}\) | GPL |
| 1494 | Tjb0607\(^{1817}\) | CC-BY-3.0 |
| 1495 | Ldo\(^{1818}\) | PD |
| 1496 | Blender Foundation | GPL |
| 1497 | Blender Foundation | GPL |
| 1498 | Blender Foundation | GPL |
| 1499 | Rosver\(^{1819}\) |  |
| 1500 | Rosver\(^{1820}\) |  |
| 1501 | Rosver\(^{1821}\) |  |
| 1502 | Rosver\(^{1822}\) |  |
| 1503 | Rosver\(^{1823}\) |  |
| 1504 | Rosver\(^{1824}\) |  |
| 1505 | Rosver\(^{1825}\) |  |
| 1506 | Rosver\(^{1826}\) |  |
| 1507 | Rosver\(^{1827}\) | PD |

\(^{1810}\)http://en.wikibooks.org  
\(^{1812}\)http://en.wikibooks.org  
\(^{1813}\)http://commons.wikimedia.org/w/index.php?title=User:Ftiercel&action=edit&redlink=1  
\(^{1815}\)http://en.wikibooks.org  
\(^{1816}\)http://commons.wikimedia.org/w/index.php?title=User:Tjb0607&action=edit&redlink=1  
\(^{1817}\)http://commons.wikimedia.org/w/index.php?title=User:Tjb0607&action=edit&redlink=1  
\(^{1818}\)http://commons.wikimedia.org/wiki/User:Ldo  
\(^{1819}\)http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1  
\(^{1820}\)http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1  
\(^{1821}\)http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1  
\(^{1822}\)http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1  
\(^{1823}\)http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1  
\(^{1824}\)http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1  
\(^{1825}\)http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1  
\(^{1826}\)http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1  
\(^{1827}\)http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1508</td>
<td>Rosver</td>
</tr>
<tr>
<td>1509</td>
<td>Rosver</td>
</tr>
<tr>
<td>1510</td>
<td>Rosver</td>
</tr>
<tr>
<td>1511</td>
<td>Rosver</td>
</tr>
<tr>
<td>1512</td>
<td>Rosver</td>
</tr>
<tr>
<td>1513</td>
<td>Rosver</td>
</tr>
<tr>
<td>1514</td>
<td>Rosver</td>
</tr>
<tr>
<td>1515</td>
<td>Rosver</td>
</tr>
<tr>
<td>1516</td>
<td>Rosver</td>
</tr>
<tr>
<td>1517</td>
<td>Rosver</td>
</tr>
<tr>
<td>1518</td>
<td>Rosver</td>
</tr>
<tr>
<td>1519</td>
<td>Rosver</td>
</tr>
<tr>
<td>1520</td>
<td>Rosver</td>
</tr>
<tr>
<td>1521</td>
<td>Rosver</td>
</tr>
<tr>
<td>1522</td>
<td>Rosver</td>
</tr>
<tr>
<td>1523</td>
<td>Rosver</td>
</tr>
<tr>
<td>1524</td>
<td>Rosver</td>
</tr>
<tr>
<td>1525</td>
<td>Rosver</td>
</tr>
<tr>
<td>1526</td>
<td>Rosver</td>
</tr>
<tr>
<td>1527</td>
<td>Rosver</td>
</tr>
<tr>
<td>1528</td>
<td>Rosver</td>
</tr>
<tr>
<td>1529</td>
<td>Rosver</td>
</tr>
<tr>
<td>1530</td>
<td>Rosver</td>
</tr>
<tr>
<td>1531</td>
<td>Rosver</td>
</tr>
<tr>
<td>1532</td>
<td>Rosver</td>
</tr>
<tr>
<td>1533</td>
<td>Rosver</td>
</tr>
</tbody>
</table>

1830 http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1
1832 http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1
1834 http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1
1845 http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1
1851 http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1
1853 http://commons.wikimedia.org/w/index.php?title=User:Rosver&action=edit&redlink=1
<table>
<thead>
<tr>
<th>Figure</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1534</td>
<td>Rosver1854</td>
</tr>
<tr>
<td>1535</td>
<td>Rosver1855</td>
</tr>
<tr>
<td>1536</td>
<td>Rosver1856</td>
</tr>
<tr>
<td>1537</td>
<td>Rosver1857</td>
</tr>
<tr>
<td>1538</td>
<td>Rosver1858</td>
</tr>
<tr>
<td>1539</td>
<td>Rosver1859</td>
</tr>
<tr>
<td>1540</td>
<td>Rosver1860</td>
</tr>
<tr>
<td>1541</td>
<td>Rosver1861</td>
</tr>
<tr>
<td>1542</td>
<td>Rosver1862</td>
</tr>
<tr>
<td>1543</td>
<td>Rosver1863</td>
</tr>
<tr>
<td>1544</td>
<td>Rosver1864</td>
</tr>
<tr>
<td>1545</td>
<td>Rosver1865</td>
</tr>
<tr>
<td>1546</td>
<td>Rosver1866</td>
</tr>
<tr>
<td>1547</td>
<td>Rosver1867</td>
</tr>
<tr>
<td>1548</td>
<td>Rosver1868</td>
</tr>
<tr>
<td>1549</td>
<td>Rosver1869</td>
</tr>
<tr>
<td>1550</td>
<td>Rosver1870</td>
</tr>
<tr>
<td>1551</td>
<td>Rosver1871</td>
</tr>
<tr>
<td>1552</td>
<td>Rosver1872</td>
</tr>
<tr>
<td>1553</td>
<td>Rosver1873</td>
</tr>
<tr>
<td>1554</td>
<td>Rosver1874</td>
</tr>
<tr>
<td>1555</td>
<td>Rosver1875</td>
</tr>
<tr>
<td>1556</td>
<td>Rosver1876</td>
</tr>
<tr>
<td>1557</td>
<td>Rosver1877</td>
</tr>
<tr>
<td>1558</td>
<td>Rosver1878</td>
</tr>
<tr>
<td>1559</td>
<td>Rosver1879</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1560</td>
<td>Rosver</td>
</tr>
<tr>
<td>1561</td>
<td>Rosver</td>
</tr>
<tr>
<td>1562</td>
<td>Rosver</td>
</tr>
<tr>
<td>1563</td>
<td>Rosver</td>
</tr>
<tr>
<td>1564</td>
<td>Rosver</td>
</tr>
<tr>
<td>1565</td>
<td>Rosver</td>
</tr>
<tr>
<td>1566</td>
<td>Rosver</td>
</tr>
<tr>
<td>1567</td>
<td>Rosver</td>
</tr>
<tr>
<td>1568</td>
<td>Rosver</td>
</tr>
<tr>
<td>1569</td>
<td>Rosver</td>
</tr>
<tr>
<td>1570</td>
<td>Rosver</td>
</tr>
<tr>
<td>1571</td>
<td>Rosver</td>
</tr>
<tr>
<td>1572</td>
<td>Rosver</td>
</tr>
<tr>
<td>1573</td>
<td>Rosver</td>
</tr>
<tr>
<td>1574</td>
<td>Rosver</td>
</tr>
<tr>
<td>1575</td>
<td>Rosver</td>
</tr>
<tr>
<td>1576</td>
<td>Rosver</td>
</tr>
<tr>
<td>1577</td>
<td>Rosver</td>
</tr>
<tr>
<td>1578</td>
<td>Rosver</td>
</tr>
<tr>
<td>1579</td>
<td>Rosver</td>
</tr>
<tr>
<td>1580</td>
<td>Rosver</td>
</tr>
<tr>
<td>1581</td>
<td>Rosver</td>
</tr>
<tr>
<td>1582</td>
<td>BotMultichill, BotMultichillT, Hazard-Bot, JarektBot, Sch lurcherBot, Si eBot, World Imaging</td>
</tr>
<tr>
<td>1583</td>
<td>PHGCOM • derivative work: Rosver (talk)</td>
</tr>
<tr>
<td>1584</td>
<td>Blender Foundation</td>
</tr>
</tbody>
</table>


1897  PD
1898  PD
1899  PD

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1585</td>
<td>blender foundation</td>
</tr>
<tr>
<td>1586</td>
<td>Blender Foundation</td>
</tr>
<tr>
<td>1587</td>
<td>Blender Foundation</td>
</tr>
<tr>
<td>1588</td>
<td>Rosver1904</td>
</tr>
<tr>
<td>1589</td>
<td>Kome1905</td>
</tr>
<tr>
<td>1590</td>
<td>CategorizationBot, El Grafo, Hedwig in Washington, PeterWD</td>
</tr>
<tr>
<td>1591</td>
<td>CategorizationBot, Hedwig in Washington, PeterWD</td>
</tr>
<tr>
<td>1592</td>
<td>CategorizationBot, Emijrpbot, Hedwig in Washington, PeterWD</td>
</tr>
<tr>
<td>1593</td>
<td>CategorizationBot, El Grafo, Emijrpbot, Hedwig in Washington, PeterWD, YiFeiBot, Zhuyifei1999</td>
</tr>
<tr>
<td>1594</td>
<td>CategorizationBot, El Grafo, Emijrpbot, Hedwig in Washington, PeterWD, YiFeiBot, Zhuyifei1999</td>
</tr>
<tr>
<td>1595</td>
<td>CategorizationBot, El Grafo, Emijrpbot, Hedwig in Washington, PeterWD, YiFeiBot, Zhuyifei1999</td>
</tr>
<tr>
<td>1596</td>
<td>CategorizationBot, El Grafo, Emijrpbot, Hedwig in Washington, PeterWD, YiFeiBot, Zhuyifei1999</td>
</tr>
</tbody>
</table>

The "Corresponding Source" for a work in object code form means all the source code for the object code and *all the specially designed source code for the accompanying的重大组件", which is not part of the work, for major components of the corresponding怕set of the major component, but which is not part of that major component. For example, Corresponding Source includes interface definitions for the work as well as the source code for any Type 1 implementation of a standard interface defined in terms of the work, and the machine-readable textual form of unpatented algorithms, except for any software interface definition or implementation provided under an intermediate computational interface specified in alarge patent license. (b) The Corresponding Source need not include anything that is not con-
сcessed with any part of the work as a single entity, such as in a library.

The "Corresponding Source" for a work in source code form means all the source code for the object code and any accompanying documentation specifying the fields of modified functionality and their order of appearance, and the Corresponding Source should include at least *(in source code form) the machine-readable textual form of any *non-typical infringement, except for any software interface definition or implementation provided under an intermediate computational interface specified in a large patent license. (b) The Corresponding Source need not include anything that is not con-
сcessed with any part of the work as a single entity, such as in a library.

The "Corresponding Source" for a work in source code form means all the source code for the object code and any accompanying documentation specifying the fields of modified functionality and their order of appearance, and the Corresponding Source should include at least *(in source code form) the machine-readable textual form of any *non-typical infringement, except for any software interface definition or implementation provided under an intermediate computational interface specified in a large patent license. (b) The Corresponding Source need not include anything that is not con-
сcessed with any part of the work as a single entity, such as in a library.

The Corresponding Source for a work in source code form means all the source code for the object code and any accompanying documentation specifying the fields of modified functionality and their order of appearance, and the Corresponding Source should include at least *(in source code form) the machine-readable textual form of any *non-typical infringement, except for any software interface definition or implementation provided under an intermediate computational interface specified in a large patent license. (b) The Corresponding Source need not include anything that is not con-
сcessed with any part of the work as a single entity, such as in a library.

The "Corresponding Source" for a work in source code form means all the source code for the object code and any accompanying documentation specifying the fields of modified functionality and their order of appearance, and the Corresponding Source should include at least *(in source code form) the machine-readable textual form of any *non-typical infringement, except for any software interface definition or implementation provided under an intermediate computational interface specified in a large patent license. (b) The Corresponding Source need not include anything that is not con-
сcessed with any part of the work as a single entity, such as in a library.

The "Corresponding Source" for a work in source code form means all the source code for the object code and any accompanying documentation specifying the fields of modified functionality and their order of appearance, and the Corresponding Source should include at least *(in source code form) the machine-readable textual form of any *non-typical infringement, except for any software interface definition or implementation provided under an intermediate computational interface specified in a large patent license. (b) The Corresponding Source need not include anything that is not con-
сcessed with any part of the work as a single entity, such as in a library.

The "Corresponding Source" for a work in source code form means all the source code for the object code and any accompanying documentation specifying the fields of modified functionality and their order of appearance, and the Corresponding Source should include at least *(in source code form) the machine-readable textual form of any *non-typical infringement, except for any software interface definition or implementation provided under an intermediate computational interface specified in a large patent license. (b) The Corresponding Source need not include anything that is not con-
сcessed with any part of the work as a single entity, such as in a library.
278.2. GNU Free Documentation License

Version 1.1, 3 November 2000


Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.


def

License is divided into two main sections. This License describes the former; to the latter is added the GNU General Public License.

Both these terms and this License will be oblivious entirely from future Free

The Free Software Foundation may publish revised versions of this License, in the same way as it publishes revised versions of the GNU General Public License. Each version is given a distinguishing version number.

This License applies for all sections except §12. This section is included in all copies of the Document, and/or all versions of it, later than the version containing the first publication of this section.

The "Title Page" means, for a printed book, the title page itself, plus any preceding content. For electronic documents, the "Title Page" is whatever section(s) you call the "Title Page" in your version. It is not the "Table of Contents" or "Index" or "Cover Text" etc. but the actual "Title Page" in your particular document.

This License expressly permits publication by multiple title pages in one document. This License does not permit combining the Document with other works.

Each section that is Entitled "Acknowledgements" is treated at all levels as a "二线" component of this "line" documentation, except for sections entitled "Front-Cover Text" or "Back-Cover Text". (However, sections do not have to be entitled "Front-Cover Text" or "Back-Cover Text" to be treated as sections which must include text which falls under the definition of a Front-Cover Text or Back-Cover Text.)

If a section in the Document is Entitled "Acknowledgements", "Dedications", "Greetings" or "History", then if the section has no sentence which identifies that section as intended by this definition, the section should be treated as subservient to any sectionEntitled "EntitledXYZ" according to this definition.

You may add a passage of at most five words from a Front-Cover Text to the Document, as a Front-Cover Text on the first front cover, and Back-Cover Texts on the back cover. Both covers must also clearly identify you as the copyright holder. For example, you may add a Dedications section given in all copies, and that you add no other passages from a First-Cover Text or Back-Cover Text.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.

You may add Front-Cover Texts to the Document, either on front covers or as endpapers, and Back-Cover Texts at the back, or back covers. Each sectionEntitled "EntitledXYZ" may be included in all copies of the Document, if you wish it to be so included.
The “Corresponding Application Code” for a Combined Work means:

- the object code of an Application, and
- any source code for the same version, in which the only changes made were to convert it to object code.

The “Corresponding Source” for a Combined Work means:

- the object code and/or source code for the Application, including any data and utility programs needed to install, use, and test it.
- the Minimal Corresponding Source of such combinations, in all combinations of the Combined Work with the Library, if applicable.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You must make a good faith effort to ensure that, in the event an Application does not supply the Library function, the application will operate properly with a modified version of the Library that is interface-compatible with the version of the Library provided with the Application.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You must make a good faith effort to ensure that, in the event an Application does not supply the function, the application will operate properly with a modified version of the Library that is interface-compatible with the version of the Library provided with the Application.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and, as a whole, are equivalent to this License, and convey Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, exclude the Library.